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Get Help
There are a number of ways to learn more about your product and interact with Oracle and other users.

Get Help in the Applications
Use help icons    to access help in the application. If you don't see any help icons on your page, click your user image
or name in the global header and select Show Help Icons.

Get Support
You can get support at My Oracle Support. For accessible support, visit Oracle Accessibility Learning and Support.

Get Training
Increase your knowledge of Oracle Cloud by taking courses at Oracle University.

Join Our Community
Use Cloud Customer Connect to get information from industry experts at Oracle and in the partner community. You
can join forums to connect with other customers, post questions, suggest ideas for product enhancements, and watch
events.

Learn About Accessibility
For information about Oracle's commitment to accessibility, visit the Oracle Accessibility Program. Videos included in
this guide are provided as a media alternative for text-based topics also available in this guide.

Share Your Feedback
We welcome your feedback about Oracle Applications user assistance. If you need clarification, find an error, or just
want to tell us what you found helpful, we'd like to hear from you.

You can email your feedback to oracle_fusion_applications_help_ww_grp@oracle.com.

Thanks for helping us improve our user assistance!
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1  Sales Questions and Answers

What are the system requirements for Microsoft
integration?  
The system requirements are different based on which version of Oracle's Microsoft integration you're using.

• Microsoft 365 for Oracle Redwood UX or Oracle CX Sales for Microsoft 365 (previous version): See the section,
Microsoft 365 Integration System Requirements.

• Oracle Sales Cloud for Outlook: See the section, Oracle Sales Cloud for Outlook System Requirements.

Microsoft 365 Integration System Requirements
The system requirements for the Microsoft 365 for Redwood UX and for the Oracle CX Sales for Microsoft 365 (previous
version) integration are listed here.

Note:  These requirements are for customers using Microsoft Exchange online with Oracle Sales. The Microsoft
integration is also available for new and implementing customers – but only the Redwood UX version. Oracle CX Sales
for Microsoft 365, the previous version, isn't available to newly implementing customers. For more information on
the Microsoft integration in the Redwood UX, see the solution playbook, How do I implement Microsoft 365 for Oracle
Sales Redwood UX? on the Oracle Help Center Sales > Playbooks page.

Email Client

You can use these versions of Microsoft Outlook using Microsoft Exchange Online (part of Microsoft 365), along with
the latest updates:

• Outlook for Microsoft 365 version 1908 (Build 11929.20254) or higher for Windows (32 and 64 bit)

• Outlook version 16.36 (20041300) or higher for Mac (32 and 64 bit)

• Outlook on the web for Microsoft 365

Note:  Incognito mode is not supported in browsers. Get the latest updates from Microsoft.

Exchange Server

• Microsoft 365 Exchange Online

• No support for On-Premises Exchange installs

Operating Systems

Any of these versions along with the latest hot fixes:

• Windows 10 version 1903 or higher

• Mac Mojave Version 10.14.6 or higher

Supported Browsers

1
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To learn more about the supported browsers, see the topic, Web Browser Requirements, in the Getting Started with
Oracle Cloud Applications guide.

Server Configurations

We don’t support:

• IMAP and POP3 email servers

• Terminal servers, such as Citrix® servers

• Remote Machines

Browser Trusted Sites

For desktop mode and Edge browser, add these domains as trusted sites:

• https://outlook.office.com

• https://outlook.office365.com

• Oracle Sales environment domain (example, https://*.oraclecloud.com)

• If you're using the Microsoft Edge browser, ensure that the browser includes the following trusted sites:
◦ https://*.office.com

◦ The Oracle Sales domain: for example: https://*.oraclecloud.com

Ensure that you select the Enable Protected Mode check box.

Oracle Sales Cloud for Outlook System Requirements
This version is for customers using Microsoft Exchange On-Premises and the Oracle Sales Cloud for Outlook add-in.
The requirements for Sales Cloud for Outlook are listed here.

Note:  This version isn't available for new and implementing customers.

Supported Operating Systems

• Microsoft Windows 7 SP1, 32-bit or 64-bit (x64)

• Microsoft Windows 8, 32-bit or 64-bit (x64)

• Microsoft Windows 8.1, 32-bit or 64-bit (x64)

• Microsoft Windows 10, 32-bit or 64-bit (x64)

Supported Microsoft Office Versions

• Microsoft Office 2007 SP2 and higher

• Microsoft Office 2010 (32-bit or 64-bit) build 14.0.4760.1000 and higher

• Microsoft Office 2013 (32-bit or 64-bit)

• Microsoft Office 2016 (32-bit or 64-bit)

• Microsoft Office 2019 (32-bit or 64-bit)

Supported Microsoft Exchange Server Versions

• Microsoft Exchange Server 2007 SP2

2
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• Microsoft Exchange Server 2010

• Microsoft Exchange Server 2013

• Microsoft Exchange Server 2016

• Microsoft Exchange Server 2019

• Microsoft 365

Supported Outlook Profiles and Protocols

• Profile with a Microsoft Exchange email account configured in Cached Exchange Mode (OST). Outlook must be
run with this profile at least once. Accounts with additional mailboxes are supported.

• Profile with an Internet email account. Outlook must be run with this profile at least once.

• VDI solutions such as Citrix are not supported.

The add-in can be installed in one of the Outlook profiles at a time.

Protocols

• POP3 is supported.

• IMAP is not supported.

Related Topics
• What are the system requirements for Oracle CX Sales Mobile?

What are the system requirements for Oracle CX Sales
Mobile?  
Here are the system requirements for Oracle CX Sales Mobile:

Apple Devices

• iOS 12.1 or higher

Android Devices

• Android OS 8.0 or higher

Related Topics
• What are the system requirements for Microsoft integration?
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How do I configure real-time and near real-time access
for access group object records?  
Using profile options, you can implement real-time and near real-time processing for objects secured using access
groups.

These options let you:

• Enable real-time processing of object records secured using access groups, so that when new object records are
created, the records are immediately accessible on the UI to the creator of the object record.

Real-time processing is supported for all access group objects.

• Enable near real-time processing for objects, so that when object records are created or updated, the new
records are accessible in near real-time to all users who have the privileges to view them.

Near real-time processing is supported for these objects:

◦ Account

◦ Activity

◦ Campaign

◦ Contact

◦ Custom objects

◦ Deal Registration

◦ HR Help Desk Request

◦ Internal Service Request

◦ MDF Budget

◦ MDF Claim

◦ MDF Request

◦ Lead

◦ Opportunity

◦ Partner

◦ Program Enrollments

◦ Service Request

The real-time processing options are enabled by default. However, to enable near real-time processing of object
records, there are some extra steps for you to perform.

Configure Real-Time Processing of Object Records
Two profile options control the real-time processing of object records that are secured using access groups:

• Real-Time Transaction Tracking Enabled (ORA_ZCA_TRANSACTION_TRACKING_ENABLED)
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• Real-Time Transaction Tracking for Access Groups Enabled
(ORA_ZCA_ACCESS_GROUPS_TRACKING_ENABLED)

Both of these profile options are enabled by default at the site level so that real-time processing is enabled for all
users. In general, you won't need to change the default values for these profile options, but you can disable real-time
processing for all users at the site level, or for individual users at the user level, if necessary.

For example, you might want to disable real-time processing for a specific user who needs to import bulk data into the
application. In cases like this, disable both profile options for the user using these steps:

1. From Setup and Maintenance, navigate to the Manage Administrator Profile Values task.
2. Search for the profile option name, for example, Real-Time Transaction Tracking Enabled.
3. In the Profile Values section, select New from the Actions menu.
4. In the Profile Level field, select User.
5. In the User Name field, search for and select a user, then click OK.
6. In the Profile Value field, select No.
7. Click Save and Close.
8. Repeat steps 2 - 7 for the Real-Time Transaction Tracking for Access Groups Enabled profile option.

Configure Near Real-Time Processing of Object Records
You can access records that are secured using access groups in near real-time, for objects that support near real-time
processing. New object records are immediately available on the UI, without needing to run the Perform Object Sharing
Rule Assignment Processing scheduled process, in these circumstances:

• When a new object record is created, when a user is added to or removed from the team associated with an
object, or when the owner of an object record is changed

• When an object record is updated, when a user gets access to an object record through a hybrid rule, or when
an access extension rule provides a user with access to an object related to the supported object

Note:  Near real-time processing isn't supported for object records that are created or updated because of territory
assignment processing. To see these types of changes on the UI, you must run the Perform Object Sharing Rule
Assignment Processing process.

To implement near real-time processing for supported objects, both of these profile options need to be enabled:

• Near Real-Time Transaction Tracking for Access Groups Enabled (ORA_ZCA_ACCESS_GROUPS_NEAR_REAL-
TIME_TRACKING_ENABLED)

This option is enabled at the site level by default.

• Common CRM Signals Active (ORA_ZCA_ENABLE_SIGNALS).

This option is disabled by default.

Enable the Common CRM Signals option to implement near real-time access for object records:

1. From Setup and Maintenance, navigate to the Manage Administrator Profile Values task.
2. Search for the profile option name, Common CRM Signals Active.
3. In the Profile Values section, select the Site profile level, then change the default value of the Profile Value field

to Yes.
4. Click Save and Close.
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What can I use the Security Console for?  
Use the Security Console work area to perform most security-management tasks.

Security Console Tasks
You can do these tasks on the Security Console:

• Review role hierarchies and role analytics.

• Create and manage custom job, abstract, and duty roles.

• Review the roles assigned to users.

Note:  You use the Manage Users work area, not the Security Console, to create users and to provision users
with roles.

• Compare roles.

• Simulate the Navigator for a user or role.

• Manage the default format of user names and the enterprise password policy.

• Manage notifications for user-lifecycle events, such as password expiration.

• Manage PGP and X.509 certificates for data encryption and decryption.

Note:  Oracle Sales and Fusion Service don't use certificate functionality.

• Set up federation and sync user and role information between Oracle Applications Security and Microsoft
Active Directory, if appropriate.

Security Console Access
You must have the IT Security Manager job role to use the Security Console. You open the Security Console by
clicking the Security Console link within the Tools menu in the Navigator. These tasks, performed in the Setup and
Maintenance work area, also open the Security Console:

• Manage Job Roles

• Manage Duties

• Manage Data Security Policies

You may also be interested in reviewing the article, How to Audit Security Customization (Role Creation, Role
Modification, Role Membership, Entitlement/ Privilege Changes) in Fusion Application (Doc ID 2175861.1), on My Oracle
Support.

Why isn't an account created when I create a contact?  
When you add a new Sales contact as part of creating an email – and neither the contact or an associated account exist
in Sales – you can create the contact on-the-fly, but you can't create the account as part of this flow. However, after
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creating the contact, you can open the contact in the web application using the Open in CX Sales action and quickly
create the account.

How can I see the Party ID of the Sales owner of a
contact?  
You can see the PartyID of the Sales owner of a contact using Microsoft 365 Designer.

1. In Application Composer, navigate to Productivity Applications Setup > CX Sales for Microsoft 365.
2. In the Microsoft 365 Designer, expand Contacts and click Details.
3. Duplicate the standard layout.
4. Drag and drop Owner Party ID from the Available Fields onto the custom layout.
5. Save your changes.
6. Owner Party ID appears in your Contacts custom layout in the add-in.
7. Publish the sandbox according to your company's business practices.

Can I modify a deep link to navigate to a specific activity
from Workspace?  
Yes. You can open a specific activity based on the activity ID from the Accounts page in Workspace using a deep link.
For example, this sample URL syntax allows direct links to the Activities subtab from the Account:

https://<hostname>:<port>/crmUI/faces/FuseOverview?
fndGlobalItemNodeId=itemNode_workspace_workspace&fndTaskItemNodeId
=ZCA_CC_INTERACTIVE_UI_CRM&fnd=%3BentityName%253DAccount%253BsubTabName%253DActivities%253BrecordId
%253D@{1}%253B%3B%3B%3Bfalse%3B256%3B%3B%3B

If you want to open a specific activity based on the activity ID, you replace the <RecordId> with the actual value of the
<ActivityId>. However, you must first use the CAST function as follows:

CAST("Activity"."Activity Id" AS NUMERIC)

This converts the ID from a text data expression to a numeric value so that you can use the numeric value to navigate to
the specific activity you want.

How do I configure address regions for accounts and
contacts?  
You use the Address object in Application Composer and the Manage Address Formats task in Setup and Maintenance
to configure address regions for accounts and contacts.

You can add or remove custom fields or standard fields (such as Type, D-U-N-S Number, Site Name, Site Number, and
so on) in the address region.
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Note:  Use Application Composer to add or remove fields in the address region. We recommend that you don’t use the
Page Composer for this purpose.

Location-specific fields (such as Address Line1, Address Line2, City, State, Postal Code, and so on) need to be managed
using the Manage Address Formats task in Setup and Maintenance. The fields configured in the Manage Address
Formats task can't be managed using the Application Composer.

When creating or editing accounts or contacts, salespeople can't save addresses by entering only address fields – they
must also enter location-specific fields. This rule applies to both standard and custom mandatory attributes on the
Address object that have been exposed using Application Composer.

To display the address region in a collapsed manner, select the Disclosed option of the address component on the page
composer.

How do I create and change sales statuses for my
opportunity?  
Opportunities and product lines on opportunities have statuses, such as Lost, No Sale, Open, and Won. You can create
sales statuses or update existing ones, as long as you stay within the predefined categories.

Before you start

Salespeople can select statuses for an opportunity or for a product line while editing an opportunity. The application
can set statuses automatically when synchronizing an opportunity and its product lines. The application uses status
categories when calculating Business Intelligence metrics for win/loss analysis.

Predefined Sales Statuses and Status Categories
The application comes with four predefined sales statuses and status categories. The predefined statuses are part of
larger status categories. Status categories aren't visible in the UI, but statuses are.

To change statuses, you can create statuses and then associate them with existing status categories. You can't add new
status categories.

This table shows the predefined statuses and categories:

Status Code, Status, and Category Meaning

Lost
 

Opportunity is closed without proceeding to a sale and lost to competitors, if any
 

No Sale
 

Opportunity is closed and not pursued
 

Open
 

Time between when a potential sales is realized and the customer decision on the sale is obtained
 

Won
 

Opportunity is closed with a buying decision from the customer and won over competitors, if any
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Create and Change Sales Statuses
You can create sales statuses or update existing ones, as long as you stay within the four predefined categories. You
also can mark statuses as inactive or active. Inactive statuses don't display in the UI.

These rules apply when creating sales statuses:

• Statuses must belong to one of the predefined status categories.

• The Status values display in alphabetic order on the UI.

• Status codes must be unique and can't be blank.

• The Status value must be unique and can't be blank.

• At least one active status in the Open status category must exist.

Oracle recommends that you retain the predefined status codes. As a best practice, to configure statuses, create more
codes. Don't deprecate or replace existing status codes.

Here's how to change sales statuses:

1. In the Setup and Maintenance work area, go to:

◦ Offering: Sales

◦ Functional Area: Opportunities

◦ Task: Manage Sales Status

2. In the Manage Sales Statuses page click the Add icon to add a new status and:

a. Enter a new Status Code.
b. Enter a new Status. This is the value that displays in alphabetic order in the opportunity pages.
c. Select the Active check box.
d. Select from one of the predefined values for Status Category.

3. To change an existing status, click in the row of the status so that it becomes editable and change the values as
you want.

4. Save your changes.

This figure shows the Manage Sales Statuses page with a new status added named "Abandoned".
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How do I edit Adaptive Search parameters?  
You can configure how Adaptive Search works and control how the Workspace interface operates using the Parameters
tab available in the Adaptive Search setup page.

Modify the parameters to define the way the Adaptive search engine operates and runs the search indexing. For
example, you can perform a partial publish to enable you to publish only those objects that have configuration
modifications. This avoids having to perform a full publish every time a configuration change is done thus saving time.

Some of the parameters you can modify include timeouts, fetch sizes, maximum number of batches and so on. You can
change parameters so that the indexing process runs successfully based on the server size and the volume of data to be
indexed.

Parameter settings include the ability to enable mass actions and record-level navigation, specify the fuzziness level for
search, set the default number of records to be displayed per page, and set the maximum number of records to export
at one time. For example, you might want to modify parameter values for the following:

• Set the maximum columns allowed in the Workspace list page

• Enable Group By in Workspace

• Enable Mass Actions

• Enable Mass Update

• Enable record level navigation

• Fuzziness Level

• Maximum Number of Records for Export

• Number of records displayed per page in Workspace

• Enable Partial Publish

You can also choose to change current and default values. Here's how to edit Adaptive Search parameters.

1. Click Navigator  > My Enterprise  >  Setup and Maintenance.
2. In the Setup and Maintenance work area, go to:

◦ Offering: Sales

◦ Functional Area: Sales Foundation

◦ Task: Configure Adaptive Search
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3. On the Configure Adaptive Search page, click the Parameters tab.

4. Highlight the Parameter Name that you want to change and click Edit. This warning is displayed.

You're about to change parameters that control how Adaptive Search works. 
Changes should only be carried out by search setup experts. Do you want to 
continue?

5. Click Yes.
6. In the Current Value field, makes the changes that you require and click Save and Close.

This table outlines the list of Adaptive search parameters available and shows the minimum, maximum, and default
values.

Parameter Name Description Minimum Value Maximum Value Default Value

Decouple incremental job at
the end of Publish
 

At the end of a Publish
process, a periodic refresh
is run so that any records
updated during the Publish
process get updated.
By default the decouple
parameter is set to N which
means that the periodic
job is run after the Publish
process. Change this
parameter to Y if you don't
want the periodic process
to run.
 

None
 

None
 

N
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Parameter Name Description Minimum Value Maximum Value Default Value

Enable Group By in
Workspace
 

Enable this parameter
to view search results in
groups based on specific
fields on the object or
related objects. Salespeople
get an overview of the
number of records in each
Grouped By grouping
and they can search and
filter records within these
groupings. They can also
view aggregates such as
count, average, and sum
of values on the records of
each group.
 

None
 

None
 

N
 

Enable Keyword
Highlighting in Workspace
 

Setting this parameter
means that any keywords
entered in the Search box
are highlighted in the
search results returned in
Workspace.
 

None
 

None
 

Y
 

Enable Mass Actions
 

You can perform some
actions on multiple records
at the same time. For
example, you can select
multiple leads in Workspace
and qualify them at once by
selecting the Qualify action.
 

None
 

None
 

Y
 

Enable Mass Update
 

You can update multiple
records at the same time.
This saves you time and
helps improve efficiency.
For example, you might
want to update the close
date for opportunity
records at the same time or
change the Lead rank from
Cool to Warm for a number
leads.
 
Use the Configure UI
tab from the Configure
Adaptive Search page to
specify which fields to
enable for mass update. In
addition, ensure that you
select the Mass Update
check box and have at least
four fields selected for
both standard and custom
objects.
 

None
 

None
 

N
 

Enable record level
navigation
 

You can use Previous
and Next buttons on the
record details page to

None
 

None
 

Y
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Parameter Name Description Minimum Value Maximum Value Default Value

navigate lists of records in
Workspace.
 

Enable Partial Publish
 

Set this parameter to do a
publish on selected set of
objects without doing a full
publish.
 

None
 

None
 

N
 

Fuzziness Level
 

This parameter defines
the number of character
edits that's considered
when a keyword search is
performed. For a value of 1,
 the search term "redwood"
returns Redwood in the
search result.
 

None
 

Two
 

One
 

Initial target shard size
required for index in GB
 

This parameter lets you
set the initial target shard
size for your search index
file. 30 GB is the predefined
value.
 

1
 

9999
 

30
 

Lookup Type Cache
Concurrency Level
 

You can configure the
Adaptive search lookup
caching to build pipelines
concurrently when the
lookup table or index file is
large. The default number
of pipelines is 2.
 

1
 

10
 

2
 

Lookup Type Cache Initial
Capacity
 

Set the initial capacity for
the concurrent hash map
that's used for the lookup
type cache.
 

16
 

10000
 

16
 

Lookup Type Cache Load
Factor
 

You can modify the cache
load factor for the lookup
type cache. The default
factor is 0.75.
 

0.5
 

1.0
 

0.75
 

Maximum Number of
Columns to Optimize
Column Sizing in
Workspace/List Page

Select the maximum
number of columns for
optimal sizing in Workspace
list pages. The default is
8 columns to optimize
column sizing.
 

1
 

20
 

8
 

Maximum columns allowed
in the Workspace/List Page
 

Adjust the number of saved
search columns to display
in Workspace list pages.
The default is 20 columns.
 

1
 

40
 

20
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Parameter Name Description Minimum Value Maximum Value Default Value

Maximum Number of
Records for Export
 

This parameter represents
the maximum number
of records to save to the
desktop in a single Export
action by users.
 

1
 

10000
 

2000
 

Maximum number of
records that can be selected
in Workspace
 

This parameter enables you
to change the maximum
number of records that can
be selected in Workspace
to perform a mass action.
The default number is 10
records and you can select
up to 25 records.
 

1
 

25
 

10
 

Minimum Characters to
type in Search Box before
Suggestions Filters are
displayed
 

This parameter lets you
change the minimum
number of characters
that you must include
in the Search box before
the suggestion filters
are displayed. The
default minimum value
is 1 character. A value
of 0 means the Filter
Suggestions display
immediately on clicking in
the search box.
 

0
 

100
 

1
 

Number of records
displayed per page in
Workspace
 

You can change the
number of records
displayed on the search
results page from the
default value of 25 records
up to a maximum of 100
records.
 

1
 

100
 

25
 

Screen Width in Pixels to
Optimize Column Sizing in
Workspace/List Page
 

Adjust the screen width
in pixels to optimize the
size of columns displayed
in Workspace list pages.
The default value is set as
auto, which means that the
screen will automatically
adjust to the number of
columns on the page.
 

1280
 

3840
 

Auto
 

Search Filter Limit
 

Set the number of filters
you can include for your
search. The default number
of filters is 6.
 

1
 

10
 

6
 

Shard maximum size
required for index in GB
 

This parameter lets you set
the shard maximum size
for your search index file in
gigabytes (GB).

1
 

9999
 

45
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Parameter Name Description Minimum Value Maximum Value Default Value

 

Related Topics
• How do I access Workspace data offline?

What's lock assignment?  
The Lock assignment check box is automatically selected when you run a manual assignment from the UI. Lock
assignment prevents a salesperson from being automatically removed from an opportunity through the assignment
engine.

Only users with Full access on the opportunity can select or deselect the Lock Assignment check box for sales team
members. Resources are assigned automatically to an opportunity during an automatic assignment process or through
a groovy script.

When the lock assignment is selected, an automatic territory assignment can't remove any sales account team
resources or team members. If the lock assignment is deselected, team members may be replaced if they no longer
match the assignment rules.

Note:  The Lock Assignment check box is not available by default and must be added to the Team subtab within the
Edit Opportunity page using Application Composer. See the next section for more information.

Extending Pages for Opportunities Using Application Composer
1. In a sandbox, navigate to Configuration > Application Composer.
2. In the object tree, select Opportunity > Pages > Application Pages.
3. Go to the Create Opportunity page and duplicate the standard layout.
4. Edit the layout.
5. In the Configure Detail Form region of the Opportunity Create page, move the Lock Assignment field from the

Available Fields to the Selected Fields list.
6. Save your changes.
7. Publish the sandbox according to your company's business practices.

How can I differentiate between copied Opportunities
and Opportunities created using Create button?  
You can create a Groovy script to help you identify opportunities that were copied from those opportunities that were
created using the Create button from the UI.

Here's how.

1. Navigate to the Opportunity object in Application Composer.
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2. Create a custom filed called OptyIdCopyText and enter the expression getAttribute(OptyId)exp as its default
value.

3. From Server Scripts area, insert the following sample Groovy script before the insert trigger. This scripts
differentiates between copied Opportunities and Opportunities created using Create from the UI.
if(OptyId.toString().equals(OptyIdCopyText_c)){

return false

}
else
{
setAttribute('DateatSalesStage1_c',null)
setAttribute('DateatSalesStage2_c',null)
setAttribute('DateatSalesStage3_c',null)
setAttribute('DateatSalesStage4_c',null)
setAttribute('DateatSalesStage5_c',null)
setAttribute('DateatSalesStage6_c',null)

}
 

4. Click Save and Close.
For more information about groovy scripting, see the Oracle Applications Cloud Groovy Scripting Reference.

How do I access the Routines dashboard?  
Sales administrators and users with the appropriate access privileges can view and create routines from the routines
dashboard. Other sales users can get access to configure and manage routines based on granting the appropriate
functional privilege to their roles.

Before you start

To use routines, you must have access to Application Composer and must have the Manage Routines privilege
(ZCA_MANAGE_ROUTINES). This privilege is available to the following roles by default:

• Application Implementation Consultant

• Sales Administrator

• Customer Relationship Management Application Administrator

Note:  If you're working with custom objects, you will also require the ORA_CRM_EXTN_ROLE role.

Here's how to access the routines dashboard:

1. Open Application Composer by selecting Configuration > Application Composer  in the Navigator menu.
2. Under the Common Setup Menu, click Routines to open the Routines dashboard.
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What are rollups?  
Rollups summarize data. For example, a rollup can calculate the sum of the potential revenue from the opportunities for
an account hierarchy.

Rollup calculations appear on top of the panels. This screenshot shows Opportunities and Service Requests rollups:

In Sales, the calculated value of a rollup appears in the object detail page. Here's a screenshot of an account in Sales,
showing rollup attributes. This screenshot shows the Rollups tab on the left pane and the rollup attributes shown in a
table:
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Note:  The Rollups feature replaces the predefined aggregated fields that were available in previous releases for
search criteria for your Workspace summarized data.

The sales application provides these predefined rollups:

Predefined Rollup Relationship Rollup Value

Total Number of Employees
 

Account only
 

The total number of employees in an account and its hierarchy
 

Fiscal Year Total Potential Revenue
 

Account only
 

The current fiscal year potential revenue from an account and its
hierarchy
 

Total Open Leads
 

Account to Sales Lead
 

The total count of the qualified and unqualified open leads of an account
and its hierarchy
 

Total Open Hot Leads
 

Account to Sales Lead
 

The total count of the qualified and unqualified hot leads of an account
and its hierarchy
 

Total Potential Revenue from Open
Leads
 

Account to Sales Lead
 

The sum of the potential revenue from qualified and unqualified open
leads of an account
 

Total Open Critical Service Requests
 

Account to Service Request
 

The total count of the open, critical service requests that are in the new,
in-progress, or waiting status of an account and its hierarchy
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Total Open Service Requests
 

Account to Service Request
 

The total count of service requests that are in the open, in-progress, and
waiting statuses, associated with an account and its hierarchy
 

Total Amount from Open Opportunity
Quotes and Orders
 

Account to Quotes and
Orders
 

The sum of amounts from the open and in-progress opportunity quotes
and orders of an account and its hierarchy
 

Total Open Activities
 

Account to Activity
 

The total count of open tasks of an account and its hierarchy
 

Total Potential Revenue from Open
Opportunities
 

Account to Opportunity
 

The sum of the potential revenue from the open opportunities of an
account and its hierarchy
 

Total Potential Revenue from Won
Opportunities
 

Account to Opportunity
 

The sum of the potential revenue from the won opportunities of an
account and its hierarchy
 

Total Open Opportunities
 

Account to Opportunity
 

The total count of open opportunities of an account and its hierarchy
 

Total Amount from Closed Opportunity
Quotes and Orders
 

Account to Opportunity
 

The sum of the amount from the closed and won opportunity quotes
and orders of an account and its hierarchy
 

Last Call Made
 

Account to Interaction
 

The date when your team made a phone call to any of the contacts
associated with an account or its hierarchy
 

Total Calls Made
 

Account to Interaction
 

The total number of phone calls made to an account and its hierarchy
 

Last Email Sent
 

Account to Interaction
 

The date when the last email was sent to any of the contacts associated
with an account or its hierarchy
 

Total Emails Sent
 

Account to Interaction
 

The total number of emails sent to an account and its hierarchy
 

Total Touches
 

Account to Interaction
 

The total number of calls made or emails sent to an account and its
hierarchy
 

Last Touch
 

Account to Interaction
 

The date when an account and its hierarchy were last contacted, either
by email or phone
 

Total Number of Open Leads Associated
with a Contact

Contact to Sales Lead The total number of qualified and unqualified open leads associated
with a contact

Total Number of Open Hot Leads
Associated with a Contact

Contact to Sales Lead The total number of qualified and unqualified hot leads associated with
a contact

Total Number of Open Opportunities
Associated with a Contact
 

Contact to Opportunity The total number of open opportunities associated with a contact

Sum of Open Opportunities Revenues
Associated with a Contact
 

Contact to Opportunity The cumulative total of revenue from the open opportunities associated
with a contact

Total Number of Open Service Requests
Associated with a Contact

Contact to Service Request The total number of service requests that are in the open, in progress, or
waiting statuses
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Total Number of Critical Open Service
Requests Associated with a Contact
 

Contact to Service Request The total number of service requests in the open, in progress, or waiting
statuses, marked as critical

Total Number of Touches with a Contact Contact to Interaction The total number of emails sent or calls made to a contact in the last 120
days

Date of Last Touch with a Contact
 

Contact to Interaction The date when the last email was sent or call was made to a contact in
the last 120 days

Total Number of Calls Made to a Contact
 

Contact to Interaction The total number of phone calls made to a contact in the last 120 days

Total Number of Emails Sent to a Contact
 

Contact to Interaction The total number of emails sent to a contact in the last 120 days

Last Call Made to a Contact
 

Contact to Interaction The date when the last outbound phone call was made to a contact in
the last 120 days

Last Email Sent to a Contact
 

Contact to Interaction The date when the last email was sent to a contact in the last 120 days

Date of Last Response from a Contact
 

Contact to Interaction The date when a last email or call was received from a contact in the last
120 days

Total Number of Responses Received
from a Contact

Contact to Interaction The total number of calls or emails received from a contact in the last
120 days

Total Number of Open Activities for a
Contact

Contact to Activity The cumulative total of:
 

• Tasks that are open and not in completed or canceled status

• Recurring or nonrecurring appointments with the current date as
the start date

• Call reports ending on the current date

Last Touch Date Sales Lead to Interaction The date when the last call or email was sent in the context of a lead

Last Call Made Sales Lead to Interaction The date when the last call was made in the context of a lead

Total Call Made Sales Lead to Interaction The total number of calls made in the context of a lead

Total Emails Sent Sales Lead to Interaction The total number of emails sent in the context of a lead

Total Touches Sales Lead to Interaction The total number of emails and calls made in the context of a lead

Last Email Sent Sales Lead to Interaction The date when the last email was sent in the context of a lead

Total Open Activities Sales Lead to Interaction The cumulative total of:
 

• Tasks that are open and not in completed or canceled status

• Recurring or nonrecurring appointments with the current date as
the start date

• Call reports ending on the current date

Total Open Opportunities Campaign to Opportunity The total number of open opportunities associated with a campaign

Total Won Opportunities Campaign to Opportunity The total number of won opportunities associated with a campaign
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Total Revenue from Opportunities Campaign to Opportunity The total revenue from the open opportunities associated with a
campaign

Total Opportunities Campaign to Opportunity The total number of opportunities associated with a campaign

Total Revenue from Open Opportunities Campaign to Opportunity The total revenue from the open opportunities associated with a
campaign

Total Revenue from Won Opportunities Campaign to Opportunity The total revenue from the won opportunities associated with a
campaign

Total Converted Leads Campaign to Sales Lead The total number of converted leads associated with a campaign

Total Leads Campaign to Sales Lead The total number of leads from a campaign

Total Hot Open Leads Campaign to Sales Lead The total number of unqualified or qualified leads ranked as hot that are
associated with a campaign

Total Open Leads Campaign to Sales Lead The total number of unqualified or qualified open leads associated with
a campaign

Total Revenue from Open Leads Campaign to Sales Lead The total amount from the unqualified and qualified leads associated
with a campaign

Total Emails Sent Opportunity to Interaction The total number of emails sent in the context of an opportunity

Total Touches Opportunity to Interaction The total number of email and calls made in the context of an
opportunity

Last Email Sent Opportunity to Interaction The date when the last email was sent in the context of an opportunity

Total Calls Made Opportunity to Interaction The total number of calls made in the context of an opportunity

Last Call Made Opportunity to Interaction The date when the last call was made in the context of an opportunity

Last Touch Date Opportunity to Interaction The date when the last call or email sent in the context of an opportunity

Total Open Activities Opportunity to Activity The cumulative total of:
 

• Tasks that are open and not in completed or canceled status

• Recurring or nonrecurring appointments with the current date as
the start date

• Call reports ending on the current date

What are the steps to set up rollups?  
Here’s a summary of how to define rollups for Sales. All the privileges, setups, and tasks involved in setting up rollups
for both the classic and Redwood user experience is provided.

This table provides the initial setup steps for rollups, navigation, brief description, and where to get more details.
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Step Applies
To

Description Navigation Where to Get the Details

1 Both
classic
and
Redwood
user
experience

Add the Manage Rollup Metrics privilege to a copy
of the Sales Administrator job role (ORA_ZBS_
SALES_ADMINISTRATOR_JOB). To the role, add users
responsible for configuring and setting up rollups.

Navigator > Tools > Security
Console > Roles

See the Edit Job or Abstract Roles
topic in the Securing Sales and
Fusion Service guide for more
information.

2 Both
classic
and
Redwood
user
experience

Verify that these scheduled processes appear on the
Scheduled Process page:
 

• Rollup Full Refresh

• Rollup Account Hierarchy and Linked Records
Refresh

• Rollup Incremental Refresh

When you unpublish or delete a rollup, the Data
Cleanup scheduled process prompts you to clear the
data.

Navigator > Tools  > Scheduled
Processes

See the Run Scheduled
Processes for Rollups topic in the
Implementing Sales guide for
more information.
See also the Scheduled Processes
chapter of the Understanding
Scheduled Processes guide.
 

2 Both
classic
and
Redwood
user
experience

After adding the privileges for the users, they get
access to the Rollups setup page. Enable the Rollup
Test Enabled profile option (ORA_ZCA_TEST_
ROLLUPS), to display the Test tab on the Rollups
setup page.

Setup and Maintenance >
Sales > Sales Foundation >
Manage Administrator Profile
Values

See the Test and Publish the
Rollups topic in the Implementing
Sales guide for more information.

3 Both
classic
and
Redwood
user
experience
(optional)

When creating new rollups, you can reuse the rollup
attributes of unpublished rollups or create custom
attributes and publish them. The custom attributes
will be available on the Rollups setup page.

Application Composer >
Standard Objects > Account >
Account Rollups >  Fields
Navigation is similar for contact
rollups and other object rollups.
 

See the information on defining
fields in the Configuring
Applications Using the
Application Composer guide.

4 Classic
user
experience
(Preferred)

Use the formula fields instead of a regular field to
create a custom attribute for rollups. Unlike regular
fields, formula fields let you build a script with rules
related to calculations.

Application Composer See the Configure Custom Rollups
Using the Formula Fields topic in
the Implementing Sales guide for
more information.

5 Classic
user
experience
(Optional)

When creating rollups that depend on fiscal year
periods, such as current quarter, use the accounting
calendar periods. The accounting calendar defines
the fiscal year and the time periods within it.

Related Object Filter on the Define
Rollups setup page.

See the Use the Accounting
Calendar Time Periods for Your
Rollups topic in the Implementing
Sales guide for more information.

6 Redwood
user
experience

Use the Visual Builder Studio to add custom rollups
to Redwood user experience pages.
You can also show the rollups on the panels in
Redwood user experience.
 

Settings and Actions > Edit Page
in Visual Builder

See these topics in the Extending
Sales in the Redwood user
experience guide:
 

• Add a Custom Field to the
Edit Contact Page

• Configure the Rollups
Region in a Panel

To access this guide, contact your
Oracle representative.
 

7 Classic
user
experience

Enable the Rollups subtab on object pages in the
Classic user experience.

Application Composer See the Show Rollup Attributes
on the Object Pages topic in the
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Step Applies
To

Description Navigation Where to Get the Details

Implementing Sales guide for
more information.

8 Both
classic
and
Redwood
user
experience
(Optional)

Enable rollups for Adaptive Search. Let salespeople
search accounts or contacts using rollups as search
criteria.

Setup and Maintenance >
Sales > Sales Foundation >
Configure Adaptive Search

See the Enable Searching for
Accounts and Contacts Using
Rollups topic in the Implementing
Sales guide for more information.

9 Redwood
user
experience
(Optional)

Enable Rollups as group by options so that
salespeople can use them to group accounts and
contacts by common attributes.

Setup and Maintenance >
Sales > Sales Foundation >
Configure Adaptive Search

See the Enable Grouping by
Rollups topic in the Implementing
Sales guide for more information.

Here's the navigation to the Rollups setup page:

1. Go to Navigator > Configuration > Application Composer.
2. Under Advanced Setup, click Define Rollups.

Note:  You don't need to be in a sandbox to access the Define Rollups page.

Here's a sample screenshot of the Define Rollups page:

The table below describes the components of the Define Rollups page.

Callout Name Description

1 Setup
 

Shows the entire list of rollups. The list includes all published and unpublished rollups, both
predefined and custom
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Callout Name Description

You can sort the columns by name, type (Regular or Aging), source object (Account), related object
of the rollup, published status, and the last refresh status of the rollup.
 

2 Actions
 

• Create: Use this option to create a new rollup from scratch.

• Duplicate: Use this option to create a working copy of a predefined rollup.

• Edit: Use this option to change the parameters of a custom rollup. For predefined rollups, you
can change two parameters: the hierarchy for, account rollups, and calculation frequency.

• Delete: Use this option to delete custom rollups. You can't delete predefined rollups; you can
only unpublish them.

3 Monitor
 

• Full Refresh: Run a full refresh every time you publish a rollup.

• Incremental Refresh: Schedule an incremental refresh so that published rollups are regularly
updated with the latest values. You can set this process to run once hourly.

Note:  Full refresh is used only after the rollups are published for the first time. After that,
 Incremental Refresh takes care of recalculating and publishing the rollups periodically.

• Hierarchy Refresh: This process is applicable for account rollups only. Schedule or run a
hierarchy refresh to recalculate account rollups if a hierarchy changes.

• Data Cleanup: Schedule a data cleanup so that whenever you delete or unpublish a rollup,
 the rollup engine runs this process and clears the calculations.

4 Test
 

Test the unpublished rollups to ensure that they're producing correct calculations.
 

How can I adjust forecasting windows and set
forecasting options?  
You can adjust the monthly forecast submission windows the application generated, change the criteria for including
opportunities in forecasts, and set other forecasting options.

After you navigate to the Select Forecasting page, you can:

• Adjust the forecast submission windows.

• Set forecasting criteria.

• Specify the granularity of product adjustments or disable adjustment by product entirely.

• Change the chart on the landing page and turn on adjustment notes.

Navigate to the Select Forecasting Options Page
Open the task Select Forecasting Options from the Setup and Maintenance work area:

• Offering: Sales

• Functional Area: Sales Forecasting

• Task: Select Forecasting Options
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Adjust the Forecast Submission Windows
The application generates the monthly forecast submission windows using the parameters specified in the Scheduled
Forecasts section.

1. Review and adjust the monthly forecast submission windows the application generated in the Scheduled
Forecasts section of the page. Each window starts on the Territory Freeze Date and ends on the Due Date.

2. If you want to specify a different set of forecasting periods or want to forecast more than one quarter at a time,
you can enter different parameters in the Forecast Period Parameters section. You must then regenerate the
scheduled forecasts and submission windows by clicking Submit. Here's an explanation of the fields in this
section:

Field Explanation Provided and Suggested Values

Forecast Period
 

Typically a quarter. Each forecast includes
only those opportunities set to close in the
forecast period.
 

Quarter
 

Adjustment Period
 

This read-only field displays the type of
period you selected when you set up your
accounting calendar. Typically, this is a
month.
 

You can't edit this field.
 

Forecast Frequency
 

Enter the number of submission windows
you want to generate for each forecast
period.
 

Because you are holding a forecasting call
each month and there are three months in
each quarter, the value is 3.
 

First Forecast Due Date
 

The date you want the first submission
window to end relative to the forecast
period. The application takes the forecast
snapshot at the end of the day.
 

The First Forecast Due Date has the default
value of 31 and the After the forecast
period start date option is selected. These
settings create the first forecast submission
window, which ends on the last day of the
first month in each quarter.
 
The application generates the subsequent
submission windows based on the number
of days you enter here and in the Territory
Freeze Date field.
 

Territory Freeze Date
 

The number of days before the end date
when you want the submission window to
start.
 
Any sales territory changes after this
freeze date are ignored and applied only to
subsequent forecasting windows.
 

For the forecast submission windows to
start at the beginning of each month, the
number provided is 31.
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Field Explanation Provided and Suggested Values

Number of Concurrent Forecasts
 

Specified how many quarters you can
submit forecast for at the same time.
 

The default value is 1, so by default, you can
forecast only one quarter at a time.
 
Entering a 2 or a 3, makes it possible for you
to submit and adjust forecasts for two or
three quarters every month.
 

Number of Scheduled Periods
 

The number of forecast periods you want to
view.
 
Managers can only adjust the forecast for
the current period during the submission
windows you generated, but you can view
the forecasts for subsequent periods.
 

The number of forecast periods is set to 4
(four quarters) for the whole year. You can
change the number of forecast periods.
 

3. If you modified forecast period options, then click Submit.

The application runs a process to regenerate the forecasting periods and updates your forecasts. The Select
Forecasting Options page is unavailable until the processes completes. When the process completes, the
generated submission windows appear in the Scheduled Forecasts region.

4. Click Submit when you are done.
5. The application automatically generates new submission windows at the end of each quarter. You must

continue to manually adjust these windows as they are generated.

Set Forecasting Criteria
The application includes in a quarterly forecast any opportunities that close within the quarter and match the forecast
criteria you set in this section.

1. By default, the application includes opportunities with a win probability greater than or equal to 70 percent. You
can change the probability to include or exclude more opportunities. It's a good idea to specify a probability
that matches the default probability of the appropriate sales stage in your sales method.

Note:  By default, the win probability is set at the opportunity level. To forecast at the level of individual
revenue lines, you can expose the win probabilities for the lines in the Edit Opportunity page using
Application Composer.

2. Selecting the Enable Forecast Criteria Override option makes it possible for salespeople or their managers to
include or exclude an opportunity from a forecast while editing regardless of its win probability. If you select the
option, then salespeople can make a selection from the Include in Forecast list while editing an opportunity.

3. Select the Enable nonrevenue forecasting option if you want to generate separate forecasts for overlay
territories.
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Specify the Granularity of Product Adjustments or Disable Adjustment by
Product Entirely
By default, sales managers see the Products tab on the Forecasts page and can adjust forecasts by product. You can
make these changes:

• Specify number of sales catalog levels sales managers can adjust in the Product Hierarchy Depth field. By
default, managers can adjust product groups up to two levels below the catalog root.

• Hide the Products tab and disable adjustments by product entirely, by deselecting the Enable Product Totals
option.

Change the Chart on the Landing Page and Turn on Adjustment Notes
The Forecasts landing page displays a Forecast Overview chart that compares your forecast with won revenue and
open pipeline. It also displays a second bar chart that shows your forecast by time periods. You can replace the second
chart with a chart comparing the forecast and quotas. You can also enable managers to add notes about their forecast
adjustments.

• To display the forecast to quota comparison chart instead of the forecast by time periods bar chart, make these
selections:

◦ In the Metrics section of the Select Forecasting Options page, select the Quota option.

◦ In the Additional settings section, deselect the Enable Forecast Trend Graph option.

• If you want to enable sales managers to add notes when they adjust forecasts, select the Enable Adjustment
Notes option in the Additional Settings section. Sales managers can add adjustment notes for each forecast
item. They can also create and edit a single adjustment note for summary territory adjustments or a note for
summary product adjustments.

How can I display workflow notifications for Assignment
Manager batch process jobs?  
You can display object workflow notifications for assignment manager batch jobs to alert you of job completions for
your specified assignment manager objects.

Change the Suppress Events for Assignment Processing in Batch Mode (ORA_MOW_ASGN_SUPRESS_EDN_EVENTS)
profile option value to N at both the site and product levels for your selected sales objects. This profile option applies
only to email notifications that are sent as part of Assignment Manager workflow tasks. Bell notifications aren't affected.
The current value is set to Y which hides all batch assignment process workflow notifications.

You can choose to turn on or off this profile option at the product level. For example, you might want to have workflow
notifications for all Opportunity batch assignment jobs but want to hide all notification for batch Account assignment
jobs. Note that the workflow notifications can't be suppressed if the assignment is processed using the Run Assignment
option from the UI.
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What do I need to know about changing recipient
territories?  
When you create a recipient territory, you use dimensional overrides to make changes to the proposed territory.

You can also make changes to recipient territories in a proposal at a later time. To end the inheritance relationship,
change the source territory field to none.

Use Scheduled Processes to run the Update Inheritance Recipients process to update all recipient territories. This
includes your changes and any inherited definitions from source territories. You can select a source territory to update,
or leave that parameter blank to run all territories. The Maximum Number of Territories in Proposal parameter is set to
0 for best performance. This is important if you have a large number of territories or complex territory definitions. If
you want to use proposals to update recipients, you can specify the maximum number of territories per proposal. The
maximum you can enter is 500. This process can also be scheduled to run periodically.

What's the maximum number of opportunity revenue
lines for one opportunity?  
The maximum number of Opportunity revenue lines is 500.

How do I troubleshoot user access issues?  
Troubleshoot data access issues for users using the access explorer.

On the Explore page, you can view all the access group rules and data security policies that affect a user's ability to view
an object record and see whether or not each rule or policy has been granted to the user. You can use this information
to find answers to questions such as these:

• What access policy do I have to grant to give the user access to a specific record?

• Which granted rule do I have to remove from the user so that the user can no longer access a record?

Note:  The Explore UI shows the data access users receive through the Oracle CX roles they’re assigned. It doesn’t
show users access to object records provided by non-CX roles, such as Oracle HCM roles, that they might also be
provisioned with.

To discover why there are issues with a user's access to a specific object record, you need to know:

• The user name of the user.

• The name of the object.

• The Public Unique Identifier (PUID) of the record.
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For information on how to find the PUID of a record, see the topic Display Public Unique Identifiers for Object
Records.

Note:  Some objects don't support PUIDs. You can't investigate a user's access to a specific record for these
objects.

Use these steps to review all the rules and policies that affect a user's access to a specific object record.

1. On the Sales and Service Access Management page, click Explore Access.
2. On the Explore page, select the name of a user in the User Name field.
3. Select an object in the Object field.
4. Enter the PUID of the relevant record in the Public Unique Identifier field.

The Public Unique Identifier field is unavailable if the object doesn't support public unique identifiers.
5. Click the Explore button.

By default, all the rules and data security polices defined for the object that grant access to the record are listed
in the Access Groups table and the Data Security Policies table respectively. Review the information in the
Status column of each table to see which of these rules and policies the user is granted.

Tip:  You can display additional data for each rule or policy by selecting options from the View menu of each
table.

6. Select the information you're interested in viewing in each table.

You can display different views of the user's access to the object record by changing the selections in the filters
available for each table.

For example, if a user can't access the record, it might be because the user isn't granted access to the record,
or because the user is granted access but the relevant rule or policy is inactive, or because the relevant data
security policy is future dated. Select these filter options to figure out the cause of the issue.

Rules or Policies to View Filter Options to Select

All the rules or policies that provide
record access that the user isn't
assigned
 

◦ Not granted option from the Show Access list (Access Groups table) or the Show
Conditions list (Data Security Policies table)

◦ Yes option from the Provides Record Access  list

 

All the inactive rules or policies
assigned to the user that provide record
access
 

◦ Granted and inactive option from the Show Access list or the Show Conditions list

◦ Yes option from the Provides Record Access  list

All the future dated policies assigned to
the user that provide record access
 

◦ Granted and future dated option from the Show Conditions list

◦ Yes option from the Provides Record Access  list
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7. In the Access Groups table, you can review the following information for each rule.

Field Description

Status
 

This field can have one of these values:
 

◦ Active. The rule is granted to the user, the rule is active, and the rule is enabled for an
active access group.

◦ Inactive. The rule is granted to the user but the rule is inactive, the access group the rule
is associated with is inactive, or the rule to group association is disabled.

◦ Not granted. The user isn't granted the rule.

Provides Record Access
 

This field indicates if a rule grants access to the record specified in the Public Unique Identifier
field. A check mark indicates that the rule provides record access; if the field is empty, the rule
doesn't provide access to the record.
 
In the Access Groups table, this field can also be set to Not Applicable. This value is displayed
for inactive custom rules. You must activate custom rules to see whether or not they provide
record access.
 

Rule Name and Group Name
 

For rules that are granted to the user, these fields show the name of the rule and the name of
the access group through which the user is assigned the rule. For rules that aren't granted to
the user, only the rule name is shown.
 

Tip:
You can click the Rule Name or Group Name fields to drill down to the edit rule or edit
group pages on the Access Groups UI if you have the Manage Group Access privilege ( ZCA_
MANAGE_GROUP_ACCESS_PRIV). This is useful if, for example, you want to investigate why
a rule is inactive, or if you want to change the activation status of a rule.
 

See the Access Groups chapter for information about editing access groups and rules.
 

Permissions
 

For rules that are granted to the user, you can review the type of access provided by the rule.
 

8. In the Data Security Policies table, you can review the following information for each policy.

Field Description

Status
 

This field can have one of these values:
 

◦ Active. The policy is active and is granted to the user.

◦ Inactive. The policy is granted to the user but is inactive.

◦ Future dated. The policy is granted to the user but the policy Start Date is set to a date in
the future so the policy isn't yet active.

◦ Not granted. The user isn't granted the policy.
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Field Description

Provides Record Access
 

This field indicates if a policy grants access to the record specified in the Public Unique
Identifier field. A check mark indicates that the rule provides record access; if the field is empty,
 the rule doesn't provide access to the record.
 

Role
 

The name of the role or roles that provide the policy. The role name is displayed only for
policies that are granted to the user.
 

Permissions
 

For policies that are granted to the user, you can review the type of access provided by the
policy.
 

You can use the information from the Status  and Provides Record Access fields to figure out what you have to
do to provide a user with record access or to remove record access. But you can't edit data security policies on
the Explore page.

For example, you might find that a policy that provides a sales manager with access to their subordinates
opportunity records is future dated. In this case, note the name of the role providing the policy and edit the
role on the Manage Data Policies page or on the Security Console to change the Start Date of the policy to the
current date.

How do I run the processes that index the legacy CRM
Search?  
You must run two processes to enable work area searches for those work areas that use the legacy CRM search.

Note:  This topic applies only to work areas that use the legacy CRM search. For Sales in the Redwood user experience
and most work areas, including Workspace, you must set up Adaptive Search instead.

Process Name Description Recommended Interval

Synchronize CRM Search Indexes
 

Creates and maintains the search index.
 

Every five minutes
 

Optimize CRM Search Indexes
 

Optimizes the index. (The index can get
fragmented over time.)
 

Weekly
 

These two processes automatically run at the recommended intervals when you use either of the following

• Setup Assistant

Setup Assistant runs these processes without any prompting from you.

• Schedule Work Area Search Processes page
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This Quick Setup page is available in the Sales offering, Sales Foundation functional area. You run both
processes by clicking Submit.

Here's how to run the processes at different intervals:

1. Click Navigator > Tools > Scheduled Processes.
2. On the Schedule Process window, click Schedule New Process.
3. In the Schedule New Process window, make sure the Job option is selected.
4. Enter the name of one of the processes in the Name field and click OK.
5. On the Process Details window, click Advanced.
6. On the Schedule tab, select the Using a schedule option.
7. Select a frequency.
8. Enter an end date in the far future.
9. Click Submit.

How do I monitor Adaptive Search background
processes?  
Adaptive Search requires several background processes to run periodically. You can monitor these processes on the
Monitor UI tab of the Configure Adaptive Search page. For example, you can view the real-time progress of Adaptive
Search indexing jobs.

When you click Publish, a progress bar indicates how much of the indexing job has been processed and what
percentage remains before completion. This feature provides have better visibility on the Publish job progress so that
you can plan your operations accordingly.

Note:  If you update job request parameters after a job is submitted, then the results displayed on the progress bar
might be unreliable.

You also receive email notifications about the status of Publish jobs for Adaptive Search if scheduled jobs haven't
completed within a 12 hour time frame. For example, you're notified about the successful completion of published
processes or receive an alert of failed processes that might be causing issues with data access. Emails are sent to
the user who submitted the last successful publish job, periodic job, or to the user who submitted the first successful
publish job if the scheduler process data isn't already purged. You can also specify more email addresses when you
schedule the publish job.

Note:  If you want, you can reschedule all Adaptive Search jobs to run under a different user. You just need to cancel
the parent job for all the jobs and sign in with the new user for the scheduler process jobs and reschedule them.

The Monitor UI tab includes sub tabs where you can monitor the processes. The following table describes the processes,
provides a recommended run schedule, and explains what actions you can take on each tab.

Note:  Oracle recommends that you perform a full publish each time you do a production to test (P2T) environment
refresh. When the full publish job completes successfully, your Adaptive Search configuration becomes the latest
active meta model. This ensures that users have the latest features and enhancements and aren't limited in
functionality due to an older version of an active meta model being in use.  The recommended schedule for some
processes might vary according to your business requirements, existing run assignments, and data load schedules.
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Process and Tab Name Process Description Recommended Schedule Available Actions

Periodic Refresh
 

Indexing enables Adaptive Search
to find records based on keyword
search terms entered, search
filters, saved search criteria, and
other search criteria. Periodic
Refresh enables Adaptive Search
to search for imported records and
records that have gone through
the mass update process. While
records you create and update in
the UI are automatically indexed
and made searchable within
seconds, imported records or
records updated by background
processes aren't available for
search until the process completes.
 

Note:
The Publish process should be
completed before running the
Periodic refresh.
 

Every hour
 

• Change the process
frequency by clicking
Schedule Periodic Refresh.

• Start the process immediately
by clicking Start Process.

• Cancel Process cancels the
instance of the process you
selected.

Publish
 

Publishes the Adaptive Search
configuration you set up in the
Quick Setup and Advanced Setup
UIs.
 

Note:
For CLOB (Character Large
Object) fields, only the first
4000 characters are indexed.
 
New CLOB fields are no longer
supported in Workspace.
 

Note:
Formula fields can't be
configured.
 
Also generated ID fields aren't
available to enable for any
objects in Adaptive Search.
 
For example, you can't search on
ID fields in Workspace such as
Party ID, SR ID, Opty ID, Record
ID for custom object, and so on.
Such fields aren't searchable and
can't be indexed by design.
 

You must click Publish to run the
process each time you:

• Make changes on the Setup
tab.

• Perform a production to test
(P2T) environment refresh

 
Here are the different phases you
can monitor from the progress bar:

• Preparing for Indexing

• Indexing in Progress

• Updating References

• Updating Latest Changes

• Activating Indexes

• Completed

 
Your changes become effective
when the process completes.
 

You can monitor the progress
of the publish process. Your
configuration is active when the
process completes successfully.
 
If the process fails to complete
successfully, contact your help
desk.
 

Maintenance
 

Backs up the current active meta
model, removes older snapshots,
 and cleans up any search server
index or snapshots that aren't

Daily
 

You can restore the current active
Adaptive Search configuration by
clicking Restore from Backup.
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Process and Tab Name Process Description Recommended Schedule Available Actions

associated with any workflow state
of the meta model.
 

Note:
Restore from Backup is
disabled if a meta model is
being published.
 

This action clears any saved
changes that aren't yet published.
 
To restore the last active Adaptive
Search configuration version, click
Revert to Previous Version.
 
Any other actions should be taken
by your help desk.
 

Territory and Resource Hierarchy
Refresh
 

Updates the index with sales
territory and resource hierarchy
changes.
 

Weekly
 

• Change the process
frequency by clicking
Schedule Periodic Refresh.

• Start the process immediately
by clicking Start Process.

• Cancel Process cancels the
instance of the process you
selected.

Update Aggregates
 

Updates the index with total
changes.
 

Weekly or as required.
 

• Change the process
frequency by clicking
Schedule Periodic Refresh.

• Start the process immediately
by clicking Start Process.

• Cancel Process cancels the
instance of the process you
selected.

Synchronize Access Rules Data
 

Updates access group object
sharing rules.
 

Automatically runs when a job,
 Perform Object Sharing Rule
Assignment Processing, or job set
is submitted for a batch of access
group object sharing rules for all
the available assignment objects.
 

Depending on your requirements,
 you can change the process
frequency by clicking Schedule
Periodic Refresh. You can also
manually Start or Cancel the
process at any time.
 

Note:  The Publish and Periodic Refresh indexing processes include records based on the following condition:
LAST_UPDATE_DATE is greater than (CURRENT DATE - MAX_AGE_IN_DAYS) days.

For example, in the case of opportunity records, this means that only those opportunities that were created and
updated within the last 365 days are indexed and available for viewing in Workspace.If you want to view records older
than 365 days for your specific object, you need to update the MAX_AGE_IN_DAYS entity to a greater number than
365.

How To Change Periodic Refresh Frequency
The default periodic refresh process runs every hour. However, you might want to change the frequency to run every 15
minutes so that any new records quickly appear in your Workspace saved searches.

Here's how to change the periodic refresh frequency.

1. Click Navigator  > My Enterprise  >  Setup and Maintenance.
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2. In the Setup and Maintenance work area, go to:

◦ Offering: Sales

◦ Functional Area: Sales Foundation

◦ Task: Configure Adaptive Search

3. From the Configure Adaptive Search page, click Monitor >  Periodic refresh.
4. Select the job row which is currently running hourly and has a status of Wait.
5. Click Schedule Periodic Refresh.
6. Click Change Frequency and adjust the schedule to run every 15 minutes or per your specific requirement.

Adaptive Search Meta Model Types
Adaptive search saves the published configuration so you can restore the behavior you had before. Or you can restore
to the seeded one. Meta models encode the information that's necessary to index the entities that are searched.
Adaptive Search supports the following meta models, each with a distinct workflow state.

• Seeded Meta Model

A ready to use model that's shipped to customers. You can click Restore Defaults to revert to the predefined
meta model.

• Sandbox Meta Model

A modified version of the Adaptive Search configuration is stored and saved when you make changes to the
configuration and click Save or Save and Close.

• Being Published Meta Model

When the configuration changes are saved and you click Publish, the meta model is in a state of being
published.

• Active Meta Model

When the full publish job completes successfully, it becomes the active meta model.

• Archived Meta Model

The previous successful version of the configuration becomes the archived meta model. There's only one
archived version available.

Index Date Ranges for Adaptive Search Objects
Adaptive Search objects are categorized into transactional objects and reference objects. Transactional objects store
Sales and Fusion Service transactions while reference objects don't. The following sections outline how the search
records for both types of objects are indexed.

Transactional Objects
When indexing transactional object search records for the first time, Adaptive Search only index records that have the
"Last Updated Date" within the last 365 days. Thereafter, records that are changed or created from transactional objects
are incrementally added to the index. Here's a list of the Adaptive Search transactional objects:

• Activities

• Campaigns
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• Case

• Deal Registration

• HR Help Desk Request

• Internal Service Request

• Leads

• Opportunities

• Quotes and Orders

• Quote and Order Lines

• Revenue Lines

• Service Requests

• Work Order

Note:  Adaptive Search transactional object details are updated asynchronously during Near Real-time Indexing. The
asynchronous update happens after the objects in the above list are refreshed.

See the following transactional object examples of what content is indexed for a specific action on a particular date for
Opportunity records:

Date Action Index Content

Dec 15, 2018
 

Publish job is run
 

Records, which have Last Updated Date > Dec
15, 2017
 

Jan 10, 2019
 

New Opportunity created with name Green
Servers
 

All previously indexed records plus the new
opportunity record (Green Servers) created
 

Jan 20, 2019
 

20 new opportunities created by an import job
 

All previously indexed records plus the 20 new
records created (after the periodic refresh job
completes)
 

Reference Objects
All records from the reference objects are indexed. Custom objects are treated as reference objects and hence all of their
records are indexed. Here's a list of the Adaptive Search Reference objects:

• All custom objects

• Account

• Asset

• Contact

• Installed Base Asset

• Partner

• Partner Contact

• Product
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• Product Group

• Territory

How can I defer replicating records during reindexing?  
You can configure how Adaptive Search indexes custom search records using the Advanced subtab from the
Parameters tab available in the Adaptive Search setup page. For example, for custom objects, you might want to defer
re-indexing of previously created records when running a partial publish indexing process.

Note:  You must have the ZCA_ADAPTIVE_SEARCH_EDIT_PARAMS_PRIV privilege to view and access the Advanced
parameters of Adaptive Search. Once you are assigned this privilege, you can also view other parameters such as

You can choose to change current and default advanced parameter values if you have the required privilege. Here's how
to edit the Defer Replica Creation During Reindexing Adaptive Search parameters for your custom business object.

1. Click Navigator  > My Enterprise  >  Setup and Maintenance.
2. In the Setup and Maintenance work area, go to:

◦ Offering: Sales

◦ Functional Area: Sales Foundation

◦ Task: Configure Adaptive Search

3. On the Configure Adaptive Search page, click the Parameters  > Advanced tab.
4. Highlight the Defer Replica Creation During Reindexing that you want to change and click Edit. This warning

is displayed.

You're about to change parameters that control how Adaptive Search works. 
Changes should only be carried out by search setup experts. Do you want to 
continue?

5. Click Yes.
6. In the Current Value field, change the value from No (default value) to Yes and click Save and Close.

The next time you perform a partial publish, only a reindexing of the custom object occurs and takes less time to
complete.

What are opportunities?  
Opportunities allow organizations to support the full sales process, from leads, to opportunities, to sales. Within
opportunities, you can capture information related to an opportunity, such as customer (account) and the products to
be sold.

Guided by the sales method tailored to each sales situation, the opportunity sales team works to close the deal.
Your sales organization can create different sales methods for different sales situations. Each sales method can take
salespeople through different sales stages and steps. See the related topic for more information about sales methods
and stages.
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In addition, administrators can specify a different default win probability percentage for each sales stage. The sales
team closes the opportunity when the deal is won or lost. If you lose the deal, the sales organization may require you to
enter competitors and the reasons why the deal was lost.

Here are just some of the data that sales teams can capture for an opportunity:

• Accounts: You can associate an account (for example, a customer or prospect) with an opportunity.

• Opportunity owner: The person who creates an opportunity is automatically assigned ownership. You can
change owner if needed.

• Contacts: You can associate contacts with an opportunity. In addition, you can specify a contact's role, affinity,
and influence level on an opportunity. A single contact can be marked as primary.

• Currency: The application supports multiple currencies at both the opportunity header and revenue-line levels.

• Budget: Indicates whether the opportunity revenue amount has been budgeted by the customer, as well as the
date that the budget was made available.

• Revenue: You can add products or product groups and amounts to an opportunity, if your administrator has
enabled the sales catalog.

• Competitors and partners: You can associate partners and competitors with opportunities.

When salespeople access opportunities, they can quickly view the sales pipeline at a glance from the UI. They can
also view Deal Registrations associated with their opportunities by simply entering the smart action Show Deal
Registrations from the Action Bar from the Opportunity page.

See the Overview of Opportunity Sales Methods and Stages topic in the Implementation Reference guide for
information about sales methods and stages.

What are some common opportunity forecasting
scenarios?  
Your sales organization can forecast opportunities by sales territory for each forecasting period and managers can
adjust those forecasts as required. The forecasting feature is available in the Classic user experience only. There are two
broad forecasting scenarios that require different setup:

• Scenario 1: Forecasting by Opportunity Owner

• Scenario 2: Forecasting When You Use Sales Territories to Assign Opportunities

Scenario 1: Forecasting by Opportunity Owner
Individual salespeople own their opportunities and forecast them. The forecasts are passed up the management
hierarchy for adjustment and approval. Your organization doesn't use geography, product, industry, or other territory
dimensions to assign salespeople to opportunities. If your sales process meets these criteria, then setup is as simple as
selecting Enable Sales Forecasting in Setup Assistant. The application sets up everything you need:

• Sets up a sales territory hierarchy that mirrors your sales resource hierarchy, with the individual salespeople as
territory owners.

• Assigns opportunities to the territory of their owners. This means that opportunity revenue is automatically
included in the forecasts of the opportunity owner.
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When new accounts or opportunities come in, managers assign ownership to one of their salespeople and the
application automatically includes those accounts and opportunities in each owner's territory.

• Keeps the sales territories in sync if your resource hierarchy changes.

If you do update the sales hierarchy and want to see that the changes reflected in your forecasts right away,
then you must run the Refresh Territories from Resources process. The process is set to automatically run
before each forecasting window freeze.

• Rolls up forecasts up the sales resource hierarchy.

• Enables quarterly forecasts.

• Creates monthly forecast submission windows, so the sales organization can adjust forecasts and pass them up
the management chain. All you have to do is adjust the forecast submission window dates.

• Makes it possible for your sales organization to forecast product totals.

If you enable forecasting by opportunity owner in Setup Assistant, then each resource can only be in one territory (their
own) and you can't use sales territories to assign opportunities by geography, product, industry, or any other dimension.

Scenario 2: Forecasting When You Use Sales Territories to Assign
Opportunities
You assign opportunities to sales territories by geography, product, industry, and other dimensions. You may have
multiple salespeople from different parts of the sales organization involved in the sale. The opportunity owner is not
necessarily the sole person forecasting the revenue. If your implementation meets any of these criteria, then you must
set up sales territories and enable assignment using the Set Forecasting Options task. You can't use Setup Assistant.

How can I act on multiple records at the same time?  
You can take actions on multiple records at the same time on any of the list pages of your Sales application. What
actions you can take depends on the records you select and the permissions you have. For example, select a group of
sales leads from the list, and you may be able to qualify them, convert them, or delete them all. If some of the leads you
selected are already converted, however, the convert action won't be available. If you don't have delete permission, you
won't be able to mass delete the leads. You can make mass updates in the list pages in different interfaces, including the
Redwood user experience (Redwood Sales and Next Gen Sales), the Classic user experience, and in Workspace.

In the Classic User Experience, you select the records, right-click and select the action you want to take from the menu.
In the Redwood user experience, you select the records and click either the Update or the Actions button.

Note:  By default, the Redwood user experience list pages have only a limited number of mass actions available. For
example, only the Qualify mass action is available for leads. The sales administrator must enable the others in the
Smart Actions work area of Application Composer. The smart action must include the following values:

• Mass Action: On

• Application: Sales

• UI Availability: List page
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Related Topics
• How do I enable mass update of records?

How do I use dynamic and nested dynamic tabs?  
If you have the required privileges and role, then you can use dynamic and nested tabs to quickly and easily navigate
across and between grouped records without losing context. Under each open top-level dynamic tab, you can open
objects as nested tabs.

To open an associated record as a nested tab, click the object link. When you open a record in a nested tab, that record
automatically becomes the active tab. You can manage objects such as Service Requests, Accounts, Contacts, Assets,
Activities, Leads, Opportunities, Campaigns, Territories, and Custom Objects, with each supporting nested dynamic
tabs.

Note:  You can only use dynamic tabs in Workspace. Dynamic tabs are not supported in the individual work areas.

The dynamic tab and nested dynamic tab feature is already predefined for users with job roles such as Customer Service
Representative and Customer Service Manager job roles. Other users who want to open objects in dynamic and nested
dynamic tabs must request their administrator to grant them a custom role with the required privileges assigned.

For example, the Service Request object enables service users to interact with multiple records simultaneously through
top-level dynamic tabs to save time accessing related information about a service interaction. The primary tabs display
instances of objects such as SRs, Queues, Contacts, and Accounts. Other workspace objects not listed, such as Partner
Accounts and Partner Contacts, open as modal windows.

Work with Dynamic Tabs and Nested Dynamic Tabs
When you have an open record and then open another record associated with the initial record, the record is shown as a
nested tab of the primary record. For example, open an Account record as a top-level dynamic tab. Drill into other linked
objects associated with that Account, such as the Primary Contact or Service Request. These objects open in a nested
dynamic tab. The maximum number of dynamic tabs that you can open at one time is 10.

You can use the nested dynamic tabs to manage multiple related objects without confusion. The nested tabs enable
better support for multiple interaction agents such as chat agents, and help increase agent productivity. The maximum
number of nested tabs that you can open at one time is 5.

The nested dynamic tabs contain these buttons:

• Save: Saves any data changes and remain on the same page.

• Save and Close: Saves any data changes and closes the tab. This button displays on the first nested tab only if
there are no other nested tabs opened. As soon as another nested tab is opened, this button is hidden.

• Cancel: Discards any data changes and closes the tab. You're notified if there are unsaved changes.

You can close the top-level dynamic tab and all the nested tabs at one time by clicking the X icon on the top-level
dynamic tab name. If you have unsaved changes in a nested tab and move away from the tab, a blue dot appears next
to the tab label. A message also appears when you hover over the label to indicate the unsaved status. When you try to
close a dynamic tab with unsaved changes in its nested tabs, a warning message appears.
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Note:  If you choose to use dynamic tabs, then record-level navigation won't be possible. That means that the
Previous and Next buttons on the record details page won't be available for navigating lists of records for Account,
Contact, Lead, Opportunity, Activity, Campaign, Territory, and custom objects through the Workspace UI.

Why can't users edit contacts even when they're the
owner?  
The users might not be synced with the Oracle Applications security database tables. Here's how to fix the issue:

1. Run these scheduled processes:

◦ Synchronize User GUID. This process resolves invalid and missing user global unique identifiers by
synchronizing them.

◦ Import User and Role Application Security Data. This process imports user and role data from LDAP and
stores it in the Oracle Applications security tables.

2. Next, navigate to Tools > Sales and Service Access Management.
3. Navigate to Object Sharing and select the Contact object from the drop-down list.
4. For the access group that the users are in, set Access Level  to Full.
5. In the Object Sharing Rules page, select Actions and publish the access group rules.
6. Navigate to the Monitor tab and run the scheduled process, Perform Object Sharing Rule Assignment

Processing.

What's Digital Sales performance?  
Sales managers can improve digital sales performance by creating contests and by setting team goals to promote and
drive digital sales performance.

Digital Sales teams can use contest leader boards to help create a healthy competitive spirit among members of their
sales organization. They can create goals to ensure the team focuses on key performance indicators. Salespeople
can then track their individual progress and take actions to ensure they meet their targets. Sales managers can view,
compare, and benchmark individual performances to help coach and motivate the sales activity of the team.

For example, in an effort to boost sales of a product recently released into the market, a sales manager creates a
contest. The contest is for a defined period of time and is aimed at increasing the number of calls the sales team makes
to potential customers. Participants, in competition mode, try to maximize the number of customer calls they make.

The sales team uses the Performance dashboard to monitor the contest time remaining, and their scores and targets,
along with some statistical data. Let's say one of your sales representatives has 15 hours left in the contest and currently
ranks third on the contest with five calls made. He can compare his score with the first-ranked participant (who has
made eight calls so far) and try to better it in the remaining time. By monitoring the Performance dashboard, users can
monitor the time remaining, their score and target, along with some statistical data.

You can activate and deactivate seeded key performance indicators (KPIs) or view, create, edit and delete custom
KPIs to use in contests and goals. The Performance dashboard displays all performance-related cards for contest and
goals where the user is a participant or is the owner. The management hierarchy of each participant can also see the
contests and goals. Sales managers can view their team's goal card as well as their own individual goal card. Sales
representatives can view their own goal cards from the Performance page.
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For example, you can click one of the following four tabs (see callout 1):

• All: Displays all active, scheduled, and ended contests and goals

• Active: Displays only contests and goals that are currently active

• Scheduled: Displays contests and goals that are scheduled but aren't active yet

• Ended: Displays all contests and goals that have ended and are no longer active

As a sales manager, you can perform these tasks from the dashboard (see callout 2):

• Create Contest

Create a contest to help create a healthy competitive spirit among members of their sales organization and
monitor a contest in progress.
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• Create Goal

Create and manage goals to ensure the team focuses on key performance indicators and review and monitor
the progress of each individual.

• Manage KPI

Manage your KPIs to support predefined and custom key performance indicator definitions and goals to
generate contests among goal participants.

You can see at a glance the time remaining for the contest or goal as well as the overall progress status (callout 3). You
can also view details of all goals, including team goals, and view a brief synopsis of how participants are performing
against their targets. In a Team Goal card, the values are calculated as the sum of KPI values achieved by all team
members including the manager and the following labels indicate the team's progress for the goal:

• Ahead (callout 2)

• Behind (callout 1)

• Completed (callout 3)

• On Track

• Ended which means a goal period has ended without the goal target being completed.

How do I create sales restricted users?  
You can create sales application users who have extensive privileges to view sales data, but limited privileges to create,
update, or delete that data, by assigning users the Sales Restricted User job role.

For example, you might want to assign the Sales Restricted User job role to accounting or legal users, to seasonal or
administrative users, or to users who are assigned an Essential User license. The Essential User license provides a user
with a read-only subscription to the cloud service.

43



Oracle Fusion Cloud Sales Automation
Sales Questions and Answers

Chapter 1
Sales Questions and Answers

Use these steps to create a sales restricted user.

1. Create the user who's to have restricted access to the application.
For information about this task, see the topic, How do I create application users?.

2. When creating the user, specify these values.

Field Value

Person Type
 

Employee
 

Resource Role
 

Sales Restricted User
 

3. In the Roles region, click Autoprovision Roles.
The user is automatically assigned the following roles:

◦ Sales Restricted User job role

◦ Resource abstract role

◦ Employee abstract role
A predefined rule automatically assigns the Employee abstract role to all active users who are created as
employees.

How do I remove unneeded privileges from my custom
employee abstract role?  
By default, some privileges are assigned to the Employee abstract role that aren’t used by Sales users. You can delete
these privileges from the custom employee role you previously created.

To delete privileges that are assigned directly to the custom employee role, edit the custom employee role you created.
If a privilege is inherited from a duty in the custom employee role hierarchy, you've to edit the custom duty role to
remove the privilege.

1. On the Roles tab of the Security Console, search for and select the custom employee role you’ve just created, for
example, Employee Custom Sales.

2. In the search results, select the Edit Role option from the Actions menu of the Employee Custom Sales role.
3. Click Next.

On the Edit Role: Function Security Policies page, all the privileges assigned directly to the Employee Custom Sales
role are listed.

4. To display the privileges the custom employee role inherits from duty roles in its hierarchy, scroll to the end of the
page, then click Load Inherited Policies.
All the privileges the custom employee role has are now listed:

◦ If the Inherited from Role column is blank for a privilege, the privilege is assigned directly to the employee
custom role and can be deleted on this page.
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◦ If the Inherited from Role column isn’t blank, you have to edit the custom duty role listed to delete a
privilege from it.

5. Delete the privileges that are assigned directly to the Employee Custom Sales role that aren’t required for sales users.
a. Delete the following privileges by selecting each privilege in turn, then clicking Delete.

- Manage Reputation Scores (HWR_REPUTATION_EE_PRIV)
- Manage Social Roles (HWR_SOCIAL_ROLES_EE_PRIV)

b. Click Yes in the Warning dialog box to confirm the deletion.
c. Click the Summary train stop.
d. On the Edit Role: Summary page, verify both privileges you deleted are listed as Removed in the Function

Security Policies row, click Save and Close, then click OK.
6. Now delete the excess privileges that are inherited by the Employee Custom Sales role from duty roles in its

hierarchy.
a. On the Roles tab of the Security Console, edit each duty role shown in the table and remove the privilege

listed.

Note:  The default prefix and suffix for copied roles is specified on the Roles subtab of the Security
Console Administration tab. By default, the role-name suffix is Custom but this might differ in your
environment.

Privilege to Remove Custom Duty Role to Edit

Manage Expense Report Expense Entry Custom

Create Performance Document by
Worker

Performance Management Worker Custom

Provide Performance Evaluation
Feedback

Performance Management Worker Custom

View Performance Information on
Worker Dashboard

Performance Management Worker Custom

Access Time Work Area Time and Labor Worker Custom

Manage Requisition Requisition Self Service User Custom

Access Learning Common
Components

Access Learning Common Components Custom

b. Once you’ve deleted each privilege, review your changes to the custom duty role on the Edit Role Summary
page and save them.

7. Finally, edit the Employee Custom Sales role on the Security Console.
Navigate to the Function Security Policies page and verify that all the excess privileges, both those assigned directly
to the role and those inherited from other roles in the hierarchy, have been removed.
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What's the lead-to-opportunity attribute mapping?  
The lead-to-opportunity attribute mapping is a predefined one-to-one mapping of the attributes between the lead
and opportunity applications. When converting leads to opportunities, lead attributes, such as sales account, products,
revenue amount, lead contacts, and other attributes, are mapped to the newly created opportunity.

You convert a lead to an opportunity when the lead is qualified and is ready for further processing along the sales cycle.
The following sections outline:

• General lead attributes mapped to opportunities

• Partner lead-specific attributes mapped to opportunities

• Lead contact attributes mapped to opportunity contact attributes

• Lead product attributes mapped to opportunity revenue line attributes

• Profile options that specify the mapping file name for user-defined mapping files

General Lead Attributes Mapped to Opportunities
This table lists the general lead attributes that are mapped to the corresponding opportunity attributes:

General Lead Attribute Opportunity Attribute

Budget Amount
 

Budget Amount
 

Budget Status
 

Budget check box
 

Customer
 

Target Party
 

Currency
 

Currency
 

Description
 

Description
 

Estimated Close Date
 

Estimated Close Date
 

Expiration Date
 

Expiration Date
 

Lead Number
 

Lead Number
 

Name
 
This attribute value is the Lead Name and
the current date and time, which generates
a unique opportunity name.
 

Name
 

Owner
 

Owner of opportunity
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General Lead Attribute Opportunity Attribute

Indicates the user who starts the
conversion.
 

Primary Contact
 

Key Contact
 

Source Code
 
If a campaign or any other source creates
a lead in which source code is used, then
this attribute value is mapped.
 

Source
 

Partner Lead Attributes Mapped to Opportunities
This table lists the partner lead attributes that are mapped to the corresponding opportunity attributes:

Partner Lead Attribute Opportunity Attribute

Deal Approved By
 
For direct leads, this attribute is set to the
user who starts the conversion.
 

Owner of opportunity
 

Deal Approved By Resource Organization
 

Resource Organization
 

Partner
 

Partner
 

Partner Type
 

Partner Type
 

Partner Program
 

Partner Program
 

Registration Type
 

Registration Type
 

Registration Number
 

Registration Number
 

Lead Contact Attributes Mapped to Opportunity Contact Attributes
To map lead contact attributes to opportunity contact attributes, the following relationships must apply between the
contact and the customer:

• The relationship end date is later than the current date.

• The relationship start date is earlier than the current date.

• The relationship status is active.

This table lists the lead contacts attributes that are mapped to the corresponding opportunity contacts attributes:
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Lead Contact Attribute Opportunity Contact Attribute

Contact
 

Contact
 

Contact Role
 

Contact Role
 

Primary
 

Primary
 

Lead Product Attributes Mapped to Opportunity Revenue Line Attributes
This table lists the lead product attributes that are mapped to the corresponding opportunity revenue line attributes:

Lead Product Attribute Opportunity Revenue Line Attribute

Amount
 

Revenue Amount
 

Approver
 

Resource Party
 

Currency
 

Currency for the Revenue Amount
 

Inventory Item
 

Inventory Item
 

Organization
 

Inventory Organization
 

Product Group
 

Product Group
 

Quantity
 

Quantity
 

Unit of Measure
 

Unit of Measure
 

Unit Price
 

Unit Price
 

Profile Options for Mapping File Names
As an administrator, you can specify your own mapping file name to use for mapping objects and attributes during
the lead-to-opportunity conversion process. For example, you can create user-defined lead attributes in Application
Composer, Copy Maps, and can then add these attributes to the existing ready-to-use mapping files. You must save
the user-defined mapping file using a unique file name and then specify the saved mapping file name in one of these
profile options:

• Use the Direct Lead to Opportunity Mapping profile option to specify the mapping file name created when a
direct lead is converted to an opportunity.
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• Use the Partner Lead to Opportunity Mapping profile option to specify the mapping file name created when a
partner lead is converted to an opportunity.

How can I define the automatic assignment of Lead team
resources?  
Using a scheduled process, you can automatically assign lead team members and appropriate sales territories to leads.
The scheduled process accepts criteria to determine the batch of leads to be assigned.

During the rule-based assignment phase of the batch process, matching candidates are automatically added to the lead
team. During the territory-based assignment phase of the batch process, territories are automatically added to the lead
territory team.

This example outlines how to set up lead assignment tasks and to schedule the tasks in sequence so that you can
automate the lead resource assignment process.

Scenario
The automotive sector uses geography data and overall lead quality to periodically assign leads to automotive dealers.
You can assign leads automatically by using score and rank criteria before being assigned a resource. Leads are
automatically assigned through the assignment manager feature by associating assignment criteria to assignment
rules. For example, leads are assigned based on the following criteria:

• Lead source

• Geography

• Lead score

• Named accounts, such as the top 20

• Industry

• Products

When partners must engage with customers to ensure a timely sales follow up, set up assignment manager to
automatically assign partner leads to internal channel managers.

Manual Setup Assignment Manager Tasks
You can perform manual setup tasks through the assignment manager UI as follows:

• Define lead distribution rules

• Define partner matching rules

• Define the quality parameters to assign leads for follow-up activities

• Set up lead qualification rules

• Set up lead classification rules to assign leads to specific sales channels

• Set up lead routing rules to route leads to sales resources in a selected sales channel

• Set up lead distribution rules to assign leads to a specific salesperson or a partner sales territory
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Use rule sets if you're assigning leads by rule-based assignment. If the lead requires territory-based assignment only,
then rule sets aren't used. During a lead import, either ranking or scoring is used as the default qualification criteria.
However, if scoring is used to determine the lead rank, then both lead score and lead rank can be used as criteria for
assigning lead resources.

Automatic Assignment Manager Tasks in Batch Mode
To automate assigning lead resources, schedule and sequence these tasks to occur in this order when assignment
manager runs in batch mode:

• Assign leads to a sales channel

• Route leads to sales organizations and sales territories

• Assign leads to individual salespeople or partners

You can also manually assign leads to specific internal or external resources. You can make these selections:

• Job type

• Rule set

• Filtering criteria for selecting lead

What types of assignment rules can I create?  
Assignment rules are created using rule sets, rules, conditions, and actions. The assignment process uses your rules to
evaluate and recommend candidate assignments for specified work objects. This topic provides scenarios to illustrate
the different types of rules you can create.

Note:  When creating an assignment rule that uses a check box field, note that the value of true may be denoted by
"Y" or "Yes" or "T". Ensure the check box is clear if you want to denote a false value.

Create Lead Qualification Rules
In this scenario, you want to create rules to classify leads as qualified if these attributes are set as specified:

• Lead Customer is sales account.

• Lead Product is set to Is Not Blank.

• Lead Score is greater than 150.

To create a rule to classify leads as qualified:

1. In the Setup and Maintenance work area, go to:

◦ Offering: Sales

◦ Functional Area: Leads

◦ Task: Manage Sales Lead Assignment Rules

2. Search for and navigate to the assignment configuration setup task for the relevant object:
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◦ For sales lead and deal assignment, go to the Manage Sales Lead Assignment Rules task. This is the task
used as an example in this topic.

◦ For the Opportunity functional area assignment, select the Manage Opportunity Assignment Manager
Rules task.

3. In the setup task page, select the category for the appropriate assignment flow, in this case Sales Lead
Qualification Rule Category.

4. Click the Add Row icon to create a rule set for the predefined rule category Sales Lead Qualification Rule
Category.

5. Create a rule with the three conditions that match the attribute settings for a lead to be considered a qualified
lead:

◦ Lead Product: Select the lead attribute Primary Product ID. Select the Is Not Blank operator.

◦ Lead Customer: Select the lead attribute Sales Account Indicator, and then select the Equals operator.
Enter the value of Y.

◦ Lead Score: Select the lead attribute Score, and then select the Greater Than operator. Enter the value of
150.

6. In the Actions region, select Qualified from the Return the Candidate Value As Qualified list.

Create Lead Scoring Rules
In this scenario, you want to create a scoring rule to:

• Increase lead scores by 150 if the lead attribute Lead Time Frame is set to 3 months.

• Increase lead scores by 100 if these attributes for leads are set as specified:

◦ Budget Status is Approved

◦ Budget Amount is greater than 500000

To create this scoring rule:

1. Create a rule set for the predefined rule category Sales Lead Scoring Rule Category.
2. Create the first rule with the conditions that match the attribute settings you want a lead to have so that 150 is

added to its score:

◦ Choose the object Sales Lead and attribute Time Frame, and then select the Equals operator. Select 3
months.

◦ Enter the action as Increase the Score by 150.

3. Similarly, create your remaining rule for the budget attributes and action to Increase the Score by 100.

a. Add the first condition: Choose the object Sales Lead and attribute Budget Status, and then select the
Equals operator. Select Approved.

b. Add the second condition: Choose the object Sales Lead and attribute Budget Amount, and then select
the Greater Than operator. Enter 500000.

c. Enter the action as Increase the Score by 100.
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Create Matching Candidate with Scoring Rules
Assign different country specialists to opportunities in some European countries based on the country and the risk level
of the Opportunity. To create matching candidate with scoring rules:

1. Create a rule set for the predefined category Sales Lead Resource Rule Category and select the Use Score 
option, the filter type of All Above Minimum Score, and the minimum score set to 20.

2. Create three rules each with conditions:

a. Create the first rule with these conditions:

- Select the object Opportunity, and then choose the attribute Customer Country. Select the
Equals operator, and then select DE.

- In the rule action, set Increase Score By to 20.
- Select and add the appropriate resource.

b. Create the second rule with these conditions:

- Select the object as Opportunity, and then choose the attribute name Customer Country. Select
the In operator, and then select FR and UK as condition values.

- In the rule action, set Increase Score By to 20.
- Select and add the appropriate resource.

c. Create the third rule with these conditions:

- Select the object Opportunity, choose the attribute name Risk Level. Select the Equals operator,
and then select the value High.

- In the rule action, set Increase Score By to 20.
- Select and add the appropriate resource.

Related Topics
• How do I update existing setup data?

Can I sort opportunity searches by the last update date?  
Yes, you can sort the records returned from your opportunity search by last updated date in descending order. Request
your administrator to change the Opportunity List Sort profile option from N to Y. You can then quickly review and
action recently updated opportunities.

How do I switch to Work Areas powered by Adaptive
Search  
Here's how existing customers can switch from the legacy work areas to the new work areas powered by Adaptive
Search. No action is required for new customers who get the new work areas by default.
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You must complete these steps:

• Use the Opt In UI to enable this feature.

• Make sure that the business objects for the work areas are indexed.

• You select the Display Object in Workspace check box on the Configure UI tab in the Configure Adaptive
Search page.

See the Configure UI section of "A Quick Rundown of the Adaptive Search Setup UI" topic for more information.

Note:  Salespeople granted the View Fuse List as Default List Pages (ZCA_VIEW_FUSE_LIST_PAGES) privilege, are
taken to the legacy work areas that use CRM Search technology instead of the new ones.

Opt in to Enable Work Areas Powered by Adaptive Search
Here's how existing customers can enable navigation to the new work areas that use Adaptive Search.

1. Sign in as a setup user.
2. In the Setup and Maintenance area, go to the Sales offering.
3. Select the Change Feature Opt In from the Sales Foundation functional area and open the Edit Features:

Sales Foundation page.
4. In the Features column, locate Open Work Areas Powered by Adaptive Search.
5. Click the pencil icon and select the Enable check box.
6. Click Done.

For more information, see the New Feature Opt-In section of the Oracle Applications Cloud - Using Functional Setup
Manager guide on the Oracle Help Center (docs.oracle.com).

How can I sort my opportunity list by last updated date?  
You can sort the records returned from your opportunity search by setting the Opportunity List Sort profile option.

Sort Opportunity Searches by Last Updated Date
By default, records on the Opportunities overview page are sorted by win probability and opportunity name. However,
if you set the Opportunity List Sort (MOO_LIST_DEFAULT_SORT) profile option to Y, then the opportunities are sorted
by last updated date in descending order. This enables sales representatives to quickly review and act upon recently
updated opportunities.

Set the Profile Option
Here's how to set the Opportunity List Sort profile option:

1. In the Setup and Maintenance work area, go to:

◦ Offering: Sales

◦ Functional Area: Opportunities

◦ Task: Manage Opportunity Profile Options
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2. In the search region of the Manage Opportunity Profile Options page, enter Opportunity List Sort in the Profile
Display Name field.

3. Click Search.
4. In the Profile Values section, select Y from the Profile Value drop-down list.
5. Click Save.

Related Topics
• How do I update existing setup data?

How do I access Workspace data offline?  
You can export data from Workspace for offline viewing and verification. For example, a sales manager might want to
export a list of accounts to perform a more in-depth analysis of their sales team or for reporting purposes.

Only sales manager and sales administrator roles are granted the predefined security privilege
ZCA_WORKSPACE_EXPORT to access the export data feature in Workspace.

The Export List button enables you download data from Workspace as a comma-separated values file. You can then
use this file to view or analyze your data offline.

Click Export List to download all data in the result set. The result set is determined by the columns displayed in the
Workspace UI. Export doesn't include data for hidden columns. It includes all the rows filtered by the current filter
criteria applied.

The default number of rows to export is 2000 and the maximum limit is set at 10000 rows. You can change the default
number of rows by changing the Maximum Number of Records for Export parameter from the Parameters tab on the
Configure Adaptive Search page. See the related topic Edit Adaptive Search Parameters for more information.

When the maximum limit of rows to export is reached, a warning message is displayed prompting you to click Continue
to export the first 2000 rows in the result. This action generates a file containing the first 2000 rows of the result set. If
you don't want to export the result set, click Cancel to return to the Workspace UI.

The exported file contains the results set data displayed in the same column headers and in the same order as displayed
in Workspace.

Note:  You can also export personally identifiable information (PII) if you have the required access to view PII
attributes in Workspace.

Related Topics
• How do I edit Adaptive Search parameters?

What are the Adaptive Search setup UI components?  
Here's a quick rundown of the Configure Adaptive Search page. The rest of this chapter provides the details.
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The Configure Adaptive Search page is made up of five tabs:

• Monitor

• Setup

• Parameters

• Configure UI

• Configure Global Search

Setup
The setup tab includes the Quick and Advanced subtabs. Use the Quick subtab to get an overview of the predefined
and custom objects are available for Adaptive Search. If you're OK with using the search configuration provided by
Oracle, you can select the objects you want to enable and click Publish.

On the Advanced subtab, you can change which objects and fields are enabled for search, how they're searched on, and
other search configurations. You can also enable and disable objects for searching. Click Publish to save these changes.
Once the publish job is complete, any user with permission to access an enabled object can search on fields enabled
within the object, retrieve search results, create saved searches, and more.

The left side of the Advanced subtab shows the ready-to-use objects, including any custom objects or child objects you
created in Application Composer. The right portion lists the fields, including any custom fields you created. You can also
view field names and their types and can enable up to 15 fields for use in searches of related objects in the Include in
Object Reference column. You must publish your changes before they take effect. See the Search Setup section of this
chapter for details.

Note:  To enable search on custom fields and custom child objects, you must first publish them from the sandbox. You
can't use the Configure Adaptive Search UI within a sandbox.
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Monitor
You can monitor the publish process as well as other indexing and maintenance processes on the Monitor tab. From
here, you can view the real-time progress of Adaptive Search indexing jobs. When you click Publish, a progress bar
indicates how much of the indexing job has been processed and what percentage remains to complete the indexing
process. See the Monitor Adaptive Search Background Processes topic for more details.

Parameters
You can configure various parameters to specify how Adaptive Search behaves, using the Parameters tab available in
the Adaptive Search setup page. For example, you can enable mass update and actions, set record-level navigation,
specify the fuzziness level for search, and so on. See the How do I edit Adaptive Search parameters? topic for details.
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Configure UI
You can use the Configure UI tab to specify which fields are available for selection as filters and for display as columns
in search results. You can also set up filter value groupings or value ranges for date and numeric fields. Users can select
these value groupings to filter search results. See Enable Fields for Display as Filters and Search Result Columns for
details.

Note:  When editing UI columns and specifying fields, always ensure that you have at least four fields selected for
both standard and custom objects.

From here, you can also add or remove Create, Export, and Mass Update buttons for every object using the following
check boxes:

• Create

• Export

• Mass Update

For example, follow these steps if you want to restrict the export option in Workspace based on the Account object.

1. Sign in as a setup user.
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2. Navigate to the Setup and Maintenance work area, and click the Configure Adaptive Search task:

◦ Offering: Sales

◦ Functional Area: Sales Foundation

◦ Task: Configure Adaptive Search

The Configure Adaptive Search page appears.
3. Click Configure UI.
4. Select Account in the left pane of the tab as the object you want to restrict the export option in Workspace.
5. Uncheck the Export option in the Features section as highlighted in this sample screenshot.

6. Click Save and Close.

You can verify your changes as follows:

1. Log out and Log in again as a sales representative user.
2. Navigate to Workspace > My Accounts Saved Search
3. Verify that the Export List button isn't displaying in the Account Workspace List Page.

See How do I access Workspace data offline? for more information.

Configure Global Search
Global search enables you to search for any object to which you have access across Sales and Fusion Services. Searches
are performed across various fields and related objects and across custom fields. Results can be filtered based on
objects and Last Updated Date.

Once you enable global search to use the adaptive search engine, you can use the Configure Global Search tab to:

• Configure objects to be included in Global search.

• Define attributes to be included in the search results.

• Define the format and content of Title, Line 1, and Line 2 of each matching record's search result.
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For more information about how to enable Global Search, see the topics in the Global Search section of the Global and
Work Area Search chapter of the sales Implementation Reference guide.

How do I make the currency selection field editable for
leads and opportunities?  
To allow salespeople select a different currency for leads and opportunities, you must make the Currency field editable.
In addition, set up multiple currencies for sales by enabling the Enable Multiple Currencies for Opportunity Revenue
Lines multicurrency setup profile option.

By default, the currency selection field isn't editable for leads and opportunities. Here's how to make the field editable:

1. Ensure you're working in an active sandbox.
2. Navigate to Configuration > Application Composer.
3. In the navigation tree, expand Standard Objects, expand Opportunity or Sales Leads, and click Pages.
4. In the region that corresponds to the page you're changing, duplicate the standard layout and edit the resulting

layout. For example, if you're making the field editable in opportunities, in the Creation Page Layout region,
duplicate the standard layout and then edit the resulting layout.

5. Select the newly created layout, click Actions and then click Edit UI Properties from the drop-down list.
6. Select Currency from the Field Selection drop-down list.
7. Select the custom layout in the Layout Properties section.
8. Click Update.
9. Select the Updatable option.

10. Click Submit.
11. Click Done on the Edit UI Properties: Creation Layout window and save your changes.
12. While still in the active sandbox, navigate to Sales > Opportunities or Sales > Leads as a user who's a sales

resource, such as a sales administrator or salesperson. Verify the change by editing an opportunity or lead and
validating that the Currency field is a drop-down list that users can select.

13. Publish the sandbox according to your company's business practices.
To set the profile option to enable multiple currencies on product lines, see How can I view the list of currencies I've
enabled in the Currency field for my Opportunity?
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How can I view the list of currencies I've enabled in the
Currency field for my Opportunity?  
A salesperson's preferred currency is usually set by default for an opportunity and its product lines. They can also pick
a different currency for their opportunities if the Multiple Currencies for Opportunity Revenue Lines profile option is
enabled and if the Currency field is editable.

Here's how you set the profile option to enable multiple currencies on product lines:

1. In the Setup and Maintenance work area, go to:

◦ Offering: Sales

◦ Functional Area: Opportunities

◦ Task: Manage Opportunity Profile Options

2. On the Manage Opportunity Profile Options page, search for the profile option, Multiple Currencies for
Opportunity Revenue Lines Enabled (the code is MOO_REVN_ENABLE_MULTICURRENCY) and select it.

3. Set to Yes to allow salespeople select different currencies enabled at the line and header levels in opportunities.
Set to No to display the default currency only for opportunities and product lines.

4. Save your changes.

Note:  In the opportunity and lead edit pages, the Currency list of values is read-only by default. If you've enabled
multiple currencies, you can allow salespeople select a different currency by making the Currency field editable. See
How do I make the currency selection field editable for leads and opportunities? for more information.

How do I manage resource organization hierarchy
changes?  
Consider a resource who's assigned the role of a manager. This manager may be part of a hierarchy and contain direct
reports.

For example, a group of salespeople report to a sales manager and this sales manager reports to a sales director. The
sales director might have one or more sales managers reporting to him or her.

A manager might leave the organization, transferred to another organization, maybe demoted from a resource manager
role to a salesperson role, and so on. In all such cases, the direct reports maybe left as orphaned resources within
the organization. To prevent such scenarios, by default it isn't allowed to change the manager having active child
organization or direct reports.

When you need to move the manager having direct reports, as an exception, you can use the Enable End Dating
Resource Manager Unconditionally (ORA_HZ_RES_ENABLE_MGR_END_UNCOND) profile option. This allows the
movement of the manager resource without the need to move the child organizations and direct reports.
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The Enable End Dating Resource Manager Unconditionally (ORA_HZ_RES_ENABLE_MGR_END_UNCOND) profile option
is set to No by default. If the profile value is set to No and you try to end date the resource manager or end-date the
resource organization membership of the resource manager while there are active direct reports, an error message is
displayed. You must first move these direct reports to another organization and then end date the resource manager.

Complete these steps to set the value of the Enable End Dating Resource Manager Unconditionally
(ORA_HZ_RES_ENABLE_MGR_END_UNCOND) profile option to Yes:

1. In the Setup and Maintenance work area, go to the following:

◦ Offering: Sales

◦ Functional Area: Sales Foundation

◦ Task: Manage Administrator Profile Values

2. Search for ORA_HZ_RES_ENABLE_MGR_END_UNCOND and view or change the profile value.

Note:  This profile option setting impacts the handling of resources using the application UI, Import, and web
services. Changing this profile value to Yes leads to orphan resources and causing data integrity issues. We
recommend that you don't change the profile value to Yes. If you must change the value, you must be extremely
cautious specially while handling large volumes of resource organization data. You must provide a replacement of the
manager at the earliest.

How do I run the Perform Object Sharing Rule
Assignment Process?  
The Perform Object Sharing Rule Assignment scheduled process assigns rules to access group assignment objects each
time you add an access group and share the rules.

You schedule and run this process from the access groups Monitor page.

By default, the process runs automatically at scheduled intervals to make sure you've the required access to all object
data for your selected access groups. But you can submit the process manually if, for example, you want immediate
access to new records and objects.

Note:  If you disable automatic scheduling of the process, you must either create your own schedule for the process,
or run the process manually. You can do both tasks from the Perform Object Sharing Rules Assignment subtab on the
Monitor page. For more information about automatic scheduling, see the topic, Scheduling Options for Object Sharing
Rules Assignment Processing.

Steps to Run the Access Group Assignment Process
1. On the Access Groups page, select the Monitor tab.
2. On the Perform Object Sharing Rules Assignment subtab, click Start Process.
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3. On the Schedule Process page, enter these values in the Basic Options region.

Field Entry

Work Object
 

Select the work object you want from the drop-down list.
 

Record Selection
 

You can run the assignment process for all records or for a subset of records by selecting the
appropriate option from the Record Selection list.
 

◦ The first time you schedule the job, select the All records option. After that, avoid
processing delays by selecting the All records option only when it's essential. For
example, when you activate and enable rules for a new object.

Tip:  You might want to run the object sharing rule assignment process for an individual
record (for each type of object) and confirm the access group rule processing is correct
before processing all records for an object.

◦ In general, schedule the process to run for a subset of records using one of these options.

- Records Since Last Run

- Records updated in last 'X' days

- Records updated in last 'X' hours

- Records updated between dates

- Single record

It's recommended that you select the Records Since Last Run option in most cases.
This option runs the job for only those records that were updated since the last time
the process was run for the object, or for records that failed or were missed during the
previous run of the job. If the job has never been previously run for the object, then all
records are processed. Using this option reduces job processing time and ensures that
changes to object rules are processed for all relevant records.

Here are some examples of how you can use the other options:

- If you've scheduled the job to run every hour, select Records updated in last 1 hours.

- If you've scheduled the job to run every 4 hours, select Records updated in last 4 hours.

- If you've scheduled the job to run daily, then select Records updated in last 1 days.

Diagnostic Mode
 

Run the process in diagnostic mode to troubleshoot any issues with access group rules
processing.
 
When you run the process in this mode, access group rule changes aren't committed. Instead
an output log is generated with details of the rules processing. You can use these details to
troubleshoot any issues with access group rules assignment. For example, the log helps you
understand why certain rules weren't applied as expected.
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4. The first time you run the process click Submit to run it immediately.

Alternatively, if you've disabled dynamic scheduling and want to create your own schedule for the process, or if
you want to create an additional schedule to supplement the default schedule, use these steps:

a. Click Advanced.
b. In the Advanced Options region, click the Schedule tab.
c. Select the Using a schedule option.
d. Select how often you want to run the process in the Frequency field.
e. Enter start and end dates for the process.
f. Click Submit.

Depending on your settings, your process runs immediately or at the intervals you specified. You can monitor
its progress in the process table on the Perform Object Sharing Rule Assignment page.

Can I modify the phone types for accounts and contacts?
 
Phone types for accounts and contacts are stored in the lookup type, ORA_HZ_PHONE_TYPE. While you can't disable
the existing ones, you can rename them.

Here's how:

1. In Setup and Maintenance, go to the following:

◦ Offering: Sales

◦ Functional Area: Sales Foundation

◦ Show: All Tasks

◦ Task: Manage Standard Lookups

2. On the Manage Standard Lookups page, search for the lookup type code, ORA_HZ_PHONE_TYPE.
3. Here are the available values for sales:

◦ Mobile

◦ Work

◦ Home

◦ Fax

◦ Land

4. Edit the meanings as needed.
5. Click Save and Close.
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Can you add extra columns to a fixed choice list field?  
No. A fixed choice list is a field that contains a list of static values populated from an FND lookup type. The fixed choice
list displays the lookup type's values in a single column, and you can't add more columns to this field.

You can, however, make the values in a fixed choice list more descriptive, which could help users more easily make
a selection at runtime. To do this, access the lookup type in the Setup and Maintenance work area and modify the
meanings for each value in the lookup type.

Or, you can instead create a dynamic choice list field in Application Composer. Dynamic choice list fields can display
multiple columns in the list of values at runtime.

How frequent are updates to Oracle licensed geography
reference data available?  
The geography reference data is updated on a quarterly basis but the update of the latest geography reference data
refresh isn't automated. You will be informed about the geography reference data refresh using release readiness
documents.

How do I import activity contact data?  
You can use Import Management to create, update, or delete your activity contact data.

You can import activity contact records using these steps:

1. Map your source activity contact data to Oracle Applications Cloud object attributes. This way the import
process would know where to insert each of the information bits.

2. Create the source CSV file with the activity contact data you want to import.
3. Kick off an import activity.
4. Check the import results to know if the import went well.

How You Map Your Source Data to Target Object Attributes
You import activity contact data into Oracle Applications Cloud from a CSV file containing your source data that's
mapped to target Oracle Applications Cloud object attributes.

You need to do the following before creating the .csv file for data import:

• Identify how your source data attributes map to the target object attributes in Oracle Applications Cloud.

• Ensure prerequisite steps are complete, such as understanding what attributes are required for importing your
objects.

• Understand your options for uniquely identifying the records.
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• Ensure parent records exist before importing child records.

• Identify the target object attributes that are required in the .csv file for a successful import

Before You Start
You must do some basic checks before starting your import. For example, make sure that:

• You have completed all the prerequisites for importing each attribute in your source data.

• You have all parent records in place before importing child records.

Select a Unique Identifier for Your Records
All records must be unique in the application. You can use one of these to identify records:

• Public unique identifiers: If you're creating records, then you can provide an easily understandable public
unique identifier. These are, usually, denoted with 'Number' and visible in the business object's UI. PUID
attributes are usually named <object> Number. If you're updating a record with a Number attribute, then use
the Number attribute to identify the record. For more information about public unique identifiers, see the topic
"How You Use Alternate Keys to Import Records" in Related Topics section.

• Source system and source system reference: Source system is an identifier for the external system, and source
system reference is a unique identifier within the external system. If you're importing new activity contacts or
are updating activity contacts that have source system reference data, then provide the source system and
source system reference values.

Required Attributes and Validations for Activity Contact Object
To import data successfully into Oracle Applications Cloud, your CSV file must include the required attributes. Make sure
that you provide valid values for these attributes so that they pass import validations inbuilt into the application.

This table lists the required attributes for activity contact records, prerequisite setup tasks and specific validations, if
any:

Attribute Description Prerequisite Setup Task/
Import Validations

Creating an Activity
Contact record

Updating an Existing
Activity Contact record

ActivityId
 

The internal identifier of
the activity to which the
contact is associated.
 

Automatically generated
by the import process if
creating a new activity
record.
 

The value is generated
automatically by the import
process if creating a new
activity record.
 

A value is required if you're
updating an existing
activity and you're not
providing other values to
identify the activity record.
 
To update an existing
activity, choose one of the
following options to identify
the record:
 

• The unique ID for the
record (ActivityId).

• The activity number
(ActivityNumber).

• The source system
code and reference
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Attribute Description Prerequisite Setup Task/
Import Validations

Creating an Activity
Contact record

Updating an Existing
Activity Contact record

(OrigEntityNumber
and OrigEntityCode).

ActivityNumber
 

The public unique identifier
of the activity to which the
contact is associated
 

If a value is provided while
creating a new activity, the
value must be unique. For
update, you can determine
the existing unique value of
the object by exporting the
Activity object.
 
Navigate to the following in
the Setup and Maintenance
work area:
 

• Offering: Sales

• Functional Area: Data
Import and Export

• Task: Schedule Export
Processes

The table ZMM_ACTY_
ACTIVITIES with column
ACTIVITY_NUMBER holds
the existing value.
 

A value is required if you're
creating a new activity.
 

A value is required if you're
updating an existing
activity and you're not
providing other values to
identify the activity record.
 
To update an existing
activity, choose one of the
following options to identify
the record:
 

• The unique ID for the
record (ActivityId).

• The activity number
(ActivityNumber).

• The source system
code and reference
(OrigEntityNumber
and OrigEntityCode).

ContactId
 

The party of type person
who's involved with this
appointment..
 

If no value is provided, the
corresponding value from
the Contacts production
table is used.
 

A value is required if you're
associating a new contact
to an activity. One of the
following must be provided
while creating a contact:
 

• ContactId

• ContactPartyNumber

• Combination of
ContactOrigSystem
and OsrContactId

To update or delete an
existing activity contact,
 select one of the following
options to identify the
record:
 

• The unique ID for the
record (ActivityId,
 ContactId).

• The activity number
(ActivityNumber,
ContactId).

• The source system
code and reference
(OrigEntityNumber
and OrigEntityCode).

ContactOrigSystem
 

The source system for the
activity with which the
contact is associated.
 

No Validation
 

A value is required if you're
associating a new contact
to an activity.
 
One of the following must
be provided while creating
a contact:
 

• ContactId

• ContactPartyNumber

• Combination of
ContactOrigSystem
and OsrContactId

Not Required
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Attribute Description Prerequisite Setup Task/
Import Validations

Creating an Activity
Contact record

Updating an Existing
Activity Contact record

ContactPartyNumber
 

The party number of the
contact.
 

This must be a valid party
in the HZ_PARTIES table.
 

A value is required if you're
associating a new contact
to an activity.
 
One of the following must
be provided while creating
a contact:
 

• ContactId

• ContactPartyNumber

• Combination of
ContactOrigSystem
and OsrContactId

This must be a valid party
in the HZ_PARTIES table
 

CorpCurrencyCode
 

The corporate currency
used by the activity to
which the contact is
associated.
 

If no value is provided, the
corresponding value from
the Contacts production
table is used.
 

If no value is provided,
 the corresponding value
is used from the Contacts
production table.
 

If no value is provided,
 the corresponding value
is used from the Contacts
production table.
 

OrigEntityCode
 

The code indicating the
original source of the
activity the activity to which
the contact is associated.
 

Valid values for upgraded
records are TASK,
 APPOINTMENT, or
INTERACTION.
 

Note:
If the record was
created in the
Activity Management
component, the value is
ACTIVITY.
 

Valid values for upgraded
records are TASK,
 APPOINTMENT, or
INTERACTION.
 

Note:
If the record was
created in the
Activity Management
component, the value is
ACTIVITY.
 

A value is required if you're
updating or deleting an
existing activity and you're
not providing other values
to identify the activity
record.
 
To update or delete an
existing activity you must
choose one of the following
options to identify the
record:
 

• The unique ID for the
record (ActivityId).

• The activity number
(ActivityNumber).

• The source system
code and reference
(OrigEntityNumber
and OrigEntityCode).

OrigEntityNumber
 

The ID that identifies the
entity record in the original
system..
 

If the internal action
code is 'INSERT' and
OrigEntityNumber and
ActivityNumber are NULL
then it will be defaulted
to the provided value. If
no value is provided, the
corresponding value from
Contacts production table
is used.
 

If the internal action
code is 'INSERT' and
OrigEntityNumber and
ActivityNumber are NULL,
 the value will be set to
the value provided by the
user. If no value is provided,
 the corresponding value
is used from the Contacts
production table.
 

A value is required if you're
updating or deleting an
existing activity and you're
not providing other values
to identify the activity
record.
 
To update or delete an
existing activity you must
choose one of the following
options to identify the
record:
 

• The unique ID for the
record (ActivityId).
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Attribute Description Prerequisite Setup Task/
Import Validations

Creating an Activity
Contact record

Updating an Existing
Activity Contact record

• The activity number
(ActivityNumber).

• The source system
code and reference
(OrigEntityNumber
and OrigEntityCode).

OsrContactId
 

The source system
reference of the contact..
 

The contact must exist in
system. You can determine
the original system
reference for the Contact
by exporting the Contacts
object.
 
Navigate to the following in
the Setup and Maintenance
work area:
 

• Offering: Sales

• Functional Area: Data
Import and Export

• Task: Schedule Export
Processes

A value is required if you're
associating a new contact
to an activity. One of the
following must be provided
while creating an assignee:
 

• ContactId

• ContactPartyNumber

• Combination of
ContactOrigSystem
and OsrContactId

The contact must exist in
system. You can determine
the original system
reference for the Contact
by exporting the Contacts
object.
 
Navigate to the following in
the Setup and Maintenance
work area:
 

• Offering: Sales

• Functional Area: Data
Import and Export

• Task: Schedule Export
Processes

OsrContactOrgId
 

The source system
reference to the contact
organization. It is used to
update the RELATIONSHIP_
ID in the interface table
(ZMM_IMP_ACTY_
CONTACTS) based on HZ_
PARTIES.
 

This must be a valid
organization type in the
HZ_PARTIES table.
 

This must be a valid
organization type in the
HZ_PARTIES table.
 

This must be a valid
organization type in the
HZ_PARTIES table.
 

Go to Navigator  > Tools >  Import Management >  Import Objects, to see all the attributes of the activity contact
object. The page also lists attribute information like type, length, description, and so on.

Create the Source CSV File
You include the data that you want to import into Sales and Fusion Service in a source CSV file.

You can use the templates available in the Import Objects UI page to create the source CSV file. To download a template:

1. Go to Navigator  > Tools >  Import Management >  Import Objects.
2. Select the Activity Contact object in the table and click Download.

You can now edit the downloaded file and provide valid values for the required attributes.

Note:  For help in populating the CSV file and to avoid any issues in entering values, see the topic Potential Issues
When Opening CSV Files With Excel in Related Topics section.
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Create the Import Activity
After you have the CSV file ready, create an import activity to import the activity contact information. To create an
import activity:

1. Go to Navigator  > Tools >  Import Management >  Import Queue.
2. Click Create Import Activity in the Manage Imports page.
3. In the Enter Import Options page, provide a name for the import activity, and select Activity Contact from the

Object drop-down list.
4. Select the CSV file in the File Name field, and click Next.
5. You would see that the source and target attributes are automatically mapped in the Map Fields page. Review

and edit the mappings if required.
6. Check the file for unmapped columns or data format issues by clicking Validate Data. Click Next.
7. Review the import details on the Review and Submit page, and click Submit when you're ready.

Review the Import Results
Check if your import succeeded on the Manage Imports page. This page shows the status of all active, completed, and
unsuccessful imports. To check the status of the import activity:

1. Go to Navigator  > Tools >  Import Management >  Import Queue.
2. Click All Imports and search for the import activity that you created earlier.
3. Check the Status column for the import activity. The import is successful if the status displays as Completed.

You can drill down on the import activity to go to the Import Status page which provides the status details of
the import activity.

Related Topics
• How do I import data?

• Potential Issues When Opening CSV Files in Excel

• How You Use Alternate Keys to Import Records

How do I edit the data access permissions for a custom
role and an object?  
You can update existing and future-dated policies for a custom role and object, and grant access to new subsets of data
for the role, using the Active Policies edit page of the Sales and Service Access Management work area.

For example, you can:

• Add or remove all access to individual policies

• Configure read, update, and delete permissions for a specific policy

• End-date policies to inactivate them

• Configure advanced permissions for policies

Follow these steps to edit the permissions to object data for a custom role.

1. Sign in to the application as a user who has either the IT Security Manager or Customer Relationship
Management Application Administrator job role.
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2. Select Navigator > Tools >  Sales and Service Access Management.
3. On the Sales and Service Access Management page, click the Manage Data Policies tab.
4. Search for or select a role in the Role field.

You can't edit policies on predefined roles, so search for and select a custom role. For example, if you copied the
predefined Salesperson role to create a custom version of the role, you could select it.

5. Select an object in the Object field, for example, select the Sales Lead object.

Note:  Select the Trading Community Party object to view access policies for both accounts and contacts.

6. Click Find Policies.
7. Click the Edit icon and the Active Policies edit page for the selected role and object is displayed.

The Access Policies table shows all available policies for the selected role and object by default but you can use
the Show Conditions filter to display only policies that are granted or only policies that aren't granted.

8. Configure the access provided to the selected object for the selected custom role by selecting or deselecting
the Read, Update, or Delete check boxes for a policy.

For example, if you're editing policies for a custom Salesperson role and the Sales Lead object, you can perform
data configuration tasks such as:

◦ Restrict the ability to delete leads to lead owners by finding any policies that provide lead access to team
members and deselecting the Delete check box for these policies.

◦ Allow sales representatives to view retired leads by finding the policy that grants this access, then clicking
the Read check box.

9. You can remove all access granted by a policy. For example, if your company doesn't use territory access, you
can remove territory access to lead data using one of the following methods:

◦ Review the Condition column to find the policies that grant territory access, then deselect the Read,
Update and Delete check boxes for each of these policies.

◦ End-date the policies so that they're no longer active by selecting a date that has passed in the End Date
field, for example, select yesterday's date.

Note:  To reactivate a policy that's deactivated, reassign the appropriate read, update, and delete permissions
to the relevant criteria and specify a start date for the policy.

10. If a policy has an advanced permission associated with it, then you can edit the advanced permission to specify
more granular levels of access to the object.

For example, a policy might provide full access to lead data for a resource in the territory assigned to the sales
lead. You can restrict this access by selecting the policy, then scrolling to the Advanced Permissions table for
the policy. You can remove update access to the lead data but retain read access by deselecting the Update 
check boxes.

Note:  You can update the advanced permissions for a policy only if the related permission in the parent row
in the Access Policies table is checked. For example, if the read permission in the parent row of a policy isn't
selected, none of the read permission options in the Advanced Permissions table can be edited.

11. Click Save and Close.

Your changes are saved and the Manage Data Policies page is displayed where you can review your changes.
If you've end-dated a policy, note that the number in parentheses beside the Inactive policies check box is
incremented.
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How do I enable mass update of records?  
Use the mass update feature to bulk update fields on multiple records. You can update multiple fields on several object
records at once, without having to go into each individual record.

For example, a salesperson can update the sales stage on multiple opportunities at the same time with just a few clicks.
Or, a salesperson can update rank and deal size on several leads at once.

Here's the setup flow:

1. Add the Update action to the landing pages of the work areas where you want to enable the feature. Landing
pages are the only pages that support the mass update feature.

2. Optionally, configure which fields salespeople can update. You can use the default fields already set if you want.
Or you can configure the list yourself.

3. Optionally, set profile options to specify how many records salespeople can update at once. You can use the
default value of 25 records if you want.

Supported Objects for Mass Update
These are the predefined, standard business objects that support mass update:

• Activities

• Accounts

• Assets

• Contacts

• Sales Leads

• Opportunities

Custom objects also support mass update.

Add the Update Action
Salespeople access the mass update feature using the Update action that you enable in the work area landing pages.
The action appears as Actions > Update on the landing page toolbar.

Remember, make all Application Composer changes in a sandbox and publish the sandbox according to your company's
processes.

These steps use the Opportunity object's landing page as an example. The basic steps are the same for all objects, but
the navigation can be different for different objects. See the Landing Page Names in Application Composer section in
this topic for the page names and navigation.

1. Navigate to Configuration > Application Composer.
2. Expand the Standard Objects tree and then expand the object you want to modify. For example, expand the

Opportunity object.
3. Within the object you're modifying, click the Pages node.
4. Ensure that the Application Pages tab is selected.
5. In the Landing Page Layouts region (use the Activities region for the Activities object), select the Standard

layout, and then click the duplicate layout icon to duplicate and edit the resulting copy. Alternatively, you can
edit an existing, custom layout.

71



Oracle Fusion Cloud Sales Automation
Sales Questions and Answers

Chapter 1
Sales Questions and Answers

6. Now, edit the new layout. For example, to edit the Opportunities landing page, click the edit (pencil) icon on the
Fuse Opportunity Overview Table.

7. In edit mode for the landing page, navigate to the Configure Detail Form: Buttons and Actions region.
8. In the Available Actions window, double-click the Update action to move it to the Selected Actions window.
9. Click Save and Close, then Done.

10. Test the changes using the steps in the Test the Changes section later in this topic.

Set the Updatable Fields
Now that you have enabled the Update action, configure the fields salespeople can update using mass update. Each
object already has several fields enabled for the mass update feature. If you want, configure this list to include other
standard fields, or even custom fields. Keep in mind that if you're setting up the mass update feature for custom objects,
then you must configure the list of fields that can be updated by users -- it's not optional like with standard objects.

You configure the list of mass update fields using the same custom landing page layout where you manually displayed
the Update action:

1. In Application Composer, navigate to the Pages node for the object you're configuring.
2. Edit the same landing page layout where you manually displayed the Update action in the above procedure.
3. Navigate to the Configure Mass Update Fields region.
4. In the Available Fields box, double-click the fields that you want to make available for the mass update feature

at runtime. Or, use the arrows to move the items that you want to make available. See the Rules for Certain Field
Types below for some details on field types and limitations or behavior.

5. After you're done making changes, click Save and Close, then Done.

Rules for Certain Field Types

Consider these rules for certain field types as you set up the feature:

• You can use both standard and custom fields. However, read-only fields, such as formula fields, and fields that
can be conditionally updated, aren't included in the list.

• Some fixed-choice list fields are related in a parent-child relationship. This simply means that the values
displayed in the child field are dependent on whatever is selected in the parent field. If you want to make a child
fixed choice list field available for the mass update feature, then you must also include its parent field.

Configure the Number of Updatable Records
You can configure the maximum number of records that users can update at once by setting profile options.

Here's the behavior:

• The default value of the profile options is 25, meaning the maximum number of records that salespeople can
update at once for those objects is 25.

• The maximum number of records that can be updated at once is 500.

• If a profile option value has a null value, the application sets the number of records that can be updated at once
to 10.

• For custom objects, the threshold value is set at 25 and can't be changed using a profile option.

Here are the mass update threshold profile options. The profile option codes are listed in parentheses.
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Object Profile Option

Activity
 

Activity Mass Update Threshold Value (ZMM_MASS_UPDATE_THRESHOLD)
 

Account
 
Asset
 
Contact
 
Sales Lead
 
Opportunity
 
Custom objects
 

Mass Update Threshold Value (ZBS_MASS_UPDATE_THRESHOLD)
 

Set the Profile Options

1. In Setup and Maintenance, go to:

◦ Offering: Sales

◦ Functional Area: Sales Foundation

◦ Task: Manage Administrator Profile Values

2. In the search region of the Manage Administrator Profile Values page, enter the profile option name in the
Profile Display Name field. Or, enter the code in the Profile Option Code field.

3. Click Search.
4. In the list that's returned, click the profile option name link.
5. Set the profile option value as needed.
6. Save your changes.

Test the Changes
It's a good idea to test the changes. For example:

1. Sign in as a user who has access to the object you just modified, such as a sales representative or sales
manager.

2. Go to the landing page and click the Actions menu to verify that the Update action is available.
3. Go through the mass update flow with some records to be sure it's working as you expect. See the Related

Topics for the procedures.

Landing Page Names in Application Composer
As you modify the landing pages, it's helpful to know their names in Application Composer. Here are the pages, along
with the navigation steps to get to them:

Object in Application Composer Navigation to Landing Page Layout Name of the Landing Page You Need to Edit

Activity
 

Activity > Pages > Application Pages > Landing
Page Layouts > Activities region
 

My Activity Overview Table
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Object in Application Composer Navigation to Landing Page Layout Name of the Landing Page You Need to Edit

Account
 

Account > Pages > Application Pages > Landing
Page Layouts
 

FUSE Account View List Table
 

Asset
 

Asset > Pages > Application Pages > Landing
Page Layouts
 

Asset Overview Table
 

Contact
 

Contact > Pages > Application Pages > Landing
Page Layouts
 

Fuse Contact List Table
 

Sales Lead
 

Sales Lead > Pages > Application Pages >
Landing Page Layouts
 

Fuse Lead Overview Table
 

Opportunity
 

Opportunity > Pages > Application Pages >
Landing Page Layouts
 

Fuse Opportunity Overview Table
 

Related Topics
• How do I apply mass update to accounts and contacts?

• How can I enable the Mass Update feature in Workspace?

How can I add custom objects, custom child objects, and
custom fields to Workspace UI?  
Users with permission to extend Workspace can access a custom object and search on it from the Workspace UI, search
on one or more fields within the custom object, retrieve search results, and create saved searches for the custom object.

Fields are searchable both in the Search box and in filters. Searching on top-level custom objects and their custom child
objects is supported. Custom child objects of standard objects are also supported.

Adaptive Search supports predefined relationships between the ready-to-use standard business objects. It also
supports one-to-one and one-to-many custom relationships between standard and custom objects.

Note:  Custom long texts aren’t supported.

Custom fields and custom child objects must be published from the sandbox before you configure Adaptive Search to
include them. You can't configure Adaptive Search inside a sandbox. Follow this standard process:

1. Create the custom fields and custom child objects using Application Composer while working in a sandbox.
2. Publish the sandbox.
3. With no sandbox open, configure the search behavior you want in Adaptive Search and publish the new

configuration.
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Note:  If you have dynamic choice list fields included from a custom object to a standard object, such as an
Opportunity, then the standard object attributes that you selected by setting the Include in Object Reference  check
box are displayed in the custom object list page. However, the custom object attributes won't be available in the
standard object list page because dynamic choice list fields aren't supported from standard objects to custom object.

Synchronization of Custom Objects, Custom Child Objects, and Custom
Fields to Workspace
When you launch the Workspace search configuration, all custom attributes published using Application Composer and
the sandbox are synchronized to the Workspace configuration UIs. It may take a little time to synchronize all custom
objects, custom child objects and custom fields to the Workspace search setup. If the searchable attribute is set to
true in Application Composer, all custom attributes for standard top level objects and custom objects are enabled for
indexing by default. However, if the searchable attribute that you want isn't set to true, then you must explicitly enable it
for indexing.

Setup is done on the Advanced setup tab. You select the business object you want to set up in the left pane of the
tab, and set the object's search properties in the right pane. See the topic How Search Action is Modified for more
information.

How do I make a field searchable in the UI?  
You can enable additional fields for search, including custom ones. You can also remove existing fields from use.

By default, the work areas powered by Adaptive Search include all of the key fields you need for search. (See the topic
Adaptive Search Configuration Provided by Oracle for a list.)

To make the field searchable in work areas powered by Adaptive Search and Global Search, including Sales in the
Redwood User Experience, involves these steps:

1. You must make the field searchable for its business object.
2. Optionally, you can enable the field for search of a related object.
3. You must publish your configuration.

Note:  If you want the field to be displayed in the UI, either as a filter or as a column in search results, then you must
enable it for display on the Configure UI tab of the Configure Adaptive Search page.

This example shows you how to enable the Chief Executive Name field, a standard application text field, but the same
procedure applies to any field, even a custom field on a standard application object. When you're done with this
configuration and publish it, a salesperson can enter the CEO name, in either Global Search or in the search box for
those work areas powered by Adaptive Search, to find the account where the person is the CEO. The search also returns
all of the opportunities for that account when you enable opportunities to be searched by account fields.

Suppose that you added the CEO name field to the Account UI and want to make entries in this field searchable. Here's a
screenshot of the Edit Account page highlighting the location of the field.
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Make the Field Searchable in Its Business Object
Here's how you make the field available for searching its business object. For example, making the account searchable
by the CEO name.

1. Navigate to the Setup and Maintenance work area, and use the following:

◦ Offering: Sales

◦ Functional Area: Sales Foundation

◦ Show: All Tasks

◦ Task: Configure Adaptive Search

2. On the Configure Adaptive Search page, Setup tab (callout 1 in the screenshot), click Advanced (callout 2).
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3. In the left pane, click the name link for the object where the custom field appears (callout 3). The CEO name
field is an account field, so you click Account.

The field is listed in the Configure Fields section.

4. Select the Enable option to index the field for Workspace and Global Search (callout 4).
5. For a text field, including Chief Executive Officer, select the Analyzed Text Search option to index individual

words in the field. Your selection also enables fuzzy search (search that retrieves results with similar spellings).
And you enable other search operators, including All of the words and Any of the words.

Note:  For fuzzy search to work, the first 3 characters of the word should match and in the remaining part of
the word there can be 1 character difference. This can be changed to 2 characters difference if needed, but the
first 3 characters still need to match.

6. Select the Include in Keyword Search option to enable the field for both Global Search and search using the
Workspace search box.

Note:  Because they're Personal Identifiable Information (PII), you can't make contact email addresses and
phone numbers available for search using global search or the Workspace search box.

If you leave this check box deselected, users can't search for accounts using the CEO name. But in Workspace,
they can still add the Chief Executive Name field as a filter for accounts and search the field there. Global Search
doesn't permit you to add filters, only to search by keyword.

7. Select the Include in Object Reference option to enable the field for search in related objects. You can enable
up to 15 fields. Make the selection if you want to use the CEO name when searching for opportunities, for
example.

If you didn't select the Include in Keyword Search option, but select Include in Object Reference, then users
searching opportunities can use the field only as a filter in Workspace.
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Make the Field Available for Searching a Related Object
You can only make the field available for search in a related business object if you selected the Include in Object
Reference option for the field.

1. In the left pane of the window, open the object where you want to enable the search. For this example,
Opportunity (callout 1 in the screenshot).

2. Select the field in the left pane, in this example, Account (Callout 2).
3. In the right pane, select Enable (callout 3).
4. If you want to use the field for searches in Global Search and in the Workspace Search box, you must select the

Include in Keyword Search  option (callout 4).
If you don't select this option, but selected Enable, then the field remains available as a filter in Workspace, but
can't be searched in Global Search.
The Include in Object Reference option isn't relevant here. Here's a summary of the two use cases:

Use Case Enable Include in Keyword Search

Users can search on the field using Global
Search and in the Workspace Search box.
For example, entering the CEO name,
 they get results containing, not only the
account where the person is a CEO, but the
opportunities for that account as well. In
Workspace, they can also select the fields
as a filter when searching for the object. For
example, when searching for opportunities
in Workspace, they can filter by CEO name.
 

Selected
 

Selected
 

Users can add the field as a filter in
Workspace, but can't search on it using the
Search box or using Global Search.
 

Selected
 

Deselected
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Publish Your Configuration
After making your option selections, click Publish.

Publishing triggers an indexing process that you can monitor on the Monitor tab, Publish subtab. Your new
configuration becomes available after the indexing process completes. If the process completes with errors for some
reason, contact your help desk.

Enable the Field for Use As a Filter in the UI
For the field to be used as a filter and added as a column in search results, you must enable it for display on the UI:

1. In the Configure Adaptive Search page, click Configure UI.
2. To enable the field for use as a filter on its object (for example, to enable the account field to be used as a filter

when searching accounts), do the following:

a. Select the object in the left pane of the Configure UI tab.
b. Select the Display in UI option for the field.

3. To enable the field for use in the UI of other related objects (for example, to enable the account field as a filter in
opportunity searches), do the following:

a. Display the related object hierarchy for the object where you want to enable the filter in the left pane of
the Configure UI tab. For example, select Opportunity (callout 1 in the following screenshot).

b. Locate and select the field's object in the object hierarchy. For example, select Account (callout 2).
c. Select Display in UI option for the field (callout 3).

4. Click Save and Close.

Related Topics
• Adaptive Search Configuration Provided by Oracle
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How do I share a saved search with everyone or with
specific job roles?  
You can configure the saved search setup to specify the saved search that appears by default whenever a user opens
the work area. You can also setup saved searches to share with everyone or to share with each specific job role.

After you create a saved search, it’s initially visible only to you. Here’s how to share it with the whole sales organization
or with individual job roles.

1. Navigate to the work area.
2. Click in the search field and select Manage Saved Searches.
3. From the Visible To list, select Me.
4. Click Actions (the three dots in the Actions column) for the saved search you want to share and select Edit.
5. Make a selection from the Shared With list:

◦ If you’re making the saved search available to the whole sales organization, select Everyone.

◦ If you’re making it available for specific roles, here’s how to add them:
i. Select Specific Roles.

ii. Click Add.
iii. Select the role.
iv. Click Save (the check mark icon).

6. Click Save.
If you shared the saved search with job roles that aren’t assigned to you, then the saved search is no longer visible on
your page. To see it, select one of the job roles assigned to it from the Visible To list.

How do I create and manage saved searches?  
Use search to find specific information across the application. You can save any search you do on a page as a new saved
search and can manage and setup saved searches to suit your requirements.

You can create and manage saved searches for different roles and for your own personal use. You can also assign
a unique default saved search for each role. A default saved search is the search a user sees when first opening
Workspace. Sales representatives can't replace or edit default saves searches assigned to them by their sales
administrators. To view the assigned default saved search, or to assign a default saved search to a user role, you must
have permission to view the object underlying the saved search. Sales users can create their own personal saved
searches, manage them, and assign their personal default saved search. These saved searches take precedence over
what you, as administrator, has assigned to them. You create and manage saved searches from the Workspace UI rather
than from the Configure Adaptive Search page.

Note:  By entering precise search criteria for your saved search, you can greatly decrease the number of records
returned and decrease the load time.

Note:  To create and manage saved searches you must have the privilege
ZCA_VIEW_ADAPTIVE_SEARCH_WORKSPACE_PRIV.
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Overview of Manage Saved Searches UI
The Manage Saved Search UI contains the My List tab, Workspace List tab, and Set Defaults tab. These allow
administrators to manage their personal list of saved searches, assign saved searches to roles, and assign default saved
searches to roles, respectively. These tabs are only exposed to administrators to:

• Assign saved searches for user roles

• Assign a default saved search for roles

• Change a default saved search for roles

• Perform overall role-based administration

Note:  Workspace users can manage their own personal saved searches from the Manage Saved Searches page but
they won't have access to the My List, Workspace List, or Set Defaults tabs. However, mobile app users can override
these restrictions and set their own default searches, too. This feature helps to display the most relevant records in
their mobile app with a single tap on the menu.

All sales users can create saved searches for themselves. But sales administrators can create saved searches for the
whole sales organization and for specific sales roles. A default saved search is the saved search that's automatically
displayed when the user first accesses Workspace. Oracle delivers predefined default saved searches for some user
roles and the search results returned depends on what role is assigned. For example, ready-to-use partner roles include
Partner Sales Representative, Partner Sales Manager, and Partner Administrator.

From the My List tab, you can manage your own personal saved searches exclusively, separate from the saved searches
that are shared with the broader organization. Here is a screenshot of the My List window.

Note:  Mobile app users can select the save searches they want from the Default for Mobile column.

From the Workspace List tab, you can share and manage saved searches with other roles. You can designate saved
searches as shared with everyone, with specific user roles, or with no one. Here's a screenshot of what the Workspace
List window looks like.
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The Set Defaults tab enables you to define the default saved search for each user role. However, to assign a default
saved search, you also must have permission to view that specific default saved search. Otherwise it won't appear in the
list of saved searches to assign. Here's a sample screenshot of the UI.

For example, if you select Site Level, the following default saved search options are displayed for Accounts:

• All Accounts

• My Accounts

• My Favorite Accounts

• My List for Accounts
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If you select a specific role, such as Sales Representative, then you may want to select the My Accounts option as your
default saved search as shown in this sample screenshot.
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Create a Saved Search
Here's how you can create a saved search either for yourself or for others in the organization. The saved searches
you create are available for selection in Workspace and also appear as filters in the actionable infolets and Workspace
infolets. The saved searches are listed in alphabetic order.

1. In Workspace, select a saved search as your starting point. For example, the All Accounts saved search
provided by Oracle lets you create your saved search for all the accounts you can see.

2. Enter your search terms. You can enter search terms in the Search box, add filters, select filter values, or any
combination of these.

3. You can add or change the columns displayed in the search results by clicking Edit Columns (the pencil icon
highlighted by callout 2 in the following screenshot).

4. Click Save As (highlighted by callout 1).

5. Enter the name for your saved search. Remember that the saved searches are listed in alphabetic order.
6. To make this saved search the default saved search for you personally, select the Set as my default saved

search option. The default saved search is what you see whenever you navigate to Workspace.
7. Specify how you want to share the saved search you're creating. There are three options:
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◦ Only Me

◦ Everyone

◦ Specific Roles

8. If you selected Specific Roles, click Search (the people icon) and select the job roles.
9. Click Create.

Related Topics
• How can I view and assign a default saved search for a role?

• Why does the Default Saved Search field display with either no name or with a Select drop-down list?

Why can't I find users to add as a resource in the
Resource Directory?  
You can use the Resource Directory to view all the existing resources within your organization and add party records as
sales resources.

If you are unable to find a party record in the Resource Directory, run the Synchronize Person Records scheduled
process. For more information, see the Implementing Global Human Resources guide.

What are the roles or privileges needed for accessing
Survivorship Rules?  
While working with Survivorship Rules, check if you have the following roles and privileges:

• ORA_ZCH_CDM_ADMIN_DUTY

• ORA_CRM_EXTN_ROLE

• ZCX_MANAGE_EXTENSIBLE_OBJECT_PRIV

How can I make sure the sales territory hierarchy mirrors
the resource hierarchy?  
If you've enabled sales forecasting by territory owner, your territories mirror your resource hierarchy and organizations.
When your resource hierarchy changes, you must run the Refresh Territories from Resources process to reflect the
changes in the territory structure. This process doesn't apply if you didn't enable forecasting by territory owner and
you're using territory dimensions for assignment and forecasting.

The Refresh Territories from Resources process runs automatically before each forecasting window. If you run the
process immediately after importing sales users, you assure that users get to see forecasts immediately rather than
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having to wait for the next forecasting period. The process updates the territory hierarchy to match your resource
hierarchy, with the resources as territory owners.

1. Click Navigator > Tools > Scheduled Processes.
2. On the Overview page, click Schedule New Process.
3. In the Schedule New Process window, enter Refresh Territories from Resources in the Name field and press

Return.
4. Select the process and click OK.

Can I set up CX Sales Mobile to display a home page
infolet?  
You can't display the infolets you see on the home page of the web application in CX Sales Mobile setup. While you can't
display the infolets themselves, you can create a BI report with the same information and make that report accessible
from the View Reports card on the mobile home page.

What can I do if the "What's Around Me?" mapping
feature isn't working in CX Sales Mobile?  
For the What's Around Me? feature to work, you must ensure that the address and geolocation attributes for Account,
Contact, and Lead are selected for Object Reference in Adaptive Search setup.

1. Make sure the feature is set up as described in the topic How do I set up the "What's Around Me?" maps feature?
2. Navigate to the Setup and Maintenance work area, and open the Configure Adaptive Search task:

◦ Offering: Sales

◦ Functional Area: Sales Foundation

◦ Show: All Tasks

◦ Task: Configure Adaptive Search
3. On the Configure Adaptive Search page, Setup tab, click Advanced.
4. In the left pane select the appropriate path, make sure the attribute is enabled, and then select the Include in

Object Reference option to enable the field for search in related objects and in CX Sales Mobile.

Path Field to Enable

Account > Primary Address PrimaryAddress

Account > Primary Address > Address GeoLocation

Account > Addresses > Address GeoLocation

Contact > Primary Address Address

Contact > Primary Address > Address GeoLocation
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Path Field to Enable

Contact > Addresses > Address GeoLocation

Lead GeoLocation

5. Click Publish. Publishing triggers an indexing process that you can monitor by clicking the Monitor tab and
then the Publish subtab. Your new configuration is available when the indexing process completes.

How can I create a BI report of the notes associated with
a sales lead?  
To create a BI report of notes associated with leads, use the following SQL query.

select * from fusion.ZMM_NOTES where SOURCE_OBJECT_CODE='LEAD'

Can I include a prospect account in a sales territory?  
Yes, you can include prospects as named accounts in sales territories.

Note:  Make sure that the profile option Account Types Enabled for Assignment
(ZCA_ASSIGNMENT_ACCT_TYPE_ENABLED) is enabled for prospects by setting the profile to
ZCA_CUSTOMER,ZCA_PROSPECT.

To add prospects to territories, use the Territories tab in the Territories work area. The Sales Territories Hierarchy tab,
where you set up territory hierarchies using proposals, limits how you can add them. Here are the details of what you
can do in each tab.

Territories Tab
On the Territories tab, you can add any account of type prospect to a live territory.

Sales Territories Hierarchy Tab
On the Sales Territory Hierarchy tab, you can:

• You can add prospect accounts only if they're child members of an account hierarchy for accounts of type
customer.

• View and delete prospect accounts. These include prospect accounts that you added on the Territories tab that
aren't part of a hierarchy.
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What's the best practice for assigning sales team
members to accounts?  
The most efficient way of assigning sales team members to accounts is to set up sales territories. When you use sales
territories for sales team assignment, there's no limitation on the number of records you can process, and you assure
data integrity, quality, and your assignment is free from human errors.

I didn't set up sales territories, so how can I use quotas, a
feature that requires them?  
If you didn't set up sales territories because you don't need them for autoassignment, you can quickly set up the
sales territories required for your quota setup. Using Simplified Sales Forecasting (Quick Setup), you can set up sales
territories that automatically mirror your sales resource hierarchy with one click. The territories that get created assure
that the opportunity owners are also the territory owners. This feature was created to enable forecasting for customers
who don't use sales territories for assignment and works for quota setup as well.

You can skip this setup if you already enabled Forecasting by Opportunity Owner in the Setup Assistant.

Assure you set up these prerequisites.

1. Set up your accounting calendar. The periods must be either monthly or quarterly.
2. Set up your hierarchy of sales resources.

To enable forecasts:

1. Enable one territory dimension and activate.

a. In the Setup and Maintenance work area, go to the following:

- Offering: Sales
- Functional Area: Territories
- Task: Enable dimensions and Metrics

b. Click Select and Add to enable one dimension, such as Account Type.
c. Save and close.
d. Click Load and Activate.

2. Create at least one opportunity with a future close date.
3. In the Setup and Maintenance work area, go to the following:

◦ Offering: Sales

◦ Functional Area: Sales Forecasting

4. Click Quick Setup, the gear icon in the Functional Area.
5. In the Configure Simplified Sales Forecasting page, the two options are selected for you. Click Submit.
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Your submission sets up all these areas for you.

• You've a territory hierarchy to match your sales resource hierarchy, with the resources as territory owners.
The Refresh Territories from Resources process synchronizes your territories to match your latest resource
hierarchy. The territories have Resource-Centric coverage and are called Resource-Centric territories. (The
process requires at least one enabled territory dimension.)

• Opportunities are automatically assigned to territories by owner.

• Forecasts roll up the territory hierarchy.

• You forecast quarterly.

• Salespeople can adjust their forecasts each month if your accounting period is monthly.

• You can forecast product totals.

• You can use quotas.

• The Forecasting Autopilot process runs every hour.

Remove Your Resource-Centric Territory Hierarchy
If you used the quick setup and then decided you won't use the resource-centric territory hierarchy, you can remove it.

1. Navigate to Scheduled Processes.
2. Click Schedule New Process.
3. Find Refresh Territories from Resources.
4. Click OK.
5. In the Diagnostic Parameters field, enter from_resource=-1
6. Click Submit.

How can I assure that the assigned lead owner remains
the owner when the lead is converted?  
When you assign a lead owner, that lead owner must accept the lead for them to remain the owner of the converted
lead. If the lead owner doesn't accept the lead and another salesperson converts the lead into an opportunity, then that
second person becomes the owner of the converted lead. You can assure that the assigned lead owners remain the
owners of converted leads by creating a Groovy script to automatically accept the lead.

To automatically accept the lead for the assigned lead owner, create a Before Update in Database trigger on the Sales
Lead object. Here is a sample script:

if (isAttributeChanged('OwnerId') && OwnerId != null){
 setAttribute('LeadAcceptedFlag', 'Y')
}

Steps to Create the Trigger
1. Enter a sandbox with Application Composer as one of the tools.
2. Open Application Composer by selecting it from the sandbox Tools menu.
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3. In the left pane, search for the Sales Lead object (callout 1 in the screenshot).

4. Expand Sales Lead under Standard Objects (callout 2).
5. Click Server Scripts (callout 3).
6. In the Server Scripts Sales Lead page, click the Triggers tab (callout 1 in the screenshot).

7. Click Add a new trigger (callout 2).
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8. In the Create Object Trigger page Name Trigger list, select Before Update in Database (callout 1 in the
screenshot).

9. Enter a trigger name.
10. Enter the Groovy script (callout 2).
11. You can validate the script by clicking Validate on the right side of the Trigger Definition section.
12. Click Save and Close.

You must publish the sandbox for the trigger to become active.

Related Topics
• Server Scripts

• Defining an Object-Level Trigger to Complement Default Processing

How do I download and install the external data loader
client?  
This topic shows how to download and install the External Data Loader Client.

Here are the steps involved in this process:

1. Download and Install the Client
2. Set up Credentials

Before You Start
Ensure that your computer has Java version 1.8 installed.
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Ensure that your Operating System is one of these:

• Microsoft Windows 7

• Microsoft Windows 8

• Microsoft Windows 10

• Microsoft Windows 11

Ensure that your Operating System is one of these.

Required Privileges

To download the client, you must have access to My Oracle Support (support.oracle.com). To use the tool to import data
into Sales and Fusion Service you must be able to access REST services and import data for the objects.

Prerequisite Steps

The Data Loader client doesn't require any specific configuration within Sales and Fusion Service. However, you must
create an import map before using it. The client passes a mapping number value when submitting an import request.
You can't create a new import mapping from the Data Loader Client application.

Download and Install the Client
You can download the client from My Oracle Support (Doc ID 2325249.1).

The download contains a ZIP file, with sub-folders. Save the ZIP file to a directory in which the full file path contains no
white spaces. You must extract all of the files to a folder on your computer.

Note:  When executing the client from the command line the application uses the name oscdataloader.jar. For
example,

> java -jar oscdataloader.jar -h

Set up Credentials
You can install and use the client for automated imports while hiding the credentials that are used with the help of the
Credential Store. The Credential Wallet holds one set of user credentials (user name and password pair). To save your
credentials use the savepassword command,

> java -jar oscdataloader.jar savepassword -username John.Doe

Enter your password:

>

You are prompted to enter the password for the specified user name value. This password is masked so that it can't be
viewed in the command window. You can then use the tool to submit or retrieve the status or log files for an import by
only providing the user name value. This protects the password of the integration user by preventing other users from
viewing the password either on the command line (by scrolling back through recently executed commands, viewing the
password in the scheduling utility, or opening a configuration file containing the password value.

You can get the options for each command, by using the option -h for that command. For example, the following
command lists the options available for the submit command.

> java -jar oscdataloader.jar submit -h
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Use the Configuration File
The default configuration file is oscdataloader.config located in the config folder. This is used for all imports, unless
otherwise mentioned. You can use another configuration file using the -config parameter.

> java -jar oscdataloader.jar listimports -config c:\test\configfile.txt

The configuration file should have all parameters, with each line of the file containing a key-value pair. For example:

import-name=Testing

input-file=c:\\testing\\testing.csv

mapping-number=888100111272708

target-url=https://mypod.oracle.com

object=Account

username=john.doe

Note:  You can save your password by setting the parameter wallet=true in the oscdataloader.config file.

How is geography data updated? Are updates available
for all countries at the same time?  
When you import the geography data for a country for the first time you would get the latest Loqate geography data.
But if your Loqate geography data is more than three months old, you have to uptake the latest Loqate geography data
by following the steps in the Replace Existing Master Geography Data with Revised Oracle-Licensed Geography Data
topic.

Related Topics
• How do I replace the existing master geography data with revised Oracle-Licensed geography data?

How can I create a custom field and add it to CX Sales
Mobile?  
You can create a custom field and add it to the CX Sales Mobile application.

The configuration involves three major steps:

1. Create the custom field for the Sales application.
2. Make the field available in Adaptive Search.
3. Add the field to CX Sales Mobile UI using the CX Sales Mobile Composer tool in Application Composer.
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Create the Custom Field

1. Enter a sandbox where Application Composer is an active tool
2. Open Application Composer.

For example, you can open Application Composer by selecting it from the sandbox Tools menu.
3. In the left pane, search for the object for which you want to create the field.
4. Expand the object node.
5. Click Fields.
6. In the Fields page, click Create.
7. On the Select Field Type window, select the type of field you are creating.
8. Enter the required information for the field. What you enter is different for each field type. For details, see the

topic Field Types and Field Properties.
9. Make sure the Include in Service Payload check box is selected.

10. Click Save and Close.
11. Click on the sandbox name and select Publish.
12. On the Sandbox Details page, click Publish again.

Make the Field Available in Adaptive Search
Follow the instructions in the topic Make Additional Fields Searchable.

Add the Field to the CX Sales Mobile UI
Follow the instructions in the topic Configure the App Using the Configuration Tool and related topics in the
Implementation Reference guide.

What are the roles required to import or export data?  
You require certain duties and roles to perform activities related to import and export management. Oracle ships several
OOTB roles with access to Import and Export data from CX Sales. You can select and use administrator level roles as
needed.

You can get additional information about the duties and roles in the Security Reference for Sales and Fusion Service
guide.

Enhanced Data Privacy
You can only view import and export jobs that you submitted. You can't view the import and export jobs and associated
data files submitted by other users. However, you can still view import jobs as part of the management reporting
hierarchy. Managers can view their directs' imports and exports.

Administrators can configure this by setting the profile option ORA_ZCA_IMPEXP_RESTRICT_USERACCESS  to Y by
navigating to Setup and Maintenance  >  Search >  Manage Administrator Profile Values task  Search for the profile
option code.
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Roles for Import and Export
This table lists the set of roles required to import and export top-level objects. The values in brackets are the role codes.
In the case of multiple roles listed, you need any one of the mentioned roles.

Note:  You can import or export a child-level object if you have the role applicable to the parent object.

Object Name Recommended Role for Import and Export
(Code)

Administrator Level Roles (Code)

Access Groups
 

Customer Relationship Management
Application Administrator (ORA_ZCA_
CUSTOMER_RELATIONSHIP_MANAGEMENT_
APPLICATION_ADMINISTRATOR_JOB)
 

Customer Relationship Management
Application Administrator (ORA_ZCA_
CUSTOMER_RELATIONSHIP_MANAGEMENT_
APPLICATION_ADMINISTRATOR_JOB)
 

Account
 

Trading Community Import Batch Management
(ORA_MANAGE_TRADING_COMMUNITY_
IMPORT_BATCH_DUTY)
 

Sales Administrator (ORA_ZBS_SALES_
ADMINISTRATOR_JOB)
 

Action
 

Internal Service Request Administrator
(ORA_SVC_INTERNAL_HELPDESK_
ADMINISTRATION)
 

Service Request Administrator (ORA_SVC_SR_
ADMINISTRATOR)
 

Action Plan
 

Service Request Administrator (ORA_SVC_SR_
ADMINISTRATOR)
 
Internal Service Request Administration
(ORA_SVC_INTERNAL_HELPDESK_
ADMINISTRATION)
 
HR Help Desk Administration (ORA_SVC_
HELPDESK_ADMINISTRATION)
 

Service Request Administrator (ORA_SVC_SR_
ADMINISTRATOR)
 
Internal Service Request Administration
(ORA_SVC_INTERNAL_HELPDESK_
ADMINISTRATION)
 
HR Help Desk Administration (ORA_SVC_
HELPDESK_ADMINISTRATION)
 

Activity
 

Sales Administrator (ORA_ZBS_SALES_
ADMINISTRATOR_JOB), Sales Manager
(ORA_ZBS_SALES_MANAGER_JOB),
 Sales Representative (ORA_ZBS_SALES_
REPRESENTATIVE_JOB), Channel Administrator
(ORA_ZPM_CHANNEL_ADMINISTRATOR_
JOB), Channel Operations Manager (ORA_
ZPM_CHANNEL_OPERATIONS_MANAGER_
JOB), Marketing Operations Manager
(ORA_MKT_MARKETING_OPERATIONS_
MANAGER_JOB), Channel Partner Portal
Administrator (ORA_ZPM_CHANNEL_
PARTNER_PORTAL_ADMINISTRATOR_
JOB), Customer Relationship Management
Application Administrator (ORA_ZCA_
CUSTOMER_RELATIONSHIP_MANAGEMENT_
APPLICATION_ADMINISTRATOR_JOB)
 

Sales Administrator (ORA_ZBS_SALES_
ADMINISTRATOR_JOB) Customer Relationship
Management Application Administrator
(ORA_ZCA_CUSTOMER_RELATIONSHIP_
MANAGEMENT_APPLICATION_
ADMINISTRATOR_JOB),
 

Asset
 

Customer Relationship Management
Application Administrator (ORA_ZCA_
CUSTOMER_RELATIONSHIP_MANAGEMENT_
APPLICATION_ADMINISTRATOR_JOB)
 

Customer Relationship Management
Application Administrator (ORA_ZCA_
CUSTOMER_RELATIONSHIP_MANAGEMENT_
APPLICATION_ADMINISTRATOR_JOB),
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Object Name Recommended Role for Import and Export
(Code)

Administrator Level Roles (Code)

 Sales Administrator (ORA_ZBS_SALES_
ADMINISTRATOR_JOB)
 

Attachments
 

FUSION_APPS_CRM_ESS_APPID, FUSION_
APPS_CRM_ODI_APPID, FUSION_APPS_CRM_
SOA_APPID, Trading Community Import Batch
Management (ORA_MANAGE_TRADING_
COMMUNITY_IMPORT_BATCH_DUTY)
 
Sales Lead Processing (ORA_MKL_SALES_
LEAD_PROCESSING_DUTY)
 
Corporate Marketing Manager (ORA_MKT_
CORPORATE_MARKETING_MANAGER_JOB)
 
Marketing Analyst (ORA_MKT_MARKETING_
ANALYST_JOB)
 
Marketing Manager (ORA_MKT_MARKETING_
MANAGER_JOB)
 
Marketing Operations Manager (ORA_MKT_
MARKETING_OPERATIONS_MANAGER_JOB)
 
Marketing VP (ORA_MKT_MARKETING_VP_
JOB)
 
Opportunity Administration (ORA_MOO_
OPPORTUNITY_ADMINISTRATION_DUTY)
 
Customer Contract Administrator (ORA_OKC_
CUSTOMER_CONTRACT_ADMINISTRATOR_
JOB)
 
Customer Contract Manager (ORA_OKC_
CUSTOMER_CONTRACT_MANAGER_JOB)
 
Enterprise Contract Administrator (ORA_OKC_
ENTERPRISE_CONTRACT_ADMINISTRATOR_
JOB)
 
Enterprise Contract Manager (ORA_OKC_
ENTERPRISE_CONTRACT_MANAGER_JOB)
 
Supplier Contract Administrator (ORA_OKC_
SUPPLIER_CONTRACT_ADMINISTRATOR_JOB)
 
Supplier Contract Manager (ORA_OKC_
SUPPLIER_CONTRACT_MANAGER_JOB)
 
Subscription Specialist (ORA_OSS_
SUBSCRIPTION_SPECIALIST_JOB)
 
Sales Catalog Administrator (ORA_QSC_SALES_
CATALOG_ADMINISTRATOR_JOB)
 
HR Help Desk Administration (ORA_SVC_
HELPDESK_ADMINISTRATION)
 
Service Request Administrator (ORA_SVC_SR_
ADMINISTRATOR)

Customer Contract Administrator(ORA_OKC_
CUSTOMER_CONTRACT_ADMINISTRATOR_
JOB), Opportunity Administration (ORA_
MOO_OPPORTUNITY_ADMINISTRATION_
DUTY) , Enterprise Contract Administrator
(ORA_OKC_ENTERPRISE_CONTRACT_
ADMINISTRATOR_JOB), Supplier Contract
Administrator (ORA_OKC_SUPPLIER_
CONTRACT_ADMINISTRATOR_JOB), HR Help
Desk Administration (ORA_SVC_HELPDESK_
ADMINISTRATION), Sales Administrator
(ORA_ZBS_SALES_ADMINISTRATOR_JOB),
 Channel Administrator (ORA_ZPM_CHANNEL_
ADMINISTRATOR_JOB), Sales Administrator
(ORA_ZBS_SALES_ADMINISTRATOR_
JOB), Service Request Administrator
(ORA_SVC_SR_ADMINISTRATOR),
 Customer Relationship Management
Application Administrator (ORA_ZCA_
CUSTOMER_RELATIONSHIP_MANAGEMENT_
APPLICATION_ADMINISTRATOR_JOB)
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Object Name Recommended Role for Import and Export
(Code)

Administrator Level Roles (Code)

 
Sales Administrator (ORA_ZBS_SALES_
ADMINISTRATOR_JOB)
 
Sales Manager (ORA_ZBS_SALES_MANAGER_
JOB)
 
Sales Representative (ORA_ZBS_SALES_
REPRESENTATIVE_JOB)
 
Customer Relationship Management
Application Administrator (ORA_ZCA_
CUSTOMER_RELATIONSHIP_MANAGEMENT_
APPLICATION_ADMINISTRATOR_JOB)
 
Channel Account Manager (ORA_ZPM_
CHANNEL_ACCOUNT_MANAGER_JOB)
 
Channel Administrator (ORA_ZPM_CHANNEL_
ADMINISTRATOR_JOB)
 
Channel Operations Manager (ORA_ZPM_
CHANNEL_OPERATIONS_MANAGER_JOB)
 
Channel Partner Manager (ORA_ZPM_
CHANNEL_PARTNER_MANAGER_JOB)
 
Channel Partner Portal Administrator (ORA_
ZPM_CHANNEL_PARTNER_PORTAL_
ADMINISTRATOR_JOB)
 
Channel Sales Director (ORA_ZPM_CHANNEL_
SALES_DIRECTOR_JOB)
 
Channel Sales Manager (ORA_ZPM_CHANNEL_
SALES_MANAGER_JOB)
 
Sales Analyst (ORA_ZSP_SALES_ANALYST_
JOB)
 

Business Plan
 

Sales Administrator (ORA_ZBS_SALES_
ADMINISTRATOR_JOB)
 

Sales Administrator (ORA_ZBS_SALES_
ADMINISTRATOR_JOB)
 

Campaign
 

Sales Administrator (ORA_ZBS_SALES_
ADMINISTRATOR_JOB)
 

Sales Administrator (ORA_ZBS_SALES_
ADMINISTRATOR_JOB)
 

Case
 

Service Request Administrator (ORA_
SVC_SR_ADMINISTRATOR), HR Help Desk
Administration (ORA_SVC_HELPDESK_
ADMINISTRATION), Internal Service Request
Administration (ORA_SVC_INTERNAL_
HELPDESK_ADMINISTRATION)
 

Service Request Administrator (ORA_
SVC_SR_ADMINISTRATOR), HR Help Desk
Administration (ORA_SVC_HELPDESK_
ADMINISTRATION), Internal Service Request
Administration (ORA_SVC_INTERNAL_
HELPDESK_ADMINISTRATION)
 

Classification Code
 

Trading Community Import Batch Management
(ORA_MANAGE_TRADING_COMMUNITY_
IMPORT_BATCH_DUTY)
 

Sales Administrator (ORA_ZBS_SALES_
ADMINISTRATOR_JOB)
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Object Name Recommended Role for Import and Export
(Code)

Administrator Level Roles (Code)

Competitor
 

Sales Administrator (ORA_ZBS_SALES_
ADMINISTRATOR_JOB)
 

Sales Administrator (ORA_ZBS_SALES_
ADMINISTRATOR_JOB)
 

Consumer
 

Trading Community Import Batch Management
(ORA_MANAGE_TRADING_COMMUNITY_
IMPORT_BATCH_DUTY)
 

Trading Community Import Batch Management
(ORA_MANAGE_TRADING_COMMUNITY_
IMPORT_BATCH_DUTY)
 

Contact
 

Trading Community Import Batch Management
(ORA_MANAGE_TRADING_COMMUNITY_
IMPORT_BATCH_DUTY)
 

Sales Administrator (ORA_ZBS_SALES_
ADMINISTRATOR_JOB)
 

Contract
 

Customer Contract Administrator (ORA_OKC_
CUSTOMER_CONTRACT_ADMINISTRATOR_
JOB), Customer Contract Manager (ORA_OKC_
CUSTOMER_CONTRACT_MANAGER_JOB),
 Enterprise Contract Administrator (ORA_OKC_
ENTERPRISE_CONTRACT_ADMINISTRATOR_
JOB), Enterprise Contract Manager (ORA_OKC_
ENTERPRISE_CONTRACT_MANAGER_JOB),
 Supplier Contract Administrator (ORA_OKC_
SUPPLIER_CONTRACT_ADMINISTRATOR_
JOB), Supplier Contract Manager (ORA_OKC_
SUPPLIER_CONTRACT_MANAGER_JOB)
 

Customer Contract Administrator (ORA_OKC_
CUSTOMER_CONTRACT_ADMINISTRATOR_
JOB), Customer Contract Manager (ORA_OKC_
CUSTOMER_CONTRACT_MANAGER_JOB),
 Enterprise Contract Administrator (ORA_OKC_
ENTERPRISE_CONTRACT_ADMINISTRATOR_
JOB), Enterprise Contract Manager (ORA_OKC_
ENTERPRISE_CONTRACT_MANAGER_JOB),
 Supplier Contract Administrator (ORA_OKC_
SUPPLIER_CONTRACT_ADMINISTRATOR_
JOB), Supplier Contract Manager (ORA_OKC_
SUPPLIER_CONTRACT_MANAGER_JOB)
 

Contests
 

Sales Administrator (ORA_ZBS_SALES_
ADMINISTRATOR_JOB)
 

Sales Administrator (ORA_ZBS_SALES_
ADMINISTRATOR_JOB)
 

Country Structure
 

Geography Administration (ORA_GEO_ADMIN_
DUTY)
 

Geography Administration (ORA_GEO_ADMIN_
DUTY)
 

Custom Object
 

Custom Objects Administration (ORA_
CRM_EXTN_ROLE), Customer Relationship
Management Application Administrator
(ORA_ZCA_CUSTOMER_RELATIONSHIP_
MANAGEMENT_APPLICATION_
ADMINISTRATOR_JOB), Sales Administrator
(ORA_ZBS_SALES_ADMINISTRATOR_JOB)
 

Custom Objects Administration (ORA_
CRM_EXTN_ROLE), Customer Relationship
Management Application Administrator
(ORA_ZCA_CUSTOMER_RELATIONSHIP_
MANAGEMENT_APPLICATION_
ADMINISTRATOR_JOB)
 

Deal Registration
 

Sales Administrator (ORA_ZBS_SALES_
ADMINISTRATOR_JOB), Channel Operations
Manager (ORA_ZPM_CHANNEL_OPERATIONS_
MANAGER_JOB)
 

Sales Administrator (ORA_ZBS_SALES_
ADMINISTRATOR_JOB), Channel Operations
Manager (ORA_ZPM_CHANNEL_OPERATIONS_
MANAGER_JOB)
 

Duplicate Resolution Request
 

ORA_ZCH_DATA_STEWARD_MANAGER
 

ORA_ZCH_DATA_STEWARD_MANAGER
 

Event
 

Sales Administrator (ORA_ZBS_SALES_
ADMINISTRATOR_JOB)
 

Sales Administrator (ORA_ZBS_SALES_
ADMINISTRATOR_JOB)
 

Event Team Member
 

Sales Administrator (ORA_ZBS_SALES_
ADMINISTRATOR_JOB)
 

Sales Administrator (ORA_ZBS_SALES_
ADMINISTRATOR_JOB)
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Object Name Recommended Role for Import and Export
(Code)

Administrator Level Roles (Code)

Geography
 

Geography Administration (ORA_GEO_ADMIN_
DUTY)
 

Geography Administration (ORA_GEO_ADMIN_
DUTY)
 

Goals
 

Sales Administrator (ORA_ZBS_SALES_
ADMINISTRATOR_JOB)
 

Sales Administrator (ORA_ZBS_SALES_
ADMINISTRATOR_JOB)
 

Hierarchy
 

Trading Community Import Batch Management
(ORA_MANAGE_TRADING_COMMUNITY_
IMPORT_BATCH_DUTY)
 

Sales Administrator (ORA_ZBS_SALES_
ADMINISTRATOR_JOB)
 

Hierarchy Member
 

Trading Community Import Batch Management
(ORA_MANAGE_TRADING_COMMUNITY_
IMPORT_BATCH_DUTY)
 

Trading Community Import Batch Management
(ORA_MANAGE_TRADING_COMMUNITY_
IMPORT_BATCH_DUTY)
 

Household
 

Sales Administrator (ORA_ZBS_SALES_
ADMINISTRATOR_JOB)
 

Sales Administrator (ORA_ZBS_SALES_
ADMINISTRATOR_JOB)
 

Hub Source System Reference
 

Trading Community Import Batch Management
(ORA_MANAGE_TRADING_COMMUNITY_
IMPORT_BATCH_DUTY)
 

Trading Community Import Batch Management
(ORA_MANAGE_TRADING_COMMUNITY_
IMPORT_BATCH_DUTY)
 

Incentive Rule Assignments
 

Incentive Compensation Analyst (ORA_
CN_INCENTIVE_COMPENSATION_
ANALYST_JOB), Incentive Compensation
Integration Specialist (ORA_CN_INCENTIVE_
COMPENSATION_INTEGRATION_SPECIALIST_
JOB), Incentive Compensation Manager
(ORA_CN_INCENTIVE_COMPENSATION_
MANAGER_JOB), Incentive Compensation
Plan Administrator (ORA_CN_INCENTIVE_
COMPENSATION_PLAN_ADMINISTRATOR_
JOB), Customer Relationship Management
Application Administrator (ORA_ZCA_
CUSTOMER_RELATIONSHIP_MANAGEMENT_
APPLICATION_ADMINISTRATOR_JOB)
 

Incentive Compensation Analyst (ORA_
CN_INCENTIVE_COMPENSATION_
ANALYST_JOB), Incentive Compensation
Integration Specialist (ORA_CN_INCENTIVE_
COMPENSATION_INTEGRATION_SPECIALIST_
JOB), Incentive Compensation Manager
(ORA_CN_INCENTIVE_COMPENSATION_
MANAGER_JOB), Incentive Compensation
Plan Administrator (ORA_CN_INCENTIVE_
COMPENSATION_PLAN_ADMINISTRATOR_
JOB), Customer Relationship Management
Application Administrator (ORA_ZCA_
CUSTOMER_RELATIONSHIP_MANAGEMENT_
APPLICATION_ADMINISTRATOR_JOB)
 

Incentive Rule Attribute Values
 

Incentive Compensation Analyst (ORA_
CN_INCENTIVE_COMPENSATION_
ANALYST_JOB), Incentive Compensation
Integration Specialist (ORA_CN_INCENTIVE_
COMPENSATION_INTEGRATION_SPECIALIST_
JOB), Incentive Compensation Manager
(ORA_CN_INCENTIVE_COMPENSATION_
MANAGER_JOB), Incentive Compensation
Plan Administrator (ORA_CN_INCENTIVE_
COMPENSATION_PLAN_ADMINISTRATOR_
JOB), Customer Relationship Management
Application Administrator (ORA_ZCA_
CUSTOMER_RELATIONSHIP_MANAGEMENT_
APPLICATION_ADMINISTRATOR_JOB)
 

Incentive Compensation Analyst (ORA_
CN_INCENTIVE_COMPENSATION_
ANALYST_JOB), Incentive Compensation
Integration Specialist (ORA_CN_INCENTIVE_
COMPENSATION_INTEGRATION_SPECIALIST_
JOB), Incentive Compensation Manager
(ORA_CN_INCENTIVE_COMPENSATION_
MANAGER_JOB), Incentive Compensation
Plan Administrator (ORA_CN_INCENTIVE_
COMPENSATION_PLAN_ADMINISTRATOR_
JOB), Customer Relationship Management
Application Administrator (ORA_ZCA_
CUSTOMER_RELATIONSHIP_MANAGEMENT_
APPLICATION_ADMINISTRATOR_JOB)
 

Incentive Rules
 

Incentive Compensation Analyst (ORA_
CN_INCENTIVE_COMPENSATION_
ANALYST_JOB), Incentive Compensation

Incentive Compensation Analyst (ORA_
CN_INCENTIVE_COMPENSATION_
ANALYST_JOB), Incentive Compensation
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Object Name Recommended Role for Import and Export
(Code)

Administrator Level Roles (Code)

Integration Specialist (ORA_CN_INCENTIVE_
COMPENSATION_INTEGRATION_SPECIALIST_
JOB), Incentive Compensation Manager
(ORA_CN_INCENTIVE_COMPENSATION_
MANAGER_JOB), Incentive Compensation
Plan Administrator (ORA_CN_INCENTIVE_
COMPENSATION_PLAN_ADMINISTRATOR_
JOB), Customer Relationship Management
Application Administrator (ORA_ZCA_
CUSTOMER_RELATIONSHIP_MANAGEMENT_
APPLICATION_ADMINISTRATOR_JOB)
 

Integration Specialist (ORA_CN_INCENTIVE_
COMPENSATION_INTEGRATION_SPECIALIST_
JOB), Incentive Compensation Manager
(ORA_CN_INCENTIVE_COMPENSATION_
MANAGER_JOB), Incentive Compensation
Plan Administrator (ORA_CN_INCENTIVE_
COMPENSATION_PLAN_ADMINISTRATOR_
JOB), Customer Relationship Management
Application Administrator (ORA_ZCA_
CUSTOMER_RELATIONSHIP_MANAGEMENT_
APPLICATION_ADMINISTRATOR_JOB)
 

Incentive Transaction
 

Incentive Compensation Analyst (ORA_
CN_INCENTIVE_COMPENSATION_
ANALYST_JOB), Incentive Compensation
Integration Specialist (ORA_CN_INCENTIVE_
COMPENSATION_INTEGRATION_SPECIALIST_
JOB), Incentive Compensation Manager
(ORA_CN_INCENTIVE_COMPENSATION_
MANAGER_JOB), Incentive Compensation
Plan Administrator (ORA_CN_INCENTIVE_
COMPENSATION_PLAN_ADMINISTRATOR_
JOB), Customer Relationship Management
Application Administrator (ORA_ZCA_
CUSTOMER_RELATIONSHIP_MANAGEMENT_
APPLICATION_ADMINISTRATOR_JOB)
 

Incentive Compensation Plan Administrator
(ORA_CN_INCENTIVE_COMPENSATION_
PLAN_ADMINISTRATOR_JOB), Customer
Relationship Management Application
Administrator (ORA_ZCA_CUSTOMER_
RELATIONSHIP_MANAGEMENT_
APPLICATION_ADMINISTRATOR_JOB)
 

Interaction
 

Service Request Administrator (ORA_
SVC_SR_ADMINISTRATOR), HR Help Desk
Administration (ORA_SVC_HELPDESK_
ADMINISTRATION), Internal Service Request
Administration(ORA_SVC_INTERNAL_
HELPDESK_ADMINISTRATION)
 

Service Request Administrator (ORA_
SVC_SR_ADMINISTRATOR), HR Help Desk
Administration (ORA_SVC_HELPDESK_
ADMINISTRATION), Internal Service Request
Administration(ORA_SVC_INTERNAL_
HELPDESK_ADMINISTRATION)
 

Kpi
 

Sales Administrator (ORA_ZBS_SALES_
ADMINISTRATOR_JOB)
 

Sales Administrator (ORA_ZBS_SALES_
ADMINISTRATOR_JOB)
 

MDF Budget
 

Sales Administrator (ORA_ZBS_SALES_
ADMINISTRATOR_JOB), Channel Operations
Manager (ORA_ZPM_CHANNEL_OPERATIONS_
MANAGER_JOB), Marketing Operations
Manager (ORA_MKT_MARKETING_
OPERATIONS_MANAGER_JOB)
 

Sales Administrator (ORA_ZBS_SALES_
ADMINISTRATOR_JOB), Channel Operations
Manager (ORA_ZPM_CHANNEL_OPERATIONS_
MANAGER_JOB)
 

MDF Claim
 

Sales Administrator (ORA_ZBS_SALES_
ADMINISTRATOR_JOB), Channel Operations
Manager (ORA_ZPM_CHANNEL_OPERATIONS_
MANAGER_JOB), Marketing Operations
Manager (ORA_MKT_MARKETING_
OPERATIONS_MANAGER_JOB)
 

Sales Administrator (ORA_ZBS_SALES_
ADMINISTRATOR_JOB), Channel Operations
Manager (ORA_ZPM_CHANNEL_OPERATIONS_
MANAGER_JOB)
 

MDF Request
 

Sales Administrator (ORA_ZBS_SALES_
ADMINISTRATOR_JOB), Channel Operations
Manager (ORA_ZPM_CHANNEL_OPERATIONS_
MANAGER_JOB), Marketing Operations

Sales Administrator (ORA_ZBS_SALES_
ADMINISTRATOR_JOB), Channel Operations
Manager (ORA_ZPM_CHANNEL_OPERATIONS_
MANAGER_JOB)
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Manager (ORA_MKT_MARKETING_
OPERATIONS_MANAGER_JOB)
 

Note
 

Sales Administrator (ORA_ZBS_SALES_
ADMINISTRATOR_JOB), Sales Manager
(ORA_ZBS_SALES_MANAGER_JOB),
 Sales Representative (ORA_ZBS_SALES_
REPRESENTATIVE_JOB), Marketing
Operations Manager (ORA_MKT_
MARKETING_OPERATIONS_MANAGER_
JOB), Customer Relationship Management
Application Administrator (ORA_ZCA_
CUSTOMER_RELATIONSHIP_MANAGEMENT_
APPLICATION_ADMINISTRATOR_JOB),
 FUSION_APPS_CRM_ESS_APPID, FUSION_
APPS_CRM_ODI_APPID, FUSION_APPS_CRM_
SOA_APPID
 

Sales Administrator (ORA_ZBS_SALES_
ADMINISTRATOR_JOB), Customer Relationship
Management Application Administrator
(ORA_ZCA_CUSTOMER_RELATIONSHIP_
MANAGEMENT_APPLICATION_
ADMINISTRATOR_JOB)
 

Objective
 

Sales Administrator (ORA_ZBS_SALES_
ADMINISTRATOR_JOB)
 

Sales Administrator (ORA_ZBS_SALES_
ADMINISTRATOR_JOB)
 

Opportunity
 

Opportunity Administration (ORA_MOO_
OPPORTUNITY_ADMINISTRATION_DUTY) ,
 Sales Administrator (ORA_ZBS_SALES_
ADMINISTRATOR_JOB), FUSION_APPS_CRM_
ESS_APPID, FUSION_APPS_CRM_ODI_APPID,
 FUSION_APPS_CRM_SOA_APPID
 

Opportunity Administration (ORA_MOO_
OPPORTUNITY_ADMINISTRATION_DUTY) ,
 Sales Administrator (ORA_ZBS_SALES_
ADMINISTRATOR_JOB)
 

Organization
 

Trading Community Import Batch Management
(ORA_MANAGE_TRADING_COMMUNITY_
IMPORT_BATCH_DUTY)
 

Sales Administrator (ORA_ZBS_SALES_
ADMINISTRATOR_JOB)
 

Partner
 

Sales Administrator (ORA_ZBS_SALES_
ADMINISTRATOR_JOB), Channel Operations
Manager (ORA_ZPM_CHANNEL_OPERATIONS_
MANAGER_JOB)
 

Sales Administrator (ORA_ZBS_SALES_
ADMINISTRATOR_JOB), Channel Operations
Manager (ORA_ZPM_CHANNEL_OPERATIONS_
MANAGER_JOB)
 

Partner Programs
 

Channel Operations Manager (ORA_ZPM_
CHANNEL_OPERATIONS_MANAGER_JOB)
 

Channel Operations Manager (ORA_ZPM_
CHANNEL_OPERATIONS_MANAGER_JOB)
 

Person
 

Trading Community Import Batch Management
(ORA_MANAGE_TRADING_COMMUNITY_
IMPORT_BATCH_DUTY)
 

Sales Administrator (ORA_ZBS_SALES_
ADMINISTRATOR_JOB)
 

Price Book Header
 

Sales Administrator (ZBS_SALES_
ADMINISTRATOR_JOB)
 

Sales Administrator (ZBS_SALES_
ADMINISTRATOR_JOB)
 

Product
 

Sales Administrator (ZBS_SALES_
ADMINISTRATOR_JOB)
 

Sales Administrator (ZBS_SALES_
ADMINISTRATOR_JOB)
 

Product Group
 

Sales Catalog Administrator (ORA_QSC_
SALES_CATALOG_ADMINISTRATOR_JOB),

Sales Administrator (ORA_ZBS_SALES_
ADMINISTRATOR_JOB)
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 Sales Administrator (ORA_ZBS_SALES_
ADMINISTRATOR_JOB)
 

 

Program Enrollments
 

Channel Operations Manager (ORA_ZPM_
CHANNEL_OPERATIONS_MANAGER_JOB)
 

Channel Operations Manager (ORA_ZPM_
CHANNEL_OPERATIONS_MANAGER_JOB)
 

Promotion
 

Loyalty Program Administrator (ORA_LOY_
LOYALTY_PROGRAM_ADMINISTRATOR_JOB)
 

Loyalty Program Administrator (ORA_LOY_
LOYALTY_PROGRAM_ADMINISTRATOR_JOB)
 

Queue
 

Service Request Administrator (ORA_
SVC_SR_ADMINISTRATOR), HR Help Desk
Administration(ORA_SVC_HELPDESK_
ADMINISTRATION), Internal Service Request
Administration (ORA_SVC_INTERNAL_
HELPDESK_ADMINISTRATION)
 

Service Request Administrator (ORA_
SVC_SR_ADMINISTRATOR), HR Help Desk
Administration(ORA_SVC_HELPDESK_
ADMINISTRATION), Internal Service Request
Administration (ORA_SVC_INTERNAL_
HELPDESK_ADMINISTRATION)
 

Quote and Order
 

Sales Administrator (ORA_ZBS_SALES_
ADMINISTRATOR_JOB)
 

Sales Administrator (ORA_ZBS_SALES_
ADMINISTRATOR_JOB)
 

Resource
 

Sales Administrator (ORA_ZBS_SALES_
ADMINISTRATOR_JOB)
 

Sales Administrator (ORA_ZBS_SALES_
ADMINISTRATOR_JOB)
 

Resource Capacity
 

Service Request Administrator (ORA_
SVC_SR_ADMINISTRATOR), HR Help Desk
Administration(ORA_SVC_HELPDESK_
ADMINISTRATION), Internal Service Request
Administration (ORA_SVC_INTERNAL_
HELPDESK_ADMINISTRATION)
 

Service Request Administrator (ORA_
SVC_SR_ADMINISTRATOR), HR Help Desk
Administration(ORA_SVC_HELPDESK_
ADMINISTRATION), Internal Service Request
Administration (ORA_SVC_INTERNAL_
HELPDESK_ADMINISTRATION)
 

Sales Lead
 

Marketing Analyst (ORA_MKT_MARKETING_
ANALYST_JOB), Sales Administrator (ORA_
ZBS_SALES_ADMINISTRATOR_JOB), Marketing
Manager (ORA_MKT_MARKETING_MANAGER_
JOB), Sales Lead Processing (ORA_MKL_
SALES_LEAD_PROCESSING_DUTY), Marketing
Operations Manager (ORA_MKT_MARKETING_
OPERATIONS_MANAGER_JOB), Corporate
Marketing Manager (ORA_MKT_CORPORATE_
MARKETING_MANAGER_JOB), Marketing
VP (ORA_MKT_MARKETING_VP_JOB), Sales
Analyst (ORA_ZSP_SALES_ANALYST_JOB),
 FUSION_APPS_CRM_ODI_APPID, FUSION_
APPS_CRM_SOA_APPID, FUSION_APPS_CRM_
ESS_APPID
 

Sales Administrator (ORA_ZBS_SALES_
ADMINISTRATOR_JOB), Sales Lead Processing
(ORA_MKL_SALES_LEAD_PROCESSING_DUTY)
 

Sales Territory
 

Customer Relationship Management
Application Administrator (ORA_ZCA_
CUSTOMER_RELATIONSHIP_MANAGEMENT_
APPLICATION_ADMINISTRATOR_JOB),
 Sales Administrator (ORA_ZBS_SALES_
ADMINISTRATOR_JOB), Territory Management
Administration (ORA_MOT_TERRITORY_
MANAGEMENT_ADMINISTRATION_DUTY),
 Sales Manager (ORA_ZBS_SALES_MANAGER_

Customer Relationship Management
Application Administrator (ORA_ZCA_
CUSTOMER_RELATIONSHIP_MANAGEMENT_
APPLICATION_ADMINISTRATOR_JOB),
 Sales Administrator (ORA_ZBS_SALES_
ADMINISTRATOR_JOB), Territory Management
Administration (ORA_MOT_TERRITORY_
MANAGEMENT_ADMINISTRATION_DUTY)
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Object Name Recommended Role for Import and Export
(Code)

Administrator Level Roles (Code)

JOB), Sales Restricted User (ORA_ZBS_SALES_
RESTRICTED_USER_JOB), Sales VP (ORA_ZBS_
SALES_VP_JOB), Channel Account Manager
(ORA_ZPM_CHANNEL_ACCOUNT_MANAGER_
JOB), Channel Operations Manager (ORA_
ZPM_CHANNEL_OPERATIONS_MANAGER_
JOB), Channel Partner Manager (ORA_ZPM_
CHANNEL_PARTNER_MANAGER_JOB),
 Channel Sales Director (ORA_ZPM_CHANNEL_
SALES_DIRECTOR_JOB), Channel Sales
Manager (ORA_ZPM_CHANNEL_SALES_
MANAGER_JOB), FUSION_APPS_OBIA_BIEE_
APPID, FUSION_APPS_CRM_ESS_APPID,
 FUSION_APPS_CRM_ADF_BI_APPID
 

Sales Territory Quota
 

Customer Relationship Management
Application Administrator (ORA_ZCA_
CUSTOMER_RELATIONSHIP_MANAGEMENT_
APPLICATION_ADMINISTRATOR_JOB),
 Sales Administrator (ORA_ZBS_SALES_
ADMINISTRATOR_JOB), Territory Management
Administration (ORA_MOT_TERRITORY_
MANAGEMENT_ADMINISTRATION_DUTY),
 Sales Manager (ORA_ZBS_SALES_MANAGER_
JOB), Sales Restricted User (ORA_ZBS_SALES_
RESTRICTED_USER_JOB), Sales VP (ORA_ZBS_
SALES_VP_JOB), Channel Account Manager
(ORA_ZPM_CHANNEL_ACCOUNT_MANAGER_
JOB), Channel Operations Manager (ORA_
ZPM_CHANNEL_OPERATIONS_MANAGER_
JOB), Channel Partner Manager (ORA_ZPM_
CHANNEL_PARTNER_MANAGER_JOB),
 Channel Sales Director (ORA_ZPM_CHANNEL_
SALES_DIRECTOR_JOB), Channel Sales
Manager (ORA_ZPM_CHANNEL_SALES_
MANAGER_JOB)
 

Customer Relationship Management
Application Administrator (ORA_ZCA_
CUSTOMER_RELATIONSHIP_MANAGEMENT_
APPLICATION_ADMINISTRATOR_JOB),
 Sales Administrator (ORA_ZBS_SALES_
ADMINISTRATOR_JOB), Territory Management
Administration (ORA_MOT_TERRITORY_
MANAGEMENT_ADMINISTRATION_DUTY)
 

Self Service Role
 

Service Request Administrator (ORA_SVC_SR_
ADMINISTRATOR)
 

Service Request Administrator (ORA_SVC_SR_
ADMINISTRATOR)
 

Service Request
 

Service Request Administrator (ORA_SVC_
SR_ADMINISTRATOR), HR Help Desk Service
Request Management (ORA_SVC_HELPDESK_
SR_MANAGEMENT), HR Help Desk Analysis
(ORA_SVC_HELPDESK_ANALYSIS), HR Help
Desk Administration (ORA_SVC_HELPDESK_
ADMINISTRATION)
 

Service Request Administrator (ORA_SVC_
SR_ADMINISTRATOR), HR Help Desk Service
Request Management (ORA_SVC_HELPDESK_
SR_MANAGEMENT)
 

Standard Text
 

Service Request Administrator (ORA_
SVC_SR_ADMINISTRATOR), HR Help Desk
Service Request Management (ORA_SVC_
HELPDESK_SR_MANAGEMENT), HR Help Desk
Analysis (ORA_SVC_HELPDESK_ANALYSIS),
 HR Help Desk Administration (ORA_SVC_
HELPDESK_ADMINISTRATION), Internal
Service Request Administration (ORA_SVC_
INTERNAL_HELPDESK_ADMINISTRATION),
 Internal Service Request Analysis (ORA_SVC_

Service Request Administrator (ORA_SVC_
SR_ADMINISTRATOR), HR Help Desk Service
Request Management (ORA_SVC_HELPDESK_
SR_MANAGEMENT), Internal Service Request
Administration (ORA_SVC_INTERNAL_
HELPDESK_ADMINISTRATION)
 

103



Oracle Fusion Cloud Sales Automation
Sales Questions and Answers

Chapter 1
Sales Questions and Answers

Object Name Recommended Role for Import and Export
(Code)

Administrator Level Roles (Code)

INTERNAL_HELPDESK_ANALYSIS), Internal
Service Request Management (ORA_SVC_
INTERNAL_HELPDESK_SR_MANAGEMENT),
 Service Request Channel User (ORA_SVC_
SR_CHANNEL_USER), Service Request Power
User (ORA_SVC_SR_POWER_USER), Service
Request Troubleshooter (ORA_SVC_SR_
TROUBLESHOOTER)
 

Standard Text Folder
 

Service Request Administrator (ORA_
SVC_SR_ADMINISTRATOR), HR Help Desk
Service Request Management (ORA_SVC_
HELPDESK_SR_MANAGEMENT), HR Help Desk
Analysis (ORA_SVC_HELPDESK_ANALYSIS),
 HR Help Desk Administration (ORA_SVC_
HELPDESK_ADMINISTRATION), Internal
Service Request Administration (ORA_SVC_
INTERNAL_HELPDESK_ADMINISTRATION),
 Internal Service Request Analysis (ORA_SVC_
INTERNAL_HELPDESK_ANALYSIS), Internal
Service Request Management (ORA_SVC_
INTERNAL_HELPDESK_SR_MANAGEMENT),
 Service Request Channel User (ORA_SVC_
SR_CHANNEL_USER), Service Request Power
User (ORA_SVC_SR_POWER_USER), Service
Request Troubleshooter (ORA_SVC_SR_
TROUBLESHOOTER)
 

Service Request Administrator (ORA_SVC_
SR_ADMINISTRATOR), HR Help Desk Service
Request Management (ORA_SVC_HELPDESK_
SR_MANAGEMENT), Internal Service Request
Administration (ORA_SVC_INTERNAL_
HELPDESK_ADMINISTRATION)
 

Standard Text User Variables
 

Service Request Administrator (ORA_
SVC_SR_ADMINISTRATOR), HR Help Desk
Service Request Management (ORA_SVC_
HELPDESK_SR_MANAGEMENT), HR Help Desk
Analysis (ORA_SVC_HELPDESK_ANALYSIS),
 HR Help Desk Administration (ORA_SVC_
HELPDESK_ADMINISTRATION), Internal
Service Request Administration (ORA_SVC_
INTERNAL_HELPDESK_ADMINISTRATION),
 Internal Service Request Analysis (ORA_SVC_
INTERNAL_HELPDESK_ANALYSIS), Internal
Service Request Management (ORA_SVC_
INTERNAL_HELPDESK_SR_MANAGEMENT),
 Service Request Channel User (ORA_SVC_
SR_CHANNEL_USER), Service Request Power
User (ORA_SVC_SR_POWER_USER), Service
Request Troubleshooter (ORA_SVC_SR_
TROUBLESHOOTER)
 

Service Request Administrator (ORA_SVC_
SR_ADMINISTRATOR), HR Help Desk Service
Request Management (ORA_SVC_HELPDESK_
SR_MANAGEMENT), Internal Service Request
Administration (ORA_SVC_INTERNAL_
HELPDESK_ADMINISTRATION)
 

Subscription
 

Subscription Specialist (ORA_OSS_
SUBSCRIPTION_SPECIALIST_JOB)
 

Subscription Specialist (ORA_OSS_
SUBSCRIPTION_SPECIALIST_JOB)
 

Subscription Service Charge Mappings
 

Subscription Specialist (ORA_OSS_
SUBSCRIPTION_SPECIALIST_JOB)
 

Subscription Specialist (ORA_OSS_
SUBSCRIPTION_SPECIALIST_JOB)
 

Subscription Usage Event
 

Subscription Specialist (ORA_OSS_
SUBSCRIPTION_SPECIALIST_JOB)
 

Subscription Specialist (ORA_OSS_
SUBSCRIPTION_SPECIALIST_JOB)
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Template
 

Service Request Administrator (ORA_
SVC_SR_ADMINISTRATOR), HR Help Desk
Administration (ORA_SVC_HELPDESK_
ADMINISTRATION), Internal Service Request
Administration (ORA_SVC_INTERNAL_
HELPDESK_ADMINISTRATION)
 

Service Request Administrator (ORA_
SVC_SR_ADMINISTRATOR), HR Help Desk
Administration (ORA_SVC_HELPDESK_
ADMINISTRATION), Internal Service Request
Administration (ORA_SVC_INTERNAL_
HELPDESK_ADMINISTRATION)
 

Territory Geographies
 

Geography Administration (ORA_GEO_ADMIN_
DUTY)
 

Geography Administration (ORA_GEO_ADMIN_
DUTY)
 

Vehicles
 

Sales Administrator (ORA_ZBS_SALES_
ADMINISTRATOR_JOB)
 

Sales Administrator (ORA_ZBS_SALES_
ADMINISTRATOR_JOB)
 

Related Topics
• Schedule the Send Pending LDAP Requests Process

Why is Import Geography Data Disabled in Manage
Geographies?  

Import Geography Data is disabled for a country if the geography data for that country isn't available from Loqate or
if the geography structure or hierarchy is already defined for that country. The existing master geography hierarchy
can be from Loqate or non-Loqate geography data providers. For example, Pakistan isn't supported currently in the
supported list of 82 countries. If you try to import geography data for Pakistan after defining geography structure or
geography hierarchy for it, Pakistan would be greyed out in the import list.

Note:  If the hierarchy is defined, delete the geography hierarchy data first and then the geography structure.

How do I import geographies?  
A geography, such as Tokyo or Peru, describes a boundary on the surface of the earth.

You can use the following options when importing geographies:

• Oracle-licensed geography reference data

• Import Management

Note:  The processing time for importing geography data can vary based on several variables, such as, the volume of
data to be loaded and it could take several hours to complete.
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Oracle-Licensed Geography Reference Data
You can import Oracle-licensed data from Loqate, for those countries where the data is available. For more information
about the supported countries, see the List of Available Countries with Loqate Geography Reference Data topic. You
can import geography data using the Manage Geographies task. Search for the country, and select Import Geography
Data from the Actions menu. If the licensed data isn't available or already set up for a particular country, then the
Import Geography Data action is disabled.

Note:
• If you are licensed to use HCM Cloud Payroll for the United States, you must import your geography data from

Vertex. For more information, see the United States Payroll implementation and administering guides.

• If you are licensed to use HCM Cloud Payroll for Canada, you can import your geography data from either
Loqate, or your own geography data vendor. Loqate is the Oracle-licensed geography vendor across all Oracle
applications, but it isn’t mandatory. You may use any other geography vendor, but it must be comparable in
structure by using a 2-character province code. For more information, see the Canada Payroll implementation
and administering guides.

• By exporting this "Geography" data from the Oracle environment to Your environment, You agree that (a)
Oracle is granting You only a restricted right to download the exported data specifically for Your use with the
Oracle Fusion services, (b) this data may not be used, transferred, or uploaded for any other purposes; and (c)
except for the restricted right granted in (a), all provisions of the Oracle Cloud Services Agreement (CSA) or
Schedule C, as applicable to You, remain in full force and effect, including specifically section 3.4 thereof.

• Geography Round-Trip Export Import is currently not supported.

Import Management
The Import Management process reads the data included in your XML or text file and imports the data into the
application.

To access Import Management functionality, go to Navigator >  Tools  >  Import Management

For more information, see the Import Your Geography Data topic.

Import Geography Data is disabled for a country if the geography data for that country isn't available from Loqate or if
the geography structure or hierarchy is already defined for that country. The existing master geography hierarchy can
be from Loqate or non-Loqate. For example, Pakistan isn't supported currently in the supported list of 82 countries. If
you try to import geography data for Pakistan after defining geography structure or geography hierarchy for it, Pakistan
would be greyed out in the import list.
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Related Topics
• Overview of Implementing Customer Data Management

• Setup Data Import and Export for Oracle Accounting Hub Cloud

• Create Legal Jurisdictions, Addresses and Authorities

How do I group data in saved searches and visualizations
by team members?  
To group data, including by the different team members in saved searches and their visualizations, you enable the Team
Members attribute for the Group By feature in Adaptive Search. You can then use the Team Members field to group data
in your search and the resulting visualization.

Here's the setup overview:

1. If you're using Workspace in the classic Sales UI, then enable the Group By feature for Workspace. This step isn't
required for Sales in the Redwood user experience.

See the Enable the Group By Feature for Workspace section for detailed steps.
2. Enable the Team Members and Team Member fields for Group By in the Configure UI tab on the Configure

Adaptive Search page.

See the Enable Team Member Fields for Group By section for detailed steps.
3. Create the saved search with the Team Members group by selected.

See the topic Create Saved Searches for the Sales Organization.
4. Create the visualization from the saved search as described in the topic Create a Visualization of a Saved

Search or an Analysis.

Enable the Group By Feature for Workspace
1. Click Navigator  > My Enterprise  >  Setup and Maintenance.
2. In the Setup and Maintenance work area, open the Configure Adaptive Search task.

◦ Offering: Sales

◦ Functional Area: Sales Foundation

◦ Task: Configure Adaptive Search

3. On the Configure Adaptive Search page, click the Parameters tab.
4. Highlight the Enable Group By and click Edit.
5. In the Warning message, click Yes.
6. In the Current Value field, change the value from N to Y and click Save and Close.

Enable Team Member Fields for Group By

1. Sign in as a setup user.
2. Navigate to the Setup and Maintenance work area, and open the Configure Adaptive Search task :
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◦ Offering: Sales

◦ Functional Area: Sales Foundation

◦ Show: All Tasks

◦ Task: Configure Adaptive Search

3. On the Configure Adaptive Search page, click the Configure UI tab.
4. Select the object you want to set up for your Group By in the left pane of the tab and open the object hierarchy

to locate Team Members and Team Member.

5. Select the Enable for Group By option for both Team Members and Team Member fields.

Note:  Ensure that the Display in UI option is also selected

6. Click Save and Close.
7. Sign out and then sign in again to see your changes.

No publishing is required to see the option in the group by. The changes you made are reflected in the Workspace UI for
the Group By field drop down lists for the selected object.

Related Topics
• Create Saved Searches for the Sales Organization

• Create a Visualization of a Saved Search or an Analysis

How can I enable multiple addresses for accounts?  
Here's how to enable multiple addresses for accounts. You can use similar steps to enable multiple addresses for
contacts and for other sales objects that display addresses, such as households.
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Create and Enter a Sandbox
Create and enter a sandbox with the Application Composer tool enabled.

1. In the Navigator, click Configuration > Sandboxes.
2. Click Create Sandbox.
3. Enter a sandbox name.
4. Select Active for Application Composer.
5. Click Create and Enter.
6. From the sandbox Tools menu, select Application Composer to enter the tool.

Display Multiple Addresses on the Account Profile Tab
While in Application Composer, expose Multiple Addresses in a custom layout:

1. Open the Standard Objects node on the left panel.

Open the Account node.
2. Click Pages
3. On the Application Pages tab, scroll down to the Details Page Layouts section.
4. Select Standard Layout and click Duplicate.
5. In the Duplicate Layout window, enter a new name for your layout or just click Save and Edit.
6. Drill down into your layout.
7. Click the Profile tab in the Subtabs Region.
8. Scroll down until you see the Primary Address and Multiple Address selections.
9. Click the Show link for Multiple Address.
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10. Click Hide for the Primary Address.

Multiple Address now displays Hide and Primary Address displays Show. Here's a screenshot:

Note:  You can't expose both regions at the same time.

11. Click Done to leave Application Composer.

Expose the Type Field
Expose the address Type field in the Add Address window. As they add addresses, salespeople use the field to indicate if
an address is a sell-to address, a bill-to address, and so on. Exposing the field on the Add Address window automatically
adds it to the Edit Address window as well.

1. While in the sandbox and Application Composer, open the Standard Objects node on the left panel.

Open the Address node.
2. Click Pages
3. On the Application Pages tab, Creation Page Layouts section, select the Standard Layout and click Duplicate.
4. In the Duplicate Layout window, enter a new name for your layout or just click Save and Edit.
5. Drill down into your layout.
6. Click Edit (the pencil icon) for Create and Edit Address.
7. In the Configure Detail Form section, locate the Type field in Available Fields pane and move it to the Selected

Fields pane.
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8. Click Save and Close.
9. Click Done to leave Application Composer.

Publish Your Sandbox

1. Click Navigator > Configuration > Sandboxes.
2. On the Sandboxes page, click the name of the sandbox.
3. Click Publish.
4. Click Continue to publish.
5. When the sandbox completes publishing, click Done.

How do I set up the "What's Around Me?" maps feature?  
Salespeople can access the "What's Around Me?" map feature directly from the CX Sales Mobile home page. The
application maps the salesperson's location using phone location, displaying nearby leads, accounts, contacts, and
opportunities.

How It Works
To display the map, the phone uses the phone's default map. Records display as pins on the map, with icons that
distinguish the record type. Tapping a pin displays a card showing record details and the actions that salespeople can do
next, such as opening a contact record.

The card's Get Directions button uses the phone's native map application to guide salespeople to their destinations.
Actions such as Contact, Edit, and Convert Lead are available directly from the cards, meaning that salespeople remain
in context when acting on the information that's presented on the map.

Note:  Records with addresses in China, Japan, and South Korea aren't geocoded or shown on maps.

Run Schedule Processes to Enable
The map feature is enabled in the app by default. But, you must run or schedule processes. Here's how you run the
scheduled processes:

Prerequisite: Enable geocoding for a country using the steps in Set Up Geocoding.

1. Sign into Sales as a user with a Sales Administrator role.
2. Navigate to Tools > Scheduled Processes.
3. In the Overview page, click Actions > Schedule New Process.
4. Click the Name list button and search for the Populate Location Latitude and Longitude Information process,

and then click OK. This process populates the latitude and longitude information for every sales object except
Leads, which is handled by a different process, as described later in this procedure.

5. Enter the parameters, such as the start date and end date, and schedule the job to run automatically at
specified intervals.

6. Click Submit.
7. Carry out the relevant steps again. This time search for Populate Lead Latitude and Longitude Information.

This process populates the latitude and longitude information for leads.
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Optionally Enable Saved Search Filters
You can use Workspace saved searches to filter the sales objects that are near a salesperson's location. If want like to
enable this filter, follow the steps in the Enable Salespeople to View Saved Search Results on a Map topic.

Related Topics
• Set Up Geocoding

Why is my Adaptive Search publish process taking time
to complete?  
The Publish process publishes the Adaptive Search configuration you set up in the Quick Setup and Advanced Setup
UIs. You must click Publish to run the process each time you make changes on the Setup tab. Your changes become
effective when the process completes.

The variations in the time it takes for the successful completion of the publish process is mainly due to the volume of
data, the number of objects enabled, and the number of attributes selected for each object.

For example, if you publish more attributes and more objects, then it takes more time to complete the publish and
indexing process. You can improve the performance by removing any attributes that you don't want to be indexed.
You can also monitor the progress of the publish process. Your configuration is live when the process completes
successfully.

Note:  The Publish process should be completed before running the Periodic refresh process.

Can I modify or translate saved searches using the User
Interface Text tool?  
No. You can't use the User Interface Text tool to modify or translate predefined Workspace saved searches. However,
you can select Manage Saved Searches to create a copy of the saved search and rename it to suit your business
requirements.

If you translate the text, ensure you use the current language of the assigned users of the saved search.

Is there a limit on the number of products you can
include in a sales catalog product group?  
No, there's no specific limit on the number of products you can have in a product group.
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How can I fix an invalid relationship error when
converting leads?  
If you try to convert a lead that contains an invalid contact relationship, you may receive an invalid relationship error
during the conversion.

For example, you create a lead with a valid active primary contact and account. An issue might arise when you go
to convert the lead if an incorrect relationship exists for a second contact on the lead. In such a scenario, you must
deactivate the relationship and after some time try to convert the lead again.

However if you want the association of the lead and contact to remain, you must add the contact back on the lead
through the Contacts tab on the Edit Lead page. Here's how to resolve the issue:

1. Navigate to the Edit Lead page.
2. In the Contacts tab, remove the second (nonprimary) contact.
3. Click Save.
4. Add the contact that you just removed back again to the lead.
5. Click Save.
6. Convert the lead.

How can I remove the standard buttons on the Account
Activities page in Sales?  
To customize the Account Activities page in the classic Sales UI, use Application Composer. For example, you can
remove standard buttons, such as the Create Appointment, Create Task, and Log a Call buttons. Here's how.

Customize the Account Activities Page
Create and enter a sandbox with the Application Composer tool enabled.

1. In the Navigator, click Configuration > Sandboxes.
2. Click Create Sandbox.
3. Enter a sandbox name.
4. Select Active for Application Composer.
5. Click Create and Enter.
6. From the sandbox Tools menu, select Application Composer to enter the tool.

Make a Copy of the Standard Layout
While in Application Composer, make a copy of the standard layout:

1. Open the Standard Objects node on the left panel.

Open the Activity node.
2. Click Pages
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3. On the Activity Pages tab, scroll down to the Embedded Activity Summary Layout section.
4. Select Standard Layout for Embedded Task List Overview and click Duplicate.
5. In the Duplicate Layout window, enter a new name for your layout or just click Save and Edit.
6. Drill down into your layout.
7. Next to Embedded Task List Overview Table, click Edit (the pencil icon).
8. Scroll down until you see the Configure Detail Form: Buttons and Actions.
9. You can remove the Create Appointment, Create Task, and Log a Call buttons by moving them from the

Selected Buttons to the Available Buttons list.
10. Click Save and Close.
11. Click Done.

Publish Your Sandbox

1. Click Navigator > Configuration > Sandboxes.
2. On the Sandboxes page, click the name of the sandbox.
3. Click Publish.
4. Click Continue to publish.
5. When the sandbox completes publishing, click Done.

How come I don't see products in leads or opportunities?
 
You must enable and publish product and product groups in Adaptive Search before you see them in the leads and
opportunities UIs. You can do this either using Setup Assistant or using this procedure.

1. Open the task Configure Adaptive Search from the Setup and Maintenance work area:

◦ Offering: Sales

◦ Functional Area: Sales Foundation

◦ Show: All Tasks

◦ Task: Configure Adaptive Search

2. Click the Setup tab.
3. Select Product and Product Group and any other object you want to enable.
4. From the Actions menu, select Full Publish.
5. You can monitor the progress of the publish process on the Monitor tab.

Related Topics
• Speed Up Your Initial Setup with Setup Assistant

• Run Setup Assistant
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How can I configure and extend application pages for
territories?  
Using Application Composer, you can modify many items that appear on the application pages for sales territories.

Use Application Composer to modify these pages:

• Territories landing page

• Create Territories page

• Details page (see a discussion of subtabs in the Details page section)

Make changes such as these examples:

• Hide or show standard fields.

• Set fields as required.

• Set field default values.

• Reorder columns.

• Change column labels.

• Add custom fields (all types).

Note:  To extend the application pages for territories, use the Sales Territory object in Application Composer.

Territories Landing Page
You can modify the Territories landing page. For example, you can hide standard fields or show custom fields.

1. Navigate to the Sales Territory object in Application Composer.
2. Select the Pages node.
3. On the Application Pages tab, under Landing Page Layouts, duplicate the standard layout to create a new

layout.

Create Territories Page
You can modify the Create Territories page. For example, you can hide standard fields, make a field required, add a
default value, and show custom fields.

1. Navigate to the Sales Territory object in Application Composer.
2. Select the Pages node.
3. On the Application Pages tab, under Creation Page Layouts, duplicate the standard layout to create a new

layout.

To enhance run time usability for your end users, optionally group custom fields into field groups.
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Details Page
The Details page consists of multiple subtabs that display along the side of the page. You can modify most of these
subtabs. You can also add subtabs to display records from child or related objects, for example.

To add custom fields to certain subtabs available from the Details page, you must first navigate to those subtab target
objects in Application Composer to create the fields. After creating the fields on the target object, you can then navigate
back to the desired details page layout for the Sales Territory object to add those fields to the specific subtabs.

1. Navigate to the Sales Territory object in Application Composer.
2. Select the Pages node.
3. On the Application Pages tab, under Details Page Layouts, duplicate the standard layout to create a new layout.
4. When making changes to the Details page, select the subtab you want to change first. These subtabs are

available from the Details page. Use the subtabs to configure which standard and custom fields display at run
time. You can also add a new tab.

◦ Summary

◦ Dimensions

This tab isn't extensible.

◦ Inclusions

This tab isn't extensible.

◦ Exclusions

This tab isn't extensible.

◦ Team Members

Use the Sales Territory Resource object to create custom fields as needed.

◦ Child Territories

Use the Sales Territory object to create custom fields as needed.

Custom Territory Attributes
Assign territories using the custom territory attributes. For example, if your organization want to track revenue by
different groups of salespeople within their territories - one group to focus on new customers while another group for
subscription renewals. Create custom territory attributes to track revenue from both the groups separately. This means
that the records are matched with the revenue, based on a new territory or a renewal territory.

How do I enable import of custom objects?  
This topic describes how to enable the import of custom objects. Before you can import and export data for custom
objects created with Application Composer, you must ensure that the required object artifacts have been generated.

Object artifacts are required to register your extensions and make them available for importing. When you publish your
sandbox after your configurations, artifacts are automatically generated and the custom objects are available for import
and export. With a single publishing, you can generate configurations for CRM, ERP, and SCM cloud applications.
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How you Enable Import of Custom Objects
To enable the import of custom object data:

1. Create a sandbox and add configurations to the objects.
2. Publish the sandbox.
3. Artifact generation is triggered automatically as part of the sandbox publish. Artifacts are generated for objects

that are changed inside sandbox only.
4. You can monitor the artifact generation status on the Generate Import and Export Artifacts tab by navigating

to Tools >  Import Management >  Import Configuration. You can perform this only once you're outside the
sandbox.

After the artifact is generated, you're ready to import. If some artifacts aren't generated automatically, then you have to
manually generate them using the Generate button. To download the diagnostics log of the artifact generation, click
the Generate button under the Diagnostics tab, and then click the link under the Attachments column. Note that you
must import the custom child objects only after importing the parent object.

Note:  If your custom field is missing from import mapping after generating the artifacts, then enable the profile
option ORA_ZCA_OBJECT_METADATA_COMPLETE_GENERATION to 'Yes' from Setup and Maintenance >  Manage
Administrator Profile Values . Then generate your artifacts again and turn the profile option back to "No".

You can update the profile option ORA_ZCA_IMPORT_EXPORT_QUEUE_SIZE to specify the size of import and export
queues for dynamic queue configurations. The possible values are LOW, MEDIUM, HIGH, and FIXED. After updating the
profile option, you must generate the artifacts for the changes to reflect.

If you have configured security in the Application Composer for create, update, or delete scenario, then such validations
aren't honored by high-volume imports. Validations are applicable only for low-volume imports.

Relationships Between Custom Objects
Parent object resources expose the child objects of top-level custom objects. For objects to interact with one another,
relationships must be created between them. The related objects can be either standard or custom objects. For
example, if you want attributes from the Employee object to be available in the Trouble Ticket object workspace, a
relationship must be defined between the Employee object and the Trouble Ticket object.

You can use Application Composer to create relationships between objects. Using Application Composer, you can create
two types of relationships:

• Parent-child: When you define a parent-child relationship, the link to the child object is included in the parent
object description. A child object doesn't have its own workspace, and the child object's records are deleted if
the parent object record is deleted.

• Reference: When you define a reference relationship, the primary key of the source object is included as a
foreign key in the description of the target object.

Intersection Objects

Use Application Composer to create many-to-many relationships between custom objects. In this case, you create
an intersection object that references the source and target objects. For example, consider two object resources,
Trouble Ticket and Resource, related by a many-to-many reference relationship, with the Assignment resource as the
intersection object. In such a case, the following applies:

• The Assignment resource has Trouble Ticket as the source object and Resources as the target object. The
objects Trouble Ticket and Resources have many-to-many relationships.
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• The Assignment resource is the child resource of both Trouble Ticket and Resources.

How you Import Record Name Values
By default, the Record Name field is automatically generated and is updated using automatic sequence. The value you
provide in the source file is ignored. If automatic record-name generation is disabled in the Application Composer, then
you must provide the value in the source file and this value is imported. However, high-volume import doesn't support
automatic generation of Record Name field; you must provide the Record Name value in the source file.

Specify the RecordNumber Attribute
When defining your custom object in Application Composer, RecordNumber field is always unique. The import activity
uses RecordNumber as the user key to resolve the record in the target database.

When you modify the PUID (RecordNumber) make sure you follow by Application Composer guidelines, to prevent
recordNumber collisions with the existing database sequence. This is applicable for both high-volume import and
import using REST service. For more information on how to prevent conflict in PUID, see the topic Custom Object Public
Unique IDs in the related topics section.

Support of Record Name Attribute
You can update custom object records by using the Record Name attribute to identify records. To enable this, you must
set the profile option ORA_ZCA_IMPORT_ENABLE_RECORDNAME_SUPPORT to Y. By default this profile option has a
value N. If you use the Record Name attribute to update records, the following order of precedence is used to identify
the records:

1. ID (PK)
2. RecordNumber (PUID)
3. RecordName (AlternatePUID)

However, you can't update the Recordname attribute value.

Related Topics
• Publish Sandboxes

How do I import resource data?  
You can use import management to create or update resource records.

To import resource records, perform the following tasks:

1. Map your source data to Oracle Applications Cloud object attributes.
2. Create source Comma Separated Values (CSV) file for import.
3. Create the import activity.
4. Review the import results.

How You Map Your Source Data to Object Attributes
To import your resource data into Oracle Applications Cloud, you must populate a .csv file with your source data and
map that source data to target object attributes in Oracle Applications Cloud.
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You need to do the following before creating the CSV file for data import:

• Identify how your source data attributes map to the target object attributes in Oracle Applications Cloud.

• Ensure prerequisite setups are done, if applicable.

• Understand your options for uniquely identifying the records.

• Ensure parent records exist before importing child records.

• Identify the target object attributes that are required in the CSV file for a successful import.

Before You Start
You must do some basic checks before starting your import. For example:

• Complete all the prerequisites for importing each attribute in your source data.

• Have all parent records in place before importing child records.

• Use the Manage Business Unit task to set up appropriate business units.

• Use the Manage Legal Entity task to set up appropriate legal entities .

• Use the Manage Resource Roles task to define resource roles. Sales Administrator role is required to load the
resource data.

Select a Unique Identifier for Your Records
To import data into Oracle Applications Cloud, your CSV file must include some specific attributes that enable the
import process to uniquely identify the records. The file import process uses the attribute values to automatically map
your source data to the target object attributes in Oracle Applications Cloud.

The preferred option to uniquely identify an object record is through the public unique identifier. If you're creating new
records, then you can provide a user-friendly public unique identifier (Party Number). If you update a record for which
you have previously provided a Number attribute, or for which a Number attribute is visible in the object's UI, you can
use the Number attribute to identify the record. For the resource object, the attribute is ResourcePartyNumber.

Required Attributes and Validations for the Resource Object
To import data successfully into Oracle Applications Cloud, your CSV file must include the required attributes. Ensure
that you provide valid values for the attributes. When you create a new resource, associated employee records are also
created. For more information about creating resources for existing employee records, see the topic "Example of Adding
Resource Profile to Existing Employees". The following table lists the required attributes for importing new resource
records, required attributes for updating resource records, prerequisite setup tasks for the attributes, and specific
validations, if any, for resource import:

Attribute Description Prerequisite Setup Task/
Import Validations

Creating a Resource
Record

Updating an Existing
Resource Record

FirstName
 

The first name of the
resource.
 

No validation
 

Required
 

Pass the party number as
the key.
 

LastName
 

The last name of the
resource.
 

No validation
 

Required
 

Pass the party number as
the key.
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Attribute Description Prerequisite Setup Task/
Import Validations

Creating a Resource
Record

Updating an Existing
Resource Record

BusinessUnit
 

The name of the business
unit associated with the
resource.
 

It should be a valid existing
value.
 

Required
 

Not updatable
 

LegalEntity
 

The name of the legal
entity associated with the
resource.
 

It should be a valid existing
value.
 

Required
 

Not updatable
 

ResourcePartyNumber
 

The public unique identifier
(PUID) of the resource
party.
 
This is also known as
Registry Id.
 

This should be unique.
 

Conditionally required
 
This is auto-generated.
However, you can provide
a value to replace the auto-
generated value when
creating the resource
record.
 

Required
 

ResourceEmail
 

The email address of the
resource
 

The email address must be
unique. Specify the email Id
when creating the resource.
 

Required
 

Pass the party number as
the key.
 

IndividualRoleCode
 

The code that represents
the resource role assigned
to the resource.
 

A resource can have only
one individual role code
assigned for a given
date range. You define
and review resource role
types and codes using the
Manage Resource Roles
task.
 

Conditionally required
 
A value is required when
creating a standalone
resource.
 

Pass the party number as
the key.
 

Username
 

The user account name of
the resource used to login
to the application.
 

The user name has to be
unique.
 

Optional
 

Not Updatable
 

ResourceOrgRoleCode
 

The code indicating
the role of the resource
in association with
organization membership.
For example, SALES_
REPRESENTATIVE, SALES_
MANAGER, and so on.
 

One organization
membership role is allowed
for a given date range.
 

Conditionally required
 
A value is required when
creating a resource as
a part of the resource
hierarchy.
 

Pass the party number as
the key.
 

RawWorkPhoneNumber
 

The work phone number of
the resource
 

No validation
 

Optional
 

Optional
 

WorkPhoneCountryCode
 

The work phone country
code of the resource
 

Enter a value when
you specify the
RawWorkPhoneNumber.
 

Conditionally required
 
A value is required
when you provide the
RawWorkPhoneNumber.

Conditionally required
 
A value is required
when you provide the
RawWorkPhoneNumber.
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Attribute Description Prerequisite Setup Task/
Import Validations

Creating a Resource
Record

Updating an Existing
Resource Record

Note:
When providing
a value for the
RawWorkPhoneNumber,
 ensure that you also
provide a value for the
WorkPhoneCountryCode.
If you don't enter a valid
WorkPhoneCountryCode,
 the format of the
RawWorkPhoneNumber
will be inaccurate.
 

  

RawMobilePhoneNumber
 

The mobile phone number
of the resource
 

No validation
 

Optional
 

Optional
 

MobilePhoneCountryCode
 

The mobile phone country
code of the resource
 

Enter a value when
you specify the
RawMobilePhoneNumber.
 

Conditionally required
 
A value is required
when you provide the
RawMobilePhoneNumber.
 

Conditionally required
 
A value is required
when you provide the
RawMobilePhoneNumber.
 

RawFaxNumber
 

The fax number of the
resource
 

No validation
 

Optional
 

Optional
 

FaxCountryCode
 

The fax country code of the
resource
 

Enter a value when you
specify the RawFaxNumber.
 

Conditionally required
 
A value is required
when you provide the
RawFaxNumber.
 

Conditionally required
 
A value is required
when you provide the
RawFaxNumber.
 

You can view the resource object and attributes in the Manage Import Objects page of the Import Management flow.
You can find attribute information like type, length, description, and so on, on this page.

The following role codes are now available in Import Management.

• ResourceOrgRoleCode - Specifies the role that the resource plays as part of the hierarchy in the organization.

• IndividualRoleCode - Specifies the role assigned to the individual resources. You can also assign additional roles
to the resource in the hierarchy to provide additional privileges to the resource.

You should not use a Resource Users import in Import Management or REST on an environment with full blown HCM
Services implementation. In such cases, Import Management or REST must be used only to convert existing HR workers
as resources. This is because, Resource Users REST API only supports vary basic attributes of the HR person/worker. It
doesn't support Oracle Human Capital Management (HCM) custom attributes defined on HR Person/Worker.
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Note:  Note the following:
• To identify a party number for a resource, you may use File Export, Resource User REST, or resource directory

user interface.

For more information about exporting data, see the topic "Export Data" in the "Related Topics" section.

• In File-based Data Import, resource can be imported to load (create/update) HR workers (Employees
and Contingent Workers) without any resource related attributes. However, this isn't possible in Import
Management.

• You can't create a standalone worker using this feature. To create a standalone worker, use the HCM Data
Loader. For more information about creating a standalone worker, see the Oracle Global Human Resources
Cloud Getting Started with Your HR Implementation guide.

• You can speed up import of up to 5,000 records at a time by using Microsoft Excel macros provided by Oracle.
The macros validate your data entries, provide lists of values, and automatically populate constant values. After
you enter your data, click a button in the macro to import data. Download the Excel macros from the Oracle
Sales: Getting Started with Your Sales Implementation: Import Macros (Document ID 2229503.1) article on My
Oracle Support.

• Loading of only worker attributes isn't supported.

• Resource Team memberships aren't supported.

• Automatic re-parenting of the child organizations or direct employees when a manager leaves the resource
organization isn't supported.

Note:  Move all reporting resources and child organizations to a different organization, when the organization
membership of the current manager is ended either due to the movement of the manager to a different organization
or the termination of the manager.

Create the Source CSV File
You include the data that you want to import into Sales and Fusion Service in a source CSV file.

You can use the templates available in the Import Objects UI page to create the source CSV file. To download a template:

1. Go to Navigator  > Tools >  Import Management >  Import Objects.
2. Select the Resource object in the table and click Download.
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You can now edit the downloaded file and provide valid values for the required attributes.

Note:  For help in populating the CSV file and to avoid any issues in entering values, see the topic Potential Issues
When Opening CSV Files With Excel in Related Topics section.

Create the Import Activity
After you have the CSV file ready, create an import activity to import the information. To create an import activity:

1. Go to Navigator  > Tools >  Import Management >  Import Queue.
2. Click Create Import Activity in the Manage Imports page.
3. In the Enter Import Options page, provide a name for the import activity, and select Resource from the Object

drop-down list.
4. Select the CSV file in the File Name field, and click Next.
5. The source and target attributes are automatically mapped in the Map Fields page. Review and edit the

mappings if required.
6. Check the file for unmapped columns or data format issues by clicking Validate Data. Click Next.
7. Review the import details on the Review and Submit page, and click Submit when you're ready.

Review the Import Results
Check if your import succeeded on the Manage Imports page. This page shows the status of all active, completed, and
unsuccessful imports. To check the status of the import activity:

1. Go to Navigator  > Tools >  Import Management >  Import Queue.
2. Click All Imports and search for the import activity that you created earlier.
3. Check the Status column for the import activity. The import is successful if the status displays as Completed.

You can drill down on the import activity to go to the Import Status page which provides the status details of
the import activity.

You must run the following scheduled processes after creating or updating a resource:

1. Reporting Hierarchy Generation: This job updates the reporting hierarchy in accordance with the changes in
internal resource hierarchy. The resource's reporting manager isn't updated unless you run this scheduled
process. Run this scheduled process after you make any changes to the hierarchy such as changing the
manager or the organization.

For more information about the Reporting Hierarchy Generation scheduled process, see the section
"Reporting Hierarchy Generation" in the Understanding Scheduled Processes guide.

2. Update Person Search Keywords: The After Batch Load parameter should be set to Y before you run the update
person search keywords schedule process. If you run this scheduled process, you can search the person in the
Manage Users UI. The application searches for keyword values in these attributes of a person's records such as
person name, user name, primary email, primary phone, work location, and so on. Run this scheduled process
when you create a new resource.

For more information about updating person search keywords, see the section "How You Update Person Search
Keywords" in the Oracle Talent Management Cloud Implementing Talent Management Base guide.

3. Send Pending LDAP Requests: This job processes the pending LDAP requests to provision the user accounts
and roles. You can specify the parameters User Type and Batch Size with this job. You must specify User Type
(usually select All); if you leave it as blank, then this process won't process any requests. If you don't set Batch
Size, the default will be A for automatic, which is 1/10th of the total requests number. You can specify a number
for batch size to instruct the process to group that number of requests together for single batch process. If you
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want the process to pick up the FAULTED requests from previous run, you can set Batch Size as AF. Run this
scheduled process when you create a new resource along with the user account.

4. Synchronize User GUID: This job synchronizes the user GUID of users including employees and contingent
workers.

For more information about the Synchronize User GUID scheduled process, see the section "Synchronize User
GUID" in the Understanding Scheduled Processes guide.

Related Topics
• How do I export data?

• How do I import data?

• How do I generate the resource reporting hierarchy?

• How do I synchronize the GUID of users?

• Schedule the Send Pending LDAP Requests Process

How do I import sales team member data?  
You can use Import Management to create or update sales team member records.

You can import sales team member records using these steps:

1. Map your source data to Oracle Applications Cloud object attributes. This way the import process would know
where to insert each of the information bits.

2. Create the source CSV file with the sales team member data you want to import.
3. Kick off an import activity.
4. Check the import results to know if the import went well.

How You Map Your Source Data to Target Object Attributes
You import sales team member data into Oracle Applications Cloud from a CSV file containing your source data that's
mapped to target Oracle Applications Cloud object attributes.

Before you create the source data file, you should:

• Know how your source data attributes map to the target object attributes in Oracle Applications Cloud. Match
each column from the source file to an attribute in the sales team member import object.

• Finish all prerequisite steps, such as understanding what attributes are required for importing your objects.

• Know how you can uniquely identify the records.

• Check the target object attributes required in the CSV file for a successful import.

• Ensure that you don't insert duplicate sales team member while importing, to avoid redundant data.

Before You Start
You must do some basic checks before starting your import. For example, make sure that:

• You have completed all the prerequisites for importing each attribute in your source data.
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• You have all parent records in place before importing child records. Also ensure that the parent records, such as
accounts, are in active status.

Select a Unique Identifier for Your Records
All records must be unique in the application. You can use one of these to identify records:

• Public unique identifiers: If you're creating records, then you can provide an easily understandable public
unique identifier. These are, usually, denoted with 'Number' and visible in the business object's UI. PUID
attributes are usually named <object> Number. If you're updating a record with a Number attribute, then use
the Number attribute to identify the record. For more information about public unique identifiers, see the topic
"How You Use Alternate Keys to Import Records" in Related Topics section.

• Source system and source system reference: Source system is an identifier for the external system, and source
system reference is a unique identifier within the external system. If you're importing new Sales Team Members
or are updating Sales Team Members that have source system reference data, then provide the source system
and source system reference values.

Required Attributes and Validations for Sales Team Member Object
To import data successfully into Oracle Applications Cloud, your .CSV file must include the required attributes. Ensure
that you provide valid values for the attributes.

This table lists the required attributes for sales team member records, prerequisite setup tasks and specific validations,
if any:

Attribute Description Prerequisite Setup Task/
Import Validations

Creating a Sales Team
Member record

Updating an Existing
Sales Team Member
record

TeamMemberId
 

Sales Team Member ID.
This is the primary key.
 

N/A
 

N/A
 

If available, provide this to
update other attributes.
 

SalesProfileID
 

Sales Profile ID
 

Active SalesProfileID to
have been created already.
 

Conditionally required
 
To be provided if none of
the following are available:
 

• PartyID

• PartyNumber

• Combination of
PartySourceSystem
and
PartySourceSystemReferenceValue

Conditionally required
 
To be provided if
TeamMemberID isn't
available. To be provided
along with ResourceID or
ResourcePartyNumber or
ResourceEmailAddress.
 

PartyID
 

Sales Account ID
 

N/A
 

Conditionally required
 
To be provided if
SalesProfileID isn't
available.
 

Conditionally required
 
To be provided if
TeamMemberID or
SalesProfileID isn't
available. To be provided
along with ResourceID or
ResourcePartyNumber or
ResourceEmailAddress.
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Attribute Description Prerequisite Setup Task/
Import Validations

Creating a Sales Team
Member record

Updating an Existing
Sales Team Member
record

PartySourceSystem
 

Party source system of the
Sales account
 

N/A
 

Conditionally required
 
To be provided if
SalesProfileID isn't
available. To be
provided along with
PartySourceSystemReferenceValue.
 

Conditionally required
 
To be provided if
TeamMemberID or
SalesProfileID or
PartyID isn't available.
To be provided along
with ResourceID or
ResourcePartyNumber or
ResourceEmailAddress.
 

PartySourceSystemReferenceValue
 

Party source system
reference of the Sales
account
 

N/A
 

Conditionally required
 
To be provided if
SalesProfileID isn't
available. To be provided
with PartySourceSystem.
 

Conditionally required
 
To be provided if
TeamMemberID or
SalesProfileID or
PartyID isn't available.
To be provided along
with ResourceID or
ResourcePartyNumber or
ResourceEmailAddress.
 

PartyNumber
 

Party number of the sales
account/PUID
 

N/A
 

Conditionally required
 
To be provided if
SalesProfileID isn't available
 

Conditionally required
 
To be provided if
TeamMemberID or
SalesProfileID or
PartyID isn't available.
To be provided along
with ResourceID or
ResourcePartyNumber or
ResourceEmailAddress.
 

ResourceID
 

Resource identifier
 

Active ResourceID to have
been created already.
 

Conditionally required
 
To be provided if
ResourcePartyNumber or
ResourceEmailAddress isn't
available.
 

Conditionally required
 
To be provided if
TeamMemberID isn't
available. To be provided
along with SalesProfileID
or PartyID or PartyNumber
or PartySourceSystem
along with
PartySourceSystemReference.
 

ResourcePartyNumber
 

Resource party number/
PUID
 

N/A
 

Conditionally required
 
To be provided if
ResourceID isn't available.
 

Conditionally required
 
To be provided if
TeamMemberID or
ResourceID isn't available.
To be provided along
with SalesProfileID or
PartyID or PartyNumber
or PartySourceSystem
along with
PartySourceSystemReference.
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Attribute Description Prerequisite Setup Task/
Import Validations

Creating a Sales Team
Member record

Updating an Existing
Sales Team Member
record

ResourceEmailAddress
 

Resource email address
 

N/A
 

Conditionally required
 
To be provided if
ResourceID isn't available
 

Conditionally required
 
To be provided if
TeamMemberID
or ResourceID or
ResourcePartyNumber isn't
available. To be provided
along with SalesProfileID
or PartyID or PartyNumber
or PartySourceSystem
along with
PartySourceSystemReference.
 

Go to Navigator  > Tools >  Import Management >  Import Objects, to see all the attributes of the sales team member
object. The page also lists attribute information like type, length, description, and so on.

Create the Source CSV File
You include the data that you want to import into Sales and Fusion Service in a source CSV file.

You can use the templates available in the Import Objects UI page to create the source CSV file. To download a template:

1. Go to Navigator  > Tools >  Import Management >  Import Objects.
2. Select the sales team member object in the table and click Download.

You can now edit the downloaded file and provide valid values for the required attributes.

Note:  For help in populating the CSV file and to avoid any issues in entering values, see the topic Potential Issues
When Opening CSV Files With Excel in Related Topics section.

Create the Import Activity
After you have the CSV file ready, create an import activity to import the sales team member information. To create an
import activity:

1. Go to Navigator  > Tools >  Import Management >  Import Queue.
2. On the Manage Imports page, click Create Import Activity.
3. In the Create Import Activity: Enter Import Options page, provide a name for the import activity, and select

Sales Team Member from the Object drop-down list.
4. Select the CSV file in the File Name field, and click Next.
5. You would see that the source and target attributes are automatically mapped in the Map Fields page. Review

and edit the mappings if required.
6. Check the file for unmapped columns or data format issues by clicking Validate Data. Click Next.
7. Review the import details on the Review and Submit page, and click Submit when you're ready.

Review the Import Results
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Check if your import succeeded on the Manage Imports page. This page shows the status of all active, completed, and
unsuccessful imports. To check the status of the import activity:

1. Go to Go to Navigator  > Tools >  Import Management >  Import Queue.
2. Click All Imports and search for the import activity that you created earlier.
3. Check the Status column for the import activity. The import is successful if the status displays as Completed.

You can drill down on the import activity to go to the Import Status page which provides the status details of
the import activity.

Related Topics
• How You Use Alternate Keys to Import Records

• Potential Issues When Opening CSV Files in Excel

How do I import data?  
Use Import Management from the Tools work area, to import data from text files. This topic is your guide to importing
data in sales, service, and incentive compensation.

You can create, update, or delete records through import.

The import options and other details differ by the type of data that you're importing. Before importing, understand how
the data in your file maps to the attributes in Oracle Applications Cloud and what values are expected in the import file.
The data records in the CSV source file may not be processed in the listed order. To learn how to monitor the status of
your import, see the topic How You Monitor Your Import Activities in the Related Topics section.

Note:  Don't submit duplicate import jobs for the same import object as they create duplicate object records.

To help you get started, you can use the example import object templates described in the related topics.

Import Data from a File
To import data:

1. Click Tools > Import Management.
2. On the Manage Imports  page, click the Create Import Activity button.
3. On the Enter Import Options page provide values for each field as shown in the following table:

Field Description of the value

Name
 

Name of the import.
 

Object
 

Object that you're importing.
 
If you can't find your object, then search for it by clicking the Search link. In the Search and
Select dialog box, enter the object name in the Object text box and click the Search button.
Select your object from the result list and click OK.
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Field Description of the value

 
You can also use the advanced search option by clicking the Advanced button. Here you can
search based on various filter criteria such as object name, Attachment supported, creation
date, and so on.
 
If the object you're importing isn't listed then verify if you have the roles and privileges required
to import the object. For information on the roles, see the topic Roles Required for Import and
Export Management referenced in the Related Topics section.
 

Attachment Object
 

To import an attachment for an existing object record in the database select the Attachments
object from the Object drop-down list. Next select the object from the Attachment Object
drop-down list.
 
For more details on importing attachments, review the topic Import Attachments.
 

File Name
 

Browse and select a text file in CSV format. The first row of the source file is treated as the
header row. Provide a file name within 40 characters.
 

Note:
If your source file has more than 50,000 records, then you must manually split the file into
several smaller files with less than 50,000 records each. The file import page only permits
50,000 records for each import job. Alternatively, you can use the External Cloud Data
Loader Client, which can accept files with more than 50,000 records. See the My Oracle
Support (support.oracle.com) document External Data Loader Client (document ID 2325249.1)
for more information about this tool.
 

Import Object Hierarchy
 

To import a hierarchy of objects, such as child and grandchild objects, click on the Import
Object Hierarchy link after you upload the source file for the parent object. Next select the
Enabled check box for the child object you want to import, and select the related source file.
 

4. Optionally, to set additional import configurations, click the Advanced Options section. Here you can configure
settings under Source File, Import Options, or Create Schedule sections.

a. In the Source File and Import Options regions, some of the options in the following table might not be
available depending on the object that you're importing:

Option Description

Import Mode
 

You can specify whether you want to create and update records or update them only.
 

- Update and create records - a new record is created if a matching record isn't
found. This is the default option.

- Create records - all the records in the file are new records which have to be created.
If there are any existing matching records, then they're marked as errors.

129



Oracle Fusion Cloud Sales Automation
Sales Questions and Answers

Chapter 1
Sales Questions and Answers

Option Description

- Delete records - all the records in the file are deleted.

Enable High-Volume Import
 

The high-volume import mode is designed to import millions of records at once. This
mode doesn't trigger any custom logic configured through the application composer. For
a list of supported objects, see the topic Data Import Options.
 
By default, this mode is enabled for the supported objects.

Note:
If ZCA_FILE_IMPORT_ENABLE_CUSTOM_BUSINESS_LOGIC is set to “Yes”, then you
won’t be able to use High Volume import.
 

 

Enable Survivorship
 

Survivorship on update is available for Account, Organization, Contact, and Person. The
check box is visible if the attribute survivorship is configured on the objects. You can use
high-volume import mode, only when the survivorship configuration uses only Source
Confidence. You can't use the high-volume import mode when Data Quality Rules are
enabled.
 

Notification email
 

The email of the individual who receives import processing notifications. The user
submitting the import receives an email notification automatically. To have more than
one email recipient, separate the email addresses with a semicolon. If you don't want to
receive the notification, then set the profile option ORA_ZCA_IMPEXP_ENABLE_EMAIL_
NOTIFY to 'N' at user level.
 

Enable Custom Business Logic
 

If you select this check box, then any custom triggers and validations configured for
the object are enabled. This may affect import performance, because of configurations.
Hence, disable this option for better performance.
 
To enable this check box by default, set the profile option ZCA_FILE_IMPORT_ENABLE_
CUSTOM_BUSINESS_LOGIC to 'Yes' by navigating to the Manage Administrator Profile
Values task.

Note:
If ZCA_FILE_IMPORT_ENABLE_CUSTOM_BUSINESS_LOGIC is set to “Yes”, then you
won’t be able to use High Volume import.
 

 

Note:
This selection has no effect on events and object workflows, and is applicable only on
triggers and validations.
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Option Description

Delimiter
 

If your file doesn't use a comma to separate values, then select the correct delimiter in the
Delimiter drop-down list. Possible values are:
 

- Caret Symbol

- Closing Curly Bracket

- Closing Parenthesis

- Closing Square Bracket

- Colon

- Comma

- Exclamatory Mark

- Minus

- Opening Curly Bracket

- Opening Parenthesis

- Opening Square Bracket

- Pipe Symbol

- Plus

- Question Mark

- Semi-Colon

- Star Symbol

- Tilde Symbol

Decimal Separator
 

The decimal separator used in your import file.
 

Date Format
 

The format of the date fields in your file.
 

Time Stamp Format
 

The format of the time fields in your file.
 

File Encoding
 

The format in which your source file is encoded. The possible values are:

- Chinese Simplified - GB, CP936

- Chinese Traditional - CP950

- Eastern European - Win, CP1250

- Greek - MS Windows, CP932

- Japanese - Shift- JIS, CP932

- Unicode - UTF-16

- Unicode- UTF-16BE, Mac, Unix

- Unicode - UTF-16LE, MS Windows

- Unicode - UTF-8

- Western European - Win, CP1252

Note:  The above mentioned encoding formats are the only ones supported. Importing
file with any other format, such as ANSI, will cause unexpected characters to be
imported.
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b. In the Create Schedule region, schedule the import to run immediately or at a future date. If you select a
future date, then provide the date and time to start the import.

You can save the Advanced Options for subsequent reuse by clicking on the Save advance options link in the UI.
The options will be retained till you click on the Reset link and reset the options to application defaults.

Note:  All fields except Import Mode, Enable Custom business Logic, Enable High-Volume Import, Enable
Survivorship Logic, Schedule Mode, and Schedule Start Time will be saved.

5. Click Next. The Map Fields page shows the first row of the data from your source file. By default, the
application tries to automatically map each of the source file columns to the appropriate target object attribute.
If some of the columns in your file couldn't be mapped, then drag the target attribute onto the Attribute
Display Name column under the Source File region.

The data in unmapped columns aren't imported.

You can save your import map by clicking on Save As in the Create Import Activity page. You can use the saved
map for future imports. You can view your saved maps by clicking on the Import Mapping drop down list in the
Create Import Activity page.

Also, you can select and then edit your saved maps for the specific objects in the Import Objects page.
6. You select a predefined mapping from the list of available mappings under the Import Mapping drop-down

list. If you're reusing an import mapping, then both the source and target columns are already populated.

Leave the Attribute Display Name field blank for any column that you don't want to import.

Click Validate Data to check the field mapping.
7. In the case of hierarchical import, you can see the mapping information for child objects in the subsequent

tabs. Note that data validation isn't done for these objects.
8. Click Next. On the Review and Submit page, review the import activity configuration. If you had not run the

prevalidation on the Map Fields page, then you get a notification message to run the validation process. You
can view any unmapped columns of parent or child objects on this page.

9. Click Validate Data to check the data in your source file. Validation errors, if any, are displayed on the Mapping
Validation screen. If you get warnings about unmapped columns, then you can ignore these columns, and
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proceed to submit the import job. Validations are for informational purposes and applicable only for low-
volume imports.

Note:  In import activity with single CSV hierarchical records, explicit validation from the mapping UI isn't
supported. For example, while importing the sales territory object, if there are matching values for the
attributes ParentUniqueTerritoryNumber and UniqueTerritoryNumber, then validation isn't supported.

Note:  During the import validation process on the Mapping page, the following custom triggers aren't
supported:

◦ Before InValidate

◦ Before Remove

◦ Before Insert in Database

◦ Before Update in Database

◦ Before Delete in Database

◦ Before Rollback in Database

◦ After Changes Posted to Database

10. Click Submit to queue the import.

Note that business events aren't fired when using Import Management.

Automating and Scheduling Import Jobs
You can automate import jobs using the import REST services. The import REST services let you manage import
activities, manage activity maps, and export object metadata. You can use an external scheduler that uses these REST
services to run recurring import jobs, create and run import activities, manage maps, and review object metadata.

You can use the Oracle WebCenter Content Document Transfer Utility to manage the import files used by the scheduler.
You can download the Oracle WebCenter Content Document Transfer Utility by navigating to the My Oracle Support
(support.oracle.com) document Oracle WebCenter Content Document Transfer Utility Readme (document ID 1624063.1).
Once downloaded, you can run the tool by navigating to the ridc folder after extraction.

For detailed instructions on automating and scheduling file import using REST API, see Oracle CX Sales and Fusion
Service: Automating and Scheduling File Import Activity Using REST API (Doc ID 2308691.1) article on My Oracle Support
(support.oracle.com).

Set Up Event Notifications for Resources
In file-based data import, the SendCredentialsEmailFlag attribute allowed the import to specify the notification setting
for each employee resource. You can do this in Import Management using the User Category option but this applies to
all resources in a single import.

To set up notifications for all events:

1. Navigate to Tools >  Security Console on the home page.
2. Click the User Categories tab.
3. Click DEFAULT. Click the Notifications tab.
4. Click the Edit button. If you want to turn on all notifications, then select the Enable Notifications check box

under the Notification Preferences heading.

133



Oracle Fusion Cloud Sales Automation
Sales Questions and Answers

Chapter 1
Sales Questions and Answers

5. Click the Save button.
6. Click the Done button.

To set up notifications for a specific event:

1. Navigate to Tools >  Security Console on the home page.
2. Click the User Categories tab.
3. Click DEFAULT. Click the Notifications tab.
4. Click the Edit button.
5. If you want to turn on a specific event notifications, click the template for the desired event.
6. On the Template Information page, select the Enabled check box and click Save and Close.
7. Click the Save button.
8. Click the Done button.

Import FCLs and DCLs
Setting FCL Field values

You must pass the lookup code in order to set the FCL field using import management.

Setting FCL and DCL Fields to Null

You must pass #NULL value for the FCL field in order to nullify a value for an FCL using Import Management.

Here is an example to nullify TargetGlobalPJDetailFlag1_c field:

PartyId TargetGlobalPJDetailFlag1_c

100000001527765
 

#NULL
 

Related Topics
• How do I monitor import activities?

• How do I map import fields?

• What are the available data import options?

• What are the roles required to import or export data?

• How do I import attachments?

How do I import contract header descriptive flexfield
data?  
You can use Import Management to create or update Contract Header Descriptive Flexfield records.

To import Contract Header Descriptive Flexfield records, perform the following tasks:

1. Map your source data to Oracle Applications Cloud object attributes.
2. Create source Comma Separated Values (CSV) file for import.
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3. Create the import activity.
4. Review the import results.

How You Map Your Source Data to Object Attributes
To import your Contract Header Descriptive Flexfield data into Oracle Applications Cloud, you must populate a .csv file
with your source data and map that source data to target object attributes in Oracle Applications Cloud.

You need to do the following before creating the CSV file for data import:

• Identify how your source data attributes map to the target object attributes in Oracle Applications Cloud.

• Ensure prerequisite setups are done, if applicable.

• Understand your options for uniquely identifying the records.

• Ensure parent records exist before importing child records.

• Identify the target object attributes that are required in the CSV file for a successful import.

Before You Start
You must do some basic checks before starting your import. For example:

• Complete all the prerequisites for importing each attribute in your source data.

• Have all parent records in place before importing child records.

Select a Unique Identifier for Your Records
To import data into Oracle Applications Cloud, your CSV file must include some specific attributes that enable the
import process to uniquely identify the records. The file import process uses the attribute values to automatically map
your source data to the target object attributes in Oracle Applications Cloud.

The preferred options to uniquely identify an object record are as follows:

• Internal ID: If you're identifying a record that already exists in Oracle Applications Cloud, then you can use
the internal ID of the record, a system-generated unique identifier attributes with "ID" in the attribute name
are typically internal IDs. You can determine the internal ID of a record by exporting Oracle Applications
Cloud object data, or by doing a transactional database query. Using an internal ID typically provides better
performance and reduces the import duration. For the Contract Header Descriptive Flexfield object, the
attribute is Contract Id.

• Public unique identifiers: If you're creating new records, then you can provide a user-friendly public unique
identifier (attributes denoted with 'Number' and usually visible in the business object's UI). If you update a
record for which you have previously provided a Number attribute, or for which a Number attribute is visible
in the object's UI, you can use the Number attribute to identify the record. For the Contract Header Descriptive
Flexfield object, the attribute is Contract PUID.

Required Attributes and Validations for the Contract Header Descriptive
Flexfield Object
To import data successfully into Oracle Applications Cloud, your CSV file must include the required attributes. Ensure
that you provide valid values for the attributes. The following table lists the required attributes for importing new
Contract Header Descriptive Flexfield records, prerequisite setup tasks for the attributes, and specific validations, if any,
for Contract Header Descriptive Flexfield import:
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Attribute Description Prerequisite Setup Task/
Import Validations

Creating a Contract
Header Descriptive
Flexfield Record

Updating an Existing
Contract Header
Descriptive Flexfield
Record

ContractId
 

The Id of the contract.
 

This must be a valid
contract Id.
 

Not required
 

Not required
 

ContractPuid
 

The unique PUID that
identifies the contract.
 

This must be a valid
contract PUID.
 

Required
 

Required
 

AttributeCategory
 

Attribute category of the
descriptive flexfield
 

No validation
 

Not required
 

Not required
 

Attribute1
 

Attribute 1 of the
descriptive flexfield
 

No validation
 

Required
 

Not required
 

Attribute2
 

Attribute 2 of the
descriptive flexfield
 

No validation
 

Not required
 

Not required
 

Attribute3
 

Attribute 3 of the
descriptive flexfield
 

No validation
 

Not required
 

Not required
 

Attribute4
 

Attribute 4 of the
descriptive flexfield
 

No validation
 

Not required
 

Not required
 

Attribute5
 

Attribute 4 of the
descriptive flexfield
 

No validation
 

Not required
 

Not required
 

You can view the Contract Header Descriptive Flexfield object and attributes in the Manage Import Objects page of the
Import Management flow. You can find attribute information like type, length, description, and so on, on this page.

Note:  For importing Context Sensitive DFFs you need to run a query in the "okc_k_headers_all_b" table that contains
the DFF you want to import. It lets you find out and populate your "AttributeCategory" field that is required to perform
the operation. It's recommended to perform the query on an already existing contract that contains the DFF you want
to import, so you can easily find the "AttributeCategory" field.To provide the Attribute category: 1. Create/Update a
contract with the Context of DFF you're expecting 2. Get the query output of "Select ATTRIBUTE_CATEGORY from
okc_k_headers_all_b where contract_number = '<<Contract Number>>'" 3. Update the value fetched from the above
query in the import data file

Create the Source CSV File
You include the data that you want to import into Sales and Fusion Service in a source CSV file.

You can use the CSV templates available in the Import Objects UI page to create the source CSV file. To download a CSV
template:

1. Go to Navigator  > Tools >  Import Management >  Import Objects.
2. Select the Contract Header Descriptive Flexfield object in the table and click Download.
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You can now edit the downloaded file and provide valid values for the required attributes.

Note:  For help in populating the CSV file and to avoid any issues in entering values, see the topic Potential Issues
When Opening CSV Files With Excel in Related Topics section.

Create the Import Activity
After you have the CSV file ready, create an import activity to import the information. To create an import activity:

1. Go to Navigator  > Tools >  Import Management >  Import Queue.
2. Click Create Import Activity in the Manage Imports page.
3. In the Enter Import Options page, provide a name for the import activity, and select Contract Header

Descriptive Flexfield from the Object drop-down list.
4. Select the CSV file in the File Name field, and click Next.
5. The source and target attributes are automatically mapped in the Map Fields page. Review and edit the

mappings if required.
6. Check the file for unmapped columns or data format issues by clicking Validate Data. Click Next.
7. Review the import details on the Review and Submit page, and click Submit when you're ready.

Review the Import Results
Check if your import succeeded on the Manage Imports page. This page shows the status of all active, completed, and
unsuccessful imports. To check the status of the import activity:

1. Go to Navigator  > Tools >  Import Management >  Import Queue.
2. Click All Imports and search for the import activity that you created earlier.
3. Check the Status column for the import activity. The import is successful if the status displays as Completed.

You can drill down on the import activity to go to the Import Status page which provides the status details of
the import activity.

Related Topics
• How do I import data?

• Potential Issues When Opening CSV Files in Excel

Why can't I see some classification information in
Customer Center?  
Customer Center displays the classification and classification group information of a customer in the Classifications
node. All classifications are categorized under classification categories.

For example, the 1987 SIC classification category has a classification code of software that you can assign to a party in
the software industry.

Customer Center displays the classification information based on the classification categories configured in the Manage
Classification Group task. You must configure all classification categories, and their codes, that you want to use in
the task so that they can be displayed in the Customer Center. For example, you have imported a customer with a
classification code that belongs to the category Major Industry Codes. However, if you don't add the classification
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category Major Industry Codes in the Manage Classification Group page then the classification code isn't displayed in
the Customer Center.

How do I import contact point data?  
You can use Import Management to create, update, or delete Contact Point records. You can use contact point to import
customer contact information such emails, phone numbers, instant messenger address, web URL, and so on.

To import Contact Point records, perform the following tasks:

1. Map your source data to Oracle Applications Cloud object attributes.
2. Create source Comma Separated Values (CSV) file for import.
3. Create the import activity.
4. Review the import results.

How You Map Your Source Data to Target Object Attributes
To import your Contact Point data into Oracle Applications Cloud, you need to populate a CSV file with your source data
and map that source data to target object attributes in Oracle Applications Cloud.

You need to do the following before creating the CSV file for data import:

• Identify how your source data attributes map to the target object attributes in Oracle Applications Cloud.

• Ensure prerequisite setups are done, if applicable.

• Understand your options for uniquely identifying the records.

• Ensure parent records exist before importing child records.

• Identify the target object attributes that are required in the CSV file for a successful import.

• Ensure that you don't insert duplicate addresses while importing, to avoid redundant data.

Before You Start
You must do some basic checks before starting your import. For example, make sure that:

• You have completed all the prerequisites for importing each attribute in your source data.

• You have all parent records in place before importing child records.

Select a Unique Identifier for Your Records
All records must be unique in the application. You can use one of these to identify records:

• Public unique identifiers: If you're creating records, then you can provide an easily understandable public
unique identifier. These are, usually, denoted with 'Number' and visible in the business object's UI. PUID
attributes are usually named <object> Number. If you're updating a record with a Number attribute, then use
the Number attribute to identify the record. For more information about public unique identifiers, see the topic
"How You Use Alternate Keys to Import Records" in Related Topics section.

• Source system and source system reference: Source system is an identifier for the external system, and source
system reference is a unique identifier within the external system. If you're importing new contacts or are
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updating contacts that have source system reference data, then provide the source system and source system
reference values.

Required Attributes and Validations for Contact Point Object
To import data successfully into Oracle Applications Cloud, your CSV file must include the required attributes. Ensure
that you provide valid values for the attributes. This table lists the required attributes for importing new Contact Point
records, required attributes for updating Contact Point records, prerequisite setup tasks for the attributes, and specific
validations, if any, for Contact Point import:

Attribute Description Prerequisite Setup Task/
Import Validations

Creating a Contact Point
Record

Updating an Existing
Contact Point Record

ContactPointType
 

Type of the contact point
that's imported or updated
 

This has to be a lookup_
code in HZ_LOOKUPS
with a lookup_type as
COMMUNICATION_TYPE
 

Provide one of these
values:
 

• EMAIL, if the email
address is to be
imported.

• INSTANT_
MESSAGING, if the
instant messenger
address is to be
imported.

• WEB, if the URL is to
be imported.

• PHONE, if the phone
number is to be
imported.

Not required
 

PartyId
 

The internal ID for the party
to which the contact point
belongs
 

No validation
 

Provide one of the
following :
 

• PartyId

• Party Number

• A combination of
Party Source System
and Party Source
System Reference
Value

Not required
 

PartyNumber
 

Specifies the PUID of the
party
 

No validation
 

Provide one of the
following :
 

• PartyId

• Party Number

• A combination of
Party Source System
and Party Source
System Reference
Value

Not required
 

PartySourceSystem
 

Specifies the original
source system of the party
 

This has to be in HZ_ORIG_
SYSTEMS_B with the status
"A".

Provide one of the
following :
 

Not required
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Attribute Description Prerequisite Setup Task/
Import Validations

Creating a Contact Point
Record

Updating an Existing
Contact Point Record

 • PartyId

• Party Number

• A combination of
Party Source System
and Party Source
System Reference
Value

PartySourceSystemReferenceValue
 

Specifies the party's source
system reference in the
original source system
 

No validation
 

Provide one of the
following :
 

• PartyId

• Party Number

• A combination of
Party Source System
and Party Source
System Reference
Value

Not required
 

SourceSystem
 

Specifies the original
source system name
 

This has to be in HZ_ORIG_
SYSTEMS_B with the status
"A".
 

Provide a valid value.
 

Not required
 

SourceSystemReferenceValue
 

Specifies the identifier in
the original source system
 

No validation
 

Provide a valid value.
 

Not required
 

ContactPointId
 

System generated unique
identifier. This is the
primary key.
 

No validation
 

Not required
 

If you can export the
existing contact point,
 provide this primary key
to identify the record for
further updates.
 

Status
 

The status of the contact
point.
 

Not required
 
This defaults to Y during
creation.
 

Not required
 

To inactivate the existing
active contact point record,
 provide the value "N".
 

DoContactPreferenceFlag
 

Add or update a contact's
preference to receive e-
mail or phone calls on
the contact, account or
household contact points.
This attribute identifies if a
contact has made a choice
to be contacted.
 

Don't set both
this attribute and
DoNotContactPreferenceFlag
to Y simultaneously.
 
Set either this attribute or
DoNotContactPreferenceFlag
to "Y". These are non-
mandatory values.
However, you can set
both this attribute and
DoNotContactPreferenceFlag
to "N".
 

Not required
 

Not required
 

DoNotContactPreferenceFlag
 

Add or update a contact's
preference not to receive
e-mail or phone calls on

Don't set both
this attribute and

Not required
 

Not required
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Attribute Description Prerequisite Setup Task/
Import Validations

Creating a Contact Point
Record

Updating an Existing
Contact Point Record

the contact, account or
household contact points.
This attribute identifies if a
contact has made no choice
to be contacted.
 

DoContactPreferenceFlag
to Y simultaneously.
 
Set either this attribute or
DoContactPreferenceFlag
to "Y". These are non-
mandatory values.
However, you can set
both this attribute and
DoContactPreferenceFlag
to "N".
 

DoNotContactReason
 

Add or update the reason
for a contact not to receive
e-mail or phone calls on
the contact, account or
household contact points.
 

This is used for
DoNotContactPreferenceFlag.
It is a non-mandatory field.
 

Not required
 

Not required
 

You can view the Contact Point object along with all its child objects and attributes in the Manage Import Objects page
of the Import Management flow. You can find attribute information like type, length, description, and so on, on this
page.

Create the Source CSV File
You include the data that you want to import into Sales and Fusion Service in a source CSV file.

You can use the templates available in the Import Objects UI page to create the source CSV file. To download a template:

1. Go to Navigator  > Tools >  Import Management >  Import Objects.
2. Select the Contact Point object in the table and click Download.

You can now edit the downloaded file and provide valid values for the required attributes.

Note:  For help in populating the CSV file and to avoid any issues in entering values, see the topic Potential Issues
When Opening CSV Files With Excel in Related Topics section.

Create the Import Activity
After you have the CSV file ready, create an import activity to import the information. To create an import activity:

1. Go to Navigator  > Tools >  Import Management >  Import Queue.
2. Click Create Import Activity in the Manage Imports page.
3. In the Enter Import Options page, provide a name for the import activity, and select Contact Point from the

Object drop-down list.
4. Select the CSV file in the File Name field, and click Next.
5. You would see that the source and target attributes are automatically mapped in the Map Fields page. Review

and edit the mappings if required.
6. Check the file for unmapped columns or data format issues by clicking Validate Data. Click Next.
7. Review the import details on the Review and Submit page, and click Submit when you're ready.
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Review the Import Results
Check if your import succeeded on the Manage Imports page. This page shows the status of all active, completed, and
unsuccessful imports. To check the status of the import activity:

1. Go to Navigator  > Tools >  Import Management >  Import Queue.
2. Click All Imports and search for the import activity that you created earlier.
3. Check the Status column for the import activity. The import is successful if the status displays as Completed.

You can drill down on the import activity to go to the Import Status page which provides the status details of
the import activity.

Related Topics
• How do I import data?

• Potential Issues When Opening CSV Files in Excel

• How You Use Alternate Keys to Import Records

How do I import product group data?  
You can use the import management to create or update Sales Catalog Product Group or Product Group records.

To import Product Group/Sales Catalog Product Group records:

1. Map your source data to Oracle Applications Cloud object attributes.
2. Create source Comma Separated Values (.csv) file for import.
3. Create the import activity.
4. Review the import results.

How You Map Your Source Data to Target Object Attributes
To import Product Group data into Oracle Applications Cloud, you need to populate a CSV file with your source data and
map that source data to target object attributes in Oracle Applications Cloud.

You need to do the following before creating the .CSV file for data import:

• Identify how your source data attributes map to the target object attributes in Oracle Applications Cloud.

• Ensure prerequisite steps are complete, such as understanding what attributes are required for importing your
objects.

• Understand your options for uniquely identifying the records.

• Ensure parent records exist before importing child records.

• Identify the target object attributes that are required in the .CSV file for a successful import.

Before You Start
You need to set certain options for some attributes in the application before you can populate them. When importing a
child record, ensure that its parent record exists in the database.
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Select a Unique Identifier for Your Records
To import data into Oracle Applications Cloud, your CSV file must include some specific attributes that enable the
import process to uniquely identify the records. The file import process uses the attribute values to automatically map
your source data to the target object attributes in Oracle Applications Cloud.

The preferred options to uniquely identify an object record are as follows:

• Internal ID: If you're identifying a record that already exists in Oracle Applications Cloud, then you can use
the internal ID of the record, a system-generated unique identifier Attributes with "id" in the attribute name
are typically internal IDs. You can determine the internal ID of a record by exporting Oracle Applications
Cloud object data, or by doing a transactional database query. Using an internal ID typically provides better
performance and reduces the import duration. For the Product Group object, this attribute is ProdGroupId.

• Public unique identifiers: If you're creating new records, then you can provide a user-friendly public unique
identifier (attributes denoted with 'Number' and usually visible in the business object's UI). If you update a
record for which you have previously provided a Number attribute, or for which a Number attribute is visible
in the object's UI, you can use the Number attribute to identify the record. For the Product Group object, the
attribute is ProductGroupReferenceNumber.

Required Attributes and Validations
To import data successfully into Oracle Applications Cloud, your .CSV file must include the required attributes. Ensure
that you provide valid values for the attributes.

This table lists the required attributes for importing new Product Group records, required attributes for updating
Product Group records, prerequisite setup tasks for the attributes, and specific validations, if any, for Product Group
import:

Attribute Description Data Type Data Length Prerequisite
Setup Task/
Import
Validations

Creating a
Product Group
Record

Updating an
Existing Product
Group Record

ProdGrpDetailsId
 

The unique
identifier of the
product group
details.
 

Long
 

18
 

No validation
 

Not required
 

Not required
 

StartDate
 

The date and time
from when the
product group is
available in the
catalog.
 

Time stamp
 

 The start date can't
be later than the
end date.
 

Not required
 

Optional
 

EndDate
 

The date and time
when the product
group is no longer
available in the
catalog.
 

Time stamp
 

 The end date has
to be later than the
start date.
 

Not required
 

Optional
 

InternalName
 

The product
group's unique
name
 

String
 

150
 

Enter a unique
name.
 

Required
 

This can't be
updated.
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Attribute Description Data Type Data Length Prerequisite
Setup Task/
Import
Validations

Creating a
Product Group
Record

Updating an
Existing Product
Group Record

ProdGroupName
 

The product group
name displayed in
the catalog.
 

String
 

250
 

No validation
 

Required
 

Optional
 

ActiveFlag
 

Indicates whether
the product
group is active or
inactive.
 

String
 

1
 

Enter either Y or N.
 

Defaults to Y
 

Optional
 

AllowDuplicateContentFlag
 

Indicates whether
products or
product groups
are allowed to
be added to the
product group
hierarchy more
than once.
 

String
 

Required
 

Optional
 

Defaults to N
 

Optional
 

ProdGroupId
 

Unique identifier of
the product group
 

Long
 

18
 

No validation
 

A value is auto
generated.
 

Required
 

ProductGroupReferenceNumber
 

The unique value
used to identify the
product group.
 

String
 

50
 

Setup the on prefix
and radix. Navigate
to the following
in the Setup and
Maintenance work
area:
 

• Offering:
Sales

• Functional
Area: Data
Import and
Export

• Task: Manage
Public Unique
Identifier
Sequence
Generation

A value is auto
generated. You can
also enter a value.
 

Required
 

RevenueRoleCode
 

The code
indicating the
revenue role
associated with
the product group.
For example, Sales
revenue line set or
Sales revenue line
set member.
 

String
 

30
 

FCL validated
against MOO_
REVENUE_ROLE
lookup
 

Not required
 

Optional
 

RevenueCategoryCode
 

The code
indicating the
revenue category

String
 

30
 

FCL validated
against MOO_

Not required
 

Optional
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Attribute Description Data Type Data Length Prerequisite
Setup Task/
Import
Validations

Creating a
Product Group
Record

Updating an
Existing Product
Group Record

associated with the
product group. For
example, Software,
 Maintenance,
 Service, Training,
 Hardware, or Back
Maintenance.
 

REVN_CATEGORY
lookup
 

AllowSelectionFlag
 

Indicates whether
the product group
is available for
selection
 

String
 

1
 

Enter either Y or
N. The import
operation fails, if
updating a record
results in:
 

• Circular
hierarchy

• Parent
product
group
with allow
duplicate N
and child with
Y.

• Hierarchy
with allow
duplicate
N results in
repeated
child/
products.

Defaults to Y
 

Optional
 

ModelName
 

Unique name of
the model
 

String
 

1000
 

No validation
 

Not required
 

Optional
 

ModelConfigAttributes
 

Model attributes
 

String
 

4000
 

No validation
 

Not required
 

Optional
 

ProdGroupDescription
 

Brief description of
the product group
 

String
 

1000
 

No validation
 

Not required
 

Optional
 

UsageRootFlag
 

Indicates whether
the product
group is the root
product group in a
hierarchy.
 

String
 

1
 

Enter either Y or N.
 

Defaults to N
 

Optional
 

AttachmentEntityName
 

Unique name of
the Attachment
Entity
 

String
 

255
 

No validation
 

Not required
 

Optional
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You can view the Product Group object along with all its child objects and attributes in the Manage Import Objects
page of the Import Management flow. You can find attribute information like type, length, description, and so on, on
this page.

Create the Source CSV File
You provide the .CSV file as input during the file-based data import process. You must populate the .CSV file with the
data you want to import into Oracle Applications Cloud.

You can either create a CSV file on your own or use templates available in preexisting mappings. To download a
template:

1. In the Navigator, under Tools, click Import Management.
2. Click Import Objects tab to open the Import Object Details page.
3. Select the object you're interested in the Import Object Details page and click the Download icon next to that

object name.
4. Save the template CSV file to a location on your desktop.

Note:  To import the product group successfully, you should split the import file into Group, Subgroup, and Item.

You must edit the template CSV file and provide valid values for the required attributes. You can attach different types of
files, giving each file a specific description.

ProductGroupReferenceNumberInternalName ProdGroupNameProdGroupDescriptionUsageRootFlag ActiveFlag AllowDuplicateContentFlagStartDate EndDate

PGSIImport_
001
 

PGSIImport_
001
InternalName
 

Display
name of
PGSIImport_
001
 

Description of
PGSIImport_
001
 

Y
 

Y
 

Y
 

05/10/2019
10:10
 

06/11/2019
11:11
 

Create the Import Activity
To import data into Oracle Applications Cloud, you need to create an import activity and provide the CSV file as an input
to the activity.

To create an import activity:

1. In the Navigator, under Tools, click Import Management.
2. On the Manage Imports page, click Create Import Activity.
3. In the Create Import Activity: Enter Import Options page, provide a name for the import activity, and select

Product Group from the Object drop-down list.
4. In File Name, browse and upload the required .CSV file, and click Next.
5. In the Create Import Activity: Map Fields page edit the attribute mappings if required, and click Next.

Note:  Click Validate Data to validate the mapping of the source file for unmapped columns and to check for
data format issues.

6. In the Create Import Activity: Review and Submit page, click Submit.

Review the Import Results
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You can review the import results by checking for the import activity in the Manage Import Activity page. A file import
activity is said to be successful when its status displays as Completed. To check the status of the import activity, do as
follows:

1. In the Navigator, under Tools, click Import Management.
2. On the Manage Imports page, search for the import activity that you created using one of the search criteria,

such as status, name, object, and so on.
3. Check the Status column for the import activity. The import is successful if the status displays as Completed.

The other valid values for the import activity status are Queued for import, Preparing data for import,
Importing data, Completed with errors, and Unsuccessful.

Note:  On this page you can also quickly view the number and status of all active imports, completed imports, and
unsuccessful imports that have been submitted.

Related Topics
• How do I import data?

How do I import incentive participant role assignments
data?  
You can use Import Management to create or update Incentive Participant Role Assignments.

To import Incentive Participant Role Assignments records, perform the following tasks:

1. Map your source data to Oracle Applications Cloud object attributes.
2. Create source Comma Separated Values (.csv) file for import.
3. Create the import activity.
4. Review the import activity.

How You Map Your Source Data to Target Object Attributes
You import Participant Role Assignments data into Oracle Applications Cloud from a CSV file containing your source
data that's mapped to target Oracle Applications Cloud object attributes.

You must do the following before creating the .csv file for data import:

• Identify how your source data attributes map to the target object attributes in Oracle Applications Cloud.

• Ensure prerequisite steps are complete, such as understanding what attributes are required for importing your
objects.

• Understand your options for uniquely identifying the records.

• Ensure parent records exist before importing child records.

• Identify the target object attributes that are required in the .csv file for a successful import
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Before You Start
You must do some basic checks before starting your import. For example, make sure that:

• You have completed all the prerequisites for importing each attribute in your source data.

• You have all parent records in place before importing child records.

Required Attributes and Validations for the Incentive Participant Role
Assignments Object
To import data successfully into Oracle Applications Cloud, your CSV file must include the required attributes. Ensure
that you provide valid values for the attributes.

This table lists the required attributes for Incentive Participant Role Assignments, prerequisite setup tasks and specific
validations, if any

Attribute Description Prerequisite Setup Task/
Import Validations

Creating an Incentive
Participant Role
Assignment record

Updating an Incentive
Participant Role
Assignment record

ParticipantRoleId
 

The unique identifier of the
participant role assignment.
 

None
 

Not Required
 

Required

ParticipantId
 

The unique identifier of a
specific participant.
 

It must be a valid
participant identifier.
 

Required
 

Conditionally Required.
Provide a value if
ParticipantRoleId isn't
provided.

RoleId
 

The unique identifier of the
role to which the participant
is being assigned.
 

It must be a valid role
identifier.
 

Required
 

Not Required

RoleStartDate Effective start date of the
role assignment.

None Required Conditionally Required.
Provide a value if you want
to change the start date.
 

RoleEndDate The end date of the role
assignment.

None Optional. Null signifies
open end date.
 

Optional. Null signifies
open end date.
 

AccessType This indicates whether the
role is a Manager role or
Member role.

None Not Required Not Required

PreserveAssignment Preserve the changes
done to the participant
role assignment and
prevent the automatic role
assignment from updating
or deleting this assignment.
 

None Not Required. Default value
is Yes.

Not Required

You can view the Incentive Participant Role Assignments object with its attributes in the Manage Import Objects page of
the Import Management flow. You can find attribute information like type, length, description, and so on, on this page.
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Create the Source CSV File
You include the data that you want to import into Sales and Fusion Service in a source CSV file.

You can use the templates available in the Import Objects UI page to create the source CSV file. To download a template:

1. Go to Navigator  > Tools >  Import Management >  Import Objects.
2. Select the Incentive Participant Role Assignments object in the table and click Download.

You can now edit the downloaded file and provide valid values for the required attributes.

Note:  For help in populating the CSV file and to avoid any issues in entering values, see the topic Potential Issues
When Opening CSV Files With Excel in Related Topics section.

Create the Import Activity
After you have the CSV file ready, create an import activity to import the Participant Role Assignments information. To
create an import activity:

1. Go to Navigator  > Tools >  Import Management >  Import Queue.
2. Click Create Import Activity in the Manage Imports page.
3. In the Enter Import Options page, provide a name for the import activity, and select Incentive Participant Role

Assignments from the Object drop-down list.
4. Select the CSV file in the File Name field, and click Next.
5. You would see that the source and target attributes are automatically mapped in the Map Fields page. Review

and edit the mappings if required.
6. Check the file for unmapped columns or data format issues by clicking Validate Data. Click Next.
7. Review the import details on the Review and Submit page, and click Submit when you're ready.

Review the Import Results
Check if your import succeeded on the Manage Imports page. This page shows the status of all active, completed, and
unsuccessful imports. To check the status of the import activity:

1. Go to Navigator  > Tools >  Import Management >  Import Queue.
2. Click All Imports and search for the import activity that you created earlier.
3. Check the Status column for the import activity. The import is successful if the status displays as Completed.

You can drill down on the import activity to go to the Import Status page which provides the status details of
the import activity.

Related Topics
• How do I import data?

• Potential Issues When Opening CSV Files in Excel

• How You Use Alternate Keys to Import Records
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How do I enable the verification of addresses, emails,
and phone numbers?  
This step is a prerequisite to verifying addresses, emails, and phone numbers. You can enable or disable address, phone,
and email verification services in the Configure Verification Services page. The Address Verification service is enabled
by default.

You can access Address, Email, and Phone Verification service only if you have already purchased Address Verification.

Note:  Currently, email and phone validations aren't supported in Customer Data Management UI.

1. You can configure the Verification Services in the Setup and Maintenance work area using the following:

◦ Offering: Customer Data Manager

◦ Functional Area: Data Quality Verification Services

2. Click the Quick Setup icon.

The Configure Verification Services page appears.
3. Select the verification services you want to enable.
4. Specify if the validity status of email and phone must be displayed.
5. (Optional) If you selected Yes in the previous step, specify the number of days since the last valid verification

status was run that the verification status must be displayed. For example, if you set this value to 60, then 60
days after the last valid verification was run the verification status is displayed.

6. Click Save and Close.

How do I apply mass update to accounts and contacts?  
You can use the mass update feature to update multiple accounts and contacts at the same time. For example, you
might want to change the primary contact or owner on multiple records without having to go into each record and make
the changes.

Among the fields that you can update for accounts are:

• Type

• Primary Contact

• Owner

• Industry

• Sales Profile Status

Among the fields that you can update for contacts are:

• Favorite Contact

• Job Title

• Prefix
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• Account

• Owner

Note:  Your administrator must enable this feature before it's available in the application.

Steps to Apply Mass Update
Here's how to update several fields on multiple accounts or contacts at once:

1. Navigate to the Accounts or Contacts landing page.
2. Search for the records you want to update.
3. Click Update from the Actions menu.
4. Select the records that you want to update and click the Update button.
5. Select the fields and assign or enter values for them. Keep in mind:

◦ If you want to update a field that has a parent field, then the value of the parent field must be the same
across all child records selected for mass update.

◦ You can't apply mass update to conditionally updatable fields.

6. When you're done making updates click Submit.

Related Topics
• How do I enable mass update of records?

What's the size limit for attachment files in the sales
application?  
Users can attach files, such as PDFs and Word docs, to both standard and custom objects. By default, the file size limit
for an individual, attached file is 2 G. You can decrease this limit, but you can't increase it.

There are no limits placed on the number of files. The size of the files is controlled centrally by the File Upload Maximum
Size (FND_FILE_UPLOAD_MAX_SIZE) profile option.

Also note:

• The only limit on the total file size that can be uploaded is the amount of available space that you have
purchased for the content server.

• There are no restrictions on the types of files you can attach.
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How do I apply the Redwood look to my home page and
configure the page?  
Your application should have the Redwood look by default. If not, you can apply the Redwood look by selecting the
Redwood theme. You can upload your own logo, cover image, or both, and save your updates as your own theme. Here's
how.

1. Activate a sandbox that has the Appearance tool in it.
2. Click Navigator  >  Configuration >  Appearance.
3. From the Themes list, select Redwood or a custom theme that someone created based on Redwood.
4. In the Logo and Cover Image fields, select the type of location where the images are stored, and do any of

these tasks based on what you select:

◦ File: Browse and select a file from your computer.

◦ Predefined: Select a file from the list of predefined images.

◦ URL: Enter a full URL for the logo.

◦ None: You don't need to do anything.

Here are a few best practices for configuring the logo and cover image:

◦ Make sure that the file names for your images don't have any spaces in them.

◦ Use a logo of width less than 200 pixels and height less than 50 pixels.

◦ Upload a monochrome version of your logo that's optimized for a dark background. The logo also needs
to be on a transparent background. The Redwood theme is optimized for a monochrome version of your
organization logo to maximize readability and accessibility, and to minimize unintentional color blending.

◦ Use a cover image of size 2600x290 pixels.

◦ After you upload a cover image, its colors are processed, and a Redwood color overlay is applied on the
processed image. So your cover image will look slightly different from the original image you uploaded.
The coloring process maximizes readability and accessibility, and minimizes unintentional color blending.

5. On the Actions menu, click Save As.
6. Enter a theme name.

Note:  You must enter a unique name that doesn't match with the name of any existing theme in your
application.

7. If you don't want to apply the theme to the application immediately, deselect the Apply this theme check box.
8. Click OK. If you've selected the Apply this theme check box, then your theme is saved and set as the current

theme. If you haven't selected the check box, your theme isn't applied to the application. But the theme is
saved, and you can apply it to your application later.
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If my organization forecasts by opportunity owner,
how do I assure salespeople see their forecasts after
importing resources?  
If your organization forecasts by opportunity owner and you import salespeople (resources) you must run the Refresh
Territories from Resources process. If you're using address, product, or another sales territory dimension to assign
opportunities, then you can skip this setup entirely

The Refresh Territories from Resources process runs automatically before each forecasting window. If you run the
process immediately after importing sales users, you assure that users get to see forecasts immediately rather than
having to wait for the next forecasting period. The process updates the territory hierarchy to match your resource
hierarchy, with the resources as territory owners.

1. Click Navigator > Tools > Scheduled Processes.
2. On the Overview page, click Schedule New Process.
3. In the Schedule New Process window, enter Refresh Territories from Resources in the Name field and press

Return.
4. Select the process and click OK.

How do I set up Global Search if it isn't working?  
If the Global Search at the top of your Home page isn't working, check your Adaptive Search setup. You can specify
which of the objects you enabled for Adaptive Search are searchable in Global Search and how the search results are
displayed.

Each Global Search result, includes:

• A title that provides the link that users click to drill down into the record. By default, the name of the record is
the title, but you can choose a different field.

• Two lines displaying fields you specify

Here is a screenshot showing the results of an account search:
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Here's how to enable Global Search:

1. In the Setup and Maintenance work area, open the Configure Adaptive Search task:

◦ Offering: Sales

◦ Functional Area: Sales Foundation

◦ Show: All Tasks

◦ Task: Configure Adaptive Search
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2. In the Configure Adaptive Search page, click the Configure Global Search tab in the left-side of the page
(callout 1 in the screenshot).

1. Configure each object you enabled for Adaptive Search:
a. Click the object link in the Objects column on the left (callout 2).
b. You can prevent users from using Global Search to search the object by deselecting the Display in UI

option (callout 3). By default, users can search all objects you enabled for Adaptive Search.
c. By default, users click on the record name link in the search results to drill into a record, but you can

select a different field. To change the drill-down link, click Title (the pencil icon, callout 4) and select the
alternate field.

d. Click the Line 1 edit button and select the fields you want to display in the first line under the title.
e. Click the Line 2 edit button and select the fields you want to display in the second line.
f. Click Save.

2. When you complete configuring all the objects, click Save and Close.

How do I stop users from being spammed with
reminders?  
You can reduce number of reminders by controlling which notifications are sent to salespeople about tasks and other
activities by setting profile options.

Company-Level Notifications
For the entire company, you can specify whether users:

• Receive notifications as owners of an activity

• Receive notifications if they aren't the owners of an activity
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• Receive task notifications if changes are made to completed tasks

For both appointments and tasks, you can specify:

• Whether users receive email notifications

• Whether users receive notification messages in the notifications list

Note:  If you enable email notifications at the company level, each individual user can still choose not to receive email
notifications. If you enable notifications in the notifications list, each individual user can still choose not to receive
notifications in the notification list.

Here are the profile options for setting up company-level activity notifications:

Profile Option Name Default Value Description

Task Notification to Contacts and Consumer
Customers Enabled
 

N
 

Enables notifications to external participants
when tasks are created, updated, or deleted
 

Appointment Notification to Contacts and
Consumer Customers Enabled
 

Y
 

Enables notifications to external participants
when appointments are created, updated, or
deleted
 

Disable Appointment E-Mail Notification
 

N
 

Specifies whether to disable appointment email
notifications
 

Disable Task E-Mail Notification
 

N
 

Specifies whether to disable task email
notifications
 

Disable Task Notification List
 

N
 

Specifies whether to disable task notifications
in the notifications list
 

Disable Appointment Notification List
 

N
 

Specifies whether to disable appointment
notifications in the notifications list
 

User-Level Notifications
You can set several profile options at the user level to control the behavior of notifications. The user preferences setting
are stored in the profile options. Users can modify their notification preferences using the preferences pages, located
under their user names in the global area.

Here are the user-level profile options for activity notification preferences:

User Name Default Value Description

Appointment Owner Notifications
 

N
 

Enables receiving appointment notifications
when the user is the owner of the appointment
 

156



Oracle Fusion Cloud Sales Automation
Sales Questions and Answers

Chapter 1
Sales Questions and Answers

User Name Default Value Description

Appointment Resource Notifications
 

Y
 

Enables receiving appointment notifications
when the user is a resource or invitee of the
appointment
 

Task Owner Notifications
 

N
 

Enables receiving task notifications when the
user is the owner of the task
 

Task Resource Notifications
 

Y
 

Enables receiving task notifications when the
user is a resource on the task
 

Task Notifications For Completed Tasks
 

N
 

Enables receiving task notifications for tasks
that have already been completed
 

Notification List Appointment Notifications
Enabled
 

Y
 

Enables receiving appointment notifications in
the notifications list
 

Email and List Appointment Notifications
Enabled
 

NA
 

Enables receiving appointment notifications in
the notifications list and through email
 

Notification List Appointment Notifications
Enabled
 

Y
 

Enables receiving appointment notifications in
the notifications list
 

E-Mail Task Notifications Enabled
 

Y
 

Enables receiving task notifications by email
 

E-Mail Appointment Reminders Enabled
 

Y
 

Enables receiving appointment reminders by
email notifications
 

Notification List Appointment Reminders
Enabled
 

N
 

Enables receiving appointment reminders in the
notifications list
 

Owner Initiated Task Notifications Enabled
 

N
 

Enables receiving task notifications when a user
creates, updates, or deletes a task and they're
the owner of the task
 

Owner Initiated Appointment Notifications
Enabled
 

N
 

Enables receiving appointment notifications
when a user creates, updates, or deletes an
appointment and they're the owner of the
appointment
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How to Disable Notifications for the Entire Company
You can disable activity notifications globally, so that no one in the company receives notifications. To disable
notifications:

1. In the Setup and Maintenance area, go to:

◦ Offering: Sales

◦ Functional Area: Sales Foundation

◦ Task: Manage Administrator Profile Values

2. Enter the profile option to disable email or appointment notification, in the Profile Option Code field.

Here the items you can disable and the profile options you use to disable them, company-wide:

What to Disable Profile Option

Appointment email notification
 

ZMM_ACTIVITY_DISABLE_EMAIL_APPT_NOTIF
 

Task email notification
 

ZMM_ACTIVITY_DISABLE_EMAIL_TASK_NOTIF
 

Appointment notification in the
notification list
 

ZMM_ACTIVITY_DISABLE_LIST_APPT_NOTIF
 

Task notification in the notification list
 

ZMM_ACTIVITY_DISABLE_LIST_TASK_NOTIF
 

3. For each item you're disabling, change the related site-level profile value to Yes.

How can I protect supporting documents from deletion? 

You can protect your supporting documents from being inadvertently deleted. Adding the new privilege, Delete
Supporting Documents by Contract Status, to the required roles lets you restrict the deletion of supporting documents
in all contract statuses other than Draft and Under Amendment.

To restrict the deletion of supporting documents in all contract statuses, revoke the existing privilege, Delete
Supporting Documents, for specific roles.

This table describes how you can configure the privileges
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Delete Supporting Documents Privilege Delete Supporting Documents by Contract
Status Privilege

Result

Yes Yes User can delete supporting documents in all
contract statuses

Yes No User can delete supporting documents in all
contract statuses

No No User can't delete supporting documents in any
contract status

No Yes User can delete supporting documents only in
Draft and Under Amendment contract status

The supplied privilege, Delete Supporting Documents by Contract Status Privilege, isn't assigned to any role by default.
Add the privilege to the necessary roles and revoke the existing privilege, Delete Supporting Documents.

For information about how to add and remove privileges to user roles, see the Edit Job or Abstract Roles topic.

How can I fetch only supplier sites that belong to the
supplier on a contract?  
Add the Contract Party Contact DFF to the contract header. The header DFF has the contract_id parameter and it can be
passed into the where clause condition and by using a where clause condition.

Here are the values to pass to the table value set of the supplier site DFF field:

• FROM: okc_k_headers_all_b a, okc_k_party_roles_b b, POZ_SUPPLIER_SITES_ALL_M c, POZ_SUPPLIERS d

• VALUE COLUMN NAME: VENDOR_SITE_CODE

• WHERE CLAUSE:

◦ a.id = b.chr_id

◦ and a.major_version = b.major_Version

◦ and b.RLE_CODE = 'SUPPLIER'

◦ and c.VENDOR_ID = d.vendor_id

◦ and c.PRC_BU_ID = a.org_id

◦ and d.party_id = b.OBJECT1_ID1

◦ and a.contract_id = :{PARAMETER.ContractId}
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Can contracts deliverables functionality be used in
standalone mode?  
No, you can't use Enterprise Contracts without its deliverables. It always exists in the context of a document, such as a
contract or purchase order.

Related Topics
• Contract Deliverables

How do I create membership rules for custom access
groups?  
You can add resource users to a custom access group by defining one or more group membership rules. Each rule
consists of conditions that determine which resources are added as members of the group.

Any users who satisfy the conditions are automatically added to the access group. Group members who no longer meet
the conditions are automatically removed from the group. You can't manually remove group members added through
group membership rule processing.

Here's how you can create a group membership rule to add members to your access group:

1. On the Access Group page, select the group you're creating the membership rule for.
2. On the Edit Access Group: Overview page, select the Member Rules tab, then click Create Rule.
3. On the Access Group: Create Group Membership Rule page, enter a Name for the group membership rule and a

Description if required.
4. In the Conditions section, specify the rule conditions.

Each rule consists of one or more conditions that are evaluated individually. You can choose whether the rule
action applies if any conditions are met, or only if all conditions are met, by selecting the appropriate value from
the Rule Applies If list.

5. Enter a rule condition by clicking the Add icon and enter the values shown in the following table:

Field Description

Object
 

Select either the Resources object or the Resources Hierarchy object.
 
Only resource users can be added to an access group, so you can only select one of these
objects.
 

Attribute
 

Select an attribute from the list. Both custom and standard attributes defined for the object you
selected are listed.
 

160

https://www.oracle.com/pls/topic/lookup?ctx=fa-latest&id=s20027633


Oracle Fusion Cloud Sales Automation
Sales Questions and Answers

Chapter 1
Sales Questions and Answers

Field Description

Support for a number of resource object attributes will be discontinued in future releases. So to
prevent issues in the future:
 

◦ Avoid using these attributes:

User Account Status, Company, Phone, Job Title, Manager First Name, Manager Last
Name, Organizations, Teams, Usages

◦ Use custom attributes that are based on database columns only. Avoid using custom
attributes, such as attributes based on the Formula field, that aren't based on database
columns. Support for attributes that aren't based on database columns will be deprecated
in future releases.

Operator
 

Select the operator for your condition. For example, Equals or Is blank.
 

Tip:  If an attribute can have multiple values, such as the Roles or Teams attributes, use the
Contains operator instead of the Equals operator to make sure that the condition adds all the
intended resources to the group. For example, if you create a rule, Roles Equals Salesperson,
 then users who are assigned only the Salesperson role are added to the group. If you create
a rule, Roles Contains Salesperson, then users assigned the Salesperson role and any other
role are also added to the group.

Value
 

Enter a value for the attribute, if relevant. If you're entering more than one value, separate each
value with a comma.
 

Enter as many conditions as needed to suit your specific requirements. For example, if you want to add all
resources who are sales representatives based in the Sales Support organization to your group, create two
conditions with values similar to these and choose the All conditions met value from the Rule Applies If drop-
down list.

This table lists example values for the fields in a rule condition:

Field Condition 1 Condition 2

Object
 

Resources
 

Resources
 

Attribute
 

Job Title
 

Organization
 

Operator
 

Equals
 

Equals
 

Value
 

Sales Representative
 

Sales Support
 

6. From the Actions menu, select Save and Publish to ensure that your changes get included in the assignment
processing.

7. Click Save and Close.
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8. Start the Run Access Group Membership Rules scheduled process to ensure that the access group membership
rules are assigned.

The Run Access Group Membership Rules scheduled process automatically runs every hour to update access
groups with changes to the group membership. But you can also run the process at any time from the Access
Groups main page by selecting the Update Groups and Members option from the Actions menu. For example,
if you edit a rule, it's a good idea to run the process straight away.

When the process completes, navigate to the Edit Access Group: Overview page where you can see that all the
resources who meet the rule conditions are added to the group. Notice that the Member Type field is set to Rule
for all the new members.

You can edit a group membership rule at any time by selecting the rule from the Edit Access Group: Group Membership
Rules page. You can also delete or inactivate the rule. If you delete or inactivate a rule, any users added to the group
through the rule are removed when the Run Access Group Membership Rules scheduled process is next run.

For information about running scheduled processes, see the Understanding Scheduled Processes guide.

Related Topics
• Understanding Scheduled Processes

Why can't my ERP users access Sales and Service data?  
Oracle's ERP roles don't give the same access as Sales and Service roles. Analyze your user's needs and give the
appropriate roles to the Sales or Service user.

See the related topics for more information.

Related Topics
• How do I troubleshoot user access issues?

• Review a User's Access to Object Data

• Types of Sales Users

What roles do suppliers need to get access to the
Procurement Contracts pages?  
Supplier users need specific roles to access the Procurement Contracts pages are:

On the Enterprise Contracts side, the roles are:

• Supplier Contract Administrator

• Supplier Contract Manager

See the Security Reference for Enterprise Contracts guide for more information on these roles.
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On the Procurement Contracts side, the roles are:

• Supplier Administrator

• Supplier Manager

See the Security Reference for Procurement guide for more information on these roles.

What are the supported electronic signature (eSignature)
providers?  
The supported eSignature providers are DocuSign and OneSpan.

How do I enable notifications for Sales?  
You define and generate notifications with a Groovy script in Application Composer, using conditions that must be met
for each notification. When a notification is created on an account that salespeople own, you can specify the notification
recipients.

For example, you can reference sample Groovy scripts to define and activate notifications for salespeople when:

• They're added to the account team.

• They're designated as owner of an account.

• An account they own has been deleted.

• A sales object is assigned to an account.

Note:  Before you enable notifications for Sales, ensure that you have enabled notifications generally. For steps, see
the topic, Disable or Enable Workflow Notifications. If you update the applications, be sure to go back and check these
settings again.

Notifications are lined up in a queue, and you can manually add a record to a queue by changing the owner. Or, you can
add a notification to a queue based on specific criteria. You can use a rule or condition to add leads to a queue based on
specific record criteria, for example. Records remain in a queue until they're assigned an owner.

Here's how you enable notifications.

1. Sign in as a setup user.
2. In the Setup and Maintenance go to:

◦ Offering: Sales

◦ Functional Area: Sales Foundation

3. Click the drop-down button in the Sales Foundation row.
4. Click Change Feature Selection in the menu. The Edit Features: Sales Foundation page appears.
5. Select the Enable check box for the notification-related features you want to set up. This enables notifications

for the Sales objects.
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Note:  This opt-in is for your chosen channel or communication path, such as bell notifications, and not for
specific objects.

6. Click Done.

How do I import contract line data?  
You can use Import Management to create or update Contract Line records.

To import Contract Line records, perform the following tasks:

1. Map your source data to Oracle Applications Cloud object attributes.
2. Create source Comma Separated Values (CSV) file for import.
3. Create the import activity.
4. Review the import results.

How You Map Your Source Data to Object Attributes
To import your Contract Line data into Oracle Applications Cloud, you must populate a .csv file with your source data
and map that source data to target object attributes in Oracle Applications Cloud.

You need to do the following before creating the CSV file for data import:

• Identify how your source data attributes map to the target object attributes in Oracle Applications Cloud.

• Ensure prerequisite setups are done, if applicable.

• Understand your options for uniquely identifying the records.

• Ensure parent records exist before importing child records.

• Identify the target object attributes that are required in the CSV file for a successful import.

Before You Start
You must do some basic checks before starting your import. For example:

• Complete all the prerequisites for importing each attribute in your source data.

• Have all parent records in place before importing child records.

Select a Unique Identifier for Your Records
To import data into Oracle Applications Cloud, your CSV file must include some specific attributes that enable the
import process to uniquely identify the records. The file import process uses the attribute values to automatically map
your source data to the target object attributes in Oracle Applications Cloud.

The preferred options to uniquely identify an object record are as follows:

• Internal ID: If you're identifying a record that already exists in Oracle Applications Cloud, then you can use
the internal ID of the record, a system-generated unique identifier attributes with "ID" in the attribute name
are typically internal IDs. You can determine the internal ID of a record by exporting Oracle Applications
Cloud object data, or by doing a transactional database query. Using an internal ID typically provides better
performance and reduces the import duration. For the Contract Line object, the attributes are Line Id and Id.
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• Public unique identifiers: If you're creating new records, then you can provide a user-friendly public unique
identifier (attributes denoted with 'Number' and usually visible in the business object's UI). If you update a
record for which you have previously provided a Number attribute, or for which a Number attribute is visible
in the object's UI, you can use the Number attribute to identify the record. For the Contract Line object, the
attribute is Line PUID.

Required Attributes and Validations for the Contract Line Object
To import data successfully into Oracle Applications Cloud, your CSV file must include the required attributes. Ensure
that you provide valid values for the attributes. The following table lists the required attributes for importing new
Contract Line records, prerequisite setup tasks for the attributes, and specific validations, if any, for Contract Line
import:

Attribute Description Prerequisite Setup Task/
Import Validations

Creating a Contract Line
Record

Updating an Existing
Contract Line Record

ContractPuid
 

The unique PUID that
identifies the contract
 

No validation
 

Required
 

Not required
 

ItemName
 

The item name for an item
type of line
 

This must be a valid
inventory item.
 

Required for an item type of
line
 

Not required
 

ItemNameTxt
 

The item name for a free
form type of line
 

No validation
 

Required for a free form
type of line
 

Not required
 

ItemQuantity
 

The line quantity.
 

No validation
 

Required for an item type of
line
 

Not required
 

LineAmount
 

The line amount.
 

No validation
 

Required for a free form
type of line
 

Not required
 

LineNumber
 

The number of the contract
line.
 

This must be a unique
number within a contract.
 

Required
 

Not required
 

LinePuid
 

The unique PUID that
identifies the contract line.
 

This must be a unique
PUID across all contract line
records.
 

Required
 

Required
 

LineStatus
 

The line status
 

This must be one of Active,
 Draft, Closed, or Canceled.
 

Required if StsCode isn't
entered
 

Not required
 

LineTypeId
 

The Id that represents the
line type.
 

This must be valid as per
OKC_CONTRACT_TYPE_
LINES.
 

Required if LineTypeName
isn't entered
 

Not required
 

LineTypeName
 

The name of the line type.
 

This must be valid as per
OKC_CONTRACT_TYPE_
LINES.
 

Required if LineTypeId isn't
entered
 

Not required
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Attribute Description Prerequisite Setup Task/
Import Validations

Creating a Contract Line
Record

Updating an Existing
Contract Line Record

StartDate
 

The date from which the
contract line becomes
effective.
 

No validation
 

Required
 

Not required
 

StsCode
 

The code that represents
the line status
 

This must be one of
ACTIVE, DRAFT, CLOSED,
 or CANCELED
 

Required if LineStatus isn't
entered
 

Not required
 

UnitOfMeasure
 

The unit of measure of the
contract line.
 

This must be a valid unit of
measure in INV_UNITS_OF_
MEASURE_TL.UNIT_OF_
MEASURE.
 

Required if the UOMCode
isn't entered
 

Not required
 

UnitPrice
 

The unit price of the line.
 

No validation
 

Required for an item type of
line
 

Not required
 

UOMCode
 

The UOM code of the
contract line.
 

This must be a valid unit of
measure in INV_UNITS_OF_
MEASURE_B.UOM_CODE.
 

Required if the
UnitOfMeasure isn't
entered
 

Not required
 

You can view the Contract Line object and attributes in the Manage Import Objects page of the Import Management
flow. You can find attribute information like type, length, description, and so on, on this page.

Note:  The attribute PriceAsOf can't be updated.

Create the Source CSV File
You include the data that you want to import into Sales and Fusion Service in a source CSV file.

You can use the CSV templates available in the Import Objects UI page to create the source CSV file. To download a CSV
template:

1. Go to Navigator  > Tools >  Import Management >  Import Objects.
2. Select the Contract Line object in the table and click Download.

You can now edit the downloaded file and provide valid values for the required attributes.

Note:  For help in populating the CSV file and to avoid any issues in entering values, see the topic Potential Issues
When Opening CSV Files With Excel in Related Topics section.

Create the Import Activity
After you have the CSV file ready, create an import activity to import the information. To create an import activity:

1. Go to Navigator  > Tools >  Import Management >  Import Queue.
2. Click Create Import Activity in the Manage Imports page.
3. In the Enter Import Options page, provide a name for the import activity, and select Contract Line from the

Object drop-down list.
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4. Select the CSV file in the File Name field, and click Next.
5. The source and target attributes are automatically mapped in the Map Fields page. Review and edit the

mappings if required.
6. Check the file for unmapped columns or data format issues by clicking Validate Data. Click Next.
7. Review the import details on the Review and Submit page, and click Submit when you're ready.

Review the Import Results
Check if your import succeeded on the Manage Imports page. This page shows the status of all active, completed, and
unsuccessful imports. To check the status of the import activity:

1. Go to Navigator  > Tools >  Import Management >  Import Queue.
2. Click All Imports and search for the import activity that you created earlier.
3. Check the Status column for the import activity. The import is successful if the status displays as Completed.

You can drill down on the import activity to go to the Import Status page which provides the status details of
the import activity.

Related Topics
• How do I import data?

• Potential Issues When Opening CSV Files in Excel

How do I import contract data?  
You can use Import Management to create or update Contract data.

To import Contract records, perform the following tasks:

1. Map your source data to Oracle Applications Cloud object attributes.
2. Create source Comma Separated Values (CSV) file for import.
3. Create the import activity.
4. Review the import results.

How You Map Your Source Data to Object Attributes
To import your Contract data into Oracle Applications Cloud, you must populate a .csv file with your source data and
map that source data to target object attributes in Oracle Applications Cloud.

You need to do the following before creating the CSV file for data import:

• Identify how your source data attributes map to the target object attributes in Oracle Applications Cloud.

• Ensure prerequisite setups are done, if applicable.

• Understand your options for uniquely identifying the records.

• Ensure parent records exist before importing child records.

• Identify the target object attributes that are required in the CSV file for a successful import.
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Before You Start
You must do some basic checks before starting your import. For example:

• Complete all the prerequisites for importing each attribute in your source data.

• Have all parent records in place before importing child records.

Select a Unique Identifier for Your Records
All records must be unique in the application.

Public unique identifiers: If you're creating records, then you can provide an easily understandable public unique
identifier. These are, usually, denoted with 'Number' and visible in the business object's UI. PUID attributes are usually
named <object> Number. If you're updating a record with a Number attribute, then use the Number attribute to identify
the record. For more information about public unique identifiers, see the topic "How You Use Alternate Keys to Import
Records" in Related Topics section.

Note:  You can't update or customize a PUID. You can provide a unique value. If left blank, the system will generate a
unique identifier.

Required Attributes and Validations for the Contract Object
To import data successfully into Oracle Applications Cloud, your CSV file must include the required attributes. Ensure
that you provide valid values for the attributes. The following table lists the required attributes for importing new
Contract records, prerequisite setup tasks for the attributes, and specific validations, if any, for Contract import:

Attribute Description Prerequisite Setup Task/
Import Validations

Creating a Contract
Record

Updating an Existing
Contract Record

ContractNumber
 

The alternate unique
identifier of the Contract.
 

No validation
 

Required
 

Not required
 

ContractPuid
 

The unique PUID that
identifies the Contract.
 

This number identifier must
be unique across Contracts
of all types.
 

Required
 

Required
 

ContractTypeId
 

The unique ID of the
Contract type. The Contract
type sets various properties
for the Contract such as the
type of permitted Contract
lines, party roles, Contract
validation checks, and the
Contract acceptance and
signature requirements.
 

You can determine and
manage Contract types.
 
Navigate to the following in
Setup and Maintenance:
 

• Offering: Sales

• Functional Area: Sales

• Task: Manage
Contract Types

Required if
ContractTypeName isn't
entered.
 

Not required
 

ContractTypeName
 

The name of the Contract
type. The Contract type
sets various properties for
the Contract such as the
type of permitted Contract
lines, party roles, Contract

You can determine and
manage Contract types.
 
Navigate to the following in
Setup and Maintenance:
 

Required if ContractTypeId
isn't entered.
 

Not required
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Attribute Description Prerequisite Setup Task/
Import Validations

Creating a Contract
Record

Updating an Existing
Contract Record

validation checks, and the
Contract acceptance and
signature requirements.
 

• Offering: Sales

• Functional Area: Sales

• Task: Manage
Contract Types

Currency
 

The name of the currency
in which Contract amounts
are entered.
 

This must be a valid
currency.
 

Required if CurrencyCode
isn't entered
 

Not required
 

CurrencyCode
 

The code of the currency
in which Contract amounts
are entered.
 

This must be a valid
currency.
 

Required if Currency isn't
entered
 

Not required
 

InvOrganizationId
 

The unique Id representing
the item master
organization
 

This must be a valid
ORGANIZATION_ID
from the HR_ALL_
ORGANIZATION_UNITS_F
table.
 

Required if the InvOrgName
isn't entered
 

Not required
 

InvOrgName
 

The name representing the
item master organization.
 

This must be a valid
ORGANIZATION_ID
from the HR_ALL_
ORGANIZATION_UNITS_F
table.
 

Required if the
InvOrganizationId isn't
entered
 

Not required
 

LegalEntityId
 

The unique Id of the legal
entity to which the Contract
belongs.
 

This must be a valid record
as per GL_LEDGER_LE_V.
 

Required if the
LegalEntityName isn't
entered.
 

Not required
 

LegalEntityName
 

The name of the legal
entity to which the Contract
belongs.
 

This must be a valid record
as per GL_LEDGER_LE_V.
 

Required if the
LegalEntityId isn't entered.
 

Not required
 

OrgId
 

The unique Id of the
business unit to which the
Contract belongs.
 

This must be a valid
business unit Id.
 

Required if the OrgName
isn't entered
 

Not required
 

OrgName
 

The name of the business
unit to which the Contract
belongs.
 

This must be a valid
business unit name.
 

Required if the OrgId isn't
entered
 

Not required
 

StartDate
 

The date on which the
Contract comes into effect.
 

No validation
 

Required
 

Not required
 

StsCode
 

The code of the Contract
status. Examples are
ACTIVE, DRAFT, CLOSED,
 and CANCELED.
 

Navigate to the following in
Setup and Maintenance:
 

• Offering: Sales

• Functional Area: Sales

Required
 

Not required
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Attribute Description Prerequisite Setup Task/
Import Validations

Creating a Contract
Record

Updating an Existing
Contract Record

• Task: Manage
Standard Lookups

Search for the Contract
Statuses lookup.
 
Activating a draft contract,
and one-time import of
closed, canceled, and active
contracts is supported. You
can't update the contract
status from active to any
other status. Also, you can't
update a contract once it is
active.
 
You can't import contracts
in EXPIRED status directly
in the system. You must
import the contracts with
ACTIVE status and then
update contract status to
EXPIRED.
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Note:  Keep a note of the following:

• The attribute GeneratedInvoiceStatus must have one of the following values:

◦ D for Draft

◦ S for Submitted for approval

◦ R for Released

◦ Ensure to provide one of the values D, S, or R while importing Project contracts.

• SupplierId is the party identifier of the supplier and SupplierSiteId is the party site identifier of the vendor.

• When you import contracts using the contract type column with the contract numbering method set as
Automatic, you can leave the ContractNumber column blank in the CSV file for the application to generate the
contract numbers automatically. You can also enter the contract number manually when you don't want the
application to assign the contract numbering automatically.

• When the contract type has the contract numbering method set as Manual, you can't leave the contract
number blank. If the contract number is left blank, then the application generates an error.

• To activate a contract while importing, provide the value 'ACTIVE' for the StsCode attribute. This will also
activate the lines added to the contract.

• To import contracts that are closed, canceled, or on hold, you must first import the contract with all required
import files, and then re-import the contract import file with the following information:

◦ Closed contracts: You must include Status (the status will be Closed), Close reason code,
CloseReasonSetCode, Termination Date.

◦ On-Hold Contracts: You must include Status (the status will be Hold), Hold Reason Code, Hold reason
Set Code, Hold Until Date.

◦ Canceled contracts: You must include Status (the status will be Canceled), Cancel Reason, Cancel
reason set code, Cancel date.

◦ To avoid the modification of the contribution percentage you must include the contribution percentage
in the same import file that you're using to activate the contract.

• To import data in other languages, use the column attributes "Language and Source Language" in Contract
header file and set the preferred language. Then import the parties with the desired values.You can view the Contract object and attributes in the Manage Import Objects page of the Import Management flow.

You can find attribute information like type, length, description, and so on, on this page.

Create the Source CSV File
You include the data that you want to import into Sales and Fusion Service in a source CSV file.

You can use the CSV templates available in the Import Objects UI page to create the source CSV file. To download a CSV
template:

1. Go to Navigator  > Tools >  Import Management >  Import Objects.
2. Select the Contract  object in the table and click Download.

You can now edit the downloaded file and provide valid values for the required attributes.
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Note:  For help in populating the CSV file and to avoid any issues in entering values, see the topic Potential Issues
When Opening CSV Files With Excel in Related Topics section.

Create the Import Activity
After you have the CSV file ready, create an import activity to import the information. To create an import activity:

1. Go to Navigator  > Tools >  Import Management >  Import Queue.
2. Click Create Import Activity in the Manage Imports page.
3. In the Enter Import Options page, provide a name for the import activity, and select Contract from the Object

drop-down list.
4. Select the CSV file in the File Name field, and click Next.
5. The source and target attributes are automatically mapped in the Map Fields page. Review and edit the

mappings if required.
6. Check the file for unmapped columns or data format issues by clicking Validate Data. Click Next.
7. Review the import details on the Review and Submit page, and click Submit when you're ready.

Review the Import Results
Check if your import succeeded on the Manage Imports page. This page shows the status of all active, completed, and
unsuccessful imports. To check the status of the import activity:

1. Go to Navigator  > Tools >  Import Management >  Import Queue.
2. Click All Imports and search for the import activity that you created earlier.
3. Check the Status column for the import activity. The import is successful if the status displays as Completed.

You can drill down on the import activity to go to the Import Status page which provides the status details of
the import activity.

Related Topics
• How do I import data?

• Potential Issues When Opening CSV Files in Excel

How do I import incentive transaction data?  
You can use the import functionality to create or update Incentive Transaction records.

To import Incentive Transaction records, perform the following tasks:

1. Map your source data to Oracle Applications Cloud object attributes.
2. Create source Comma Separated Values (.csv) file for import.
3. Create the import activity.
4. Review the import results.

How You Map Your Source Data to Target Object Attributes
To import your Incentive Transaction data into Oracle Applications Cloud, you need to populate a CSV file with your
source data and map that source data to target object attributes in Oracle Applications Cloud.
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You need to do the following before creating the .CSV file for data import:

• Identify how your source data attributes map to the target object attributes in Oracle Applications Cloud.

• Ensure prerequisite steps are complete, such as understanding what attributes are required for importing your
objects.

• Understand your options for uniquely identifying the records.

• Ensure parent records exist before importing child records.

• Identify the target object attributes that are required in the .CSV file for a successful import.

Before You Start
You must do some basic checks before starting your import. For example, make sure that:

• You have completed all the prerequisites for importing each attribute in your source data.

• You have all parent records in place before importing child records.

Select a Unique Identifier for Your Records
To import data into Oracle Applications Cloud, your CSV file must include some specific attributes that enable the
import process to uniquely identify the records. The file import process uses the attribute values to automatically map
your source data to the target object attributes in Oracle Applications Cloud.

The preferred option to uniquely identifying an object record is through the Internal ID. If you're identifying a record that
already exists in Oracle Applications Cloud, then you can use the internal ID of the record, a system-generated unique
identifier Attributes with "id" in the attribute name are typically internal IDs. Use this option only if you're updating
Incentive Transactions. You can determine the internal ID of a record by exporting Oracle Applications Cloud object
data, or by doing a transactional database query. Using an internal ID typically provides better performance and reduces
the import duration. For the Incentive Transaction object, the attributes are Transaction Number and Transaction Type.

Required Attributes and Validations for Incentive Transaction Object
To import data successfully into Oracle Applications Cloud, your .CSV file must include the required attributes. Ensure
that you provide valid values for the attributes.

The following table lists the required attributes for importing new Incentive Transaction records, required attributes for
updating Incentive Transaction records, prerequisite setup tasks for the attributes, and specific validations, if any, for
Incentive Transaction import:

Attribute Description Data Type Data Length Prerequisite
Setup Task/
Import
Validations

Creating a
Incentive
Transaction
Record

Updating an
Existing Incentive
Transaction
Record

Business Unit
 

Name of the
business unit
 

Varchar2
 

240
 

To find the
business unit:
 

1. Navigate to
Setup and
Maintenance.

2. Navigate to
the Manage

Required
 
A value is required
either for the
Business Unit or
the Business Unit
Id.
 

Required
 
A value is required
either for the
Business Unit or
the Business Unit
Id.
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Attribute Description Data Type Data Length Prerequisite
Setup Task/
Import
Validations

Creating a
Incentive
Transaction
Record

Updating an
Existing Incentive
Transaction
Record

Business
Units task.

3. In the Search
results region,
 search for
the name and
select the
name that's
displayed.

Note:
You can export
the results to
a spreadsheet
and use this
information to
identify and
assign the
Business Unit
values to the
data that you're
preparing.
 

Business Unit ID
 

Unique numeric
identifier for
the Oracle
Fusion Incentive
Compensation
business unit.
 

Number
 

18
 

To find the
business unit:
 

1. Navigate to
Setup and
Maintenance.

2. Navigate to
the Manage
Business
Units task.

3. In the Search
results region,
 click the
View menu
and add the
Business Unit
ID Column.

Note:
You can export
the results to
a spreadsheet
and use this
information to
identify and
assign the
Business Unit
ID values to the
data that you're
preparing.
 

Required
 
A value is required
either for the
Business Unit or
the Business Unit
Id.
 

Required
 
A value is required
either for the
Business Unit or
the Business Unit
Id.
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Attribute Description Data Type Data Length Prerequisite
Setup Task/
Import
Validations

Creating a
Incentive
Transaction
Record

Updating an
Existing Incentive
Transaction
Record

Event Date
 

When the
transaction
triggers an
incentive event
associated with the
row, for example,
 salespeople are
compensated
when an invoice is
booked or an order
is posted.
 

Date
 

 The period must
be open before
you can collect the
transaction into
the application.
 

Required
 

Required
 

Transaction
Amount
 

The transaction
amount to be
evaluated by the
credit and earning
processes.
 

Number
 

 If providing a
monetary amount,
the amount should
be in the currency
of the source
application.
 

Required
 

Required
 

Transaction
Number
 

Unique transaction
identifier used
in the source
application. The
combination of
Source Transaction
Number and
Transaction
Type values
must be unique,
 and is validated
during the Collect
Transactions
process.
 

Varchar2
 

30
 

Map an identifier
that end users
recognize and
can search. For
example, map
your source
invoice number
and invoice line
number to this
field.
 

Required
 

Required
 

Transaction Type
 

Defines the type
of the transaction.
Predefined
transaction types
are CLAWBACK,
 CUSTOMER_
SATISFACTION,
 GRP, INVOICE,
 ITD, MANUAL,
ORDER, PAYMENT,
 and RAM_
ADJUSTMENT.
 

Varchar2
 

30
 

The value must
be a valid lookup
code for lookup
type CN_TP_
TRANSACTION_
TYPE. To define
your own
transaction types:
 

1. In Setup and
Maintenance,
 go to the
Manage
Incentive
Compensation
Lookups task.

2. Search for
CN_TP_
TRANSACTION_
TYPE.

Required
 

Required
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Attribute Description Data Type Data Length Prerequisite
Setup Task/
Import
Validations

Creating a
Incentive
Transaction
Record

Updating an
Existing Incentive
Transaction
Record

3. Add your
transaction
types.

You can view the Incentive Transaction object along with all its child objects and attributes in the Manage Import
Objects page of the Import Management flow. You can find attribute information like type, length, description, and so
on, on this page.

Note:  Don't use the Transaction Sub-Type attribute. It's intended for internal use only.

Create the Source CSV File
You include the data that you want to import into Sales and Fusion Service in a source CSV file.

You can use the templates available in the Import Objects UI page to create the source CSV file. To download a template:

1. Go to Navigator  > Tools >  Import Management >  Import Objects.
2. Select the Incentive Transaction object in the table and click Download.

You can now edit the downloaded file and provide valid values for the required attributes.

Note:  For help in populating the CSV file and to avoid any issues in entering values, see the topic Potential Issues
When Opening CSV Files With Excel in Related Topics section.

Create the Import Activity
After you have the CSV file ready, create an import activity to import the information. To create an import activity:

1. Go to Navigator  > Tools >  Import Management >  Import Queue.
2. Click Create Import Activity in the Manage Imports page.
3. In the Enter Import Options page, provide a name for the import activity, and select Incentive Transaction

from the Object drop-down list.
4. Select the CSV file in the File Name field, and click Next.
5. You would see that the source and target attributes are automatically mapped in the Map Fields page. Review

and edit the mappings if required.
6. Check the file for unmapped columns or data format issues by clicking Validate Data. Click Next.
7. Review the import details on the Review and Submit page, and click Submit when you're ready.

Review the Import Results
You can review the import results by checking for the import activity in the Manage Import Activity page. A file import
activity is said to be successful when its status displays as Completed. To check the status of the import activity, do as
follows:

1. In the Navigator, under Tools, click Import Management.
2. On the Manage Imports page, search for the import activity that you created using one of the search criteria,

such as status, name, object, and so on.
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3. Check the Status column for the import activity. The import is successful if the status displays as Completed.
The other valid values for the import activity status are Queued for import, Preparing data for import,
Importing data, Completed with errors, and Unsuccessful.

Note:  On this page you can also quickly view the number and status of all active imports, completed imports, and
unsuccessful imports that have been submitted.

Related Topics
• How do I import data?

• Potential Issues When Opening CSV Files in Excel

How do I monitor import activities?  
You can monitor imports that were scheduled to run, have completed successfully, or have failed with errors. For each
import, you can view the details and make the necessary updates for any failed records that you want to import again.

You can view the list of imports from the Manage Imports page of the Import Queue tab. To view the status of an
import job click the link in the import's Name column. The Import Status page shows the status of the most recently
executed instance of the import. The Import Status page contains the following sections:

• Status Bar

• Details

• Import Attachments

Status Bar
The status bar shows the progress of the import in a graphical format. It shows the following stages during the import
process:

• Import activity queued: The import request is queued for processing, and is waiting to begin execution.

• Preparing data for import: The data from the source file are being loaded in the temporary staging table for
further processing.

• Importing data: The data from the source file are being validated and loaded in the target tables.

• Completing import activity: The import data have been loaded in the target tables, and cleanup tasks, such as
the generation of log files, are in progress.

• Completed with errors: The import has completed with errors.

• Successful: The import has completed successfully.

• Completed with warnings: The import has completed with warnings.

• Canceled: The import was canceled by the user.

• Unsuccessful: The import was unsuccessful.

Hovering your mouse over the progress bar shows the status on the number of records imported.
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Note:  If the job is in the same status for a long time, then generate a diagnostic log as described in the topic Generate
the Diagnostics Log for Import in Related Topics section. When you raise a service request, attach the diagnostic log
files to help technical support to resolve the issue.

Activity and Record Details
The Activity Details section shows the name of the import, import activity identifier, object name, and the name of the
user who submitted the import. The section on date and time displays the start and end times, estimated completion
time, and the time taken to complete the import.

The Record Details section displays the number of import records in each stage of processing. The various status
details are summarized in the following table:

File Processing Summary Information Description

Records Read From File
 

The number of records read from the source file. Clicking the link for the number of records lets you
download the spreadsheet file with the records.
 

Records Loaded Successfully
 

The number of import object records that were imported to the application destination tables.
 

Records With Errors Reported
 

The number of records that failed with errors when importing data from the interface tables to the
destination tables. You can view the error details in the Exception and Error files attached to the
process. Clicking the link for the number of records lets you download the spreadsheet file with the
error records.
 

Records With Warnings
 

The number of records that were uploaded with warnings when importing data from the interface
tables to the destination application tables. Clicking the link for the number of records lets you
download the spreadsheet file with the warning records.
 

Unprocessed
 

The number of records that weren't processed.
 

Clicking on the Advanced Options section shows the advanced configuration options that you had selected when
creating the import activity.

The rejected file records don't contain the error message when import job ends in unsuccessful status.

Note:  In the files that are generated after the completion of an import activity, all error message values are enclosed
within double quotation marks. The use of double quotation marks improves the format of the log files by ensuring
that the error messages containing commas aren't treated as multiple values.

Detailed Import Status
The Detailed Import Status page shows the status of the different steps in the import activity. You can navigate to this
page by selecting View Detailed Import Status from the Actions menu on the Status page. For each step, this page
shows the individual sub tasks of the import process. This information helps the technical support team to fix any issues
during the import.
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Purge Import Data
Import Management periodically runs an automatic process that purges all data associated with import jobs. This
process purges data older than 7 days by default. You can extend this time to 30 days by setting the value in the profile
option ZCA_IMPORT_PURGING_DURATION.

If you wish for the data to be purged instantaneously on job completion, you can do the same using the
ZCA_IMPORT_PURGE_ON_JOBCOMPLETION profile option. The default value for this profile option is Y and impacts
data for all objects except the ones registered as 'ObjectPostProcess'

Alternately, if you want to control purging through the UI from the Import Object Details Page, you can set the
ZCA_IMPORT_PURGE_FROM_UI profile option to Y to display the purge option on the Import Object Details page.

Import Attachments
The Import Attachments  section lists the files associated with this import in a table. The Actions column
lets you either download the file or view more details. Success log file isn't generated after the import job is
completed successfully. To generate success logs for even successfully completed jobs, set the profile option
ZCA_IMPORT_SUPPRESS_SUCCESSLOG_GENERATION to 'No'. You can download the following files from this section:

• Process Log: Click Action  > Generate Log.

• Diagnostics Log file: Click Action  > Generate Diagnostics.

• Map file: Click the Download link to download the import activity map file in CSV format.

• Source CSV file used for the import.

• Exception files that include a row for each record that failed. All the errors for that row are concatenated and
displayed in the Error Message column of the file.

• Error file that includes all the errors for each record that failed validation.

Related Topics
• How do I import data?

• How do I generate the diagnostics log for import?

What are the best practices for high volume data import?
 
Here are some best practices for high volume data import.

At some time, you might need to load large volumes of data into your CX Sales and B2B Service instance. For example,
during initial roll-out, expanding use of CX Sales and B2B Service to other users or divisions, or expanding use of CX
Sales and Fusion Service to include other object types (for example, adding support for Service objects).

When loading large volumes of data to CX Sales and Fusion Service, one of the key considerations is the time taken
to import data. Reducing the amount of time required to import a large volume of data is crucial, if you have a limited
period of time to run the data imports (for example, during a weekend migration). Oracle recommends certain best
practices that you can use to improve the performance of the data import.
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Actual throughput varies for users based on a number of factors including the volume of data contained in each record,
the number of relationships being created during data import, and the number of records in your source file.

Before executing the data import in a production environment, Oracle recommends that you perform these functional
validation and performance optimization procedures in your test environment:

• Data Cleansing

• Validate Functional Import

• Optimization Process

Performing these exercises in your test environment ensures that these exercises don't impact existing operations or
the data in your production environment.

Data Cleansing
Before proceeding with high volume imports, you need to clean the data being imported thoroughly. Ensuring that your
data is in the correct format reduces the number of errors that are encountered during data import. This benefits your
overall throughput in two ways:

• Processing time isn't wasted on attempting to import records that can't be imported.

• You don't have to review error logs, fix issues, and reimport data. It costs less to clean your data before
attempting a data import than it does to fix issues that arise during data import.

When cleaning the data, note the following:

• Field Length - ensure that the data doesn't exceed the maximum field length in OSC

• Data Type - ensure that the data is of the correct type for the field to which it's being imported in OSC

• Required - ensure that a value is provided for all mandatory fields

• Conditionally Required - in some cases, a value is required based on the value provided for another field (for
example, for Opportunity a Close Date is required if the Status of the Opportunity is set to Closed)

• Foreign Keys - provide a valid value for foreign keys to create relationships between records. The foreign keys
can vary for every object.

By ensuring that your data is clean, you can avoid many issues associated with importing your data from your legacy
application into CX Sales and Fusion Service.

Validate Functional Import
To verify that you have successfully cleaned your data, Oracle recommends that you validate your import in your test
environment with a small set of data. Follow these guidelines to validate the functional import:

• Before you import large volumes of data, ensure that your import completes successfully and that the resulting
data matches your expectations. This includes ensuring that the data is imported to the correct object, fields
have been mapped correctly, and relationships are imported properly.

• Import a small number of records including values for each attribute. Oracle recommends that you use the
smallest set of input data possible that can still save the variations present in your full data set.

• Identify any data issues that are reported in the import log files. Fix any specific issues reported for rows with
errors. If a row doesn't have an error reported, then don't reimport that row. After you resolve all the issues
and successfully import your subset of data, apply any changes to your larger data set (for example, if you
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determine that your time stamp format is incorrect, fix this for all records in the input data file for your full data
set).

Optimization Process
Importing high volume of data is a project and should be included in the project plan for your implementation. You need
to allocate time for the actual import of data and for the design and optimization of the import process for your data
set.

When optimizing the data import, you identify the number of records to be included in your input data file as well as
the number of concurrent import activities that can be activated. You trigger concurrent import activities by running
more than multiple data import operations simultaneously. The number of concurrent import activities is the number of
data imports that are running and haven't yet completed. Running import activities serially or running too many import
activities concurrently can lower your throughput. Finding the right values for these two parameters is a key aspect
of designing your import process. There's no right answer for every situation. Every data set is different; you need to
repeat this process for any new data import operations that you plan to perform.

Note:  Don't import more than 100,000 records in a single import operation or perform more than five concurrent
import activities.

Oracle recommends that you adhere to this process when planning high volume data import:

• Establish baseline performance

• Scale up import volume

• Optimizing Concurrent Import Activities

Each of these steps is explained in greater detail.

Establish Baseline Performance
Oracle recommends that after you have cleaned your data and validated that your import is functionally correct, you
should begin the process of scaling up your import volumes. The first step in this process is to establish a performance
baseline. This involves performing a set of serial imports using a high volume of records.

Oracle recommends that you begin by importing a small number of records (a few hundred to a few thousand) in a
single import activity. For example, you may import 10,000 records using four import activities of 2,500 records each.
After these data import activities have completed, you should note the time required to complete the import of records
and calculate the overall throughput (number of records imported per second).

Note:  You may also want to track the time between data import operations.

Scale Up Import Volume
After you have established a baseline, you can increase the number of records in your input file and begin to run
multiple imports concurrently. Scale the volumes in a controlled manner and note your throughput at every step.
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Optimize Concurrent Import Activities
You can run multiple import activities simultaneously. This can improve your overall throughput versus serially running
the same imports. The optimal number of concurrent import activities can vary across objects and use cases; you must
perform testing prior to beginning your production data load to identify the most efficient data import plan.

You can run multiple data import activities concurrently by submitting a new import activity while the first activity is
still being processed. CX Sales and Fusion Service processes both import activities without waiting for the first activity
to complete before starting the second activity. You can continue to run multiple data import activities concurrently for
additional data import activities.

For example, you first run a test to measure the throughput when importing 200,000 records using four serial activities
of 50,000 records each. You may then run a test to import a total of 600,000 records as shown in this table:

Test Number Total Number of
Records

Number of Records
per Activity

Number of Activities Concurrency Average Throughput

1
 

200,000
 

50,000
 

4
 

Serial
 

2.1
 

100,000
 

50,000
 

2
 

Concurrent
 

2.2
 

200,000
 

50,000
 

4
 

Concurrent
 

2.3
 

300,000
 

50,000
 

6
 

Concurrent
 

At every step, you should note the average throughput. If you reach a point where throughput is decreasing, then you
may have exceeded your optimal concurrency. You may want to repeat the tests to ensure that you have sufficient data
points to draw a correct conclusion.

You can import file attachments to some record types. Importing attachments impacts import performance and should
be considered when planning your data import activities.

You can also adjust the data import based on the number of records in your input data file. For example, start with
25,000 records and increase by 25,000 records with every run. As you increase the number of records in each batch,
note the average throughput. If you reach a point where throughput is decreasing, then you may have exceeded your
optimal number of records. Oracle doesn't recommend importing more than 100,000 records in a single import activity
and exceeding five concurrent import activities.

Pod Size
Significant changes to your usage patterns such as adding many new users or the execution of high volume data
imports may change your pod sizing assessment. Ensure that your environment is properly sized to handle the import
data volumes generated by your organization along with other operations that are performed by your users. Before
starting a high volume import process or one time data load, you may want to have Oracle review your sizing. Contact
Oracle help desk to start this review process.
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How do I create a standalone resource?  
You can import resource data from an external data source into Sales and Fusion Service using Import Management.
You must create or import resources before you can associate them with resource organizations.

Before You Begin
The scenario in this example assumes that the following prerequisites have already been set up.

1. Employees must exist in the application.
2. User accounts and email IDs are set up for the already existing employees.
3. Appropriate business units are set up using the Manage Business Unit task.

To find the business unit, navigate to the following in the Setup and Maintenance work area:

◦ Offering: Sales

◦ Function Area: Data Import and Export

◦ Task: Manage Business Units

4. Appropriate legal entities are set up using the Manage Legal Entities task.

To find the legal entity, navigate to the following in the Setup and Maintenance work area:

◦ Offering: Sales

◦ Function Area: Data Import and Export

◦ Task: Manage Legal Entities

Scenario
In this scenario, Lina John is created as a SALES_REPRESENTATIVE. You must create a source file (CSV) with the
attributes and import it using import management as shown in this table.

Attribute Name Value

FirstName
 

Lina
 

LastName
 

John
 

UserName
 

LINA.JOHN@VISION.COM
 

ResourceEmail
 

lina.john@vision.com
 

BusinessUnit
 

Vision Corporation Enterprise
 

LegalEntity Vision Corporation
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Attribute Name Value

  

IndividualRoleCode
 

SALES_REPRESENTATIVE
 

Note:  To create a Sales Manager, specify SALES_MANAGER for the Individual Role Code attribute.

You can import the source data file.

1. Go to Navigator  > Tools >  Import Management >  Import Queue.
2. Click Create Import Activity in the Manage Imports page.
3. In the Enter Import Options page, provide a name for the import activity, and select Resource from the Object

drop-down list.
4. Select the CSV file in the File Name field, and click Next.
5. The source and target attributes are automatically mapped in the Map Fields page. Review and edit the

mappings if required.
6. Check the file for unmapped columns or data format issues by clicking Validate Data. Click Next.

Note:  Validation errors, if any, are displayed on the Mapping Validation screen. If you get warnings about
unmapped columns, then you can ignore these columns and proceed to submit the import job. Validations
are for informational purposes and applicable only for low-volume imports.

7. Review the import details on the Review and Submit page, and click Submit when you're ready.
8. Navigate to Resource Directory and search for Lina in the Search section.

Related Topics
• How do I import resource data?

• How do I import data?

• Schedule the Send Pending LDAP Requests Process

How can I hide the contact address from the leads pages
in classic UI?  
Use Page Composer to hide the contact address in the Create Lead and Edit Lead pages in the classic UI. Here's how.
You can't hide the address using Application Composer.

1. Create and enter a sandbox with Page Composer as the tool.
2. Open the page you want to configure: Create Lead or Edit Lead.
3. If you're editing the Create Lead pages, you must enter a lead name.
4. Open Page Composer from the sandbox Tools menu.
5. In the Page Composer menu bar, click the Select tab.
6. Click in the whole page component (the blue border around the whole page).
7. Click Edit Component.
8. In the Component Properties window, click Children.
9. Uncheck the Contact Address element.
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How do I enable address verification and to avoid data
conflicts between the Oracle Address, Email, and Phone
Verification and master reference geography data?  
You're a sales customer who doesn't use geographies for territory assignment or tax calculation and has purchased
Oracle Account and Contact Enrichment by Dun and Bradstreet for data enrichment and the Oracle Address, Email, and
Phone Verification for address verification.

To enable address verification and to avoid data conflicts between the Oracle Address, Email, and Phone Verification
and master reference geography data you must do the following setups:

• Deselect the Enable List of Values option in the Geography Mapping and Validation region to avoid Oracle
Address, Email, and Phone Verification data conflicts with master reference geography data. By deselecting this
option you can avoid any UI level validation against master geographies while adding address.

• Select Geography Validation Level for Country as No validation to verify address data by Oracle Address, Email,
and Phone Verification.

Perform the following steps on the Manage Geography Validation page to enable address verification and to avoid data
conflicts between the Oracle Address, Email, and Phone Verification and master reference geography data:

1. In the Setup and Maintenance work area, go to the following:

◦ Offering: Customer Data Management

◦ Functional Area: Enterprise Profile

◦ Task: Manage Geographies

2. On the Manage Geographies page, search for the country by the name or country code, for example US.
3. Click the Go to Task button in the Validation Defined column. The Manage Geography Validation page appears.
4. Deselect the Enable List of Values check boxes for all the geography attributes to avoid any UI level validation

against master geographies while entering the addresses. If the Enable List of Values check boxes are selected
then, in case of data conflicts, Geography Naming References records aren't created.

Note:  If any of the Geography Types listed isn't applicable to the selected country's territory structure, then you must
deselect the geography validation for that type.

If you're planning to create territories based on a particular Geography Type, such as County, then you must deselect all
the Geography Validation levels under that Geography Type (in this case City and Postal Code) based on which you want
to create the territory.

Tip:  Review the Address Style Formats that are selected on the Manage Geography Validation page. The review is
required because on the Account or Contact Simplified UI page, address attributes are displayed based on the address
formats and verified or enriched addresses are saved in Oracle Applications Cloud based on the selected address
formats.
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How do I configure the default Activity search?  
You can configure the default set of records shown in Activity search by changing a lookup type. The lookup type order
determines the order of the values in the Activity search Show filter.

The application uses the default search on the Activities landing page when it displays the initial list of activities to a
user.
Users can go to the Activities tab from other application areas such as accounts, opportunities, and leads.

The available values for Activity default search are:

• Open Activities

• Completed Activities

• All Activities

Steps to Change the Default Activity Search
Here's how to change the default Activity search:

1. Navigate to the Setup and Maintenance work area.
2. Click the Tasks menu and click Search.
3. Search for the Manage Standard Lookups task and open it.
4. Search for the ORA_ZMM_ACTIVITY_FILTER_TYPE lookup type.
5. Use the Display Sequence column to specify the order of the default values according to the order in which you

want them to appear in the Show filter.
6. Click Save and Close.

Note:  You can't add, delete, or change the end date of values provided in the list.

Can I disable Global Search for specific roles, such as
partner roles?  
Search results depend on the data access granted to each user by their role and other factors, so partner roles don't
see any results they aren't permitted to see. If you want to remove the Global Search box at the top of the page
altogether, however, you can't remove it by role. You can either remove Global Search for everyone, or for specific
users. To remove the Global Search box for specific users or for everyone, set the profile option Global Search Enabled
(FUSION_APPS_SEARCH_ENABLED) using the Manage Administrator Profile Values task in Setup and Maintenance.
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How do I reactivate a deleted resource?  
You may want to reactivate a resource or activate a deleted resource by changing the end date.

Typically, a resource is end-dated when they have ended their primary work relationship with their employer or when
they moved to another organization. To end date a resource, set a past date to "To Date" of that resource in the
Resource Directory.

For example, a resource works in a company for 4 years in sales and for next 2 years they are moved to a sales role.
You may want to track this resource as a separate resource. While auditing the reporting hierarchy or resources, we will
clearly know that this resource is a non-sales resource for 2 years. You can end date the resource when they move to a
non-sales organization. During the period when a resource is not a sales resource, they can't work on CX transactions.
When the resource moves back to sales, you can reactivate the resource by removing the end date. Note that if we
simply remove the end date on an existing end-dated resource, we cannot explain why this resource assigned any
transactions during the 2 year period. Remove the To Date from the resource which will make it currently effective or
reactivate it.

1. Navigate to Resource Directory.
2. Click View Resources in the Tasks region.
3. Search for a resource name using the Resource Name and Effective As-of Date field. The effective date is a date

between the start date and end date of the resource.
4. Select the resource and click Edit.
5. Remove the To Date.
6. Click Save and Close.

You can now add the resource to a resource organization and also resource role, if needed.

What do I do when I get an error when running the
Refresh Territories from Resources process?  
If you receive the error "FND_CMN_SYS_ERR: An error occurred. Contact your help desk." when you run the Refresh
Territories from Resources process, check that you've enabled a sales territory dimension. You must enable at least
one territory dimension, even if you're not using any dimensions for assignment. Both the process and this one-time
required setup apply to resource-centric territories, where each opportunity owner also owns their own territory. These
are sales territories that you set up by enabling the Forecast by Opportunity Owner option in Setup Assistant or by using
the Quick setup in the Forecasting functional area in Setup and Maintenance.

Here's how to enable a dimension. This is a one-time setup.

1. Open the task Enable Dimensions and Metrics from the Setup and Maintenance work area:

◦ Offering: Sales

◦ Functional Area: Territories

◦ Task: Enable Dimensions and Metrics

2. On the Enable Dimensions and Metrics page, click Edit.
3. In the Dimensions region, click Select and Add.
4. Select Account Type and click OK.
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5. From the Actions menu at the page level, select Load and Activate.

Your selection runs a process that loads the required data.
You can select Refresh Status from the Actions menu at the page level to monitor the process progress. When the
process completes successfully, you're done.

How can I track multiple emails for a contact?  
While the contact overview displays only the primary email address, you can store and view multiple email addresses for
each contact. For example, your contact may use both their work and private email addresses to communicate with you.
You can save both and designate one of them as the primary. Here's how.

Multiple Email Addresses in the Redwood UI

• To view all of the email addresses for a contact, enter Show in the Action Bar and select Show Email
Addresses.

• To add an address:

a. Enter Add in the Action Bar and select Add Email Address
b. In Contact Preference, indicate if the contact has agreed to be contacted or not using this email address.

If you haven't determined their preference, then select None.
c. Select the email purpose (type), such as Home or Work.
d. You can enter a reason why the individual doesn't want to be contacted.
e. Specify if the new email is the primary email address. A primary address is the address that shows up in

contact and account overviews and is automatically entered in outgoing emails.

Multiple Email Addresses in the Classic UI
If you're using the classic UI, here's how you can view and manage multiple email addresses:

1. Display the contact.
2. Click the Profile tab.
3. Next to All Emails, click Edit (the pencil icon).

Note:  If the All Emails field isn't available, your administrator can add the field to the page layout using
Application Composer.

4. In the Manage All Emails window, enter the email address, and specify the type.

Note:  If your organization requires additional email types, your administrator can add them to the lookup
type CONTACT_POINT_PURPOSE.

5. Indicate if the new email is the primary email address. A primary address is the address that shows up in
contact and account overviews and is automatically entered in outgoing emails.

188



Oracle Fusion Cloud Sales Automation
Sales Questions and Answers

Chapter 1
Sales Questions and Answers

What can I use as a replacement for Oracle Social
Network in Sales and CX Sales Mobile?  
You can use Microsoft Teams as a replacement for the Oracle Social Network in both the web sales application and in CX
Sales Mobile.

How do I update employee information using import
management?  
You can update a resource by changing the resource information such as first name, last name, and email address. You
can also update a resource with additional information such as fax number, phone number, middle name, and so on.

Note:  End dated resources can't be updated using import or REST.

How to update the last name of a resource?
Vang Duffy is a Sales Manager in Sales and Fusion Service. You can view the resource details of Vang Duffy from the
Resource Directory. From the Navigator, click Resource Directory and search for Vang Duffy in the Search section, his
resource details appears as shown in this image.

The reporting hierarchy and organization details of Vang Duffy are as follows:
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In this scenario, Vang Duffy changes his name to Vang Smith. To update Vang's last name, you must use the Resource
Party Number and Last Name attributes in your source file. To update Vang's last name from Duffy to Smith, create a
source file (CSV) with these attributes and import it using import management.

Attribute Name Value

ResourcePartyNumber
 

Conta765976
 

LastName
 

Smith
 

You can import the source data file.

1. Go to Navigator  > Tools >  Import Management >  Import Queue.
2. Click Create Import Activity in the Manage Imports page.
3. In the Enter Import Options page, provide a name for the import activity, and select Resource from the Object

drop-down list.
4. Select the CSV file in the File Name field, and click Next.
5. The source and target attributes are automatically mapped in the Map Fields page. Review and edit the

mappings if required.
6. Check the file for unmapped columns or data format issues by clicking Validate Data. Click Next.

Note:  Validation errors, if any, are displayed on the Mapping Validation screen. If you get warnings about
unmapped columns, then you can ignore these columns and proceed to submit the import job. Validations
are for informational purposes and applicable only for low-volume imports.

7. Review the import details on the Review and Submit page, and click Submit when you're ready.

After running the import file, navigate to Resource Directory and search for Vang in the Search section. The resource
details of Vang after the last name is updated appear as shown in this image:
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Also, note that Vang's last name is updated in the reporting hierarchy.

How to update the email address of a resource?
Rina Nash is a Sales Representative in Sales and Fusion Service. You can view the resource details of Rina Nash from the
Resource Directory. From the Navigator, click Resource Directory and search for Rina Nash in the Search section. Rina's
resource details are displayed.

In this scenario, Rina Nash changes her name to Rina Pinto Jacob after marriage. Rina not only wants to change her last
name, but also wants to update her email ID and middle name.

To update Rina's last name, email address, and middle name, you must create a source file (CSV) with these attributes
and import it using import management. However, in this scenario, to update Rina's email ID, you must provide the
email address in your CSV file.

Attribute Name Value

ResourcePartyNumber
 

Conta765976
 

ResourceEmail
 

rina.jacob@vision.com
 

You can import the source data file.

1. Go to Navigator  > Tools >  Import Management >  Import Queue.
2. Click Create Import Activity in the Manage Imports page.
3. In the Enter Import Options page, provide a name for the import activity, and select Resource from the Object

drop-down list.
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4. Select the CSV file in the File Name field, and click Next.
5. The source and target attributes are automatically mapped in the Map Fields page. Review and edit the

mappings if required.
6. Check the file for unmapped columns or data format issues by clicking Validate Data. Click Next.

Note:  Validation errors, if any, are displayed on the Mapping Validation screen. If you get warnings about
unmapped columns, then you can ignore these columns and proceed to submit the import job. Validations
are for informational purposes and applicable only for low-volume imports.

7. Review the import details on the Review and Submit page, and click Submit when you're ready.
8. Navigate to Resource Directory and search for Rina in the Search section.

Rina's email address will be updated and visible in the resource pages, such as the resource directory.

How to update the phone number of a resource?
Rina Nash is a Sales Representative in Sales and Fusion Service. You can view the resource details of Rina Nash from the
Resource Directory. From the Navigator, click Resource Directory and search for Rina Nash in the Search section. Rina's
resource details are displayed.

In this scenario, Rina Nash changes her name to Rina Pinto Jacob after marriage. Rina not only wants to change her last
name, but also wants to update her work phone number and middle name.

To update Rina's last name, work phone number, and middle name, you must create a source file (CSV) with these
attributes and import it using import management. However, in this scenario, to update Rina's phone number, you must
provide the work phone country code and work phone number in your CSV file.

Attribute Name Value

ResourcePartyNumber
 

Conta765976
 

WorkPhoneCountryCode
 

+1
 

RawWorkPhoneNumber
 

510-599-7487
 

You can import the source data file.

1. Go to Navigator  > Tools >  Import Management >  Import Queue.
2. Click Create Import Activity in the Manage Imports page.
3. In the Enter Import Options page, provide a name for the import activity, and select Resource from the Object

drop-down list.
4. Select the CSV file in the File Name field, and click Next.
5. The source and target attributes are automatically mapped in the Map Fields page. Review and edit the

mappings if required.
6. Check the file for unmapped columns or data format issues by clicking Validate Data. Click Next.

Note:  Validation errors, if any, are displayed on the Mapping Validation screen. If you get warnings about
unmapped columns, then you can ignore these columns and proceed to submit the import job. Validations
are for informational purposes and applicable only for low-volume imports.

7. Review the import details on the Review and Submit page, and click Submit when you're ready.
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8. Navigate to Resource Directory and search for Rina in the Search section.

Rina's email address is updated and visible in the resource pages, such as the resource directory.

How do I display the country in the address field?  
By default, if the name of the country selected in the user profile and the name of the country in the address are the
same, the country is not displayed on the address field of an account or contact.

For example, US is set as the country in your user profile and the billing address is also US, then the billing address is
displayed without the country name US.

To see the country selected in the user profile go to User Profile and click Set preferences > General Preferences >
Regional > Territory

You can change this behavior in the account and contact addresses using the Regional Country in Address Formats
Included profile option.

Perform the following steps to change the profile option value:

1. Click Navigator > My Enterprise > Setup and Maintenance work area.
2. Click the Tasks menu and click Search. Search for Manage Administrator Profile Values task and open it.
3. Search for Regional Country in Address Formats Included profile option using the profile option code

ORA_HZ_INCLUDE_REGIONAL_COUNTRY.
If the profile value of the ORA_HZ_INCLUDE_REGIONAL_COUNTRY profile option is set to yes and the country
name set in the user profile is the same as the country in the address, then the country name is displayed.
If the profile value of the ORA_HZ_INCLUDE_REGIONAL_COUNTRY profile option is set to no and the country
name set in the user profile is the same as the country in the address, the country name isn't displayed.

4. Click Save and Close.

What fields can I audit for Sales?  
Here are the fields you can audit in Oracle Sales:

Sales Objects Available for Auditing

Area Parent Objects Child Objects

Account and Contact Management
 

Account (Account Profile)
 

• Sales Account Profile

◦ Sales Account Resource

◦ Sales Account Territory

• Address

◦ Address Purpose
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Area Parent Objects Child Objects

• Phone

• Email

• Instant Messaging

• Web

• Classification Assignment

• Additional Account Name

• Contact Preference

• Usage Assignment

• Additional Identifier

• Source System References

• Relationship

◦ Customer Contact Profile

Account and Contact Management
 

Contact (Person Profile)
 

• Sales Account Profile

◦ Sales Account Resource

◦ Sales Account Territory

• Contact Address

◦ Address Purpose

• Phone

• Email

• Instant Messaging

• Web

• Classification Assignment

• Additional Contact Name

• Contact Preference

• Usage Assignment

• Additional Identifier

• Source System References

• Relationship

◦ Customer Contact Profile

Account and Contact Management
 

Household (Household Profile)
 

• Sales Account Profile

◦ Sales Account Resource

◦ Sales Account Territory

• Address

◦ Address Purpose
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Area Parent Objects Child Objects

• Phone

• Email

• Instant Messaging

• Web

• Classification Assignment

• Additional Household Name

• Contact Preference

• Usage Assignment

• Additional Identifier

• Source System References

• Relationship

Account and Contact Management
 

Resource (Resource Profile)
 

• Address

◦ Address Purpose

◦ Location SDO

• Phone

• Email

• Instant Messaging

• Web Page

• Resource Organization Membership

• Resource Role Assignment

• Sales Representative Setup

Common Components
 

Activity
 

• Contacts

• Resources

Contracts
 

Contract header
 

• Buy Contract Line

• Project Contract Line

• Sales Contract Line

• Service Contract Line

Opportunities
 

Opportunity
 

• Opportunity Revenue

• Opportunity Split Revenue

• Opportunity Recurring Revenue

• Opportunity Revenue Line Set

• Opportunity Team Member

• Opportunity Partner

Opportunity Revenue
 

Opportunity
 

• Forecast

• Worst Case

• Estimated Price

195



Oracle Fusion Cloud Sales Automation
Sales Questions and Answers

Chapter 1
Sales Questions and Answers

Area Parent Objects Child Objects

• Product

• Quantity

• Discount

• Amount

• Line Currency

• Revenue Type

• TypeCodeSetId

• Best Case

• Win Probability

• UOM

• Product Group

• Frequency

• End By

• End After

• Recurring Quantity

• Recurring Estimated

• Recurring Revenue

• Start Date

• Status

• StatusCodeSetId

• Close Date

• Win/Loss Reason

• CloseReasonClodeSetId

• Competitor

• Include in Forecast

• Recurring Worst Case

• Recurring Best Case

• Sales Channel

• Partner

• Recurring Expected Revenue

• Additional Text 1

• Additional Text 2

• Additional Number 1

• Additional Amount 1

• Recurring Additional Number 1

• Recurring Additional Amount 1

Marketing
 

Leads
 

• Leads Product

• Leads Resources
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Area Parent Objects Child Objects

• Leads Contacts

• Leads Territories

Marketing
 

Budget
 

• Budget Entries

• Fund Requests

Partner Relationship Management
 

Partner
 

• Classification Assignment

• Partner Type

• Customer Contact Profile

• Partner Certification

• Expertise

• Geographies Served

• Industries Served

• Product Specialties

• Account Team

• Address

• Phone

• Web

• Email

• Instant Messaging

Partner Relationship Management
 

Partner Program
 

• Program Benefit Details

• Program Objective Details

• Program Contract Templates

Partner Relationship Management
 

Partner Enrollment
 

• Enrollment Participants

• Contract Enrollments

Sales Catalog
 

Product Group header
 

• Product Group

• Product Group Product

◦ Eligibility Rules

• Product Group Relation

• Product Group Attachments

Sales Catalog Product header • Product

• Product Attachment

Territory Management
 

Sales Territory
 

• Sales Territory Resource

• Sales Territory Line of Business

• Sales Territory Coverage

• Sales Territory Coverage Dimension
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Area Parent Objects Child Objects

• Sales Territory Coverage Dimension Value

Territory Management
 

Sales Territory Proposal
 

Sales Territory Proposal
 

Note:  You can also audit custom objects that you create in Application Composer. On the Configure Business Object
Attributes page, select CRM Application Composer from the Product list of values. You can then select either a top-
level custom object or its child objects, or an intersection object that was created from a many-to-many relationship.

Steps to Enable Auditing in Sales
Here's how to enable audit history so that your users can see the change history of sales business objects:

1. Sign in as a setup user.
2. In the Setup and Maintenance area, use the search pane to search for the Manage Audit Policies task.
3. In the Manage Audit Policies page, click Configure Business Object Attributes in the Oracle Fusion

Applications region.
4. Select appropriate business object or business object area from the list.

◦ For sales Accounts, Business Plans, Objects, or Quotes, select CRM Common.

◦ For sales Activities, select Applications Common Components.

◦ For Products and Product Groups, select Sales Catalog.

◦ For Opportunities, select Sales.

5. If necessary, select a child item from the list of objects in the Audit Name table.
6. Click the add icon in the Audited Attributes area.
7. Select the fields you want to audit.
8. Click Save and Close.

Note:  Administrators must have the Manage Sales Audit Policies (FND_MANAGE_SALES_AUDIT_POLICIES_PRIV)
privilege to do these steps.

Can I check what infrastructure is used by Sales to run
the database?  
No. Access to the identity of the infrastructure, core services, and applications used by Oracle Sales is strictly protected
and can't be viewed for security reasons. Security is embedded in every layer of Sales to offer continuous and seamless
protection.
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How can I change an existing error message?  
You can create messages and change predefined messages stored in the message dictionary. Here's how to edit a
predefined message or a message that you created.

1. In the Setup and Maintenance work area, go to the Manage Messages task.
2. On the Manage Messages page, search for and select an existing message that you want to modify.
3. Click the Edit icon.
4. On the Edit Message page, change the existing details according to your specific requirements.

Note:  Don't edit the message number for predefined messages.

5. Click Save and Close.

Can I add custom child object fields as columns in the
Workspace list?  
No. Adding custom fields or exposing fields from a child object as columns to the Workspace List UI isn't possible. You
can only use custom fields for filtering the Workspace list results.

How can I restrict email notifications on weekends using
Groovy?  
You can write a groovy script in Application Composer for your object that restricts email notifications from sending at
the weekend (both Saturday and Sunday) to specified recipients.

Let's say you've scheduled a process to run daily to cater for the following condition: If a Lead isn't updated from the
last 7 days, then automatically trigger an email notification for the lead owner.

To restrict the notification from being triggered on weekends, use the following sample code at the start of your script
to get the day of the week and then use the condition to either run the rest of the code or skip it as follows.

def date = new Date()
Calendar calendar = Calendar.getInstance();
calendar.setTime(date);
def day = calendar.get(Calendar.DAY_OF_WEEK);
if (day == 7 || day == 1){ //1 is mapped to Sunday and 7 is mapped to Saturday
println('Do Nothing')
}
else{
//write the rest of the code that you want to run on weekdays
}
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Note:  Before you enable notifications for Sales, ensure that you've enabled notifications generally. For steps how to
do this, see the topic, Disable or Enable Workflow Notifications. If you update your sales application, be sure to go back
and check these settings again.

What profile options do I need to set for qualifying
leads?  
You must set two profile options for lead qualification templates to specify what template name to display for the
collection of questions, possible answers, and questionnaire feedback when you're qualifying leads.

Set these two profile options:

• MKL_LEAD_QUALIFICATION_TEMPLATE_PROFILE (Advanced Lead Qualification Enabled) for Direct Leads

• MKL_PARTNER_LEAD_QUALIFICATION_TEMPLATE (Advanced Lead Qualification Enabled) for Partner Leads

The qualification template used is based on the Sales Channel field. For example, if the Sales Channel is set to Direct,
it will use the template specified in MKL_LEAD_QUALIFICATION_TEMPLATE_PROFILE. If the Sales Channel is set to
Partner or is blank, it will use the template specified in MKL_PARTNER_LEAD_QUALIFICATION_TEMPLATE.

How can I prevent an opportunity I'm editing from being
selected as a child Opportunity?  
You can insert a Before Update trigger script on the Opportunity object. Here's an example:

if (ParentOpportunity_Id_c == OptyId){
 throw new oracle.jbo.ValidationException('You can't set a Parent Opportunity as the same Opportunity 
you are editing.')
}

What do I when the Synchronize CRM Search Indexes
process is stuck or ends with an error?  
To run the process, you must have the Customer Relationship Management Application Administrator job role or a
custom job role with the privilege 'Run Search Index Scheduler' ( ZCA_RUN_SEARCH_INDEX_SCHEDULER_PRIV).

This solution applies to the following error:

ESS-02001 User <user name> does not have execute permission on metadata object
 oracle.apps.ess.crmCommon.JobDefinition.SynchSearchContextIndexJob.
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Here's how to fix the issue:

1. Assign the user the role Customer Relationship Management Application Administrator or add the privilege
Run Search Index Scheduler ( ZCA_RUN_SEARCH_INDEX_SCHEDULER_PRIV) to an existing job role.

2. Run scheduled process: Send Pending LDAP Requests
3. Run scheduled process: Import User and Role Application Security Data
4. Resubmit the process: Synchronize CRM Search Indexes

How do I auto generate billing account numbers?  
You can automatically generate billing account numbers that begin from a certain number.

For example, you may have loaded legacy accounts with existing account numbers. You determine the maximum
account number. You can then specify that any billing account that is newly created will be an increment of this
maximum account number.

You must first set Customer Account Number Generation profile option (HZ_GENERATE_CUSTOMER_NUMBER) to Auto
numbering, update not allowed. You then specify that the billing account numbers must be increments of the initial
value, say, 32,100.

The initial value will take effect on newly created accounts.

1. Click Navigator > My Enterprise > Setup and Maintenance work area.
2. Click the Tasks menu and click Search. Search for  Manage Administrator Profile Values task and open it.
3. Search for the Party Number Generation profile option using the profile code HZ_GENERATE_CUSTOMER_NUMBER.
4. Set the value to Auto numbering, update not allowed at the site level.
5. Click Save and Close.
6. Click Navigator > My Enterprise > Setup and Maintenance work area.
7. Click the Tasks menu and click Search. Search for Manage Document Sequences.
8. Expand the BILLING_ACCOUNT_NUMBER row and type the initial value. For example, you can type 32100.
9. Click Save and Close.

How do I auto generate party site numbers?  
You can automatically generate party site numbers that begin from a certain number.

For example, you may have loaded legacy party site numbers with existing party site numbers. You determine the
maximum party site number. You can then specify that any party site number that is newly created will be an increment
of this maximum party site number.

You must first set Party Site Number Generation profile option (PARTY_SITE_NUMBER) to Auto numbering, update not
allowed. You then specify that the party site numbers must be increments of the initial value, say, 22,102.

The initial value will take effect on newly created accounts.

1. Click Navigator > My Enterprise > Setup and Maintenance work area.
2. Click the Tasks menu and click Search. Search for  Manage Administrator Profile Values task and open it.
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3. Search for the Party Number Generation profile option using the profile code PARTY_SITE_NUMBER.
4. Set the value to Auto numbering, update not allowed at the site level.
5. Click Save and Close.
6. Click Navigator > My Enterprise > Setup and Maintenance work area.
7. Click the Tasks menu and click Search. Search for Manage Document Sequences.
8. Expand the PARTY_SITE_NUMBER row and type the initial value. For example, you can type 22,102.
9. Click Save and Close.

How do I auto generate contact numbers?  
You can automatically generate contact numbers that begin from a certain number.

For example, you may have loaded legacy contact numbers with existing contact numbers. You determine the
maximum contact number. You can then specify that any contact that is newly created will be an increment of this
maximum account number.

You must first set Contact Number Generation profile option (HZ_GENERATE_CUSTOMER_NUMBER) to Auto
numbering, update not allowed. You then specify that the contact numbers must be increments of the initial value, say,
32,100.

The initial value will take effect on newly created accounts.

1. Click Navigator > My Enterprise > Setup and Maintenance work area.
2. Click the Tasks menu and click Search. Search for  Manage Administrator Profile Values task and open it.
3. Search for the Party Number Generation profile option using the profile code HZ_GENERATE_CONTACT_NUMBER.
4. Set the value to Auto numbering, update not allowed at the site level.
5. Click Save and Close.
6. Click Navigator > My Enterprise > Setup and Maintenance work area.
7. Click the Tasks menu and click Search. Search for Manage Document Sequences.
8. Expand the CONTACT_NUMBER row and type the initial value. For example, you can type 32100.
9. Click Save and Close.

How do I auto generate party numbers?  
You can automatically generate party numbers that begin from a certain number.

For example, you may have loaded legacy party numbers with existing party numbers. You determine the maximum
party number. You can then specify that any party number that is newly created will be an increment of this maximum
party number.

You must first set Party Number Generation profile option (HZ_GENERATE_PARTY_NUMBER) to Auto numbering,
update not allowed. You then specify that the billing account numbers must be increments of the initial value, say,
32,100.

The initial value will take effect on newly created accounts.
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1. Click Navigator > My Enterprise > Setup and Maintenance work area.
2. Click the Tasks menu and click Search. Search for  Manage Administrator Profile Values task and open it.
3. Search for the Party Number Generation profile option using the profile code HZ_GENERATE_PARTY_NUMBER.
4. Set the value to Auto numbering, update not allowed at the site level.
5. Click Save and Close.
6. Click Navigator > My Enterprise > Setup and Maintenance work area.
7. Click the Tasks menu and click Search. Search for Manage Document Sequences.
8. Expand the REGISTRY_ID row and type the initial value. For example, you can type 32100.
9. Click Save and Close.

How can I add new note types?  
Here's how to add new note types for an object:

1. Navigate to Setup and Maintenance and search for the Manage Sales Note Type task.
2. Add a new row to the ZMM_NOTE_TYPE: Lookup Codes table.
3. Add the new lookup, check Enable, and enter a meaning and a description.
4. Save and close.
5. In Setup and Maintenance, go to the Manage Sales Note Type Mapping task.
6. In the Manage Sales Note Type Mapping page, select the business object, such as Sales Account.
7. In the Mapped Lookup Value field, select the lookup code you created earlier.
8. Select an end date if needed, and set the Default field to Y.

How do I notify a lead owner by email when a lead is
assigned to them?  
You can create email notifications using the Routines feature. Routines is the fastest way of creating email notifications.
It doesn't require any Groovy scripting, and automatically appends a link to the lead in the email.

The following steps apply mainly to Redwood User Experience (UX) users. However, Simplified UI users can also use
these steps but note that some options on the Trigger page aren't available for Simplified UI users.

1. Open Application Composer outside a sandbox (Navigator > Configuration >  Application Composer).
2. Click Routines.
3. Click Create Routine.
4. Click Skip Templates.
5. Enter a name and description. For example: Email Notification for New Lead Owner Notify owner that a lead

was assigned to them.
6. Select the object, in this case Sales Lead.
7. Click Next.
8. On the Trigger page:

◦ Redwood UX users have the following options:
- Hourly
- Daily
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- Weekly
- Monthly
- Yearly
- Record created
- Record deleted
- Attribute changed

◦ Simplified UI users have the following options:
- Hourly
- Daily
- Weekly
- Monthly
- Yearly

Note:  For Simplified users, if the existing options don't suit your requirements, you can use Rules to specify
a trigger when the routine should run. For example, you can create and apply certain rule conditions to
Attribute Owner ID, or Last Update Date, or Status and so on to trigger and submit the routine.

9. For Redwood UX users, select Attribute changed and then select Owner ID from the list of attributes because
you're sending the email after the owner is updated in the record.

Note:  Redwood User Experience (UX) users will have access to more triggers to specify when the routine
runs. For example, in addition to the defined recurring schedules, they can choose to run the routine as soon
as an attribute is changed or when a record is created, updated, or deleted.

10. Click Next.
11. On the Actions page, select Send Email as the action type.
12. In the To field, select Owner ID.
13. In the Subject and Body fields, you can enter both text and mail-merge attributes. For example, to include the

lead name, enter Name in the Attribute search box, press Return, and click Lead Name. Your action enters the
mail-merge field {{$Name}}.

Note:  The email sent to the new owner gets automatically appended with a link to open the lead.

14. Optionally, you can add another action. For example, in addition to sending the email you can create a task by
selecting Create Task from the Action Type list and entering the task attributes.

15. Click Next.
16. In the Rules, page you can create rules and groups of rules that select the leads the notification runs on. In this

example, we're notifying the owner when any lead is assigned to them, so you can skip this step.
17. Click Next.
18. On the Review page, review your entries and click Submit.

See Overview of Routines for more information about routines.

Why don't I see any products and product groups when I
try to add them to leads and opportunities?  
If you don't see any products or product groups when you try to add them to leads or opportunities in Sales in the
Redwood user experience, the application administrator may not have enabled products and product groups for
Adaptive Search.
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Here's how a setup user can enable these and other objects for Adaptive Search:

1. In the Setup and Maintenance work area, open the Configure Adaptive Search task:

◦ Offering: Sales

◦ Functional Area: Sales Foundation

◦ Show: All Tasks

◦ Task: Configure Adaptive Search

2. On the Configure Adaptive Search page, click the Setup tab.
3. On the Setup tab, Quick subtab, select Product and Product Groups and any other objects you may want to

enable.
4. Click Publish.

Your action runs an indexing process and an hourly index refresh for the objects you selected. You can monitor
the progress of the indexing process on the Monitor tab. The process can take several minutes to complete,
depending on your data volume.

Can I set the CX Sales Mobile app to provide directions
from Google Maps instead of Apple Maps on iPhones?  
The Get Directions button uses the phone's native map application to guide salespeople to their destinations. So, if the
native app is Apple Maps, you will get directions from Apple Maps. Try defaulting Google Maps on your phone and then
refresh the CX Sales Mobile app.

Can I hide a country?  
If your business is not operating in any country, you may want to hide it.

You may want to hide a country from appearing in the list of countries, for example, while updating the address of a
contact. This can be done in Manage Territories.

1. Click Navigator > My Enterprise > Setup and Maintenance work area.
2. Click the Tasks menu and click Search. Search for Manage Territories and open it.
3. Search the country you want to hide using its Territory Code or Territory Name.
4. Clear the selection of the check box in the Enabled column.
5. Click Save and Close.
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How do I verify email addresses and phone numbers?  
You can verify email addresses and phone numbers in your application using the Oracle Address, Email, and Phone
Verification service.

When your sales organization subscribes to the Oracle Address, Email, and Phone Verification service, you know right
away if you entered an invalid phone number or email address.

The application can't check if the phone numbers and emails you enter are valid for the specific person or account, of
course, but it does assure that a phone number will actually dial and that an email won't bounce.

When a phone number or an email address is invalid for some reason, you get notified right under your entry. If nothing
appears, the information is valid and you're good to go. Here's a screenshot of an invalid phone number to give you an
idea of what you see under invalid information:

Callout Number What You See

1
 

Status. For phone numbers, this can be only Invalid. Email addresses can also display the status of
Partially-Valid: the domain is valid but the name isn't. If the person left the company, or changed their
name, you'll see the Partially-Valid status for the email, for example.
 

2
 

Date the email address or phone number was verified by the application.
 

3
 

Reverify button that you can use to verify again. You never know when area codes or email addresses
may change. What's valid today may not be in six months.
 

4
 

Overwrite button to manually set the status. The application, isn't perfect. If you know the number or
email is correct, you can set the status to Verified. When you do, you see Overwritten on instead of
Verified on.
 

Although the application doesn't display a Valid status for valid entries right away, you do eventually see it together
with the date the information was verified. (How much later is under the control of the application administrator). Why
display the status at all? When the information is old, you or your colleagues may want to verify it again by clicking
Reverify.
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How to have different contact address fields depending
on the country selected?  
You must create different address fields using address formats depending on the country you selected.

To create an address style format:

• Specify the address style format and address style

• Create the format variation layout

• Assign a locale

In this example, we will create an address style to format Canadian postal addresses.

Create the Address Style Format Name and Specify the Address Style
To create an address style format and specify the address style:

1. In the Setup and Maintenance work area, go to the following:

◦ Offering: Customer Data Management

◦ Functional Area: Trading Community Foundation

◦ Task: Manage Address Formats

2. On the Manage Address Formats page, click Create from the actions menu.
3. On the Create Address Style Format page, complete the fields in the Overview section, as shown in the

following table.

Field Value

Code
 

CA_POSTAL_ADDR
 

Name
 

Canadian Postal Address Format
 

Address Style
 

Postal Address
 

Default
 

No
 

4. Click Save.

Create the Format Variation Layout
To create a format variation layout:

1. In the Format section on the Create Address Style Format page, click the Format Layout tab.
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2. In the Format Variation section, select Add from the Actions menu.
3. Enter a variation rank in the Variation field.

Note:  You can't change the Variation Number. If you're specifying Create and Edit address forms, always use
variation value as 1 irrespective of rank. If you're specifying Read Only formatted address (either single line or
more than one line), always use variation with highest rank.

4. In the Format Variation Layout section, select Add from the Action menu.
5. Complete the fields as shown in the following table.

Field Value

Line
 

1
 

Position
 

1
 

Prompt
 

Address line 1
 

Address Element
 

Address line 1
 

Required
 

Yes
 

Uppercase
 

No
 

6. Create another address line as shown in the following table.

Field Value

Line
 

2
 

Position
 

2
 

Prompt
 

City
 

Address Element
 

City
 

Required
 

Yes
 

Uppercase
 

Yes
 

7. Click Expand on the City address line, then enter the value 1 in Blank Lines Before.
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8. You can create as many address lines as you require. Click Expand if you want to enter blank lines and
delimiters before, or after, an address line. In this section, you can also use the Attribute Transform Function
to specify how the country attribute value must be displayed. The Attribute Transform Function supports two
functions:

◦ hz_format_pub.get_tl_territory_name(COUNTRY)

◦ hz_format_pub.get_neu_country_code(COUNTRY)

These functions are used only in display formats or read-only formats where the address data is formatted in a
single field. Examples for such formats are overview pages and multiple addresses section in a list. Let's look at
these functions in detail:

◦ hz_format_pub.get_tl_territory_name(COUNTRY): Converts a country code of a country into its name.
For example, MX is converted to Mexico. The country is displayed in the language that's set in the user
profile. If the profile value of the ORA_HZ_INCLUDE_REGIONAL_COUNTRY profile option is set to yes
and the country name set in the user profile is the same as the country attribute value, then the country
name is displayed. If the profile value of the ORA_HZ_INCLUDE_REGIONAL_COUNTRY profile option
is set to no and the country name set in the user profile is the same as the country attribute value, the
country name isn't displayed. To change the profile value, navigate to the following in the Setup and
Maintenance work area:

- Offering: Sales
- Functional Area: Sales Foundation
- Task: Manage Administrator Profile Values

◦ hz_format_pub.get_neu_country_code(COUNTRY): Converts a country code for North European
countries into a code that's placed before the postal code in a formatted address. For example, for France
F is placed before the postal code. B is used for Belgium, D for Germany, and so on.

Note:  For more information about territory codes and their prefix for North European postal codes,
see Seeded Address Formats for Countries topic.

Note:  While creating a new address style format, make sure that the transform function is present for each
component as in predefined address style formats. The transform function may impact translation.

Assign a Locale
An address style format is assigned to a geographic location. Locale provides mapping between territory_code and
address style format.

To assign an address style format to a locale:

1. In the Format section on the Create Address Style Format page, click the Locale Assignment tab.
2. Select New from the Actions menu.
3. Select the country for the address style format. You can assign multiple countries to the format.
4. Click Save and Close.

Related Topics
• How can I create an address style format layout?

• How can I create a variation of an Address Style Format?

209



Oracle Fusion Cloud Sales Automation
Sales Questions and Answers

Chapter 1
Sales Questions and Answers

How do I undo enrichment of an enriched account?  
In certain scenarios, you may have to undo enrichment of a Dun & Bradstreet (D&B) enriched account and associate it
again with Oracle Account and Contact Enrichment by Dun & Bradstreet to get the right updates for your account.

Let's see some examples:

• In the UK, when a private limited company goes public, D&B creates a new company record with a fresh DUNS
number, and it obsoletes the old DUNS number and records of the company. In such a case, you have to restart
the enrichment to get the latest updates for your account.

• In a rare case, enrichment can result in an incorrect operation and a Sales account is updated with incorrect
D&B company data.

In such cases, you can undo the existing enrichment and redo it so that right data is updated in the Sales account
records. Here’s how you undo enrichment:

1. Go to Navigator  > Sales > Accounts.
2. Select a D&B enriched account you don't want to enrich any longer.
3. On the Accounts page, click Actions and select Undo Enrichment.
4. Save your changes.

Note:
• After undoing the enrichment, your account unlinks from D&B, but the old data remains. Redo the enrichment

so that the latest data from D&B replaces the old data.

• The enrichment sync jobs won't run for accounts unlinked from enrichment.

Why should I use the Maintain Party and Location
Current Record Information process?  
You can use this Maintain Party and Location Current Record scheduled process to sync worker records in Human
Capital Management (HCM) to person parties and to update the current profile record for people, organizations, and
locations based on today's date.

Syncing worker records to person party records helps in managing applications such as HR Help Desk, HCM
Payroll, Expense, and so on. This scheduled process creates or updates person party records with party usage of
HR_EMPLOYEE or HR_CONTINGENT_WORKER that are defined as workers in HCM such as pending worker, employee,
contingent worker, nonworkers, and so on. This scheduled process updates person party records with party usage of
HR_EMPLOYEE or HR_CONTINGENT_WORKER that are defined in HCM as canceled hire or purged worker.

In HCM, active workers are workers who are continuing in the organization. For example, employee and contingent
worker. Future workers are workers who aren’t currently part of the organization. For example, pending worker.
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This scheduled process works in two modes:

• Normal Mode: All the person types listed in the table below except for employee and contingent worker who
were hired in the past or current date are synchronized.

• Full Mode: Employee and contingent worker who were hired in the past or current date are synchronized in
addition to the person types processed in the normal mode.

The following table lists the person types that are supported for synchronization in this scheduled process:

List of person types supported for synchronization in this scheduled process

Person Type Hire Date Sync in Normal Mode Sync in Full Mode

Employee Past Date/ Current Date No Yes

Employee Future Date Yes Yes

Contingent Worker Past Date/ Current Date No Yes

Contingent Worker Future Date Yes Yes

Pending Worker Past Date/Current Date /Future
Date

Yes Yes

Nonworker Past Date/Current Date /Future
Date

Yes Yes

Ex-Employee Past Date/Current Date /Future
Date

Yes Yes

Ex-Contingent Worker Past Date/Current Date /Future
Date

Yes Yes

Ex-Pending Worker Past Date/Current Date /Future
Date

Yes Yes

Ex-Nonworker Past Date/Current Date /Future
Date

Yes Yes

Purged Worker Past Date/ Current Date Yes Yes

Prerequisites
This scheduled process syncs active workers only when the profile option Enable Current Active
Worker Sync For MPLCRI Job (ORA_HZ_ENABLE_MPLCRI_ACTIVE_WORKER) is set to yes (Y), and
HRC_DISABLE_HCM_EVENTS_PROCESSING profile option is set to yes. This setting is named as Full mode.
When the HRC_DISABLE_HCM_EVENTS_PROCESSING profile option is set to yes, Change Person Details
events aren't published. Therefore, both the profile options (ORA_HZ_ENABLE_MPLCRI_ACTIVE_WORKER and
HRC_DISABLE_HCM_EVENTS_PROCESSING) must be set to yes to avoid creating duplicate person parties while syncing
active HCM worker records.

The following table displays the profile options and their values in both the modes:
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This table displays the profile options and their values in both the modes

Profile Option Normal Mode Full Mode

ORA_HZ_ENABLE_MPLCRI_ACTIVE_WORKER No Yes

HRC_DISABLE_HCM_EVENTS_PROCESSING N Y

Note:  Setting the HRC_DISABLE_HCM_EVENTS_PROCESSING to yes turns off all HCM events. This is very risky
because this setting can break business flows that consume HCM events. So, ensure that this profile option is set to
yes only during very short periods of time.

This setting is only applicable to active workers and not applicable to other person records such as nonworkers,
contingent workers, and so on.

When to Use
This scheduled process is used to:

• De-normalize the future dated current location profile, party sites, and contact points based on today's date
with extended support to future end-dated records.

• Create a party record for a Human Capital Management person record, if the party doesn't exist.

• Synchronize the first name, middle name, the last name, the title of the person, work phone, and work email
attributes of the person records.

• When you purge the employee record of a purged worker, run this scheduled process to purge the
corresponding person details. This scheduled process end dates the person usage assignment and
synchronizes the deleted details of the purged worker.

Note:  Party usage dates aren't synced during update. In other words, if an employee quits or is terminated (in HCM)
and this scheduled process is executed, the party usage assignment isn't end dated. So, if an employee quits or is
terminated from work, the person party record is still available. If phone number or email is deleted in HCM and this
scheduled process is run, the corresponding person record's phone number or email is deleted.

Privileges Required
Verify that you have the following privileges or roles:

• Application Implementation Consultant

• Master Data Management Application Administrator

Before You Start
Review the following before scheduling this scheduled process:

• Recommended Frequency:

◦ When there is a requirement to create or update worker records as person parties to complete business
flows such as setting up direct payment methods, then run this scheduled process.
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◦ The scheduled process can be run when HCM workers are created or updated from HCM interfaces like
HDL loader and then to sync workers into person parties.

• Compatibility:

◦ This scheduled process is self-incompatible. If multiple instances are submitted, the first instance runs,
and subsequent instances remain in Wait status.

◦ Ensure that you don't schedule this process and the Synchronize Person Records process at the same
time.

Parameters

Parameter Optional or
Mandatory

Description Parameter Values Special Combinations
Required

None

Synchronization Type
 

Optional
 

Specify the object to
be synchronized. You
can specify Worker
(HR Persons) or Party
and location (De-
normalize Parties).
If you don't select
anything, both objects
are synchronized.
 

• Party and
location

• Worker

Not applicable
 

None
 

Person Type
 

Optional
 

Specify the type of
person records to be
synchronized.
 

• Ex-Nonworker

• Nonworker

• Employee

• Pending Worker

• Ex-Employee

• Ex-Pending
Worker

• Ex-Contingent
Worker

• Contingent
Worker

• Purged Worker

Synchronization Type
must be Worker.
 

None
 

From Date
 

Optional
 

Specify the from
date in the date
range during which
employee records
were created or
updated.
 

Select a date.
 

Synchronization Type
must be Worker.
 

None
 

To Date
 

Optional
 

Specify the to date in
the date range during
which the employee
records were created
or updated.
 

Select a date.
 

Synchronization Type
must be Worker.
 

None
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Parameter Optional or
Mandatory

Description Parameter Values Special Combinations
Required

None

Person Number
 

Optional
 

Specify the person
number to be
synchronized.
 

Specify a valid person
number.
 

Synchronization Type
must be Worker.
 

None
 

How do I import Non-Oracle Licensed geography data?  
You can use Import Management to create Geography data. It's recommended to use import management if you're
importing Non-Oracle Licensed geography data or while loading your own geography from other vendors. You can
also add alternate name or code to existing geographies with import. For more information see Example of Importing
Geography Data.

To import Geography data, perform the following tasks:

1. Map your source data to Oracle Applications Cloud object attributes.
2. Create source Comma Separated Values (CSV) file for import.
3. Create the import activity.
4. Review the import results.

How You Map Your Source Data to Object Attributes
To import your Geography data into Oracle Applications Cloud, you must populate a .csv file with your source data and
map that source data to target object attributes in Oracle Applications Cloud.

You need to do the following before creating the CSV file for data import:

• Identify how your source data attributes map to the target object attributes in Oracle Applications Cloud.

• Create Country Structure before importing Geography data. For information on how to create Country
Structure, see Import Your Country Structure and Example of Importing Country Structure in Related Topics
Section.

• Identify the target object attributes that are required in the CSV file for a successful import as mentioned in the
table Required Attributes and Validations for the Geography Object below.

Before You Start
You must do some basic checks before starting your import. For example, make sure that:

• You have completed all the prerequisites for importing each attribute in your source data such as creating a
country structure.

Required Attributes and Validations for the Geography Object
To import data successfully into Oracle Applications Cloud, your CSV file must include the required attributes. Ensure
that you provide values for the attributes. The following table lists the required attributes for importing new Geography
records, prerequisite setup tasks for the attributes, and specific validations, if any, for Geography import:
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Attribute Description Prerequisite Setup Task/ Import
Validations

Creating a Geography Record

CountryCode
 

The code of the country to which
the geography belongs.
 

This is validated against the
country structure to check if
the structure is defined for this
country.
 

Required
 

PrimaryGeographyName
 

The primary name of the
geography.
 

This is validated against the name
of country if geography type is
'Country' or LevelNumber is 1.
 

Required
 

RecordTypeCode
 

The record type code that
represents the intent of the import
data. The values are:
 

• 0 - indicates the geography
that already exists in the base
table.

• 1 - indicates the intent to
create a new geography.

• 2 - indicates the intent to
add an alternate identifying
name or code to an existing
geography.

No Validation
 

Required
 

LevelNumber
 

The level number of the geography
in the hierarchy. For example,
 Country is at Level 1 and State
(California) is at Level 2.
 

The level should exist in the
country structure.
 

Required
 

SourceID
 

The source ID for the geography,
 along with the parent source ID
is used to identify the geography
parent and child relationship
within the source file data and the
interface table data.
 

None
 
 

Required
 

ParentSourceID
 

The parent source ID for the
geography, along with the
source ID is used to identify the
geography's parent and child
relationship with records within the
source file data. This should be null
for the country record, as Country
is at the top of the hierarchy.
 

None
 

Required
 

You can view the Geography object and attributes in the Manage Import Objects page of the Import Management flow.
You can find attribute information like type, length, description, and so on, on this Manage Import Objects page.
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Note:   Keep a note of the following:

• You can't update geographies via import.

• You can't add alternate names or alternate code of country via import. You can do so only via UI.

• Before adding a new alternate name, make sure that the alternate name does not exist with the same value
for any other geography name.

• You can enable high-volume import for the Geography import object in the Manage Import Objects page.

• PrimaryGeographyCodeType and PrimaryGeographyCode can't be added after PrimaryGeographyName is
created via import. You must create them together. Alternatively, you can add primaryGeographyCodeType
and PrimaryGeographyCode from the UI after the import is complete.

• The attributes ProviderGeoId, ParentProviderGeoId, and ParentGeographyId are currently Not Supported.
Create the Source CSV File
You include the data that you want to import into CX Sales and Fusion Service in a source CSV file.

You can use the templates available in the Import Objects UI page to create the source CSV file. To download a template:

1. Go to Navigator  > Tools >  Import Management >  Import Objects.
2. Select the Geography object in the table and click Download.

You can now edit the downloaded file and provide valid values for the required attributes.

Note:  For help in populating the CSV file and to avoid any issues in entering values, see the topic Potential Issues
When Opening CSV Files With Excel in Related Topics section.

Create the Import Activity
After you have the CSV file ready, create an import activity to import the information. To create an import activity:

1. Go to Navigator  > Tools >  Import Management >  Import Queue.
2. Click Create Import Activity in the Manage Imports page.
3. In the Enter Import Options page, provide a name for the import activity, and select Geography from the

Object drop-down list.
4. Select the CSV file in the File Name field, and click Next.
5. The source and target attributes are automatically mapped in the Map Fields page. Review and edit the

mappings if required.
6. Check the file for unmapped columns or data format issues by clicking Validate Data. Click Next.
7. Review the import details on the Review and Submit page, and click Submit when you're ready.

Review the Import Results
Check if your import succeeded on the Manage Imports page. This page shows the status of all active, completed, and
unsuccessful imports. To check the status of the import activity:

1. Go to Navigator  > Tools >  Import Management >  Import Queue.
2. Click All Imports and search for the import activity that you created earlier.
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3. Check the Status column for the import activity. The import is successful if the status displays as Completed.
You can drill down on the import activity to go to the Import Status page which provides the status details of
the import activity.

Note:  Geography names aren't translatable and are always displayed in the same language in which they were loaded
irrespective of the language of the signed in user. If you need different options of display, you can use the alternative
names option.

Related Topics
• How do I import data?

• Potential Issues When Opening CSV Files in Excel

• Import Your Country Structure Data

• Example of Importing Country Structure Data

• Example of Importing Geography Data

Why can't I find inactive records for purging them?  
You can purge inactive data or records that you no longer need using this scheduled process. This scheduled process
reads the configuration information such as age of inactive record and filter criteria. It then purges parent and child
records that meet the filter criteria.

When to Use
You can use this scheduled process to purge sales contact, sales household, or sales account information that meet the
specified filter criteria.

Note that only inactive records that are available in the sales context can be purged. For example, an inactive Partner
record can't be purged because Partner isn’t related to Sales. Only inactive and related merged sales accounts, sales
contacts, and sales households which have no dual usage, or any additional usage (more than one usage) can be
purged. Examples of inactive contacts, accounts, or households with dual usage are:

• contact which is also a supplier contact

• sales account which also has billing account usage

The following sales contact record types are supported:

• CONTACT

• ORG_CONTACT

• CUSTOMER_CONTACT

• SALES_PROSPECT

• SALES_ACCOUNT

The following sales account record types are supported:

• SALES_PROSPECT
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• SALES_ACCOUNT

Also, along with the purge of the inactive accounts, households, or contacts, references of these purged records, such as
identifier or name, are also removed in other applications like opportunities, leads, campaigns, territories, assets, deals,
quotes, activities (tasks and appointments), notes, forecasts, business plans, and contracts. For these flows, purged
accounts and contacts don't appear on application pages, web service responses, and BI reports.

Merged records can be purged only when the master (survivor) party becomes inactive.

Purge account, contact, and household records in the following situations:

• Purge Inactive Sales Accounts and contacts to comply with General Data Protection Regulations (GDPR).

• Cleanup data because incorrect data was created that's no longer needed.

• In some rare cases, cleanup of data maybe required to improve performance of the application.

Privileges Required
Verify that you have the following privileges or role:

• Privilege

◦ ORA_ZBS_SALES_ADMINISTRATOR_JOB

• Role

◦ Sales Administrator

Before You Start
Review the following before scheduling this scheduled process:

• Recommended Frequency:

◦ You can run this scheduled process on need basis or schedule it for appropriate frequency, such as daily
once.

• Execution Time

◦ The execution time for a single data record is 1 to 2 minutes.

◦ The execution time for a batch job or certain volume of data say 10k is around 1 hours 30 minutes to
2hours.

• Compatibility

◦ This scheduled process is incompatible with itself and any other scheduled process.

◦ There are no processes that must be run after running this process.

Parameters

218



Oracle Fusion Cloud Sales Automation
Sales Questions and Answers

Chapter 1
Sales Questions and Answers

Parameter Optional or
Mandatory

Parameter Values Description Special Combinations
Required

Notes

Name
 

Mandatory
 

Sales Contact
 
Sales Account
 

Purges inactive
records that meet
the filter criteria. For
more information
about specifying the
filter criteria, see the
Related Topics section.
 

No
 

N/A
 

Execution Mode
 

Mandatory
 

Regular mode for
party purge
 
Exception mode for
party purge clean up
 

Sales accounts and
sales contacts may
be referred in other
applications. Examples
of such references
are identifier or name
in applications like
opportunities, leads,
 campaigns, territories,
 and so on.
 
In Regular mode
for party purge, the
references of inactive
party records based
on the currently
specified filter criteria
are removed.
 
In Exception mode
for party purge clean
up, the references
of any party which
no longer exists
in addition to the
references identified in
the regular mode are
removed.
 
We recommend that
you use the Exception
mode with caution.
Use this mode only
when references exists
of inactive records in
other applications like
opportunities, leads,
 campaigns, territories,
 assets, deals, quotes,
 activities (tasks
and appointments),
 notes, forecasts,
 business plans, and
contracts and the
corresponding Party
Record is purged.
 

No
 

N/A
 

Troubleshooting Information
You are notified about the scheduled process completion when scheduled process is successful.
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Related Topics
• Purge Inactive Data

How do I add a geography to the geography hierarchy?  
You can add a new geography to the geography hierarchy. The new geography can be added under any level of the
hierarchy for an existing geography type in the country geography structure.

For example, we can add a new postal code 94065 under United State, California, San Mateo, Redwood City.

1. Click Navigator > My Enterprise > Setup and Maintenance work area.
2. Click the Tasks menu and click Search. Search for Manage Geographies.
3. On the Manage Geographies page, enter US in the Code field. Click Search.
4. Click Hierarchy Defined for United States.

Note:  If there are many child geographies for the selected parent geography, a message asking you to
refine the search criteria is displayed. The child geographies are displayed after you refine the search
criteria. If there are many search results, you may have to further refine the search criteria. The maximum
number of child geographies that can be displayed is controlled by the ORA_HZ_GEO_HIERARCHY_LIMIT
profile option. You can change the value of this profile option by navigating to the Setup and Maintenance
work area, click the Tasks menu, and search for Manage Administrative Profile Values task. Search for the
ORA_HZ_GEO_HIERARCHY_LIMIT profile option and change the value.

5. Search using State as the Geography Type and CA as the Code.
6. Drill down to San Mateo and select Redwood City.
7. Click Actions > Create.
8. Type 94065 for Name in the Primary Name and Alternative Names section.
9. Click Save and Close.

10. Click Save and Close.
11. Click Done.

How do I define set attribute value rules?  
This example demonstrates how to create a survivorship rule of the type Set Attribute Value.

You can determine survivorship at the attribute level using the set attribute value survivorship rule type. Set attribute
value rules are used in party merge to determine which attribute value should come from which record.

The input to the survivorship rule is given in the IF clause. In a set attribute value rule, the inputs are the party records
and their source information. The source information contains information about all attributes for each record in
the database. If you're creating rules that use the Source information VO, you define it in the Define Source Systems
Confidence page of the Manage Source System Confidence task. You must map each attribute to its source system and
given a Source Confidence score on a scale of 1 to 100.

The following table lists the attributes in the source information VO to create a set attribute value rule.
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Attribute Name Description

RecordId
 

The record ID of a specific attribute.
 

AttributeName
 

The name of the attribute.
 

Source
 

The source system from where the attribute is updated.
 

SourceConfidenceLevel
 

The source confidence level assigned to the source system.
 

SourceUpdateDate
 

The date when the attribute was last updated.
 

The THEN clause determines the output object that picks the master record. In this case, setAttribute function creates
the output object. To create Set Attribute Value rules, you perform the following steps:

1. Navigate to the Manage Survivorship Rules task.
2. Click Add. The Create Survivorship Rule page appears.

Tip:  You can select attributes from the available attributes in the Create Survivorship Rule page. It pre-
populates the rule template with the selected attributes. It's not mandatory to set attributes from the available
attribute.

3. Enter the sample information provided in the following table on the Create Survivorship Rule page.

Field Value

Rule Name
 

PickAttributeValueRule
 

Description
 

Select the master value for a specific attribute based on specified master selection criteria.
 

Select the master value for a specific
attribute based on specified master
selection criteria.
 

Set attribute value
 

Object Type
 

Organization
 

Template
 

Select the Attribute Based template to select the surviving value based on the characteristic
of the attributes. For example, you need an Attribute Based template to pick an attribute with
the highest or lowest value such as a party number, or salary, or the earliest incorporated
year. Select the Source Confidence Based template to select the surviving value based on the
confidence in the source information.
 

4. Select attributes from the available attributes to pre-populate the rules template. In case you want to use the
predefined set attribute rules, don't select any attributes.

5. Click Apply. You're taken to the Define Survivorship Rules: Select Attribute Value page.
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In the Define Survivorship Rules: Select Attribute Value page, you specify criteria for selecting the master attribute value.
The criteria that you define in this page determine the feature of the rule. You also have the option of using one of the
following three predefined templates:

• Highest Source Confidence Level Wins for Organization (or Person): Use this rule to select the attribute values
with the highest source confidence level.

• Most recently updated Organization (or person) attribute: Use this rule to select the attribute values with the
most recently updated date.

• Least recently updated Organization (or person) attribute: Use this rule to select the attribute values with the
oldest updated date.

The following sections of this topic contain three worked examples that show different ways of manually setting master
attribute values in the Define Survivorship Rules: Select Attribute Value page. They are as follows:

• Set the Values with the Earliest Update Date as the Surviving Attribute Values

• Set the Value with the Highest Source Confidence Level as the Surviving Attribute Value for D-U-N-S Number

• Set the Values with the Earliest Incorporated Year as the Surviving Attribute Values

How You Set the Values with the Earliest Update Date as Surviving
Attribute Values
This rule has a single condition to set all the surviving attribute values based on the earliest update date. The following
is a use case for a set attribute rule to select the values with the earliest update date as surviving attribute values:

Use Case 1

Party Record

The following table contains information for party records.

Record Name Party ID Party Name D-U-N-S Number

Record 1
 

1
 

Oracle Corp
 

198837472
 

Record 2
 

2
 

Oracle USA Corp
 

489203901
 

Record 3
 

3
 

Oracle
 

null
 

Source Information

The following table contains information for source information records.

Record ID Attribute Name Source Source Confidence Level Source Update Date

1
 

Party Name
 

FUSION
 

95
 

1/5/2016
 

2
 

Party Name
 

FUSION
 

95
 

1/5/2010
 

3 Party Name SIEBEL 90 1/5/2000
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Record ID Attribute Name Source Source Confidence Level Source Update Date

     

1
 

D-U-N-S Number
 

DNB
 

100
 

2/5/1990
 

2
 

D-U-N-S Number
 

FUSION
 

95
 

1/5/2016
 

In this case:

• The D-U-N-S number attribute value from the record with ID 1 is selected as master because the source
information indicates that it has the earliest source update date.

• The Party Name attribute value from the record with the ID 3 is selected as master because the source
information indicates that it has the earliest source update date.

Populate the Define Survivorship Rules: Select Attribute Values page with the IF and THEN rules condition values
provided in the following table.

Rule Condition Value

IF Condition
 

IF picked attribute is a AttributeSourceInfoVO
and there is no case where {
Other Attribute == AttributeSourceInfoVO and
there is no case where
Other Attribute is a AttributeSourceInfoVO
Picked Attribute.Attributename is OtherAttributename and
PickedAttribute.RecordId isn't Other Attribute.recordId and
Picked Attribute.SourceUpdateDate more than OtherAttribute.SourceUpdateDate}

THEN Condition
 

THEN 
call setAttribute (picked attribute.Attributename, Picked Attribute.RecordId)

The following figure displays the Define Survivorship Rules: Select Attribute Values page with the IF and
THEN rules conditions to create the set attribute value rule that selects the values with the earliest source
update date as the surviving attribute value. The figure provides the following details. Name of the rule:
History WinsIF condition: If picked attribute is a AttributeSourceInfoVO and there is no case where {Other
Attribute is AttributeSourceInfoVO and Picked Attribute.AttributeName is Other Attribute.AttributeName and
PickedAttribute.RecordId isn't Other Attribute.RecordId and Picked Attribute.SourceUpdateDate more than Other
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Attribute.SourceUpdateDate}THEN condition: Then call setAttribute (Picked Attribute.AttributeName, Picked

Attribute.RecordId) 

How You Set the Value with the Highest Source System Confidence Level
as the Surviving Attribute Value for D-U-N-S Number
This rule has a single condition to select the D-U-N-S number value with the highest source confidence level as the
surviving attribute value for the D-U-N-S number attribute. The following is a use case for a set attribute rule to select
the D-U-N-S number value with the highest source confidence level as the surviving attribute value:

Use Case

Party Record

The following table contains information for party records.

Record Name Party ID Party Name D-U-N-S Number

Record 1
 

1
 

Oracle Corp
 

198837472
 

Record 2
 

2
 

Oracle USA Corp
 

489203901
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Record Name Party ID Party Name D-U-N-S Number

Record 3
 

3
 

Oracle
 

null
 

In this case, the party record contains three records with the attribute Party Name and two records with D-U-N-S
number. These attributes are picked to create the source information. The source information table defined using the
attributes from this party record table is as follows:

Source Information

The following table contains information for source information records.

Record ID Attribute Name Source Source Confidence Level Source Update Date

1
 

Party Name
 

FUSION
 

95
 

1/5/2016
 

2
 

Party Name
 

FUSION
 

95
 

1/5/2010
 

3
 

Party Name
 

SIEBEL
 

90
 

1/5/2000
 

1
 

D-U-N-S Number
 

DNB
 

100
 

2/5/1990
 

2
 

D-U-N-S Number
 

FUSION
 

95
 

1/5/2016
 

In this case, the D-U-N-S attribute value for the record with ID 1 is selected as master because the source information
indicates that it has the highest source confidence level among all records that have the D-U-N-S Number attribute.

The following figure displays Define Survivorship Rules: Select Attribute Values page with the IF and THEN rules
condition values to set the attribute value with the highest source system confidence level as the master. The figure
provides the following details.Name of the rule: Highest Source Confidence LevelIF condition: If picked attribute is
a AttributeSourceInfoVO andPicked Attribute.ArrtibuteName is EnquireDUNSNumberC and there is no case where
{Other Attribute is a AttributeSourceInfoVO and Picked Attribute.AttributeName is Other Attribute.AttributeName
and Picked Attribute.RecordId isn't Other Attribute.RecordId and Picked Attribute.SourceConfidenceLevel is less than
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OtherAttribute.SourceConfidenceLevel}THEN condition: Then call setAttribute (Picked attribute.AttributeName, Picked

Attribute.RecordId) 

How You Set the Values with the Earliest Incorporated Year as the
Surviving Attribute Values
This rule has a single condition to select values with the earliest incorporated year as the surviving attribute values. The
following is a use case for creating such a set attribute value rule:

Use Case 1

Party Record

The following table contains information for party records.

Record Name Party ID Party Name Incorporated Year

Record 1
 

1
 

Oracle Corp
 

1980
 

Record 2
 

2
 

Oracle USA Corp
 

1990
 

Record 3
 

3
 

Oracle
 

2000
 

In this case, the party record table contains three records with the attributes Party Name, Party ID, and Incorporated
Year. The attribute values for the record with the earliest incorporated year are picked as master attribute values.

The following figure displays Define Survivorship Rules: Select Attribute Values page with the IF and THEN rules
condition values to set the attribute with the earliest incorporated year as the master. The figure provides the
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following details.Name of the rule: Selecting the Earliest Incorporated YearIF condition: If for each case where org
is a OrganizationDVO and org.IncorpYear isn't null and there is no case where another org is a OrganizationDVO
and org.PartyId isn't another org.PartyId and another org.IncorpYear isn't null and org.IncorpYear.intvalue() is
more than another org.incorpyear.intValue()THEN condition: Then call setAttribute ("IncorpYear", org.PartyId)

How do I override system mapping?  
You can override system mapping for merge requests by manually modifying it. To manually modify system mapping,
you must select the master record and its associated attributes, and then specify the resolution for the child entity
conflicts and errors.

You can resolve child entity conflicts and errors by merging, transferring, or removing the record attributes.

You can override system mapping using these steps:

1. Navigate to the Duplicate Resolution work area as follows: Navigator >  Customer Data Management > 
Duplicate Resolution.
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2. Select the duplicate resolution request for which you want to override system mappings and drill down through
the request ID to the Review Merge Request page.

Note:  You can override system mappings only for those merge requests that are in New status, which
indicates that the request is open for review and processing. The status depends on the following:

◦ The merge request isn't an auto-merge request and the profile option
ZCH_USER_MERGE_REQUESTS is set to Process Subject to Approval. For more information
about this profile option, see Customer Hub Profile Options topic listed in the Related Links
section.

◦ Your administrator has run the Run Request Dispatch Job from the Setup and Maintenance
area to change the merge request status from Pending to New. A request dispatcher is run
periodically for pending merge requests, and sets the status of pending requests to New. You
can also request your administrator to run the Run Request Dispatch Job from the Setup and
Maintenance area to set the status of the pending requests to new. A setup user can access this
task in the Setup and Maintenance work area, using the following:

- Offering: Customer Data Management
- Functional Area: Customer Hub
- Task: Run Request Dispatch Job

3. Click Override on the Review Merge Request page to view the Override System Mapping: Select Master
Record page.

4. In the duplicate set on the page, select the record that you want to make the master and click Set Master.

Optionally, you can also remove records from the duplicate set to prevent them from being merged. You can
also mark the removed record as a nonduplicate to exclude it from all the subsequent merge requests.

5. Click Next to navigate to the Override System Mapping: Map Profile Attributes page.
6. Select a value from any of the duplicate records for each profile attribute to be retained in the master record.

If the number of duplicate records is five or less than five, you can select the value from the record columns. If
the number of duplicate records is greater than five, you can select the value from the value choice list. In the
profile attribute value choice list, you can hover over the value to see the attribute value's record. This helps you
associate the correct value with the master record. You can also manually enter a new value in the Final Value
column for an attribute.

7. On the Override System Mapping: Map Entities page, you can merge two or more entities into a single entity.
You can also remove merge entities, such as addresses, from the merge processes by clicking the Remove icon.
If the Remove icon isn't available, you must enable the ORA_ZCH_ALLOW_REMOVE_FEATURE profile option.
For more information about creating this profile option, see the Enable the Remove Option on the Override
System Mapping UI section in this topic. Child entities associated with the entities that are removed using the
Remove icon won't be transferred to the master record.

8. Click Next to view the Override System Mapping: Review page. Now you can review the mapping settings
and click Submit to override the default system mappings. In case there are edits, click Back to make updates to
the mapping settings before submission.
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Enable the Remove Option on the Override System Mapping UI
You can enable the Remove icon on the Override System Mapping UI by enabling the profile option
ORA_ZCH_ALLOW_REMOVE_FEATURE by setting its value to Yes as follows:

1. Sign in as a setup user such as, Sales Administrator, Master Data Management Application Administrator, or
Application Implementation Consultant.

2. Click Navigator >  Setup and Maintenance work area.
3. Click the Tasks menu and click Search. Search for Manage Administrator Profile Values task and open it.
4. Search for the Profile Option ORA_ZCH_ALLOW_REMOVE_FEATURE.
5. Click Actions, New in the ORA_ZCH_ALLOW_REMOVE_FEATURE: Profile Values area.
6. Select Site as the profile level and Y as the profile value.
7. Click Save and Close.

Related Topics
• Customer Hub Profile Options

What are the Master Record Selection settings?  
Controls the method used to identify which record in a duplicate set becomes the master during a merge.

The options are:

• Select master record using survivorship rule: Logic configured with Oracle business rules using the Manage
Survivorship Rules setup task determines the master.

• Select the oldest record as master: The record with the earliest creation date is the master.

• Select the latest record as master: With the most recent creation date is the master.

• Select master based on duplicate identification results: Internal logic of the duplication identification process
determines the master.

• Select master record using Data Quality Rules: Logic configured with Application Composer Data Quality Rules
determines the master.

Consider these points:

• The Select the older record as master and Select the latest record as master options use optimized internal
processes and may offer the best performance.

• Master Record Selection can't be survivorship rule or Data Quality Rules if the Merge Scope has been set to
Customer data management specific areas with restrictions.

• The Duplicate Identification batch process identifies a preliminary master record, but the final determination of
master record occurs within duplicate resolution processing per the Master Record Selection Setting. Select the
Select master based on duplicate identification results option if you want to retain the master record selection
from the duplicate identification results.
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How can I search for an account by any of the words in
the name when creating an opportunity?  
Sales in the Redwood user experience provides you with the fastest way of searching using any of the words in
an account name when you're creating an opportunity. Just place your cursor in the Account field to see the most
frequently used accounts. If the suggestions don’t match what you’re looking for, enter any of the words in the name.
You can also search for the account using the contact name, city, or other related information. You can also search by a
combination of attributes, such as a word in the name and the city where the account is located.

If you're creating an opportunity in the classic Sales UI, you must click Search in the Account field drop-down list and
then select the contains operator for the account name to be able to search by any of the words in the account name.

How do I manage export objects?  
Export objects correlate with tables in Oracle Applications Cloud. Understand export objects and their attributes to
manage the data that you want to export.

Supported Objects
You can export these objects and their child objects using Export Management:

• Access Groups

• Account

• Action

• Action Plan

• Activity

• Asset

• Assignment Rule Candidate

• Assignment Rule Condition

• Assignment Rule

• Assignment Rule Set

• Business Plan

• Campaign

• Case

• Compensation Plan

• Compensation Plan Component

• Compensation Plans Flex

• Competitor

• Contact
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• Contract

• Contests

• Deal Registration

• Duplicate Resolution Request

• Geographies*

• Goals

• Household

• HRHelpDeskRequest

• Hub Source System Reference

• Inbound Message

• Incentive Compensation Performance Measure

• Incentive Participant

• Incentive Participant Goal

• Incentive Participant Role Assignments

• Interaction

• Interaction Participant

• KPI

• Linked Party

• MDF Budget

• MDF Claim

• MDF Request

• Nonduplicate

• Note

• Objective

• Opportunity

• Organization

• Partner

• Partner Programs

• Performance Measure Flex

• Performance Measure Rate Dimensional Input

• Performance Measure Score Card

• Plan Component

• Plan Component Flex

• Plan Component Performance Measure

• Plan Component Rate Dimensional Input

• Plan Component Rate Table

• Price Book Header

• Product

• Product Group
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• Program Enrollments

• Promotion

• Queue

• Relationship

• Resolution Link

• Resolution Request

• Resource

• Resource Capacity

• Sales Forecast Quota

• Sales Lead

• Sales Orders

• Sales Territory

• Sales Territory Quota

• Self-Service Role

• Service Request

• Standard Lookups

• Standard Text

• Standard Text Folder

• Standard Text User Variable

• Subscription

• Template

• Territory Geographies. For more information see Export Territory Geography Zone Hierarchies? (Doc ID
2853475.1) on My Oracle Support.

• Transaction

• Trees

• Wrap Up

Note:  Legal Note: By exporting the Geographies data from the Oracle environment to Your environment, You agree
that (a) Oracle is granting You only a restricted right to download the exported Geographies data specifically for Your
use with the Oracle Fusion services; (b) the Geographies data may not be used, transferred, or uploaded for any other
purposes; and (c) except for the restricted right granted in (a), all provisions of the Oracle Cloud Services Agreement
(CSA) or Schedule C, as applicable to You, remain in full force and effect, including specifically section 3.4 thereof.

Export Object Details
Click Tools > Export Management > Export Objects. To see the details of an export object, select it on the Export
Object Details page. Here are the details that you see about each exportable object:

Column Description

Display Name
 

The object as it's called in the user interface.
 

232

http://support.oracle.com


Oracle Fusion Cloud Sales Automation
Sales Questions and Answers

Chapter 1
Sales Questions and Answers

Column Description

Language Independent Code
 

The internal name of the object.
 

Parent Object
 

The parent object of the selected object. If there are multiple parents for an object, they're shown
separated by commas.
 

View Hierarchy
 

Clicking on the View Hierarchy icon shows the hierarchy between the parent and child objects in a
graphical format.
 

User Key
 

The attribute or the group of attributes that's used to uniquely identify a record.
 

Required Attributes
 

The attribute or the group of attributes for which values are required to create a record. These can't be
NULL when updating a record.
 

Target Attributes
Here are the details that you see for each target attribute.

Column Description

Display Name
 

Name of the target attribute in the user interface.
 

Attribute Name
 

Internal or field name of the attribute.
 

Required
 

Indicates whether the attribute is mandatory or not.
 

Default Value
 

The default value for the attribute, if any.
 

Type
 

Data type of the target attribute.
 

Length
 

Maximum allowed length for the target attribute values.
 

Description
 

A short description of the target attribute.
 

Export Inactive and Merged Data
You can export inactive and merged accounts, contacts, households, organizations, and persons using export
management. You don't need to rely on data model queries to fetch the deleted or merged records.

Note:  To export inactive records, you need to explicitly add the condition to the criteria, or else only the active records
will be exported. For example, I for Inactive and M for merged. All associated child records (active or inactive) will be
exported irrespective of their status, if no criteria is added.
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How do I get sales quotes to work in CX Sales Mobile?  
You must complete two setups listed in this topic. After you complete them, sales representatives can quickly access
Oracle Configure, Price, and Quote (Oracle CPQ) quotes related to their accounts and opportunities from Oracle CX Sales
Mobile. Additionally, they can share the proposal document with the team for feedback, or email proposals to customers
from the mobile app to speed up the negotiation cycle.

Here are the two steps you must complete to provide access to quotes in CX Sales Mobile:

1. Create a confidential application for CX Sales Mobile in Oracle Identity Cloud Service.

Note:  If you already completed this step, you can just edit the application you created previously and add the
new information. You don't have to create a new application.

2. Display the quotes and lists of quotes in the CX Sales Mobile UI.
Prerequisites: Before you start, you must complete all the steps to integrate Oracle Sales and Oracle CPQ. For details,
refer to the Integrating Oracle CX Sales with Oracle CPQ guide and the Quotes and Orders chapter in Implementation
Reference guide.

Create a Confidential Application for Oracle CX Sales Mobile in Oracle
Identity Cloud Service
Here's how you create CX Sales Mobile as a Confidential Application in Identity Cloud Service:

1. Sign in to My Console in Identity Cloud Service, by navigating to www.oracle.com > View Accounts and
enter the name of the relevant pod in the Cloud Account Name field. You have at least two pods, a test and a
production pod, so ensure that you enter the correct pod.

2. Click Next and enter your Identity Cloud Service password. If you can't remember the password, contact Oracle
Support for help.

Note:  For more information about Identity Cloud Service, navigate to https://docs.oracle.com, search for
Identity Cloud Service, and click Oracle Identity Cloud Service - Get Started.

3. In the Identity Cloud Service console, expand the Navigation Drawer, and then click Applications.
4. Click Add. Then on the Add Application page, click Confidential Application.
5. In the Details tab of the Add Confidential Application wizard, enter information in the Name and Description

fields. These fields are used to identify the Confidential Application in Identity Cloud Service only, they don't
appear outside of Identity Cloud Service. For example, they don't appear in the Oracle CX Sales app.

6. Click Next.
7. In the Client tab, click the Configure this application as a client now option.
8. In the Allowed Grant Types options list, select these options:

◦ Refresh Token

◦ Authorization Code

9. Select the Allow non-HTTPS URLs option.

Note:  This option doesn't open a URL that isn't secure, it just sends a request to the CX Sales Mobile app.

10. In the Redirect URL field, enter cxm://?oAuth=true
11. Click Next.
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12. In the Resources tab, enter a value in the Access Token Expiration field. This defines how long the access
token associated with CX Sales Mobile remains valid.

13. Select the Is Refresh Token Allowed option and enter a value in the Refresh Token Expiration field. This
defines how long the access token can be refreshed until the sales representative needs to sign into the CX
Sales Mobile app again.

When an access token expires, the CX Sales Mobile app uses a valid refresh token to get a new pair of access
and refresh tokens. If the refresh token isn't valid, or has expired, the sales representative has to sign in again.
If the refresh token is valid the CX Sales Mobile app uses it to get a new access token, which is used to validate
subsequent access to the app.

Note:  It's recommended to keep the access token validity to a short duration and the refresh token to a long
duration. For example, 30 minutes for the access token and 7 days or more for the refresh token.

14. In the Primary Audience field, add your host URL.
15. In the Secondary Audience field, fill in your CPQ domain (for example, https://xxxx-xxx.bigmachines.com).
16. In the Scopes section, click Add, and enter the value /cxmobile.
17. In the Scopes section, click Add, and your CPQ scope. The CPQ scope will be in the form <CPQ_domain>/api

(for example, https://xxxx-xxx.bigmachines.com/api)
18. Under Resources, select Add Scope.
19. Select the Resource Client Oracle Applications (Fusion), which is the available resource provided by Oracle.
20. Add all required scopes from the resource client, including the CX Sales Mobile and CPQ scopes you just

created.
21. Click Next to navigate to the Web Tier Policy tab. Nothing needs to be entered here.
22. Click Next to navigate to the Authorization tab. Nothing needs to be entered here.
23. Click Finish. The CX Sales Mobile application has been added in a deactivated state.
24. Record the Client ID and Client Secret that appear in the Application Added dialog box. The Client ID and

Client Secret are equivalent to a credential (for example, an ID and password) that your application uses to
communicate with Identity Cloud Service.

25. Click Close.
26. At the top of the page, to the right of the application name, click Activate.
27. In the Activate Application? dialog box, click Activate Application.

For more information about creating a Confidential Application, navigate to https://docs.oracle.com, search for Identity
Cloud Service, click Oracle Identity Cloud Service - Get Started, and click Manage confidential Applications under
the Manage Applications heading.

Display Quotes and Quote Lists in the Mobile App
1. Enable Quote lists in the Navigator to display the Quote and Orders saved searches setup in Workspace:

Note:  These steps are optional. You only need to enable Quotes lists in the Navigator if you want your users
to have access to all of their quotes in aggregate.

a. Enter a sandbox with Application Composer and click to Application Composer > Mobile Application
Setup.

b. Click the CX Sales Mobile Composer tab.
c. In the Application Features pane, click Home.
d. Scroll down in the mobile interface designer pane and select the Quotes and Orders feature.
e. In the Feature Details, toggle Show On Navigator to On.

2. Quotes and Orders are enabled by default in the summary views of Accounts and Opportunities. If associated
quote records exist for the parent records, then quote pickers appear in the Account and Opportunity Summary
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pages automatically. However, if you created page layouts before Update 21C and you want quotes to appear in
these pages, then you need to enable quotes by following these steps:

a. In Summary view of the Accounts feature, select your custom page layout.
b. In the mobile interface designer pane, select Add Child or Related.
c. From the list of options, select SalesOrders.
d. Repeat these steps for your Opportunity Summary page layouts.

3. Click Save.
4. Test and publish your configurations.

How can I use Sales as my SSO provider with CPQ?  
When integrating with Oracle Configure, Price, and Quote (Oracle CPQ), you can set up Sales as a Service Provider (SP)
or as an Identity Provider (IdP).

To set up Sales as the IdP, you need to use Oracle Identity and Access Management (IAM)'s Identity Domains (formerly
IDCS) as follows: Sales (IdP) < IAM Identity Domains (SP, IdP) < CPQ (SP).

By default, every Sales environment is configured as an IdP to IAM Identity Domains instance as an SP.

When integrating with Oracle CPQ, IAM Identity Domains can be the IdP for Oracle CPQ as SP. You need to configure the
implementation as described in the Oracle CPQ section of the Oracle Identity Cloud Service - Application Catalog: IDCS
SSO Setup for CPQ. Also see the Single Sign-On (SSO) section of the Oracle CPQ online help.

Additionally, see How To Configure SSO For CX Sales To CPQ Integration (Doc ID 2680045.1) on My Oracle Support.

What are the advantages of integrated apps?  
When you run your business on a connected suite of Oracle applications, your entire organization can operate on a
single point of truth. Because a connected applications suite provides common data elements, a common workflow
engine, and a consistent user interface, you see the benefits of integrating the underlying technologies across your
business applications.

You can find more benefits of an integrated suite of applications in The Synergies of Unified Data.

How do I copy custom fields from one object to another?
 
Here's how you can copy custom fields from one object to another. In this example, we'll create a custom field in the
Account object and copy it to the Subscription object.

Note:  Access to a sandbox and Application Composer are required in this procedure.
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1. Begin by creating a custom field for the Account object: Navigate to Application Composer > Account >
Fields.

2. For this scenario, we're using a fixed choice list, so create a fixed choice list and set its list of values. Take note of
the API Name since we'll use this later in this procedure.

3. Next, navigate to Pages > Application Pages.
4. Select the Edit Organization Details Region in the Details Page section.
5. Using the Available Fields list, highlight your recently created field and move it to the Selected Fields list.
6. Save and close and page.
7. Let's move on to the Subscription object: Look for it under the Standard Objects list and expand it.
8. Select Fields and create a new, custom field. We're using a simple text object, so make sure that it can hold the

length of the values for the fixed choice list.
9. Navigate to Pages and select the Details Page Layout. Duplicate the standard layout and edit the copy.

10. Click the pencil icon near Edit Subtab: Summary.
11. Using the Available Fields list, highlight your recently created field and move it to the Selected Fields list.
12. Now let's create a trigger: Begin by selecting Server Scripts Triggers.
13. In the Triggers field, create a new trigger and set these values:

◦ Trigger Name: Name the trigger something easy to remember, like PartyChange.

◦ Field Name: Name the field PrimaryPartyId.

◦ In the Trigger Definition use this sample code:
def org = newView('OrganizationProfile');
def view_Criteria = newViewCriteria(org);
def view_criteria_row = view_Criteria.createRow();
def view_condition = view_criteria_row.ensureCriteriaItem('PartyId');
view_condition.setOperator('=');
view_condition.setValue(PrimaryPartyId);
view_Criteria.insertRow(view_criteria_row);
org.appendViewCriteria(view_Criteria);
org.setMaxFetchSize(1);
org.executeQuery();

if(org.hasNext())
{
 def o = org.next();
 setAttribute('*REPLACE WITH ATTRIBUTE NAME OF CUSTOM SUBSCRIPTION FIELD *',o.*API Name for the
 Custom field in Account*)
 //For example
 //setAttribute('MyCustomSubText_c',o.CustomFCLTest_c)

14. Save your changes and test the change: Go to Setup and Maintenance and search for the Manage Customers
task.

15. Search for and select an organization and verify that the custom fixed choice list you created is available in the
organization information page.

16. Select a value, save your changes, and close the page.
17. Go to Subscription Management and create a new subscription.

Be sure to select the customer from the previous organization that you queried in the Manage Customers task.
18. In the Overview page, you should see the custom field for Subscription Management with the previously

selected value.

Can I rename a custom role in an access group?  
No, you can't. Make note of the name you give any custom roles in access groups so you can refer to them later if
needed.
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How do I set up VAT or other tax policies for CX?  
VAT and other tax-related setups for CX are done in the Oracle ERP applications, such as Oracle Financials; the
application you use depends on your configuration. On Oracle Help Center, search using keywords for what you need,
such as "VAT" or "tax".

What's the purpose of the Manage Message Templates
functionality introduced in release 23B?  
Using the Message Templates selection in Application Composer, you can create and manage email templates. Both
salespeople and automated processes in Orchestration can use the templates to send outgoing emails. You create the
templates for a specific object and can include attributes from that object as mail-merge fields. Salespeople who are
using the template to send emails to customers can modify the text, and add their signatures and attachments.

Note:  Use Message Templates. The Email Templates selection in Application Composer is a different feature entirely.

What's a foldout subview and what new search
functionality was introduced in 23B?  
Foldout subviews are the pages you can open from the record overviews in the new Sales in the Redwood user
experience, by clicking a link at the bottom of the record overview panels. Whereas each panel on the record overview
shows only the most important information, the subviews list them all. For example, the Contacts panel on an account
record may display only three contacts, but clicking the View All Contacts link displays a subview (All Contacts page) that
lists all the contacts. The new feature makes it possible to search for records in these lists using filters.

You can filter and search through the information on the Contacts, Accounts, Opportunities, and other the"All" pages in
a record provided that the pages include the Action Bar. Which attributes you can filter and search on depends on the
information type. If you added custom objects, you can filter on all of its attributes.

1. In the Action Bar, enter filter and select a filter. For example, on the All Contacts Page, you can filter on Name,
Primary Email, Comments, and Contact Job Title.

Note:  You can’t filter on all of the common attributes, just on those listed. For example, you can’t filter
opportunities by sales stage. And you can’t filter team resources by their role.

2. Select the operator.
3. Enter a search term in the Value field. You can enter only one keyword. Searches aren't case-sensitive and no

operators are permitted.
4. Click Apply.
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5. You can add additional filters.
Here’s a screenshot of the Contacts page for an account with the Name filter applied, and Contains operator selected.
Nelson is the search term entered in the Value field.

What's Next Gen Sales?  
Next Gen Sales and Digital Sales are other names sometimes used for Sales in the Redwood user experience, a
new conversational interface that's been built for Oracle Sales. The Redwood user experience includes many new
features that aren't available in the previous version of the product. For example, the Redwood UX makes it possible for
salespeople to interact with the application using natural language and chat bots. Sales administrators can boost sales
performance by setting up motivational goals and contests and by walking salespeople through best sales practices for
different sales situations using the Orchestration feature.

The new Redwood user experience gives virtual sellers the ability to search, find, and navigate their accounts with
simple commands. Unlike other CRMs that rely on hidden tabs and buttons within a record, sellers simply tell the
assistant what they need to do and the new virtual sales capability recommends the next best action—helping them
convert leads, engage prospects, and update records with a few simple, intuitive keystrokes.

Can I delete a custom subtab that was added to the
classic UI?  
In the classic UI, you can't delete a custom tab after your sandbox is published, but you can hide it.
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Here's how:

1. Create and enter a sandbox with Application Composer as one of the tools.
2. In Application Composer, select the object.
3. Expand the object in the object tree, and select the Pages node.
4. Select the Application Pages tab.
5. Find the type of page that you want to modify, such as the details page layout. You can create a new custom

layout by clicking the Duplicate Layout icon to duplicate and edit an existing layout.
6. In the layout Subtabs region, click the Hide, Show, and Reorder button (the icon with the two vertical up and

down arrows)
7. Hide the subtab.
8. Click Done.
9. Publish the sandbox.

Can I increase BI Publisher output to CSV beyond the
maximum setting of 2 million records?  
The default maximum number of rows for CSV output from BI Publisher is 1,000,000, although if required, you can
download up to 2,000,000 rows to a spreadsheet. Downloading more than 2,000,000 rows, however, can lead to
degradation of services and potential issues with BI Publisher reporting capabilities. BI Publisher is meant for creating
documents. If you require to extract larger numbers of records, consider using Oracle Business Intelligence Cloud
Connector (BICC).

For more information on configuring your BI Publisher settings, see the topic How do I optimize BI Publisher settings to
reduce issues with runtime memory and data export?

Related Topics
• Overview of Business Intelligence Cloud Connector

How do I optimize BI Publisher settings to reduce issues
with runtime memory and data export?  
You can optimize BI Publisher settings in the administrative console of BI Publisher. Oracle recommends updating the
configuration settings if you're facing runtime memory errors or issues with exporting reporting data. Setting your
configuration above our recommendations can lead to degradation of services and potential issues with BI Publisher
reporting capabilities.

To make updates, sign in to the XMLPServer as a user with administrator permissions and navigate to:

• ◦ Administration > Runtime Configuration  > Properties > Memory Guard & Data Model

You can update the following configurations settings:

• Maximum Report Data Size for Online Reports

◦ Default Configuration is 300MB
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◦ Configuration can be updated up to 1GB

• Free Memory Threshold

◦ Default Configuration is 500MB

◦ Configuration can be updated up to 2GB

• Maximum Rows for CSV Output

◦ Default Configuration is 1,000,000 rows

◦ Configuration can be updated up to 2,000,000 rows

• Maximum Data Size Limit For Data Generation

◦ Default Configuration is 500MB

◦ Configuration can be updated up to 2GB

• SQL Query Timeout

◦ Default Configuration is 600 (seconds)

◦ Configuration can be updated up to 1800 (seconds)

In SQL, how do I show a date in the date format: 19 July
2023?  
Here's a SQL select statement and output to show a date in a format 19 July 2023.

SQL select statement : SELECT TO_CHAR(SYSDATE, 'DD MONTH YYYY') FROM DUAL

Output: TO_CHAR(SYSDATE,'DDMONTHYYYY').

Can we change the file type and delimiter for BI Cloud
Connector (BICC) extracts?  
No. You can't change either the file type or delimiter. You can extract data only in the CSV format.

To support parsing of the comma-separated value files, column values are wrapped in double quotes. The double quote
value in the column is escaped using two consecutive double quote values. Because of this, a custom delimiter isn’t
required.

Related Topics
• Manage Files in External Storage for Custom Warehouse Integration
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Why are users with my custom role for OTBI not able to
see sales data in OTBI reports?  
Sales data access depends on the resource and sales territory hierarchies the salesperson is in, regardless of the role. If
a salesperson or manager isn't on a sales team or territory hierarchy and they don't manage people who are, they won't
be able to see any opportunity or lead information.

How do I make custom PVOs visible in BICC?  
In order to make a custom public view object (PVO) visible in BICC, you must first include the PVO in one of the
offerings. You can then extract the data for that custom PVO through BICC.

To add a custom PVO to an offering:

1. Sign in on your BICC: https://<HOST>/biacm.
2. From the menu on the right, select Manage Offerings and Data Store.
3. Drill down on any offering to open the data store Offering: <offering name> page.
4. Click Add (the plus sign icon).
5. In Data Store Key, click the button Search Extensions.
6. Search for your custom VO. For example, if the custom object is Claims_c, then the PVO to be called is

CrmAnalyticsAM.ExtensibilityAM.Claims_c.
7. Select the PVO.
8. Select the offering you want to associate the VO with.
9. Click Done.

How do I hide an OTBI file path in the browser address
bar to enhance security?  
You can mask the OTBI file path location shown on browser address bar by creating a dynamic URL for your reports.

For details, see See the Oracle Support Document 2453010.1 (How to create a dynamic URL for BIP reports, which will be
generated dynamically based on input from an external application?)

How can I migrate an analysis or dashboard from one
Fusion application environment to another?  
You can copy analyses and dashboards from one environment to another using the Archive and Unarchive commands
in BI Answers.

242

https://support.oracle.com/epmos/faces/DocumentDisplay?id=2453010.1
https://support.oracle.com/epmos/faces/DocumentDisplay?id=2453010.1


Oracle Fusion Cloud Sales Automation
Sales Questions and Answers

Chapter 1
Sales Questions and Answers

For details see Oracle Support Document 1943582.1 (Fusion Applications OBIEE :How Do We Migrate an Analysis or
Dashboard from One Fusion Applications Environment to Another? )

Can I see prior changes to a field after I've added it to the
application?  
No, you can't. Audit history (also called change history) for a field only shows up in audit results after it's been added to
the application.

See What fields can I audit for Sales? for details on the supported objects and how to enable change history in the
application.

Is any data stored on the local machine when installing
the Outlook add-in?  
No data is stored on the local machine when users install the Microsoft Outlook add-in.

What do I do when I get a data store is inactive message
while integrating BICC with Fivetran?  
Check that the user is provisioned with the appropriate BICC UCM roles and has the role:
OBIA_EXTRACTTRANSFORMLOAD_RWD.

You can also confirm the role in UCM. Sign in to UCM, go to the right corner, and click your user name.

Can I create a custom subject area from a custom data
model in BI publisher?  
You can only create a custom subject area from the objects that are available in Application Composer. Joins that you've
build on your custom SQL may or may not be available during custom subject area creation, depending on how the
objects you're using are related. So, it will really depend on what custom SQL you're using on your data model.

In addition, data models aren't likely to use data security so they don't have any restrictions. By contrast, custom subject
areas apply data security according to the roles and access granted from the application.
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How do I create an analysis report for Lead Source?  
Try "Lead" and "Channel Type Name" from the Marketing - CRM Leads subject area.

How do I make custom dynamic choice fields (DCLs)
visible in analytics?  
You add custom dynamic choice list fields (DCLs) to custom subject areas. Here's how.

1. Navigate to Application Composer.
2. Click Custom Subject Areas on the Overview page of Application Composer.
3. Select Create from the Actions menu.
4. In Define Custom Subject Area, provide the name for your subject area and select the primary object. Display

labels have the Custom: prefix added automatically.
5. In Select Child Objects, add the child object.
6. In Configure Fields, add the DCL as follows:

a. Click Select Fields.
b. In the Select Fields window, select the Related Object option and select the object with the DCL.
c. Move the DCL field from the Available Fields list to the Selected Fields column.

7. Optionally, in Configure Dates, select one or more date columns for date leveling.

Date leveling lets you add calendar attributes to your analytics, which provide better context to your transaction
data.

You can also select one date field to be the canonical date for the custom subject area. Do this if you want to
create analytics that can drill up and down the date hierarchy.

8. In Configure Security, select the required security level for the Everyone Role Name, which is added by default.
You can add additional role names by clicking in the + icon and define the security level for each one of them.

The security definition here only controls who can access the custom subject area definition to create reports. It
doesn't control data visibility which is automatically controlled based on the user running the reports.

9. In Review and Submit, review the custom subject area configuration for all added objects, attributes, and
measures and click Submit.

After you submit, the custom subject area is published and made available within Oracle BI Composer. After
you save or submit a custom subject area, you can't modify its primary object.
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Which subject area can I use to create an analysis that
shows the resource roles assigned to the resources
within the internal resource organization hierarchy?  
Use the Sales - CRM Resource subject area, The resource role is an attribute in the Employee/Resource folder and it is
called "Employee Job Title Name". The resource role is also shown in Resource Hierarchy as <level> Position Name.

How do I create a report on fields on an object, such as a
contact, that are filled or not?  
Use the sample SQL query as a starting point.

1. Click Create New Analysis and select last option: Create Analysis from Simple Logical SQL.
2. Paste the sample query below:

SELECT

 0 s_0,

 (filter(sum("Sales - CRM Contacts"."Contact Fact"."# of Contacts") using "Sales - CRM
 Contacts"."Contact"."Email Address" is not null)/sum("Sales - CRM Contacts"."Contact Fact"."# of
 Contacts"))*100 s_1,

 (filter(sum("Sales - CRM Contacts"."Contact Fact"."# of Contacts") using "Sales - CRM
 Contacts"."Contact"."Email Address" is null)/sum("Sales - CRM Contacts"."Contact Fact"."# of
 Contacts"))*100 s_2,

 filter(sum("Sales - CRM Contacts"."Contact Fact"."# of Contacts") using "Sales - CRM
 Contacts"."Contact"."Email Address" is not null) s_3,

 filter(sum("Sales - CRM Contacts"."Contact Fact"."# of Contacts") using "Sales - CRM
 Contacts"."Contact"."Email Address" is null) s_4,

 sum("Sales - CRM Contacts"."Contact Fact"."# of Contacts") s_5

FROM "Sales - CRM Contacts"

3.
Here's a sample output:
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How do I manage geography validation?  
After defining the geography hierarchy, you need to specify the structure for the country.

You can choose which address style format you would like to use for the country, and for each selected address style
format you can map geography types to address attributes. You can also select which geography types to include in
address validation or tax validation, and which geography types will display in a list of values during address entry in
other user interfaces. The geography validation level for the country, such as error or warning, can also be selected.
Geography validation determines the geography mapping and validation for a country's address styles, and the overall
address validation control for a country.

The No Styles Format address style format is the default address style format for a country. By defining the mapping
and validation for this format you will ensure that validations can be performed for any address in the country. After the
No Styles Format is defined you can set up additional mapping for specific address styles.

For each address style format, you can define the following:

• Map to attribute

• Enable list of values

• Tax validation

• Address validation

• Address validation control

Attribute Mapping
For every address style format, you can map each geography type to an address attribute. For example, you can
map the State geography type to the State address attribute for the United States, or map the State geography type
to the County address attribute for the United Kingdom. The geography types that appear are based on how the
country structure is defined. The list of address attributes that appear are based on address formats delivered with the
application, or your customer defined address formats.

Note:  You only need to map geography types that you want to use for address or tax validation purposes.

Enable List of Values
Once a geography type is mapped to an attribute, then you can specify whether the geography type will appear in a
list of values during address entry in user interfaces. It is very important to review carefully if you want to enable a list
of values. You should only enable a list of values if you have sufficient geography data imported or created for that
geography. If the setup for master geography data is incomplete, then the geography data is either not imported or
created. As a result, the list of values for the address attribute doesn't list any geography data.

Once you have enabled a list of values for an address attribute, you can only select the geography data available for the
geography type. This means that if a specific geography value isn't available in the geography hierarchy, you can't create
an address with a different geography value.

Note:  Enable List of Values applies to the UI only. It doesn't apply to import, web services, nor REST APIs. For these,
all of the required geography types must have a value in the request when creating or updating an address.
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Tax Validation
You can also specify whether a geography type will be included in tax validation. For example, for the United States
North America address style format you specify that County, State, and City are used for tax validation. This will mean
that when a transaction involves an address with the North America address style, the address must have the correct
county, state, and city combination based on the geography hierarchy data, to be considered valid for tax calculation.

Address Validation
You must set up address validation for those geography elements that you plan to use in your application. Address
validation checks whether geography elements of an address such as state, city, postal code, and soon are valid as per
master geography data. Setting up validation also helps ensure that the addresses are correct and deliverable during
entry. You can select states or other address elements from lists to ensure accuracy during entry. For example, when
you enter a postal code, the application can validate if the postal code exists. Note that address validation isn’t the same
as address verification. Address Verification updates and enhances your address. Address verification depends upon
Oracle or any third-party address verification services to perform verification.

You can specify whether a geography type will be included in address validation. For example, when the user enters a
United States address using the North American address style format, the address must have the correct country, state,
and postal code combination based on geography hierarchy data to be considered geographically valid.

If an address element is mapped to a geography type, but not selected for geography validation usage, then during
address entry suggested values are provided for the address element, but the address element isn't validated.

You need to verify that the default mapping between Geography Type and Map to Attribute is valid in the Geography
Mapping and Validation region and update it if required when you define geography validation.

After setting geography validation, all features that directly and indirectly depend upon geographies are impacted. For
example, multiple applications such as ERP, CX, and SCM that use geographies are impacted.

Oracle recommends that you use the following valid mapping for the countries that Loqate supports:

Country Name Country Code Geography Type Map to Attribute

Andorra
 

AD
 

• Country

• Parroqia

• Settlement

• Postal Code

• Country

• State

• City

• Postal code

Angola
 

AO
 

• Country

• Provincia

• Municipio

• Comuna

• Localidad

• Country

• Province

• County

• City

• Additional address
attribute 2

Argentina
 

AR
 

• Country

• Province

• Department

• Municipality

• Country

• Province

• County

• City
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Country Name Country Code Geography Type Map to Attribute

• Postal Code • Postal code

Australia
 

AU
 

• Country

• State

• City

• Postal Code

• Country

• State

• City

• Postal code

Austria
 

AT
 

• Country

• Bundensland

• Bezirk

• Gemeinde

• Postal Code

• Country

• State

• County

• City

• Postal code

Belgium
 

BE
 

• Country

• Gewest

• Provincie

• Gemeente

• Postal Code

• Country

• Additional address
attribute 1

• Province

• City

• Postal code

Bolivia
 

BO
 

• Country

• Departmento

• Provincia

• Canton

• Country

• Additional address
attribute 1

• Province

• City

Bosnia and Herzegovina
 

BA
 

• Country

• District

• Kanton

• Opcine

• Nasalje

• Postal Code

• Country

• Additional address
attribute 1

• Province

• County

• City

• Postal code

Brazil
 

BR
 

• Country

• State

• City

• Postal Code

• Country

• State

• City

• Postal code

Bulgaria
 

BG
 

• Country

• Oblast

• Obshhina

• Settlement

• Country

• Additional address
attribute 1

• Province

• City
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Country Name Country Code Geography Type Map to Attribute

• Postal Code • Postal code

Canada
 

CA
 

• Country

• Province

• City

• Postal Code

• Country

• Province

• City

• Postal code

Cayman Islands
 

KY
 

• Country

• Island

• District

• Postal Code

• Country

• State

• City

• Postal code

Chile
 

CL
 

• Country

• Region

• Provincia

• Kommune

• Postal Code

• Country

• State

• County

• City

• Postal code

China

Note:
China geography structure is
supported but geocoding isn't
supported.
 

 

CN
 

• Country

• Province

• City

• Postal Code

• Country

• Province

• City

• Postal code

Croatia
 

HR
 

• Country

• Zupanije

• Grad

• Postal Code

• Country

• Province

• City

• Postal code

Cuba
 

CU
 

• Country

• Provincia

• Municipio

• City

• Postal Code

• Country

• Province

• County

• City

• Postal code

Cyprus
 

CY
 

• Country

• Periochi

• Dimos

• Postal Code

• Country

• Province

• City

• Postal code

Czech Republic
 

CZ
 

• Country

• Kraj

• Country

• State
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Country Name Country Code Geography Type Map to Attribute

• Okres

• Obec

• Postal Code

• County

• City

• Postal code

Denmark
 

DK
 

• Country

• Amt

• Settlement

• Postal Code

• Country

• Province

• City

• Postal code

Dominican Republic
 

DO
 

• Country

• Provincia

• Municipio

• Town

• Postal Code

• Country

• Province

• County

• City

• Postal code

Ecuador
 

EC
 

• Country

• Province

• Canton

• City

• Postal Code

• Country

• Province

• County

• City

• Postal code

Estonia
 

EE
 

• Country

• Maakond

• Vald

• Postal Code

• Country

• State

• City

• Postal code

Finland
 

FI
 

• Country

• Laani

• Kunta

• Postal Code

• Country

• State

• City

• Postal code

France
 

FR
 

• Country

• Region

• Department

• Commune

• Postal Code

• Country

• Additional address
attribute 1

• State

• City

• Postal code

Germany
 

DE
 

• Country

• Bundesland

• Gemeinde

• Postal Code

• Country

• State

• City

• Postal code
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Country Name Country Code Geography Type Map to Attribute

Great Britain
 

GB
 

• Country

• County

• Township

• Postal Code

• Country

• State

• City

• Postal code

Greece
 

GR
 

• Country

• Periferia

• Nomi

• Dimotika

• Postal Code

• Country

• State

• County

• City

• Postal code

Guadalupe
 

GP
 

• Country

• Commune

• Postal Code

• Country

• City

• Postal code

Guam
 

GU
 

• Country

• State

• County

• Municipality

• Village

• Postal Code

• Country

• State

• County

• City

• Additional address
attribute 2

• Postal code

Guernsey
 

GG
 

• Country

• City

• Parishes

• Villages

• Postal Code

• Country

• City

• Additional address
attribute 2

• Additional address
attribute 3

• Postal Code

Hungary
 

HU
 

• Country

• Megye

• Jaras

• Telepules

• Settlement

• Postal Code

• Country

• Additional address
attribute 1

• Province

• County

• City

• Postal code

Iceland
 

IS
 

• Country

• Jaras

• Telepules

• Settlement

• Country

• Province

• County

• City
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Country Name Country Code Geography Type Map to Attribute

• Postal Code • Postal code

India
 

IN
 

• Country

• State

• City

• Postal Code

• Country

• State

• City

• Postal code

Indonesia
 

ID
 

• Country

• Province

• Regency

• City

• Postal Code

• Country

• Province

• County

• City

• Postal code

Ireland
 

IE
 

• Country

• Province

• Post County

• Postal_Code

• Country

• State

• City

• Postal Code

Isles of Man
 

IM
 

• Country

• Locality

• Settlement

• Postal Code

• Country

• City

• Additional address
attribute 2

• Postal code

Israel
 

IL
 

• Country

• District

• Subdistrict

• City

• Postal Code

• Country

• State

• County

• City

• Postal code

Italy
 

IT
 

• Country

• Regione

• Provincia

• Comune

• Postal code

• Country

• Additional address
attribute 1

• Province

• City

• Postal code

Jamaica
 

JM
 

• Country

• Parish

• Settlement

• Country

• State

• City

Japan
 

JP
 

• Country

• Prefecture

• Country

• State
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Country Name Country Code Geography Type Map to Attribute

• City

• Postal Code

• City

• Postal code

Jordan
 

JO
 

• Country

• Muhafazat

• Liwa

• Tajma

• Postal Code

• Country

• State

• County

• City

• Postal code

Kenya
 

KE
 

• Country

• County

• Division

• Settlement

• Country

• State

• City

• Additional address
attribute 2

Latvia
 

LV
 

• Country

• Rajons

• Pilseta

• Postal Code

• Country

• State

• City

• Postal code

Liechtenstein
 

LI
 

• Country

• Wahlkreis

• Gemeinde

• District

• Postal Code

• Country

• Additional address
attribute 1

• State

• City

• Postal code

Lithuania
 

LT
 

• Country

• County

• Municipality

• Ward

• Postal Code

• Country

• State

• County

• City

• Postal code

Luxembourg
 

LU
 

• Country

• Canton

• Commune

• Settlement

• Postal Code

• Country

• State

• County

• City

• Postal code

Malaysia
 

MY
 

• Country

• State

• District

• Subdistrict

• Country

• State

• County

• City
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Country Name Country Code Geography Type Map to Attribute

• Postal Code • Postal code

Malta
 

MT
 

• Country

• Region

• Local Council

• Postal Code

• Country

• State

• City

• Postal code

Martinique
 

MQ
 

• Country

• Department

• Arrondisement

• Commune

• Postal Code

• Country

• State

• County

• City

• Postal code

Mexico
 

MX
 

• Country

• State

• Municipality

• Locality

• Postal Code

• Country

• State

• County

• Additional address
attribute 2

• Postal code

Netherlands
 

NL
 

• Country

• Province

• Municipality

• Town

• Postal Code

• Country

• Province

• County

• City

• Postal code

New Zealand
 

NZ
 

• Country

• Region

• Town

• Postal Code

• Country

• State

• City

• Postal code

Norway
 

NO
 

• Country

• Fylke

• Kommune

• Postal Code

• Country

• Province

• City

• Postal code

Oman
 

OM
 

• Country

• Muhafazah

• District

• City

• Country

• State

• County

• City

Peru
 

PE
 

• Country

• Region

• Country

• Province
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Country Name Country Code Geography Type Map to Attribute

• Provincia

• Distrito

• Postal Code

• County

• City

• Postal code

Poland
 

PL
 

• Country

• Wojewodztwo

• Powiat

• Gmina

• Postal Code

• Country

• Province

• County

• City

• Postal code

Portugal
 

PT
 

• Country

• Distrito

• Concelho

• Settlement

• Postal Code

• Country

• Province

• County

• City

• Postal code

Puerto Rico
 

PR
 

• Country

• Commonwealth

• Municipio

• Barrio

• Postal Code

• Country

• State

• County

• City

• Postal code

Qatar
 

QA
 

• Country

• Municipality

• Zone

• Country

• State

• City

Reunion Island
 

RE
 

• Country

• Region

• Department

• Commune

• Postal Code

• Country

• State

• County

• City

• Postal code

Romania
 

RO
 

• Country

• Regiune

• Judet

• Settlement

• Comuna

• Postal Code

• Country

• Additional address
attribute 1

• Province

• County

• City

• Postal code

Russia
 

RU
 

• Country

• Federal_District

• Federal_Subject

• Country

• Additional address
attribute 1
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Country Name Country Code Geography Type Map to Attribute

• Oblast

• Postal Code

• State

• City

• Postal code

San Marino
 

SM
 

• Country

• Comune

• Postal Code

• Country

• State

• Postal code

Singapore
 

SG
 

• Country

• Region

• District

• Postal Code

• Country

• State

• City

• Postal code

Slovakia
 

SK
 

• Country

• Kraj

• Okres

• Obec

• Postal Code

• Country

• Province

• County

• City

• Postal code

Slovenia
 

SI
 

• Country

• Regija

• Upravna Enota

• Obcina

• Settlement

• Postal Code

• Country

• Additional address
attribute 1

• Province

• County

• City

• Postal code

South Africa
 

ZA
 

• Country

• Province

• District Municipality

• Local Municipality

• Postal Code

• Country

• Province

• County

• City

• Postal code

South Korea
 

KR
 

• Country

• Jibang

• Siti

• Postal Code

• Country

• State

• City

• Postal code

Spain
 

ES
 

• Country

• Autonomous Community

• Province

• City

• Postal Code

• Country

• Additional address
attribute 1

• Province

• City
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Country Name Country Code Geography Type Map to Attribute

• Postal code

Sri Lanka
 

LK
 

• Country

• Province

• District

• Divisional Secretariat

• Postal Code

• Country

• Province

• County

• City

• Postal code

Swaziland
 

Note:
This country maybe labeled
Eswatini in Manage Territories.
 

SZ
 

• Country

• District

• Inkhundla

• Town

• Postal Code

• Country

• Province

• County

• City

• Postal code

Sweden
 

SE
 

• Country

• Lan

• Settlement

• Postal Code

• Country

• Province

• City

• Postal code

Switzerland
 

CH
 

• Country

• Kanton

• Bezirk

• Gemeinde

• Postal Code

• Country

• State

• County

• City

• Postal code

Taiwan
 

TW
 

• Country

• County

• Town

• Postal Code

• Country

• State

• City

• Postal code

Thailand
 

TH
 

• Country

• Region

• Changwat

• Amphoe

• Postal Code

• Country

• Additional address
attribute 1

• State

• City

• Postal code

Tunisia
 

TN
 

• Country

• Governorate

• Delegation

• Postal Code

• Country

• State

• City

• Postal Code

Turkey
 

TR
 

• Country • Country
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Country Name Country Code Geography Type Map to Attribute

• Sehir

• Ilce

• Kasaba

• Postal Code

• Province

• County

• City

• Postal code

United Arab Emirates
 

AE
 

• Country

• Emirate

• City

• Area

• Country

• State

• City

• Additional address
attribute 2

United States
 

US
 

• Country

• State

• County

• City

• Postal Code

• Country

• State

• County

• City

• Postal code

Uruguay
 

UY
 

• Country

• Departamento

• City

• Postal Code

• Country

• State

• City

• Postal code

Vatican City
 

VA
 

• Country

• Municipal

• Settlement

• Postal Code

• Country

• Province

• City

• Postal code

Vietnam
 

VN
 

• Country

• Region

• Tihn

• Quan

• Thank Pho

• Postal Code

• Country

• Additional address
attribute 1

• Province

• County

• City

• Postal code

Note:  For either the tax or address validation, don't skip any level unless you're certain that the selected geography
types can uniquely identify geographies. For example, the United States country structure is: State, County, City,
and Postal Code, and you want to select just State and Postal Code for address or tax validation. However, for the
combination of California and 94065, the city can be either Redwood Shores or Redwood City. In this case, you should
also select at least the City geography type for address or tax validation.
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Address Validation Control
You can select the address validation level for a country. Validation will check if the entered address maps to the
geography hierarchy data available for the country, and the address validation control determines whether you can save
an address that didn't pass validation during address entry. For example, if the validation level is Error, then an address
can't be saved if the values don't match the geography hierarchy data.

These are the address validation levels you can choose:

• Error - only completely valid addresses can be saved, with all mandatory address elements entered.

• No Validation - all addresses can be saved including incomplete and invalid addresses.

Regardless of the result of validation, the validation process will try to map any address attribute to a geography of
the country, and store any mapping it could establish based on the available data. This is called  Geography Name
Referencing   and it's executed as part of validation. The result of this referencing is used in several business processes
in the application to map an address to a specific geography or zone. Therefore, Geography Name Referencing is
the process of validating and mapping address elements of existing location table records against master reference
geographies. For example, CA value in the STATE column of the HZ_LOCATIONS table is mapped to the master
reference geography of CA (California).

The Geography Dimension value in territories is derived from sell-to addresses of sales accounts. To use geography
dimensions in territories, you must validate the geography elements in the addresses, such as state, city, and postal
code. You can validate the address by enabling geography validation for each country using the Manage Geographies
task. Perform the following in the Manage Geographies task:

• Enable at least one level in the geography hierarchy for geography validation.

• Enable geography validation for all geography levels that you intend to use for territory definition for each
country.

• If needed, enable a list of values containing specific geography elements. This will help users search and select
appropriate geography values during addresses entry and eliminate all possibilities of wrong address entry.

You can set geography validation control to Error in the Manage Geography Validation page. This ensures that users can
only use valid geography elements in addresses.

Note:  If you have already created addresses before setting up address validation for a country, you must enable
geography validation and then execute the Validate Geographies of Addresses Against Master Geographies task for
that country. This validates all your geography elements.

Related Topics
• How do I validate geographies of addresses against master geographies and generate naming references?

• How can I save an address that didn't pass geography validation?

• Setting Up Geography Validation

Can I sync my Financials accounts with Sales?  
After users create accounts and contacts in Oracle Financials, use the scheduled process, Synchronize Financials Cloud
Accounts and Contacts, to sync the data into Oracle Sales. This process is one-way, from Financials to Sales.
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Here's how the process works:

1. The scheduled process checks for all party records (organization and person) that have the Customer usage
in Financials and that don't have a record in the Sales Accounts table (ZCA_SALES_ACCOUNTS) in the sales
application.

2. For the identified records, the process inserts new records in the Sales Accounts table, and in the Party Usages
table (HZ_PARTY_USG_ASSIGNMENTS), for Organization, Sales Account, and Person.

Important Points
Keep these points in mind as well:

• After the billing process finishes, the application creates billing accounts and contacts in Financials.

• The party used for the Sales account customer is available in Oracle ERP after you convert it to a billing account
from the Oracle Accounts Receivable UI.

• The process supports addresses associated with customer accounts and contacts. It also supports address
purposes, such as bill-to.

• Enable the Billing Accounts subtab from Application Composer to let your users see the customer account
number and the description.

• If you need your data to refresh regularly, it's a good idea to set up a schedule for the process using the
advanced option in the scheduled processes window.

Steps to Sync from Financials to Sales
To sync accounts and contacts data from Financials to your sales application:

1. Click Navigator > Tools > Scheduled Processes.
2. Click Actions > Schedule New Process and search for the Synchronize Financials Accounts and Contacts with

CX Sales process.
3. Verify that the data is synchronized in your sales application: Sign in to the Accounts pages as a user who has

access to the sales pages, such as the sales administrator or a salesperson, and view the new data.

Why am I getting the error, "Unable to retrieve content.
Additional information for Remote Region error #5?"  
If you're getting the error, "Unable to retrieve content. Additional information for Remote Region error #5" when setting
up products, it's possible that you haven't set the profile option, Sales Products Item Organization.

Set the profile option and try again.

How can users access both Sales and Service apps?  
When you receive your Oracle Cloud application, access to its functionality and data is secured using a role-based
access control security model. In a role-based access control security model, you provide users with roles which are
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assigned access privileges to protected resources. As long as users have the necessary roles, they can access both
applications.

Oracle provides many predefined job and abstract roles as part of the security reference implementation for the sales
and service applications.

Sales Roles
Here's some predefined job roles for sales users:

• Channel Account Manager

• Channel Operations Manager

• Channel Sales Manager

• Customer Contract Administrator

• Customer Data Steward

• Customer Relationship Management Application Administrator

• Data Steward Manager

• Enterprise Contract Administrator

• Enterprise Contract Manager

• Incentive Compensation Manager

• Incentive Compensation Plan Administrator

• Incentive Compensation Analyst

• Inside Sales Manager

• Inside Sales Representative

• Marketing Manager

• Marketing Operations Manager

• Marketing VP

• Master Data Management Application Administrator

• Partner Administrator

• Partner Sales Manager

• Partner Sales Representative

• Sales Administrator

• Sales Analyst

• Sales Catalog Administrator

• Sales Lead Qualifier

• Sales Manager

• Sales Representative

• Sales VP

• Supplier Contract Administrator
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You also assign the following abstract roles to sales users who are employees so they can carry out their work:

• Employee

• Resource

If you're using the Incentive Compensation functionality, you can also assign the following abstract roles to users:

• Incentive Compensation Participant

• Incentive Compensation Participant Manager

Service Roles
Many job roles and duty roles are predefined in the Service offering. These are the predefined job roles specific to this
product area:

• Chat Agent

• Customer Service Manager

• Customer Service Representative

• Knowledge Analyst

• Knowledge Manager

• Field Service Technician

• Internal Help Desk Administrator

• Internal Help Desk Agent

• Internal Help Desk Manager

• Case Manager

• Case Worker

Guidance for Assigning Predefined Roles
As a security administrator, you've access to the predefined roles and privileges that are readily available for
assignment. However, you must assess the user's need before assigning those roles as is with the complete set of
privileges.

Note:  Be extremely cautious when assigning predefined roles as-is. "Advisory Note on Subscription Impact" in the
Security Reference for Common Features guide.

When you assign predefined roles and privileges as is, you're entrusting users with full access to all data and
functionality. Such unrestricted access without identifying the business need might pose a security concern. Also, the
assigned privileges might account for subscription consumption irrespective of whether you bought the cloud service
or not. A detailed list of all the predefined roles that impact subscription is available for reference. See the spreadsheet
Predefined Roles with Subscription Impact.

If you're aware of a requirement or recommendation to assign specific predefined roles as is, it's fine to do so. For
example, only while setting up an application, you might need to assign the predefined Application Implementation
Consultant role as is. Once the setup is complete, you can unassign it. Otherwise, the recommended process is to always
make a copy of the predefined role, remove the privileges you don't need, and assign only the required privileges. That
way, you'll hit the subscription usage in a controlled way, based on your business need.
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Note:  Updates to Oracle Fusion Applications might also include changes to certain predefined roles. Check the
release readiness documents for your product area to know if there are any updates to the predefined roles that are
in use. If you find changes that are relevant, incorporate the same changes into your custom role. This will remain an
ongoing maintenance activity for the custom roles.

For more information, see the "User and Role-Provisioning Setup Options" and other related topics in the Securing
Applications guide.

See the Security Reference for Sales and Fusion Service guide for a complete list of roles and privileges in Sales and
Fusion Service.

How do I manage Geography Structures, Hierarchies,
and Validation?  
You can add geography structure by first defining the geography types using the Manage Geographies task. You can
then create geography hierarchy and geography validations also using the Manage Geographies task.

This example shows how you can configure the geography structure, geography types within the structure, geography
hierarchy, and geography validation for a country geography, using the United Kingdom country geography as an
illustration.

The following table summarizes the key decisions for this scenario.

Decisions to Consider In This Example

Copy an existing country structure?
 

No, create a new country structure.
 

What is the structure of the geography
types?
 

Create geography types with the following ranking structure:
 

1. County
2. Post Town

What is the geography hierarchy?
 

Create the following hierarchy:
 

1. Country of United Kingdom
2. County of Berkshire
3. Post Town of Reading

Which address style format will you use
when mapping geography validations?
 

The default address style format called the No Styles Format.
 

Are you using Oracle Fusion Tax for tax
purposes?
 

No, don't select Tax Validation for the geography types.
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Define the Geography Structure
You can add the County and Post Town geography types to the United Kingdom geography structure.

1. On the Manage Geographies page, enter GB in the Code field. Click Search.
2. On the Manage Geographies page, click Structure Defined.
3. On the Manage Geography Structure page, click the Create button next to the Copy Country Structure From

field.
4. In the Geography Structure section, select the County list item in the Add Geography Type field.
5. Click Add.
6. Select the Post Town list item in the Create and Add Geography Type field.
7. Click Add.
8. Click Save and Close.

Note:  You can't modify or delete a geography type.

Define the Geography Hierarchy
You can add the geographies for the County and Post Town geography types using the geography hierarchy user
interfaces to create the geography hierarchy for United Kingdom. You can also use Import Management to import
geography hierarchies using a CSV or XML file.

1. On the Manage Geographies page, enter GB in the Code field. Click Search.
2. On the Manage Geographies page, click Hierarchy Defined.

Note:  If there are many child geographies for the selected parent geography, a message asking you to
refine the search criteria is displayed. The child geographies are displayed after you refine the search
criteria. If there are many search results, you may have to further refine the search criteria. The maximum
number of child geographies that can be displayed is controlled by the ORA_HZ_GEO_HIERARCHY_LIMIT
profile option. You can change the value of this profile option by navigating to the Setup and Maintenance
work area, click the Tasks menu, and search for Manage Administrative Profile Values task. Search for the
ORA_HZ_GEO_HIERARCHY_LIMIT profile option and change the value.

3. In the Geography Hierarchy section, click United Kingdom to highlight the table row, and click Create.
4. In the Create County page, Primary and Alternate Names section, enter Berkshire in the Name field.
5. Click Save and Close.
6. In the Geography Hierarchy section, click Berkshire to highlight the table row, and click Create.
7. In the Create Post Town page, Primary and Alternate Names section, enter Reading in the Name field.
8. Click Save and Close.

Define the Geography Validations
You can define the geography mapping and validation for the United Kingdom default address style format to specify
the geography validations for the geography types you added to United Kingdom. You can then map the geography
types to attributes, enable the geography types for Lists of Values and Geography Validation, and set the geography
validation level.

1. On the Manage Geographies page, click Validation Defined.
2. In the Address Style section, click No Styles Format to highlight the table row.
3. For the County geography type, click the County list item in the Map to Attribute field.
4. Select the Enable List of Values and Geography Validation options.
5. For the Post Town geography type, click the City list item in the Map to Attribute field.
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6. Select the Geography Validation option.
7. In the Geography Validation Control section, select Error in the Geography Validation Level for Country list.
8. Click Save and Close.

How do I replace the existing master geography data
with revised Oracle-Licensed geography data?  
You must import and set up reference geography data for the countries where you do business.

Using the Oracle-licensed geography reference data, you no longer have to source geography data from a third party.
You can import Oracle-licensed data from Loqate, including the country structure and hierarchy information, either to
create a new geography setup or replace your existing geography data.

All customers with the exception of United States HCM Payroll customers, can use the information in this section to
replace existing geography data with Loqate geography data. You can follow these steps if you're using Nokia or any
other geography data and now want to move to Loqate geography data.

Before you begin, perform the following steps:

• Backup existing geography data including customizations, if any.

• Backup territory geographies.

• Perform impact analysis by contacting the support team to identify the use of geography IDs downstream.

Note:  Before deleting the geography data, make sure that GEOGRAPHY_ID isn't referenced in any downstream
applications such as TAX, FIN, Legal, and so on. Geography data is used across Oracle Cloud applications such as
Human Capital Management, TAX, and Legal. Global Single Instance POD users share the same geography data and
before deleting geography data, the geography usage POD analysis is required. The Oracle Support team can help you
identify the downstream impact.

Create an Export File of All Territories
In case you have implemented Customer Data Management along with the sales functionality, you must export all
territories before deleting the master geography data because removing the master geography data invalidates the
territory definitions that are based on the Geography dimension. You can either export the definitions of all territories to
a file or make manual corrections. If there are a large number of territories, export the territories definition to a file for
the territories import process. However, if there are very few affected territories, then you can choose to either export
the territories definition to a file or make corrections manually.

This procedure is applicable only if there are territories defined using the Geography dimension.

Perform the following steps to create an export file of all territories.

1. From the Territories and Quotas work area, click View Active Territories in the Tasks pane.
2. In the View Active Territories page, select the territory at the highest level.
3. Click the Actions list, and select Export, and then Export Selected Territory Hierarchy.
4. In the Warning dialog box, click OK.
5. Click the Actions list and select Export, and then View Export Status.
6. Review the status of the export job and verify if it has completed successfully.
7. In the Exported Data File column, click the .zip file against your export job, and click Save. All the territories are

exported to a compressed file on your system.
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8. Click OK.
9. Click Done in the View Active Territories page.

Delete the Territory Geography Data
A territory definition has references to the territory geography data and master geography data. Territory geography
data is based on the master geography data, in case you have implemented Customer Data Management along with the
sales functionality, you must delete the territory geography data prior to deleting the master geography data. When you
delete the territory geography data, all territories that are defined using geography dimension become invalid.

This procedure is applicable only if territory geographies are defined.

Perform the following steps to delete the territory geography data.

1. In the Setup and Maintenance work area, go to the following:
◦ Offering: Sales

◦ Functional Area: Territories

◦ Task: Manage Territory Geographies
2. On the Manage Territory Geographies page, click View All Hierarchies.
3. Select the highest level node for the country for which you want to replace the master geography data and click

the Delete  icon.
4. In the Warning dialog box, click OK.
5. In the Confirmation dialog box, click OK. The parent node of the territory geography data and its children are

deleted.
6. Repeat steps 3 to 5 to delete all the higher nodes in the territory geography data.
7. Click Save and Close.

The Territory Management application retains a copy of the dimension members referenced in the territory definitions.
This copy is updated when you trigger the Load and Activate process from the Enable Dimensions and Metrics task.
Therefore, although the territory geography data is deleted, the territory definitions may appear to remain valid.

Delete the Master Geography Data
Delete the existing geography data one country at a time. We recommend that you raise a service request for assistance
in deleting the geography data.

Delete Geography Structure

If you have created a geography structure, it prevents the geography imports from working or working as desired. For
example, if the geography structure exists, the Import Geography option may not be enabled for a country in Manage
Geographies even if Loqate predefined geography data is available for that country and the geography hierarchy doesn't
exist yet.

Note:  If any geography hierarchy was created manually, it must be deleted first.

If the geography structure was created manually, you can follow these steps to delete it. However, we recommend that
you raise a service request for assistance in deleting the geography structure.

1. In the Setup and Maintenance work area, go to the following:
◦ Offering: Customer Data Management

◦ Functional Area: Enterprise Profile
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◦ Task: Manage Geographies

2. On the Manage Geographies page, enter either the country name or the two-letter ISO code (for example, US),
and click Search.

3. Select the country in the search results and click Actions >  Manage Geography Structure.
4. In the Manage Geography Structure page, delete each level of the structure.
5. Click Save and Close.

You can now proceed to importing geography data.

Note:  If other setup or transaction data exists that's based on the geography data, replacement procedures for that
setup must also be followed.

Import Oracle-Licensed Geography Reference Data
Use this procedure to import Loqate geography data in Manage Geographies one country at a time. If the country data
you want isn't supported by Loqate geography seed data and point the Loqate supported country list here, then the
Import Geography Data action is disabled.

The geography data is provided by Loqate and is third-party content. As per Oracle policy, this software and
documentation may provide access to or information about content and services from third parties. Oracle and its
affiliates aren't responsible for and expressly disclaim all warranties of any kind with respect to third-party content and
services. Oracle and its affiliates aren't responsible for any loss, costs, or damages incurred due to your access to or use
of third-party content, products, or services.

Perform the following steps to import Oracle-licensed geography reference data.

1. In the Setup and Maintenance work area, go to the following:

◦ Offering: Customer Data Management

◦ Functional Area: Enterprise Profile

◦ Task: Manage Geographies

2. On the Manage Geographies page, enter either the country name or the two-letter ISO code (for example, US),
and click Search.

3. Select the country in the search results.
4. Click the Actions list, and select Import Geography Data.

Note:  Import Geography Data is disabled for a country if the geography data for that country isn't available
from Loqate or if the geography structure or hierarchy is already defined for that country. The existing master
geography hierarchy can be from Loqate or non-Loqate.

5. In the Warning dialog box, click OK.
6. In the Confirmation dialog box, click OK.

The import of larger countries may require several hours to complete.

You can track the progress of the import process by selecting Scheduled Processes from the Navigator.

Note:  To access the Scheduled Processes work area, you must be signed in as a user with the Employee abstract role.
The initial user doesn't have this role assigned, but the other users you created do.

After the import is complete, you can search for the country again in the Manage Geographies page. Check marks now
appear in the Structure Defined and Hierarchy Defined columns indicating the import completed successfully.
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Next, click the Validation Defined icon to define the validations, enable List of Values, and choose address style format
for a country as set up before. For more information, see the Geography Validation topic.

The Geocoding Defined and Address Cleansing Defined columns are used for additional features which you must
license from Oracle and set up separately.

• Geocoding makes it possible to display customers in the vicinity of a mobile address. You set up Geocoding
Enabled for those countries where you're using Around Me functionality in CX Sales Cloud Mobile.

• Cleansing makes it possible to validate addresses down to the street level.

Add any geography customizations.

Run the Geography Name Referencing Process
The Geography Name Referencing (GNR) process validates address elements in location tables, such as
HZ_LOCATIONS, against the master geography data.

Run the GNR process in the following situations:

• When you are using geography based address validation (not third party address validation services).

• GNR data is needed for your business processes (such as ERP Tax).

Note:  Note: You can't update existing data, such as effective start date, in the GNR process tables for the locations.

Perform the following steps to run the GNR process.

1. Navigate to Tools >  Scheduled Processes work area.
2. On the Overview page, click Actions >  Schedule New Process.
3. Click the Name list and search for Validate Geographies of Addresses Against Master Geographies, and

then click OK.
4. Click OK in the Schedule New Process dialog box.
5. In the Process Details dialog box, enter the following details:

◦ Location Table Name: HZ_LOCATIONS

◦ Run Type: ALL

◦ Usage Code: GEOGRAPHY

6. Enter the country code in the Country Code field.
7. Click Submit.
8. In the Confirmation dialog box, click OK.
9. Click Close.

10. In the Scheduled Processes page, click the Refresh icon.
11. Verify if the status of the process has completed successfully.

Find the locations failing in Geography Name References using: https://cloudcustomerconnect.oracle.com/posts/
b1e16b06ae. Fix Geography Name References failures by updating addresses with the latest geography data.
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Recreate and Load the Territory Geography Data
In case you have implemented Customer Data Management along with the sales functionality, you can recreate the
territory geography data, after the master geography data is imported, using either of the following methods:

• Import process: If you created the original territory geography data using the import process, then use the
same import file to recreate the territory geography structure. For more information about importing the
territory geography data using Import Management, see Import Your Sales Territory Data in the Oracle CX
Understanding Import and Export Management for CX Sales and Fusion Service guide.

• Manual creation process: You can manually recreate the territory geography data structures, as they existed
before their deletion, using the Manage Territory Geographies task. For more information about creating zones
and adding geographies to a zone, see Managing Territory Geographies in the Related Topics section.

After you have recreated the territory geography data, perform the following steps to load the data.

1. In the Setup and Maintenance work area, go to the following:

◦ Offering: Sales

◦ Functional Area: Territories

◦ Task: Enable Dimensions and Metrics

2. On the Enable Dimensions and Metrics page, click the Actions list, and select Load and Activate. The
process loads the territory geography data to make dimension members available for selection when defining
territories.

3. In the Confirmation dialog box, click OK.
4. Click Done.

Restore the Invalid Territory Definitions
After recreating the territory geography hierarchies and running the Load and Activate option from the Enable
Dimensions and Metrics task, the geography dimensions are populated with the new geography members. The
geography members in the territory appear as invalid because your territories still reference the old copies of the
dimension members that were deleted. The new members aren't referenced automatically by the territories. You must
re-reference the territory definitions from the old geography dimension members to the new ones.

You can restore the invalid territory definitions by either importing the previously created export file or making manual
corrections to the territories.

To restore valid territory definitions using territories import:

1. Open the export file you saved in the Creating an Export File of All Territories step. The compressed file
contains four CSV files.

2. Open TERR_HEADER.CSV file.
3. Enter REPLACE in the Action column for all territories that are based on geography dimension.
4. Save the file in CSV format and compress it together with three other CSV files.
5. From the Territories and Quotas work area, click View Active Territories in the Tasks pane.
6. Click the Actions list, and select Import to Proposal, and then Import Territories.
7. Select the newly created compressed file and click OK.
8. Click the Actions list and select Import to Proposal, and then View Import Status.
9. Review the status of the export job and verify if it has completed successfully.

10. Click OK.
11. From the Tasks pane, click Manage Territory Proposals.
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12. In the Manage Territory Proposals page, on the Current Territory Proposals table, search for the proposal with
your import file name.

13. Click the import file name to open the territory proposal.
14. Click Edit Coverage to verify that the territory definitions are valid.
15. Verify that there are no values listed as invalid in the Selected Dimension Members section.
16. Click Save and Close.
17. Click Activate. The territory proposal of your import file is activated.

To restore valid territory definitions through manual corrections:

1. From the Territories and Quotas work area, click Manage Territory Proposals in the Tasks pane.
2. In the Manage Territory Proposals page, click the Create icon.
3. In the Create Territory Proposals dialog box, enter a name and click Save and View.
4. In the Territory Proposals page, add all the territories with the Geography dimension value other than the value

Any to the proposal.
5. Select a territory and click Edit Coverage.
6. In the Edit Coverage page, select Geography from the Dimensions list. The invalid dimension members are

displayed in the Selected Dimension Members pane.
7. Expand the values in the Available Dimension Members section or search for the member that has the same

name as the one marked invalid in the Selected Dimension Members pane.
8. Select one or more new geography dimension members from Available Dimension Members pane and click

Add icon to the Selected Dimension Members pane.
9. Click the Remove icon to remove the invalid members from the Selected Dimension Members pane.

10. Click Save and Close.
11. Repeat steps 4 to 10 for all territories that were based on Geography dimension.
12. Click Activate. After the activation process is complete, your territory definitions are valid again and are

referencing to the new geography data.

Although this method is always applicable, it's most appropriate when you have to restore territory definitions for a
smaller number of territories.

To run the batch assignment process for opportunities:

1. From Navigator, click Scheduled Processes.
2. In the Schedule Processes page, click Schedule New Process.
3. In the Schedule New Process dialog box, search for the Request Revenue Territory Assignment process and

select it.
4. Click OK.
5. In the Process Details dialog box, enter OpenOpportunitiesByCreationDate in the View Criteria Name field.

This selects all revenue lines belonging to open opportunities that were created in the last 'X' days.
6. Enter BindOptyCreationDateFrom= followed by the date.

For example, if BindOptyCreationDateFrom=2014-01-01, then all open opportunities which were created
between 1st January 2014 till the current date, are processed.

7. Click Submit to schedule the process.
8. In the Confirmation dialog box, make a note of the process identifier for monitoring the process, and click OK.
9. Click Close.

10. In the Schedule Processes page, click the Refresh icon.
11. Review the status of the process job and verify if it has completed successfully.

Note:  Review a small subset of the open opportunities to confirm that the territory assignment is as
expected.
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To run the batch assignment process for sales accounts:

1. Ensure that the ZCA_SA_AUTO_ASSIGN_ON_CREATE and ZCA_SA_AUTO_ASSIGN_ON_UPDATE profile
options are set to Yes in the Manage Customer Center Profile Options task.

2. From Navigator, click Customers.
3. In the Customers page, click Create Account.
4. In the Create Account page, enter a name and address of the sales account, and select the Address is sell to

check box.
5. Click Save and Close.
6. From Navigator, click Customers.
7. In the Search pane, search for the name of the sales account you created and select it.
8. In the section Customer Information, select Sales Account Team. The details of the sales account and

territories associated with the sales account are displayed.

This indicates that the sales account was created successfully and the batch assignment was run automatically
to assign the matching territories to the sales account.

To run the batch assignment process manually from the Scheduled Processes page, perform the following steps.

1. From Navigator, click Scheduled Processes.
2. In the Schedule Processes page, click Schedule New Process.
3. In the Schedule New Process dialog box, search for the Request Account Assignment process and select it.
4. Click OK.
5. Enter SalesAccount_Work_Object in the Work Object Code field and

SalesAccountTerritory_Candidate_Object in the Candidate Object Code field.
6. Select Territory in the Assignment Mode list.
7. Enter AllSalesAccountsVC in the View Criteria Name field. This selects all sales accounts.
8. Click Submit to schedule the process.
9. In the Confirmation dialog box, make a note of the process identifier for monitoring the process, and click OK.

10. Click Close.
11. In the Schedule Processes page, click the Refresh icon.
12. Review the status of the process job and verify if it has completed successfully.

Note:  Review a small subset of the accounts to confirm that the territory assignment is as expected.

Verify that the downstream applications using geography data is working fine.

Can I translate dynamic choice list (DCL) values into the
language of the signed-in user?  
No, DCL values are actual transaction records from another object, so can't be translated. You can translate the
displayed text on fixed-choice list (FCL) fields, but not transactional records.
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Is there a way to add links to attachments in a report?  
You can create an SQL syntax similar to this example for opportunity attachments. You must have the AttachmentsRead
role. It gives you read access to attachments to UCM server.

SELECT

fdt.file_name,

fd.DATATYPE_CODE,

fdt.dm_document_id,

fdt.dm_version_number,

 fdt.dm_version_number document_id,

 fdt.dm_document_id UCM_file,

CASE

WHEN fd.DATATYPE_CODE = 'WEB_PAGE' THEN FDT.URL

ELSE

 'https://'

|| h.EXTERNAL_VIRTUAL_HOST

|| '/cs/idcplg?IdcService=GET_FILE&dID='

 || fdt.dm_version_number

 ||'&dDocName='

 || fdt.dm_document_id

 || '&allowInterrupt=1' 

END File_Link

FROM

fnd_attached_documents fad,

 fnd_documents_tl fdt,

FND_DOCUMENTS fd,

FUSION.ASK_DEPLOYED_DOMAINS h

WHERE

h.DEPLOYED_DOMAIN_NAME = 'FADomain'

AND fad.document_id = fdt.document_id

AND fad.document_id = fd.document_id

AND fdt.LANGUAGE = 'US'
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AND fad.pk1_value = {{Optyid'}}

What determines which task and appointment
notifications salespeople receive?  
Task and appointment notifications both through the Notifications (Bell icon) and Things to Finish are controlled
by profile options that you can set both at site and user levels. For example, to have salespeople notified when
they're added to an appointment as a resource, you set the profile option Appointment Resource Notifications
(ZMM_ACTIVITY_APPT_NOTIF_RESOURCE) to Yes. You can enable notifications for everyone by selecting Yes at the site
level, or notify specific individuals you enter.

Here's how to obtain a list of the profile options and set them:

1. In the Setup and Maintenance work area, open the Manage Administrator Profile Values task:
◦ Offering: Sales

◦ Functional Area: Sales Foundation

◦ Task: Manage Administrator Profile Values
2. In the Search section, Profile Option Code field, enter ZMM_ACTIVITY%_NOTIF% and click Search.

The application displays a list of profile options that you can set to control notifications for tasks and
appointments.

You must run the Synchronize Notifications in Global Header scheduled process to ensure that all the in-app notification
UIs reflect the latest task status. For details about this process, see the topic Synchronize Notifications in the Global
Header and Home Page with Workflow Tasks.

How do I enable desktop pages for Resource Directory?  
You can use the Resource Directory to view all the resources within your organization. You can also use the Resource
Directory to find and communicate with other resources, and to network and collaborate with them.

You can access the Resource Directory using the following path: Navigator > Resource Directory. You can also perform
some of the functions of the resource directory using the Manage Resources setup task.

You use the Resource Directory to perform the following tasks:

• View and modify your profile

• View your organization information

• View information related to other organizations

• View the profiles of other resources

• Communicate with other resources

Note:  If you are unable to find a party record in the Resource Directory, run the Synchronize Person Records
scheduled process. For more information, see the Implementing Global Human Resources guide.
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Note:  You can set the profile option HZ_RESOURCE_ALLOW_CUSTOMIZATION to Yes to enable desktop pages for
Resource Directory in Application Composer. The default value of this profile option is No.

How do I set up the required address option for accounts
and contacts?  
Administrators can set an address as required or optional depending on the type of account or contact. You can specify
that an address is required and determine how the address appears on the UI.

Manage Profile Values
Use the Manage Administrator Profile Values task to specify that an address is required while creating an account.
Profile options let you enable or disable address options for accounts and contacts. Use these profile options to specify
that an address is required while creating an account.

Profile Option Code Profile User Name Description

ZCA_ACCOUNT_ADDRESS_REQUIRED_
ENABLED
 

Account Address Required
 

Specify whether an address is required while
creating an account.
 

ZCA_CONTACT_ADDRESS_REQUIRED_
ENABLED
 

Contact Address Required
 

Specify whether an address is required while
creating a contact.
 

This table lists the profile values and which types of accounts require the address to be entered. By default, the profile
option setting is Required for customer.

Profile Value Description Required for Account Type

Yes
 

The address is required.
 

All types of accounts.
 

No
 

The address isn't required.
 

The address is optional, regardless of the
account type.
 

Required for customer
 

The address is required only for the account
type that's set to this profile value.
 

The address is required only for customers.
 

To make the address required while creating an account:

1. In the Setup and Maintenance area, go to the following:

◦ Offering: Sales

◦ Functional Area: Sales Foundation
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◦ Task: Manage Administrator Profile Values

2. Click the Manage Administrator Profile Values link.

The Manage Administrator Profile Values page appears.
3. Enter the code in the Code field, and click Search.

The application displays the profile option information.
4. In the Profile Values section, select Yes in the Profile Value field.
5. Click Save and Close.

Manage Address Formats
Use the Manage Address Format task to set up address attributes. The address format lets you manage the appearance
of the address for accounts and contacts. For example, you can change the case of letters in an address, or mark a
specific address attribute as required.

To specify which fields in an address are required:

1. In the Setup and Maintenance area, go to the following:

◦ Offering: Sales

◦ Functional Area: Sales Foundation

◦ Task: Manage Address Formats

2. Click the Manage Address Formats link.

The Manage Address Formats page appears.
3. Select a country from the drop-down list.
4. In the Format Variation Layout area, select the fields that you want to set as required in the Required column.
5. Click Done.

Groovy Support for Numbering Management
You can automatically generate the site ID of an address while creating a contact or an account using a groovy script.
Before you can use the groovy script, you must verify that the value for HZ_GENERATE_PARTY_SITE_NUMBER profile
option is set to Auto numbering, update allowed (AUTONUM_UPDATE).

How do we dynamically insert logo images into our RTF
template?  
To dynamically insert images such as logos into BI Publisher templates, follow the instructions on Oracle Support in
article How to use images dynamically in BI Publisher RTF template (Doc ID 2409855.1).The article includes sample code
and a link to a sample template.
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What are the available data import options?  
You can import your data from an external application into Oracle Applications Cloud in several different ways, including
using public web services.

Which import method you use depends on the type of data you're importing, the volume of data, and technical
requirements. If you're integrating one cloud service with other cloud services, then you must use additional import
methods as described in the appropriate guides.

When you're importing data for a particular object, you must make sure that any prerequisite objects already exist in
the application. For example, if you're importing contacts for an account, then the account must already exist in the
application. If one import job depends on the contents of another import job, then complete the prerequisite job before
starting the dependent job. For example, if you're importing both accounts and opportunities, then import accounts
before importing opportunities.

The following table lists the import methods and references to further information.

Import Method Description When to Use How to Access For More Information

Quick Import Excel Macros
 

You can use the import
macros to speed up and
simplify the import of up
to 5000 records at a time
for some objects. They
validate your data entries,
 provide list of values, and
automatically populate
constant values.
 
The macros create data
files that are automatically
imported using Import
Management.
 
You can import the
following objects using
import macros:
 

• Sales Users

• Products and product
groups

• Accounts

• Contacts

• Account Hierarchy

• Leads

• Opportunities

These are best to import
data in your initial
deployment.
 
The macros are targeted to
the simple proof of concept
sales automation use case
covered in the Importing
Sales Users chapter of
the Getting Started with
Your Sales Implementation
guide. For example, the
import macros assume that
you're importing account,
 contact, and lead records
for one country at a time.
 
The macros generate log
files with information about
the File Import job, and
these log files can also
serve as a learning tool for
more complex import.
 

You can download the Excel
macros and any required
mapping files from the
Getting Started with Your
Implementation: Quick
Import Macros (Document
ID 2229503.1) article on My
Oracle Support.
 

The chapters in the
Getting Started with Your
Sales Implementation
guide provide detailed
instructions and video
tutorials for using the
macros.
 
For instructions on how
to add your own fields to
the macros, see. How to
Configure Quick Import
Macro for importing
Employee Resources (Doc
ID 2364229.1) article on My
Oracle Support.
 

Import Management
 

Import Management
improves definition, error
handling, and performance
for importing flat files
(.CSV). For example, Import

Use Import Management
for importing outside
the scope of the Getting
Started with Your
Implementation guide.

Click Import Management
in the Navigator.
 

See the Understanding
Import and Export
Management guide for
instructions on using the
import.
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Import Method Description When to Use How to Access For More Information

Management has drag and
drop mapping capabilities
and validates the first ten
records in your data file
before you import to ensure
the data meets the import
constraints of the various
attributes.
 
Import Management is
available for importing data
for the following application
objects and their child
objects:
 

• Access Groups

• Account

• Action

• Action Plan

• Activity

• Address

• Asset

• Attachment

• Business Plan

• Campaign

• Case

• Classification

• Classification Code

• Competitor

• Consumer

• Contact

• Contract

• Contests

• Country Structure

• Deal Registration

• Hierarchy

• Hierarchy Member

• Household

• Hub Source System
Reference

• Incentive Rule
Assignments

• Incentive Rule
Attribute Values

• Incentive Rules

• Incentive Transaction
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Import Method Description When to Use How to Access For More Information

• Interaction

• MDF Budget

• MDF Claim

• MDF Request

• Note

• Objective

• Opportunity

• Organization

• Partner

• Partner Program

• Person

• Price Book Header

• Product

• Product Group

• Program Enrollment

• Promotion

• Queue

• Relationship

• Resource

• Resource Capacity

• Sales Lead

• Sales Order

• Sales Territory

• Sales Territory Quota

• Self-Service Role

• Service Request

• Standard Text

• Standard Text Folder

• Standard Text User
Variable

• Subscription

• Template

• Template Action

• Territory Geographies

• Any additional objects
you create

External Data Loader Client
 

Command-line tool that's
used to import high-
volume flat source data
files into CX Sales and
Fusion Service. This tool

Use this import method
for importing very large
data files for the objects
supported by Import
Management.

You can download the
client from Oracle Support
Document 2325249.1
(External Data Loader

Instructions for using the
client are available in the
document and in the client
itself.
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Import Method Description When to Use How to Access For More Information

splits a large data file into
multiple smaller files to
adhere to import volume
limits, and enables the
tracking of import status.
 
The client supports the
same objects as Import
Management.
 

 Client) on My Oracle
Support.
 

The chapter Import Data
Using External Data
Loader Client in the guide
Understanding Import and
Export Management for CX
Sales and Fusion Service
provides information about
using the External Data
Loader Client.
 

Web Services
 

Web services are available
for external client
applications to start and
monitor import jobs.
You can manage Import
Management jobs using
REST web services, and File
Import jobs using SOAP
web services.
 

Use web services to
manage import jobs to
import directly from an
external application.
 

Public APIs are available
for both the Import
Management/REST
services and the File
Import/SOAP services.
 
The following REST APIs
are available for import:
 

• Import Activities

• Import Activity Maps

• Import Export Objects
Metadata

The SOAP service is called
the File Import Activity
Service.
 

For REST API
documentation, see the
REST API for CX Sales and
Fusion Service guide.
 
For SOAP API
documentation, see the
SOAP Web Services for CX
Sales and Fusion Service
guide.
 

High-Volume Import
 

The high-volume import
mode is designed to import
millions of records at
once. This mode doesn't
trigger any custom logic
configured through the
application composer. This
option is available for the
following objects and their
child objects:
 

• Account

• Address

• Asset

• Classification Code

• Contact

• Contract

• Contract Line

• Country Structure

• Custom Object
(custom top level
objects and custom
child objects)

• Geography

• Hierarchy

Use this import mode
for importing very large
number of records for the
objects supported.
 

You can access High-
Volume Import either using
REST services or using
External Data Loader Client.
 
When importing using
REST, set the "High-
volume" attribute to enable
this mode of import.
 
When importing using the
External Data Loader Client,
set the command-line
parameter "-high-volume"
to enable this mode of
import.
 

For REST API
documentation, see the
REST API for CX Sales and
Fusion Service guide.
 
The chapter Import Data
Using External Data
Loader Client in the guide
Understanding Import and
Export Management for CX
Sales and Fusion Service
provides information about
using the External Data
Loader Client.
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Import Method Description When to Use How to Access For More Information

• Hierarchy Member

• Household

• Hub Source System
Reference

• Incentive Transaction

• Organization

• Person

• Sales Territory Quota

• Territory Geographies

Note:  Object work flows can't be invoked using Import Management.

The following figure provides an architectural overview of the different import methods:

• File Import uses the SOA architecture to import data into Oracle CX Sales.

• Quick Import uses the REST Web services to import data into Oracle CX Sales. When you import data using
the quick import Excel macros, you're creating an import activity in Import Management using the REST web
services. The macro import creates the same import activity and uses the same mapping as you do when you
initiate the import from the application. You can monitor each import in the macro or in the application itself.

• Both Import Management and the External Data Loader Client use the same scheduled processes for import.
When you import very large files using the client, the REST APIs create multiple processes to respect the Import
Management file size limit.

• To import from an external application, use the SOAP and REST web services directly.
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Related Topics

How do I generate the resource reporting hierarchy?  
You can use this scheduled process to generate the resource reporting hierarchy for a given internal resource
organization hierarchy, a sales, or a marketing organization hierarchy. This scheduled process also updates the
reporting hierarchy when changes occur in the organization hierarchy.
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You can run this scheduled process when new resources are created in Import Management using Resource User.

When to Use
This scheduled process:

• Updates the reporting hierarchy in accordance to the changes in internal resource or partner organization
hierarchy. This scheduled process updates the reporting hierarchy in accordance with the changes in internal
resource hierarchy. The resource's reporting manager isn't updated unless you run this scheduled process.

• Must be run after you make any changes to the hierarchy such as changing the manager or the organization.

Privileges Required
Verify that you have the following privilege or roles:

• Roles:

◦ Application Implementation Consultant

◦ Master Data Management Application Administrator

• Privilege:

◦ Run Trading Community Resource Reporting Hierarchy Generation

Before You Start
Review the following before scheduling this scheduled process:

• Recommended Frequency:

◦ You can run this scheduled process when new resources are created in Import Management using
Resource User.

◦ You can run this scheduled process when the same resource is visible multiple times in Team Members
tab of Opportunity.

◦ You can run this scheduled process as needed or at appropriate intervals, such as daily.

• Compatibility:

◦ This scheduled process is self-incompatible. If multiple instances are submitted, the first instance runs
and subsequent instances remain in blocked status until the first instance is completed.

Parameters

Parameter Optional or
Mandatory

Description Parameter Values Special Combinations
Required

Notes

Tree Structure Code
 

Mandatory
 

Specifies the type of
resource hierarchy.
 

RESOURCE_ORG_
TREE_STRUCTURE
PARTNER_ORG_TREE_
STRUCTURE
 

None
 

This parameter is List
of Values driven.
 
Selecting RESOURCE_
ORG_TREE_

282



Oracle Fusion Cloud Sales Automation
Sales Questions and Answers

Chapter 1
Sales Questions and Answers

Parameter Optional or
Mandatory

Description Parameter Values Special Combinations
Required

Notes

STRUCTURE builds
the internal resource
hierarchy.
 
Selecting PARTNER_
ORG_TREE_
STRUCTURE builds the
corresponding partner
tree.
 

Tree Code
 

Mandatory
 

Specifies the tree
code.
 

GLOBAL_SALES_
MARKETING
 

None
 

This parameter is List
of Values driven.
 
Select 'GLOBAL_
SALES_MARKETING'
for internal resource
hierarchy.
 
Select corresponding
tree code for Partner
Hierarchy.
 

Tree Version ID
 

Mandatory
 

Specifies the version
ID of the Tree.
 

Any
 

None
 

This parameter is List
of Values driven.
 
Select corresponding
Tree Version ID for the
hierarchy that must be
re-generated.
 

How do I synchronize the GUID of users?  
You can use this scheduled process to synchronize the user GUID of users including Employees, Contingent Workers,
and Partner Contacts in CRM database.

When to Use
This scheduled process is used to:

• Update the user GUID in CRM database for users.

• Remove the user GUID from CRM database for inactive parties.

• Remove invalid user GUID from CRM database that doesn't exist in HCM database.

Privileges Required
Verify that you have the following privileges or roles:

• Application Implementation Consultant
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• Master Data Management Application Administrator

Before You Start
Review the following before scheduling this scheduled process:

• Recommended Frequency
◦ You can run this scheduled process when some users aren't properly connected to Person Parties.

◦ You can run this scheduled process on ad hoc basis or schedule it for appropriate frequency, such as daily
once.

• Compatibility
◦ No self-incompatibility defined.

Parameters
None.

How do I map import fields?  
After entering the import options, map the fields in the source file to the corresponding target attributes.

You can do these in the section:

• Automatic Mapping

• Map Fields

• Save the Import Mapping

Automatic Mapping
The automatic mapping feature maps the source file columns to the target attribute columns. The application
automatically saves the mapping created under the name Automatic Mapping and lists it in the Import Mapping drop-
down list.

For an import file attribute to get automatically mapped, the column header for the attribute in the import file should be
same as the Attribute Name. You can view the Attribute Name and Attribute Display Name in the Import Objects tab.

Note:  You must map the column headers to the attribute display name when using an exported file to import. The
exported file contains the display name as column headers, hence doesn't get automatically mapped.

You can download the import object templates from the Import Objects tab, and use them to create the source CSV file
for your import. The templates have prepopulated column headers that ensure that the attributes are automatically
mapped.

For auto mapping to work correctly provide the name of the columns in the input CSV. Follow the below steps to create
the source CSV file for your import:

1. Navigate to Tools > Import Management > Import Objects
2. Filter the object based on display name of the object or language Independent Code (ObjectCode)
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3. Download the file and decompress it.
4. In the file named like <ObjectCode>.csv, remove the 2nd row.
5. Use the names in the first row for column names of the input csv file.

For more details please refer readme.txt.

You can override a column mapping, by dragging target attributes from Target Attributes section to the Attribute
Name field of the Source File section. If you change the mapping, then you must save the mapping with a different
name. Once you provide the name, the date and year time stamp is appended to the mapping name. The newly created
mapping appears in the Import Mapping drop-down list. To apply the automatic mapping instead of your custom
mapping, select Automatic Mapping from the Import Mapping drop-down list and click Apply.

Map the Fields
The Map Fields section can be subdivided into source file columns and target attribute columns. The source column
header value is derived from the source file.

The following table outlines the source columns.

Source Column Description

Column Header
 

Represents the column header for the text files.
 

Example Value
 

Values are derived from the first source file saved with the predefined mapping. If you didn't select
a predefined mapping, then the example values are taken from the first data row in the source file
selected in the first step of the Import Activity definition.
 

Attribute Name
 

Represents the target attribute that's to be mapped to the source column.
 

The following table outlines the target columns.

Target Column Description

Target Attribute
 

The attribute name that represents the corresponding table column for the object.
 

Required
 

Indicates whether the target attribute is a required or a user key. Required indicates that the key is
required while creating a new record. User key indicates that the key is required while updating an
existing record.
 

Note:  For required fields, ensure that data is available for the respective attributes in the input CSV file. You can use
the validate function to check if all required fields are available before submitting the import job.

Save the Import Mapping
You can use automatic mapping to map the source file attributes to target attributes as described in the previous
section. To map more attributes or override existing mappings, then click Save As and save your custom map. The
name of a mapping file must be unique for the object.
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For more information on how to import your data, see the object-specific import topics in the chapter Import Your Data.
These topics are titled Import Your <Object-Name> Data. They provide the following information about importing data:

• How to map your source data to Oracle Applications Cloud object attributes. This way the import process would
know where to insert each of the information bits.

• Required attributes and validations for the object.

• How to create the source CSV file with the data you want to import.

• How to start an import activity.

• How to check the import results to know if the import went well.

Related Topics
• How do I import data?

How do I create a report that lists attachments?  
While there's no subject area for you to use in creating a BI report on attachments, you can use Oracle BI Publisher to
get the information.

Sign in to BIP and use the below query.

Select ENTITY_NAME,count(*)

FROM FUSION.FND_ATTACHED_DOCUMENTS

WHERE ENTITY_NAME not in
 ('ESS_REQUEST_HISTORY','ZCA_EXP_BATCHES','MKT_CM_CAMPAIGNS','MKT_IMP_JOBS','MKT_TM_TREATMENTS','MOO_STG_B')

Group by ENTITY_NAME

Other columns of interest in FND_ATTACHED_DOCUMENTS are 

Object Type

ENTITY_NAME

Object Id

PK1_VALUE

AttachmentId

ATTACHED_DOCUMENT_ID

Document Id

DOCUMENT_ID

 

The other table which can tells file name with extension is

select a.ENTITY_NAME,a.PK1_VALUE,a.ATTACHED_DOCUMENT_ID,

286



Oracle Fusion Cloud Sales Automation
Sales Questions and Answers

Chapter 1
Sales Questions and Answers

 d.DOCUMENT_ID ,d.TITLE ,d.DM_DOCUMENT_ID ,d.FILE_NAME

FROM FUSION.FND_ATTACHED_DOCUMENTS a ,FUSION.FND_DOCUMENTS_TL d

Where a.DOCUMENT_ID = d.DOCUMENT_ID

and a.ENTITY_NAME not in
 ('ESS_REQUEST_HISTORY','ZCA_EXP_BATCHES','MKT_CM_CAMPAIGNS','MKT_IMP_JOBS','MKT_TM_TREATMENTS','MOO_STG_B')

How can I build a report that shows when a specific
report has been run and when?  
You can build a report using the OTBI Usage Real Time subject area.

Here's an example:

SELECT
 "OTBI Usage Real Time"."OTBI Report"."Report Name" s_1,
 "OTBI Usage Real Time"."OTBI Report"."Report Path" s_2,
 "OTBI Usage Real Time"."Time"."Report Start Date" s_3,
 "OTBI Usage Real Time"."Time"."Year" s_4,
 "OTBI Usage Real Time"."User"."User Name" s_5,
 "OTBI Usage Real Time"."Facts - Usage Metrics"."Report Execution Count" s_6
FROM "OTBI Usage Real Time"
WHERE
(("Time"."Year" = '2023') AND ("User"."User Name" LIKE 'USERNAME%'))

How do I obtain a list of duty and data roles for Fusion
CX?  
You can view all the duty and data roles in the Oracle Security Reference for Sales and B2B Service  guide, or you can
obtain spreadsheets you can filter on Oracle Support.

See the following Oracle Support articles for the spreadsheets and more information:

• Oracle CX Sales and B2B Service: Security Reference Spreadsheets (Doc ID 1677508.1)

• Mapping of Roles, Duties and Privileges in Fusion Applications (Doc ID 1460486.1)

• Security Resource Center (Oracle CX Sales and B2B Service) (Doc ID 1609084.1)

How do I refresh BI reports audit data for user adoption
reporting?  
Use the Refresh BI Reports Audit Data for User Adoption Reporting scheduled process to refresh the BI report audit
tables for user adoption reporting.
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This scheduled process interacts with the database to deliver and refresh data that you see in the BI reports for user
adoption and usage tracking for the application.

When to Use
This scheduled process:

• This scheduled process is used for supporting Reporting on User Adoption.

• There are no jobs that must be run before this job is executed.

• This scheduled process is used for collection and aggregating data needed for reporting on user Adoption.

• BI reports based on user adoption don't reflect the correct data, if this job isn't run.

• The User Session Activity Tracked profile option (FND_TRACK_USER_ACTIVITY) must be enabled for this
scheduled process.

Privileges Required
Verify that you have the following privileges or roles:

• Privileges
◦ ACM_RUN_CRM_ANALYTICS_REFRESH_AUDIT_TABLE_JOB_PRIV

• Roles
◦ Sales Administrator

◦ Sales VP

◦ Sales Manager

Before You Start
Review the following before scheduling this scheduled process:

• Recommended Frequency:
◦ It is recommended that you run this process once a day at the end of business.

• Execution Time:
◦ It takes around 2 to 5 minutes to complete processing one batch of records.

◦ This scheduled process completes running few hundreds of records within a minute.

• Compatibility:
◦ There are no compatibility issues with other scheduled processes and itself.

Parameters

Parameter Optional or
Mandatory

Description Parameter Values Special Combinations
Required

Notes

Full Refresh
 

Mandatory
 

Specify Yes (Y) if you
want to purge all the
data.

Y or N
 

None
 

It is recommended
that you run this
scheduled process
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Parameter Optional or
Mandatory

Description Parameter Values Special Combinations
Required

Notes

 with Full Load ="N" to
incrementally capture
the audit
 
data. This scheduled
process performs
better when run as an
incremental Load.

Purge After (Months)
 

Mandatory Specify the number
of the months after
which the audit data is
purged.

Specify a number. This parameter
determines the
retention period of
the audit data. For
example, you specify
"13" as the value of this
parameter, audit data
older than 13 months
is purged. Audit data
up to 13 months is
maintained.

.

Troubleshooting Information
• If you configure this scheduled process to notify you in case of failures, you will receive reports of failures.

• This job can be restarted, if it doesn't run successfully.

• The job can be restarted in case of failures. No clean up activity is needed.

• The latest user adoption data is reflected in BI reports, if the job runs successfully.

How does Oracle back up my Sales data?  
Oracle Cloud Operations makes daily backups of your production and test environments for use in case of a
catastrophic failure. Oracle Cloud Operations doesn't perform backup or restore operations on demand, however. Once
provisioned, you're the sole owner of the data and metadata configuration. Oracle Cloud Operations thoroughly tests all
releases and fixes to eliminate a need for you to request such backup or restore operations.

You can make backups of your own by exporting sales data using Export Management. You can export metadata using
Customization Set Migration (CSM) and Functional Setup Manager (FSM) Migration. You can migrate BI Publisher
reports and data models from one environment to another. For more details, review the following documents from
Oracle Support:

• Frequently Asked Questions on Hosting Scenarios for Oracle Cloud Fusion Applications Services (Doc ID
1537549.1)

• Best Practices and Recommendations for Using Customization Set Migration (CSM) Feature (Doc ID 2116725.1)

• Best Practices for Functional Setup Manager Migration - Export and Import (Doc ID 2632594.1)

• Business Intelligence Publisher Enterprise User Interface Steps To Migrate The BI Publisher Reports Folder And
Data Models From One Environment To Another (Doc ID 2494901.1)
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Is there a way to push updates to CX Sales Mobile
immediately, without having users sign out?  
When you publish a sandbox with changes to your CX Sales Mobile application, users don't have to sign out of the app,
but they must force-close the app and reopen it for the changes to be visible.

Is there any duplicate checking when creating territories?
 
You're prevented from creating duplicate territories in the UI. The application ignores duplicate territories when they're
imported.

Application Usage Insights are enabled in BI and the
Objects tab shows correct data, but there's no data in the
Sessions tab. Why?  
You must run the process Refresh BI Reports Audi Data for User Adoption Reporting to collect the audit data. Oracle
recommends running the process once every day.

The Oracle Enterprise Scheduler process accepts 2 parameters:

• Full Load (Y/ N): Set to N to incrementally capture the audit data. This setting ensures better performance and
prevents the deletion of all the historical audit data you collect.

A setting of Y deletes all your historical audit data regardless of the number of months you enter in the Purge
after (Months) parameter.

• Purge after (Months): Enter the number of months you want to retain the audit data. Entering 12, for example,
causes the purging of audit data you collected that's older than 12 months. You always retain the latest 12
months worth of data. If you're starting to capture data today, the audit will start purging a month's worth of
data after at the end of the 13 month.
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How do I default the current year in a date parameter in a
BI Publisher data model?  
You can use the same sysdate function {$SYSDATE ()$} that's used to default a date in the parameter and specify the
date format string as yyyy.

Here are the settings:

Attribute Name Attribute Value

Name p_year

Data Type Date

Default Value {$SYSDATE()$}

Parameter Type Date

Display Label Enter Year (YYYY Format)

Text Field Size 4

Options (Ignore User Timezone) Checked

Date Format String yyyy

Can I display sales territory change history in the UI?  
No, but you can create a report of the changes instead. The Change History subtab doesn't display sales territory
changes. However, you can enable audits of territory management using the setup task Manage Audit Policies in the
Setup and Maintenance work area, and then view the report in the Audit Reports work area, which is available in the
Navigator, Tools section.

To set up auditing, you must be a setup user, a sales administrator, or have another job role that includes the Manage
Sales Audit Policies privilege (FND_MANAGE_SALES_AUDIT_POLICIES_PRIV).

Saved searches are displayed in alphabetic order. Can I
reorder them?  
No. Saved searches are always displayed in alphabetic order. The only way to change the order is to rename them.
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How do I navigate the Hierarchy Viewer to view account
hierarchies?  
The panel shows default hierarchy rollups, such as:

• Total number of accounts in the hierarchy

• Revenue from won opportunities

• Potential Revenue from open opportunities

• Open opportunities

The Account Hierarchy panel shows the address details and the total child accounts of the parent company of the
account.

Click View Account Hierarchy for more information, such as the subsidiaries of the account, their primary contacts,
and addresses. You can toggle between the tree table view and the grid view. You can use the breadcrumbs to navigate
through the hierarchy. Drill down the Open Opportunities and Won Opportunities columns on the Opportunity
summary tab to view the amounts of individual child records and cumulative amounts of parent records including its
child record amounts.

Why aren't Microsoft Outlook emails syncing to CX?  
You might not have added permissions to the users in Microsoft Azure and in Oracle Sales.

With delegated permissions, when your users' Microsoft token expires (90 days from last sign-in in the add-in), the sync
fails with error until the users re-sign into the add-in.

If you want sync to continue seamlessly without your users needing to sign-in to the add-in every 90 days, then you can
add application permissions for the APIs required for the integration to the application registered in Microsoft Azure.

After you give the extra application permissions to the application in Microsoft Azure, the standard sync scheduled
process uses the permissions to sign in. The add-in, meanwhile, continues to use the existing delegated permissions.

Note:  Only administrators can enable the application permissions.

After you give the extra application permissions, your users need to sign in to the add-in just once and then they don’t
need to open the add-in again.

Add and Enable Application Permissions
To add and enable the application permissions for the add-in:

1. Add the application permissions in Microsoft Azure for the application you created for the Oracle Microsoft 365
add-in.

2. Enable application permissions in the Sales application.
3. Notify your users to sign into the add-in once.
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Add Application Permissions in Microsoft Azure

1. Sign in to Microsoft Azure.
2. Open the application you registered for the Oracle Microsoft 365 add-in.
3. Go to the API Permissions tab and click Add a permission.
4. Select APIs my organization uses.
5. Search for Office and select Office 365 Exchange Online.
6. Click Application Permissions and add the permissions shown in this table:

Permission Option to Select

Calendars Calendars.ReadWrite.All

Contacts Contacts.ReadWrite

Mail Mail.ReadWrite

Mailbox Settings MailboxSettings.ReadWrite

Tasks Tasks.ReadWrite

User User.Read.All

7. Click Add Permissions.
8. On the API permissions page, select Grant admin consent for each permission you added to consent on behalf

of users.

Enable Application Permissions in the Sales Application

1. In the Setup and Maintenance work area, use the Manage Microsoft 365 task:

◦ Offering: Sales

◦ Functional Area: Integrations

◦ Task: Manage Microsoft 365

2. In Synchronization Settings, enable the Enable Microsoft Application Permission option.
3. Click Save and Close.

Why is my new custom field visible in the UI but not
showing in BI?  
It's not enough to publish the sandbox with the custom field. You must also edit the custom subject area and add the
new field.

Related Topics
• Create Custom Subject Areas

• Frequently Asked Questions (FAQs) for Custom Subject Areas
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How do I validate geographies of addresses against
master geographies and generate naming references?  
This scheduled process helps you validate an address against master geography data and generates geography naming
references.

Geography Name Referencing (GNR) process validates address elements in location tables, such as HZ_LOCATIONS,
against the master geography data.

When to Use
This scheduled process validates address data against master geographies. This scheduled process checks whether
geography elements of an address like state, city, postal code, are valid as per master geography data. It also stores
Geography Name Referencing information for the address. Note that geography validation isn’t the same as address
verification. Address Verification depends upon Oracle or any third-party address verification services for verifying
addresses.

You can run this scheduled process for the following reasons:

• When you must generate or refresh the geography naming references data for a location.

• After creating new locations or updating existing locations using import and when geography naming
references generation at the time of creation is turned off.

• When the master geography hierarchy has changed after the geography naming references data is computed
and we require to re-compute the geography naming references data.

• We recommend that the profile option value of the HZ_POST_IMPORT_GNR_INVOKE profile option is set to N.
When this profile option value is set to N, the Validate Geographies of Addresses Against Master Geographies
scheduled process isn't invoked after every import following bulk uploads. Instead, you must schedule
this scheduled process every week during off peak hours. This helps improve the geography data import
performance.

• Schedule this process after loading Persons or Employees in HCM.

The time taken to complete one instance of this scheduled process (GNR job) depends upon the following factors:

• The number of locations or addresses in the application

• The number of validation levels set for a given country

• The number of geographies for the given country

To process a large volume of addresses for a country using this scheduled process, fine tune the following profile
options:

• HZ_GNR_NUM_OF_WORKERS: By default, the value of this profile option is 1. So only one worker job is created.
Increase this number based on the number of jobs you want to use.

• HZ_GNR_COMMIT_SIZE: By default, the value of this profile option is 1000 records. Increase this number based
on the number of records you want to process.
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Privileges Required
Verify that you have the following privilege or role:

• Role:

◦ Application Implementation Consultant

• Privilege:

◦ Run Trading Community Geography Name Referencing Maintenance

Before You Start
Review the following before scheduling this scheduled process:

• Recommended Frequency:

◦ Run this scheduled process whenever the geography naming references data for a location is generated
or refreshed.

• Compatibility:

◦ This process is self-incompatible and also incompatible with the Group Territory Geographies process.

◦ If multiple instances are submitted, the first instance runs and subsequent instances remain in blocked
status until the first instance is completed.

Parameters

Parameter Optional or
Mandatory

Description Parameter Values Special Combinations
Required

Notes

Location Table Name
 

Mandatory
 

Specifies the table
name containing the
address records that
you want to process.
 

HZ_LOCATIONS
 
PER_ADDRESSES_F
 

None
 

The PER_
ADDRESSES_F value
works only for tax
validation and not for
address validation.
For example, if you
are using this GNR
process in HCM and
you select the PER_
ADDRESSES_F option,
 then this scheduled
processes can be used
for tax purposes but
not for validating
employee addresses.
 

Run Type
 

Mandatory
 

Specifies the data
set to be processed.
Specify if you want to
process all records,
 only records that
previously resulted
in error, or only new

ALL
 
ERROR
 
NEW
 

None
 

ALL-Validates all
Locations
 
Error-Re-validates
erroneous records
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Parameter Optional or
Mandatory

Description Parameter Values Special Combinations
Required

Notes

records that were
never processed. The
choice to process
all records can take
considerable amount
of time to complete. In
taxation applications,
 an upgrade parameter
is available, if the
application is installed
at the time of upgrade.
If you already
processed all records
or upgraded recently,
 you may select only
the New or the Error
parameter.
 

NEW-Validates new
locations
 

Usage Code
 

Optional
 

Specifies the
validation usage
code. This parameter
specifies whether
the GEOGRAPHY
or TAX validation
must be run. Specify
to run the program
for either the tax or
geography validation
usage. The program
provides results
that correspond
to validation rules
associated with the
selected usage.
 

GEOGRAPHY
 
TAX
 

None
 

Use GEOGRAPHY for
address validation.
 

Country Code
 

Optional
 

Specifies the ISO
Country Code for
which the process is
run. Enter the country
for which addresses
must be processed.
 

Example: US
 

None
 

N/A
 

From Location ID
 

Optional
 

Specifies the
beginning Location ID
from which validation
should be run
 

Numeric Value
 

From Location ID
should be less than To
Location ID
 

N/A
 

To Location ID
 

Optional
 

Specifies the ending
Location ID till which
validation should be
run
 

Numeric Value
 

To Location ID should
be greater than From
Location ID
 

N/A
 

Start Date
 

Optional
 

Specifies the begin
Location Effective
Start Date
 

Date
 

Format : YYYY/MM/
DD
 
Example: 2019/12/24
 

N/A
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Parameter Optional or
Mandatory

Description Parameter Values Special Combinations
Required

Notes

Start Date should be
lower than End Date
 

End Date
 

Optional
 

Specifies the begin
Location Effective End
Date
 

Date
 

Format : YYYY/MM/
DD
 
Example: 2019/12/24
 
End Date should be
higher than Start Date
 

N/A
 

Geography Name Referencing (GNR) records are created for addresses based on the country structure for a particular
country and the validations defined on that structure. The following table displays the relationship between validations
defined and the creation of GNR records. It also shows how the records change when correct or incorrect data are
provided as values for addresses.

Use Case Address Validations
Defined

Address GNR Records GNR Map Status

Correct data with no
validations

None Country: US
 
State: CA
 
City: Redwood City
 
Postal Code: 94065
 

GNR record created for
country

Success

Correct data with
validations turned on for all
levels

Country: US
 
Validations Defined for:
State, County, City, Postal
Code
 

Country: US
 
State: CA
 
City: Redwood City
 
Postal Code :94065
 

GNR Records created for
country, state, county,city
and postal code

Success

Correct date with validation
defined only for last level

Country: US
 
Validations Defined for:
Postal Code
 

Country: US
 
State: CA
 
City: Redwood City
 
Postal Code: 94065
 

GNR Records created for
country, state, county,city
and postal code

Success

Correct date with validation
defined only for last level.
Postal Code is unique and

Country: US
 

Country: US
 
State: CA

GNR Records created for
country, state, county,city
and postal code.

Success
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Use Case Address Validations
Defined

Address GNR Records GNR Map Status

falls within single city in the
county.

Validations Defined for:
Postal Code
 

 
City:
 
Postal Code: 94065
 

Correct data with validation
on middle level

Country: US
 
Validations Defined for: City
 

Country: US
 
State: CA
 
City: Redwood City
 
Postal Code: 94065
 

GNR Records created for
country, state, county,city
and postal code

Success

Correct data with validation
on middle level.
 
Postal Code is unique and
falls within single city in the
county.
 

Country: US
 
Validations Defined for: City
 

Country: US
 
State: CA
 
City: <NULL>
 
Postal Code: 94065
 

GNR Records created for
country, state, county,city
and postal code .

Success

Incorrect data for last level
with validation on middle
level

Country: US
 
Validations Defined for: City
 

Country: US
 
State: NY
 
City: New York
 
Postal Code: 1111
 

GNR Records created for
country, state, county and
city

Success

Incorrect data for last levels
with validation on middle
level

Country: US
 
Validations Defined for:
State
 

Country: US
 
State: CA
 
City: Abc
 
Postal Code: 94065
 

GNR Records created for
country and state

Success

Incorrect data for last levels
with validation on middle
level

Country: US
 
Validations Defined for:
State
 

Country: US
 
State: CA
 
City: Redwood City
 
Postal Code: 111
 

GNR Records created for
country, state, county and
city

Success
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Use Case Address Validations
Defined

Address GNR Records GNR Map Status

Incorrect data for last level
with validations turned on
for all levels

Country: US
 
Validations Defined for:
State, County, City, Postal
Code
 

Country: US
 
State: CA
 
City: Redwood City
 
Postal Code: 10027
 
(assume 10027 postal code
does not exist)
 

GNR Records created for:
 
Country
 
state
 
county
 
city
 

Error

Incorrect data for middle
level followed by correct
data on subsequent levels
with validations turned on
for all levels

Country: US
 
Validations Defined for:
State, County, City, Postal
Code
 

Country: US
 
State: CA
 
City: Xyz
 
Postal Code: 94065
 

GNR Records created for:
 
Country
 
State
 

Error

Incorrect data for middle
level with validation defined
only for last level

Country: US
 
Validations Defined for:
Postal Code
 

Country: US
 
State: CA
 
City: Abc
 
Postal Code: 94065
 

GNR Records created for
country and state

Error

Correct data with validation
defined only for last level.
Same Postal Code is in
two cities (which are in the
same county).

Country: US
 
Validations Defined for:
Postal Code
 

Country: US
 
State: CA
 
City: <NULL>
 
Postal Code: 94065
 

GNR Records created for
Country, State, County

Error

Related Topics
• How do I manage geography validation?

• Address Validation using Geography Naming Reference (GNR) Report

• Setting Up Geography Validation

• How can I save an address that didn't pass geography validation?
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What's the maximum number of custom objects that we
can create using Application Composer?  
There's no fixed limit on the number of custom objects that you can create using Application Composer.

What's the maximum number of mashups that we can
create using Application Composer?  
There is no technical restriction on the number of mashups allowed, since mashups are just iFrames embedded in a
Fusion application.

Do I still need to run the Synchronize CRM Search
Indexes process if I'm using Workspace?  
No. Workspace and most of the Sales work areas use Adaptive Search, a different and newer search technology. You
must run the Synchronize CRM Search Indexes process only if you’re still using some of the legacy work areas that use
the older CRM search.

How do I create a custom saved search to share with
everyone?  
After you create a custom saved search, it’s initially visible only to you. Here’s how to ensure that its shared with the
whole sales organization when you've migrated the changes to your production environment.

1. Navigate to the work area from where you want to share your custom saved search.
2. Click in the search field and select Manage Saved Searches.
3. From the Visible To list, select Me.
4. Click Actions (the three dots in the Actions column) for the saved search you want to share and select Edit.
5. From the Shared With list, select Everyone.
6. Click Save.
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How many assignment subprocesses can be run for each
Service server available in my environment?  
The maximum number of subprocesses that can be run is based on the number of Service servers available in your
environment. Each server can process a maximum of 16 subprocesses (threads).

For example, lets say that you Production environment shows 25 processes with record counts on each subprocess
but your Development environment only shows 25 processes with record counts on 15 subprocesses. The other 10
subprocesses show a record count of 0. The totals and sum of the processes is correct for 15 subprocesses but 10
subprocesses show with 0 records. This is expected behavior based on the number of Service servers available in your
environment. In our example, the Development environment has 1 server so when you submit a job with 25 processes,
only a maximum of 16 subprocesses (threads) can start with no other process using any threads.

In the given scenario, 15 subprocesses started and 10 subproceses are waiting to get the threads. Those 15 subprocesses
did all the processing of records and that's why you'll see the behaviour as outlined.

How do I create BI reports for past periods?  
You can use the Time dimension in the subject areas to report on the desired dates. Keep in mind that to see the correct
dates, you must have the accounting calendar set up in the application.

How do I import subscription product bill line data?  
You can use import management to create or update Subscription Product Bill records.

To import Subscription Product Bill records, perform the following tasks:

1. Map your source data to Oracle Applications Cloud object attributes.
2. Create source Comma Separated Values (CSV) file for import.
3. Create the import activity.
4. Review the import results.

How You Map Your Source Data to Target Object Attributes
To import your Subscription Product Bill data into Oracle Applications Cloud, you need to populate a CSV file with your
source data and map that source data to target object attributes in Oracle Applications Cloud.

You need to do the following before creating the CSV file for data import:

• Identify how your source data attributes map to the target object attributes in Oracle Applications Cloud.

• Ensure prerequisite setups are done, if applicable.
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• Understand your options for uniquely identifying the records.

• Ensure parent records exist before importing child records.

• Identify the target object attributes that are required in the CSV file for a successful import.

Before You Start
You must do some basic checks before starting your import. For example, make sure that:

• You have completed all the prerequisites for importing each attribute in your source data.

• You have all parent records in place before importing child records.

Select a Unique Identifier for Your Records
To import data into Oracle Applications Cloud, your CSV file must include some specific attributes that enable the
import process to uniquely identify the records. The file import process uses the attribute values to automatically map
your source data to the target object attributes in Oracle Applications Cloud.

The preferred option for uniquely identifying an object record is through the Public unique identifier. If you're creating
new records, then you can provide a user-friendly public unique identifier (attributes denoted with 'Number' and usually
visible in the business object's UI). If you update a record for which you have previously provided a Number attribute, or
for which a Number attribute is visible in the object's UI, you can use the Number attribute to identify the record. For the
Subscription Product Bill object, the attributes are CoveredLevelPuid, PrePaymentNumber and SequenceNumber.

Required Attributes and Validations for Subscription Product Bill Object
To import data successfully into Oracle Applications Cloud, your CSV file must include the required attributes. Ensure
that you provide valid values for the attributes. This table lists the required attributes for importing new Subscription
Product Bill records, required attributes for updating Subscription Product Bill records, prerequisite setup tasks for the
attributes, and specific validations, if any, for Subscription Product Bill import:

Attribute Description Prerequisite Setup Task/
Import Validations

Creating a Subscription
Product Bill Record

Updating an Existing
Subscription Product Bill
Record

DateBilledTo
 

The date up to which the
subscription product is
billed
 

This must be a valid date.
 

Required
 

Not required
 

RecurringFlag
 

Option indicating whether
this line is recurring.

Note:  Pass recurring
flag as 'Y' if you need to
create Credit Memo.

 

Y or N
 

Required
 

Not required
 

BillingPeriod
 

The billing period
 

This must be a positive
number and unique for the
product.
 

Required
 

Not required
 

DateToInterface The date to interface This must be a valid date. Not Required Not required
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Attribute Description Prerequisite Setup Task/
Import Validations

Creating a Subscription
Product Bill Record

Updating an Existing
Subscription Product Bill
Record

     

DateBilledFrom
 

The date from which the
subscription product is
billed
 

This must be a valid date.
 

Required
 

Not required
 

BillLineId
 

The bill line ID
 

Do not pass any value.
 

Not Required
 

Not required
 

InterfacedFlag
 

Option indicating whether
the bill line is interfaced
 

Y or N
 

Required
 

Not required
 

SubscriptionProductPuid
 

The subscription product
PUID
 

This must be a valid
subscription product PUID.
 

Required
 

Not required
 

SubscriptionId
 

The subscription ID.
 

Do not pass any value.
 

Not Required
 

Not required
 

SubscriptionProductId
 

The subscription product
ID.
 

Do not pass any value.
 

Not required
 

Not required
 

BillLinePuid
 

The bill line PUID.
 

This must be a unique bill
line PUID.
 

Required
 

Required
 

Amount
 

The amount
 

This must be a positive
number.
 

Required
 

Not required
 

UsageFlag
 

Option indicating whether
the line is a usage line.
 

Y or N
 

Required
 

Not required
 

UsageAcquiredFlag
 

Option indicating whether
the usage has been
acquired.
 

Y or N
 

Not required
 

Not required
 

UsagePricedFlag
 

Option indicating whether
usage line has been priced.
 

Y or N
 

Not required
 

Not required
 

TransactionClass
 

The transaction class.
 

This must be INV for
invoice and CM for credit
memo.
 

Required
 

Not required
 

TransactionTax
 

The transaction tax.
 

This must be a positive
number.
 

Not required
 

Not required
 

TransactionAmount
 

The transaction amount.
 

This must be a positive
number.
 

Not required
 

Not required
 

InvoiceBillLineId
 

The invoice bill line ID.
 

Do not pass any value.
 

Not required
 

Not required
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Attribute Description Prerequisite Setup Task/
Import Validations

Creating a Subscription
Product Bill Record

Updating an Existing
Subscription Product Bill
Record

UsageCaptureDate
 

The usage capture date.
 

This must be a valid date.
 

Not required
 

Not required
 

UsageQuantity
 

The usage quantity.
 

This must be a positive
number.
 

Not required
 

Not required
 

ChargePeriod
 

The charge period.
 

This must be a valid charge
period.
 

Not required
 

Not required
 

PricingError
 

The pricing error.
 

Do not pass any value.
 

Not required
 

Not required
 

ListPrice
 

The list price.
 

This must be a
positive number when
TransactionClass is INV and
a number when it's CM.
 

Required
 

Not required
 

RevenueLineId
 

The revenue line ID.
 

Do not pass any value.
 

Not required
 

Not required
 

TransactionClassMeaning
 

The meaning of transaction
class lookup.
 

Invoice or Credit Memo
 

Not required
 

Not required
 

InvoiceDate
 

The invoice date.
 

This must be a valid date.
 

Not required
 

Not required
 

NewCreditMemoPUID
 

The credit memo PUID.
 

Do not pass any value.
 

Not required
 

Not required
 

CreditMemoAmount
 

The credit memo amount.
 

Do not pass any value.
 

Not required
 

Not required
 

CreditMemoFlag
 

The credit memo option.
 

Do not pass any value.
 

Not required
 

Not required
 

CreditMemoReason
 

The credit memo reason.
 

Do not pass any value.
 

Not required
 

Not required
 

CustomerTrxTypeSequenceId
 

The customer transaction
type sequence ID.
 

This must be a number.
 

Not required
 

Not required
 

CoveredLevelId
 

The covered level ID.
 

Do not pass any value.
 

Not required
 

Not required
 

ChargeId
 

The charge ID.
 

This must be a valid charge
ID.
 

Required
 

Not required
 

You can view the Subscription Product Bill object along with all its child objects and attributes in the Manage Import
Objects page of the Import Management flow. You can find attribute information like type, length, description, and so
on, on this page.
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Note:  Total cost value (TCV) isn't automatically calculated while importing bill lines. You need to manually calculate
it and add it to header and product level. You can automatically calculate the TCV and generate bill line by setting
Generate Billing to Y in header.

Note:  To import Subscription Bill Line Credit memo, you must include BillLinePuid, CreditMemoAmount,
CreditMemoFlag, and CreditMemoReason attributes in the CSV file. The BillLinePuid should be the PUID of the existing
Invoice Bill Line for which a Credit memo needs to be added.

Create the Source CSV File
You include the data that you want to import into Sales and Fusion Service in a source CSV file.

You can use the templates available in the Import Objects UI page to create the source CSV file. To download a template:

1. Go to Navigator  > Tools >  Import Management >  Import Objects.
2. Select the Subscription Product Bill object in the table and click Download.

You can now edit the downloaded file and provide valid values for the required attributes.

Note:  For help in populating the CSV file and to avoid any issues in entering values, see the topic Potential Issues
When Opening CSV Files With Excel in Related Topics section.

Create the Import Activity
After you have the CSV file ready, create an import activity to import the information. To create an import activity:

1. Go to Navigator  > Tools >  Import Management >  Import Queue.
2. Click Create Import Activity in the Manage Imports page.
3. In the Enter Import Options page, provide a name for the import activity, and select Subscription Product Bill

from the Object drop-down list.
4. Select the CSV file in the File Name field, and click Next.
5. You would see that the source and target attributes are automatically mapped in the Map Fields page. Review

and edit the mappings if required.
6. Check the file for unmapped columns or data format issues by clicking Validate Data. Click Next.
7. Review the import details on the Review and Submit page, and click Submit when you're ready.

Review the Import Results
Check if your import succeeded on the Manage Imports page. This page shows the status of all active, completed, and
unsuccessful imports. To check the status of the import activity:

1. Go to Navigator  > Tools >  Import Management >  Import Queue.
2. Click All Imports and search for the import activity that you created earlier.
3. Check the Status column for the import activity. The import is successful if the status displays as Completed.

You can drill down on the import activity to go to the Import Status page which provides the status details of
the import activity.
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Related Topics
• How do I import data?

• Potential Issues When Opening CSV Files in Excel

How can I enable the Mass Update feature in Workspace?
 
You can enable the Mass Update feature in Workspace using the Parameters tab available in the Adaptive Search setup
page.

You can perform some actions on multiple records at the same time. For example, you can select multiple leads in
Workspace and qualify them at once by selecting the Qualify action. This saves you time and helps improve efficiency.

Here's how to edit Adaptive Search parameters to enable the mass update feature.

1. Click Navigator  > My Enterprise  >  Setup and Maintenance.
2. In the Setup and Maintenance work area, go to:

◦ Offering: Sales

◦ Functional Area: Sales Foundation

◦ Task: Configure Adaptive Search

3. On the Configure Adaptive Search page, click the Parameters tab.
4. Highlight the Enable Mass Update parameter and click Edit. This warning is displayed.

You're about to change parameters that control how Adaptive Search works. 
Changes should only be carried out by search setup experts. Do you want to 
continue?

5. Click Yes.
6. In the Current Value field, change the default value of N (No) to Y (Yes) to turn on the mass update feature and

click Save and Close.

How do I manage party usages?  
Party Usages describe how parties can be used across the application in business flows. Use this procedure to create
and edit party usages.

Create Party Usages

1. In the Setup and Maintenance work area, go to the following:

◦ Offering: Customer Data Management
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◦ Functional Area: Trading Community Foundation

◦ Task: Manage Party Usages

2. Click Actions >  Create.
3. Specify the following information in the Overview section of the page:

◦ Specify the code for the party usage. You can't change the code of an existing party usage.

◦ Specify a name.

◦ Select the type of party usage.

◦ (Optional) Provide a description.

4. Specify the following information in the Assignment section of the page:

◦ If you have identified business events that can create an assignment to a party, select Restrict Manual
Assignment.

◦ If the bulk import or manual assignment can create an assignment, select Unconditional Assignment.

Note:  The Unconditional Assignment isn't available for predefined party usages.

◦ If you want to restrict only business events that you identified to update an assignment to a party, select
Restrict Manual Update.

◦ Select Relationship Causes Assignment to allow an assignment to a party if a party relationship is
created.

◦ (Optional) Provide descriptions.

5. In the Exclusivity Rules section, specify the from and to dates during which the party usage is assigned
exclusively.

6. In the Incompatibility Rules section, select the party usages which can't be assigned along with the selected
party usage. For example, you can specify for a prospect party usage that a party couldn't have a prospect
usage and customer usage at the same time. You can also specify the time period during which the selected
party usages can't be assigned.

7. In the Transition Rules section, specify the party usage which the selected party usage transitions to. You can
also specify the time period when the transition starts and, optionally, ends. For example, when a party that
currently has the applicant party usage is assigned the student party usage, the applicant usage is set with an
end date.

8. Click Save and Close.

Edit Party Usages

1. In the Setup and Maintenance work area, go to the following:

◦ Offering: Customer Data Management

◦ Functional Area: Trading Community Foundation

◦ Task: Manage Party Usages

2. Click Actions >  Edit.
3. Change the following information in the Overview section of the page:

◦ Edit the name.

◦ Edit the description as needed.

4. Select or clear the selection for the following information in the Assignment section of the page:
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◦ If you have identified business events that can create an assignment to a party, select Restrict Manual
Assignment.

◦ If the bulk import or manual assignment can create an assignment, select Unconditional Assignment.

Note:  The Unconditional Assignment isn't available for predefined party usages.

◦ If you want to restrict only business events that you identified to update an assignment to a party, select
Restrict Manual Update.

◦ Select Relationship Causes Assignment to allow an assignment to a party if a party relationship is
created.

◦ Edit or provide the descriptions.

5. Add or update from and to dates during which the party usage is assigned exclusively in the Exclusivity Rules
section. Or, change or delete the existing dates.

6. Modify the party usages which can't be assigned along with the selected party usage in the Incompatibility
Rules section. For example, you can specify for a prospect party usage that a party couldn't have a prospect
usage and customer usage at the same time. You can also specify the time period during which the selected
party usages can't be assigned. Or, change or delete the existing rules.

7. In the Transition Rules section, update the party usage which the selected party usage transitions to. You can
also specify the time period when the transition starts and, optionally, ends. For example, when a party that
currently has the applicant party usage is assigned the student party usage, the applicant usage is set with an
end date. Or, change or delete existing transition rules.

8. Click Save and Close.

How can we use the Contains operator for the Accounts
field while searching activities?  
Use Workspace or Sales in the Redwood user experience for your searches. These newer interfaces, which use Adaptive
Search, already include the Contains operator.

Can I change the accounting calendar after it's being
used in transactions?  
Once you set up your accounting calendar and start using it in transactions, you can't change it, like, for example,
changing it from calendar year to fiscal year.

You usually create a single accounting calendar as part of your implementation. The accounting calendar defines the
time periods used in the applications. When you create the calendar, you specify the exact dates for each period.

These defined periods, often called enterprise periods, are used for many purposes in the applications. Examples
include:

• Reports that provide amounts by enterprise period, such as a sales pipeline analysis

• Metrics calculations by period for territory analysis
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• The ability to adjust forecast amounts by time period

• Distribution of quota amounts by time period

Thus, after you have transactions created against your accounting calendar, you can't modify it.

How do I manage import objects?  
Import Objects correlate with the tables in Oracle Applications. Understand import objects and their attributes to
manage the data that you want to import. Objects for which you don't have license or access won't show up in the UI.

Import Object Details
Click Tools > Import Management > Import Objects. To see the details of an import object, select it on the Import
Object Details page. Here are the details that you see about each importable object.

Column Description

Display Name
 

The object as it's called in the User Interface.
 

Language Independent Code
 

The internal name of the object.
 

Parent Object
 

The parent object of the selected object. If there are multiple parents for an object, they're shown
separated by comma.
 

View Hierarchy
 

Clicking on the View Hierarchy icon shows the hierarchy between the parent and child objects in a
graphical format.
 

User Key
 

The attribute or the group of attributes that's used to uniquely identify a record.
 

Required Attributes
 

The attribute or the group of attributes for which values are required to create a record. These can't be
NULL when updating a record.
 

Description
 

A short description of the object.
 

Download
 

Link to download the import object template files for each object and its child objects.
 

Target Attributes
Here are the details that you see for each target attribute.

Column Description

Display Name Name of the target attribute in the User Interface.
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Column Description

  

Attribute Name
 

Internal or field name of the attribute.
 

Required
 

Indicates whether the attribute is mandatory or not.
 

Default Value
 

The default value for the attribute, if any.
 

Type
 

Data type of the target attribute.
 

Length
 

Maximum allowed length for the target attribute values.
 

Description
 

A short description of the target attribute.
 

Related Topics
• Define Objects

What do I do if I can't see the account hierarchy in the
Redwood user experience?  
You must run the Refresh Denormalized Data for Account Hierarchy process to see the hierarchy.

Here's how to run the process:

1. From the Navigator open the Schedule Processes work area (Navigator > Tools > Schedule Processes).
2. Click Schedule New Process.
3. In the Schedule New Process window, click the Search Name (the down arrow button).
4. Scroll down to the end of the list and click Search.
5. In the Name field, enter: Refresh Denormalized Data for Account Hierarchy.
6. Click Search.
7. Select the row with the search result.
8. Click OK two times.
9. In the Process Details dialog box. Click the Advanced button.

10. Under Advanced Options, Parameters tab, set Full Refresh to Yes.
11. Go to Schedule tab and select the Using a schedule option
12. Select a frequency for the refresh. For example, if the hierarchy is changed often, select Daily, Weekly, or

Monthly.
13. Click Submit.
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Why can't I find the Service Requests tab for Accounts?  
If the Service Requests subtab isn't visible in the Account object, check that it's enabled in Application Composer.

1. Navigate to Setup and Maintenance
2. Select Service as the Offering.
3. Click Actions > Edit Implementation Status.
4. Ensure that Implemented is selected.

When should I run the Adaptive Search publish process? 

Adaptive Search requires several background processes to run periodically. Oracle recommends that you perform a full
publish each time you do a production to test (P2T) environment refresh and when you change your Adaptive Search
configuration.

Can I change how opportunity territory-based
assignment automatically assigns by opportunity owner?
 
No, you can't change the standard default application behavior when assigning opportunity territories to the
opportunity owner. However, if you want more territories to be assigned to an opportunity, for example based on
revenue, then as a workaround, you can create customer centric territories using a product dimension.

After you set up your territories, territory-based assignment matches territory dimensions and attributes to work
objects. You can set up territory-based assignment to be completely automated, to happen on-demand, or you can
use a combination of these settings. Territory-based assignment requires that you set up your territories and resource
hierarchy, set profile options to configure assignment, and run assignment processes.

In addition, you can also use rule-based assignment to set up more rules used to assign resources to work objects.
Rule-based assignment lets you capture attributes not defined in territory-based assignment. Once you set up the rules
containing conditions that records must meet, then resources get assigned to the object when they match the rule
conditions.
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Can I specify multiple parallel approvers when
configuring my business process flow?  
Yes. You can change the default template to design either a parallel or serial business process flow and save it as a new
project. A parallel approval is where any one approval is enough from the approvers specified in the process flow.

A serial approval is where all the approvals are required sequentially from the specified approvers. See Set Up Parallel
Approval for more information about creating an approval workflow that requires approval from a group of people, in
any order.

Related Topics
• Configure an Approval Process for Opportunities

How can I create an address style format layout?  
Click New in the Manage Address Formats page and add address lines in the Format Variation Layout section. If you
require more than one address style format layout, then you can create a format variation and add a different address
format layout.

How can I create a variation of an Address Style Format? 

You can create different variations of an address style format, with each variation having its own layout.

For example, a country's postal address may have variations such as general postal address, rural address, and military
address. When you create an address style format, the layout defined for the format is assigned as the default variation.
Click Add in the Format Variation region of the Edit Address Style Format page, for the address style format, to add
a variation of the Address style. For each address style format variation, you can enter a variation rank to define the
priority of the variation.

What is a Batch Assignment Progress Report?  
You can generate a batch assignment progress report to show you a variety of details about your assignment processes.

The batch assignment progress report indicates the number of records processed, unprocessed, successful or failed,
and the number of records processed per minute for a process. The report provides details of assignment processing
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for multiple batch assignment processes and their sub-processes. You can run this report while a batch assignment
process (accounts, leads, opportunities, revenue, or partner accounts) is running, or after a process has completed.

Access the Diagnostic Dashboard to generate the batch assignment progress report. The report includes two tables, one
with details of the main process, followed by details of the sub-processes. The second table with sub-processes appears
only if the Include Sub Process parameter is set to True.

Input Parameters

The report has the following input parameters:

Input Parameter Description

Parent Process ID
 

Identifiers for the parent scheduled processes.
 
You can enter multiple process IDs.
 

From Date
 

Select the start date.
 

To Date
 

Select the end date.
 

Include Sub Processes
 

Select True to include sub-processes. The default value is False.
 

Example Report

Here is an example of a batch assignment progress report, along with description of what each value means:

Column Sample Value Description

Parent Process ID
 

504
 

Identifier for the scheduled process
 

Work Object
 

SalesAccount_Work_Object
 

Code for the work object
 

Candidate Object
 

SalesAccountTerritory_Candidate_Object
 

Code for the candidate object
 

Submitted By
 

Sales_admin
 

User name of the person submitting the
process
 

Process Status
 

Running
 

Status of the process, such as, Not Started, In
Progress, or Canceled
 

Process Start Time
 

11/19/12 8:48 PM UTC
 

Start Time of the process. Shows date, hours,
 and minutes
 

Process End Time
 

11/19/12 8:56 PM UTC
 

End Time of the process. Shows date, hours,
 and minutes
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Column Sample Value Description

Process Elapsed Time (Minutes)
 

22
 

Number of minutes the process has been
running
 

Records per Minute
 

10.46
 

Number of records processed per minute
 

Number of Sub Processes
 

10
 

Number of sub-processes launched from the
parent process
 

Number of Records
 

100000
 

Number of records in the process
 

Number Not Processed
 

94452
 

Number of records not yet processed
 

Number Successful
 

5542
 

Number of records successfully processed
 

Number Failed
 

6
 

Number of records failed
 

Failure Rate
 

0.00006
 

Number of failures divided by the Number of
items
 

Assignment Elapsed Time
 

21.45
 

Number of minutes the assignment processing
has been running
 

Records Processed Last 10 Minutes
 

12.63
 

Number of records processed in the previous 10
minutes
 

Number of Retries
 

0
 

Number of times the process has been
resubmitted
 

You can also use the report to estimate the time it will take to complete a batch assignment process. This report
provides details on the number of records completed and the number of records in progress. You can generate this
report repeatedly to conduct performance analysis of the batch assignment processing.

Related Topics
• Example of Generating Assignment Reports

How do I request account assignment?  
Use the Request Account Assignment scheduled process to request territory assignments for specified accounts.
An account represents a company or person you sell to. If your business sells to a contact or household, an account
represents the contact and household you sell to.
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Assignment manager lets you assign territories related to your sales accounts, including customers, prospective
customers, individual contacts, and households. You can use assignment rules defined for accounts only to filter the
territories that are assigned to accounts.

When to Use
Use this scheduled process in the following cases:

• By default, accounts are assigned automatically when the account is created or updated. Alternatively, sales
people with access to the account team can run assignment for a specific account.

• You can run this scheduled process to run account assignments in bulk.

• You can run this scheduled process whenever there is a mass change in the account dimensional attributes. For
example, change in address, organization type, organization size, auxiliary classifications, industries, and so on.

• You can run this scheduled process whenever there is any change in territory configuration.

• You can run this scheduled process after running Bulk import so that territories are assigned to the imported
customers.

• Schedule this process if you don't auto assign territories but assign territories periodically.

• This scheduled process processes a set of accounts based on the view criteria chosen. For example, you can
process all accounts modified after a particular date.

• If auto-assignment isn't enabled and this scheduled process isn't run, territories won't be assigned to accounts.
The visibility of the accounts (view or edit access) is impacted, if you use territory-based data security.

• For a list of profile options that impact this feature, see the Related Topics section.

Privileges Required
Verify that you have the following roles or privileges:

• Roles:

◦ Sales Administrator

• Privileges:

◦ Run Sales Party Batch Assignment

Before You Start
Review the following before scheduling this scheduled process:

• Recommended Frequency

◦ See the table containing the view criteria information in the Parameters section.

• Compatibility:

◦ This scheduled process is incompatible with itself. These scheduled processes should not be requested to
run in parallel against the same opportunity batch, to avoid potential locking issues.

◦ Geography Name Referencing hierarchy data must be setup before running this scheduled process
because the territory assignment uses Geography Name Referencing data.
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◦ Ensure that groovy triggers aren't executed for user IDs that are used for assignments. If this check isn't
performed, groovy triggers are executed for all accounts that get assigned and could lead to performance
issues. For more information about these assignments, see the When are territories assigned to accounts
topic in the Related Topics section.

◦ Multiple instances of this process running simultaneously can cause performance issues.

◦ Don't make any changes to the territory setup while running this scheduled process.

Parameters

Parameter Optional or Mandatory Description Parameter Values Special Combinations
Required

Work Object
 

Mandatory
 

Specify a predefined work
object or the one you
created.
 

Account
 

None
 

Candidate Object
 

Mandatory
 

Specify the candidate
object.
 

Account Territory
 

None
 

Assignment Mode
 

Mandatory
 

Specify the assignment
mode.
 

Territory
 

None
 

Rule Category Name
 

Optional
 

Specify if you're using rule-
based assignment.
 

Don't select any value.
 

None
 

View Criteria Name
 

Mandatory
 

Specify a view criteria name
from the View Criteria table.
 

See the View Criteria table.
 

None
 

View Criteria Bind Values
 

Optional
 

Specify the view criteria
bind values of the
associated view criteria
name from the View
Criteria table.
 

See the View Criteria table.
 

None
 

Replace Team
 

Optional
 

Specify the replace team
information. This option
isn't supported for Sales
Account Assignment.
 

Yes or No
 

None
 

Number of Work Objects
per Sub Process
 

Optional
 

It is recommended that this
value isn't changed. This
number depends upon the
Maximum Sub Processes
per Process parameter's
value.
 

Thousand is the default
value.
 

None
 

Maximum Sub Processes
per Process
 

Optional
 

If the number objects
created is less than 500
thousand, then leave the
default option of 10 as the
maximum number of sub

Ten is the default value.
 

None
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Parameter Optional or Mandatory Description Parameter Values Special Combinations
Required

processes per process. The
following recommendation
is only applicable for
when this process is run
for the first time or for
a complete run for all
objects. However, the next
time you run the process,
 only the changed objects
are processed. If you're
executing incremental
runs at periodic scheduled
times, then there's no need
to update the default value
of 10.
 
Oracle recommends
changing this value if the
number of objects is:
 

• Between 500
thousand and 1 million
objects enter 5

• Greater than 1 million
objects, enter 10

• Greater than 5 million
objects, enter 20

• Greater than 10 million
objects, enter 30

Metrics Logging Interval
 

Optional
 

Used for internal purpose
only.
 

Don't change this value.
100 is the default value.
 

None
 

Test Data Parameters
 

Optional
 

Used for internal purpose
only.
 

Don't change this value.
 

None
 

Diagnostic Mode
 

Optional
 

Used for troubleshooting
purposes.
 

Not applicable.
 

None
 

View Criteria Name View Criteria Description View Criteria Bind Values Recommended Run Frequency

SalesAccountsUpdatedSinceVC
 

Use this view criteria to assign
accounts which haven't been
previously assigned and have
LAST_UPDATED_DATE is greater
than or equals the specified date
and (LAST ASSIGNED DATE is
empty or LAST ASSIGNED DATE is
less than or equal to the specified
date.
 

BindLastUpdateDate= [YYYY-
MM-DD HH:MM:SS]
 

Daily
 

SalesAccountsAssignedBeforeVC
 

Use this view criteria to reassign
accounts which have been

BindLastAssignedDate=
[YYYY-MM-DD]

Daily
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View Criteria Name View Criteria Description View Criteria Bind Values Recommended Run Frequency

previously assigned and have
LAST_ASSIGNED_DATE (in the
ZCA_SALES_ACCOUNTS table) less
than the specified date.
 

 
BindReassignment
BatchId=[Territory
Reassignment Batch ID]
 

SalesAccountTerritoryBatchReassignmentVC
 

Use this view criteria to reassign
accounts impacted by the specified
territory and territory dimensional
realignment batch. This view
criteria is also used internally to
initiate immediate or automatic
assignments after territory
proposal activation and territory
dimension updates.
 

BindReassignment
BatchId=[Territory Reassignment
Batch ID]
 

Run as per business requirements
 

SalesAccountBulkImportVC
 

Use this view criteria to assign
accounts created in a given
customer import batch.
 
This view criteria is also used
internally to initiate immediate/
automatic assignments after
customer import.
 

BindReassignment
BatchId=[Import Activity
ID]
 

Run as per business requirements
 

SalesAccountDimsForPartyVC
 

Use this view criteria to assign the
account with the specified account
ID.
 

BindPartyId= [Sales
Account ID]
 

Run as per business requirements
 

Troubleshooting Information
Use this information to troubleshoot the scheduled process:

• Warning or errors are displayed and details are captured in the scheduled process.

• Use the Diagnostic mode for detailed analysis.

• Use the Batch Assignment Progress Report or the Batch Assignment Error Report to view the details. For more
information about these reports, see the Related Topics section.

Related Topics
• What is a Batch Assignment Progress Report?

• What is a Batch Assignment Error Report?

• When are territories assigned to accounts?

What is a Batch Assignment Error Report?  
Use assignment management functionality to generate batch assignment error report. The batch assignment error
report provides details of the error and warning messages generated while processing individual records during batch
assignment process.
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The report provides a summary of the test input parameters and message details for each record that meets the input
parameters. You can run this report while a batch assignment process (accounts, leads, opportunities, revenues, or
partner accounts) is running, or after a process has completed.

Access the Diagnostic Dashboard to generate the batch assignment error report. The report shows the test parameters
followed by two results tables. The first table provides a summary of the process, and the second table shows details of
the records that meet the criteria entered when running the report.

Report Parameters

Here's a description of the input parameters used to generate the batch assignment error report.

Input Parameter Description

Parent Process ID
 

Identifier for the parent ESS process.
 
You can enter only a single process ID.
 

Assignment Status
 

Enter the status of the assignment, such as, error, succeeded, and so on. The default is error.
 

Work Object Public Unique Identifier
 

This is optional. The value that you enter here will depend on the Identifier Attribute of the work object
being processed in a batch.
 

Range of Records
 

Enter the range of records in a process to report. The default value is the value set in the MOW_DTF_
ERROR_REPORT_MAX_LIMIT profile option.
 
You can change this profile option value in the Manage Administrator Profile Values setup task.
 

Example Report

Here's an example of the Process Summary section of a batch assignment error report:

Process Summary

Work Object Candidate Object Start Time End Time

SalesAccount_Work_Object
 

SalesAccountTerritory_Candidate_
Object
 

2013/2/11 12:13
 

2013/2/11 02:45
 

Here's an example of the Process Details section containing the records that meet the criteria entered when running the
batch assignment error report:

Work Object Public Unique Identifier Assignment Status Message Details

1243213
 

Successful
 

Not applicable.
 

1728224
 

Error
 

225030 MOW_AMENG_AO_ASSERT_ FAILED
An error occurred while loading assignment
object Sales_Account_Work_object. There's a
mismatch between the view object definition
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Work Object Public Unique Identifier Assignment Status Message Details

in the assignment configuration and the actual
view object definition used during assignment
processing. Update and save the assignment
object to register it with the latest view object
definition.
 

1982663
 

Successful
 

Not applicable.
 

2392053
 

Successful
 

Not applicable.
 

Use the batch assignment error report to check if there were errors in the batch assignment process and if a particular
work object record was processed.

Related Topics
• Example of Generating Assignment Reports

When are territories assigned to accounts?  
Internal territories are assigned to accounts in the following scenarios.

• When accounts are created.

• When a sell-to address is added to an existing sales party.

• When accounts are imported in bulk.

• When certain attributes on accounts that correspond with territory assignment dimensions are updated.

• When batch assignment is run.

• When you select the Assign Territories menu action on the Sales Account Team node for the account

• When territories are realigned or when personnel leave the territory or the company.

• When a sales manager reassigns all of the sales representative's account to a different owner that triggers the
reassignment of territories for those accounts to the new owner.
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Note:  The following profile options determine whether territory assignment and reassignment is automatic for
accounts. The default setting for both is YES.

• Sales Account Automatic Assignment on Create Enabled

• Sales Account Automatic Assignment on Update Enabled

Automatic assignments are always enabled following an import, party merge and territory realignment. During initial
implementation and migration, it's possible to create accounts before territories have been set up in the application.
These accounts won't receive any territory assignment because there are no territories. These accounts need to
be explicitly assigned when territories are configured and activated in the application. This is one exception which
doesn't have immediate/automatic assignment. The recommendation is to run a batch assignment to assign these
accounts created at the beginning of the implementation using the view criteria SalesAccountsUpdatedSinceVC.

When you make a field conditionally required on an account, then add the following groovy script before adding your
business logic:

if (userName=='FUSION_APPS_CRM_SOA_APPID'|| userName()=='FUSION_APPS_CRM_ESS_APPID')
return false

Partner territories get assigned to accounts in the following scenarios.

• When a partner-generated lead is approved, all partner territories associated to the partner-generated lead are
automatically assigned to the account.

• Users with the privilege Manage Sales Party Partner Territory can assign partner territories from the account
team UI.

Note:  Territory Management must be implemented to use this feature.

Related Topics
• Overview of Account Assignment Profile Options

• Account Territory Member Access

• How can I add territories to an account?

• Account Team Member Access Levels

What is the security access difference for contacts
created by Customer, Prospect, and Standalone types?  
This topic lists the standalone data security predicates predefined for each of the business objects supported by
Adaptive Search. Data security predicates provide access to object data, the access type, and the data to be accessed.

The data to be accessed can be All, a specific record, or a subset of the data.

Note:  Adaptive Search doesn't support the use of custom data security policies. Customers must use Access Groups
instead as described in the Securing CX Sales and Fusion Service guide.
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The instance set defines the subset of data that limits the condition part of the data resource. For more information, see
the Manage Database Resources section of the Securing CX Sales and Fusion Service guide.

ACCOUNT

This table lists the instance set name and associated description for the Account business object:

Instance Set Name Instance Set Description Required Action Set

HZPARTIESHZ197
 

Access the trading community organization
for table HZ_PARTIES for a trading community
organization that's a partner and the user is a
member of the partner organization.
 

• View Sales Party

• Read

HZPARTIESZBS100105
 

Access the sales party for table HZ_PARTIES
where they're in the management chain of the
account owner.
 

• View Sales Party

• Read

HZPARTIESZBS100106
 

Access the sales party for table HZ_PARTIES
where they're the account owner.
 

• View Sales Party

• Read

HZPARTIESZCM1
 

Access the sales party for table HZ_PARTIES
where user is in the sales account team.
 

• View Sales Party

• Read

HZPARTIESZCM8
 

Access the sales party for table HZ_PARTIES for
all sales parties in the enterprise.
 

• View Sales Party

• Read

HZPARTIESZCM133
 

Access the sales party for table HZ_PARTIES for
all prospects in the enterprise.
 

• View Sales Party

• Read

HZPARTIESZCM134
 

Access the sales party for table HZ_PARTIES for
all customers in the enterprise.
 

• View Sales Party

• Read

HZPARTIESZCM3
 

Access the sales party for table HZ_PARTIES
where user is in the management chain of a
resource who's on the sales account team.
 

• View Sales Party

• Read

HZPARTIESZCM39
 

Access the sales party for table HZ_PARTIES
where user is a member of the territory
associated with the sales account.
 

• View Sales Party

• Read

HZPARTIESZCM4
 

Access the sales party for table HZ_PARTIES
where user is in the sales account team with
edit access.
 

• View Sales Party

• Read

HZPARTIESZCM40
 

Access the sales party for table HZ_PARTIES
where user is a member of the territory that's
an ancestor of the territory associated with the
sales account.
 

• View Sales Party

• Read
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Instance Set Name Instance Set Description Required Action Set

HZPARTIESZCM44
 

Access the sales party for table HZ_PARTIES
where user is in the management chain of a
resource who's on the sales account team with
edit access.
 

• View Sales Party

• Read

HZPARTIESZCM45
 

Access the sales party for table HZ_PARTIES
where user is in the sales account team with full
access.
 

• View Sales Party

• Read

HZPARTIESZCM46
 

Access the sales party for table HZ_PARTIES
where user is in the management chain of a
resource who's on the sales account team with
full access.
 

• View Sales Party

• Read

HZPARTIESZCM51
 

Access the sales party for table HZ_PARTIES
where user is the owner of the territory
associated with the sales account.
 

• View Sales Party

• Read

HZPARTIESZCM52
 

Access the sales party for table HZ_PARTIES
where user is the owner of the territory that's
an ancestor of the territory associated with the
sales account.
 

• View Sales Party

• Read

HZPARTIESZCA99968
 

Access the accounts where they're in access
groups.
 

• View Sales Party

• Read

ACTIVITY

This table lists the instance set name and associated description for the Activity business object:

Instance Set Name Instance Set Description Required Action Set

ZMMACTYACTIVITIESZMM1398
 

Access the activity for table ZMM_ACTY_
ACTIVITIES where they're only an owner of an
activity (1=1).
 

• View Activity

• Read

ZMMACTYACTIVITIESZMM1399
 

Access the activity for table ZMM_ACTY_
ACTIVITIES where they're only a delegator of an
activity (1=1).
 

• View Activity

• Read

ZMMACTYACTIVITIESZMM1400
 

Access the activity for table ZMM_ACTY_
ACTIVITIES where they're in the management
chain of an owner only of an activity.
 

• View Activity

• Read

ZMMACTYACTIVITIESZMM1401
 

Access the activity for table ZMM_ACTY_
ACTIVITIES where they're in the management
chain of a delegator only of an activity.
 

• View Activity

• Read
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Instance Set Name Instance Set Description Required Action Set

ZMMACTYACTIVITIESZMM1402
 

Access the activity for table ZMM_ACTY_
ACTIVITIES where they're only a resource of an
activity.
 

• View Activity

• Read

ZMMACTYACTIVITIESZMM1403
 

Access the activity for table ZMM_ACTY_
ACTIVITIES where they're in the management
chain of a resource only of an activity.
 

• View Activity

• Read

ZMMACTYACTIVITIESZMM1404
 

Access the activity for table ZMM_ACTY_
ACTIVITIES where they're the owner of an
account associated with an activity.
 

• View Activity

• Read

ZMMACTYACTIVITIESZMM1405
 

Access the activity for table ZMM_ACTY_
ACTIVITIES where they're on the sales account
team and the sales account activity that's in
their management hierarchy.
 

• View Activity

• Read

ZMMACTYACTIVITIESZMM1406
 

Access the activity for table ZMM_ACTY_
ACTIVITIES where they're on the sales account
territory and the sales account activity that's in
their territory hierarchy.
 

• View Activity

• Read

ZMMACTYACTIVITIESZMM1408
 

Access the activity for table ZMM_ACTY_
ACTIVITIES where they're on the opportunity
team and the opportunity activity that's in their
management hierarchy.
 

• View Activity

• Read

ZMMACTYACTIVITIESZMM1409
 

Access the activity for table ZMM_ACTY_
ACTIVITIES where they're on the opportunity
territory and the opportunity activity that's in
their territory hierarchy.
 

• View Activity

• Read

ZMMACTYACTIVITIESZMM1410
 

Access the activity for table ZMM_ACTY_
ACTIVITIES where they're on the lead team and
the lead activity that's in their management
hierarchy.
 

• View Activity

• Read

ZMMACTYACTIVITIESZMM1411
 

Access the activity for table ZMM_ACTY_
ACTIVITIES where they're on the lead territory
and the lead activity that's in their territory
hierarchy.
 

• View Activity

• Read

ZMMACTYACTIVITIESZMM47
 

Access the activity for table ZMM_ACTY_
ACTIVITIES for all template activities in the
enterprise.
 

• View Activity

• Read

ZMMACTYACTIVITIESZMM48
 

Access the activity for table ZMM_ACTY_
ACTIVITIES where they're either a resource or a
delegator of an activity.
 

• View Activity

• Read
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Instance Set Name Instance Set Description Required Action Set

ZMMACTYACTIVITIESZMM49
 

Access the activity for table ZMM_ACTY_
ACTIVITIES where they're either a resource or a
delegator of a task or an owner or a delegator
of an appointment or an owner or a delegator
of a call report activity.
 

• View Activity

• Read

ZMMACTYACTIVITIESZMM50
 

Access the activity for table ZMM_ACTY_
ACTIVITIES where they're either the owner or a
delegator of an activity.
 

• View Activity

• Read

ZMMACTYACTIVITIESZMM51
 

Access the activity for table ZMM_ACTY_
ACTIVITIES where they're in the management
chain of an activity resource.
 

• View Activity

• Read

ZMMACTYACTIVITIESZMM52
 

Access the activity for table ZMM_ACTY_
ACTIVITIES where they're in the management
chain for a task activity or they're an owner for
an appointment activity.
 

• View Activity

• Read

ZMMACTYACTIVITIESZMM53
 

Access the activity for table ZMM_ACTY_
ACTIVITIES where they're in the management
chain of the activity owner.
 

• View Activity

• Read

ZMMACTYACTIVITIESZMM54
 

Access the activity for table ZMM_ACTY_
ACTIVITIES for all activities in the enterprise.
 

• View Activity

• Read

ZMMACTYACTIVITIESZMM74
 

Access the activity for table ZMM_ACTY_
ACTIVITIES where they're a participant on the
activity.
 

• View Activity

• Read

ZMMACTYACTIVITIESZMM75
 

Access the activity for table ZMM_ACTY_
ACTIVITIES where they're either a resource or a
delegator of a task or an owner or a delegator
of an appointment or a call report activity.
 

• View Activity

• Read

ZMMACTYACTIVITIESZMM76
 

Access the activity for table ZMM_ACTY_
ACTIVITIES where partner users are resources
in the activity.
 

• View Activity

• Read

ZMMACTYACTIVITIESZMM77
 

Access the activity for table ZMM_ACTY_
ACTIVITIES can edit all activities where users
from their partner company are participating.
 

• View Activity

• Read

ZMMACTYACTIVITIESZMM1413
 

Access the activity for table ZMM_ACTY_
ACTIVITIES where they're in the management
chain of a resource for the primary contact of
an activity.
 

• View Activity

• Read

ZMMACTYACTIVITIESZMM1414
 

Access the activity for table ZMM_ACTY_
ACTIVITIES where they're member of a partner
territory.

• View Activity

• Read
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Instance Set Name Instance Set Description Required Action Set

 

ASSET

This table lists the instance set name and associated description for the Asset business object:

Instance Set Name Instance Set Description Required Action Set

ZCAASSETZCM213
 

Access the Asset for table ZCA_ASSET where
user is a sales party team member of the asset
owner party.
 

• View Asset

• Read

ZCAASSETZCM214
 

Access the Asset for table ZCA_ASSET where
user is in the management chain of a resource
who's a sales party team member of the asset
owner party.
 

• View Asset

• Read

ZCAASSETZCM215
 

Access the Asset for table ZCA_ASSET where
user is a member of the territory associated
with the asset owner party.
 

• View Asset

• Read

ZCAASSETZCM216
 

Access the Asset for table ZCA_ASSET where
user is a member of the territory that's an
ancestor of the territory associated with the
asset owner party.
 

• View Asset

• Read

ZCAASSETZCM224
 

Access the Asset for table ZCA_ASSET where
user is in the management chain of a resource
who's a sales party team member of the asset
owner party with edit access.
 

• View Asset

• Read

ZCAASSETZCM228
 

Access the Asset for table ZCA_ASSET where
user is in the management chain of a resource
who's a sales party team member of the asset
owner party with full access.
 

• View Asset

• Read

ZCAASSETZCM252
 

Access the Asset for table ZCA_ASSET where
user is owner of the territory associated with
the asset owner party.
 

• View Asset

• Read

ZCAASSETZCM253
 

Access the Asset for table ZCA_ASSET where
user is a owner of the territory that's an
ancestor of the territory associated with the
asset owner party.
 

• View Asset

• Read

ZCAASSETZCM254
 

Access the Asset for table ZCA_ASSET where
user is a sales party team member of the asset
owner party with edit access.
 

• View Asset

• Read
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Instance Set Name Instance Set Description Required Action Set

ZCAASSETZCM255
 

Access the Asset for table ZCA_ASSET where
user is a sales party team member of the asset
owner party with full access.
 

• View Asset

• Read

ZCAASSETZCM266
 

Access the Asset for table ZCA_ASSET all assets
in the enterprise where asset owner party is a
prospect.
 

• View Asset

• Read

ZCAASSETZCM268
 

Access the Asset for table ZCA_ASSET all assets
in the enterprise where asset owner party is a
customer.
 

• View Asset

• Read

CAMPAIGN

This table lists the instance set name and associated description for the Campaign business object:

Instance Set Name Instance Set Description Required Instance Name

MKTCAMPAIGNSZCA100054
 

Access groups can view marketing integration
campaigns as a member of an access group
associated to the marketing integration
campaign.
 

• View Marketing Integration Campaign

• Read

CASE

This table lists the instance set name and associated description for the Case business object:

Instance Set Name Instance Set Description Required Instance Name

SVCCASESSVC330
 

Access the cases for table SVC_CASES
where the case is assigned to them or their
subordinate.
 

• View Case Header

• Read

SVCCASEMESSAGESSVC322
 

Access the case messages for table SVC_CASE_
MESSAGES where they're the creator of a
message.
 

• View Case Header

• Read

COMPETITOR

This table lists the instance set name and associated description for the Competitor business object:

Instance Set Name Instance Set Description Required Instance Name

HZPARTIESZCA100184
 

Access the trading community party for table
HZ_PARTIES a member of an access group
associated to the sales competitor.
 

• View Sales Party

• Read
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CONTACT

This table lists the instance set name and associated description for the Contact business object:

Instance Set Name Instance Set Description Required Instance Name

HZPARTIESHZ196
 

Access the trading community person for table
HZ_PARTIES for all people in the enterprise
(1=1). Ensure that View Sales Party action is
enabled.
 

• View Sales Party

• Read

HZPARTIESHZ198
 

Access the trading community person for
table HZ_PARTIES for their trading community
person record.
 

• View Sales Party

• Read

HZPARTIESHZ199
 

Access the trading community person for table
HZ_PARTIES for all persons who are a member
of their partner organization.
 

• View Sales Party

• Read

HZPARTIESZBS100105
 

Access the sales party for table HZ_PARTIES
where they're in the management chain of the
account owner.
 

• View Sales Party

• Read

HZPARTIESZBS100106
 

Access the sales party for table HZ_PARTIES
where they're the account owner.
 

• View Sales Party

• Read

HZPARTIESZBS100108
 

Access the sales party for table HZ_PARTIES
for all customer contacts where they're in the
management chain of a resource who's on the
account team of at least one related account.
 

• View Sales Party

• Read

HZPARTIESZBS100116
 

Access the sales party for table HZ_PARTIES for
all customer contacts where they're a member
of a territory associated with at least one related
account.
 

• View Sales Party

• Read

HZPARTIESZBS100118
 

Access the sales party for table HZ_PARTIES for
all customer contacts where they're a member
of an ancestor territory to a territory associated
with at least one related account.
 

• View Sales Party

• Read

HZPARTIESZBS100119
 

Access the sales party for table HZ_PARTIES
for all customer contacts where they're in the
management chain of a resource who's on the
account team of at least one related account
with full access.
 

• View Sales Party

• Read

HZPARTIESZBS100120
 

Access the sales party for table HZ_PARTIES
for all customer contacts where they're in the
management chain of a resource who's on the
account team of at least one related account
with edit access.
 

• View Sales Party

• Read
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Instance Set Name Instance Set Description Required Instance Name

HZPARTIESZCM1
 

Access the sales party for table HZ_PARTIES
where user is in the sales account team.
 

• View Sales Party

• Read

HZPARTIESZCM133
 

Access the sales party for table HZ_PARTIES for
all prospects in the enterprise.
 

• View Sales Party

• Read

HZPARTIESZCM134
 

Access the sales party for table HZ_PARTIES for
all customers in the enterprise.
 

• View Sales Party

• Read

HZPARTIESZCM169
 

Access the sales party for table HZ_PARTIES
for all customer contacts where they're in the
account team of at least one related account
with edit access.
 

• View Sales Party

• Read

HZPARTIESZCM170
 

Access the sales party for table HZ_PARTIES
for all customer contacts where they're in the
account team of at least one related account
with full access.
 

• View Sales Party

• Read

HZPARTIESZCM173
 

Access the sales party for table HZ_PARTIES
for all customer contacts where they're in the
account team of at least one related account.
 

• View Sales Party

• Read

HZPARTIESZCM3
 

Access the sales party for table HZ_PARTIES
where user is in the management chain of a
resource who's on the sales account team.
 

• View Sales Party

• Read

HZPARTIESZCM39
 

Access the sales party for table HZ_PARTIES
where user is a member of the territory
associated with the sales account.
 

• View Sales Party

• Read

HZPARTIESZCM4
 

Access the sales party for table HZ_PARTIES
where user is in the sales account team with
edit access.
 

• View Sales Party

• Read

HZPARTIESZCM40
 

Access the sales party for table HZ_PARTIES
where user is a member of the territory that's
an ancestor of the territory associated with the
sales account.
 

• View Sales Party

• Read

HZPARTIESZCM44
 

Access the sales party for table HZ_PARTIES
where user is in the management chain of a
resource who's on the sales account team with
edit access.
 

• View Sales Party

• Read

HZPARTIESZCM45
 

Access the sales party for table HZ_PARTIES
where user is in the sales account team with full
access.
 

• View Sales Party

• Read
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Instance Set Name Instance Set Description Required Instance Name

HZPARTIESZCM46
 

Access the sales party for table HZ_PARTIES
where user is in the management chain of a
resource who's on the sales account team with
full access.
 

• View Sales Party

• Read

HZPARTIESZCM51
 

Access the sales party for table HZ_PARTIES
where user is the owner of the territory
associated with the sales account.
 

• View Sales Party

• Read

HZPARTIESZCM52
 

Access the sales party for table HZ_PARTIES
where user is the owner of the territory that's
an ancestor of the territory associated with the
sales account.
 

• View Sales Party

• Read

HZPARTIESZCM158
 

Access the Contacts with one party usage.
 

• View Sales Party

• Read

HZPARTIESZCM415
 

Access the Contacts which aren't created by
Partner User.
 

• View Sales Party

• Read

HZPARTIESZCA99972
 

Access the Contacts where they're in access
groups.
 

• View Sales Party

• Read

CUSTOM

This table lists the instance set name and associated description for the Custom object business object:

Instance Set Name Instance Set Description Required Instance Set

ZCX_OWNER_[OBJECT_NAME]
 

Access the Custom Object where the user is
Owner of the Custom Object.
 

Read
 

ZCX_MGR_HIER_[OBJECT_NAME]
 

Access the Custom Object where the user is in
management chain of the Owner of the Custom
Object
 

Read
 

DEAL REGISTRATION

This table lists the instance set name and associated description for the Deal Registration business object:

Instance Set Name Instance Set Description Required Instance Set

MKLDMDEALSMKL1500
 

Access the deal registration summary for table
MKL_DM_DEALS for all deal registrations in the
enterprise.
 

• View Deal Registration

• Read
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Instance Set Name Instance Set Description Required Instance Set

MKLDMDEALSMKL4021
 

Access the deal registration summary for table
MKL_DM_DEALS where they're a resource on
the deal team with view, edit or full access.
 

• View Deal Registration

• Read

MKLDMDEALSMKL5049
 

Access the deal registration summary for table
MKL_DM_DEALS where they're in the partner
organization.
 

• View Deal Registration

• Read

MKLDMDEALSZCA100002
 

Access the deal registration summary for table
MKL_DM_DEALS a member of an access group
associated with the deal registration.
 

• View Deal Registration

• Read

HR HELP DESK REQUEST

This table lists the instance set name and associated description for the HR Help Desk Request business object:

Instance Set Name Instance Set Description Required Instance Set

SVCSERVICEREQUESTSSVC460
 

Access the service request header for table
SVC_SERVICE_REQUESTS for all HRHD service
requests(1=1).
 

Read
 

SVCSERVICEREQUESTSSVC489
 

Access the service request header for table
SVC_SERVICE_REQUESTS where they're the
primary contact of the HRHD service request.
 

Read
 

SVCSERVICEREQUESTSSVC514
 

Access the service request header for table
SVC_SERVICE_REQUESTS where the HRHD
service request is assigned to them.
 

Read
 

SVCSERVICEREQUESTSSVC486
 

Access the service request header for table
SVC_SERVICE_REQUESTS where they created
the HRHD service request.
 

Read
 

SVCSERVICEREQUESTSSVC515
 

Access the service request header for table
SVC_SERVICE_REQUESTS where they're a
member of HRHD service request team.
 

Read
 

SVCSERVICEREQUESTSSVC519
 

Access the service request header for table
SVC_SERVICE_REQUESTS where the HRHD
service request is assigned to them or their
subordinate.
 

Read
 

SVCSERVICEREQUESTSSVC520
 

Access the service request header for table
SVC_SERVICE_REQUESTS where they or their
subordinate is a member of HRHD service
request team.
 

Read
 

SVCSERVICEREQUESTSSVC516
 

Access the service request header for table
SVC_SERVICE_REQUESTS where the HRHD

Read
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Instance Set Name Instance Set Description Required Instance Set

service request is assigned to a queue that
they're a member.
 

SVCSERVICEREQUESTSSVC476
 

Access the service request header for table
SVC_SERVICE_REQUESTS where the HRHD
service request is assigned to a queue that they
or their subordinate is a member.
 

Read
 

INSTALLED BASED ASSET

This table lists the instance set name and associated description for the Installed Based Asset business object:

Instance Set Name Instance Set Description Required Instance Set

CSEASSETSBSVC605
 

Access the installed base asset for table CSE_
ASSETS_B for all enterprise assets.
 

• Manage Installed Base Asset

• Read

CSEASSETSBSVC437
 

Access the installed base asset for table CSE_
ASSETS_B for all installed base assets where
they're listed as the contact on the asset
account team that owns the asset.
 

• Manage Installed Base Asset

• Read

CSEASSETSBSVC438
 

Access the installed base asset for table CSE_
ASSETS_B for all installed base assets where
they're listed as the primary contact on the
asset.
 

• Manage Installed Base Asset

• Read

CSEASSETSBSVC439
 

Access the installed base asset for table CSE_
ASSETS_B for all installed base assets where
they're a manager for the account listed on the
asset.
 

• Manage Installed Base Asset

• Read

CSEASSETSBSVC434
 

Access the installed base asset for table CSE_
ASSETS_B for all customer assets.
 

• Manage Installed Base Asset

• Read

INTERNAL SERVICE REQUEST

This table lists the instance set name and associated description for the Internal Service Request business object:

Instance Set Name Instance Set Description Required Instance Set

SVCSERVICEREQUESTSSVC273
 

Access the service request header for table
SVC_SERVICE_REQUESTS for all internal help
desk service requests (1=1).
 

Read
 

SVCSERVICEREQUESTSSVC289
 

Access the service request header for table
SVC_SERVICE_REQUESTS where the internal
help desk service request is assigned to them or
their subordinate.

Read
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Instance Set Name Instance Set Description Required Instance Set

 

SVCSERVICEREQUESTSSVC290
 

Access the service request header for table
SVC_SERVICE_REQUESTS where they're the
primary contact of the internal help desk
service request.
 

Read
 

SVCSERVICEREQUESTSSVC311
 

Access the service request header for table
SVC_SERVICE_REQUESTS where the internal
help desk service request is assigned to them.
 

Read
 

SVCSERVICEREQUESTSSVC291
 

Access the service request header for table
SVC_SERVICE_REQUESTS where they created
the internal help desk service request.
 

Read
 

SVCSERVICEREQUESTSSVC312
 

Access the service request header for table
SVC_SERVICE_REQUESTS where they're a
member of internal help desk service request
team.
 

Read
 

SVCSERVICEREQUESTSSVC292
 

Access the service request header for table
SVC_SERVICE_REQUESTS where they or their
subordinate is a member of internal help desk
service request team.
 

Read
 

SVCSERVICEREQUESTSSVC310
 

Access the service request header for table
SVC_SERVICE_REQUESTS where the internal
help desk service request is assigned to a
queue that they're a member.
 

Read
 

SVCSERVICEREQUESTSSVC288
 

Access the service request header for table
SVC_SERVICE_REQUESTS where the internal
help desk service request is assigned to a
queue that they or their subordinate is a
member of HRHD Service Request.
 

Read
 

LEAD

This table lists the instance set name and associated description for the Lead business object:

Instance Set Name Instance Set Description Required Set Instance

MKLLMLEADSMKL1
 

Access the sales lead for table MKL_LM_LEADS
where they're a resource in the lead sales team.
 

• View Sales Lead

• Read

MKLLMLEADSMKL10
 

Access the sales lead for table MKL_LM_
LEADS where they're a resource in the territory
assigned to the sales lead.
 

• View Sales Lead

• Read

MKLLMLEADSMKL104
 

Access the sales lead for table MKL_LM_LEADS
where they're the owner of the sales lead.

• View Sales Lead
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Instance Set Name Instance Set Description Required Set Instance

 • Read

MKLLMLEADSMKL114
 

Access the sales lead for table MKL_LM_LEADS
where they're a resource in the lead sales team
with full access.
 

• View Sales Lead

• Read

MKLLMLEADSMKL129
 

Access the sales lead for table MKL_LM_LEADS
where they're a territory resource in the sales
lead territory team or a territory resource with
a descendant territory in the sales lead territory
team.
 

• View Sales Lead

• Read

MKLLMLEADSMKL138
 

Access the sales lead for table MKL_LM_LEADS
for all retired leads in the enterprise.
 

• View Sales Lead

• Read

MKLLMLEADSMKL148
 

Access the sales lead for table MKL_LM_LEADS
for all partner leads in the enterprise.
 

• View Sales Lead

• Read

MKLLMLEADSMKL15
 

Access the sales lead for table MKL_LM_LEADS
where they're a manager in the management
hierarchy of a resource in the lead sales team
with full access.
 

• View Sales Lead

• Read

 

MKLLMLEADSMKL152
 

Access the sales lead for table MKL_LM_LEADS
for all sales leads in the business units that
they're authorized.
 

• View Sales Lead

• Read

MKLLMLEADSMKL16
 

Access the sales lead for table MKL_LM_LEADS
where they're a manager in the management
hierarchy of the owner of the sales lead.
 

• View Sales Lead

• Read

MKLLMLEADSMKL22
 

Access the sales lead for table MKL_LM_LEADS
where they're a manager in the management
hierarchy of a resource in the lead sales team.
 

• View Sales Lead

• Read

MKLLMLEADSMKL310
 

Access the sales lead for table MKL_LM_LEADS
where they're in the management hierarchy of
the owner of the lead.
 

• View Sales Lead

• Read

MKLLMLEADSZBS902
 

Access the sales lead for table MKL_LM_LEADS
where they're member or in management chain
of lead sales team, member of territory team or
upward territory hierarchy.
 

• View Sales Lead

• Read

MKLLMLEADSZCA99964
 

User can view lead for their access groups.
 

• View Sales Lead

• Read

OPPORTUNITY

This table lists the instance set name and associated description for the Opportunity business object:
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Instance Set Name Instance Set Description Required Instance Set

MOOOPTYMOO119
 

Access the opportunity for table MOO_OPTY
for the selected records where I am on the team
on the sales UI.
 

• View Opportunity

• Read

MOOOPTYMOO120
 

Access the opportunity for table MOO_OPTY
for the selected records I own on the sales UI.
 

• View Opportunity

• Read

MOOOPTYMOO121
 

Access the opportunity for table MOO_OPTY
for the selected records my subordinates own
on the sales UI.
 

• View Opportunity

• Read

MOOOPTYMOO122
 

Access the opportunity for table MOO_OPTY
for the selected records where my subordinates
are on the team on the sales U1.
 

• View Opportunity

• Read

MOOOPTYMOO123
 

Access the opportunity for table MOO_OPTY
for the selected records in my territory on the
sales UI.
 

• View Opportunity

• Read

MOOOPTYMOO124
 

Access the opportunity for table MOO_
OPTY for the selected records in my territory
hierarchy on the sales UI.
 

• View Opportunity

• Read

MOOOPTYMOO88
 

Access the opportunity for table MOO_OPTY
for all opportunities in the enterprise (1=1).
 

• View Opportunity

• Read

MOOOPTYZBS99903
 

Access the opportunity for table MOO_OPTY
where they're a member or in a management
chain of opportunity sales team with view,
 edit or full access, member of territory team or
upward territory hierarchy.
 

• View Opportunity

• Read

MOOOPTYZBS99904
 

Access the opportunity for table MOO_OPTY
where they're a member or in management
chain of opportunity account team, account
territory team or upward territory hierarchy.
 

• View Opportunity

• Read

MOO_OPTYACCTERR_HIER_RES
 

Access the opportunity for table MOO_OPTY
where they're a territory resource in the
opportunity sales account territory team or a
territory resource with a descendant territory in
the opportunity sales account territory team.
 

• View Opportunity

• Read

MOO_OPTY_ADMIN_SALES_ADMIN
 

Access the opportunity for table MOO_OPTY
for all opportunities in the business units that
they're authorized within.
 

• View Opportunity

• Read

MOO_OPTY_EDIT_OPTYTEAM_MGR
 

Access the opportunity for table MOO_OPTY
where they're in the management chain of an
opportunity sales team member with edit or full
access.

• View Opportunity

• Read
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Instance Set Name Instance Set Description Required Instance Set

 

MOO_OPTY_EDIT_OPTYTEAM_REPS
 

Access the opportunity for table MOO_OPTY
where they're an opportunity sales team
member with edit or full access.
 

• View Opportunity

• Read

MOO_OPTY_FULL_OPTYTEAM_MGR
 

Access the opportunity for table MOO_OPTY
where they're in the management chain of
an opportunity sales team member with full
access.
 

• View Opportunity

• Read

MOO_OPTY_FULL_OPTYTEAM_REPS
 

Access the opportunity for table MOO_OPTY
where they're an opportunity sales team
member with full access.
 

• View Opportunity

• Read

MOO_OPTY_TERR_HIER_RES
 

Access the opportunity for table MOO_
OPTY where they're a territory resource in
the opportunity territory team or a territory
resource with a descendant territory in the
opportunity territory team.
 

• View Opportunity

• Read

MOO_OPTY_VIEW_ACCTTEAM_MGR
 

Access the opportunity for table MOO_OPTY
where they're in the management chain of an
opportunity sales account team member.
 

• View Opportunity

• Read

MOO_OPTY_VIEW_ACCTTEAM_REPS
 

Access the opportunity for table MOO_OPTY
where they're a member of the opportunity
sales account team.
 

• View Opportunity

• Read

MOO_OPTY_VIEW_OPTYTEAM_MGR
 

Access the opportunity for table MOO_OPTY
where they're in the management chain of an
opportunity sales team member with view, edit,
 or full access.
 

• View Opportunity

• Read

MOO_OPTY_VIEW_OPTYTEAM_REPS
 

Access the opportunity for table MOO_OPTY
where they're an opportunity sales team
member with view, edit, or full access.
 

• View Opportunity

• Read

MOOOPTYZCA99962
 

User can view Opportunities where they're in
access groups.
 

• View Opportunity

• Read

PARTNER

This table lists the instance set name and associated description for the Partner business object:

Instance Set Name Instance Set Description Required Action Set

HZPARTIESHZ521
 

Access the Partner where the user is the owner
of the Partner Account.
 

Read
 

336



Oracle Fusion Cloud Sales Automation
Sales Questions and Answers

Chapter 1
Sales Questions and Answers

Instance Set Name Instance Set Description Required Action Set

HZPARTIESHZ522
 

Access the Partner where the user is in
management chain of the owner of the Partner
Account.
 

Read
 

HZPARTIESHZ523
 

Access the Partner where the user is a member
of the Partner Account team.
 

Read
 

HZPARTIESHZ524
 

Access the Partner where the user is in
management chain of the member of the
Partner Account team.
 

Read
 

HZPARTIESHZ525
 

Access the Partner where the user is an owner
or member of the Territory assigned to the
Partner Account.
 

Read
 

HZPARTIESHZ526
 

Access the Partner where the user is a member
of the territory and a descendant territory is
assigned to the Partner Account.
 

Read
 

HZPARTIESHZ197
 

Access the Partner where user is a member of
partner organization.
 

Read
 

HZPARTIESZCA99978
 

User can view Partner where they're in access
groups.
 

Read
 

PARTNER CONTACT

This table lists the instance set name and associated description for the Partner Contact business object:

Instance Set Name Instance Set Description Required Instance Set

HZPARTIESHZ530
 

Access the Partner Contact where the user is a
member of the Partner Account team.
 

Read
 

HZPARTIESHZ531
 

Access the Partner Contact where the user is
in management chain of the member of the
Partner Account team.
 

Read
 

HZPARTIESHZ532
 

Access the Partner Contact where the user is
Owner of the Partner Account.
 

Read
 

HZPARTIESHZ533
 

Access the Partner Contact where the user is
in management chain of the Owner of Partner
Account.
 

Read
 

HZPARTIESHZ534
 

Access the Partner Contact where the user is a
member of the Territory assigned to the Partner
Account.

Read
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Instance Set Name Instance Set Description Required Instance Set

 

HZPARTIESHZ535
 

Access the Partner Contact where the user is
a member of the territory and a descendant
territory is assigned to the Partner Account.
 

Read
 

QUOTES AND ORDERS

This table lists the instance set name and associated description for the Quotes and Orders business object:

Instance Set Name Instance Set Description Required Instance Set

ZCASALESORDERHEADERSZBS999939
 

Access the sales order for table ZCA_SALES_
ORDER_HEADERS where they're a member
or in management chain of associated
opportunity sales team with view, edit or full
access, member of territory team or upward
territory hierarchy.
 

• View Sales Order

• Read

ZCASALESORDERHEADERSZBS999941
 

Access the sales order for table ZCA_SALES_
ORDER_HEADERS where they're member or in
management chain of associated opportunity
account team, account territory team or upward
territory hierarchy.
 

• View Sales Order

• Read

ZCASALESORDERHEADERSZBS999948
 

Access the sales order for table ZCA_
SALES_ORDER_HEADERS for all associated
opportunities in the business units that they're
authorized within 1=1.
 

• View Sales Order

• Read

ZCASALESORDERHEADERSZPM5322
 

Access the sales order for table ZCA_
SALES_ORDER_HEADERS for all associated
opportunities having a partner organization.
 

• View Sales Order

• Read

ZCASALESORDERHEADERSZPM5325
 

Access the sales order for table ZCA_
SALES_ORDER_HEADERS where they're in
the management chain of an associated
opportunity sales team member with view, edit,
 or full access.
 

• View Sales Order

• Read

ZCASALESORDERHEADERSZPM5326
 

Access the sales order for table ZCA_SALES_
ORDER_HEADERS where they're an associated
opportunity sales team member with view, edit,
 or full access.
 

• View Sales Order

• Read

ZCASALESORDERHEADERSZPM5329
 

Access the sales order for table ZCA_SALES_
ORDER_HEADERS where they're a member of
a partner resource organization whose partner
organization is on the associated opportunity.
 

• View Sales Order

• Read

QUOTE AND ORDER LINE
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The Quote and Order Line object follows the same security requirements as the Quote and Order Line business object.

SERVICE REQUEST

This table lists the instance set name and associated description for the Service Request business object:

Instance Set Name Instance Set Description Required Instance Set

SVCSERVICEREQUESTSSVC1
 

Access the service request header for table
SVC_SERVICE_REQUESTS for all customer
relationship management service requests
(1=1).
 

Read
 

SVCSERVICEREQUESTSSVC12
 

Access the service request header for table
SVC_SERVICE_REQUESTS where the customer
relationship management service request is
assigned to them or their subordinate.
 

Read
 

SVCSERVICEREQUESTSSVC13
 

Access the service request header for table
SVC_SERVICE_REQUESTS where they or
their subordinate is a member of customer
relationship management service request team.
 

Read
 

SVCSERVICEREQUESTSSVC14
 

Access the service request header for table
SVC_SERVICE_REQUESTS where they or
their subordinate is a member of customer
relationship management service request
account team.
 

Read
 

SVCSERVICEREQUESTSSVC242
 

Access the service request header for table
SVC_SERVICE_REQUESTS where the customer
relationship management service request is
assigned to a queue that they're a member.
 

Read
 

SVCSERVICEREQUESTSSVC32
 

Access the service request header for table
SVC_SERVICE_REQUESTS where the customer
relationship management service request is for
a partner.
 

Read
 

SVCSERVICEREQUESTSSVC35
 

Access the service request header for table
SVC_SERVICE_REQUESTS where their partner
account is on the customer relationship
management service request.
 

Read
 

SVCSERVICEREQUESTSSVC70
 

Access the service request header for table
SVC_SERVICE_REQUESTS where they created
the customer relationship management
service request or are a member of customer
relationship management service request
contact list.
 

Read
 

TERRITORY

This table lists the instance set name and associated description for the Territory business object:
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Instance Set Name Instance Set Description Required Instance Set

MOTTERRITORIESMOT1
 

Access the sales territory for table MOT_
TERRITORIES where they're the territory owner.
 

• View Sales Territory

• Read

MOTTERRITORIESMOT2
 

Access the sales territory for table MOT_
TERRITORIES where they're the owner of a
parent territory in the territory hierarchy.
 

• View Sales Territory

• Read

MOTTERRITORIESMOT4
 

Access the sales territory for table MOT_
TERRITORIES where they're an administrator of
the territory.
 

• View Sales Territory

• Read

MOTTERRITORIESMOT5
 

Access the sales territory for table MOT_
TERRITORIES where they're an administrator of
a parent territory in the territory hierarchy.
 

• View Sales Territory

• Read

MOTTERRITORIESMOT26
 

Access the sales territory for table MOT_
TERRITORIES where they're a member of the
territory team.
 

• View Sales Territory

• Read

MOTTERRITORIESZCA100084
 

Access the sales territory for table MOT_
TERRITORIES where they're a member of an
access group associated to the sales territory
with read access.
 

• View Sales Territory

• Read

WORK ORDER

This table lists the instance set name and associated description for the Work Order business object:

Instance Set Name Instance Set Description Required Instance Set

SVCWORKORDERSSVC214
 

Access the field service work order for table
SVC_WORK_ORDERS where the field service
work order is standalone or associated with a
service request.
 

Read
 

SVCWORKORDERSSVC216
 

Access the field service work order for table
SVC_WORK_ORDERS where they or their
subordinate is a member of the field service
work order account team.
 

Read
 

SVCWORKORDERSSVC217
 

Access the field service work order for table
SVC_WORK_ORDERS where they or their
subordinate is a member of the field service
work order contact team.
 

Read
 

SVCWORKORDERSSVC219
 

Access the field service work order for table
SVC_WORK_ORDERS where they or their
subordinate is a member of the service request
team associated with the field.
 

Read
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Instance Set Name Instance Set Description Required Instance Set

SVCWORKORDERSSVC220
 

Access the field service work order for table
SVC_WORK_ORDERS where they or their
subordinate created the service request
associated with the field service work order.
 

Read
 

SVCWORKORDERSSVC221
 

Access the field service work order for table
SVC_WORK_ORDERS where they or their
subordinate created the field service work
order.
 

Read
 

SVCWORKORDERSSVC222
 

Access the field service work order for table
SVC_WORK_ORDERS where they or their
subordinate is assigned to a field service work
order.
 

Read
 

SVCWORKORDERSSVC223
 

Access the field service work order for table
SVC_WORK_ORDERS where their partner
account is on the field service work order.
 

Read
 

SVCWORKORDERSSVC224
 

Access the field service work order for table
SVC_WORK_ORDERS where the field service
work order is for a partner account.
 

Read
 

SVCWORKORDERSSVC246
 

Access the field service work order for table
SVC_WORK_ORDERS where they or their
subordinate is the technician assigned to a field
service work order.
 

Read
 

SVCWORKORDERSSVC455
 

Access the field service work order for table
SVC_WORK_ORDERS where they or their
subordinate is the technician assigned to a field
service work order.
 

Read
 

How to make Email and Primary Phone fields mandatory
in contact?  
You can add email addresses for accounts or contacts using the respective UI pages or REST APIs. While entering these
email addresses, the format of the email address should be validated.

You can use Groovy scripts to specify the rules to validate email address and phone number formats.

For more information on Groovy scripting, see Oracle Applications Cloud Groovy Scripting Reference guide. For more
information about REST APIs, see the REST API for CX Sales and Fusion Service guide.

The following code is a sample for validating email addresses and phone numbers:

def tCPhone = Phone;
tCPhone?.reset();
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def noPhone = true;
println("Phone1" + tCPhone);
def RawPhNumber;
def PhNumber;
def emailaddr

while( tCPhone.hasNext())
{
 def tCphoneRecord = tCPhone?.next();
 println('Phone' + tCphoneRecord );
 PhNumber = tCphoneRecord?.PhoneNumber;
 println('PhoneNum' + PhNumber );
 RawPhNumber = tCphoneRecord?.RawPhoneNumber;
 // println('RawPhoneNum' + RawPhNumber );
 if((PhNumber != null || RawPhNumber != null) && tCphoneRecord?.Status == 'A') {
 noPhone = false;
 break;
 }
}

def noEmail = true;
def emailiter = Email;
emailiter.reset();
def val = PrimaryEmailAddress
println("PrimaryEmail"+ val);
while(emailiter.hasNext())
{
 def emailrow = emailiter.next();
 //println('email' + emailiter);
 emailaddr = emailrow?.EmailAddress
 if(emailaddr != null){
 noEmail = false;
 break;
 }
}

if(noPhone && noEmail){
 
 throw new oracle.jbo.ValidationException('Phone number or Email required' + RawPhNumber + ': ' + PhNumber +
 ': ' + emailaddr);
}
return true;

How can I create a sales account owner?  
You can create a sales account owner in the Manage Users task UI or by resource import. You can't create resources in
the Security Console.

Creating sales users creates rudimentary Human Resources records, even if you aren't implementing HCM. Before you
create sales users, you must create the elements of the resource hierarchy they are a part of. And you must create the
provisioning rules that automatically provide the sales users you create with the security permissions they need to do
their jobs.

Sales Resource Hierarchy
The sales resource hierarchy shows up as the org chart in the Resource Directory. But the hierarchy is more than a pretty
picture. It determines who can see what sales information and forms the basis of your forecasting setup. For example,
sales managers can view and forecast the opportunities of their subordinates, but not the opportunities managed by
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others. Oracle supports matrix management, so the resource hierarchy you build doesn't have to match the formal
reporting hierarchy in the Oracle Global Human Resources Cloud or other Human Resources applications.

To give you an idea of what a sales resource hierarchy looks like, here's a screenshot of a portion of Vision Corp.'s
Resource Directory. Aside from their names, all users in the hierarchy must have:

• A resource role (highlighted by callout 1)

The resource role describes the role that each resource plays in the organization. It displays right underneath
the user name in the Resource Directory available in the CX Sales UI and elsewhere. Resource roles are also
used as the primary condition in the role-provisioning rules. You can create resource roles either in Setup
Assistant or manually, using the setup task Manage Resource Roles.

• A resource organization (callout 2)

You must create a resource organization for every manager. Each individual contributor who isn't a manager
automatically inherits the manager's organization. The name of the resource organization need not be any
formal department name, but you should avoid using manager names to accommodate hierarchy changes. You
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can create resource organizations as you are create users in the UI, or you can create them when you import
users using the Excel import macro.

The application builds the resource organization hierarchy using the management hierarchy that you specify when you
create users. You must enter a manager for each user you create, except for the top of the resource hierarchy.

Sales Resource Roles Provided by Oracle
Oracle provides you with these standard resource roles and the appropriate job roles for each:

• Channel Account Manager

• Channel Operations Manager

• Channel Sales Manager
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• Chief Executive Officer

• Contract Administrator

• Contract Manager

• Customer Data Steward

• Data Steward Manager

• Partner Administrator

• Partner Sales Manager

• Partner Salesperson

• Sales Administrator

• Sales Lead Qualifier

• Sales Manager

• Salesperson

• Sales Restricted User

• Sales Setup User

• Sales Vice President

Except for the Chief Executive Officer and the Salesperson, there's a corresponding job role with the same name for
each of the resource roles provided by Oracle. The job role corresponding to the Salesperson resource role is Sales
Representative. The Chief Executive Officer is usually assigned the Sales Vice President job role.

Role-Provisioning Rules Setup Assistant Creates Automatically
If you used Setup Assistant, you're in luck. Setup Assistant automatically creates the role-provisioning rules for users
with all the standard sales resource roles. The rules provision user with the job roles and abstract roles they need.

If you didn't use Setup Assistant, perhaps because you're implementing multiple services at the same time, then you
must create all of the role-provisioning rules manually. You create the rules using the Manage HCM Role Provisioning
Rules task.

Here's a list of the role-provisioning rules Setup Assistant creates, the condition that triggers the provisioning, and the
job and abstract roles each rule provisions. You can get a description of each job and abstract role from the Security
Reference for CX Sales and Fusion Service guide.

Provisioning Rule Name Condition Job or Abstract Roles
Provisioned

UI Access

Channel Account Manager
 

HR Assignment Status is Active
 
Resource Role is Channel Account
Manager
 

Channel Account Manager
 
Resource
 

CX Sales UIs

Channel Sales Manager
 

HR Assignment Status is Active
 
Resource Role is Channel Sales
Manager
 

Channel Sales Manager
 
Resource
 

CX Sales UIs

Channel Operations Manager
 

HR Assignment Status is Active
 

Channel Operations Manager
 

CX Sales UIs
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Provisioning Rule Name Condition Job or Abstract Roles
Provisioned

UI Access

Resource Role is Channel
Operations Manager
 

Resource
 

Chief Executive Officer
 

HR Assignment Status is Active
 
Resource Role is Chief Executive
Officer
 

Sales VP
 
Resource
 

CX Sales UIs

Contract Administrator
 

HR Assignment Status is Active
 
Resource Role is Contract
Administrator
 

Contract Administrator
 
Resource
 

CX Sales UIs

Contract Manager
 

HR Assignment Status is Active
 
Resource Role is Contract Manager
 

Contract Manager
 
Resource
 

CX Sales UIs

Customer Data Steward
 

HR Assignment Status is Active
 
Resource Role is Customer Data
Steward
 

Customer Data Steward
 
Resource
 

CX Sales UIs

Data Steward Manager
 

HR Assignment Status is Active
 
Resource Role is Data Steward
Manager
 

Data Steward Manager
 
Resource
 

CX Sales UIs

Partner Administrator
 

Resource Role is Partner
Administrator
 

Partner Administrator
 

CX Sales UIs

Partner Sales Manager
 

Resource Role is Partner Sales
Manager
 

Partner Sales Manager
 

CX Sales UIs

Partner Sales Representative
 

Resource Role is Partner
Salesperson
 

Partner Sales Representative
 

CX Sales UIs

Sales Administrator
 

HR Assignment Status is Active
 
Resource Role is Sales
Administrator
 

Sales Administrator
 
Resource
 

Both CX Sales and Digital Sales UIs

Sales Lead Qualifier
 

HR Assignment Status is Active
 
Resource Role is Sales Lead
Qualifier
 

Sales Lead Qualifier
 
Resource
 

CX Sales UIs

Sales Manager
 

HR Assignment Status is Active
 
Resource Role is Sales Manager
 

Sales Manager
 
Resource
 

Both CX Sales and Digital Sales UIs
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Provisioning Rule Name Condition Job or Abstract Roles
Provisioned

UI Access

Sales Representative
 

HR Assignment Status is Active
 
Resource Role is Salesperson
 

Sales Representative
 
Resource
 

Both CX Sales and Digital Sales UIs

Sales Restricted User
 

HR Assignment Status is Active
 
Resource Role is Sales Restricted
User
 

Sales Restricted User
 
Resource
 

CX Sales UIs

Sales Setup User
 

HR Assignment Status is Active
 
Resource Role is Sales Setup User
 

Application Implementation
Consultant
 
IT Security Manager
 
Application Diagnostics
Administrator
 
Sales Administrator
 
Sales Analyst
 

Both CX Sales and Digital Sales UIs

Sales Vice President
 

HR Assignment Status is Active
 
Resource Role is Sales Vice
President
 

Sales VP
 
Resource
 

Both CX Sales and Digital Sales UIs

Contingent Worker
 

HR Assignment Status is Active
 
System Person Type is Contingent
Worker
 

Contingent Worker
 

CX Sales

Employee
 

HR Assignment Status is Active
 
System Person Type is Employee
 

Employee
 

Not applicable.

You create sales users as employees. So, two role-provisioning rules come into play: the rule triggered by the users'
resource roles and the rule triggered by the fact that they are employees. For example, when you create a user with the
Sales Manager resource role provided by Oracle, the application automatically provisions the Sales Manager job role
and the Resource abstract role. Because you're creating the user as an employee, the application also provisions the
Employee abstract role.

Here's a diagram that shows the two rules that are triggered when you create an employee resource with the Sales
Manager resource role.
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Resource Roles That Provide Access to Digital Sales UIs
When you assign these four resource roles to resources, the role provisioning-rules created automatically by the Setup
Assistant provide access to both the Digital Sales and CX Sales UIs.

• Sales Representative

• Sales Manager

• Sales VP

• Sales Administrator

When You Need Additional Resource Roles and Role-Provisioning Rules
You may need to create additional resource roles either by entering them in the Setup Assistant, or using the Manage
Resource Roles task for any of these reasons:

• You want other job titles to display for your users.

For example, if you want a user to display the Sales Evangelist title in the organization chart, you must create
the Sales Evangelist resource role and a provisioning rule for it.

• You want to provision some users with special privileges.

For example, if one of the sales managers in your organization also acts as a sales administrator, you provision
her with both job roles. To do this, you must create a new resource role and a provisioning rule to go along with
it.
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• You want to create a sales administrator who is a manager.

The Sales Administrator resource role provided by Oracle is intended for an individual contributor (member).
If your sales administrator manages others, then you must create a separate manager resource role and a
provisioning rule to go with it.

Each time you create a resource role, you must also create a corresponding role-provisioning rule. For example, if you
created the Sales Support resource role, then you must create a role-provisioning rule to provision one or more of the
available job roles and the Resource abstract role. If you created the resource roles in Setup Assistant, then the rules
are created for you automatically. If you create the resource role using the Manage Resource Roles task, then you must
create the role-provisioning rules manually.

For information on how to change the resource role for a user and make other organizational changes, see the topic
How do I change user resource roles when job assignments change? and the rest of the User Management chapter in the
Securing Sales and Fusion Service guide.

How do I change user resource roles when job
assignments change?  
When job assignments change, you can update the resource role assigned to the employee. Updating a resource role
involves these steps:

• Assigning the user a new resource role that corresponds to the new job assignment, for example, Sales
Manager.

• Setting an end date for the old resource role, for example, Salesperson.

If the employee's new role also involves a change in the user's resource organization, for example, if the user is
promoted to a management role from a non-management role, you must also change the user's organization
membership.

You can make changes to role assignments using either the resource import management functionality or using the
Sales UI. Although importing changes takes care of many tasks that you have to perform manually in the UI, if you're
updating resource role information for an individual user, then using the UI can be more efficient.

These steps describe how to update role information in the UI for a user who's promoted from a sales representative
role to a sales manager role.

1. Sign in to the application as the sales administrator or as a setup user.
2. Select Navigator  >  My Team  > Users and Roles to open the Search Person page.
3. Search for and select the user who's being promoted. The Edit User page for the user opens.
4. In the Resource Information region, do the following:

a. In the Resource Role field, add the new resource role for the user, for example, Sales Manager.
b. In the Reporting Manager field, update the user's manager.
c. In the Organization field, specify the user's resource organization.

You must create a resource organization for every manager in your Sales organization. If you haven't
created a resource organization for the new manager, then you can create one by clicking the Create link
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from the end of the Organization list. The Create Organization dialog box is displayed allowing you to
enter a new organization name.

d. To automatically provision any roles provided by the new resource role you just assigned the user, click
the Autoprovision Roles button in the Resource Information section.

e. Click Save and Close.
5. Set an end date for the user's old resource role using these steps:

a. Form the Navigator menu, select Directory  >  Resource Directory.
b. In the Tasks area of the Resource Directory page, select View Resources.
c. On the View Resources page, search for and select the user.

The Resource page for the user opens.

Note that the user is assigned the new resource organization you previously created.
d. Click the Roles tab, and in the Roles list, select the current role assigned to the user, for example,

Salesperson, and enter an end date in the To Date field.

The value you enter is the date the user's assignment in the current role ends.
e. Click Save and Close.

Note:  When you promote a user from one management position to another, for example, from a Sales Manager role
to a Sales VP role, then the resource hierarchy is maintained provided that the promoted user's resource organization
doesn't change. So any users who reported to the Sales Manager continue to report to the same individual when
that individual is promoted to the Sales VP role. If the promoted user's resource organization does change upon the
promotion, the user's reports must be reassigned to a new manager.

For information about changing role assignments using the resource import management functionality, see the topic
about importing resource data in the Understanding Import and Export Management for Sales and Fusion Service
guide.

Related Topics
• How do I import resource data?

• Make an Employee a Sales Resource

How do I create application users?  
You must create sales users as resources who are part of the sales resource hierarchy. You can create sales users either
in the Manage Users task UI or by resource import, but you can't create resources in the Security Console.

This topic describes how to create individual sales users in the Manage Users task UI. If you have a large number of
sales users to create, then importing users is useful. For additional information, see the chapter about importing sales
users in the Implementing Sales guide or the chapter about importing resource data in the guide Understanding Import
and Export Management for Sales and Fusion Service.

Before creating application users, make sure you have completed these tasks:

• Set up any additional resource roles or role provisioning rules that are required.
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• Created a resource organization for each manager. If you don't create the resource organization ahead of time,
then you must do so while creating each manager user.

Each manager is assigned with his or her own resource organization. Individual contributors automatically
inherit their manager's resource organization. The application determines who's a manager from the resource
role you assign to the user.

When you create application users, you automatically set up the reporting hierarchy of your organization by indicating
each person's manager. For this reason, first create the user at the top of the hierarchy and that user's organization.
You don't enter a manager for this user. You can then create the rest of the users starting directly under the top of the
hierarchy and working your way down.

Steps to Create an Application User
Here's how to create sales users in the UI. The procedure is slightly different for managers and individual contributors:

• You must assign each manager with his or her own resource organization. You can create the resource
organization while creating the manager.

• Individual contributors automatically inherit their managers' resource organization.

The application determines who's a manager from the resource role you assign to the user.

1. Select Navigator  > My Team  > Users and Roles to open the Search Person page.
2. In the Search Results section, click the Create icon.

The Create User page opens.
3. In the Personal Details region, enter the user's name and a unique email address. The application sends user

notifications to this email address by default unless you disable notifications in the Security Console.

Note:  After you create the user, if you want to change the email address you can do so on the Users tab
of the Security Console or using file import. You can't change email addresses on the Edit User page of the
Manage Users work area.

4. The application prefills today's date in the Hire Date field and uses that date as the start date for the resource.

If you're planning to use quotas, then you must make sure that the hire date is a date before the start of the
first quota period. For example, if you're allocating monthly quotas for fiscal year July 01, 2015 to June 30, 2016,
then you must enter a hire date of 7-1-2015 or earlier. You can't change the hire date after you create the user.

5. In the User Details region, you can either create a new account or link an existing, standalone user account to
the new person record you're creating.

◦ When creating Sales users, create a new account. To create a new account, select the Enter user name
option and then enter a user name. If you leave the User Name field blank, then the user name is
generated automatically using the enterprise default format. Unless you specify otherwise, email address
is the default user name format.

◦ Alternatively, if you want to link the new person record you're creating to an existing standalone user
account, select the Link user account option, then search for and select the user account in the Link
User Account dialog box.

6. In the User Notification Preferences region, select the Send user name and password option if you want
a notification to be sent to the user when you save the user record and the user account is created. The
notification includes a URL users can use to reset their password and sign in.

The Send user name and password option is enabled only if notifications are enabled on the Security Console
and an appropriate notification template exists. For example, if the predefined notification template New
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Account Template is enabled, then a notification is sent to the new user when you select the Send user name
and password option.

If you deselect the Send user name and password option, a notification isn't sent when the account is created
but you can choose to send the email later by running the Send User Name and Password E-Mail Notifications
process. The process sends notifications to any users for whom you haven't so far requested an email. An
appropriate notification template must be enabled at that time. Alternatively, you can use the Security Console
to reset the password and send the notification.

7. In the Employment Information region, enter the values shown in the following table.

Field Entry

Person Type
 

Select Employee.
 

Legal Employer
 

Select the legal employer Oracle created using the information you provided when you signed
up with the cloud service.
 

Business Unit
 

Select the business unit for the user. Oracle creates an initial business unit using the
information you provided when you signed up.
 

You don't have to complete the remaining fields in the Employment Information region.
8. In the Resource Information region, enter the following values.

Field Entry

Resource Role
 

Select the role the user plays in the resource organization.
 

Reporting Manager
 

Select the user's manager.
 
If you're creating the top user in your hierarchy, such as the CEO, you can leave this field blank.
 

Organization
 

If the user you're creating is a manager, and if you already created a resource organization
for this manager, then select the appropriate resource organization. If you haven't created a
resource organization for the manager, then you can create one by clicking the Create link from
the end of the Organization list. The  Create Organization dialog box is displayed allowing you
to enter a new organization name.
 
If the user you're creating isn't a manager, then the resource organization is automatically
copied from the manager.
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9. In the Roles region, click Autoprovision Roles.

Any roles for which the user qualifies automatically appear in the Role Requests table with the status Add
Requested.

The application provisions roles according to the provisioning rules specified for the selected resource role.
Each sales user must have both the Employee and the Resource abstract roles in addition to the job roles they
require.

10. You can also provision a role manually to the user if required by clicking Add Role. The Add Role dialog box
opens.

11. Search for and select the role. The role is added to the Role Requests table with the status Add Requested.

Note:  Roles that you can provision to others must appear in a role mapping for which you satisfy the role-
mapping conditions and where the Requestable option is selected for the role.

12. Click Save and Close.

The application creates the user. If you selected the Send user name and password option, the application also
sends the user the email with the URL the user can use to sign in to the application for the first time.

13. Click Done.

Related Topics
• Create a Resource Organization

• Types of Sales Users

How can my user view application data?  
You must identify a user as a resource to view your application data.

To identify specific employees, contingent workers, or partner contacts as resources, you must search for them and
enable them as resources. You can use the Manage Resources task, Manage Users UI, and the Resource Directory to
search persons and identify them as resources. Once you have identified these resources, you can assign them to
organizations as required. Similarly, you can also identify newly added employees or contingent workers as resources.

How do I manage Enterprise Data Quality matching
configurations?  
You can manage Enterprise Data Quality (EDQ) matching configurations using the Manage Enterprise Data Quality
Matching Configurations setup task.

You can perform the following tasks as part of managing Enterprise Data Quality (EDQ) matching configurations.

• Copying a predefined Enterprise Data Quality matching configuration

• Editing a copy of the predefined Enterprise Data Quality matching configuration
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Copy a Predefined Enterprise Data Quality Matching Configuration
To copy or make a duplicate of a predefined Enterprise Data Quality matching configuration, complete these steps:

1. In the Setup and Maintenance work area, go to the following:

◦ Offering: Customer Data Management

◦ Functional Area: Data Quality Foundation

◦ Task: Manage Enterprise Data Quality Matching Configurations

2. On the Manage Enterprise Data Quality Matching Configurations page, select the Account Duplicate
Identification match configuration, and click Duplicate.

3. Click Yes in the Warning dialog box.
4. Click Save to save the copy of the predefined configuration.

Note:  You must save the copy of the predefined configuration, if you want to edit it.

5. Repeat Steps 2 to 4 to create copies of the predefined configuration for the Contact Duplicate Identification
match configurations.

Edit a Copy of the Predefined Enterprise Data Quality Matching
Configuration
To edit a copy of the predefined Enterprise Data Quality matching configuration, complete these steps:

Note:  You can't edit the predefined Enterprise Data Quality configuration. You can only make a copy of it and edit it
by following this procedure.

1. In the Setup and Maintenance work area, go to the following:

◦ Offering: Customer Data Management

◦ Functional Area: Data Quality Foundation

◦ Task: Manage Enterprise Data Quality Matching Configurations

2. On the Manage Enterprise Data Quality Matching Configurations page, select the copy of Account Duplicate
Identification match configuration that you created in Copying a Predefined Enterprise Data Quality Matching
Configuration section, and click Edit.

3. Select the Active check box to set the Account Duplicate Identification match configuration as the active
configuration.

Note:  By default, the predefined configurations are always set to active. If there are one or more copies of the
predefined configurations, then you can set any of them to active by selecting the Active check box. At any
given point in time, only one configuration can be active.

Note:  Also, note that the Usage option is set to Both, which indicates that the configuration is for both real-
time and batch matching.

Note:  You must rebuild keys before activating a new or copied configuration. For more information about
Rebuilding Keys, see the Key Generation topic.

4. Click Yes in the Warning dialog box to set this configuration as active.
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5. In the Match Attributes section, perform the following steps:
a. Select a row to edit the mapping, and click the drop-down button for the selected row.
b. Select the relevant attribute from the list.
c. If the list doesn't display the attribute that you want for the mapping including published custom fields,

then click Search to search for the attribute.

Note:  To identify duplicates based on a custom field search the custom attribute in the Account
attribute drop-down and then map it to any available unused EDQ attribute.

d. Select the relevant option and click OK.
6. Select a Cluster Key Level option. For example, select Typical.
7. In the Score Threshold field, enter a value between 0 and 100, such as 85. In the Match Results Display Limit

field, enter a value between 0 and 100, such as 20.

Note:  The Match Results Display Limit option isn't available for Batch.

8. Click Save.

Note:  You can see the Automerge Threshold and Autolink Threshold values in the Batch tab. You can change
these values in the Manage Customer Hub Profile Options page or override these values while creating the
duplicate identification batch criteria rules.

Related Topics
• Enterprise Data Quality Matching Configurations

• Create Duplicate Identification Batches and Define Subset Rules

• Customer Hub Profile Options

• Automerge

• Key Generation

How can you enable a report to show amounts in the
user-preferred currency?  
You enable users to specify their preferred report currency when you select one of two user-preferred currency
conversion methods in the Reports and Analytics catalog, under My Account Preferences. When you do, salespeople
can specify the report currency in their General Preferences.

Your organization must implement multiple currencies for this to work, of course.

Note:  Only Fact amounts are converted. Dimensional amount columns, such as budget amounts under the
Opportunity folders, aren't converted.

Set the Currency Conversion Method for Reports and Analytics
1. Click Navigator > Tools > Reports and Analytics.
2. Click Browse Catalog.
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3. Click My Profile and select  My Account.
4. In the Preference tab, select one of the two conversion methods from the Currency list:

◦ User Preferred Currency using Simple Currency Management: Converts the amount in the corporate
currency to the currency you selected using the conversion rate valid at the time the record was last
updated or saved. (this is the default setting)

◦ User Preferred Currency using Advanced Currency Management: Converts the amounts from the
currency in the transaction itself using the conversion rate on the date of your report.

5. Click OK.

How Users Specify Their Currency
Here's how salespeople specify the currency for their reports:

1. Navigate to Tools, Set Preferences.
2. Select General Preferences > Regional.
3. Select the preferred currency. Available currencies include those set up in your application.

How do I enable duplicate records for many to many
relationships?  
You can enable or disable duplicate records for many-to-many relationships using the
ORA_ZCX_MM_ALLOW_DUPLICATE_FEATURE profile option.

To change the default values of these profile options:

1. Click Navigator > My Enterprise > Setup and Maintenance work area.
2. Click the Tasks menu and click Search.
3. Search for Manage Administrator Profile Values task and open it.
4. Search using the profile option code ORA_ZCX_MM_ALLOW_DUPLICATE_FEATURE.
5. Change the profile value as needed.

How do I enable duplicate checking on CX Sales Mobile?  
You can enable duplicate checking for CX Sales Mobile in Application Composer Mobile Application setup.

Before you start, make sure that you've enabled duplicate checking in the Sales application itself. See the topic How do I
enable duplicate checking for accounts and contacts?.

Steps to Enable
1. Create and enter a publishable sandbox where Application Composer is enabled.
2. Navigate to Application Composer > Mobile Application Setup > CX Sales Mobile Composer > Settings
3. In the list of settings, expand Check for Duplicates.
4. Flip on the Enable for Accounts switch to enable account duplicate checking.
5. Flip on the Enable for Contacts switch to enable contact duplicate checking.
6. Click Save in the upper right-hand corner of the screen.
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7. Validate that the duplicate checking works in CX Sales Mobile.
8. Publish the sandbox.

How the Duplicate Checking Works
The duplicate checking identifies potential duplicates when salespeople create accounts and contacts. The salesperson
can either decide to accept the existing record or create a new one. The duplicate check is done synchronously. After
tapping Save on the create page, the user must wait for the duplicate check to complete before progressing to the next
step.

If there are more than 5 potential matches for a new account or contact, the 5 highest scoring potential matches are
displayed to the user as determined by scoring criteria established in Enterprise Data Quality Matching Configurations.

How can I hide a smart action from the Actions menu in
Workspace objects?  
Use the Smart Actions page in Application Composer to disable or enable an action. Smart actions are contextual
actions that are mapped to an object and client application, such as Workspace.

Smart actions make tasks that are used often easily accessible because they're always available from the same place on
a page, such as from the Workspace list page or in the Action Bar. Here's how to remove a smart action so that users
won't see it:

1. In Application Composer, click Smart Actions, available in the Common Setup.
2. Find the action you want to disable and select No in the Enabled column.

What privilege do I need to view partner information for
my Opportunity?  
If you're assigned a custom role, then you must be granted the Manage Opportunity Partners
(MOO_MANAGE_OPPORTUNITY_PARTNERS_PRIV) privilege to view partner information when editing an opportunity.

For example, the Sales Channel and Primary Partner fields and the Partners subtab are only visible to users who have a
job role that includes this privilege.

Note:  If an administrator used Application Composer to remove the Primary Partner Field from the Edit Opportunity
layout, then you won't see the Partners tab or the Primary Partner field if your job role includes the Manage
Opportunity Partners privilege.
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Can I change and replace words or phrases that appear
on pages and other areas of the UI?  
Yes, you can use the User Interface Text tool to change text that appears on application pages. For example, you can
change field names, page titles, help text (not links) that appear in help windows or menu labels on the Navigator and
home pages and so on.

Note:  To use the User Interface Text tool, make sure you've the Manage User Interface Text
(FND_MANAGE_USER_INTERFACE_TEXT_PRIV) privilege.

You can also use this tool to change or translate multiple strings at the same time and you can export your strings to
make your changes offline. See Modify Text Using User Interface Text Tool for more about the User Interface Text tool.

How do I convert leads to accounts in CX Sales?  
If your business uses net new leads where account values are entered manually using free-form text fields, then you can
make the New Account field available on the Leads UI through Application Composer. This field is hidden by default, so
to use it for your new leads, you must manually expose this field.

If the new lead that you enter gets converted to an opportunity, the details become available as existing account
information. To have a new account created as part of the lead conversion into an opportunity, you must set up the
following:

1. Expose the New Account field on the Leads page as described in the Add the New Account Field to the CX
Sales Lead UIs  section:

a. Create and activate a sandbox.
b. Create custom layouts for the appropriate pages and add the field as required.
c. Review your work in the leads pages.
d. Publish the sandbox.

2. Enable the default setting for the creation of an account, a contact, both an account and a contact, or
none during lead conversion by setting the profile option Create Account and Contact from Lead
(ORA_MKL_LEAD_ACT_CON_CREATE). The default value is Both,to but you can enter Account to suit your
requirements.

3. Create the Copy Map for Lead to Account file to capture the data that needs to be transferred at conversion
time. This file maps objects and attributes during the creation of an account, when converting a lead to an
opportunity. See the Copy a Lead to Account Map section for more information.

4. Set the Lead to Account Mapping (MKL_LEAD_TO_ACCOUNT_MAPPING_NAME) profile option value from the
default Standard Copy Lead To Account Map value with the exact name of the mapping file name created in
Copy Maps as created in the previous step.

358

https://www.oracle.com/pls/topic/lookup?ctx=fa-latest&id=s20069115


Oracle Fusion Cloud Sales Automation
Sales Questions and Answers

Chapter 1
Sales Questions and Answers

Add the New Account Field to the CX Sales Lead UIs
You must add the New Account field to the leads pages that salespeople use to create and qualify net new leads.

1. In the Navigator, click Configuration > Application Composer.
2. In Application Composer, search for the Sales Lead object (callout 1 in the screenshot).

3. Open the Sales Lead object (callout 2).
4. Click Pages (callout 3).
5. For each of the pages where you need to expose the field, do the following:

a. Locate the page.
b. Click Duplicate (callout 4).
c. In the Duplicate Layout window, enter a new name for your layout or just click Save and Edit.
d. On the Layout page, click Edit (the pencil icon).
e. In the Available Fields column, find the New Account field and move them to the Selected Fields

column.
f. Use the arrow buttons to move the fields where you want them.

g. Click Save and Close.

You're returned to the Layout page, which reflects your changes.
h. Click Done.

You're returned to the Application Composer page.

Copy a Lead to Account Map
Copy maps enable you to create objects by copying existing objects. For example, you can use predefined mapping files
to copy lead attributes stored on a lead to the account created during lead conversion.
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Here's how to copy a lead to an account map:

1. Ensure that you're working in an active sandbox.
2. Click Navigator > Configuration > Application Composer.
3. Select Sales to filter the object search, and in Advanced Setup, select Copy Maps.
4. On the Copy Maps page, select the Copy Lead to Account > Standard Copy Lead to Account Map.
5. Create a copy of the map and enter relevant account mappings on the Edit Copy Map page.
6. Click Save and Close.
7. Specify the mapping file name in the following profile option:

◦ Use the Lead to Account Mapping (MKL_LEAD_TO_ACCOUNT_MAPPING_NAME) profile option to
specify the mapping file name created in Copy Maps. This file maps objects and attributes during the
creation of an account when converting a lead to an opportunity.

How can I download CX Sales Mobile if I can't access
Google Play Store?  
Users in countries where you can't access the Google Play Store can download the latest version of Oracle CX Sales
Mobile from Oracle using this link: https://www.oracle.com/downloads/cloud/oracle-cx-sales-mobile-downloads.html

You can distribute the app to your users through any MDM or EMM service, or you can make the app available on your
internal secure portals. The app version made available on this site is the same as the one on the Google Play Store.

How do I change the first or last name of a user?  
You can change the name of a user by editing their profile in Users and Roles. Here's how:

1. In the Navigator open My Team > Users and Roles.
2. In the Search Person window, search for the name using the Keywords  field.
3. Click the name link to edit the user.
4. Change the name.
5. Click Save and Close.

How do I resolve account search errors in Workspace?  
Sometimes you might receive an error that Workspace can't retrieve records for the object you're searching for, or you
might see some records in your search results list that you can't drill down for more details. If this happens, it's more
than likely the record indexing hasn't fully completed, or you might need to run a full Publish indexing process from the
Monitor UI tab of the Configure Adaptive Search page.

While records you create and update in the UI are automatically indexed and made searchable within seconds, imported
records or records updated by background processes aren't available for search until the process completes.
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You must click Publish to run the indexing process each time you:

• Make changes on the Setup tab

• Perform a production to test (P2T) environment refresh

• Receive errors when searching or trying to retrieve records in Workspace

Can I set a standard object field as required using a
custom layout?  
No. Standard objects such as Leads, Opportunities, Competitors, and so on already have their associated field
properties set, such as default, required, updatable, and read-only. Hence, a field for standard objects can't be set as
required if using a custom layout.

You can use Page Composer to display a field with the required symbol (*) but it won't act as a functional required
field. The required * symbol will be visible on the field and will allow manual data entry but without any functional
implications.

Related Topics
• Providing an Expression to Make a Custom Field Conditionally Required

• Set the Required Field Property

How do I enable team-based access to custom objects
when using access groups?  
You can provide team resources with access to custom object data, where access is based on the resource's
membership in a team, also known as team-based access group security. With this type of security, team members and
their management hierarchy can access custom object records.

To enable team-based security for custom objects:

1. Create a relationship between your custom object and the Resource object.

In Application Composer, create a many-to-many relationship between your custom object and the Resource
object, where your custom object is the source object.

2. Create a subtab so that your users can add resources to custom object records at runtime.

Add a Team subtab to the custom object details page layout, where the Team subtab is based on the
intersection object created from your many-to-many relationship.

3. Configure security so that the team member on the custom object record and their management hierarchy
have access to the record.

To do this, set security for both the intersection object and the custom object.

For the intersection object:
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a. Navigate to the Security node for the intersection object.
b. On the Define Policies page, select each role that needs access and, for each column (Read, Update,

Delete), select All.

For the custom object:

a. Navigate to the Security node for the custom object.
b. On the Define Policies page, select the Enable Access Group Security check box.
c. Select the Configure Team for Access Group Security check box and select the many-to-many

relationship that you just created.
4. Configure functional security for the required roles.

This step isn't related to access group security (data security), but it's a required step so that the right roles can
access the custom object's user interface pages at the appropriate level (functional security).

Note:  The Enterprise Scheduler Administration role needs to be added in custom object functional security
for access group security to work.

a. Navigate to the Security node for the custom object.
b. On the Define Policies page, select each role that needs access and, for each column (Read, Update,

Delete), select the access level for reading, updating, and deleting records: Functional Read, Functional
Delete, or Functional Update.

5. Publish your sandbox.
Finally, enable your custom object for access group object sharing rules. You do the next set of steps in the Sales and
Service Access Management work area.

1. Navigate to Access Groups in the Sales and Service Access Management work area.
2. On the Object Sharing Rules page, select the Synchronize Custom Objects and Fields item from the Actions

menu.

After you sync, your custom object displays in the Object list.
3. Select your custom object from the Object list to configure object sharing rules.

In the Rules region, the (Custom Object) Team and (Custom Object) Team Hierarchy predefined rules display, in
addition to the rules for (Custom Object) Owner and (Custom Object) Owner Hierarchy.

4. Click each rule to assign a custom access group and access level.

Note that access groups are automatically created based on roles created using the Security Console.

For more information, see the Access Groups chapter in the Oracle Fusion Cloud Customer Experience Securing
Sales and Fusion Service guide:

5. On the Access Groups Monitor page, optionally schedule and run the Perform Object Sharing Rule Assignment
process to assign access group object sharing rules to your custom object.

By default, the process runs automatically at scheduled intervals to make sure you have the required access to
all object data for your selected access groups. But you can submit the process manually if, for example, you
want immediate access to new records and objects.

362



Oracle Fusion Cloud Sales Automation
Sales Questions and Answers

Chapter 1
Sales Questions and Answers

How do I import hierarchy data?  
You can use the import management to create Hierarchy data.

The hierarchies supported are:

• Customer hierarchy

• Dun and Bradstreet hierarchy

• Trading Community Party hierarchy

To import Hierarchy records, perform the following tasks:

1. Map your source data to Oracle Applications Cloud object attributes.
2. Create source Comma Separated Values (.csv) file for import.
3. Create the import activity.
4. Review the import results.

How You Map Your Source Data to Target Object Attributes
To import your Hierarchy data into Oracle Applications Cloud, you need to populate a CSV file with your source data and
map that source data to target object attributes in Oracle Applications Cloud.

You need to do the following before creating the .CSV file for data import:

• Identify how your source data attributes map to the target object attributes in Oracle Applications Cloud.

• Ensure prerequisite steps are complete, such as understanding what attributes are required for importing your
objects.

• Understand your options for uniquely identifying the records.

• Ensure parent records exist before importing child records.

• Identify the target object attributes that are required in the .CSV file for a successful import.

Before You Start
You must do some basic checks before starting your import. For example, make sure that:

• You have completed all the prerequisites for importing each attribute in your source data.

• You have all parent records in place before importing child records.

Select a Unique Identifier for Your Records
To import data into Oracle Applications Cloud, your CSV file must include some specific attributes that enable the
import process to uniquely identify the records. The file import process uses the attribute values to automatically map
your source data to the target object attributes in Oracle Applications Cloud.

The preferred option to uniquely identifying an object record is the Internal ID. If you're identifying a record that
already exists in Oracle Applications Cloud, then you can use the internal ID of the record, a system-generated unique
identifier Attributes with "ID" in the attribute name are typically internal IDs. Use this option only if you're updating
Hierarchies. You can determine the internal ID of a record by exporting Oracle Applications Cloud object data, or by
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doing a transactional database query. Using an internal ID typically provides better performance and reduces the import
duration. For the Hierarchy object, the attributes are TreeStructureCode, TreeCode, TreeName, and TreeVersionName.

Required Attributes and Validations for Hierarchy Object
To import data successfully into Oracle Applications Cloud, your .CSV file must include the required attributes. Ensure
that you provide valid values for the attributes.

The following table lists the required attributes for importing new Hierarchy records, prerequisite setup tasks for the
attributes, and specific validations, if any, for Hierarchy import:

Attribute Description Data Type Data Length Prerequisite Setup
Task/ Import
Validations

Creating a Hierarchy
Record

TreeStructureCode
 

Unique identifier for a
tree structure.
 

Varchar2
 

30
 

Seeded data needs to
be present.
 

Required
 

TreeCode
 

User defined Identifier
for the tree code.
 

Varchar2
 

30
 

No validation
 

Required
 

TreeName
 

Name of the tree
 

Varchar2
 

80
 

No validation
 

Required
 

TreeVersionName
 

Version Name of the
tree
 

Varchar2
 

80
 

No validation
 

Required
 

LangCode
 

Indicates the code
of the language
into which the
contents of the
translatable columns
are translated.
 

Varchar2
 

4
 

No validation
 

Required
 

AsofDate
 

The date that's used
to determine the
tree version when
you're updating a tree
version.
 

Date
 

 No validation
 

Optional
 

You can view the Hierarchy object along with all its child objects and attributes in the Manage Import Objects page of
the Import Management flow. You can find attribute information like type, length, description, and so on, on this page.

Create the Source CSV File
The .CSV file is provided as input to the file-based data import process. You must populate the .CSV file with the data
you want to import into Oracle Applications Cloud.

You can either create a CSV file on your own or use templates available in preexisting mappings. To download a
template, do the following:

1. Go to Navigator  > Tools >  Import Management >  Import Objects.
2. Select the Hierarchy object in the table and click Download.
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You can now edit the downloaded file and provide valid values for the required attributes.

Note:  For help in populating the CSV file and to avoid any issues in entering values, see the topic Potential Issues
When Opening CSV Files With Excel in Related Topics section.

Create the Import Activity
To import data into Oracle Applications Cloud, you need to create an import activity and provide the CSV file as an input
to the activity.

To create an import activity, do the following:

1. In the Navigator, under Tools, click Import Management.
2. In the Manage Imports page, click Create Import Activity.
3. In the Create Import Activity: Enter Import Options page, provide a name for the import activity, and select

Hierarchy from the Object drop-down list.
4. In File Name, browse and upload the required .CSV file, and click Next.
5. In the Create Import Activity: Map Fields page edit the attribute mappings if required, and click Next.

Note:  Click Validate Data to validate the mapping of the source file for unmapped columns and to check for
data format issues.

6. In the Create Import Activity: Review and Submit page, click Submit.

Note:  Initiate the Tree Flattening Service manually. Do one of the following:

◦ From the navigator, select Scheduled Processes. In the Schedule New Process dialog, search for
Party Hierarchy Generation and click OK.

◦ From Setup and Maintenance, search and run the Trading Community Party Hierarchy
Generation task.

Review the Import Results
You can review the import results by checking for the import activity in the Manage Import Activity page. A file import
activity is said to be successful when its status displays as Completed. To check the status of the import activity, do as
follows:

1. In the Navigator, under Tools, click Import Management.
2. On the Manage Imports page, search for the import activity that you created using one of the search criteria,

such as status, name, object, and so on.
3. Check the Status column for the import activity. The import is successful if the status displays as Completed.

The other valid values for the import activity status are Queued for import, Preparing data for import,
Importing data, Completed with errors, and Unsuccessful.

Note:  On this page you can also quickly view the number and status of all active imports, completed imports, and
unsuccessful imports that have been submitted.
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Related Topics
• How do I import data?

• Potential Issues When Opening CSV Files in Excel

How can I create an analysis showing only the active
sales territories in the Sales - CRM Territory Resource
subject area?  
By default, territory analyses include all territories, including those that are deleted or inactive. If you don't want to
include inactive territories in your analysis, then you can filter them out using the Effective End Date attribute which is
available in the Territory folder in the Sales - CRM Territory Resource subject area.

You've two ways of filtering out inactive sales territories in your analyses using Effective End Date :

• If you're creating an analysis using the wizard on the Reports and Analytics page, you can only filter out inactive
territories by a specific date you enter: Effective End Date > <today's date>.

• On the Catalog page, by contrast, you can, instead of a specific date, enter the variable CURRENT_DATE, which
filters out all inactive territories by the system date, the current date whenever you run the analysis.

Create the Analysis in the Wizard, filtering Out Inactive Territories by a
Specific Date

1. On the home page, click Navigator > Tools > Reports and Analytics
2. On the Reports and Analytics page, click Create > Analysis.
3. In the Select Subject Area page, search and select the Sales - CRM Territory Resource subject area and create

your analysis.
4. In the Sort and Filter step, click Add Filter and select the Effective End Date column (available in the Territory

folder).
5. Select the is greater than operator and enter a date.

6. Complete creating the analysis.
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Filter Out Inactive Territories by the System Date in the Catalog
1. On the home page, click Navigator > Tools > Reports and Analytics
2. On the Reports and Analytics page, click the Browse Catalog button.
3. Create or edit an analysis for the Sales - CRM Territory Resource subject area.
4. On the Criteria tab, click Create a filter for the current subject area  icon (the filter icon).
5. Select the Effective End Date column (available in the Territory folder).
6. In the New Filter window, select the Is greater than operator.
7. Click the Add More Options  button and select SQL expression.

Note:  You can't use Session Variable selection here.

8. In the SQL Expression field, enter CURRENT_DATE. The

9. Click OK.
10. Complete creating the analysis.

How do I specify the Industry Classification for accounts?
 
NAICS and SIC contain classification codes that represent major industries.

North American Industrial Classification System (NAICS) codes and Standard Industrial Classification (SIC) provide
uniform classification system of industries. For example,

322 is the NAICS classification code for Paper Manufacturing and 3254 is the NAICS classification code for
Pharmaceutical and Medicine Manufacturing.

Use the following procedure to specify which industry classification category you want to use for accounts.
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The classifications for the category you select appear in the list of values for the Industry field in the Account user
interface. By default, the profile is set to CUSTOMER_CATEGORY.

1. Sign in as a setup user.
2. In the Setup and Maintenance work area, go to the following:

◦ Offering: Sales

◦ Functional Area: Sales Foundation

◦ Task: Manage Administrator Profile Values

3. On the Manage Administrator Profile Values page, search for the Profile Option Code
MOT_INDUSTRY_CLASS_CATEGORY.

4. Select the classification category from the Profile Value list. The available values are:

◦ 1972 SIC

◦ 1977 SIC

◦ 1987 SIC

◦ CUSTOMER_CATEGORY

◦ NACE

◦ NAF

◦ NAICS_1997

◦ NAICS_2002

◦ NAICS_2017

5. Click Save and Close.

What are Agreement Rules?  
An agreement rule is a collection of patterns and conditions that are defined to determine whether a merge request
should be vetoed by the application or not. Merge requests that violate these rules are either rejected or end in error.

Agreement rules let you check a merge request for any veto conditions that can prevent a merge from occurring.
These rules save resources and time by obviating the need to review merge requests to prevent undesired merge from
being processed. Besides, agreement rules prompt you to consider alternative duplicate resolution mechanism such as
linking.

Agreement rule can be of the following two types:

• Predefined

• User-defined

Predefined Agreement Rules
These are agreement rules that are predefined in the application. You can only view the predefined agreement rules.

The following table describes the predefined agreement rules shipped with the application for Oracle Sales Cloud.
Merge requests that violate these rules are automatically rejected.
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Name Description

HR_APPLICANT_VETO
 

Prevents a person party with an active party usage of HR_APPLICANT from merging with another
party.
 

HR_EMPLOYEE_VETO
 

Prevents a person party with an active party usage of HR_EMPLOYEE from merging with another party.
 

HR_CONTINGENT_WORKER_VETO
 

Prevents a person party with an active party usage of HR_CONTINGENT_WORKER from merging with
another party.
 

HR_PARTY_SITE_VETO
 

Prevents a party site with active original system reference from Oracle Fusion Human Capital
Management system from merging with another party site.
 

RESOURCE_PERSON_VETO
 

Prevents a person party with an active party usage of RESOURCE from merging with another party.
 

BANK VETO
 

Prevents an organization party with an active party usage of BANK from merging with another party.
 

CLEARINGHOUSE_VETO
 

Prevents an organization party with an active party usage of CLEARINGHOUSE from merging with
another party.
 

BANK_BRANCH_VETO
 

Prevents an organization party with an active party usage of BANK_BRANCH from merging with another
party.
 

BRANCH_CLEARINGHOUSE_VETO
 

Prevents an organization party with an active party usage of CLEARINGHOUSE_BRANCH from merging
with another party.
 

LEGAL_EXTLEGAL_PARTYUSGRULE_VETO
 

Prevents an organization party with active party usage of LEGAL_ENTITY from merging with another
organization party with active party usage of EXTERNAL_LEGAL_ENTITY.
 

IC_PARTICIPANT_PERSON_VETO
 

Prevents a person party with an active party usage of INCENTIVE_COMP_PARTICIPANT from merging
with another party.
 

IC_PARTICIPANT_ORG_VETO
 

Prevents an organization party with an active party usage of INCENTIVE_COMP_PARTICIPANT from
merging with another party.
 

PARTNER_VETO
 

Prevents an organization party with an active party usage of PARTNER from merging with another
party.
 

INACTIVE_PARTNER_VETO
 

Prevents an organization party with an active party usage of INACTIVE_PARTNER from merging with
another party.
 

CUST_CONTACT_DIFF_RESOURCE_ORG_
VETO
 

Prevents two partner owned contacts belonging to different resource organizations from being
merged.
 

CUST_CONTACT_INTERNAL_PARTNER_
VETO
 

Prevents a partner owned contact that doesn't belong to a resource organization from merging with
another partner owned contact that belongs to a resource organization.
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Name Description

CUST_CONTACT_INTERNAL_PARTNER_
ORG_VETO
 

Prevents a contact owned by an internal user from merging with a contact owned by a partner user.
 

CARD_ISSUER_VETO
 

Prevents an organization party with an active party usage of CREDIT_CARD_PROVIDER from merging
with another party.
 

LEGAL_ENTITY_VETO
 

Prevents an organization party with an active party usage of LEGAL_ENTITY from merging with
another party.
 

ESTABLISHMENT_VETO
 

Prevents an organization party with an active party usage of ESTABLISHMENT from merging with
another party.
 

HIERARCHY_CYCLE_PREVENTATION_
VETO
 

Prevents merge from happening when the master party record is at a level lower than the nonmaster
party record within the same active tree version.
 

NAMEDACCOUNT_UNNAMEDACCOUNT_VETO
 

Prevents merge from happening when the master party record isn't a named account whereas the
nonmaster party recordis a named account and these are in active hierarchies.
 

The following table describes the predefined agreement rules shipped with the application for other Fusion applications.
Merge requests that violate these rules are automatically rejected.

Functional Area Name Description

Distributed Order Orchestration DOOPartyMerge Prevents the customer account and customer
account sites from getting merged when an
open Distributed Order Orchestration (DOO)
order is associated with either of them.

Distributed Order Orchestration POZSUPPLIER Prevents the party merge process from
being completed, when any of the following
conditions are met:

• The corresponding supplier isn't merged

• Few purchase orders aren't transferred for
the corresponding From Supplier

• The merged-from party and merged-
to party aren't correlated with the same
merged-from supplier and merged-to
supplier

• The corresponding supplier site haven't
been merged

• Few purchase orders aren't transferred for
the corresponding supplier site

• The merged to party site doesn't have an
associated supplier site

• The merging contact parties aren't valid
supplier contacts
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Functional Area Name Description

• The merging contact parties don't belong
to same supplier

Tax ZX_PARTY_MERGE Prevents the party from merging when any of
the following conditions are met:

• The 'From Party Tax Profile type' is not the
same as 'To Party Tax Profile type'

• The 'From Party Tax Profile type' equal to
'THIRD PARTY'

• The From party tax attributes
(Registration Type code, Registration
Number, Rule code, Self-assess flag,
Inclusive tax flag) aren't same as the To
party tax attributes (Registration Type
code, Registration Number, Rule code,
Self-assess flag, Inclusive tax flag)

Accounts Payable AP_PARTYVETO Prevents party merge in the unprocessed
invoices or unprocessed payments.

Accounts Receivable AR_FinArCustomersVeto Prevents the customer merge when either of
the following conditions are met:

• The merging customer has any Balance
Forward Bill (BFP) in draft mode in the
application

• The merging customer site has any BFB in
draft mode in the receivables application

CSE Assets CSE_SELLING_BUSINESS_UNIT_VETO After the customer account site merge, CSE
party merge will check if the new account site
+ the sold from business unit combination that
we have in our cse_assets_b table is a valid
combination using hz_cust_acct_sites_all. If not
valid, we will veto the party merge.

Service SVC_CSS_CONT_PENDING_REG_VETO
 
SVC_CSS_ACT_PENDING_REG_VETO
 
SVC_CSS_ACT_USERS_VETO
 

Validate that contacts can't be merged if the
victim contact has a self-service registration
record
 
Don't allow account merge if the account has
contacts with pending registrations
 
Do not allow account merge if the account has
active ODCS users
 

Grant/Award Management GMS_SPONSOR_NOT_EXIST_VETO
 
GMS_TOSPON_NOTLOC_VETO
 

The master party doesn't exist as a grants
sponsor.
 
The sponsor LOC of the master and target party
isn't same. Ensure the LOC is same for both
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Functional Area Name Description

sponsors. Either the LOC for both is enabled or
both is disabled.
 

User-defined Agreement Rules
These are additional agreement rules that you can define to determine whether a merge request should be vetoed by
the application. You can create, view, update, and delete user-defined agreement rules.

Note:  The application doesn't support changing agreement rules inside the Application Composer sandbox.
Therefore, the merge engine doesn't pickup the changes made to these rules inside the Application Composer
sandbox.

How do I get financial customer records to appear as
accounts in the Sales application?  
You can make basic information from customer account records in Oracle Financials appear in the Sales application in
multiple ways.

You can do any of the following:

• Enable duplicate checking in your Sales application.

• Run a process to make all Financials customer accounts available in Sales.

• Use the REST API to make individual Financials customer accounts available as Sales accounts.

Enable Duplicate Checking in Sales
When you enable duplicate checking in Sales, you make it possible for salespeople to view and select existing Financials
customer accounts make basic information about individual Financials accounts visible in Sales.

Each time a salesperson creates an account record, the application checks both sales and financials records for potential
duplicates. The application uses multiple matching criteria that you can configure, such as the organization name, the
address, tax ID, and the D-U-N-S Number. If a potential match is found, the salesperson can either select the existing
record or continue to create a new record. If the salesperson selects an existing record, and that record exists only in
Financials, then the application automatically makes the record available in Sales.

For details on how to enable duplicate checking, see the topic How do I enable duplicate checking for accounts and
contacts?.
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Run a Process
Run the process Synchronize Financials Cloud Accounts and Contacts with CX Sales to make all Financials customer
accounts visible in sales. The process identifies those Financials accounts that don't include the required Sales Account
information and automatically generates it making these accounts visible in both Sales and Financials.

1. Click Navigator > Tools > Scheduled Processes.
2. On the Overview page, click Schedule New Process.
3. In the Schedule New Process window, enter Synchronize Financials Cloud Accounts and Contacts with CX

Sales in the Name field and press Return.
4. Select the process and click OK.

Use the REST APIs
Use the web service: https://{environment host}/crmService/SalesPartyService?WSDL

Here's a sample payload. You can use it to create either an account of type Customer or type Prospect.

<typ:createSalesAccount>
<typ:salesAccount>
<sal:AccountDirectorId>999999999999999</sal:AccountDirectorId>
<sal:PartyId>999999999999999</sal:PartyId>
<sal:SalesAccountType>ZCA_CUSTOMER</sal:SalesAccountType>
<!--sal:SalesAccountType>ZCA_PROSPECT</sal:SalesAccountType-->
</typ:salesAccount>
</typ:createSalesAccount>

Related Topics

How do I enable duplicate checking for accounts and
contacts?  
You can have the application automatically check for possible duplicates whenever a salesperson creates an account or
a contact. If you're using Oracle Financials Cloud, the application checks for potential duplicates in Financials as well as
in Fusion Sales. Salespeople see the possible duplicates in a separate window and get to decide if they want to continue
creating the new record or edit an existing one instead. If they select a Financials customer account record that isn't yet
available in Sales, the basic information from that record becomes available in Sales as well. Setup is simple: just enable
the duplicate checking server, activate the built-in duplicate matching, set a couple of profile options, and you're ready
to go.

Here's a screenshot of the window salespeople see when the try to create an account with possible duplicates.
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In the background, the application uses sets of rules, called matching configurations, to identify potential account
and contact duplicates. If you license Oracle Customer Data Management, you can create matching configurations of
your own and you can also check for duplicates in your data in batches. Oracle Customer Data Management includes
industrial-strength data cleansing features, but the basic duplicate checking you're enabling here's available free of
additional charges.

Enable the Server Used for Duplicate Matching

1. In Setup and Maintenance, go to the following:

◦ Offering: Sales

◦ Functional Area: Sales Foundation

◦ Task: Manage Server Configurations

2. Click the Enabled option for EDQ Realtime and Batch Basic Match Server.

3. Click Save and Close.

374



Oracle Fusion Cloud Sales Automation
Sales Questions and Answers

Chapter 1
Sales Questions and Answers

Activate the Existing Duplicate Matching Configurations

1. In Setup and Maintenance, go to the following:

◦ Offering: Sales

◦ Functional Area: Sales Foundation

◦ Task: Manage Enterprise Data Quality Matching Configurations
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2. Activate each of the matching configurations provided by Oracle:

◦ Account Duplicate Identification

◦ Contact Duplicate Identification

◦ Address Duplicate Identification

Here's how:

a. Drill down into the configuration to edit it.
b. In the Edit Match Configuration page, click Rebuild Keys.

The application warns you that all existing keys will be purged.
c. Click Yes.

The application starts the key generation process, which takes a few minutes to complete. The page
doesn't automatically refresh the status, but you can monitor the progress of the process in the
Scheduled Processes work area (Navigator > Tools > Scheduled Processes)

Here's a partial screenshot of the Edit Match Configuration page highlighting the Rebuild Keys button
(callout 1), which is disabled after you start the process. When the process completes, the page displays
the Active option (callout 2).

d. Select the Active option.
e. Click Save and Close.
f. Reply Yes to the warning.

g. In the Incremental Key Generation window, click Submit.

When you're done, all three configurations should now have a check mark in the Active column on the Manage
Enterprise Data Quality Matching Configurations page.
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Set Profile Options for Account Matches
Set two profile options:

• Duplicate Account Notification (ZCM_ACC_DUP_NOTIFICATION)

This profile option enables the UI that shows notifications of potential duplicate accounts. Make sure that this
profile option is set to TRUE.

• Exact Account Name Match (ZCM_ACC_EXACT_NAME_MATCH)

If the data quality matching configuration fails to identify potential account duplicates, this profile option
enables checks for potential duplicate records using exact name matches only. Setting this profile option
to TRUE is optional because the data quality checking configuration uses multiple attributes, including the
organization name, D-U-N-S number, tax ID, and address to identify potential duplicates. The exact name
match is just an extra check.

1. In the Setup and Maintenance work area, open the Manage Administrator Profile Values task:

◦ Offering: Sales

◦ Functional Area: Sales Foundation

◦ Task: Manage Administrator Profile Values

2. From the search region of the Manage Administrator Profile Values page, Profile Option Code field, enter the
profile option code name for one of the profiles:

◦ ZCM_ACC_DUP_NOTIFICATION

◦ ZCM_ACC_EXACT_NAME_MATCH

3. Click Search.
4. Set the profile option value to the TRUE.
5. Click Save and Close.

Related Topics
• How do I enable duplicate checking on CX Sales Mobile?

Can I disable the Evaluate Agreement Rules profile
option?  
The Evaluate Agreement Rules (ORA_ZCH_AGREEMENT_EVALUATION) profile option controls whether agreement rules
are adhered to during merge processing.

Setting this option to N disables agreement rule checking. We recommend that you don't disable agreement rules.

Note:  Disabling agreement rules can lead to orphan data and may cause issues for different application flows. We
recommend that you don't disable it.

You can add a new profile value row and specify h or N.
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You can set the profile option value only at the site level using the predefined profile option definitions.

The following table lists the Customer Hub profile options that you can configure in the Setup and Maintenance work
area using the following:

• Offering: Customer Data Management

• Functional Area: Customer Hub

• Task: Manage Customer Hub Profile Options

How do I refresh denormalized data for account
hierarchy?  
Use the Refresh Denormalized Data for Account Hierarchy scheduled process to refresh the denormalized data for the
account hierarchy.

This scheduled process is used to update and organize the information about accounts

When to Use
This schedule process:

• This scheduled process impacts hierarchy data.

• You won’t be able to get the hierarchy data if you don’t run this scheduled process. The denormalized table will
be blank.

Privileges Required
Verify that you have the following privilege:

• HZ_RUN_TRADING_COMMUNITY_ACCOUNT_HIERARCHY_CHANGE_IDENTIFICATION_PRIV

Verify that you have the following roles:

• Sales Admin

Before You Start
Review the following before scheduling this scheduled process:

• Recommended Frequency:

◦ On regular intervals depending on how frequently the hierarchy data is getting changed or manipulated.

◦ After an upgrade, a full refresh should only be performed once. Rerun requests should only be made
when data has been added to or deleted from the hierarchy. Depending on how frequently the hierarchy
is altered, you must schedule this job and choose the frequency. This scheduled process does a full
refresh for the first time. In the subsequent runs, it syncs only impacted hierarchies.
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• Compatibility:

◦ This scheduled process is self-incompatible. If multiple instances are submitted, the first instance runs
and subsequent instances remain in blocked status until the first instance is completed.

Parameters
You might need to specify some of the following parameters:

Parameter Optional or
Mandatory

Description Parameter Values Special Combinations
Required

Notes

Full Refresh
 

Mandatory
 
Default value: No
 

After an upgrade, a full
refresh should only
be performed once.
Rerun requests should
only be made when
data has been added
to or deleted from the
hierarchy. Depending
on how frequently the
hierarchy is altered,
 you must schedule
this job and choose
the frequency. A job
will behave as a Full
Refresh if it is run
in this mode for the
first time; otherwise,
 the job will sync only
impacted nodes.
 

No
 

Under Advanced
Options, you need to
expose a parameter
for Full Refresh under
Parameters tab which
is by default selected
as "No"
 

N/A
 

Troubleshooting Information
Use this information to troubleshoot the scheduled process.

• Check the log or output file.

• If the scheduled process didn't run successfully, you can re-submit the process after rectifying the error.

• This scheduled process is idempotent, which means, this scheduled process can be restarted if it failed in the
initial run. No cleanup is required.

• You can create a notification schedule. To do this: Click Advanced Options and go to the Notification tab on
the Process Details page.

How do I enable duplicate checking in Sales?  
You can have the application automatically check for possible duplicates whenever a salesperson creates an account or
a contact. If you're using Oracle Financials, the application checks for potential duplicates in financial accounts as well as
sales accounts. Salespeople see the possible duplicates in a separate window and get to decide if they want to continue
creating the new record or edit an existing one instead. If they select a financials record that doesn't yet exist in sales,
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the basic in formation from that record becomes available in Sales as well. Setup is simple: just enable the duplicate
checking server, activate the built-in duplicate matching, set a couple of profile options, and you're ready to go.

How do I enable duplicate checking in Sales?

Here's a screenshot of the window salespeople see when the try to create an account with possible duplicates.

In the background, the application uses sets of rules, called matching configurations, to identify potential account
and contact duplicates. If you license Oracle Customer Data Management, you can create matching configurations of
your own and you can also check for duplicates in your data in batches. Oracle Customer Data Management includes
industrial-strength data cleansing features, but the basic duplicate checking you're enabling here's available free of
additional charges.

If you're using Oracle Financials, the application checks for potential duplicates in financial accounts as well as sales
accounts.

Enable the Server Used for Duplicate Matching

1. In Setup and Maintenance, go to the following:

◦ Offering: Sales

◦ Functional Area: Sales Foundation

◦ Task: Manage Server Configurations
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2. Click the Enabled option for EDQ Realtime and Batch Basic Match Server.

3. Click Save and Close.

Activate the Existing Duplicate Matching Configurations

1. In Setup and Maintenance, go to the following:

◦ Offering: Sales

◦ Functional Area: Sales Foundation

◦ Task: Manage Enterprise Data Quality Matching Configurations
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2. Activate each of the matching configurations provided by Oracle:

◦ Account Duplicate Identification

◦ Contact Duplicate Identification

◦ Address Duplicate Identification

Here's how:

a. Drill down into the configuration to edit it.
b. In the Edit Match Configuration page, click Rebuild Keys.

The application warns you that all existing keys will be purged.
c. Click Yes.

The application starts the key generation process, which takes a few minutes to complete. The page
doesn't automatically refresh the status, but you can monitor the progress of the process in the
Scheduled Processes work area (Navigator > Tools > Scheduled Processes)

Here's a partial screenshot of the Edit Match Configuration page highlighting the Rebuild Keys button
(callout 1), which is disabled after you start the process. When the process completes, the page displays
the Active option (callout 2).

d. Select the Active option.
e. Click Save and Close.
f. Reply Yes to the warning.

g. In the Incremental Key Generation window, click Submit.

When you're done, all three configurations should now have a check mark in the Active column on the Manage
Enterprise Data Quality Matching Configurations page.
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Set Profile Options for Account Matches
Set two profile options:

• Duplicate Account Notification (ZCM_ACC_DUP_NOTIFICATION)

This profile option enables the UI that shows notifications of potential duplicate accounts. Make sure that this
profile option is set to TRUE.

• Exact Account Name Match (ZCM_ACC_EXACT_NAME_MATCH)

If the data quality matching configuration fails to identify potential account duplicates, this profile option
enables checks for potential duplicate records using exact name matches. Setting this profile option to TRUE is
optional because the data quality checking configuration uses multiple attributes, including the name, D-U-N-S
number, tax ID, and address to identify potential duplicates. The exact name match is just an extra check.

1. In the Setup and Maintenance work area, open the Manage Administrator Profile Values task:

◦ Offering: Sales

◦ Functional Area: Sales Foundation

◦ Task: Manage Administrator Profile Values

2. From the search region of the Manage Administrator Profile Values page, Profile Option Code field, enter the
profile option code name for one of the profiles:

◦ ZCM_ACC_DUP_NOTIFICATION

◦ ZCM_ACC_EXACT_NAME_MATCH

3. Click Search.
4. Set the profile option value to the TRUE.
5. Click Save and Close.

How can I create a list of all prospect accounts and their
contacts?  
You can create a list of all your prospects and their contacts in the Reports and Analytics work area using the Sales -
CRM Customers and Contacts Real Time subject area.

To create a list of all accounts, select the Name attributes from the Customer and Contact folders. To filter out just the
prospect accounts, open the Customer folder, and add the filter: Account Type - Organization is equal to Prospect.

Here are the steps to create the analysis using the wizard:

1. Open the Reports and Analytics work area. (Navigator > Tools > Reports and Analytics).
2. Click Create > Analysis.
3. Search for and select the Sales - CRM Customers and Contacts Real Time subject area.
4. Click Next.

The Create Analysis wizard appears.
5. In the Select Columns step, Subject Areas pane, expand the Sales - CRM Customers and Contacts Real Time

subject area.
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6. Expand the Customer folder.
7. Scroll down to find the Name attribute and move it to the Selected Columns list.
8. In the Subject Areas pane, expand the Contact folder.
9. Scroll down to find the Name attribute and move it to the Selected Columns list.

10. Click Next.
11. In the Select Views step (Step 2), enter a name for your analysis, for example: List of Prospects and Their

Contacts.
12. In the Table list, select Table (recommended) to display your list as table.
13. Select the Preview option.

The table of your accounts and contacts appears.
14. On the list of the Wizard steps, click the Sort and Select step (Step 5).
15. Click Add Filter > More Columns on the left-hand side.
16. Open the Customer folder and select Account Type - Organization.
17. Click OK.
18. In the filter Operator field, select is equal to / is in.
19. In the Value field, enter Prospect (exact capitalization is important).
20. Click Submit.
21. Enter a name for the analysis and select the folder where you want to save it in the catalog.

Here's a screenshot showing the analysis criteria as they appear in the catalog.
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Can I create a custom field on the Partner Contact
object?  
The Partner Contact object is not yet extensible in Application Composer. Until the object is extensible, you can't create
custom fields, such as dynamic choice list fields, for the object.

How do I customize the MDF Request approval flow?  
The Marketing Development Fund feature (MDF) is optimized for partner users. You can optimize the user experience
for channel managers by modifying the relevant fields and pages for the needed roles. Since brand owners don't have
identical approval processes, MDF provides a flexible and quick way to create pre-approval validations that meet your
specific business needs. If your business processes change, you can change your validations accordingly.

Activity management pages are optimized for direct sales. You must modify the activities pages to expose MDF
attributes for customers offering MDF programs to their partners.

You must make the appropriate decisions during implementation for the following features that drive MDF request and
MDF claim approvals:

• Approval routing rules

• Approval process flows

MDF Requests and MDF Claims Approval Routing Rules
MDF requests and MDF claims submitted by partners must be assigned to appropriate personnel in your organization
so they can get access to MDF requests or claims based on their roles. For example, people who are approvers must be
assigned properly so they can view, approve, reject, or return an MDF request or an MDF claim.

By default, commonly needed approval routing rules for MDF requests and MDF claims are provided. However, you can
create your own approval workflow to route MDF requests and MDF claims to the correct approvers.

MDF Request and MDF Claim Approval Process Flows
The default MDF approval processes should meet most MDF request and MDF claim use cases. However, if you
need to modify one or both flows, you can do so by editing the included human task flows, using the existing
business flows as your templates. The templates are: FundRequestApprovalHumanTask for MDF requests and
ClaimApprovalHumanTask for MDF claims.

Use these steps to edit the existing business flow templates in the Worklist application.

1. Sign in with your sales administrator credentials.
2. Click the Notification bell icon in the global header.
3. Click More Details, and then click Customer Relationship Management.
4. From the user_name drop-down list, select Administration - Task Configuration.
5. Perform the following steps as needed:
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a. For MDF Requests

i. Search for Fund% in the search field in the left panel.
ii. Click the Edit icon in the left panel.

iii. In the Assignees tab, and click inside the MDF Request Stage One Approvers box.
iv. Click the FundRequestApproval business rule.
v. Make the changes you need to fit your business needs.

b. For MDF Claims

i. Search for Claim% in the search field in the left panel.
ii. Click the Edit icon in the left panel.

iii. In the Assignees tab, and click inside the MDF Claim Stage One Approvers box.
iv. Click the ClaimRequestApproval business rule.
v. Make the changes you need to fit your business needs.

6. Save your changes.

Change the Number of Stages in an Approval Flow
MDF offers up to five approval stages, with both serial and parallel approvals on each stage for both MDF requests and
MDF claims. If you need to add additional approval stages to the MDF request or MDF claim flow, follow these steps:

1. Click the MDF Request or MDF Claim Approval Stage Three box.
2. Deselect the Ignore Participants check box.
3. Click Advanced.
4. Deselect the Ignore Stage check box.
5. Click MDF Request or MDF Claim Approval Stage Three Approvers.
6. Click Advanced.
7. Deselect the Ignore Participants check box.
8. Save your changes.

To remove stages, you can create rules that skip approval levels. For example, use these steps if you want to have one
approval stage for MDF claims:

1. Create a new rule that skips stage one.
2. Move this rule so it's the first rule in the UI.
3. Inactivate the first seeded rule.

Example of Configuring MDF Pre-Approval Validation
Sales administrators can use Application Composer to create customer-defined validations that run before an approver
takes action on a submitted MDF request or MDF claim. In this example, a sales administrator for a brand owner
creates a validation that ensures MDF requests can only be approved if a budget is associated to the request. When this
validation is activated, approvers receive an error message when they try to approve a MDF request that doesn't have
an associated budget.

Each human task action requires a separate validation. After you create the validation in Application Composer, you
must create a profile option whose value is the name of the object function that will be invoked when the human task
action executes. You can configure validations for the following human task actions:

• Return

• Approve
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• Reject

• Withdraw

To create the pre-approval validation, sales administrators must:

1. Create the validation in Application Composer as an object function under the MDF request object, Server
Scripts link.

2. Create a site level profile option with a value that's the same as the name of the object function that will be
invoked.

1. Create and Configure the Validation
Use the following steps to create and configure a validation for MDF requests that ensures a MDF request can only be
approved if a budget is associated to it.

1. Sign in with your sales administrator credentials.
2. Ensure that you're in a sandbox.
3. Navigate to Application Composer.
4. From the list of Standard Objects, select MDF Request.
5. Select Server Scripts, then select Object Functions, and click Create.
6. On the Object Function page, provide the following:

◦ Function Name: type a name for the function, such as validateMDFRequest.

◦ Return: select String.

7. In the Parameters area, click Create and provide the following:

◦ Name: type a name for the parameter, such as parameter.

◦ Type: String.

8. In the Function Body area, type the following:

def context = parameter?.tokenize(';='); // Replace 'parameter' with whatever parameter name is defined in
the object function, in this case it is 'parameter'. .

def stage = context[1];

def participant = context[3];

def user = context[5];

if(BudgetId ==null && stage == 'SoaOLabel.RequestBudgetFundRequestApprovalStageTwo'){ // This condition

is on the second stage which is final stage for the seeded flow

return "A Budget must be associated to Fund Request before the final approval"; // Error message to be
shown on UI if the validation fails

}

return null; // Return null otherwise, which means the validation is successful.
9. Validate the script and click Save and Close.
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2. Create and Configure the Profile Option
Use the following steps to create and configure the profile option for the previous validation.

1. Sign in with your sales administrator credentials.
2. Ensure that you're in a sandbox.
3. Navigate to Setup and Maintenance.
4. Search for and select Manage Profile Options.
5. Create a new profile option with the following values:

◦ Profile Option Code: MKT_FUNDREQUEST_APPROVE_VALIDATION_OBJFUNC (This is the code for Fund
Request approve validation; the codes are predefined for object/action validation and must be defined
exactly the same)

◦ Profile Display Name: Fund Request Approve Validation Object Function

◦ Application/Module: Marketing

◦ Start Date: Provide a start date for the validation.

6. Click Save and Close.
7. Select the Enable check box for the profile option at the Site level only and select the Updatable check box at

the site level only.
8. Click Save and Close.
9. Test the validation by approving the FundRequest without providing the Budget. It should display the message

what was returned in the groovy. Once you complete the testing, you can publish the sandbox.

How do I access the Manage Service Mappings sandbox
tool?  
To access the Manage Service Mappings tool from within a sandbox, you must use the regular navigation. See Options
to Open Configuration Tools from Sandboxes UI.

How can I configure the Search and Select page for
custom dynamic choice lists?  
Search and select pages are accessed from dynamic choice list fields, and are predefined for standard objects and
automatically generated for custom objects. You can hide and show the fields that display on search and select pages,
as needed.

To configure a search and select page for an object:

1. In Application Composer, navigate to an object and click the Pages node.
2. On the Application Pages tab, scroll to the Reusable Regions region and edit the Default custom layout.

If the default custom layout doesn't yet exist, then duplicate the standard layout. You can also duplicate any
existing custom layout.

388

https://www.oracle.com/pls/topic/lookup?ctx=fa-latest&id=s20067975
https://www.oracle.com/pls/topic/lookup?ctx=fa-latest&id=s20067975


Oracle Fusion Cloud Sales Automation
Sales Questions and Answers

Chapter 1
Sales Questions and Answers

3. On the Edit Search and Select Dialog Box Layout page, configure both the search and table regions of the
search and select page.

For example, select which fields to show and hide. You can also rearrange the fields in the search region by
moving the fields up and down inside the Selected Fields pane.

Related Topics
• Configure a Search and Select Dialog Box for Custom Objects

• Configure a Search and Select Dialog Box for Standard Objects

How do I change the Summary subtab name on the
Leads page?  
While you can change the name of other subtabs on the Leads detail page, changing the name of the Summary subtab
on the Leads page isn't supported.

How can I make the opportunity's Win/Loss Reason field
required?  
To make the Win/Loss Reason field required when closing an opportunity, you can use the Close Opportunity Win/Loss
Reason Required profile option (MOO_CLOSE_WINLOSS_REQD).

Why didn't search using the Contains option in the
legacy CRM Search return the expected search results?  

If there’s an issue with the search results when you use the Contains operator, then the search results may not be
properly indexed.

To index the records, run the Optimize CRM Search Indexes and Synchronize CRM Search scheduled processes. The
Contains operator is only used in the work areas that still use CRM Search. Workspace and Redwood Sales use the
newer Adaptive Search, a high-performance search engine which permits you to search using related information.

Related Topics
• How do I run the processes that index the legacy CRM Search?

• Do I still need to run the Synchronize CRM Search Indexes process if I'm using Workspace?

• What do I when the Synchronize CRM Search Indexes process is stuck or ends with an error?
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Can I import a Java package for use in Groovy scripts?  
No, the import of additional packages isn't supported.

When writing Groovy scripts, you may use only the classes and methods that are documented. See Classes and Methods
Supported in Groovy Scripts.

Why can't I change the display name of a custom
dynamic choice list field?  
The presence of a data filter on the dynamic choice list might prevent you from changing the field's display name. Try
removing the data filter before making other field configuration updates. After making your changes, you can add the
filter back again.

How can I remove the Manage User Details link from the
Edit Partner Contact page?  
To remove the Manage User Details link from the Edit Partner Contact page, use Application Composer.

1. Create a sandbox with Application Composer enabled as a tool.
2. In Application Composer, expand Objects > Standard Objects > Contact > Pages.
3. In the Edit Partner Contact region > Edit Subtab: Summary region, open a custom layout and remove the cl4

link from the Selected Fields list.
4. Publish your sandbox.

Related Topics
• Overview of Dynamic Page Layouts

Can I update a deal registration after submitting it for
approval?  
No. After submitting a deal registration for approval, the deal registration Summary page becomes read-only.

• If partners have submitted the deal registration in error or if they want to supply additional information, then
they must withdraw a deal registration submission.

• If the deal registration approver requires additional information, then they can return the deal registration to
the partner owner.
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In such cases, the approver must specify a reason for the return.

Once the deal registration is in Returned or Withdrawn status, the partner can edit it and then resubmit the deal
registration for approval.

Can I set a default value for a child fixed choice list field?  
No. If you have two fixed choice list fields (list of value fields) that are in a hierarchical relationship, then you can't set
a default value for the child field. This is because the available values for the child field are derived from the selection
made at runtime for the parent field.

Related Topics
• Fixed Choice Lists

How do I use the Search box and search operators to
search for my records in Workspace?  
You can enter a combination of search terms using operators. For example, if you're searching for an account, you
might want to search on the account name, the street address, and the name of the primary contact, and so on. Here
are some tips and guidelines for how best to use the search box in Workspace.

Search Tips
• Use the enhanced autocomplete feature in the Workspace search box to help you add and apply filters to the

results. Autocomplete reduces the number of clicks and let you filter results without opening the Show Filters
pane. For example, as you begin to type "Prim" you'll see "Primary Industry" as one of the suggestions (Primary
Industry is an attribute of accounts). Select an attribute to show possible values in a drop-down list. You can
choose one of the possible values to filter the accounts based on that primary industry.

• If you're searching for an item with multiple words in the name, you can enter any of the words. For example,
a search for Angel retrieves matches for the account names "Vitamin Angels", "Los Angeles Rubber", and
"Angeles Warehouse".

• Workspace search also matches your entry with similarly spelled words. Search results based on such fuzzy
matches are rendered below exact matches. The most relevant items are always displayed first. The fuzzy
match settings can be changed during setup. By default, the application displays spellings that are one letter
off if the first three letters of the word match exactly. A keyword search on the term Cernar, for example, might
return "Cerner" or "Cernas" in the search results. It won't return "Cesner", "Carner", or "Kerner".

• Searching is case insensitive for the keyword Search box. Let's say you enter the words Pinnacle or pinnacle,
then Workspace returns the same results.

Note:  However, if you enter a search term with all capitalized letters, that search term is changed to Camel
Case in the search results returned. For example, if you enter RED WOOD, then Workspace returns records
containing Redwood Shores.
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• Enter entire words or numbers you're searching for.

For example, entering the word Pin when searching for accounts, returns Pin Point Needlework Inc. and Oracle
on 100 Pin Road.

• You can enter multiple search terms separated by spaces.

Spaces between words act as implicit + (plus symbol) operators. For example, entering Pinnacle Corporation
finds all the accounts with those two words in the name, including Pinnacle Savings Corporation, Pinnacle
Distribution Corporation, and Pinnacle Corporation.

• Put multiple search terms in quotes to narrow down your search.

For example, entering "Pinnacle Corporation" returns only Pinnacle Corporation, and any other records with
those two terms in that specific order.

• Capitalization doesn't matter on search terms.

• Use the star (*) symbol to indicate missing characters or partial words. This symbol can be used at the
beginning, end or middle of a word to be searched.

For example, entering *tion as your search term returns Presentation. If you enter Present*, records with
Present, Presentation, and Presents are returned. Finally, if you enter the star symbol in the middle of a word
such as Pr*tion, records with the terms Presentation and Production are returned.

• Use the question mark (?) to match exactly one character. This wildcard can be used at the beginning, end or
middle of a word to be searched.

For example, entering Pri?e returns the following results: - Price - Prize.

Search Operators
• Use the preferred operators + (plus symbol), | (pipe symbol) and - (minus symbol) in place of the boolean

operators AND, OR and NOT respectively. For example, entering + Oracle -"Redwood" returns Oracle locations
not in Redwood city.

Note:  If you don't specify any operator and use a space, then it's considered as an implicit AND and there's
no need to add the + sign. For example, entering "Oracle Redwood" will get back results having both Oracle
and Redwood keywords in them. So Oracle Redwood will give the same results as "Oracle + Redwood"

• Use the | (pipe symbol) operator to search on multiple terms.

For example, entering Chicago | Pittsburgh, finds accounts in both of these cities and accounts with those
terms in the name.

• Use the - (minus symbol) operator to narrow down your search.

For example, entering Oracle - Sunnyvale when searching for accounts, returns Oracle locations excluding
those in Sunnyvale.

When you use - (minus symbol) followed by two or more words you must enclose the words in double quotes
(" " ). For example, entering Oracle - "San Francisco" when searching for accounts, returns Oracle locations
excluding those in San Francisco. If you exclude the double quotes, then searches would return Oracle locations
in areas beginning with San such as San Jose, San Diego and so on.
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What do I do when I get a BI report time-out error?  
A time-out error in Oracle Business Intelligence Publisher means that you need to fine-tune your query. For example,
you can add more filters and use more indexed columns.

View the Oracle recommendations in the Oracle support document Oracle Business Intelligence Publisher Performance
Recommendations for Fusion Cloud Applications (Doc ID 2800118.1).

Can I modify creation page layouts in Application
Composer to let users add attachments?  
No. In Application Composer, you can add the attachments functionality to edit page layouts, but not to creation page
layouts.

This means that if users wants to add attachments to a new record, then they must create and save the record first.
They can then edit the record to add attachments.

Related Topics
• Overview of Dynamic Page Layouts

Can I add a Save and Continue button to subtab creation
pages in Application Composer?  
No. In Application Composer, you can't add a Save and Continue button to subtab creation pages. Subtab creation
pages can have only a Save button.

This means that, when users create records inside a subtab, they must first save the record and then edit it to continue
making changes.

Related Topics
• Related Object Subtabs

• Child Object Subtabs
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Is there a maximum number of page layouts that I can
create in Application Composer?  
There's no maximum number of page layouts that you can create in Application Composer for an object. As a best
practice, however, avoid creating too many page layouts. This keeps your layout management tasks simpler over future
releases.

For example, a good target to aim for might be 3-4 creation page layouts and 6-8 details page layouts.

Note:  To avoid creating too many layouts, use the UI properties on a field itself to control things like whether or not
it's visible or updatable.

Related Topics
• Overview of Dynamic Page Layouts

• Define Required, Updatable, and Hidden Properties for Fields

How can I calculate the difference between the current
date time vs. another date time using Groovy?  
To calculate the difference between the current date time vs. another date time for any given row, you can use the
Groovy sample script below.

Here's an example that uses the creation date for opportunities:

def dt2 = now();

def dt1 = CreationDate;

long diffInMills = dt2.getTime() - dt1.getTime();

println("Diff between Creation Date:" + CreationDate + " and today: " + dt2 );

println("The difference in milliseconds is:" + diffInMills );

println("The difference in seconds:" + diffInMills / 1000 );

println("The difference in minutes:" + diffInMills / (1000*60) );

println("The difference in hours:" + diffInMills / (1000*60*60) );

println("The difference in days:" + diffInMills / (1000*60*60*24) );

394

https://www.oracle.com/pls/topic/lookup?ctx=fa-latest&id=s20044162
https://www.oracle.com/pls/topic/lookup?ctx=fa-latest&id=s20065930


Oracle Fusion Cloud Sales Automation
Sales Questions and Answers

Chapter 1
Sales Questions and Answers

How can I get a list of all products and product groups?  
You can get a list of all products and product groups in your sales catalog by creating an analysis in the Sales - CRM
Opportunities and Products Real Time subject area.

Here's how to create a list of products and the product groups they're in:

1. Open the Reports and Analytics work area (Navigator > Tools >  Reports and Analytics).
2. Click Browse Catalog.
3. Click Create  > Analysis on the menu bar.
4. In the Select Subject Area window, search for and select Sales - CRM Opportunities and Products Real Time.
5. Open the Product folder. In this subject area, the attributes in the Products folder cover both Products and

Product Groups. Product Groups and Products are differentiated by the value of the Product Group Flag
attribute.

6. Move the following attributes to the Selected Columns list:

◦ Product Name

Displays both product names and product group names depending on the value of the filter Product
Group Flag you add in step 8. In this example, we're creating a report on products, so the value of this
filter is N.

◦ All the sales catalog hierarchy name fields from 1 to 8. These provide the structure of the products and
product groups in your catalog, starting with 1 at the bottom of the hierarchy:

i. Sales Catalog Hierarchy 1 Name
ii. Sales Catalog Hierarchy 2 Name

iii. Sales Catalog Hierarchy 3 Name
iv. Sales Catalog Hierarchy 4 Name
v. Sales Catalog Hierarchy 5 Name

vi. Sales Catalog Hierarchy 6 Name
vii. Sales Catalog Hierarchy 7 Name

viii. Sales Catalog Hierarchy 8 Name

◦ Sales Catalog Hierarchy Top Level Name

The name of the root node, the top product group, in the sales catalog.
7. In the Filters section, click Create a filter for the current subject area (filter) icon and click More Columns.
8. In the Select Column dialog box, open the Product folder, select Product Group Flag, and click OK.
9. In the New Filter dialog, select the is equal to/is in operator.

10. In the Value field, select the N option as you're displaying a list of products.
11. Save your report.
12. On the Results tab, you can review the list of products and the product groups they're in.

If a product belongs to a product group higher in the hierarchy, its product name is repeated in a row. For
example, the following table shows the partial row in the report for the 100kW Natural Gas Engine product. The
product name is repeated in the level 1 and level 2 names because the product is a member of the Natural Gas
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Engines product group at level 3. The Natural Gas Engines product group (in level 3) is nested in the Engines
product group (level 4).

Sample Report Row Showing the Product and Its Product Groups in the Catalog

Product Name Sales Catalog Hierarchy
1 Name

Sales Catalog Hierarchy
2 Name

Sales Catalog Hierarchy
3 Name

Sales Catalog Hierarchy
4 Name

100kW Natural Gas
Engine

100kW Natural Gas
Engine

100kW Natural Gas
Engine

Natural Gas Engines Engines

Why is my sales pipeline not showing up in the Sales
Dashboard?  
The Sales Pipeline section in the Sales Dashboard displays the results of the My Dashboard analysis provided by Oracle.
If your pipeline data doesn't match the filter criteria in the analysis, then no results show up in the Sales Dashboard.
The My Pipeline analysis displays data only on open and won opportunities that use the Standard Sales Process
sales method provided by Oracle and that are closing in the current fiscal quarter and in the next quarter. If your
opportunities use a different sales method or don't meet the other criteria, then no pipeline data will appear in the Sales
Dashboard.

To confirm if this is the issue, review the results of the My Pipeline analysis:

1. Open the Reports and Analytics work area (Navigator > Tools >  Reports and Analytics).
2. Click Browse Catalog.
3. In the Folders window pane, open the following folders: Shared Folders > Sales >  Embedded Content > Sales

Representative > oJet.
4. With the oJet folder selected, open the My Pipeline analysis in the right-hand pane.
5. Click the Results tab.
6. If the analysis doesn't display any results, then you must create your own analysis and display it in the

dashboard instead of the one supplied by Oracle.

Is Adaptive Search available for on-premise and U.S.
government pods?  
No. Many customers run their applications and Oracle databases in their own data centers on Oracle Cloud@Customer.
Currently, Cloud@Customer pods and U.S. government pods don't support Adaptive Search.
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Where can I find the lead Deal Size attribute for my BI
analysis?  
You can find the lead Deal Size attribute in multiple subject areas. For example, in the Sales - CRM Pipeline subject area,
it's available in the Facts >  Lead Facts  folder. In this subject area, and in many others, Deal Size is renamed Potential
Revenue.

Here's how to find all the subject areas that include Deal Size:

1. Download the spreadsheet for your release from the customer connect post R13.x CX OTBI Subject Area to
Database Lineage Mapping Spreadsheet.

2. Filter column G, DATABASE_OBJECT, on MKL_LM_LEADS.
3. Filter column H, DATABASE_COLUMN, on DEAL_SIZE.

Column A, SUBJECT_AREA, lists the subject areas where the attribute is available. Column B, PRESENTATION_TABLE
lists the folders that contain the Deal Size attribute.

Note:  In most of the subject areas, Deal Size is called Potential Revenue.

Here's a list of the subject areas, the folders, and attribute names for lead Deal Size in the 23C spreadsheet.

Subject Area Folder Attribute Name

Marketing - CRM Lead to Order Lead Facts Potential Revenue

Marketing - CRM Campaigns and Leads Real
Time

Lead Facts Potential Revenue

Marketing - CRM Campaign Performance Lead Facts Potential Revenue

Marketing - CRM Leads Lead Facts Potential Revenue

Marketing - CRM Leads Real Time Lead Facts Potential Revenue

Partners - CRM Leads and Opportunities Real
Time

Lead Facts Potential Revenue

Marketing Segmentation Leads Lead Deal Size

Marketing Segmentation Leads Lead Facts Potential Revenue

Partners - CRM Partner Overview Partner Registered Lead Facts Deal Size

Partners - CRM Registered Leads Real Time Partner Registered Lead Facts Deal Size

Sales - CRM Customer Overview Lead Facts Potential Revenue

Sales - CRM Pipeline Lead Facts Potential Revenue

Territory Management - CRM Leads Lead Facts Potential Revenue
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Do I need to run a process to activate a territory
proposal?  
You're no longer required to run the Activate Proposal process from the Run Territory Proposal Activation setup task to
activate a sales territory proposal. This process is now scheduled to automatically run when needed.

How does the opportunity Predicted Win Probability get
calculated?  
Oracle Sales uses a built-in machine learning model to calculate the predicted win probability of a given opportunity
using the historical data about your won and lost opportunities.

The model is automatically retrained on the prior 3 years' worth of data every month.

The model recalculates the Predicted Win Probability every 12 hours based on updates salespeople have made in the
meantime.

For the Predicted Win Probability changes to be made visible in the UI, the opportunities must be first indexed for
Adaptive Search. The indexing process, which runs often, indexes a record depending on the date and time of the last
update (Last Updated Date). Any change to the record normally updates that date. Since many changes in the Predicted
Win Probability are very incremental, however, Oracle prevents unnecessary reindexing of records by using the profile
option AI Update Who Columns Threshold (ORA_ZCA_AI_UPDATE_WHO_THRESHOLD).

By default, if the Predicted Win Probability changes by less than 5 percent, there's no update to the Last Updated Date.
You can set this profile to a different value by using the Manage Administrator Profile Values task in the Setup and
Maintenance work area. The threshold you apply here also applies to changes in the AI Lead Score.

Note:  Oracle provides an analogous model for calculating the AI Lead Score. The differences between the leads and
opportunity models are only in the details.

When you enable the Predicted Win Probability feature, the application checks that you've enough historical data for the
model to be trained. It checks you've at least the following:

• 1,000 closed opportunities

• 100 lost opportunities

• 1,000 opportunity contacts

• 1,000 opportunity stages

• 100 won opportunities

These are just the bare minimum requirements. Chances are that you won't get meaningful predictions on small
numbers.
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The model trains on the shape of your data for the different opportunity stages. Here are the objects the data is drawn
from:

• Account

• Activity

• Contact

• Opportunity

• Opportunity Contact

• Opportunity Revenue

• Opportunity Stage Snapshot
The snapshot compares information in opportunities by stages. For example, it compares the activities in the
initial Qualifying stage to the same stage in won and lost opportunities.

Attributes that don't include enough data are discarded. For example, if your opportunities typically include few
contacts, the contact information will be excluded from the model and predictions. Attributes with lots of data are
combined into features, which the model uses to make the predictions.

While you can't configure or copy the model itself, you can make some changes:

• You can exclude records from being used in the model training and predictions
For example, you can exclude opportunities that have completely different sales processes from those
you're trying to predict, because including them would yield inaccurate predictions. If you're primarily selling
equipment, for example, you may want to exclude subscription renewals. You can exclude opportunities using
multiple attributes, including sales method and sales channels, for example.
Excluded records still display the Predicted Win Probability field, but the field value is blank.

• Use custom attributes to train the model.
While you can't add attributes to the model, you can substitute custom attributes for a subset of the attributes
included in the model. The following objects permit substitutions for a small subset of existing attributes:

◦ Activity

◦ Opportunity

◦ Opportunity Contact

399



Oracle Fusion Cloud Sales Automation
Sales Questions and Answers

Chapter 1
Sales Questions and Answers

◦ Opportunity Stage Snapshot

Here's a screenshot of the page where you can tweak the model with callouts describing the major features you can use
to configure the model.

Predicted Win Probability Configuration Page

Callout Description

1 Select the object you want to configure.

2 Specify the attributes and values that you want to use to exclude records. You can enter multiple filters.

3 You can replace the attributes listed under the Model Feature Configuration heading with your own
custom attributes.

How does the AI Lead Score get calculated?  
Oracle Sales uses a built-in machine learning model to score leads. From the AI Lead Score, salespeople can get an idea
of the likelihood a lead will be converted to an opportunity. The application calculates the score, which can range from 0
to 100 percent, by finding patterns in historical data about your converted and lost leads.

The model is automatically retrained on the prior 3 years' worth of data every month.

The model recalculates the AI Lead Score in leads every 12 hours based on updates salespeople have made in the
meantime.
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For the AI Lead Score changes to be made visible in the UI, the leads must be first indexed for Adaptive Search.
The indexing process, which runs often, indexes a record depending on the date and time of the last update (Last
Updated Date). Any change to the record normally updates that date. Since many changes in the AI Lead Score are very
incremental, however, Oracle prevents unnecessary reindexing of records by using the profile option AI Update Who
Columns Threshold (ORA_ZCA_AI_UPDATE_WHO_THRESHOLD).

By default, if the AI Lead Score changes by less than 5 percent, there's no update to the Last Updated Date. You can set
this profile to a different value by using the Manage Administrator Profile Values task in the Setup and Maintenance
work area. The threshold you apply here also applies to changes in the Opportunity Win Probability.

Note:  Oracle provides an analogous model for calculating the Opportunity Win Probability. The differences between
the leads and opportunity models are only in the details.

When you enable the AI Lead Score feature, the application checks that you've enough historical data for the model to
be trained. It checks you've at least the following:

• 1,000 closed leads

• 100 converted leads

• 1,000 lead activities

Activities include calls, meetings, and emails.

• 1,000 lead contacts

• 100 retired leads

These are just the bare minimum requirements. Chances are that you won't get meaningful predictions on small
numbers.

The model trains on the shape of your data from the information in:

• Activities

• The information in the lead itself

• Lead contacts

Attributes that don't include enough data are discarded. Attributes with lots of data are combined into features, which
the model uses to make the predictions.
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While you can't configure or copy the model itself, you can make some changes:

• You can exclude records from being used in the model training and predictions using attributes from the leads
themselves or from their activities

For example, you can exclude leads for a subset of products that are different from the products you usually
sell, because including them would yield inaccurate predictions. If you're primarily selling equipment, for
example, you may want to exclude leads for subscription renewals. You can exclude leads using multiple
attributes, including product groups, campaigns, and partners, for example.

Excluded records still display the AI Lead Score field in the UI, but the field value is blank.

• You can train the model on custom attributes

While you can't add attributes to the model, you can substitute custom attributes for some of the lead
attributes included in the model. Only the Lead object itself allows substitutions for a small subset of existing
attributes:

Here's a screenshot of the page where you can tweak the model with callouts describing the major features you can use
to configure the model.

Lead Scoring Configuration Page

Callout Description

1 Select the object you want to configure.

2 Specify the attributes and values that you want to use to exclude records. You can enter multiple filters.

3 You can replace the attributes listed under the Model Feature Configuration heading with your own
custom attributes.
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How can I update prices on product lines?  
You can update a price for a product line by using a groovy script to pull the list price for a product from the selected
price book and stamp that value in the Amount field on the product line.

Here are the steps.

1. Ensure you're working in an active sandbox.
2. In Application Composer, navigate to Standard Objects > Opportunity > Opportunity Revenue > Server

Scripts.
3. Select the Triggers tab.
4. In the Server Scripts Opportunity Revenue page, in the Field Triggers section, select the Add a New Trigger

icon. The page changes to the Create Field Trigger page, and the Trigger Type field defaults to After Field
changed.

5. In the Create Field Trigger page, select Product for the Field Name.

Note:  If there are two instances of Product in the list, select the first one.

6. In the Trigger Name field, enter FetchPrice.
7. In the Trigger Definition region, enter this script:

//Get the ID of the item:
def var_InventoryItemId = nvl(getAttribute('InventoryItemId'), (long) 0) 
//Get the ID of the price book (this is useful if you have multiple price books):
def var_DCL_PriceBook = Opportunity?.PriceBook_Id_c // 
//PriceBook is a dynamic choice list on the opportunity.
//Make a view of the PriceBookItem object, since that's where the prices for items are stored:
def view_PriceBookItem = newView('PriceBookItem')
def view_Criteria = newViewCriteria(view_PriceBookItem)
def view_criteria_row = view_Criteria.createRow()

//Define the first sort criteria. Basically, find all records in PriceBookItem that match the ID of the
 InventoryItemId on revenue.
def view_condition = view_criteria_row.ensureCriteriaItem('InvItemId')
view_condition.setOperator('=')
view_condition.setValue(var_InventoryItemId)

//Define the second sort criteria. If there are multiple price books that contain the same item with
 different prices, get the price of the item corresponding to the price book selected in the dynamic
 choice list on the opportunity.
def view_condition_1 = view_criteria_row.ensureCriteriaItem('PricebookId')
view_condition_1.setOperator('=')
view_condition_1.setValue(var_DCL_PriceBook)

//Execute the sort and query the records:
view_Criteria.insertRow(view_criteria_row)
view_PriceBookItem.appendViewCriteria(view_Criteria)
view_PriceBookItem.setMaxFetchSize(1400) //1,400 is the number of records in the system; change this
 number according to your system records.
view_PriceBookItem.executeQuery()

def var_price // This is a variable that will hold the price from PriceBookItem
while(view_PriceBookItem.hasNext()){
def var_Row = view_PriceBookItem.next()

//Get the price from PriceBookItem for the item you want:
var_price = var_Row.getAttribute('ListPrice') 
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}
//Assign the price to the revenue field UnitPrice:
setAttribute('UnitPrice',var_price) 

8. Click Save and Close.
9. Verify that the FieldName in the Triggers section appears as InventoryItemId.

10. Test the changes and publish the sandbox.

How do I create a lead processing activity to run the lead
assignment process?  
Here's an example of how to create a lead processing activity to run the lead assignment process. It describes how to
run the process to assign imported leads to the inside sales representatives for lead qualification. It also outlines how to
assign qualified leads to field sales for conversion to opportunities.

Follow these steps to create a lead processing activity to run the lead assignment process:

1. Search for and open the task Manage Lead Processing Activities from the Setup and Maintenance work area.

The Lead Processing Activities page appears. This page lists all of your processing activities.
2. Click Create Lead Processing Activity.

The Create Lead Processing Activity window appears.
3. To assign the leads you previously imported to inside sales for qualification, enter the parameters listed in this

table.

UI Region Field Entry

Activity Details
 

Process Type
 

Assignment
 

Lead Selection
 

Status
 

Unqualified
 

Lead Selection
 

Assignment Status
 

Unassigned
 

Schedule
 

Schedule Mode
 

Immediate
 

4. Click Submit.
5. Next, create and submit a second activity to assign the leads to field sales after the leads are qualified. Enter the

parameters listed in this table.

UI Region Field Entry

Activity Details
 

Process Type
 

Assignment
 

Lead Selection Status Qualified
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UI Region Field Entry

   

Schedule
 

Schedule Mode
 

Run this activity on a repeating schedule to
make sure the leads are transferred to field
sales as soon as they're qualified by inside
sales.
 
To run the activity regularly, select Repeats,
 enter a frequency, a start date, and an end
date far into the future. You must enter both
a start date and an end date for the process
to run.
 

6. You can monitor the processes on the Manage Lead Processing Activities page. This page lists all of your
processing activities.

Depending on your settings, your process runs immediately or at the intervals you specified. You can monitor its
progress by searching for the job set process by name on the Overview page.

You can also set up the process to run regularly per your business requirements as follows:

1. Click Advanced.
2. Click the Schedule tab.
3. Select the Using a schedule option.
4. Select the frequency and start date.
5. Enter an end date far in the future.
6. Click Submit.

How do I enable multiple business units (BUs) for sales?  
To enable multiple business units (BUs) for sales, you must set two profile options. Set the Multiple Business Units
Enabled (HZ_ENABLE_MULTIPLE_BU_CRM) profile to Yes. You must also set the Customer Relationship Management
Business Unit Default (HZ_DEFAULT_BU_CRM) profile to the default sales business unit.

Note:  If you exported values for business unit profile options and then imported them into another environment,
keep in mind that the values aren't retained, and you need to set them each time after export/import.

Here's how to set the profile options:

1. In Setup and Maintenance, go to:

◦ Offering: Sales

◦ Functional Area: Company Profile

◦ Task: Manage Common CRM Business Unit Profile Options

2. In the Manage Common CRM Business Unit Profile Options page, select the HZ_ENABLE_MULTIPLE_BU_CRM
profile option and set it to Yes.

3. Click Save and Close.
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4. Select the HZ_DEFAULT_BU_CRM profile option and set it to the default sales business unit.
5. Click Save and Close.

What artificial intelligence (AI) features are integrated
with Sales?  
Your Oracle Sales application includes a number of analytics and artificial intelligence features that can help your
sales organization improve sales efficiency and productivity. Both types of features are grouped under the term Sales
Intelligence.

You can enable all of these features by using the Enable Sales Intelligence Features task from Setup and Maintenance
work area.

The Sales Intelligence features use three different technologies developed by different teams at Oracle:

• Adaptive Intelligence (Oracle AI Apps for Sales)

Uses machine learning models and analytics to help with processing leads and converting opportunities to
deals. For leads, Adaptive Intelligence (now renamed Oracle AI Apps for Sales) provides salespeople with
the probability of a lead being converted to an opportunity (the lead score). For opportunities, Adaptive
Intelligence recommends the best actions to take on an opportunity. In Sales in the Redwood user experience,
the recommended actions for opportunities appear automatically along with other recommendations at the top
of the list of activities. For classic Sales, you must add these to the UI using Application Composer.

• Sales Insights

Analyzes historical account, lead, opportunity, and contact data to provide salespeople with recommended
actions. As a Sales Administrator, you can enable or disable individual recommendations and change their
wording.

• Machine Learning

A platform for creating sales machine learning models. Oracle provides you with a sample Similar Accounts
model that identifies similar accounts using location, size, industry, and other factors. As a sales administrator
without prior artificial intelligence (AI) modeling expertise, you can configure your own version of the Similar
Accounts model, or you can develop completely new machine learning models of your own. The Similar
Accounts model is enabled by default. In Sales in the Redwood user experience , salespeople can review similar
accounts simply by entering "Show similar accounts" in the Action Bar. For the Sales UI, you must expose this
feature using Application Composer.

Here's a list of the different Sales Intelligence features that you can enable by using the setup task Enable Sales
Intelligence Features. When you enable a feature, the application determines if you have enough data to make the
feature live. If the feature is available for setup, then you can then configure it further using the administration UIs for
each technology.

Account Recommendations

Feature Description Technology

Account Engagement Level Rates the level of engagement of the sales
organization with each account. The rating

Sales Insights
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Feature Description Technology

is based on the number of active leads,
 the number of deals, and the frequency of
interactions and activities with the account.

Similar Accounts Identifies similar accounts by such factors as
industry, address, and company size.

Machine Learning

Contact Recommendations

Feature Description Technology

Lead Contact Recommendations Recommends contacts to add to leads.
Contacts are recommended based on their
involvement in past successful leads, deals,
 and their level of interactions with the sales
organization (the number of meetings, calls,
 and emails).
 

Sales Insights

Lead Contact Validation Recommends contacts from similar leads that
have been converted into opportunities.

Sales Insights

Opportunity Contact Recommendation Recommends contacts from similar successful
opportunities.

Sales Insights

Opportunity Contact Validation Recommends contacts that are frequently
added to similar opportunities.

Sales Insights

Lead Recommendations

AI Feature Description Technology

Effectiveness of Lead Activities Suggests what activities that a salesperson
should take on a lead based on the activities
associated with successful leads.

Sales Insights

Lead Score (AI Lead Score) Indicates the probability of a successful
conversion of sales leads to opportunities.
 

Note:  There are two types of lead score in
the application: Score and AI Lead score.
We're talking about the AI Lead Score in the
UI.

Adaptive Intelligence

Opportunity Recommendations

AI Feature Description Technology

Opportunity Activity Effectiveness Suggests what activities that a salesperson
should take on opportunities based on the
activities associated with successful leads.

Adaptive Intelligence
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AI Feature Description Technology

Opportunity Next Best Action Recommends actions from similar deals closed
in the past.

Adaptive Intelligence

Opportunity Predicted Win Probability Predicts win probability using historical data. Adaptive Intelligence

How can I delete a partner?  
You can't delete partner accounts, but you can inactivate them by changing the status to either Expired or Terminated.

When a partner account's status is Terminated:

• You can't modify existing user accounts of that partner or create new user accounts for that partner.

• You can still create new partner contacts.

• You must deactivate any existing user accounts that you don't want logging in, before you terminate a partner,
because existing partner contacts and their user accounts are intact even after you terminate a partner.

• You can always change the status of the partner back to active to allow creation or modification of the user
account again.

Why does an approved deal registration still show the
option to submit it for approval?  
If the user has either the Sales Administrator or Channel Operations Manager job role, then they will still see the Submit
for Approval action even on approved deal registrations.

This is because sales administrators and channel operations managers can resubmit approved (or rejected) deal
registrations to allow for the correction of any submissions made in error.

If, however, you don’t want your sales administrators and channel operations managers to see the Submit for Approval
action on approved deal registrations, then create custom job roles for those users with the Resubmit Deal Registration
privilege (MKL_RESUBMIT_DEAL_REGISTRATION_PRIV) removed.

How you manage Personally Identifiable Information?  
As a setup user, you can manage PII information in Oracle Applications Cloud.

In this example, you will add or update personally identifiable information (PII) data for your contacts. Before you can
add or update the PII data, you must expose the PII attributes from Application Composer in an active sandbox.
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Activate a Sandbox
1. Sign in as a setup user such as Sales Administrator.
2. From the Administration group in the Settings and Actions menu, select Manage Sandboxes.
3. Click Actions and then click New.
4. Enter a name in the Sandbox Name field.
5. Click Save and Close.
6. In the Confirmation dialog box, click OK.
7. In the Manage Sandboxes dialog box, select the sandbox you just created and click the Set as Active button.

Expose PII Attributes from Application Composer
The Taxpayer Identification Number and Home Phone PII attributes can be exposed from the Application Composer.

1. Navigate to Application Composer.
2. From the Objects View, select Standard Objects, Contact, and then Pages. Ensure Simplified Pages is

selected.
3. To add the Taxpayer Identification Number and Home Phone PII attributes to the Create Contact page:

a. In the Create Contact section, select Standard Layout and click the Edit icon.
b. In the Create Contact region, click the Edit icon.
c. Move the Taxpayer Identification Number and Home Phone PII attributes from the Available Fields list

to the Selected Fields list to add to the Create Contact page.
d. Click Save and Close.
e. Click Done.

4. To add the Taxpayer Identification Number and Home Phone PII attributes to the Edit Contact page:
a. In the Edit Contact section, select Standard Layout and click the Edit icon.
b. Click the Profile tab to add the custom field.
c. In the Summary region, click the Edit icon.
d. Move the Taxpayer Identification Number and Home Phone PII attributes from the Available Fields list

to the Selected Fields list to add to the Edit Contact page.
e. Click Save and Close.
f. Click Done

Add and Update PII Data
1. Navigate to Contacts .
2. In the Contacts page, enter the name of the contact and click the Search icon.
3. In the Edit Contact page of the contact, click the Profile tab.
4. Enter the PII data such as the Taxpayer Identification Number and Home Phone, and click Save and Close.
5. In the Contacts page, click the Create Contact button.

Note:  You can proceed to create a contact or click Cancel to exit without saving.

Publish the Sandbox
You can publish a sandbox after you have tested and verified that the modifications done in that sandbox are ready to
be moved to the mainline metadata.

1. Select a sandbox link that appears on the page and click the More link.
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2. In the Sandbox Details dialog box, click the Publish button.
3. Click Yes in the Publish confirmation message box.
4. Close the Manage Sandboxes dialog box.
5. From the Settings and Actions menu, click Sign Out.

Related Topics
• How you protect Personally Identifiable Information?

• How you manage Personally Identifiable Information?

What are the privileges or roles needed to access
Resource Directory?  
The Resource Directory icon is available in Tools menu only if you have the required privileges or roles.

Verify that you have the following job roles:

• Resource (ORA_HZ_RESOURCE_ABSTRACT)

• Sales Administrator (ORA_ZBS_SALES_ADMINISTRATOR_JOB)

You should be able to access Resource Directory pages and the Sales Admin job role further granted access to
"Identify Resources" functionality.

What are the survivorship rules for parties with custom
objects and attributes?  
This topic describes how to define survivorship rules for merging parties having custom objects and attributes.

For example, you can define a survivorship rule of the type Set Master Record to select the party with the maximum
number of custom objects or the party with a specific attribute as the master. You can also define a survivorship rule of
the type Set Attribute Value to select the smallest value for a specific attribute.

Custom Objects and Attributes
You can use Oracle Application Composer to configure and extend Oracle CX Sales and Fusion Service applications.
The Application composer provides you the ability to extend an Oracle CX Sales and Fusion Service application's object
model. You can configure CX Sales and Fusion Service objects by adding new fields (custom fields or custom attributes)
to an existing object (standard objects). Or you create entirely new objects (custom objects) and related fields (custom
attributes).

Custom Objects and Attributes in Survivorship Rules
The following table describes the basic merge operations that can be performed on standard or custom objects.
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Object Examples Can be merged Can be transferred Can be removed

Standard Top-Level Object
 

Account/Organization
 
Contact/Person
 

Yes
 

Not applicable for top-level
objects
 

Not applicable for top-level
objects
 

Standard Child Object
 

Address
 
Phone
 

Yes (by reviewing in the
Data Steward UI)
 

Yes (by default if not
merged or removed)
 

Yes (by reviewing in the
Data Steward UI)
 

Standard Child Object
 

Lead
 
Opportunity
 

No
 

Yes (always)
 

No
 

Custom Top-Level Object
 

Not applicable
(implementation specific)
 

No
 

Not applicable for top-level
objects
 

Not applicable for top-level
object
 

Custom Child Object
 

Not applicable
(implementation specific)
 

No
 

Yes (always)
 

No
 

The following table describes whether or not these objects and attributes can be used while defining conditions,
clauses, and actions for survivorship rules of the type Set Master Record and Set Attribute Value.

Object Examples Can be used in
Set Master Record
rule conditions

Can be used in
Set Master Record
rule actions

Can be used in Set
Attribute Value
rule conditions

Can be used in Set
Attribute Value
rule actions

Can be used
for Attribute
Override in Data
Steward UI

Standard Top-
Level Object
 

Account/
Organization
 
Contact/Person
 

Yes (standard and
custom attributes)
 

Yes (standard
record ID attribute)
 

Yes (standard and
custom attributes)
 

Yes (standard and
custom attributes)
 

Yes (standard and
custom attributes)
 

Standard Child
Object
 

Address
 
Phone
 

Yes (standard and
custom attributes)
 

No, survivorship
not supported for
child objects
 

No, survivorship
not supported for
child objects
 

No, survivorship
not supported for
child objects
 

No, attribute
override not
supported for child
objects
 

Standard Child
Object
 

Lead
 
Opportunity
 

Yes (standard and
custom attributes)
 

Not applicable if
you can't merge
the records
 

No
 

Not applicable if
you can't merge
the records
 

Not applicable if
you can't merge
the records
 

Custom Top-Level
Object
 

Not applicable
(implementation
specific)
 

No
 

Not applicable if
you can't merge
the records
 

No
 

Not applicable if
you can't merge
the records
 

Not applicable if
you can't merge
the records
 

Custom Child
Object
 

Not applicable
(implementation
specific)
 

Yes (all attributes
are custom)
 

Not applicable if
you can't merge
the records
 

No
 

Not applicable if
you can't merge
the records
 

Not applicable if
you can't merge
the records
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How to edit the Summary page?  
Edit the Summary page to edit the objects.

Edit a custom layout to do the following:

• Add fields, actions, links, buttons, and subtabs. If you add the Attachments field, then at runtime, users can add
attachments to the record.

• Hide and show, reorder, and relabel regions, including subtabs.

To edit a custom layout:

1. In Application Composer, select the object that you want to create custom layouts for.
2. Expand the object in the object tree, and select the Pages node.
3. Select the Application Pages tab.
4. Find the type of page that you want to modify, such as a creation page layout or a details page layout. Click the

Duplicate Layout icon to duplicate and edit an existing layout.
5. Design the page layout. Depending on how the page is designed, you can add fields, actions, links, and buttons.

You can also hide and show, reorder, and relabel regions.

If the page layout is for a details page, then you can also add and reorder subtabs, and add the Attachments field.

Note:  Adding the Attachments field lets users add attachments to the record at runtime.

At runtime, while editing an object, you can mark the record as your favorite using the Add to favorites icon.

How do I import organization data?  
You can use Import Management to create or update Organization records.

To import Organization records, perform the following tasks:

1. Map your source data to Oracle Applications Cloud object attributes.
2. Create source Comma Separated Values (CSV) file for import.
3. Create the import activity.
4. Review the import results.

How You Map Your Source Data to Target Object Attributes
To import your Organization data into Oracle Applications Cloud, you need to populate a CSV file with your source data
and map that source data to target object attributes in Oracle Applications Cloud.

You need to do the following before creating the CSV file for data import:

• Identify how your source data attributes map to the target object attributes in Oracle Applications Cloud.
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• Ensure prerequisite setups are done, if applicable.

• Understand your options for uniquely identifying the records.

• Ensure parent records exist before importing child records.

• Identify the target object attributes that are required in the CSV file for a successful import.

• Ensure that you don't insert duplicate addresses while importing, to avoid redundant data.

Before You Start
You must do some basic checks before starting your import. For example, make sure that:

• You have completed all the prerequisites for importing each attribute in your source data.

• You have all parent records in place before importing child records.

Select a Unique Identifier for Your Records
All records must be unique in the application. You can use one of these to identify records:

• Public unique identifiers: If you're creating records, then you can provide an easily understandable public
unique identifier. These are, usually, denoted with 'Number' and visible in the business object's UI. PUID
attributes are usually named <object> Number. If you're updating a record with a Number attribute, then use
the Number attribute to identify the record. For more information about public unique identifiers, see the topic
"How You Use Alternate Keys to Import Records" in Related Topics section.

• Source system and source system reference: Source system is an identifier for the external system, and source
system reference is a unique identifier within the external system. If you're importing new organizations or are
updating organizations that have source system reference data, then provide the source system and source
system reference values.

Required Attributes and Validations for Organization Object
To import data successfully into Oracle Applications Cloud, your CSV file must include the required attributes. Ensure
that you provide valid values for the attributes. This table lists the required attributes for importing new Organization
records, required attributes for updating Organization records, prerequisite setup tasks for the attributes, and specific
validations, if any, for Organization import:

Attribute Description Prerequisite Setup Task/
Import Validations

Creating an Organization
Record

Updating an Existing
Organization Record

SourceSystem
 

The original source system
name
 

Know the source system.
 
To view source systems,
 use the Manage Trading
Community Source System
task.
 

Conditionally Required
 
To identify an organization
record, use one of these:
 

• Combination of
SourceSystem and
SourceSystemReferenceValue

• PartyNumber

Conditionally Required
 
To identify an organization
record, use one of these:
 

• Combination of
SourceSystem and
SourceSystemReferenceValue

• PartyNumber

SourceSystemReferenceValue
 

The identifier in the original
source system
 

Know the source system
reference value.
 

Conditionally Required
 

Conditionally Required
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Attribute Description Prerequisite Setup Task/
Import Validations

Creating an Organization
Record

Updating an Existing
Organization Record

To view the source systems
reference, use the Manage
Trading Community Source
System task.
 

To identify an organization
record, use one of these:
 

• Combination of
SourceSystem and
SourceSystemReferenceValue

• PartyNumber

To identify an organization
record, use one of these:
 

• Combination of
SourceSystem and
SourceSystemReferenceValue

• PartyNumber

PartyNumber
 

The public unique identifier
of the party.
 

Know party number.
 
To obtain a list of all party
IDs and party numbers,
 export the Party object.
 

Conditionally Required
 

Conditionally Required
 

OrganizationName
 

The name of the party of
the Organization party
type.
 

The organization names
are listed in the Resource
Directory.
 

Required
 

Conditionally Required
 

PartyUsageCode
 

Specifies the party
usage code to which the
organization is associated
 

This should be an active
value in the HZ_PARTY_
USAGES_B table.
 

Required
 

Not required
 

CleanlinessScore
 

The overall score for
the account or contact
record for the category
Cleanliness
 

No validation
 

Optional
 

Optional
 

CompletenessScore
 

The overall score for
the account or contact
record for the category
Completeness
 

No validation
 

Optional
 

Optional
 

DataConfidenceScore
 

The overall data confidence
score that indicates the
level of data quality for a
record
 

No validation
 

Optional
 

Optional
 

DuplicateIndicator
 

Signifies the duplicate
status of the record that's
determined as follows:
 

• A null value indicates
that the record isn't
a duplicate or hasn't
been evaluated.

• The record can also
have one of 2 other
values - DUPE (record
is a duplicate) or LINK
(record is linked to
another record).

No validation
 

Optional
 

Optional
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Attribute Description Prerequisite Setup Task/
Import Validations

Creating an Organization
Record

Updating an Existing
Organization Record

DuplicateScore
 

The overall score for the
account or contact record
for the category Duplicate
 

No validation
 

Optional
 

Optional
 

EnquiryDuns
 

A unique identifier used
to query the Dun and
Bradstreet data. If the
location is a branch,
 in some countries the
"DUNS" number of the
headquarters is used to
run the query. Otherwise,
 the "DUNS" number is
considered.
 

No validation
 

Optional
 

Optional
 

EnrichmentScore
 

The overall score for
the account or contact
record for the category
Enrichment
 

No validation
 

Optional
 

Optional
 

LastScoreUpdateDate
 

The date and time at which
this record was updated by
the source system in the
last update source system
column
 

No validation
 

Optional
 

Optional
 

RecencyScore
 

The overall score for the
account or contact record
for the category Recency
 

No validation
 

Optional
 

Optional
 

ThirdPartyFlag
 

This option tracks if a party
has a direct relationship
with the organization
using Oracle receivables
or through a third party
supplier. The value Y
denotes third party
relationship, while the
value N denotes direct
relationship. If Oracle
Service is installed, the
Third Party field in the
Customers window is
mandatory.
 

No validation
 

Optional
 

Optional
 

ValidatedFlag
 

Indicates if the party was
validated. The value Y
denotes a validated party,
 while the value N denotes a
party that's not validated.
 

No validation
 

Optional
 

Optional
 

ValidityScore
 

The overall score for the
account or contact record
for the category Validity

No validation
 

Optional
 

Optional
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Attribute Description Prerequisite Setup Task/
Import Validations

Creating an Organization
Record

Updating an Existing
Organization Record

 

You can view the Organization object along with all its child objects and attributes in the Manage Import Objects page of
the Import Management flow. You can find attribute information like type, length, description, and so on, on this page.

Create the Source CSV File
You include the data that you want to import into CX Sales and Fusion Service in a source CSV file.

You can use the templates available in the Import Objects UI page to create the source CSV file. To download a template:

1. Go to Navigator  > Tools >  Import Management >  Import Objects.
2. Select the Organization object in the table and click Download.

You can now edit the downloaded file and provide valid values for the required attributes.

Note:  For help in populating the CSV file and to avoid any issues in entering values, see the topic Potential Issues
When Opening CSV Files With Excel in Related Topics section.

Create the Import Activity
After you have the CSV file ready, create an import activity to import the information. To create an import activity:

1. Go to Navigator  > Tools >  Import Management >  Import Queue.
2. Click Create Import Activity in the Manage Imports page.
3. In the Enter Import Options page, provide a name for the import activity, and select Organization from the

Object drop-down list.
4. Select the CSV file in the File Name field, and click Next.
5. You would see that the source and target attributes are automatically mapped in the Map Fields page. Review

and edit the mappings if required.
6. Check the file for unmapped columns or data format issues by clicking Validate Data. Click Next.
7. Review the import details on the Review and Submit page, and click Submit when you're ready.

Review the Import Results
Check if your import succeeded on the Manage Imports page. This page shows the status of all active, completed, and
unsuccessful imports. To check the status of the import activity:

1. Go to Navigator  > Tools >  Import Management >  Import Queue.
2. Click All Imports and search for the import activity that you created earlier.
3. Check the Status column for the import activity. The import is successful if the status displays as Completed.

You can drill down on the import activity to go to the Import Status page which provides the status details of
the import activity.

Related Topics
• How do I import data?

• Potential Issues When Opening CSV Files in Excel

• How You Use Alternate Keys to Import Records
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How do I import account data?  
You can use Import Management to create, update, or delete your account data.

You can import account records using these steps:

1. Map your source account data to Oracle Applications Cloud object attributes. This way the import process
would know where to insert each of the information bits.

2. Create the source CSV file with the account data you want to import.
3. Kick off an import activity.
4. Check the import results to know if the import went well.

How You Map Your Source Data to Target Object Attributes
You import account data into Oracle Applications Cloud from a CSV file containing your source data that's mapped to
target Oracle Applications Cloud object attributes.

You need to do the following before creating the .csv file for data import:

• Identify how your source data attributes map to the target object attributes in Oracle Applications Cloud.

• Ensure prerequisite steps are complete, such as understanding what attributes are required for importing your
objects.

• Understand your options for uniquely identifying the records.

• Ensure parent records exist before importing child records.

• Identify the target object attributes that are required in the .csv file for a successful import

Note:   You can enable automatic territory-based assignment after sales accounts are imported. You can enable this
feature by turning the profile option ZCA_BATCH_ASSIGN_ON_BULK_IMPORT ON. If the profile option is disabled,
then you must manually run a batch assignment or assign each sales account individually.

To better manage your account information, the account object has the following child objects:

• Address

• Classification

• Relationship

• Sales Team Member

Note:  You can't set an attribute value to NULL in high-volume import (import management with the option Enable
High-Volume Import selected). However, when updating a record, you can change an attribute value from NOT NULL
to NULL

If you're importing account records with attributes specific to the parent account object or along with single child record
details (like phone, email, address, and so on), then you can include the child record details in the same .csv file for
account object. However, if you're importing multiple records of any child object, then you must create multiple .csv
files to import- one for each child which has multiple records that you're importing. For example, if you're importing 5
emails, 5 phones, and 5 addresses for an account, then you must create three import files - one for Account object, one
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for Contact Point object (phone and email), and one for Address object. There are separate help topics describing how
to import each of these child objects. For more information, see the related topics section.

Note:  High-volume import for accounts now supports hierarchy management and generation.

Before You Start
You must do some basic checks before starting your import. For example, make sure that:

• You have completed all the prerequisites for importing each attribute in your source data. For example, when
using source system reference information to identify your account records, the source system of the account
object should be enabled for parties using the Manage Trading Community Source Systems task.

• You have all parent records in place before importing child records. For example, when importing the address of
an account, ensure the account exists.

Select a Unique Identifier for Your Records
All records must be unique in the application. You can use one of these to identify records:

• Public unique identifiers: If you're creating records, then you can provide an easily understandable public
unique identifier. These are, usually, denoted with 'Number' and visible in the business object's UI. PUID
attributes are usually named <object> Number. If you're updating a record with a Number attribute, then use
the Number attribute to identify the record. For account object, the attribute is PartyNumber and shows up
in the UI as Party Number. For more information about public unique identifiers, see the topic "How You Use
Alternate Keys to Import Records" in Related Topics section.

• Source system and source system reference: Source system is an identifier for the external system, and source
system reference is a unique identifier within the external system. If you're importing new accounts or are
updating accounts that have source system reference data, then provide the source system and source system
reference values. For account object, these are SourceSystem and SourceSystemReferenceValue and show up
as Party Source System and Party Source System Reference Value in the UI.

Review Required Attributes and Validations for Account Object
To import data successfully into Oracle Applications Cloud, your CSV file must include the required attributes. Make sure
that you provide valid values for these attributes so that they pass import validations inbuilt into the application.

This table lists the required attributes for account records, prerequisite setup tasks and specific validations, if any:

Attribute Description Prerequisite Setup
Tasks or Import
Validations

Creating an Account
Record

Updating an Existing
Account Record

Deleting an Existing
Account Record

SourceSystem
 

The source system for
the sales account.
 

Know the source
system.
 
To view source
systems, use the
Manage Trading
Community Source
System task.
 

Conditionally Required
 
To identify an account
record, use one of
these:
 

• SourceSystem
and
SourceSystemReferenceValue

Conditionally Required
 
To identify an account
record, use one of
these:
 

• SourceSystem
and
SourceSystemReferenceValue

Conditionally Required
 
To identify an account
record, use one of
these:
 

• SourceSystem
and
SourceSystemReferenceValue
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Attribute Description Prerequisite Setup
Tasks or Import
Validations

Creating an Account
Record

Updating an Existing
Account Record

Deleting an Existing
Account Record

• PartyNumber • PartyNumber • PartyNumber

SourceSystemReferenceValue
 

The reference number
or text representing
the source system
unique ID for the party
(account or contact) to
which the sales profile
belongs.
 

Know the source
system reference
value.
 
To view the source
systems reference, use
the Manage Trading
Community Source
System task.
 

Conditionally Required
 
To identify an account
record, use one of
these:
 

• SourceSystem
and
SourceSystemReferenceValue

• PartyNumber

Conditionally Required
 
To identify an account
record, use one of
these:
 

• SourceSystem
and
SourceSystemReferenceValue

• PartyNumber

Conditionally Required
 
To identify an account
record, use one of
these:
 

• SourceSystem
and
SourceSystemReferenceValue

• PartyNumber

PartyNumber
 

The public unique
identifier of the party.
 

The party must exist.
 
You get a list of all
party IDs and party
numbers by exporting
the Party object.
 

Conditionally Required
 

Conditionally Required
 

Conditionally Required
 

OrganizationName
 

The name of the party
of the Organization
party type.
 

Organization names
are listed in the
Resource Directory.
 

Required
 

Conditionally Required
 

Conditionally Required
 

OwnerPartyId
 

The identifier of the
account owner.
 

This attribute is
required only in
import management,
but optional in high-
volume import.
 

Required
 

Not Required
 

Not Required
 

Note:  When deleting or updating accounts, you must ensure that the account related to the party number provided
has the Sales Account usage. If you provide the party number of an account that doesn't have the Sales Account
usage, then the relationships for that account are also deleted. For example, if you provide the party number
ORA17292 that doesn't have a Sales Account usage, then the related partners, contacts, and so on are also deleted.

For the extension child objects of account, RecordName field isn't unique. Hence you can't update the records only by
passing RecordName.

You can use the profile option ORA_HZ_IMPORT_MULTI_ADDRESS_TYPE to control how address types are entered. By
default this profile option is set to Yes, so you can enter multiple address types, during high-volume import of Account,
Contact, and Household objects . You can disable this profile option to improve the import performance. When you set
this profile option to No, you can enter only a single address type.

Note:   When importing accounts or legal entities, you can retrieve duplicates using the Customer Data Management
Duplicates LOV only if you have licensed the data quality functionality. Once licensed, you must rebuild the keys for
your matching configuration using the Manage Enterprise Data Quality Matching Configurations task. After the keys
are rebuilt, the matching functionality uses the settings in the match configuration to identify duplicates.

419



Oracle Fusion Cloud Sales Automation
Sales Questions and Answers

Chapter 1
Sales Questions and Answers

Go to Navigator  > Tools >  Import Management >  Import Objects to see all the attributes of the account object. The
page also lists attribute information like type, length, description, and so on.

Create the Source CSV File
You include the data that you want to import into CX Sales and Fusion Service in a source CSV file.

You can use the templates available in the Import Objects UI page to create the source CSV file. To download a template:

1. Go to Navigator  > Tools >  Import Management >  Import Objects.
2. Select the Account object in the table and click Download.

You can now edit the downloaded file and provide valid values for the required attributes.

Providing the ZIP and Country Code values in the import CSV file won't automatically populate the State/County/City
fields. Values for these fields should be separately provided in the import file.

Note:  For help in populating the CSV file and to avoid any issues in entering values, see the topic Potential Issues
When Opening CSV Files With Excel in Related Topics section.

Create the Import Activity
After you have the CSV file ready, create an import activity to import the account information. To create an import
activity:

1. Go to Navigator  > Tools >  Import Management >  Import Queue.
2. Click Create Import Activity in the Manage Imports page.
3. In the Enter Import Options page, provide a name for the import activity, and select Account from the Object

drop-down list.
4. Select the CSV file in the File Name field, and click Next.
5. You would see that the source and target attributes are automatically mapped in the Map Fields page. Review

and edit the mappings if required.
6. Check the file for unmapped columns or data format issues by clicking Validate Data. Click Next.
7. Review the import details on the Review and Submit page, and click Submit when you're ready.

Review the Import Results
Check if your import succeeded on the Manage Imports page. This page shows the status of all active, completed, and
unsuccessful imports. To check the status of the import activity:

1. Go to Navigator  > Tools >  Import Management >  Import Queue.
2. Click All Imports and search for the import activity that you created earlier.
3. Check the Status column for the import activity. The import is successful if the status displays as Completed.

You can drill down on the import activity to go to the Import Status page which provides the status details of
the import activity.

Note:  After importing your data successfully, you need to run a couple of post processing jobs for duplicate
identification, duplicate resolution, and account assignment. For more information on import management post
processing jobs, see the topic Import Management Post Processing Jobs
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When importing accounts you can now load the account hierarchy data. Use the following attributes to import accounts:

• ParentAccountPartyId

• ParentAccountPartyNumber

• ParentAccountSourceSystem

• ParentAccountSourceSystemReferenceValue

You can load account hierarchy data. To load the account hierarchy data:

1. Load the account data without providing values for the parent attributes mentioned above.
2. Load the account hierarchy using the Hierarchy and Hierarchy Member import objects. For more information,

see How do I import hierarchy data? and Import Your Hierarchy Member Data

Delete an Account

Related Topics
• How do I import data?

• How do I import contact point data?

• Import Your Address Data

• How You Use Alternate Keys to Import Records

• Potential Issues When Opening CSV Files in Excel

• How You Enable Automatic Account Assignment

How do I enroll into a partner program?  
If the channel organization offers partner programs, a partner can enroll into a partner program and receive the benefits
associated with that program.

Note:  By default, partner users can't access partner program enrollments. To provide access, assign the
ZPM_VIEW_PARTNER_PROGRAM_ENROLLMENT_PRIV and ZPM_APPLY_PARTNER_PROGRAM_PRIV privileges.

The process of enrolling into a partner program involves the following:

1. Select the partner program from a program catalog listed in the channel organization's application.
2. Confirm basic information like the organization, language, and so on.
3. Select a start date for the enrollment.

Note:  The start date can't be past or prior to the active dates of the partner program. If partners don't specify
a start date, the approval date of their enrollment becomes the start date for the enrollment.

4. Complete the questionnaire.
5. Accept the agreements associated to the partner program.
6. Review and submit the partner program enrollment request.
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Related Topics
• Synchronize User and Role Information

What are the file-size limits for import?  
You can import a maximum of 50,000 records per data file. This limit is applicable for files imported using the User
Interface and the REST service (low-volume). The size of the data file can't exceed 250 MB.

You can submit multiple jobs at one time. The application dynamically calculates the number of jobs that will run
parallelly at a time. All other jobs are queued and executed as and when the previous jobs complete.

Note:  If you're using the importActivities REST service to submit jobs (also known as 'import activities'), then each
job can contain up to 20 CSV files in the request payload. This means that 10 jobs, each with 20 CSV files of 50,000
records, can instruct the application to process up to one million records at a time.

To import much higher volumes of data, you must use the External Data Loader Client (EDLC). EDLC accepts files with
more than 50,000 records. It breaks these larger files into smaller pieces of 50,000 each and imports them. Using the
high-volume mode of EDLC, you can split and import in pieces of 500,000 records each.

Here are the file and record limits for Import Management:

Import Channel and Mode Maximum Number of Files per job
Submission

Maximum Records Processed in a Single
Submission

User Interface (low-volume)
 

1 file (50k records)
 

50k records
 

REST Service (low-volume)
 

50k records per file
 

Unlimited (Must be manually split by the user
into 50k record files)
 

EDLC (low-volume)
 

50k records per file
 

Unlimited (EDLC splits into 50k record files by
default, and submits in a single REST call.)
 

User Interface (high-volume)
 

1 file (500k records)
 

Unlimited (Must be manually split by the user
into 500k record files)
 

REST Service (high-volume)
 

500k records per file
 

Unlimited (Must be manually split by the user
into 500k record files)
 

EDLC (high-volume)
 

500k records per file
 

Unlimited (EDLC splits into 200k record files by
default, and submits in a single REST call.)
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Note:  Oracle recommends that you use EDLC (high-volume) import for the supported objects and that you limit
the job to 2 million records with 20 files per job (around 100k records per CSV file). If you plan to run parallel import
batches, Oracle recommends that you run a maximum of 10 parallel batches. User performance will vary based on
your data and configuration. The recommendation of 10 parallel batches of 100 K records is a tip to get you started.
You need to explore and identify the configuration that best suits your organization's requirements.

Note:  Ensure that purge and imports aren't running in parallel for the same object at the same time.

Note:  Split the data into multiple files if the import with large number of fields or 50k records fails.

Note:  Order the records to have better performance. Keep all the child levels belonging to the same parent in the
same file. Such as keep all the Subscription cover levels belonging to the same parent "Subscription Product " in the
same file.

How do I import incentive compensation participants?  
You can use the import management functionality to create or update Incentive Compensation Participants. You can
specify the exact parties you want to import as participants.

You can import Incentive Participants using these steps:

1. Map your source data to Oracle Applications Cloud object attributes. This way the import process would know
where to insert each of the information bits.

2. Create the source CSV file for import.
3. Create the import activity.
4. Review the import results.

How You Map Your Source Data to Target Object Attributes
You import Incentive Participants into Oracle Applications Cloud from a CSV file containing your source data that's
mapped to target Oracle Applications Cloud object attributes.

Before you create the source data file, you should:

• Know how your source data attributes map to the target object attributes in Oracle Applications Cloud. Match
each column from the source file to an attribute in the Incentive Participants import object.

• Finish all prerequisite steps, such as understanding what attributes are required for importing your objects.

• Know how you can uniquely identify the records.

• Check the target object attributes required in the CSV file for a successful import.

• Ensure that you don't insert duplicate Incentive Participants while importing, to avoid redundant data.
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Before You Start
You must do some basic checks before starting your import. For example, make sure that:

• You have completed all the prerequisites for importing each attribute in your source data.

• You have all parent records in place before importing child records.

Required Attributes and Validations for Incentive Participants Object
To import data successfully into Oracle Applications Cloud, your CSV file must include the required attributes. Ensure
that you provide valid values for the attributes.

This table lists the required attributes for Incentive Participants, prerequisite setup tasks and specific validations, if any:

Attribute Description Prerequisite Setup Task/
Import Validations

Creating an Incentive
Participant

Updating an Existing
Incentive Participant

PartyNumber
 

The party number of the
participant. This is used to
find the party that's to be
imported as a participant.
 

The PartyNumber must
match an existing party.
 

Required
 

Required
 

Business Unit
 

Unique numeric identifier
for the Oracle Fusion
Incentive Compensation
business unit
 

The business unit should
be valid.
 

Required
 

Not Required
 

Type
 

Indicates whether the
participant is an Analyst
or Participant. Analysts
administer and manage the
application. Participants
are individuals who can
receive compensation or
sales credits inside the
application.
 

The valid values are
ANALYST or PARTICIPANT.
 

Required
 

Not required for update.
This field can't be updated
or changed after the
participant is created.
 

Go to Navigator  > Tools >  Import Management >  Import Objects, to see all the attributes of the Incentive
Participants object. The page also lists attribute information like type, length, description, and so on.

Note:   You can't update participant detail records through import after the initial creation. You can update them by
creating a new import, via the UI, or through a REST call.

Create the Source CSV File
You include the data that you want to import into Sales and Fusion Service in a source CSV file.

You can use the templates available in the Import Objects UI page to create the source CSV file. To download a template:

1. Go to Navigator  > Tools >  Import Management >  Import Objects.
2. Select the Incentive Participants object in the table and click Download.
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You can now edit the downloaded file and provide valid values for the required attributes.

Note:  For help in populating the CSV file and to avoid any issues in entering values, see the topic Potential Issues
When Opening CSV Files With Excel in Related Topics section.

Create the Import Activity
After you have the CSV file ready, create an import activity to import the Incentive Participants information. To create an
import activity:

1. Go to Navigator  > Tools >  Import Management >  Import Incentive Participants.
2. On the Manage Imports page, click Create Import Activity.
3. In the Create Import Activity: Enter Import Options page, provide a name for the import activity, and select

Incentive Participants from the Object drop-down list.
4. Select the CSV file in the File Name field, and click Next.
5. You would see that the source and target attributes are automatically mapped in the Map Fields page. Review

and edit the mappings if required.
6. Check the file for unmapped columns or data format issues by clicking Validate Data. Click Next.
7. Review the import details on the Review and Submit page, and click Submit when you're ready.

Review the Import Results
Check if your import succeeded on the Manage Imports page. This page shows the status of all active, completed, and
unsuccessful imports. To check the status of the import activity:

1. Go to Go to Navigator  > Tools >  Import Management >  Import Incentive Participants.
2. Click All Imports and search for the import activity that you created earlier.
3. Check the Status column for the import activity. The import is successful if the status displays as Completed.

You can drill down on the import activity to go to the Import Status page which provides the status details of
the import activity.

Related Topics
• How You Use Alternate Keys to Import Records

• Potential Issues When Opening CSV Files in Excel

How can I avoid creating a paysheet if the payment
amount is zero?  
You can’t avoid creating a paysheet even if the payment amount is zero. This allows analysts to create manual
adjustments, if needed.

However, to avoid unnecessary data validation and approvals on paysheets with zero amounts, use the Manage
Parameters task in the Setup and Maintenance work area. Settings that you make using the Manage Parameters task
affect payment processing, including paysheet approvals.

1. In the Setup and Maintenance work area, go to the following:
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◦ Offering: Sales

◦ Functional Area: Incentives

◦ Task: Manage Parameters

2. Set the Default Paysheet Approval Status to Approved.
3. Set the Minimum Payment Automatic Approval Amount to 0.

Can I create a non-monetary earning type for plan
components?  
You can create a non-monetary earning type in Setup and Maintenance.

1. In the Setup and Maintenance work area, go to the following:

◦ Offering: Sales

◦ Functional Area: Incentives

◦ Task: Manage Earning Types

2. For each business unit that you need, create an earning type called Non-monetary.
3. Note:  Don’t set up any currency code for this earning type.

You can then associate plan components with this non-monetary earning type in the Compensation Plans work area.

How do I change the way the person's name is displayed
in the home page welcome greeting?  
You can change the name format in the welcome greeting by using the Manage Person Name Formats task in the Setup
and Maintenance Work area. By default, the greeting displays the first name followed by the prefix and the last name.
You can change it to any format. For example, you can display last name followed by the first name, the prefix and the
last name only, or just address the person with the first name.

You can create your own formats, two for each country:

• A local format is suitable for users in a single legislation who prefer to see person names in the character set
appropriate to their legislation.

• A global format is suitable for users in a multinational enterprise who prefer to see person names in a single
(typically, Western) character set, so that all names, regardless of origin, have the same representation.

See the following topics for details:

Related Topics
• Person Name Formats

• Apply Name Formats to Person Names, Keywords, and LDAP
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How do I ensure that workflow task notifications in the
Global Header and Home Page are synchronized?  
Users can get in-app notifications for the same workflow task in various UIs and email notifications. The Synchronize
Notifications in Global Header scheduled process ensures that all the in-app notification UIs reflect the latest task
status.

When workflow tasks are assigned to users, they can get an email and a notification in the global header and in the
Things to Finish section on the home page. Updates they make to tasks from the global header, for example approving
them, are automatically reflected in the Things to Finish section. Same goes the other way around, too.

But, the notifications don't immediately reflect changes to the task status if users act through email, the Worklist:
Notifications and Approvals work area, or BPM Worklist. For example, after you approve a task from email, you can still
see the notification in the global header and home page asking for approval. Another case like that's when a task is
assigned to an approval group, and everyone in the group gets a notification. Say you approve that task from the Things
to Finish section. Your notification is removed from that section and the notifications list in the global header, but the
same notification is still there for everyone else in the approval group.

So, use the Synchronize Notifications in Global Header scheduled process to sync notifications with the latest task
status for all users:

• This affects the notifications list in the global header, the Things to Finish section, and the Notifications page
that shows all notifications, not just what's pending for the user.

• The process includes notifications not just for tasks that require action, but also ones that are just FYI.

• The process doesn't update the title of notifications in the global header, home page, or Notifications page. Like
email subjects, the notification titles are static.

Note:  No matter what the task status is, the scheduled process also removes notifications that are older than 30 days
from the notifications list, Things to Finish section, and Notifications page.

Even when notifications aren't in sync with the latest workflow task status, users can still find the latest task status in the
Worklist: Notifications and Approvals work area.

Schedule the Process
In the Scheduled Processes work area, submit the Synchronize Notifications in Global Header process to run on
a schedule. It's recommended that you schedule the process to run every two hours. How often you should run the
process depends on the volume of approvals. For example, there might be more during month-end or year-end
activities. But if you do need to run the process more often, don't schedule it to run more often than every 30 minutes.

How long the process takes to run also depends on the volume of approvals. If you're running the process for the first
time, or it hasn't run in a very long time, then the process might take hours to finish.

You need to have the Manage Scheduled Job Definition (FND_MANAGE_SCHEDULED_JOB_DEFINITION_PRIV) privilege
to run this process. Your security administrator can assign a custom job role with this privilege.
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What Happens After Synchronization
One key thing that affects what users see in the notifications list, Things to Finish section, or Notifications page is
whether the workflow task is pending for the user. Here's an example of what happens before and after the scheduled
process runs:

1. A notification is pending a user's approval.
2. The user approves the task from email. The task status changes, but the notification requesting approval is still

in the global header and Things to Finish section.
3. After synchronization, because the task status is Completed and the task is no longer pending for the user,

here's what happens to the notification:

◦ It's removed from the list in the global header.

◦ It's no longer a card in the Things to Finish section.

◦ On the Notifications page, it moves from the Assigned to Me tab to the All tab.

How do I set up a notification when a user requests more
information?  
A notification is an alert for users, such as salespeople and managers, to notify them about an event on a business
object. For example, when a contract approval ends in error, you can specify who should receive the notification to
enable them to take necessary actions. The recipient of the notification could be the workflow initiator, approver,
assignee, and so on.

An action or event might be a request for more information about the contract by one of the approvers. You can set up
your approval flow to do this by selecting the Assignees settings for the recipient of the task in the BPM Worklist. Here
are the steps to set up the notification alert to ensure that a user receives a bell notification when contract approver
selects Request More Information.

1. Sign in as a setup user.
2. Navigate to the Setup and Maintenance work area.
3. Search and select the Manage Task Configurations for Customer Relationship Management task.

The BPM Worklist page appears.
4. In the tasks to be configured region, select ContractsApproval.
5. In the Search box, search for the ContractsApproval task you're using for the object workflow.
6. Click the Edit task pencil icon from the toolbar, then click the Notifications tab.
7. Click the + (plus) icon.
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8. From the Task Status drop-down, select Request Info.

Available options are Assign, Complete, Error, Expire, Request Info, Update Outcome, Suspend, Withdrawn,
Resume, Update, Alerted and All other Actions.

9. Then select who will receive the notification by selecting Assignees from the list of values of the Recipients
column.

10. Click the Save icon and optionally enter comments.
11. Click the Commit task icon and optionally enter comments.
12. Test your workflow to verify your changes.

Why am I receiving notifications for contracts that have
expired?  
From the Manage Contract Types page you can choose to send notifications before contract expiration. If the setup is
performed, the contact role to be notified will receive a notification when the Send Contract Expiration Notifications
scheduled process is run and the condition is satisfied.
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You can choose to deselect the Notify before expiration check box for a specific contract from the Edit Contract Type
UI as shown:

What privileges do I need to run Contract Terms
Deliverable Notification processes?  
Contract deliverables establish and track both contractual and noncontractual commitments that must be honored as
part of negotiations and contractual agreements between businesses and suppliers or customers based on contract
intent.

You can send automatic notifications:

• Before the due date of the deliverable

• When one of the parties changes the status of the deliverable

• When a deliverable is overdue

• When a deliverable must be escalated after the due date

430



Oracle Fusion Cloud Sales Automation
Sales Questions and Answers

Chapter 1
Sales Questions and Answers

For notifications to appear, the following processes must be running:

• Send Contract Terms Deliverable Due Date Notifications

• Send Contract Terms Deliverable Escalation Notifications

• Send Contract Terms Deliverable Overdue Notifications

Note:  You must have the OKC_DELIVERABLE_NOTIFICATIONS_PROCESS_PRIV (Send Contract Fulfillment
Notification) privilege to run these processes.

You must also have the required roles to run the schedules processes. Use the Scheduled Processes work area to
run all the processes you've access to and to manage submissions. If you need access to this work area, ask your
security administrator to assign you a role that gives you access, for example a custom role with the Manage Scheduled
Processes (FND_MANAGE_SCHEDULED_PROCESSES_PRIV) privilege.

Note:  Oracle recommends that security administrators don't assign the required privileges to predefined roles
directly to users. Instead, make a copy of a predefined role, remove the privileges that your users don't need, and
assign users the role that contains only the privileges they need.

How do I automate creating resources from users with
HCM jobs assigned to them?  
You can automate the process of converting employee users you created in HCM into Oracle Sales and Service
resources. You automate the process by mapping the HCM jobs to resource roles and enable the automation by setting
a profile option. The resource roles get automatically assigned to users based on the mapping. Provisioning rules you've
set up can then provision the required job roles and the resource abstract role.

The resource role to job mapping simplifies the task of assigning resource roles to new employees or contingent
workers, resulting in time and cost efficiency. It works regardless if the employees are created in the UI or through
import management.

For example, an employee joins the Sales department with the sales representative job and the employee's job is
already mapped to the Salesperson resource role. In this case, the employee is automatically converted to a resource
and is assigned the mapped resource role. Thus, you can place new employees faster in organizational and reporting
hierarchies.

Here's how to enable the automatic process and how to map HCM jobs to resource roles:

1. Set the Automated Resource Creation Enabled (HZ_AUTOMATE_RESOURCE_CREATION) profile option to Yes.
a. In the Setup and Maintenance work area, go to the following:

- Offering: Sales
- Functional Area: Sales Foundation
- Task: Manage Administrator Profile Values

b. Use the Profile Option Code field to search for HZ_AUTOMATE_RESOURCE_CREATION and set the value
to Yes.

2. Map the HCM jobs to their roles.
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a. In the Setup and Maintenance work area, open the Manage Resource Roles task:

- Offering: Customer Data Management
- Functional Area: Resources
- Task: Manage Resource Roles

b. You can create a role with the required details by clicking Actions >  Create or edit an existing role by
clicking Actions >  Edit.

c. Scroll down to Job Mapping and click Actions >  Add Row.
d. Search for and map the HCM jobs.
e. Click Save and Close.

How can I display a country?  
If your business is operating in any country, you may want to enable it.

You may want to display a country from appearing in the list of countries, for example, while updating the address of a
contact. This can be done in Manage Territories.

1. Click Navigator > My Enterprise > Setup and Maintenance work area.
2. Click the Tasks menu and click Search. Search for Manage Territories and open it.
3. Search the country you want to display using its Territory Code or Territory Name.
4. Select the Enabled column.
5. Click Save and Close.

Why is there a Target Release field in the initiatives?  
The target release date is the market release date, that's the date on which the content of the initiative must be made
available. This is an optional field for now.

When a sales VP or another manager leaves, how do
I make territories and quotas reflect the new resource
hierarchy?  
If salespeople in your organization own and forecast their own opportunities (forecast by opportunity owner), then you
can easily make the territory structure and quotas reflect changes at the top of the resource hierarchy by running a
couple of scheduled processes.

You run the two processes from the Scheduled Process work area in the following order:

1. To update the territory hierarchy with the resource hierarchy changes, run the scheduled process Refresh
Territories from Resources. No parameters are required.
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2. To make the quota plan reflect the changes, run the Synchronize Quotas process after the Refresh Territories
from Resources process has completed. Select the sales quota plan you want to update as a parameter.

Steps to Run the Processes
1. Click Navigator > Tools > Scheduled Processes.
2. Click Schedule New Process.
3. For Type, select the Job option.
4. In the Name field list, click Search.
5. Search for each process by name.
6. Select the process and click OK.
7. When running the Synchronized Quotas process, in the Parameters region of the Process Details page, select

the sales quota plan.
8. Click Submit.

Related Topics
• What do I do when I get an error when running the Refresh Territories from Resources process?

Why are we getting the ORA-01795 error in BI Publisher? 

The error indicates that there are too many values defined in the SQL filter for a given expression.

The option to pass more than one value to BIP SQL via bind parameters makes reports very flexible and versatile.
However, BI Publisher doesn't limit the number of passed values, and it could generate a SQL with very large number of
IN-LIST values, possibly hitting the internal Oracle limit of maximum 1,000 IN-LIST values.

Please review the recommendations in this support document and adjust your query accordingly: Oracle Business
Intelligence Publisher Performance Recommendations for Fusion Cloud Applications.

What's the name of the audit table for the Opportunity
sales object?  
The audit table name for the opportunity summary page is MOO_OPTY_. The audit table name for the opportunity revenue
page is MOO_REVN_. Note the pattern <table name> + '_'.

All tables ending with the underscore are audit tables. See the Tables and Views for Sales and Fusion Service guide for
more information.
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How can I prevent users from deleting opportunities?  
Smart actions make frequently used tasks, such as creating, editing, or deleting records, easily accessible because
they're always available from the same place on a page, such as from the Workspace list page or in the Action Bar.

You can use the Smart Actions page in Application Composer to enable or disable actions. Or, you can allow or restrict
access to specific actions through privileges that are granted for different roles. For example, the delete action for
opportunities has the privilege MOO_DELETE_OPPORTUNITY_PRIV associated with it. If a user doesn't have this
privilege, or if the privilege is revoked for the necessary role, then the delete smart action wont be available to that user.

What's LDAP authentication?  
Lightweight Directory Access Protocol (LDAP) is an internet protocol used to access information directories. It lets users
access centrally stored information over a network. There are several process that are run by your security administrator
to authenticate and manage the entries and attributes in a directory.

For example, run the Retrieve Latest LDAP Changes scheduled process once during implementation. This process
copies data from the LDAP directory to the Oracle Fusion Applications Security tables. Thereafter, the data is
synchronized automatically.

The Send Pending LDAP Requests process sends bulk requests and future-dated requests that are active to your LDAP
directory. It's recommended that you schedule the Send Pending LDAP Requests process to run daily.

See the Why You Run the Send Pending LDAP Requests Process and the Synchronize Your Sales Application with the
LDAP Directory from the Securing Applications guide for more information.

What are the best practices for managing Geography
mismatches?  
This topic employs a couple of use cases to illustrate the best practices for setting up Master Reference Geographies
for sales customers using the Oracle Account and Contact Enrichment by Dun & Bradstreet (D&B) for Sales for data
enrichment and the Oracle Address, Email, and Phone Verification for address, email, and phone number verification.

When you perform the real-time enrichment of accounts or contacts using the Oracle Account and Contact Enrichment
by Dun & Bradstreet (D&B), if there's a geography data mismatch between the predefined master geography data
and the Dun and Bradstreet (D&B) data, then the Service enriches the accounts and contacts data but you can't edit
or save the enriched data unless the master geography data mismatches are resolved. In addition, you can verify the
enriched address using the Oracle Address, Email, and Phone Verification, however, in case of mismatches between
Oracle Account and Contact Enrichment by Dun & Bradstreet (D&B) (Loqate) and predefined master geography data
you can't save the verified address.

The second use case describes the setup required to enable address verification and to avoid data conflicts between the
Oracle Address, Email, and Phone Verification and master reference geography data.
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Use Case 1
You're a sales customer using master reference geographies for territory assignments or tax calculation and have
purchased Oracle Account and Contact Enrichment by Dun & Bradstreet (D&B) for data enrichment and Oracle
Address, Email, and Phone Verification. In this case, while the Loqate geography reference data is configured as master
geography, Tax calculation is being done using Vertex master geography data. Also, address validation is enabled based
on the customer's requirement.

Best Practice: Review geography mapping for the countries where you do business. If the geography mapping for
a specific country isn't mapped according to the country-specific address attributes, update the mapping. Oracle
recommends performing enrichment before verifying address.

Suppose that you're doing real time enrichment of account or contact. If there's a geography data mismatch between
the predefined master geography and the D&B data, the Oracle Account and Contact Enrichment by Dun & Bradstreet
(D&B) still enriches the accounts and contacts data but can't edit or save the enriched account or contact unless the
master geography data mismatches are resolved. However, you can verify the enriched address using the Oracle
Address, Email, and Phone Verification.

To save a verified address that has master geography data mismatch, you must add alternative names for the
mismatched hierarchy elements in master geography. The following are the steps to add alternative name for the
mismatched hierarchy element:

1. In the Setup and Maintenance work area, go to the following:

◦ Offering: Customer Data Management

◦ Functional Area: Enterprise Profile

◦ Task: Manage Geographies

2. On the Manage Geographies page, search for the country by the name or country code, for example US.
3. Click the Go to Task button in the Hierarchy Defined column. The Manage Geographies Hierarchy page for the

particular country appears.

Note:  If there are many child geographies for the selected parent geography, a message asking you to
refine the search criteria is displayed. The child geographies are displayed after you refine the search
criteria. If there are many search results, you may have to further refine the search criteria. The maximum
number of child geographies that can be displayed is controlled by the ORA_HZ_GEO_HIERARCHY_LIMIT
profile option. You can change the value of this profile option by navigating to the Setup and Maintenance
work area, click the Tasks menu, and search for Manage Administrative Profile Values task. Search for the
ORA_HZ_GEO_HIERARCHY_LIMIT profile option and change the value.

4. Highlight the mismatched hierarchy element, for example California State, and click the Edit icon.
5. Click the Add icon on the Edit page.
6. Add an alternative name CA for the California state geography element.
7. Click Save and Close

Once the alternative name is added for the mismatched hierarchy element in master geography, you can save the
enriched address.

Use Case 2
You're a sales customer who doesn't use geographies for territory assignment or tax calculation and has purchased
Oracle Account and Contact Enrichment by Dun & Bradstreet (D&B) for data enrichment and the Oracle Address, Email,
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and Phone Verification for address verification. To enable address verification and to avoid data conflicts between the
Oracle Address, Email, and Phone Verification and master reference geography data you must do the following setups:

• Deselect the Geography Validation option in the Geography Mapping and Validation region to avoid Oracle
Address, Email, and Phone Verification data conflicts with master reference geography data. By deselecting this
option you can avoid any UI level validation against master geographies while adding address.

• Select Geography Validation Level for Country as No validation to verify address data by Oracle Address, Email,
and Phone Verification.

Perform the following steps on the Manage Geography Validation page to enable address verification and to avoid data
conflicts between the Oracle Address, Email, and Phone Verification and master reference geography data:

1. In the Setup and Maintenance work area, go to the following:

◦ Offering: Customer Data Management

◦ Functional Area: Enterprise Profile

◦ Task: Manage Geographies

2. On the Manage Geographies page, search for the country by the name or country code, for example US.
3. Click the Go to Task button in the Validation Defined column. The Manage Geography Validation page appears.
4. Deselect the Geography Validation check boxes for all the geography attributes to avoid any UI level validation

against master geographies while entering the addresses. If the Enable List of Values check boxes are selected
then, in case of data conflicts, Geography Naming References records aren't created.

Note:  If any of the Geography Types listed isn't applicable to the selected country's territory structure, then you must
deselect the geography validation for that type.

If you're planning to create territories based on a particular Geography Type, such as County, then you must deselect all
the Geography Validation levels under that Geography Type (in this case City and Postal Code) based on which you want
to create the territory.

Tip:  Review the Address Style Formats that are selected on the Manage Geography Validation page. The review is
required because on the Account or Contact Simplified UI page, address attributes are displayed based on the address
formats and verified or enriched addresses are saved in Oracle Applications Cloud based on the selected address
formats.

Related Topics
•

How do I import plan component performance measure
data?  
You can use Import Management to create and update Plan Component Performance Measure records.

To import Plan Component Performance Measure records, perform the following tasks:

1. Map your source data to Oracle Applications Cloud object attributes.
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2. Create source Comma Separated Values (CSV) file for import.
3. Create the import activity.
4. Review the import results.

How You Map Your Source Data to Target Object Attributes
To import your Plan Component Performance Measure data into Oracle Applications Cloud, you need to populate a CSV
file with your source data and map that source data to target object attributes in Oracle Applications Cloud.

You must do the following before creating the CSV file for data import:

• Identify how your source data attributes map to the target object attributes in Oracle Applications Cloud.

• Ensure prerequisite steps are complete, if applicable.

• Understand your options for uniquely identifying the records.

• Ensure parent records exist before importing child records.

• Identify the target object attributes that are required in the CSV file for a successful import.

Before You Start
You must do some basic checks before starting your import. For example, make sure that:

• You have completed all the prerequisites for importing each attribute in your source data.

• You have all parent records in place before importing child records.

Required Attributes and Validations for the Plan Component Performance
Measure Object
To import data successfully into Oracle Applications Cloud, your CSV file must include the required attributes. Ensure
that you provide valid values for the attributes.

This table lists the required attributes for creating and updating Plan Component Incentive Formula records,
prerequisite setup tasks for the attributes, and specific validations, if any, for Plan Component Incentive Formula records
import:

Attribute Description Prerequisite Setup Task/
Import Validations

Creating a Plan
Component Performance
Measure Record

Updating a Plan
Component Performance
Measure Record

PlanComponentPerformanceMeasureId
 

The unique identifier
generated internally
that associates a plan
component with a
compensation plan.
 

None
 

Not Required
 

Required
 

PerformanceMeasureId
 

The unique identifier for a
compensation plan.
 

Must be the identifier for
an existing compensation
plan.
 

Required
 

Required
 

PlanComponentId
 

The unique identifier of a
plan component.

Must be the identifier for an
existing plan component.

Required
 

Required
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Attribute Description Prerequisite Setup Task/
Import Validations

Creating a Plan
Component Performance
Measure Record

Updating a Plan
Component Performance
Measure Record

  

CalculationSequence
 

Indicates the order in which
the calculation engine
considers a performance
measure within a plan
component.
 

Must be a number. The
default value is 1.
 

Not Required
 

Not Required
 

PerformanceMeasureWeight
 

The percentage of
influence a plan component
has on the compensation
plan.
 

Must be a number. The
default value is 100.

Not Required
 

Not Required
 

EarningBasis
 

Specifies whether
attainment and earnings
calculations use the same
credit categories and
whether the incentive
formula uses the measure
attainment in calculations.
 

Possible values include Y, N.
The default value is Y.
 

Not Required
 

Not Required
 

You can view the Plan Component Performance Measure object and its attributes in the Manage Import Objects page of
the Import Management flow. You can find attribute information like type, length, description, and so on, on this page.

Create the Source CSV File
You include the data that you want to import into Sales and Fusion Service in a source CSV file.

You can use the templates available in the Import Objects UI page to create the source CSV file. To download a template:

1. Go to Navigator  > Tools >  Import Management >  Import Objects.
2. Select the Plan Component Performance Measure object in the table and click Download.

You can now edit the downloaded file and provide valid values for the required attributes.

Note:  For help in populating the CSV file and to avoid any issues in entering values, see the topic Potential Issues
When Opening CSV Files With Excel in Related Topics section.

Create the Import Activity
After you have the CSV file ready, create an import activity to import the information. To create an import activity:

1. Go to Navigator  > Tools >  Import Management >  Import Queue.
2. Click Create Import Activity in the Manage Imports page.
3. In the Enter Import Options page, provide a name for the import activity, and select Compensation Plan

Component from the Object drop-down list.
4. Select the CSV file in the File Name field, and click Next.
5. You would see that the source and target attributes are automatically mapped in the Map Fields page. Review

and edit the mappings if required.
6. Check the file for unmapped columns or data format issues by clicking Validate Data. Click Next.
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7. Review the import details on the Review and Submit page, and click Submit when you're ready.

Review the Import Results
Check if your import succeeded on the Manage Imports page. This page shows the status of all active, completed, and
unsuccessful imports. To check the status of the import activity:

1. Go to Navigator  > Tools >  Import Management >  Import Queue.
2. Click All Imports and search for the import activity that you created earlier.
3. Check the Status column for the import activity. The import is successful if the status displays as Completed.

You can drill down on the import activity to go to the Import Status page which provides the status details of
the import activity.

Related Topics
• How do I import data?

• Potential Issues When Opening CSV Files in Excel

• How You Use Alternate Keys to Import Records

Can I create a user role to run all scheduled processes?  
You may have a set of scheduled processes that must be run often in your application. You may want to consolidate all
privileges that are required to run that set of scheduled processes into one role.

Here are some pointers to do this:

• To access the Scheduled Processes work area, you require the Manage Scheduled Processes
(FND_MANAGE_SCHEDULED_PROCESSES_PRIV) privilege.

• List all the roles and privileges that each scheduled process requires. For example, Schedule Custom Groovy
Object Functions scheduled process requires the following roles and privileges:

◦ Customer Relationship Management Application Administrator

◦ Application Implementation Consultant

◦ Master Data Management Application Administrator

◦ ZCX_MANAGE_EXTENSIBLE_OBJECT_PRIV

• You can ask your security administrator to assign a custom role with these privileges.

• Also note that if a user is inactive, for example because they left the company, the processes they submitted on
a recurring schedule won't run. For security reasons, it's best that you cancel that submission and schedule a
new one if still needed. The same situation applies to users who are locked or failed to authenticate.
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Can I rename my assigned saved searches in Workspace?
 
No. You can only rename your own personal saved searches. You can't rename other saved searches, such as those
created or assigned by an administrator. While each business object has its own list of default saved searches, you can
choose a saved search as your personal default and can change the name to suit your requirements from the My List
tab on the Manage Saved Searches page.

Note:  Only administrators can assign saved searches to different roles and assign default saved searches to different
user roles.

The following screenshot shows an example of the Manage Saved Searches window as seen by users. The associated
table describes the columns highlighted in the screenshot by callouts.

Callout Number Column Name Description

1
 

My Default Saved Search for Workspace
 

This is your personal default saved search. You
can keep the default saved search assigned by
the administrator, or change the saved search
to a different one contained in the drop-down
list.
 

2
 

Manage List
 

The business object containing the saved
searches you're managing. For example, by
selecting Accounts for Manage List, saved
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Callout Number Column Name Description

searches based on the Account business object
are displayed. You can quickly switch between
saved searches across objects. Once a new
object is selected, saved searches related to
that object are immediately displayed.
 

3
 

Show in List
 

The saved search appears in the list of saved
searches only when this option is selected.
While you can't delete lists provided by Oracle,
 you can hide them by deselecting the Show in
List option.
 

4
 

Default
 

Each salesperson can specify one saved search
for each object as their personal default.
You see the results of your personal default
saved search when you open work areas
powered by Adaptive Saved search, including
those in CX Sales Mobile in the Redwood
User Experience. The personal default saved
searches don’t apply to the Workspace work
area, as Workspace always opens to the default
saved search you select in the My Default Saved
Search for Workspace field.
 

5
 

Name
 

You can rename your own personal saved
searches here. However you can't rename
other saved searches, such as those created or
assigned by an administrator.
 

6
 

Shared With
 

You can view but can't change the values here.
 

7
 

Delete
 

You can only delete your own personal saved
searches. You can't delete saved searched
provided by Oracle or an administrator.
 

How do I add a value to a new lookup I created on the
Manage Standard Lookups page?  
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To add a value to a new lookup, make sure to add the value in the Tag column. For example, you created a new lookup
Activity Type, and you created a start date for the lookup. If you need this value to show up in Tasks, for example, add a
value such as :TASK:

If you need the value to show up in tasks and appointments, add a value such as :TASK:APPOINTMENT:

How do I change the record set values in Sales?  
You can change the values that appear in the Record Set field list. Each record set value restricts a search to a subset of
records.

If a value doesn't apply to your implementation, for example, you can remove the value from the list by entering an end-
date. If you don't use sales teams or sales territories, you can remove all the values that restrict the search by sales team
or by territory.

Change Record Set Lookup Values
1. Navigate to the Setup and Maintenance work area, and use the following:

◦ Offering: Sales

◦ Functional Area: Sales Foundation

◦ Task: Manage Standard Lookups

2. In the Meaning field, enter %Record Set%.
3. Click Search.

The page displays a list of the lookup types for search filter record sets for the different sales objects.
Here's a screenshot of the Manage Standard Lookups page showing some of the search results.

4. Select the lookup type you want to change in the search results.
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5. You can edit the values in the Lookup Codes region. You must scroll down.

Here's a screenshot of the Lookup Codes region of the Manage Standard Lookups page for the Lead Search
Filter Record Sets lookup type.

You can perform one or more of the following edits, depending on the lookup type:

◦ Change the wording the user sees in the list by editing the Meaning field.

Changing the meaning doesn't affect application functionality.

◦ Remove a value from use by entering an end date.

◦ Change the display sequence.

6. Click Save and Close.

What do I do to fix bell notification links so they open
Sales in the Redwood user experience pages?  
To open Redwood pages instead of the classic pages from notifications, users must
have the following privileges: ZBS_NOTIFICATION_DRILLDOWN_VBCS_PRIV and
SVC_MANAGE_OMNICHANNEL_PRESENCE_AND_AVAILABILITY_PRIV. These privileges are included in the sales
job roles provided by Oracle. If these privileges are missing from your custom job roles, then add them and run the
following processes.

After adding the missing privileges, run the following processes in the specified order. Ensure that each process
completes before launching another.

Run Order Process Name Description

1 Send Pending LDAP Requests Manages requests to create or update users,
 roles and role grants in LDAP.
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Run Order Process Name Description

2 Send Personal Data for Multiple Users to LDAP Syncs personal information with LDAP. You
can sync all users or only those users whose
information has been changed

3 Retrieve Latest LDAP Changes Syncs users, roles, and role grants with
definitions in LDAP.

4 Synchronize User GUID Resolves invalid and missing user global unique
identifiers by synchronizing them.

5 Import User and Role Application Security Data Imports user and role data from LDAP to
security application tables.

Can a report show opportunity revenue in both
corporate and transaction currencies?  
Yes, Business Intelligence (BI and OTBI) reports can display opportunity revenue totals in both the transaction currency
and the corporate currency.

For details, see the document you can download from the support article User Preferred Currency Usages in Business
Intelligence (BI) (1633382.1).

How do I specify the sales order numbering for orders
created against service requests?  
You can control how sequence numbers are generated for sales orders created from service requests by setting the
profile option, Retain Sales Order Number for Orchestration Order Number (DOO_RT_USE_ORDER_NUMBER).

If this profile option is set to Yes, then the sales order numbers are the same as the service request numbers. If this
profile option is set to No, then the sales order numbers are generated by Order Management.

How do I create or update Telephone Numbering Plans?  
You can create Telephone Numbering plans or update existing Telephone Numbering plans such as pattern of digits,
display formats, and so on.

You can update telephone number plans from the Manage Phone Numbering Plans page. You can't edit the country
information if the country has area codes, mobile prefixes, or phone formats defined.

To create or update telephone number plans:

1. In the Setup and Maintenance work area, go to the following:
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◦ Offering: Customer Data Management

◦ Functional Area: Trading Community Foundation

◦ Task: Manage Phone Numbering Plans

The Manage Phone Numbering Plans page opens.
2. Click Actions > Create to create. Else, search for the country whose telephone number plan you want to update.

For example, to search for the United States, select United States in the Country Code list or enter 1 in the
Phone Country Code field.

3. Select the country and click Edit to view the Edit Phone Numbering Plan page.
4. You can edit the following country-specific phone information in the Scheme section:

◦ Trunk Prefix: The code to dial before long distance numbers within the country, for example 1 for the US.

◦ International Prefix: The code to dial before international numbers when calling from the country that
you're setting up, for example 011 for the US.

◦ Subscriber Number Length: The length of the subscriber number for countries where the subscriber
length is fixed.

◦ Area Code Length: The length of the area code for countries where the area code length is fixed.

5. You can edit the following regional phone number information for the country in the Regional Information
section:

◦ Area Codes: Lets you define area codes that you want to use for the country.

◦ Mobile Prefixes: Lets you define mobile prefixes that you want to use for this country. Mobile prefixes
contain the area code and possible prefixes of the subscriber number. For example, the mobile prefix of
650506 consists of the 650 area code and the 506 subscriber number prefix.

◦ Telephone Number Formats: Lets you define multiple telephone number display formats for a country.

6. Click Save and Close to save your updates.

Related Topics
• Why can't I update the country information section in the Edit Telephone Numbering page?

How can I import additional PIM attributes into Sales
products?  
While you can't import additional attributes, including descriptive flexfields (DFFs), using the standard scheduled
process Import Sales Products From PIM Data Hub, you can create custom fields in the Sales application and then use
Import Management to import the additional attributes into them.

For details, see the support document: How To Import Products In Oracle Sales Cloud Application (2233490.1).
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How do I delete a saved search I created?  
You can delete saved searches you and other administrators created. Your action deletes the saved search for every role
where it's shared. You can't delete saved searches provided by Oracle, but you can hide them.

1. Navigate to the work area.
2. Click the search field and select  Manage Saved Searches.
3. From the Visible To list, select Me to see the saved search lists that you shared with everyone and those you

haven’t shared yet.

If you shared the list with a specific job role, and that job role isn’t assigned to you, then you must select that job
role from the list to see the saved search you want to delete.

4. Click Actions (the three dots in the Actions column) and select Delete.
5. Click Save.

How can I set the Close Date field to be blank when I
create an opportunity?  
The Opportunity Close Date Default (MOO_DEFAULT_CLOSE_WINDOW) profile option determines the number of
days to add to the current date when calculating the default opportunity close date. By default, your sales application
automatically sets the Close Date to 20 days after today's date when you create an Opportunity.

If the default value of 20 days doesn't suit your business requirements, you can edit the Opportunity Close Date Default
profile option to change the close date value. For example, you might want the Close Date field to always be blank when
you create an opportunity. Here are the steps to change profile option.

1. In the Setup and Maintenance work area, go to:

◦ Offering: Sales

◦ Functional Area: Sales Foundation

◦ Task: Manage Administrator Profile Values

2. From the search region of the Manage Administrator Profile Values page, enter the profile option code name
(MOO_DEFAULT_CLOSE_WINDOW in the Profile Option Code field.

3. Click Search.
4. In the Profile Value  field of the Opportunity Close Date Default profile, remove the default value of 20 and

leave blank.
5. Click Save and Close.

When you next create an Opportunity, the Close Date field will now be blank.
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How do I default a filter in a dashboard I embedded in
the Analysis subtab of a Sales record?  
You can make a report viewed in a record automatically display information about that record by adding the is
prompted operator to the appropriate filters in your report.

1. Open the report in BI.
2. In the report Criteria subtab, click the Filter icon for the appropriate column. For Operator, select is prompted.

Leave the other options blank.
3. Click OK.

For a complete description of how to create and embed a report in the Analysis subtab, see the topic: How do I embed a
BIP report in the Analytics subtab in a Sales record?.

Why can't I enable fields for the number of leads,
opportunities, and activities for contacts in Adaptive
Search?  
You can't enable fields that show totals for Adaptive Search because Oracle is replacing the classic aggregate fields with
Rollups. With Update 24B, all classic aggregate fields will be deprecated and no longer supported. Aggregate fields,
including NumberOfOpenLeads and NumberOfOpenOpportunities for contacts, are now disabled in the Adaptive
Search setup page. To achieve the same search functionality, you can enable the equivalent rollup fields instead.

Here's an overview of the setup:

1. Open the Define Rollups work area from Application Composer outside the sandbox.
2. Search for the rollup equivalent to the aggregate field you want to enable. For example, for

NumberOfOpenLeads, search for Number of Open Leads.
3. Drill into the rollup and publish it (Actions > Publish).
4. Enable the rollup field for Adaptive Search and publish.

For setup details and information on what you need to do to transition from aggregate fields to rollups, please see the
support document Move from Classic Aggregates to Rollups (2977196.1).

How can I notify the new task owner by email when the
task is assigned to them?  
Create a routine to notify the new task owner by email. Here's how.

1. Open Application Composer outside a sandbox (Navigator > Configuration >  Application Composer).
2. Click Routines.
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3. Click Create Routine.
4. Click Skip Templates.
5. In the Basic Details step, enter a name and description. For example: Email Notification for New Task Owner.
6. Select the Object, in this case Activity.
7. Click Next.
8. In the Trigger step, select Attribute Changed and then select Owner ID from the list of attributes. You're

sending the email after the owner is updated in the record.
9. Click Next.

10. In the Actions step, select Send Email  as the Action Type.
11. In the To field, select Owner ID.
12. In the Subject and Body fields, you can enter both text and mail-merge attributes.

For example, to include the task name in the Subject line of the email:

a. Use the Attributes search box to search for Subject. This is the subject of the task.
b. Select Subject and press Return.

Your action enters the mail-merge field {{$Subject}}.

Note:  The email sent to the new owner gets automatically appended with a link to open the task.

13. Click Next.
14. In the Rules step, you specify Task as the activity that will send the notification:

a. In the Activity list, select Include all groups.
b. Make these entries for the rule:

Field Entry

Attribute Activity

Operator Equals

Value Task

15. Click Next.
16. On the Review page, review your entries and click Submit.

How do I embed a BIP report in the Analytics subtab in a
Sales record?  
Here's how you can embed a Business Intelligence Publisher (BIP) report in the Analytics tab on the edit pages of any
of the sales object records, including accounts, opportunities, and leads. You can use the same procedure on service
request and partner pages as well. The report shows information for each individual record. This procedure applies only
to pages in the classic user experience. It isn't applicable to Sales in the Redwood user experience.

Here's an overview of the setup:

1. In Business Intelligence, set the "Is Prompted" filter. This setting displays data specific to the record.
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2. Enable the subtab on the object page.
3. Add the report to the subtab on the object page.

The following steps use the Opportunities landing and edit pages as an example. You can use these same steps for
other sales and service objects, including service request, work order, and queue.

Set the "Is Prompted" Filter
To show data specific to the record, you enable the "Is Prompted" filter on the name or object ID for the report.

1. Open an existing report, or create a new report in BI.
2. In the report Criteria subtab, select the Filter icon for the appropriate column. Under Operator, select is

prompted. Leave the other options blank.
3. Click OK.

Enable Object Edit Page Analytics Subtabs
This procedure uses the Opportunity object landing page as an example. The procedure is the same for all object edit
pages.

1. In Navigator click Application Composer.
2. Select Sales from the Application drop-down list.
3. Expand Standard Objects  and go to Opportunity.
4. Under Opportunity click Pages.
5. Under Detail Page Layouts  copy the standard layout or select an existing created layout where the Analytics

subtab is added.
6. Click the Reorder subtab.

This shows the Configure subtab option for the edit object page.

7. Click OK.
8. Click Done. The Analytics subtab now shows on the Edit Opportunity page.

Add Analytics to Edit Object Subtabs
The final step is to add an analysis to the Edit Object subtab you've just enabled. When an analysis is added to the
object page, it shows data specific to the signed in user's transaction record. The specific data shows because of the
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"is prompted" filter being set in the analytic which passes parameters from the transaction record to the analytic. A
parameter is visible in the analytic when a filter prompt is added.

1. At the top of the Home Page click the arrow next to your name and select Edit Pages. The Edit Pages dialog
appears.

2. Select Job Role  and choose the role to which your change should apply. Any analytics you add in this context
apply only to the role you define here.

3. In Opportunities on the analytics subtab click  Add Content and navigate to the analysis you want to show on
the Opportunity page.

4. Click Add next to the analysis and close the dialog. The analysis is now added to the Analytics subtab.
5. Next step you want to either save the default parameters, or add parameters specific the object your are

working with.

Click Parameters.

This shows the Parameters button on the Edit Opportunity analytic.

6. The parameter used is pageFlowScope variable and is set by default for Opportunity, Leads, Partners,
Service Request and custom object pages. For example, in the case of Opportunity the parameter
is #pageFLowScope.biFilterName_OpportunityOpportunityId. In the case of Service Request it's
"#{pageFlowScope.biFilterName_ServiceRequestServiceRequestId}" . If for any reason the parameter field is
blank, insert the variable manually and save it.

This shows the parameter value of #pageFLowScope.biFilterName_OpportunityOpportunityId on an Edit
Opportunity ID analytic column ..#pageFLowScope.biFilterName_OpportunityOpportunityId on an Edit
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Opportunity ID analytic column.

7. For the objects that aren't prepopulated with the pageFlowScope parameters, you can use one of these
sessionScope variables depending on which object page you're on, and the columns available in the analytic.

◦ Customer ID: #{sessionScope.zcmAnalyticsCustomerId}

◦ Contact ID: #{sessionScope.hzAnalyticsContactPartyId}

◦ Contact Name: #{sessionScope.hzAnalyticsContactName}

◦ Lead ID: #{sessionScope.mklAnalyticsLeadId}

◦ Opportunity ID: #{sessionScope.mooAnalyticsOpportunityId}

◦ Partner ID:#{sessionScope.zpmAnalyticsPartnerId}

How do I enable account team members to edit
accounts?  
Only account team members with Full access can edit all account information. By default, only account owners have Full
access. Members of the territories on the account have only view access. Using access groups, you can automatically
grant the Full access to any set of users, including the team members added through territories, or you can grant access
to specific individuals.
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Create the Access Group to Enable Edit Access
In this example, you create an access group that enables users with the Sales Representative job role to edit all account
information when they're members of the account territory. If your use case is different, then you can use other criteria
to select users or add individuals and you can add multiple access permissions.

1. As a user with the security manager role, such as a setup user, open the Sales and Service Access Management
work area (Navigator > Tools > Sales and Service Access Management .

2. On the Access Groups tab, click Create.
3. In the Create Access Group page, enter a name and select Active.
4. Click Save and Continue.
5. Click the Object Rules tab.
6. On the Object Rules tab, Object field, select Equals as the operator and Account as the object.
7. Click Add Rule.
8. Select the predefined rule. For example, to add access to territory team members on the account, click Account

Territory Team.

Tip:  You can review a description of the access each rule provides by drilling into it.

9. Click Done.
10. Specify the Access Level. Select Full for edit access.
11. Click the Member Rules tab.
12. On the Member Rules tab, click Create Rule.
13. Enter a rule name, for example: Sales Reps.
14. In the Conditions section, click Add Rule (plus sign icon).
15. Make these entries to provide access to all users with the Sales Representative job role:

Field Entry

Object Resources

Attribute Roles (Roles)

Operator Equals

Value Sales Representative

16. Click Actions >  Save and Publish.
17. When the Published Status  shows Published, click Save and Close

Run Processes to Apply the Expanded Access
Run the Run Access Group Membership Rules and Perform Object Sharing Rule Assignment Processing processes
to apply the expanded access to accounts so you can test it. These two processes are run automatically on a schedule,
so you'll need to wait until they run if you don't run them.

1. Open the Scheduled Processes work area. (Navigator > Tools > Scheduled Processes).
2. Click Schedule New Process.
3. In the Schedule New Process window, with the Job option selected, click Search: Name (the down arrow

button).
4. Click the Search link at the end of the list.
5. Enter the name of the process: Run Access Group Membership Rules.
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6. Click Search.
7. Select the process and click OK.
8. In the Process Details window, Record Selection, select All Records or another value.
9. Click Submit.

10. Now search for and run the Perform Object Sharing Rule Assignment Processing process.
In the Process Details window for this process, select Account as the Object and All Records as the Record
Selection.

Can I see change history for Sales in the Redwood user
experience?  
In Sales in the Redwood user experience, salespeople can see the history of updates to key sales information on the
View All Activities page on each record (the activity stream). You can view the audit of all changes on the Change
History subtab of a record in the Classic user experience. The View All Activities page in the Redwood user experience is
designed with salespeople in mind. Sales in the Redwood user experience doesn't include a Change History subtab, but
all the changes in your Redwood application tracked by your audit setup are visible in the Classic UI Change History.

How can I create approvals for activities such as
appointments?  
You can create approvals for activities, opportunities, and other objects using object workflows to trigger business
process workflows. Using Oracle Business Process Manager (BPM) you can create different types of approval workflows,
including group approvals, parallel approvals, and multiple approvals on a single record. For details, see the topic Object
Workflows and Business Processes.

How do I set up Activities for Sales in the Redwood user
experience?  
Here's a summary of the set up steps to enable Activities for Sales in the Redwood user experience:

Step Description Navigation

1
 

You must create and activate an activities
configuration for each object you use in Digital
Sales. You create an activities configuration by
duplicating an existing one. Oracle provides a
predefined configuration for each object. If you
want to use the predefined configuration, just

Navigator > Configuration > Configure
Activities Display
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Step Description Navigation

copy it and activate it. If you want to change
what gets displayed in Activities for an object,
 you can edit your copy before activating it.
 

2 Set the profile option Set the Common CRM
Signals Active (ORA_ZCA_ENABLE_SIGNALS) to
No.

Setup and Maintenance  >  Sales > Sales
Foundation > Manage Administrator Profile
Values

3 Run the Publish Feed Elements process to
create the index required by Adaptive Search.
 
Don't select the Production to Test Enabled
check box. This check box is used for migrating
indexes from production to test instances.
 
You run this process only once.

Navigator > Tools > Scheduled Processes
 

4 Enable the natural English-language filtering
of activities. Using this feature, a salesperson
can enter "filter my tasks due tomorrow",
to view all tasks due by the end of the next
calendar day in their time zone where they're
listed as a resource. Like all natural-language
processing in Sales, this feature uses Oracle
Digital Assistant (ODA) to process the text.

Setup and Maintenance  >  Sales > Digital
Assistant > Manage Digital Assistant

5 Set the profile option Set the Common CRM
Signals Active (ORA_ZCA_ENABLE_SIGNALS) to
Y.

Setup and Maintenance  >  Sales > Sales
Foundation > Manage Administrator Profile
Values

Can a task template assign a task to a specific user?  
Yes. You can configure object workflows to trigger auto-creation and assignment of tasks.

For more information, see Create Tasks in the Configuring Applications Using Application Composer guide.

How can I send reminders to an activity owner until the
activity is completed?  
You can create and send email reminders to activity owners to complete tasks, appointments, and call reports by using
the Routines feature.

The Routines feature, available in Application Composer, makes it easy to ensure timely completion and keep your team
on track.

• Flexible scheduling:

Send reminders daily until tasks are done and set to the Complete status, or only when they're overdue.
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• Targeted notifications:

Choose to focus on specific objects (like opportunities) or send reminders for all tasks, even those without a
related object.

• Extensible templates:

Easily create reminders using the Past Due Tasks template as a starting point.

• Direct links to open the activity:

Reminders include convenient links for salespeople to directly access and complete their tasks.

Note:  Existing customers must enable both the Digital Sales Next Gen UI and Sales in the Redwood
UX features in Setup and Maintenance to enable notification links to open records in the Redwood user
experience. For details see the section Set the Notification Link to Open the Redwood UI.

Here's an example of how you'd set up a daily reminder to complete all tasks that aren't set to the status of Complete by
the date the routine is run:

1. Open Application Composer outside the sandbox. (Navigator Configuration  Application Composer)
2. Click the Routines icon.
3. In the routines list page, click the Create Routine button.
4. Click the Past Due Tasks  template.
5. In the Basic Details page enter a name and description for the routine. These aren't visible to the users you

notify.
6. The Object is Activity.
7. Click Next.
8. On the Trigger page, specify when this routine will be run. To send daily reminders, select Daily.
9. Click Next.

10. On the Actions page, make modifications to the Send Email action provided in the template. Here are some
sample values:

Field Entry

To Owner ID

Subject Reminder: Complete task {{$Subject}}with the due of {{$DueDate}}.

Body Please complete the task and update the status to complete or canceled.

11. Click Next.
12. On the Rules page, enter the rules. The template includes rules for tasks with a priority equal to 1, that are due

in the previous 7 days, and that are associated with an object. (The template ignores stand-alone tasks).

In this example, we're sending the email notifications to owners of all tasks that aren't set to the complete or
canceled status by the due date. We're including due dates on or before the date the routine is run.

a. Change the rules in the first group to the following:

Field Entry

Attribute Activity
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Field Entry

Operator Equals

Value Task

Field Entry

Attribute Due Date

Operator Until

Value Run Date

Operator <leave blank, or select plus or minus>

Value <leave blank, or enter number of days>

Field Entry

Attribute Status

Operator Not In

Value Complete, Canceled

b. You can delete the second group of rules from the template unless you want to restrict your notifications
to tasks with objects or add other rules.

13. Click Next.
14. Review routine and click Submit.
15. The routine is now active and appears in the list of routines.
16. From the Actions menu (three dots), you can run the routine immediately. From this menu, you can also take

other actions: you can pause, edit, and delete the routine, for example.

Set the Notification Link to Open the Redwood UI
Existing customers must enable both the Digital Sales Next Gen UI and Sales in the Redwood UX features in Setup
and Maintenance to open records in the Redwood user experience. New customers can skip this step as the feature is
enabled automatically.

1. Open the Setup and Maintenance work area. (Navigator > My Enterprise > Setup and Maintenance).
2. Make sure the Sales offering is selected.
3. Click the Actions button and select Change Feature Selection.
4. Make sure both Digital Sales Next Gen UI and the Sales in the Redwood UX features are enabled.
5. Click Done.
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Why don't my custom fields appear in the add-in?  
The Microsoft 365 Outlook add-in in the classic Sales user experience gets data from the Sales application through a
REST API call. If the custom fields you created aren't included in the REST service Include in Service Payload, your users
can't find those fields in the add-in.

To add the fields to the service payload, go to Application Composer in the sales application and open your custom field
record. Select the Include in Service Payload check box and save your changes.

Note:  Oracle recommends that you use the Redwood User Experience version of the Microsoft Outlook add in. To get
started, see Overview of Microsoft 365 for Redwood UX in the solution playbook, How do I implement Microsoft 365 for
Oracle Sales Redwood UX?.

Can I request an environment clone with only some of
the data?  
Environment clones and environment refreshes always follow standard processes.

For details, see the article on My Oracle Support, Oracle Applications Cloud Service Definition - Environment Refresh
(Doc ID 2015788.1).

How do you add additional match identifiers while
configuring match attributes for Duplicate Identification?
 
You can't add any additional match identifiers while configuring Match Attributes for Duplicate Identification.

Here is a work around to add any additional match identifiers while configuring Match Attributes for Duplicate
Identification. Navigate to Manage Enterprise Data Quality Matching Configurations setup option and copy or edit an
existing configuration.

In the Match Attributes section, perform the following steps:

1. Select a row to edit the mapping, and click the drop-down button for the selected row.
2. Select the relevant attribute from the list.
3. If the list doesn't display the attribute that you want for the mapping including published custom fields, then

click Search to search for the attribute. Select the relevant option and click OK.

Note:  To identify duplicates based on a custom field search the custom attribute in the Account attribute
drop-down and then map it to any available unused EDQ attribute.
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4. Select the relevant option and click OK.
5. Click Save.

Is it possible to create an Owner without having to create
a user with a license assigned?  
No, this is not possible. Owners must be resources, which means they must be created as users. To create users, a
license is required.

How can I expand the Addresses region by default?  
You can use the Page Composer settings to keep the Address region on the Contact page expanded.

Go to Page Composer and select Disclosed option on the Properties tab of the address component. This ensures that
the Address region on the Contact page remains expanded. This reduces the number of clicks to view the Address
region.

How do I import contact data?  
You can use the Import Management to create, update, or delete contact records.

You can import contact records using these steps:

1. Map your source contact data to Oracle Applications Cloud object attributes. This way the import process would
know where to insert each of the information bits.

2. Create the source CSV file with the contact data you want to import.
3. Kick off an import activity.
4. Check the import results to know if the import went well.

How You Map Your Source Data to Target Object Attributes
To import your contact data into Oracle Applications Cloud, you must populate a .csv file with your source data and map
that source data to target object attributes in Oracle Applications Cloud.

You must do the following before creating the .csv file for data import:

• Identify how your source data attributes map to the target object attributes in Oracle Applications Cloud.

• Ensure prerequisite steps are complete, such as understanding what attributes are required for importing your
objects.

• Understand your options for uniquely identifying the records.

• Ensure parent records exist before importing child records.

• Identify the target object attributes that are required in the .csv file for a successful import
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To better manage your contact information, the contact object has the following child objects:

• Address

• Classification

• Relationship

• Sales Team Member

Note:  You can't set an attribute value to NULL in optimized import (standard import with the option Enable High-
Volume Import selected). However, when updating a record, you can change an attribute value from NOT NULL to
NULL

If you want to import only a few records, then you can create a single CSV file for all contact attributes. However if you
want to import a large number of records, then you may decide to create multiple CSV files, one for each of the contact
child objects. Note that you must have imported the CSV file for contact object successfully before trying to import the
CSV files for the child objects. There are separate help topics describing how to import each of these child objects. For
more information, see the related topics section.

Before You Start
You must do some basic checks before starting your import. For example, make sure that:

• You have completed all the prerequisites for importing each attribute in your source data.

• You have all parent records in place before importing child records.

Select a Unique Identifier for Your Records
All records must be unique in the application. You can use one of these to identify records:

• Public unique identifiers: If you're creating records, then you can provide an easily understandable public
unique identifier. These are, usually, denoted with 'Number' and visible in the business object's UI. PUID
attributes are usually named <object> Number. If you're updating a record with a Number attribute, then use
the Number attribute to identify the record. For more information about public unique identifiers, see the topic
"How You Use Alternate Keys to Import Records" in Related Topics section.

• Source system and source system reference: Source system is an identifier for the external system, and source
system reference is a unique identifier within the external system. If you're importing new contacts or are
updating contacts that have source system reference data, then provide the source system and source system
reference values.

Required Attributes and Validations for the Contact Object
To import data successfully into Oracle Applications Cloud, your .csv file must include the required attributes. Ensure
that you provide valid values for the attributes.

This table lists the required attributes for contact records, prerequisite setup tasks and specific validations, if any:
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Attribute Description Prerequisite Setup
Task or Import
Validations

Creating a Contact
Record

Updating an Existing
Contact Record

Deleting an Existing
Contact Record

SourceSystem
 

The code representing
the source system for
the contact.
 

Identify the source
system or configure
source systems either
by using the Manage
Trading Community
Source System task,
 or by importing
the source system
information into
Oracle Applications
Cloud using the
Source System
Reference import
object.
 

Conditionally
Required For uniquely
identifying a contact
record, provide one of
the following reference
information:
 

• SourceSystem
and
SourceSystemReferenceValue

• PartyNumber

Conditionally
Required For uniquely
identifying a contact
record, provide one of
the following reference
information:
 

• SourceSystem
and
SourceSystemReferenceValue

• PartyNumber

Conditionally
Required For uniquely
identifying a contact
record, provide one of
the following reference
information:
 

• SourceSystem
and
SourceSystemReferenceValue

• PartyNumber

SourceSystemReferenceValue
 

The reference number
or text representing
the source system
unique ID for the
contact.
 

Identify the source
system or configure
source systems either
by using the Manage
Trading Community
Source System task,
 or by importing
the source system
information into
Oracle Applications
Cloud using the
Source System
Reference import
object.
 

Conditionally
Required For uniquely
identifying a contact
record, provide one of
the following reference
information:
 

• SourceSystem
and
SourceSystemReferenceValue

• PartyNumber

Conditionally
Required For uniquely
identifying a contact
record, provide one of
the following reference
information:
 

• SourceSystem
and
SourceSystemReferenceValue

• PartyNumber

Conditionally
Required For uniquely
identifying a contact
record, provide one of
the following reference
information:
 

• SourceSystem
and
SourceSystemReferenceValue

• PartyNumber

PartyNumber
 

The public unique
identifier of the
contact.
 

No prerequisite tasks
 

Conditionally Required
 

Conditionally Required
 

Conditionally Required
 

FirstName
 

First name of a person
party.
 

No prerequisite tasks
 

Required
 

Not required
 

Not required
 

LastName
 

Last name of a person
party.
 

No prerequisite tasks
 

Required
 

Not required
 

Not required
 

Note:  For the Time Zone import attribute, specify the time zone of the contact to know the preferred time to call or
send e-mail to the contact.

You can use the profile option ORA_HZ_IMPORT_MULTI_ADDRESS_TYPE to control how address types are entered. By
default this profile option is set to Yes, so you can enter multiple address types, during high-volume import of Account,
Contact, and Household objects . You can disable this profile option to improve the import performance. When you set
this profile option to No, you can enter only a single address type.

Go to Navigator  > Tools >  Import Management >  Import Objects, to see all the attributes of the contact object. The
page also lists attribute information like type, length, description, and so on.
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Create the Source CSV File
You include the data that you want to import into CX Sales and Fusion Service in a source CSV file.

You can use the templates available in the Import Objects UI page to create the source CSV file. To download a template:

1. Go to Navigator  > Tools >  Import Management >  Import Objects.
2. Select the Contact object in the table and click Download.

You can now edit the downloaded file and provide valid values for the required attributes.

Providing the ZIP and Country Code values in the import CSV file won't automatically populate the State/County/City
fields. Values for these fields should be separately provided in the import file.

Note:  For help in populating the CSV file and to avoid any issues in entering values, see the topic Potential Issues
When Opening CSV Files With Excel in Related Topics section.

Create the Import Activity
After you have the CSV file ready, create an import activity to import the contact information. To create an import
activity:

1. Go to Navigator  > Tools >  Import Management >  Import Queue.
2. Click Create Import Activity in the Manage Imports page.
3. In the Enter Import Options page, provide a name for the import activity, and select Contact from the Object

drop-down list.
4. Select the CSV file in the File Name field, and click Next.
5. You would see that the source and target attributes are automatically mapped in the Map Fields page. Review

and edit the mappings if required.
6. Check the file for unmapped columns or data format issues by clicking Validate Data. Click Next.
7. Review the import details on the Review and Submit page, and click Submit when you're ready.

Review the Import Results
Check if your import succeeded on the Manage Imports page. This page shows the status of all active, completed, and
unsuccessful imports. To check the status of the import activity:

1. Go to Navigator  > Tools >  Import Management >  Import Queue.
2. Click All Imports and search for the import activity that you created earlier.
3. Check the Status column for the import activity. The import is successful if the status displays as Completed.

You can drill down on the import activity to go to the Import Status page which provides the status details of
the import activity.

Note:  After importing your data successfully, you need to run a couple of post processing jobs for duplicate
identification, duplicate resolution, and account assignment. For more information on import management post
processing jobs, see the topic: Import Management Post Processing for Accounts and Contacts.

Related Topics
• Potential Issues When Opening CSV Files in Excel

• How You Use Alternate Keys to Import Records
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How do I import person data?  
You can use import management to create or update Person data.

You can import Person records using these steps:

1. Map your source data to Oracle Applications Cloud object attributes. This way the import process would know
where to insert each of the information bits.

2. Create the source CSV file with the Person data you want to import.
3. Kick off an import activity.
4. Check the import results to know if the import went well.

How You Map Your Source Data to Target Object Attributes
You import Person data into Oracle Applications Cloud from a CSV file containing your source data that's mapped to
target Oracle Applications Cloud object attributes.

Before you create the source data file, you should:

• Know how your source data attributes map to the target object attributes in Oracle Applications Cloud. Match
each column from the source file to an attribute in the Person import object.

• Finish all prerequisite steps, such as understanding what attributes are required for importing your objects.

• Know how you can uniquely identify the records.

• Check the target object attributes required in the CSV file for a successful import.

• Ensure that you don't insert duplicate Person while importing, to avoid redundant data.

Before You Start
You must do some basic checks before starting your import. For example, make sure that:

• You have completed all the prerequisites for importing each attribute in your source data.

• You have all parent records in place before importing child records.

Select a Unique Identifier for Your Records
All records must be unique in the application. You can use one of these to identify records:

• Public unique identifiers: You can pass the PUID when creating Person records. If the PUID isn't passed, it
will be auto generated. You can optionally provide the PUID when creating Person records. If you're updating
records, then you can provide an easily understandable public unique identifier. These are, usually, denoted
with 'Number' and visible in the business object's UI. PUID attributes are usually named <object> Number. If
you're updating a record with a Number attribute, then use the Number attribute to identify the record. For
more information about public unique identifiers, see the topic "How You Use Alternate Keys to Import Records"
in Related Topics section.

• Source system and source system reference: Source system is an identifier for the external system, and source
system reference is a unique identifier within the external system. If you're importing new Persons or are
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updating Persons that have source system reference data, then provide the source system and source system
reference values.

Required Attributes and Validations for Person Object
To import data successfully into Oracle Applications Cloud, your .CSV file must include the required attributes. Ensure
that you provide valid values for the attributes.

This table lists the required attributes for Person records, prerequisite setup tasks and specific validations, if any:

Attribute Description Prerequisite Setup Task/
Import Validations

Creating a Person record Updating an Existing
Person record

PartyId
 

The internal ID for the
Person type party
 

When updating the record,
 this should already exist.
 

Not required
 

Conditionally required.
 
To identify a person record,
 use one of these:
 

• Combination of
SourceSystem and
SourceSystemReferenceValue

• PartyNumber

• PartyId

Country
 

The country code of the
postal address
 

Identify valid country
codes using the Setup and
Maintenance, Manage
Territories task.
 

Conditionally required
 
A value is required only
when you're creating an
address for the Person
record.
 

The attribute is neither
required nor conditionally
required.
 

AddressNumber
 

The internal unique
identifier that's internally
generated when creating an
address
 

No validation
 

This is a PUID for Address.
If a value is passed, it will be
imported. Otherwise, it will
be auto-generated.
 

Pass the AddressNumber.
 

OrganizationPartyNumber
 

The party number of the
organization to which the
person is related
 

This should already exist.
 

Not required
 

Not required
 

DeceasedFlag
 

The option that indicates
whether the person
imported is deceased
 

Y or N
 
The default value is N.
 

Not required
 

Not required
 

PartyNumber
 

The unique identifier of the
party
 

Know the party number. To
obtain a list of all party IDs
and party numbers, export
the Person object.
 

This is a PUID for Person. If
a value is passed, it will be
imported. Otherwise, it will
be auto-generated.
 

Conditionally required
 
To identify a person record,
 use one of these:
 

• Combination of
SourceSystem and
SourceSystemReferenceValue

• PartyNumber

• PartyId
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Attribute Description Prerequisite Setup Task/
Import Validations

Creating a Person record Updating an Existing
Person record

FirstName
 

The first name of the
person
 

No validation
 

Required. A value is
required for the FirstName,
 MiddleName, or LastName.
 

Not required
 

MiddleName
 

The middle name of the
person
 

No validation
 

Required. A value is
required for the FirstName,
 MiddleName, or LastName.
 

Not required
 

LastName
 

The last name of the
person
 

No validation
 

Required. A value is
required for the FirstName,
 MiddleName, or LastName.
 

Not required
 

PartyUsageCode
 

Specifies the party usage
code to which the person is
associated
 

Select one of the following
values:
 

• EXTERNAL_PAYEE

• CONTACT

• PAYMENT_ISSUING_
AUTHORITY

• PARTY_OF_INTEREST

• VIRTUAL_ASSISTANT

• FS_TECH

You can assign a limited
set of unrestricted party
usages through the Person
import object. To create
persons of other types, use
the specific import objects
created for those purposes.
 

Required
 

Not required
 

SourceSystem
 

The original source system
name
 

Know the source system.
To view source systems,
 use the Manage Trading
Community Source System
task.
 

Conditionally required
 
To identify a person record,
 use one of these:
 

• Combination of
SourceSystem and
SourceSystemReferenceValue

• PartyNumber

Conditionally required
 
To identify a person record,
 use one of these:
 

• Combination of
SourceSystem and
SourceSystemReferenceValue

• PartyNumber

• PartyId

SourceSystemReferenceValue
 

The identifier in the original
source system
 

Know the source system
reference value. To view
source system reference,
 use the Manage Trading
Community Source System
task.
 

Conditionally required
 
To identify a person record,
 use one of these:
 

• Combination of
SourceSystem and
SourceSystemReferenceValue

• PartyNumber

Conditionally required
 
To identify a person record,
 use one of these:
 

• Combination of
SourceSystem and
SourceSystemReferenceValue

• PartyNumber
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Attribute Description Prerequisite Setup Task/
Import Validations

Creating a Person record Updating an Existing
Person record

• PartyId

Go to Navigator  > Tools >  Import Management >  Import Objects, to see all the attributes of the Person object. The
page also lists attribute information like type, length, description, and so on.

Create the Source CSV File
You include the data that you want to import into CX Sales and Fusion Service in a source CSV file.

You can use the templates available in the Import Objects UI page to create the source CSV file. To download a template:

1. Go to Navigator  > Tools >  Import Management >  Import Objects.
2. Select the Person object in the table and click Download.

You can now edit the downloaded file and provide valid values for the required attributes.

Note:  For help in populating the CSV file and to avoid any issues in entering values, see the topic Potential Issues
When Opening CSV Files With Excel in Related Topics section.

Create the Import Activity
After you have the CSV file ready, create an import activity to import the Person information. To create an import
activity:

1. Go to Navigator  > Tools >  Import Management >  Import Queue.
2. On the Manage Imports page, click Create Import Activity.
3. In the Create Import Activity: Enter Import Options page, provide a name for the import activity, and select

Person from the Object drop-down list.
4. Select the CSV file in the File Name field, and click Next.
5. You would see that the source and target attributes are automatically mapped in the Map Fields page. Review

and edit the mappings if required.
6. Check the file for unmapped columns or data format issues by clicking Validate Data. Click Next.
7. Review the import details on the Review and Submit page, and click Submit when you're ready.

Review the Import Results
Check if your import succeeded on the Manage Imports page. This page shows the status of all active, completed, and
unsuccessful imports. To check the status of the import activity:

1. Go to Navigator  > Tools >  Import Management >  Import Queue.
2. Click All Imports and search for the import activity that you created earlier.
3. Check the Status column for the import activity. The import is successful if the status displays as Completed.

You can drill down on the import activity to go to the Import Status page which provides the status details of
the import activity.
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Related Topics
• How You Use Alternate Keys to Import Records

• Potential Issues When Opening CSV Files in Excel

• Why can't I see the people I just imported?

How do I import using the external data loader client?  
This topic describes how to import using the External Data Loader Client tool.

You can use the tool to split a source file into multiple smaller files for upload and then import. This lets you import large
files that exceed the import size limits. You can split a CSV file in one of two ways:

• Independently - the specified CSV file can be split based on selected parameters and no import is performed

• As part of import - the specified CSV file is split and then each of the resulting files is uploaded and then
imported

The following steps are involved in using the tool:

• Submit Import Jobs

• Review Status of Import Jobs

• Retrieve Log Files

Submit Import Jobs
The submit operation, takes the source single CSV file, splits the file into smaller files (if necessary), uploads those files
to the Webcenter Content Repository and then imports the files. When executing the client from the command line, you
must provide the URL of the pod to run the import, the user credentials for authentication, the import object name, the
import map number, and the import source file name.

> java -jar oscdataloader.jar submit -target-url https://mypod.oracle.com -username importuser -input-file
 Account.csv -import-name "Account Import" -object Account -mapping-number 123565

If multiple import activities are created due to splitting of files, then import activity name values are the same. The file
name values are suffixed with a count value. For example, if the source file Account.csv is split into two files, then file
name values are called Account_1.csv and Account_2.csv.

Note:  If the target isn't open through public internet, it wouldn't be accessible through public internet.

You can retrieve the list of imports that have recently run on a server using the listimports command. For example,

> java -jar oscdataloader.jar listimports -target-url https://mypod.oracle.com -username importuser

lists the imports as a table in the command window. An example of the output would contain the following information:
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Identifier Name Object Attachment
Object

Start Time End Time Status Submitted By Activate

0123456789012345
 

Account
Import
20170410
 

Account
 

N/A
 

20170410
14:56T05:00
 

20170410
16:56T05:00
 

Completed
 

John.Doe
 

Yes
 

7878787878787878
 

Opportunity
Sync
 

Opportunity
 

N/A
 

20170411
17:06T05:00
 

20170411
20:06T05:00
 

Completed
with errors
 

John.Doe
 

Yes
 

Note:  You should place the import source files in local folders while using EDLC. Remotely mounted files might cause
performance issues.

Review Status of Import Jobs
To get the status of an import activity, enter the identifier value of the import on the command line. For example:> java
-jar oscdataloader.jar getlogs -target-url https://mypod.oracle.com -username importuser -log-type Exception -

import-activity 012345678912345

This command displays the detailed status of the matching import request (if no matching request is found, then an
error is displayed). An example of the output contains the following information:

Object Attachment
Object

Status Start Time End Time Number of
File Splits

Records
Read

Successfully
Loaded

Errors
Reported

Warnings
Reported

Account
 

N/A
 

Completed
 

20170410
14:56T05:00
 

20170410
17:36T05:00
 

2
 

50,000
 

49,950
 

50
 

0
 

Retrieve Log Files
You can get the log files generated by an import activity using the getlogs command. For example,

> java -jar oscdataloader.jar getlogs -target-url https://mypod.oracle.com -username importuser -log-type
 Exception -import-activity 012345678912345

Log files retrieved by the getlogs command are stored in the importlogs folder by default. Log file of the External Data
Loader Client is stored in the oscdataloaderlogs folder.

Can I select which record to retain as the master while
merging records?  
Yes, when merging records to resolve duplicates, you can specify which record to retain as the master.

You can do this when:

• manually creating duplicate resolution requests
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• overriding the system mapping for merge requests

• set the Master Record Selection profile option which controls the method used to identify which record in a
duplicate set becomes the master during a merge

Create Duplicate Resolution Requests Manually
When you're sure that two or more records are confirmed duplicates, you can decide to create a duplicate resolution
request manually using the following steps:

1. Navigate to the Duplicate Resolution work area as follows: Navigator > Customer Data Management >
Duplicate Resolution.

2. Click Tasks and then click Create Resolution Request.
3. Search for the records that you want to merge, link, or test merge. For example, select the Party Type as Person

and enter the Name as John, and click Search.

Note:  You can only search on standard fields using the Advanced Search option. Custom fields of the
Accounts or Contacts objects aren't available.

4. Select two or more duplicate records using the Shift or Control key.
5. Click Actions > Create Request.
6. Enter a name for the request in the Create Request: Select Type dialog.
7. Select the request type as Generic, Merge, Link, or Test Merge. You can also select the Master Record, if

needed.
8. Click OK.

You can also submit request dispatch jobs directly from the Duplicate Resolution work area by clicking the
Dispatch button, which will submit the job for immediate processing.

Override System Mapping
You can override system mapping for merge requests by manually modifying it. To manually modify system mapping,
you must select the master record and its associated attributes, and then specify the resolution for the child entity
conflicts and errors.

You can resolve child entity conflicts and errors by merging, transferring, or removing the record attributes.

You can override system mapping using these steps:

1. Navigate to the Duplicate Resolution work area as follows: Navigator >  Customer Data Management > 
Duplicate Resolution.
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2. Select the duplicate resolution request for which you want to override system mappings and drill down through
the request ID to the Review Merge Request page.

Note:  You can override system mappings only for those merge requests that are in New status, which
indicates that the request is open for review and processing. The status depends on the following:

◦ The merge request isn't an auto-merge request and the profile option
ZCH_USER_MERGE_REQUESTS is set to Process Subject to Approval. For more information
about this profile option, see Customer Hub Profile Options topic listed in the Related Links
section.

◦ Your administrator has run the Run Request Dispatch Job from the Setup and Maintenance
area to change the merge request status from Pending to New. A request dispatcher is run
periodically for pending merge requests, and sets the status of pending requests to New. You
can also request your administrator to run the Run Request Dispatch Job from the Setup and
Maintenance area to set the status of the pending requests to new. A setup user can access this
task in the Setup and Maintenance work area, using the following:

- Offering: Customer Data Management
- Functional Area: Customer Hub
- Task: Run Request Dispatch Job

3. Click Override on the Review Merge Request page to view the Override System Mapping: Select Master
Record page.

4. In the duplicate set on the page, select the record that you want to make the master and click Set Master.

Optionally, you can also remove records from the duplicate set to prevent them from being merged. You can
also mark the removed record as a nonduplicate to exclude it from all the subsequent merge requests.

5. Click Next to navigate to the Override System Mapping: Map Profile Attributes page.
6. Select a value from any of the duplicate records for each profile attribute to be retained in the master record.

If the number of duplicate records is five or less than five, you can select the value from the record columns. If
the number of duplicate records is greater than five, you can select the value from the value choice list. In the
profile attribute value choice list, you can hover over the value to see the attribute value's record. This helps you
associate the correct value with the master record. You can also manually enter a new value in the Final Value
column for an attribute.

7. On the Override System Mapping: Map Entities page, you can merge two or more entities into a single entity.
You can also remove merge entities, such as addresses, from the merge processes by clicking the Remove icon.
If the Remove icon isn't available, you must enable the ORA_ZCH_ALLOW_REMOVE_FEATURE profile option.
For more information about creating this profile option, see the Enable the Remove Option on the Override
System Mapping UI section in this topic. Child entities associated with the entities that are removed using the
Remove icon won't be transferred to the master record.

8. Click Next to view the Override System Mapping: Review page. Now you can review the mapping settings
and click Submit to override the default system mappings. In case there are edits, click Back to make updates to
the mapping settings before submission.

Controls the method used to identify which record in a duplicate set becomes the master during a merge.
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The options are:

• Select master record using survivorship rule: Logic configured with Oracle business rules using the Manage
Survivorship Rules setup task determines the master.

• Select the oldest record as master: The record with the earliest creation date is the master.

• Select the latest record as master: With the most recent creation date is the master.

• Select master based on duplicate identification results: Internal logic of the duplication identification process
determines the master.

• Select master record using Data Quality Rules: Logic configured with Application Composer Data Quality Rules
determines the master.

Consider these points:

• The Select the older record as master and Select the latest record as master options use optimized internal
processes and may offer the best performance.

• Master Record Selection can't be survivorship rule or Data Quality Rules if the Merge Scope has been set to
Customer data management specific areas with restrictions.

• The Duplicate Identification batch process identifies a preliminary master record, but the final determination of
master record occurs within duplicate resolution processing per the Master Record Selection Setting. Select the
Select master based on duplicate identification results option if you want to retain the master record selection
from the duplicate identification results.

How can I identify contacts that are matched with
contacts in LinkedIn?  
Contacts that your organization matches with contacts in LinkedIn using the LinkedIn Sales Navigator include the value
LINKEDIN in the Original System Reference for Party attribute. You can create a BI report using this attribute as a filter
from the Sales - CRM Contacts subject area or from any other subject area with a Contacts folder (Contact >  Contact -
Additional Attributes  > Original System Reference for Party)

You can also use a direct SQL to get the matched records:

Select ORIG_SYSTEM_REFERENCE,OWNER_TABLE_NAME,OWNER_TABLE_ID from fusion.hz_orig_sys_references 

Where ORIG_SYSTEM='LINKEDIN' OWNER_TABLE_ID is the record ID, OWNER_TABLE_NAME is the main table where
the record is located (for example: HZ_PARTIES for contacts and accounts, MOO_OPTY for opportunities, and so on).

How can I get a list of all the personal saved searches
created by end-users in Sales?  
You can create a BI report with the following SQL query to get the list. You can use the information about the personal
searches salespeople create, to create additional saved searches for the sales organization.
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This query lists all the custom saved searches created by the users:

 select ss.saved_search_uuid,stl.localized_name, stl.language,ee.entity_name, ss.creation_date,
 ss.created_by, ss.keywords, ss.query_json,ss.aggregations_json,ss.sort_json,ss.fields_json from
 fusion.zca_es_saved_searches_b ss, fusion.zca_es_saved_searches_tl stl, fusion.zca_es_entities ee
 where ss.created_by <>'SEED_DATA_FROM_APPLICATION' and stl.saved_search_uuid=ss.saved_search_uuid and
 ss.entity_uuid=ee.entity_uuid 

How do I search in fields in the Details pages?  
In Sales in the Redwood user experience, the fields on the Details pages give you the same advanced search capabilities
as the list pages. You can search using words in the name or using related information. Like list pages, you can select a
saved search to restrict the search to just the items of interest to you.

1. Place your cursor in the field to see recent and frequently accessed items.

Here’s a sample list of suggestions (callout 2) for the Primary Contact field (callout 1).

2. If the suggestions don’t match what you’re looking for, search using words in the name and related attributes.
For example, if you’re adding a contact to a lead or opportunity, you can search by contact name or by account
name. Searching by the account name gets you a list of all of the contacts for account.

You can also search on a combination of terms. For example, you can enter the account name and the city
where it’s located. For example, a search on Pinnacle (the account name) and Seattle (the city), gets you
Pinnacle Technologies in Seattle.
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3. You can narrow down the scope of your searches ahead of time by picking a saved search from the Actions
menu (callout 1 in the screenshot).

For example, to search only accounts where you are on the team or territory, select the My Accounts saved
search (callout 2). The saved search name appears as a filter in the field name (callout 3)

. 

Tip:  You may be able to search on attributes not displayed in the list of search results. For example, you may be able
to search for accounts by the account owner although Owner isn’t one of the columns in the results. Your application
administrator can enable search on a large number of fields.

Which Attributes You Can Search
Here's a list of searchable attributes Oracle predefined for each create field.

• Account:

Page Attributes You Can Search

All create pages where the Account
field appears.
 

Account Name, Account Primary Address, Primary Contact Name
 

• Contact

Page Attributes You Can Search

Create Account
 

Contact Name, Job Title
 

Create Appointment
 

Contact Name, Job Title, Primary Account Name
 

Create Lead Contact Name, Job Title, Primary Account Name
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Page Attributes You Can Search

  

Create Opportunity
 

Contact Name, Job Title, Primary Account Name
 

Create Task
 

Account Name, Account Primary Address, Primary Contact Name
 

• Lead

Page Attributes You Can Search

Create Appointment and Create Task
pages
 

Lead Name, Account Name, Primary Contact: Name
 

• Opportunity

Page Attributes You Can Search

Create Appointment and Create Task
pages
 

Opportunity Name, Account Name
 

Search Partial Words, Exact Phrases, and Use Operators
You can search on partial words, exact phrases, and use operators between words. Here's how:

• Use the star (*) symbol to indicate missing characters or partial words. You can use the symbol at the
beginning, end, or middle of the search term.

For example, entering *tion as your search term to find all items ending with the letters tion. Entering the star
symbol in the middle of a word such as Pi*le, returns Pinnacle, Pineapple, and so on.

• Use the question mark (?) to match exactly one character. You can use this wildcard at the beginning, end, or
middle of a word.

For example, entering Pri?e returns Price, Prize, Pride, and so on.

• Put multiple search terms in quotes to search for exact phrases.

For example, entering "Pinnacle Corporation" returns only Pinnacle Corporation, and any other records with
those two terms in that specific order.

• Use the OR operator to search on multiple terms.

For example, entering Chicago OR Pittsburgh, finds accounts with those terms in the name. If your application
administrator enabled searching on addresses, the results also include all accounts in Chicago or Pittsburgh.

• Use the NOT operator to narrow down your search.
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For example, entering Pinnacle NOT Technologies when searching for accounts, returns all accounts with
Pinnacle in the name, but not Pinnacle Technologies.

When you use NOT followed by two or more words, you must enclose the words in double quotes (" ").
For example, entering Pinnacle NOT "Techologies Inc" when searching for accounts, excludes Pinnacle
Technologies Inc.

• Capitalization doesn't matter on search terms, but the operators OR and NOT must be in uppercase letters.

How do we display different products in the sales catalog
in different business units?  
You can display different sections of your sales catalog in different business units by using sales territories. You set up
the sales territories for the business units with the business unit dimension and then filter the sales catalog using those
territories as described in this topic. The filtering you set up doesn't depend on sales teams or assignment. As they
browse products, salespeople see only the product groups in their business unit territories.

You set the territory filtering options in the product groups setup pages.

1. Sign in as the sales administrator.
2. In Setup and Maintenance, go to:

◦ Offering: Sales

◦ Functional Area: Sales Catalog and Products

◦ Task: Manage Product Group Usage

3. Select the Base catalog in the upper portion of the page. (If your catalog uses a different usage, then select it.)
4. Click the Functions tab in the Details section of the page.
5. Click the Value drop-down list for the Territory engine option. If multiple applications have a Territory engine

row, then select the row that has the application you want the filtering to apply to. The applications that can use the
territory filtering functionality appear in the Mode column of the Functions tab. For example, click Territory engine
for the Opportunity Management application shown in the Mode column.

6. Make your filtering selection, using the information in the following table.

Option Description

Do not run
 

Territory filtering is off. The Filter by Territory check box doesn't display.
 

Enforce territory
 

Territory filtering is on, but is transparent to the user. The Filter by Territory check box doesn't
display.
 

Display choice - checked by default
 

Territory filtering is on. The territory filter check box is displayed and checked by default. The user
can deselect the check box to disable the territory filtering.
 

Display choice - unchecked by default
 

Territory filtering is off. The territory filter check box is displayed and deselected by default. The user
can check the check box to enable the territory filtering.
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7. Click Save and Close.

How can I avoid record lock error on accounts?  
You might get a record lock error on accounts or contacts when you try to update it.

This happens because:

• There are parallel updates to the same record by another service request or UI.

• You're creating or updating relationship records for a contact in a batch pointing to same account record.

• You're creating or updating relationship records for an account in a batch pointing to same contact record.

When you create a new account or contact relationship, then the parent record gets updated along with the child record.
This causes a record lock error on the parent. This happens more so when there is parallel record create or update using
web services.

To avoid this issue, consider the following:

• When creating or updating relationships for a contact in a batch operation the same Account shouldn’t be used.

• When creating or updating relationships for Accounts in a batch operation the same contact shouldn’t be used.

• Parallel updates should be avoided to the same account or contact record by Service or UI flows.

To avoid Locks in such cases it’s recommended to have a Retry mechanism in place.

How do I allow the update of sales contacts while
protecting ERP contacts from being edited?  
When you sync accounts and contacts from Financials to Sales, the ERP contacts can be edited in Sales just like sales
contacts. The sales and ERP contacts are indistinguishable. To protect the ERP contacts from being edited, you must
create a way to distinguish between the two types of contacts and then update security to allow editing only for the
sales contacts.

For example, you can do the following:

1. Create a custom field on Application Composer that's set to a specific value when the contacts are created in
Sales.

2. Remove contact edit access for all the sales job roles.
3. Use Access Management to add edit access to contacts that are flagged as sales contacts.
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How do I enable the creation of a lead from an account in
Oracle CX Sales Mobile?  
You can enable salespeople to create leads directly from an account record in Oracle CX Sales Mobile by using Mobile
Application Setup in Application Composer. Here's how.

Add the Lead Creation Capability to the Account Layout
Here's a screenshot of the Account Summary view in the CX Sales Mobile Composer. The callouts highlight the steps to
add the create lead action. Detailed steps follow.

Setup Summary and Screenshot

Callout Description

1 With Account Views open, select the Summary view.

2 Duplicate the Account Detail layout.

3 In the screen mock-up, scroll down to the Leads card and click the square with arrow icon (that's the
first icon from the left) and select the type of create lead action you want to enable.
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1. Open Application Composer in a sandbox.
2. Click Mobile Application Setup.
3. In Application Features, click Accounts.
4. In Accounts Views, click Summary.
5. Click Clone (the two-suares icon) for the Account Detail standard layout.
6. Enter a name for your custom layout and click OK.
7. Select the layout you just created.
8. In the phone image layout screen scroll down to the Leads section.
9. Click the first icon at the top of the Leads card (a square with an arrow pointing into it) Click to change

relationship association with the target.
10. In the dialog box, select one of the three options:

◦ Create: salespeople can create new leads for the account.

◦ Add: salespeople can add existing leads to the account.

◦ Both: salespeople can both create and add existing leads.
Click OK.

Test Your Configuration and Publish the Sandbox
1. After making your configurations, keep the Oracle CX Sales application open and make sure that the sandbox

where you made the changes is active in the application.
2. Open CX Sales Mobile on your mobile device and sign in as the same user that you used to make your

configurations. If you've already signed in to CX Sales Mobile, you need to force close the app and open it again.
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This is because the app picks up the latest updates in the sandbox when you restart the app, or when you sign
in.

3. Once you've restarted the app and signed in, your configurations are ready to view. The sandbox where you
made your configurations is linked to your user details, and the configurations are automatically downloaded
when you restart the app. However, you can double-check that you're in the correct sandbox by tapping
Settings > System in the CX Sales Mobile menu and checking the Sandbox Name and the Last Download
Time.

4. Check your configurations. If you've more than one pod and you want to check your configurations in another
pod, then you need to connect to the other pod by changing the host URL. Navigate to Settings in the CX Sales
Mobile app, tap Reset Application, and enter the host URL of the relevant pod.

5. If you make further updates in the sandbox, you need to force close the app, and sign in again to see the
updates.

6. When you're happy with your configurations, publish the sandbox to distribute the configurations to your users.

How can I get user login history or application usage
from Oracle Fusion Applications?  
You have a few options for getting user sign-in and user usage information from Oracle Fusion Applications.

For more information about how to get user sign-on data and user usage in Oracle Fusion Applications, see the article
on My Oracle Support, Security Reports in Fusion Application (Doc ID 2210883.1).

How do I get started with the Revenue Transformation
Solution?  
As revenue leaders look to modernize and compete, that often means pivoting to new business models or expanding
to hybrid models that incorporate subscriptions, products, and services. Oracle Sales is powering this transition with
end-to-end business flows that extend to the Oracle Fusion ERP Suite for orders, invoicing, payments, and revenue
recognition, enabling organizations to effectively and efficiently transition from one-time selling to anything-as-a-
service (XaaS) models.

Oracle's Revenue Transformation Solution enables you to connect business processes to reach your full revenue
potential. Oracle’s revenue transformation solution combines Oracle Sales, Oracle Configure, Price, and Quote (Oracle
CPQ), Oracle Sales Performance Management, and Oracle Subscription Management – plus a host of Oracle's other
revenue operations applications – to establish and accurately manage sales targets, sell any combination of products
and services on a subscription basis, and provide global visibility into sales performance and revenue reporting.

The solution lets you price your product competitively, leveraging Oracle CPQ pricing capabilities in a single, unified
administration flow, offering a streamlined user experience.

For more information about how you can implement a complete revenue transformation solution using key integrated
features of several Oracle applications or modules, see the How do I get started with the Revenue Transformation
Solution? solution playbook on the Oracle Help Center Sales > Playbooks page.
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How do I configure contract approval notifications?  
When a contract is sent for approval, all approvers receive a standardized workflow and email notification. You can now
configure the notifications to meet your specific business needs and requirements through the Business Intelligence
Publisher (BIP) .RTF-based contract approval notification template or subtemplate.

Note:  This feature is controlled by opt-in. If you’ve opted in, the new BIP-based contract approval notification is sent
during contract approval. If you decide not to opt-in, then you’ll continue to see the current notification display.From
Update 24D, the feature will be available by default.

For more information about how you can opt-in and make your changes to your contact approval notifications, see the
How do I configure contract approval notifications? solution playbook on the Oracle Help Center Sales > Playbooks page.

How do I implement Microsoft 365 for Oracle Sales
Redwood UX?  
The Microsoft 365 Integration for Oracle Sales Redwood User Experience consists of the next-generation Microsoft
Outlook add-in and sync capabilities.

The main benefits in this next-generation release are:

• Task-Oriented Functionality and Insights: The Redwood UX add-in, known as the Oracle Sales for Outlook
add-in, features task-oriented functionality geared to salespeople's day-in-the-life scenarios, in the context of
Outlook interactions and interface.

Salespeople begin their day with a daily briefing, right in the add-in. Insights from Sales further help them
engage with their customers, easily schedule and prepare for meetings, and review and respond to emails.

• Intuitive UIs Optimized for Microsoft Outlook: The UI is optimized for Outlook, providing 360-degree sales
information for meetings and emails, directly in the context of those meetings and emails.

Salespeople can share meetings and emails with Sales. Emails are shared as conversation messages.

• Autosyncing of Data Betweeen Microsoft Exchange and Oracle Sales: This next-generation integration
supports bidirectional sync for appointments, tasks, and contacts, as well as the automatic sync of
appointments from Exchange to Sales.

Appointments, tasks, and contacts can be synced from Sales to Exchange based on Workspace-defined saved
searches. Emails can be shared by setting the Shared with Oracle category. Responses to shared emails can also
be automatically captured from Outlook.

• Daily Summary of Appointments: In addition, salespeople see a daily summary of appointments that they can
act on. A default Workspace saved search can be set for each object across the organization and salespeople
can set their preferred saved searches for sync using the add-in.
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• Improved Sign-In Experience: The add-in provides a better and more secure sign-in experience than the
previous version. Based on your company's policy, the add-in uses OAuth, a feature that lets salespeople stay
signed in for longer.

• Easy Customization and Deployment: The add-in comes with predefined layouts to use as-is, or if changes
are required, the predefined layouts can be easily tailored using the new Oracle Sales for Outlook tool in
Application Composer.
The tool makes it easy to migrate customizations from the earlier CX Sales for Microsoft 365 add-in or from
the Oracle CX Sales Mobile application, so you don't need to manually rebuild the customizations for this
integration.

For more information on how your organization can benefit from the Microsoft 365 Integration for Oracle Sales
Redwood User Experience, see the solution playbook, How do I implement Microsoft 365 for Oracle Sales Redwood UX?
on the Oracle Help Center Sales > Playbooks page.

Related Topics
• What are the system requirements for Microsoft integration?

How do I check which copy maps are used during lead
conversion?  
Copy maps are a declarative way to specify which fields are copied among objects. The functionality for converting a
lead to an opportunity uses the predefined Copy Lead To Opportunity Map copy map feature. You can use predefined
mapping files to specify which copy maps to use when converting leads.

For example, predefined mapping files are available as part of your sales application to enable you to map objects and
attributes during the creation of an account or a contact when converting a lead to an opportunity. Specify the copy
map name you want in one of these profile options:

• Use the Direct Lead to Opportunity Mapping profile option to specify the copy mapping file name created
when a direct lead is converted to an opportunity.

• Use the Partner Lead to Opportunity Mapping profile option to specify the copy mapping file name created
when a partner lead is converted to an opportunity.

• Use the Lead to Account Mapping  profile option to specify the mapping file name created in Copy Maps. This
file maps objects and attributes during the creation of an account when converting a lead to an opportunity.

• Use the Lead to Contact Mapping profile option to specify the mapping file name created in Copy Maps. This
file maps objects and attributes during the creation of a contact when converting a lead to an opportunity.

Here's how to access the profile options to see what copy map is being used:

1. In the Setup and Maintenance work area, go to the following:
◦ Offering: Sales

◦ Functional Area: Opportunities

◦ Task: Manage Sales Lead Profile Options
2. In the Manage Sales Lead Profile Options page, enter the name of one of the mapping profile options you want

in the Profile Display Name field. For example, search for the Direct Lead to Opportunity Mapping profile
option.
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3. Click Search.
4. In the Profile Values section, you can see the name of the mapping file used when the lead is converted to an

opportunity.
5. Click Close.

What's the allowed attachment file type and size for
sharing emails?  
This topic shows the attachment size limit for sharing emails and for uploading files from objects such as Account and
Opportunity.

• Images: JPEG, GIF, PICT, PNG, TIFF: 2 MB

• Microsoft files: PPT, DOC, EXCEL: 10MB

• Video: QT, MP4, .XMS: 10 MB

• Audio: M4A, MPEG3, AAC, .WAV: 2 MB

For uploading files from objects such as Account and Opportunity:

• Upload a file: 10 MB

• Upload contact or avatar image: 2MB

Note:  If you have a locally-installed Outlook application and the Edge browser on Windows computers, you can't use
Microsoft 365 add-in to download the attachments that have been uploaded to the sales records. Alternatively, you
can download them from the sales application.

What effect has the Territory-Based Assignment
Selective Update Enabled profile option?  
The Territory-Based Assignment Selective Update Enabled (MOO_TBA_SELECTIVE_UPDATE_ENABLED) profile option
is used to update the opportunity time stamp during territory-based assignment if the Revenue Owner or Opportunity
Owner assignment outcome has changed.

If disabled, this profile option will always update the opportunity time stamp during territory-based assignment.
However, to reduce the performance overhead, the last assigned time stamp (date) isn't updated for any incoming
territories where the time stamp is the same as already assigned territories.

How do I reprice and a generate billing schedule?  
To reprise and generate a billing schedule, you need to:

1. Set GenerateBillingSchedule to Y in the Products file.
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2. Set GenerateBillingSchedule to Y in the Subscription file.
3. Set reprice to Y in the Products file.
4. Re-import the Subscription.csv after this.

To activate your subscription, you need to re-import the Subscription.csv file after importing all required files.

Note:  You can't reprice and generate a billing schedule when a subscription is in Active status.

How do I filter and search in lists of Contacts?  
You can filter and search through the information on Contact records if the list pages include the Action Bar. Which
attributes you can filter and search on depends on the information type.

Here are the steps to help filter and refine your contact search.

1. In the Action Bar, enter filter and select a filter. For example, on the All Contacts Page, you can filter on Name,
Primary Email, Comments, and Contact Job Title.

Note:  You can’t filter on all of the common attributes, just on those listed. For example, you can’t filter team
resources by their role.

2. Select the operator.
3. Enter a search term in the Value field. You can enter only one keyword. Searches aren't case-sensitive and no

operators are permitted.
4. Click Apply.
5. You can add additional filters.

Here’s a screenshot of the Contacts page for an account with the Name filter applied, and Contains operator selected.
Nelson is the search term entered in the Value field.
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How do I delegate activities to another user?  
You can enable the ability for all sales users in your implementation to delegate their activities, such as delegating
calendar appointments or tasks, to another user. To enable delegation, you set separate profile options for
appointments and tasks.

When users delegate an activity, they're simply changing the owner of the activity. After an activity is delegated, both
the original owner and the user who now owns the activity can edit or update the activity.

To enable activity delegation:

1. In Setup and Maintenance, go to:

◦ Offering: Sales

◦ Functional Area: Sales Foundation

◦ Task: Manage Administrator Profile Values

2. Search for and set two profile options according to your business needs. This table lists the profile options:

Profile Option Display Name Profile Option Code Description and Setting

Appointment Delegation Enabled ZMM_ACTIVITY_APPT_DELEGATION Enables sales users to delegate
appointments to other sales users. Set to
Yes at site level to enable all users in the site
to use the delegation feature.
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Profile Option Display Name Profile Option Code Description and Setting

Task Delegation Enabled ZMM_ACTIVITY_TASK_DELEGATION Enables sales users to delegate tasks to
other sales users. Set to Yes at site level
to enable all users in the site to use the
delegation feature.

3. Save your changes.

Disable Delegation
Turn off delegation if you no longer want the second owner to co-own the activity.

Why can't I search revenue line details from the
Opportunity workspace area?  
Opportunity revenue line information isn't available for Workspace search columns because an opportunity can have
multiple revenue lines. However, if you've the Revenue Lines object enabled for Adaptive Search, then you can use the
Revenue Lines workspace area to view the products and opportunities for each revenue line.

To view a list of opportunities having one specific product, you can add a filter on the Revenues field to search for
corresponding records. When you create an opportunity, a primary revenue record is automatically created. The primary
revenue record is independent of products added to an opportunity and is always associated with the opportunity even
if no products are added to the opportunity. The primary revenue record displays as a summary line in the UI but no
product related information such as item name or description values are displayed.

How can I enable Redwood Sales, the latest version of
the Sales application?  
If you're a new customer, then Redwood Sales, the latest version of Oracle Sales in the Redwood user experience, is
already enabled for you. If you're an existing customer, however, you must enable both the Digital Sales Next Gen UI
and Sales in the Redwood UX features in the Sales offering. When you're done, salespeople access the newest feature
versions from the Redwood Sales tab on the home page.

Here are the setup details:

1. Sign in as a setup user and open the Setup and Maintenance work area.
2. In Setup and Maintenance, display the Sales offering.
3. From the Actions menu, select Change Feature Selection.
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4. In the Edit Features: Sales page, enable both the Digital Sales Next Gen UI feature and its child feature Sales in
the Redwood UX.

5. Click Done.

What's the maximum number of values I can use for
an Opportunity Rule-Based Assignment (RBA) rule
condition?  
The maximum number of values to use for a rule condition is 500 when creating rules for Opportunity Rule-Based
Assignment (RBA).

How do I import notes?  
This topic shows how to import notes using the Import Management feature. You can attach a note to an existing object
record.

Types of Notes
Note can be one of the following types:

• GENERAL

• REFERENCE

• SPECIAL

A note with line break may not be imported with the correct formatting. To ensure you import the content with the line
breaks, insert a <br> instead of a line break in the note. Refer to Notes Imported Does Not Show In Correct Format In UI 
for more information.
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Before You Start
Before importing the note, make sure to import the object record to attach the note. You can import an object, such
as Sales Lead, using Import Management. See the topic Import Data for the details on importing. After the import
completes, note the primary key and PUID of the record created using the success log file.

How You Import the Note
You're set to import the note and associate with the object record. Use the following steps to import notes using Import
Management.

1. Click Tools > Import Management.
2. On the Manage Imports page, click the Create Import Activity button. On the Enter Import Options page,

enter a name for your import. In the Object drop-down list select Note.
3. In the Note Object drop-down list that appears, select the object to associate with the note, such as Sales Lead.
4. Create the note CSV file in the following format.

ObjectPuid or SourceObjectId NoteTxt NoteTypeCode

CDRM_82807 or 300100181729328
 

A sample note text
 

SPECIAL
 

You must provide either ObjectPuid or SourceObjectId in the source file, but not both.

ObjectPuid - The public unique identifier of the object. In case of Sales Lead, this refers to the LeadNumber
value.

SourceObjectId - The primary key of the object. For Sales Lead, this refers to the LeadID value.

NoteTxt - The note entry.

NoteTypeCode - The category of the note. The possible values are GENERAL, REFERENCE, and SPECIAL.
5. Browse the source CSV file and create the import activity.
6. Review the import activity configuration and click submit to activate the import. The Manage Imports page

shows the status of the submitted import.

How do I prevent duplicate contacts from appearing in
the Outlook add-on?  
To keep the app from creating duplicating contacts in the integration with Microsoft using the Outlook add-on, you
need to enable the setting that lets the sync process delete duplicates.

Allow Contact Deletion in the Redwood UX
Enable the setting, Allow Sync to Delete Oracle Sales Contacts, if you're using the Redwood User Experience (UX)
version of the Microsoft Outlook add-on.
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See Configure Contacts Sync for more information.

Note:  Oracle recommends that you use the Redwood UX version of the Microsoft Outlook add in. See Overview of
Microsoft 365 for Redwood UX to get started.

Allow Contact Deletion in the Classic Sales UX
If you're using the previous version, the Oracle CX Sales for Microsoft 365 add-on, then enable the setting, Allow Sync to
Delete CX Contacts.

See Manage Microsoft 365 for more information.

How do I set sync options in the previous version of the
Microsoft Outlook add-in?  
You must configure several settings that let the Microsoft 365 Sales for Outlook add-in run smoothly, such as sync
options, default saved search, conflict resolution, and record sync limits.

Note:  Oracle recommends that you use the Redwood User Experience (UX) version of the Microsoft Outlook add in,
not the previous version. See Overview of Microsoft 365 for Redwood UX for more information.

Navigate to the Manage Microsoft 365 Page
Here's how to get to the Manage Microsoft 365 page, where you set the options for the previous version of the add-in:

1. Sign in as a setup user or as the sales administrator.
2. Navigate to:

◦ Offering: Sales

◦ Functional Area: Integrations

◦ Task: Manage Microsoft 365

3. You can find the settings in the Manage Microsoft 365 page.

Options You Can Set
This table describes the contacts, appointments, and tasks sync settings.

Settings Area Setting Name Description

Conflict Resolution Default Conflict Resolution • CX Server Wins: The records in the Sales application overwrite the
records in Microsoft 365.

• Outlook Client Wins: The records in Microsoft 365 overwrite the
records in the Sales application.

• User Selected: Users can select at runtime the way to resolve
conflicts.
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Settings Area Setting Name Description

Allow User to Override Default Conflict
Resolution

Lets users view the conflict resolution options in the add-in and select
the option they want.

Usage Tracking Enable Add-in Usage Tracking Lets you track the usage of the Microsoft 365 add-in by your users.

Enable Application Permission This setting enables standard sync to gain access to all the mailboxes
so that users don't have to frequently sign in into the add-in.

Enable Dynamic Batching for Sync This setting auto-enables the sync engine to determine the optimized
batch size for sync, based on the Oracle server capacity. This improves
performance.

Allow Users to Select Default Saved
Search

Selecting this check box causes the default saved search defined in the
Microsoft 365 Designer as the saved search for all the users. Custom
saved searches specified by users in the add-in are ignored.

Synchronization Tracking This setting lets you monitor the sync statistics and displays the details
in the Microsoft 365 Monitor.

Include Attachments in Sync This setting lets the sync engine share attachments on emails or
appointments with Sales.

Synchronization Settings

Attachment Size Limit The maximum size limit is 10 MB. You can configure according to your
business needs. Files larger than the size you configured here won't be
shared with Sales.

Enable Sync This is a primary setting to indicate you want to sync contacts. If this
setting is disabled, other settings in this section are disabled, too.

Allow Sync to Create CX Contacts When a user shares new contacts from Outlook, new contact records
are created in the sales application.

Allow Sync to Delete CX Contacts This setting means that when a user removes a contact in Outlook, the
corresponding contact records are removed in Sales.

Contacts

Limit Enter the number of records to be synced in every run of the sync
process.

Enable Sync This is a primary setting to indicate you want to sync appointments. If
this setting is disabled, other settings in this section are disabled, too.

Enable Bidirectional Sync If set to a yes value, appointments are synced between Sales and
Outlook. If you deselect it, the sync engine only syncs appointments
from Outlook to Sales and not from Sales to Outlook.

Allow Sync to Create CX Appointments If set to a yes value, this setting means that when a user shares
meetings from Outlook, appointment records are created in Sales.

Appointments

Allow Sync to Delete CX Appointments If set to a yes value, when a user removes a meeting or an appointment
from Outlook, the corresponding appointment record is removed from
Sales.

488



Oracle Fusion Cloud Sales Automation
Sales Questions and Answers

Chapter 1
Sales Questions and Answers

Settings Area Setting Name Description

Autocapture Appointments If set to a yes value, appointments are automatically synced without the
need for the users to tag the appointments as Shared with Oracle.

Capture Appointments with Empty
Invitee List

This setting is available only when Auto-capture Appointments is
selected. Select this setting to sync those appointments that don't have
any invitees. Usually, salespeople create such appointments to block
some time on their calendars to complete priority tasks.

Include Private Appointments Users' private appointments are synced during the auto-sync of
appointments.

Allow Invitees to Share Appoinments Allows salespeople to share the meetings they were invited to.

Limit Enter the number of records to be synced in every run of the sync
process.

Enable Sync This is a primary setting to indicate you want to sync tasks. If this
setting is disabled, other settings in this section are disabled too.

Allow Sync to Create CX Tasks When a user shares emails from Outlook, emails are saved as tasks in
the sales application.

Allow Sync to Delete CX Tasks When a user deletes an email from Outlook, the corresponding task is
removed from the sales application.

Include Private Tasks from Outlook Syncs the private tasks in Outlook with the sales application.

Tasks

Limit Enter the number of records to be synced in every run of the sync
process.

Agreement Acceptance Shows the user who has accepted the terms and conditions mentioned
in the end user license agreement.
Also shows the date and time when the user has accepted the
agreement.
 

End User License Agreement
Details

View Agreement Click the link to go through the agreement again.

How can I enable recurring revenue schedules for Oracle
Sales?  
Salespeople can use recurring revenue schedules to account for revenue against opportunity products or product
groups that are part of subscription business models. If you're using the Redwood fragments version of Sales, then you
can enable recurring revenue schedules using these instructions.

Note:  This topic is applicable only if you're using the fragments version of Sales in the Redwood UX.
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To enable recurring revenue schedules, you must complete these steps in Oracle Visual Builder Studio:

Steps to Enable Recurring Revenue Schedules

Setup Step Context

1. Create a new event listener and action
chain.
 

When you create an event listener, an action chain is automatically created, as well.
 
Update the action chain to turn on the ability to create recurring revenue schedules.
 

2. Manually update the action chain name,
 if necessary.
 

This step is required only if the action chain name doesn't look like the value documented below.
 

3. If your extension is using a cloned
layout for the Edit Layout rule
set, then modify the path for the
RevenueRecurrenceLayout section.
 

This step is required only for cloned layouts.
 

1. Create Event Listener and Action Chain
Add a new event listener for the opportunitiesChildRevenueOnEditEvent event.

1. In Visual Builder Studio, click the Layouts side tab.
2. On the Layouts side tab, click the CX Sales > Opportunities > ChildRevenue node.

3. On the ChildRevenue tab, click the Event Listeners subtab.
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4. Click + Event Listener.
5. In the Create Event Listener dialog, click opportunitiesChildRevenueOnEditEvent.
6. Click Next.
7. Click the + icon next to Action Chains.
8. In the New Action Chain field, enter opportunitiesChildRevenueOnEditEventChangeListener.
9. Click Finish.

Next, update the action chain for the opportunitiesChildRevenueOnEditEventChangeListener event listener.

1. On the refreshed Event Listeners page, next to the new
opportunitiesChildRevenueOnEditEventChangeListener event listener, click Go to Action Chain.

2. On the Actions subtab, right click the Return previous node and then click Go to Code.
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3. In the code, the row for return previous; is highlighted.

Place your cursor at the end of the previous row and add this code snippet:

 if (event.cartItem && Object.keys(event.cartItem).length === 0 && event?.row.SplitTypeCode !=
 "PARENTSPLIT") {
 previous = {};
 previous.enableRecurrence = true;
 }

The previous code confirms the event that's called when the user edits an opportunity product, and also
confirms that the revenue line being edited is not already a parent split line. If those things are true, then the
ability to create recurring revenue schedules is set to true.

2. Update the Action Chain Name
In some instances, you might need to update the action chain name. Here's how:

1. In Visual Builder Studio, click the Git side tab.
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2. Navigate Untracked > extension1 / sources > dynamicLayouts > oracle_cx_salesUI > opportunities /
child / ChildRevenue > chains > layout-x.json.

3. In the layout-x.json file, scroll down to the eventListeners section and confirm that the action chain name
looks as follows:

"chain": "opportunitiesChildRevenueOnEditEventChangeListener"
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3. Modify the Path for the RevenueRecurrenceLayout Section (for Cloned
Layouts Only)
If you're working with a cloned layout for the Edit Layout rule set, then review the JSON to confirm that the path for the
recurring revenue schedule section is correct.

1. Still on the ChildRevenue tab, click the JSON subtab.
2. Scroll down to the displayProperties in the EditLayout section.
3. In the displayProperties section, review the RevenueRecurrenceLayout line.

4. Add a "/" just before RevenueRecurrenceLayout so that the code looks like this:

"{{ $variables.isShowRevenueRecurrenceFields ? {\"RevenueRecurrence\": \"/RevenueRecurrenceLayout\"} :

null }}"

Test the Flow
You can now test the flow to confirm that users can configure recurring revenue schedules for an opportunity.

1. In Visual Builder Studio, click the App UIs side tab.
2. Navigate CX Sales > cx-sales > opportunities > opportunities-list.
3. From the opportunities-list page, click the Preview button to see your changes in your runtime test

environment.

4. The resulting preview link will be:

https://<servername>/fscmUI/redwood/cx-sales/opportunities/opportunities-list

5. Change the preview link as follows:

https://<servername>/fscmUI/redwood/cx-sales/application/container/opportunities/opportunities-list

Note:  You must add /application/container to the preview link.

6. On the Opportunities list page, click any opportunity to edit.
7. On the Opportunity detail page, click the View All Products link that displays on the Products panel.
8. Click a product that you want to configure a recurring revenue schedule for, and then from the Actions menu,

click Edit.
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9. In the Edit Opportunity Revenue drawer, click the Add Schedule button.

10. In the Schedule region that displays, you can now configure a recurring revenue schedule.

11. Add the schedule details.

For example, in the End After < > Transactions field, enter a number such as 4.
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12. Click Generate Schedule.

Note the schedule is created.

13. Save your work by using the Push Git command.

Navigate to the Git tab, review your changes, and do a Git push (which does both a commit and a push to the
Git repository).
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Why does my Workspace record query return fewer
results than the record count in my reports?  
By design, Workspace record queries return only records that were updated within the last 365 days. Workspace
transactional data for several objects are marked with a "Last Update Date" stamp that restricts the search to only 1 year.
Any record that hasn't been updated for more than a year won't appear in the Workspace search results.

Other methods of reporting updated records outside of Workspace doesn't have this restriction, hence the reason for
differences in the record count. Here's a list of the Workspace transactional objects:

• Activities

• Leads

• Opportunities

• Quotes and Orders

• Service Requests

Note:  Workspace transactional object details are updated asynchronously during Near Real-time Indexing.The
asynchronous update happens after the objects in the above list are refreshed.

How do I filter records by creation date and time in
Workspace?  
You can select the creation date and time to filter by a specific date to narrow down your object list of search results in
Workspace. This saves you time because you can conduct more focused searches.

For example, you can add the Creation Date field as an object search filter and specify a specific time filter as part
of your date search filter to help further refine your list of returned records in Workspace or work areas powered by
Adaptive Search.

Follow these steps to filter account records by date and time.

1. From Workspace or a work area powered by Adaptive Search , select the object you want to search such as
Accounts.
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2. Click Show Filters and select Creation Date from the list of available filters and move it to the selected pane as
shown.

3. Edit the Creation Date filter and enter the date and time on the Select Date and Time panel as shown.
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4. Click Search to narrow your search results of accounts based on the creation date and time filter you specified.

How do I use the legacy Sales documentation?  
Use the legacy guides to learn how to set up core sales functionality, which remains the same in all Sales versions.

• Implementing Sales: Use this guide to set up users and core sales features, including accounts, competitors,
leads, opportunities, and sales territories. The core sales features are the same in all the sales versions and use
the same setup tasks and pages.
Be aware that the guide covers the setup of features in classic Sales that are still supported, but have been
replaced with newer features. For example, task templates and Sales Coach have been replaced by the
Orchestration feature in Redwood Sales.

• Using Sales in the Redwood User Experience: provides an introduction to the Redwood UX. While many
features have been added and others enhanced, the guide still provides a useful starting point. For users,
there's little difference between Next Gen Sales (Digital Sales) and the new fragments technology which
underlies the latest Redwood Sales.

• Extending Digital Sales (Next Gen Sales) 23D: Use this guide to learn how to extend and configure features in
Next Gen Sales, the older version of Sales in the Redwood user experience. This guide is available only on our
secure site.
If you're on the latest fragments version of Sales, then instead refer to the playbooks on the Oracle Help Center.

How do I enable business objects for Adaptive Search?  
Enabling a business object builds a search index and makes the object available for Redwood Sales Workspace, and
other work areas powered by Adaptive Search. It also makes the object available for Global Search, REST web services,
and Workspace infolets.

Here's how to enable business objects for Adaptive Search.

1. In the Setup and Maintenance work area, open the Configure Adaptive Search task:
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◦ Offering: Sales

◦ Functional Area: Sales Foundation

◦ Show: All Tasks

◦ Task: Configure Adaptive Search

Note:  If this is your first time configuring Adaptive Search, then with the Sales Foundation functional area
selected, click Actions and then select Change Feature Selection from the list. In the Edit Features: Sales
Foundation page, click Enable for Configure Adaptive Search and click Done.

2. On the Configure Adaptive Search page, click the Setup tab.
3. On the Setup tab, Quick subtab, select the objects you want to enable for Adaptive Search:

Enabling an object enables any custom child objects and any custom fields you created. Not all the objects are
sales objects. Partner and Partner Contact are only pertinent for Partner Relationship Management. HR Help
Desk Request, Internal Service Request, and Service Request are specific to Fusion Service. The Case, HR Help
Desk Request, Installed Base Asset, Internal Service Request, Product, Product Group, and Work Order objects
can be enabled for REST web services only.

Note:  Making the selection on the Quick tab enables the default search configuration. Use the Advanced tab
to change search behavior and to enable custom objects.

4. By default, the objects you enable on the Quick subtab are enabled in all the UIs that use Adaptive Search as
well. You can disable objects from appearing in those UIs using the Configure UI and Configure Global Search
tabs, but keep them available for REST web services.

5. Click Publish.

Your action runs an indexing process and an hourly index refresh for the objects you selected. You can monitor
the progress of the indexing process on the Monitor tab. The process can take several minutes to complete,
depending on your data volume.

Note:  You can choose to publish only those objects for which you've changed the configuration. This avoids
having to perform a full publish every time a configuration change is done, thus saving a lot of time.

6. Click the Monitor tab and Publish subtab to monitor the process. If the process completes with errors, contact
your help desk.

How do I remove an icon from the home page for a
particular job role?  
You can remove an icon from the home page and the Navigator for a specific job role by editing its El Expression in the
Structure tool. For example, you can use this method to remove the Analytics icon that was added in release 23D to
Sales in the classic user experience.

Here's how you can configure what shows up in the Navigator and Home page with suggestions on the different El
Expressions you can use to hide items.
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Create and Enter a Sandbox with the Structure Tool
Create and enter a sandbox with the Structure tool:

1. Navigate to Configuration > Sandboxes.
2. Click Create Sandbox.
3. In the Create Sandbox page, enter a name and select Structure as the tool.
4. Click Create and Enter.

The Sandbox toolbar appears at the top of the page.
5. From Tools, select Structure to open the Structure page.

Specify What Users See on the Navigator and in the Springboard
With the Navigation Configuration tab selected, you can configure what appears on the Navigator and springboard.
Just click the item or group name to edit.

• Specify where and for whom the item shows up by making a selection from Show on Navigator and Show
on Springboard. You can choose to display individual items in the Navigator only, in both the Navigator
and springboard, or in neither. You can't display an item in the springboard only. If you hide an item in the
Navigator, it gets automatically hidden on the springboard as well. Here are the options:

◦ Yes: displays the item for all users with the right security permissions.

◦ No: hides the item from all users in all applications.

◦ EL Expression: lets you add an EL Expression that must be true to display the item.

Add EL Expression conditions to display items or groups selectively to users with specific job roles, or
even by user name. Here are some examples of EL Expressions you can use:

Who can see the group or page
entry

EL Expression and Example

Only users having any of the specific
roles
 

#{securityContext.userInRole['<Role_Name>']}

 
#{securityContext.userInRole['ORA_FND_APPLICATION_ADMINISTRATOR_

JOB,ORA_PER_EMPLOYEE_ABSTRACT']}

 

Only users not having any of the
specific roles
 

#{!(securityContext.userInRole['<Role_Name>']}

 
#{!(securityContext.userInRole['ORA_FND_APPLICATION_ADMINISTRATOR_

JOB,ORA_PER_EMPLOYEE_ABSTRACT'])}

 

Only users having all of the specific
roles
 

#{securityContext.userInAllRoles['<Role_Name>']}

 
#{securityContext.userInAllRoles['ORA_FND_APPLICATION_

ADMINISTRATOR_JOB,ORA_PER_EMPLOYEE_ABSTRACT']}

 

Only users not having all of the
specific roles

#{!(securityContext.userInAllRoles['<Role_Name>']}
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Who can see the group or page
entry

EL Expression and Example

 #{!(securityContext.userInAllRoles['ORA_FND_APPLICATION_

ADMINISTRATOR_JOB,ORA_PER_EMPLOYEE_ABSTRACT'])}

 

Only users having access to specific
resources, for example, the Social
work area
 

#{securityContext.userGrantedResource['resourceType=FNDResourceType;resourceName=FND_

Launch_Social_Menu;action=launch']}

 

• Rename a group and change its icon.

• Move items to a different group by using the arrow keys, or by selecting a different group while editing the item.
You can't nest groups within other groups.
For example, move both Workspace items from the Workspace group to the Sales group. There are two
Workspace items because Oracle provides two different versions of Workspace: one for sales and one for
service. Users see only one icon on their home page, depending on their security settings.

• Copy items.

• Move items within a group using the up and down arrow keys.
For example, you may want to move the Workspace icon to be the first icon users see on their page.

• Get rid of the Others group.
Any top-level items (items that aren't part of a group in the Structure tool) display in the Others group in the UI.
You can't rename that category or move it, but you can hide the group by moving or hiding all items in it.

• Create new groups and add your own content.
You can create new groups from the Create menu and display them selectively by adding EL Expressions. You
can copy items into the group or create your own items by selecting Create Page Entry from the Create menu.

Note:  To simplify future functionality updates, don't create groups to provide different views for different
sets of users, however. Add the EL Expressions to individual items instead.

How do I get a list of inactive contacts with no activities
in OTBI so I can delete them?  
You can create the list of contacts in an inactive status with no associated activities using the following SQL query
in Oracle Transactional Business Intelligence (OTBI). You can then use the party IDs in the list to delete the inactive
contacts using Import Management. Import Management doesn't permanently purge the data. To purge the contacts,
you must use the Manage Party Purge Activities task in the Setup and Maintenance work area.

Here's the sample SQL query to get a list of contacts in the Inactive status that don't have any activities associated with
them:

SELECT
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0 s_0,
"Sales - CRM Contacts"."Contact"."Contact Row ID" s_1,
"Sales - CRM Contacts"."Contact"."First Name" s_2,
"Sales - CRM Contacts"."Contact"."Full Name" s_3,
"Sales - CRM Contacts"."Contact"."Last Name" s_4,
"Sales - CRM Contacts"."Contact"."Sales Profile Status" s_5,
"Sales - CRM Contacts"."Contact Fact"."# of Contacts" s_6,
"Sales - CRM Sales Activity"."Activity Facts"."# of Activities" s_7
FROM "Sales - CRM Contacts"
WHERE
(("Sales - CRM Sales Activity"."Activity Facts"."# of Activities" = 0) AND ("Contact"."Sales Profile Status"
 = 'INACTIVE'))
ORDER BY 5 ASC NULLS LAST, 6 ASC NULLS LAST, 2 ASC NULLS LAST, 3 ASC NULLS LAST, 4 ASC NULLS LAST
FETCH FIRST 75001 ROWS ONLY

How come I don't see a custom field in the list landing
page?  
For a custom field to be available in landing pages and searches, you must enable it in Adaptive Search and make sure
you've run the Publish process.

To make a field searchable in work areas powered by Adaptive Search, including Sales in the Redwood user experience,
you must complete these steps using the Configure Adaptive Search task in the Setup and Maintenance work area.:

1. You must make the field searchable for its business object.
2. Optionally, you can enable the field for search of a related object.
3. You must publish your configuration.

For detailed steps, see How do I make a field searchable in the UI?.

How can I map lead qualification assessment data to
custom fields for my lead using Groovy?  
Lead assessment templates enable consistent and predictable assessment for all leads in your sales organization. You
can create a Groovy script to include a Before Insert and a Before Update trigger on the Assessment object to map
qualification assessment data such as question responses, response ratings, or score and so on to custom fields in your
Leads detail page.

The lead qualification templates use the Assessment object and include assessment questions that represent industry
best practices, sales methodologies, or a combination of both. Here's a sample of Groovy code that you can include in
the assessment object to map the lead assessment data to your custom leads

Note:

You'll need to replace the Custom_Lead_field_c and AssessmentQuestionField_c attribute values with values of your
specific custom fields.

********** Update Assessment and Lead Data **********

if(RelatedObjTypeCode == 'LEAD'){
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def vo = newView('Lead')

def vc = vo.createViewCriteria()

def vcr = vc.createRow()

def vcitem = vcr.ensureCriteriaItem('LeadId')

vcitem.setOperator('=')

vcitem.setValue(AssessedObjectId)

vc.insertRow(vcr)

vo.appendViewCriteria(vc)

vo.executeQuery()

if(vo.hasNext()){

 def curRow = vo.next();

 curRow.setAttribute('Custom_Lead_field_c',AssessmentQuestionField_c);

}

}

How come I don't see all of the recurring appointments
in my Sales application when I create them?  
Recurring activities require the Periodic Refresh process to run before they show up. This Adaptive Search indexing
process is set to run every hour, so you see only the initial appointment when you create it. You may have to wait some
time before seeing all of the scheduled appointments in Sales and in CX Sales Mobile.

You can find out when the process runs by checking the Monitor Periodic Refresh tab in the Configure Adaptive Search
setup task in Setup and Maintenance work area:

• Offering: Sales

• Functional Area: Sales Foundation

• Show: All Tasks

• Task: Configure Adaptive Search

If desired, you can change the process schedule.
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How can I email whole dashboards rather than individual
pages in OTBI Agent?  
Create a new agent in Oracle Transactional Business Intelligence (OTBI), point to your dashboard, and select any page.
After you select a dashboard page, the Entire Dashboard  check box appears. By selecting this check box, you can
schedule the delivery of entire dashboards. The email includes one Microsoft Excel file with tabs for each dashboard
page.

How do I capture a .har file?  
You can capture a .har file for troubleshooting an Oracle Redwood session. It's recommended that you use either the
Firefox or the Chrome browser.

Before you start, make sure that only one browser window is open.

See these sections for steps and videos:

• Capture a .har File in the Firefox Browser

• Capture a .har File in the Chrome Browser

Capture a .har File in the Firefox Browser
Here’s what you need to do:

1. Navigate to the UI page where you want to record the .har file.
2. Enable the developer tools by navigating to More tools  >  Web Developer Tools.
3. On the console, click the Network tab.
4. Click the settings icon and make sure the Persist Log option is selected.
5. Click the trash can icon to clear all existing logs shown on the console.
6. Select the activity that you need the .har file for.
7. Click Settings  >  Save All as HAR .

Watch video
 

Capture a .har File in the Chrome Browser
Here’s what you need to do:

1. Navigate to the UI page where you want to record the .har file.
2. Enable the developer tools by navigating to More tools  >  Developer Tools.
3. On the console, click the Network tab.
4. Click the settings icon and make sure the Preserve Log option is selected.
5. Click the cancel icon to clear all existing logs shown on the console.
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6. Select the activity that you need the .har file for.
7. Click the download icon to export the .har file.

Watch video
 

How do I set up the Application Usage Insights
dashboard?  
Use the Application Usage Insights dashboard to view application usage details.

To enable the Application Usage Insights dashboard, you need to ensure that the time zone, calendar, and resource
hierarchy are active. You also have to create the relevant roles and run the required scheduled processes.

See these sections for steps and videos:

• Time Zone, Calendar, and Resource Hierarchy

• Access and Roles

• Application Usage Insights Dashboard

Time Zone, Calendar, and Resource Hierarchy
To view the insights, the site-level calendar should be active, the time zone must be in sync, and the resource directory
enabled.

To check the calendar status:

1. Navigate to Setup and Maintenance.
2. In Sales, search and select for the Manage Calendar Profile Options task.
3. Note the active calendar profile value, for example Oracle_Cal.
4. Go back to Setup and Maintenance.
5. In Sales, search for and select the Manage Accounting Calendars task.
6. Search for the active calendar, for example, Oracle_Cal.
7. Check whether the start date and the end date are up-to-date. If not, add years as needed.
8. Click Save and Close.

To check the time zone sync status:

1. Navigate to Navigator > Tools > Set Preferences.
2. Click Regional under General Preferences.
3. Note the Time Zone.
4. Navigate to Navigator > Tools > Reports and Analytics.
5. Click Browse Catalog.
6. Select Profile > My Account.
7. Confirm that the report time zone matches the previously noted time zone both in Publisher Preferences and

general Preferences. If they are not in sync, select the right time zone in Publisher Preferences.
8. Navigate to Navigator > Tools > Scheduled Processes.
9. Click Schedule New Process and search for and select Refresh Denormalized Time Dimension Table for BI.
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10. Click OK to sync your time zones.

To enable the resource directory:

1. Navigate to Navigator > Others > Resource Directory.
2. If the hierarchy is incorrect, navigate to Resource directory, select Organization Hierarchies, and then search

for Internal Research Organization Hierarchy.
3. Click Edit icon > Actions  > Edit this hierarchy version. Edit the resource hierarchy as needed.
4. Click Done.
5. The Reporting Hierarchy Generation process will be scheduled automatically. You can view its status at

Navigator > Tools > Scheduled Processes.

Watch video
 

Access and Roles
To access the Application Usage Insights dashboard, first you must check whether the User track activity and the Click
History are enabled. Then you must add relevant roles and set the scheduled process parameters.

To check whether User track activity and Click History are enabled:

1. Navigate to Setup and Maintenance.
2. In Sales, search for and select the Manage Administrator Profile Values task.
3. Search for User Session Activity Tracked and make sure the Profile Value is ENABLED.
4. Search for Disable Click History Features and make sure the Profile Value is No.

To add relevant roles:

1. Navigate to Navigator > Tools > Security Console.
2. Enter the Role Code.
3. Click the Role Category drop-down list and select Common Job Roles.
4. Click Next.
5. To create an administrator role with four different function security policies, iterate the steps 6 to 8 for these

function security policies:

◦ View Organization Data in Application Usage Insights UI (only for users with administrative privileges)

◦ Manage Custom Objects in Application Usage Insights (only for users with administrative privileges)

◦ View Application Usage Insights UI

◦ Run Populate Click Description Process

6. Click Add Function Security Policy.
7. Search for and select the relevant roles mentioned in step 5.
8. Click Add Privilege to Role.
9. To access the User Adoption and Click History subject areas, in the Role Hierarchy section, search for and add

User System Usage Transaction Analysis Duty.
10. Click Add Role Membership.
11. Navigate to Users section and click Add User.
12. Search for the user and click Add User to Role.
13. To check the Role status, navigate to Navigator > Tools > Security Console and click the Administration tab.

To run the relevant scheduled processes:

1. Navigate to Navigator > Tools > Scheduled Processes.
2. Click Schedule New Process.
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3. Search for Click History Data Purge Process.
4. Click OK.
5. Click Advanced.
6. Select Using a Schedule.
7. Enter the start date.
8. Click Submit.

Now you’ve completed all the prerequisites to enable Application Usage Insights.

Watch video
 

Application Usage Insights Dashboard
You can use the Application Usage Insights Dashboard to see page views and application usage. The Page Views
tab lets you view insights based on the number of sign-ins and the session duration. You can filter these insights by
Duration, Team Member Names, Roles, and Managers.

Using the Enterprise Visibility filter, you can see enterprise-wide insights. User insights are ranked in a top 30 list based
on clicks and time spent on the page.

In the Application Usage tab, you can view the insights specific to objects such as Activities, Opportunities, and more.
Using the My Organization Visibility filter, you can also export the insights.

Watch video
 

How do I import competitor data?  
You can use Import Management to create or update Competitor records.

To import Competitor records, perform the following tasks:

1. Map your source data to Oracle Applications Cloud object attributes.
2. Create source Comma Separated Values (CSV) file for import.
3. Create the import activity.
4. Review the import results.

How You Map Your Source Data to Object Attributes
To import your Competitor data into Oracle Applications Cloud, you must populate a .csv file with your source data and
map that source data to target object attributes in Oracle Applications Cloud.

You need to do the following before creating the CSV file for data import:

• Identify how your source data attributes map to the target object attributes in Oracle Applications Cloud.

• Ensure prerequisite setups are done, if applicable.

• Understand your options for uniquely identifying the records.

• Ensure parent records exist before importing child records.

• Identify the target object attributes that are required in the CSV file for a successful import.
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Before You Start
You must do some basic checks before starting your import. For example:

• Complete all the prerequisites for importing each attribute in your source data.

• Have all parent records in place before importing child records.

Select a Unique Identifier for Your Records
To import data into Oracle Applications Cloud, your CSV file must include some specific attributes that enable the
import process to uniquely identify the records. The file import process uses the attribute values to automatically map
your source data to the target object attributes in Oracle Applications Cloud.

If you're identifying a record that already exists in Oracle Applications Cloud, then you can use the internal ID of the
record, a system-generated unique identifier attributes with "ID" in the attribute name are typically internal IDs. You can
determine the internal ID of a record by exporting Oracle Applications Cloud object data, or by doing a transactional
database query. Using an internal ID typically provides better performance and reduces the import duration. For the
Competitor object, the attributes are Party Id and Registry Id.

Required Attributes and Validations for the Competitor Object
To import data successfully into Oracle Applications Cloud, your CSV file must include the required attributes. Ensure
that you provide valid values for the attributes. The following table lists the required attributes for importing new
Competitor records, prerequisite setup tasks for the attributes, and specific validations, if any, for Competitor import:

Attribute Description Prerequisite Setup Task/
Import Validations

Creating a Competitor
Record

Updating an Existing
Competitor Record

Organization Name
 

Competitor Name - The
name that identifies the
competitor object
 

Not Applicable
 

Required
 

Conditionally Required
 

Name
 

Competitor Name - The
name that identifies the
competitor object
 

Not Applicable
 

Conditionally Required
 

Conditionally Required
 

Party Type
 

Competitor Party Type -
Type of party record
 

Not Applicable
 

Conditionally Required
 
The default value is
ORGANIZATION.
 

Do not provide a value.
 

Party ID
 

PartyId -The unique ID for
the existing competitor
record.
 

A list of all party IDs is
obtained by exporting the
Competitor object.
 

Do not provide a value.
 

Required
 

Registry ID
 

Registry ID (PartyNumber) -
The public unique identifier
of the Competitor.
 

Not Applicable
 

Do not provide a value.
 

Conditionally Required
 

You can view the Competitor object and attributes in the Manage Import Objects page of the Import Management flow.
You can find attribute information like type, length, description, and so on, on this page.
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Create the Source CSV File
You include the data that you want to import into Sales and Fusion Service in a source CSV file.

You can use the templates available in the Import Objects UI page to create the source CSV file. To download a template:

1. Go to Navigator  > Tools >  Import Management >  Import Objects.
2. Select the Competitor object in the table and click Download.

You can now edit the downloaded file and provide valid values for the required attributes.

Note:  For help in populating the CSV file and to avoid any issues in entering values, see the topic Potential Issues
When Opening CSV Files With Excel in Related Topics section.

Create the Import Activity
After you have the CSV file ready, create an import activity to import the information. To create an import activity:

1. Go to Navigator  > Tools >  Import Management >  Import Queue.
2. Click Create Import Activity in the Manage Imports page.
3. In the Enter Import Options page, provide a name for the import activity, and select Competitor from the

Object drop-down list.
4. Select the CSV file in the File Name field, and click Next.
5. The source and target attributes are automatically mapped in the Map Fields page. Review and edit the

mappings if required.
6. Check the file for unmapped columns or data format issues by clicking Validate Data. Click Next.
7. Review the import details on the Review and Submit page, and click Submit when you're ready.

Review the Import Results
Check if your import succeeded on the Manage Imports page. This page shows the status of all active, completed, and
unsuccessful imports. To check the status of the import activity:

1. Go to Navigator  > Tools >  Import Management >  Import Queue.
2. Click All Imports and search for the import activity that you created earlier.
3. Check the Status column for the import activity. The import is successful if the status displays as Completed.

You can drill down on the import activity to go to the Import Status page which provides the status details of
the import activity.

Related Topics
• How do I import data?

• Potential Issues When Opening CSV Files in Excel

How do I import opportunity competitor data?  
You can use the Import Management to create, update, or delete opportunity competitor records.
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You can import opportunity competitor records using these steps:

1. Map your source opportunity competitor data to Oracle Applications Cloud object attributes. This way the
import process would know where to insert each of the information bits.

2. Create the source CSV file with the opportunity competitor data you want to import.
3. Kick off an import activity.
4. Check the import results to know if the import went well.

How You Map Your Source Data to Target Object Attributes
To import your opportunity competitor data into Oracle Applications Cloud, you must populate a .csv file with your
source data and map that source data to target object attributes in Oracle Applications Cloud.

You must do the following before creating the .csv file for data import:

• Identify how your source data attributes map to the target object attributes in Oracle Applications Cloud.

• Ensure prerequisite steps are complete, such as understanding what attributes are required for importing your
objects.

• Understand your options for uniquely identifying the records.

• Ensure parent records exist before importing child records.

• Identify the target object attributes that are required in the .csv file for a successful import

Before You Start
You must do some basic checks before starting your import. For example, make sure that:

• You have completed all the prerequisites for importing each attribute in your source data.

• You have all parent records in place before importing child records.

Select a Unique Identifier for Your Records
All records must be unique in the application. You can use one of these to identify records:

• Public unique identifiers: If you're creating records, then you can provide an easily understandable public
unique identifier. These are, usually, denoted with 'Number' and visible in the business object's UI. PUID
attributes are usually named <object> Number. If you're updating a record with a Number attribute, then use
the Number attribute to identify the record. For more information about public unique identifiers, see the topic
"How You Use Alternate Keys to Import Records" in Related Topics section.

• Source system and source system reference: Source system is an identifier for the external system, and
source system reference is a unique identifier within the external system. If you're importing new opportunity
competitors or are updating opportunity competitors that have source system reference data, then provide the
source system and source system reference values.

Required Attributes and Validations for Opportunity Competitor Object
To import data successfully into Oracle Applications Cloud, your .csv file must include the required attributes. Ensure
that you provide valid values for the attributes.

This table lists the required attributes for opportunity competitor records, prerequisite setup tasks and specific
validations, if any:
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Attribute Description Prerequisite Setup
Tasks or Import
Validations

Creating an
Opportunity
Competitor Record

Updating an Existing
Opportunity
Competitor Record

Deleting an Existing
Opportunity
Competitor Record

OptyCompetitorId
 

The unique identifier
for Competitors of the
Opportunity, that's
generated by the
application.
 

Not Applicable
 

Do not provide
 

Conditionally Required
 

Conditionally Required
 

OptyId
 

The unique ID
for the existing
opportunity record in
the destination table.
 

You can obtain
the OptyID for an
existing opportunity
by exporting the
Opportunity object
by navigating to the
following in the Setup
and Maintenance work
area:
 

• Offering: Sales

• Functional Area:
Data Import and
Export

• Task: Schedule
Export Processes

Conditionally Required
 
Either OptyId or
OptyNumber is
required.
 

Conditionally Required
 

Conditionally Required
 

OptyNumber
 

The public unique
identifier of the
opportunity.
 

Not applicable.
 

Conditionally Required
 
Either OptyId or
OptyNumber is
required.
 

Conditionally Required
 

Conditionally Required
 

CmptPartyId
 

The party identifier
with competitor party
usage.
 

Not applicable
 

Required
 

Do not provide.
 

Do not provide
 

Go to Navigator  > Tools >  Import Management >  Import Objects, to see all the attributes of the opportunity
competitor object. The page also lists attribute information like type, length, description, and so on.

Create the Source CSV File
You include the data that you want to import into Sales and Fusion Service in a source CSV file.

You can use the templates available in the Import Objects UI page to create the source CSV file. To download a template:

1. Go to Navigator  > Tools >  Import Management >  Import Objects.
2. Select the Opportunity Competitor object in the table and click Download.

You can now edit the downloaded file and provide valid values for the required attributes.

Note:  For help in populating the CSV file and to avoid any issues in entering values, see the topic Potential Issues
When Opening CSV Files With Excel in Related Topics section.
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Create the Import Activity
After you have the CSV file ready, create an import activity to import the opportunity competitor information. To create
an import activity:

1. Go to Navigator  > Tools >  Import Management >  Import Queue.
2. Click Create Import Activity in the Manage Imports page.
3. In the Enter Import Options page, provide a name for the import activity, and select Opportunity Competitor

from the Object drop-down list.
4. Select the CSV file in the File Name field, and click Next.
5. You would see that the source and target attributes are automatically mapped in the Map Fields page. Review

and edit the mappings if required.
6. Check the file for unmapped columns or data format issues by clicking Validate Data. Click Next.
7. Review the import details on the Review and Submit page, and click Submit when you're ready.

Review the Import Results
Check if your import succeeded on the Manage Imports page. This page shows the status of all active, completed, and
unsuccessful imports. To check the status of the import activity:

1. Go to Navigator  > Tools >  Import Management >  Import Queue.
2. Click All Imports and search for the import activity that you created earlier.
3. Check the Status column for the import activity. The import is successful if the status displays as Completed.

You can drill down on the import activity to go to the Import Status page which provides the status details of
the import activity.

Related Topics
• How do I import data?

• How do I update existing setup data?

• Potential Issues When Opening CSV Files in Excel

• How You Use Alternate Keys to Import Records

Can sales administrators view all of the reports created
by others in the Reports and Analytics catalog?  
No. Sales administrators can only view the reports in the Shared folder. They can't view the reports in My Folders of
other users.

What's the impact of increasing the frequency of the
Periodic Refresh process for Adaptive Search in Sales?  
The Periodic Refresh indexing process is set to run every hour. You can increase the frequency without impacting
performance. However, how frequently you can run the process depends on the volume of your data. If you run the
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process every 5 minutes, for example, and it takes the process more than 5 minutes to process the new records, the
process will prevent the next one from running.

How do I back up and restore analyses and reports in the
OTBI catalog?  
As a best practice, you should back up (archive) the entire Oracle Transactional Business Intelligence (OTBI) catalog.
When you do, you can easily restore any folder someone deleted by accident and you can move your content to other
environments. For details, see the topic About Backing Up and Restoring Content.

Can I apply mass updates to retire multiple sales leads at
once?  
No, it isn't possible to retire multiple sales leads at once using the mass update smart action. The Retire action can't be
enabled as a smart action because it uses a method-type action that isn't supported in batch operations.

See How can I act on multiple records at the same time? for more informations about the actions you can apply using
mass updates.

How can I access data from the row picked in the picker? 

To obtain the record name and ID from event.pickedRowsData, use the following:

• event.pickedRowsData["PriceEntry_c.EntryProductName_Id_c"].Id

• event.pickedRowsData["PriceEntry_c.EntryProductName_Id_c"].RecordName

What's Orchestration and how do I enable it?  
Orchestration is a feature that guides salespeople through best sales practices for different sales situations. For
example, through sales orchestration, salespeople are led through each step of a task flow while they're in the
application. The guidance gives them details like which buttons to click and which fields to fill out.

Let's say you might want to provide a series of recommended steps for your sales organization to follow when
qualifying a sales lead or closing deals in opportunities. For each orchestration stage, you can specify what information
the salesperson needs to provide and what actions they need to take during their sales activities. To help them qualify
leads, you can orchestrate the task by specifying the different steps required to take an unqualified lead to different
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statuses: to qualified, to converted, and to retired. The orchestration is divided into orchestration stages, one for each
status. To move an opportunity to the next stage in the sales cycle, you specify what information the salesperson needs
to provide and what actions they need to take at each of the different stages to close the deal.

You can also provide automated steps that take actions behind the scenes and follow up when things don't go as
planned. For example, you can automatically send a follow-up email if a customer doesn't respond when a salesperson
contacts them. Orchestration steps that require salespeople to take action appear on the Guidance panel in opportunity
and lead overviews. The panel gets displayed only if there's an active orchestration running on that particular record. In
addition, the orchestration creates tasks and appointments to go along with the steps.

For more information, see Enable the Orchestration Feature in the How do I get started with Orchestration? solution
playbook on the Oracle Help Center Sales > Playbooks page.

Can I remove the Add button to prevent adding account
addresses?  
Unfortunately, the Addresses region in the Edit Accounts page in classic Sales isn't extensible. However, you have a
couple of other options to prevent users from adding account addresses.

Option 1: Remove the Manage Address Privilege from Role
Even though you can't remove the Add button using Oracle's configuration tools, you can remove the privilege, Manage
Address, from users' roles. Users without the Manage Address privilege have read-only access to addresses. See How do
I edit job or abstract roles? for more information.

Option 2: Use Single Address Region in the Edit Accounts Page
There's another option as well. You can disable the multiple addresses region and enable the single address region
instead. This will remove the Add button, because then only one address can be displayed in the Edit Accounts region.
See How can I enable multiple addresses for accounts? for more information.

How do I edit job or abstract roles?  
To edit user roles, you always create a custom role by copying a predefined job role or abstract role and then editing the
copy.

Note:  You must have the IT Security Manager job role to perform these security tasks.

High-Level Steps to Copy and Edit Predefined Roles
Here are the high-level steps to copy and edit predefined job and abstract roles.
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CAUTION:  While creating custom roles, make sure you assign only the required privileges. Assigning all the privileges
could impact license usage. Before you proceed, see the topic, What should I know about copying and editing
predefined roles?

1. Copy a Role
2. Edit the Copied Role
3. Add or Remove Existing Functional Security Privileges for the Role
4. Manage Data Security Policies for the Role
5. Add or Remove Roles That the New Role Inherited
6. Assign the New Role to Users
7. Review the Role

Copy a Role
To copy a job or abstract role:

1. On the Roles tab of the Security Console, search for the role to copy.
2. Select the role in the search results. The role hierarchy appears in tabular format by default.

Tip:  Click the Show Graph icon to show the hierarchy in graphical format.

3. In the search results, click the down arrow for the selected role and select Copy Role.
4. In the Copy Options dialog box, select a copy option.
5. Click Copy Role.
6. On the Copy Role: Basic Information page, review and edit this information as appropriate:

◦ Role Name

◦ Role Code

◦ Description

◦ Enable Role for Access from All IP Addresses (appears only if location-based access is enabled)

Tip:  The role name and code have the default prefix and suffix for copied roles specified on the Roles subtab
of the Security Console Administration tab. You can overwrite these values for the role that you're copying.
However, any roles inherited by the copied role are unaffected by any name changes that you make here.

7. Click the Summary and Impact Report train stop.
8. Click Submit and Close, then OK to close the confirmation message.
9. Review the progress of your copy on the Role Copy Status subtab of the Security Console Administration tab.

Once the status is Complete, you can edit the copied role.

Edit the Copied Role
Edit the copy of the job or abstract role:

1. On the Roles tab of the Security Console, search for and select the role.
2. In the search results, click the down arrow for the selected role and select Edit Role.
3. On the Edit Role: Basic Information page, you can edit the role name and description, but not the role code. If

location-based access is enabled, then you can also manage the Enable Role for Access from All IP Addresses
option.

4. Click Next.
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Add or Remove Existing Functional Security Privileges for the Role
On the Edit Role: Function Security Policies page, any function security privileges granted directly to the copied role
appear on the Privileges tab. Click Load Inherited Policies to populate the table with the privileges that the role
inherited.

To view details of the code resources that a privilege secures, select the privilege in the Details section of the page.

You can add or remove existing privileges from the copied role. To delete a privilege that's added directly to the copied
role, select the privilege and click the Delete icon.

Note:  You can't delete inherited privileges. And, you can't create new functional security policies.

To add a privilege to the copied role:

1. Click Add Function Security Policy.
2. In the Add Function Security Policy dialog box, search for and select a privilege or role.
3. If you select a role, then click Add Selected Privileges to add all function security privileges from the role to

your custom role. If you select a single privilege, then click Add Privilege to Role.
4. Click OK to close the confirmation message.
5. Repeat to add more privileges.
6. Close the Add Function Security Policy dialog box.

All the privileges you selected are listed on the Edit Role: Function Security Policies page.
7. Click Next.

The Resources tab, which is read-only, lists any resources granted to the role directly rather than through function
security privileges. Because you can't grant resources directly to roles on the Security Console, only resource grants
created before Release 12 could appear on this tab. You can't edit these values.

Manage Data Security Policies for the Role
On the Edit Role: Data Security Policies page, any data security policies granted to the copied role appear. You can add
or remove policies from the copied role and you can edit the existing policies.

Click Next to continue to the next page.

Add or Remove Roles That the New Role Inherited
The Edit Role: Role Hierarchy page shows the copied role and its inherited duty roles. The hierarchy is in tabular format
by default but you can switch to graphical mode. You can add or remove roles.

To remove a role:

1. Select the role in the table.
2. Click the Delete icon.
3. Click OK to close the confirmation message.

To add a role:

1. Click the Add Role icon.
2. In the Add Role Membership dialog box, search for and select the role to add.
3. Click Add Role Membership.
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4. Click OK to close the confirmation message.
5. Repeat for other roles.
6. Close the Add Role Membership dialog box.

The Edit Role: Role Hierarchy page shows the updated role hierarchy.
7. Click Next.

Assign the New Role to Users
On the Edit Role: Users page assign the copied role to a user by adding or removing user access to the role.

Add user access to a role:

1. Click the Add User button.
2. In the Add User dialog box, search for and select a user or role (job or abstract role).
3. If you select a role, then click Add Selected Users to add all the users assigned the role to your custom role. If

you select a single user, then click Add User to Role.
4. Click OK to close the confirmation message.
5. Repeat from step 2 for additional users.
6. Close the Add User dialog box.

The Edit Role: User page shows the updated role membership.
7. Click Next.

To remove user access to a role:

1. Select the user in the table.
2. Click the Delete icon.
3. Click OK to close the confirmation message.

Review the Role
On the Edit Role: Summary and Impact Report page, review the summary of changes. Then do the following:

1. Click Back to make corrections.
2. When you've completed any changes, click Save and Close to save the role.
3. Click OK to close the confirmation message.

The role is available immediately.

What should I know about copying and editing
predefined roles?  
Copying predefined roles and editing the copies is the recommended approach to creating roles for your own business
purposes. This recommended approach comes with some guidelines you should be aware of.

Note:  You can copy the predefined roles but can't edit them. Predefined roles have role codes with the prefix ORA_.
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Options When Copying Roles
When you copy a role using the Security Console, you can:

• Copy the top role only (shallow copy); or,

• Copy the top role and its inherited roles (deep copy)

Copying the Top Role

If you select the Copy top role option, you copy only the role you have selected. The source role has links to roles in its
hierarchy, and the copy inherits links to the original versions of those roles. Subsequent changes to the inherited roles
affect not only the source top role, but also your copy. The result of selecting the Copy top role option, therefore, is as
follows:

• You can add roles directly to the copied role without affecting the source role.

• You can remove any role that's inherited directly by the copied role without affecting the source role.

• If you remove any role that's inherited indirectly by the copied role, then the removal affects both the copied
role and any other role that inherits the removed role's parent role, including the source role.

• If you edit any inherited role, then the changes affect any role that inherits the edited role. The changes aren't
limited to the copied role.

To edit the inherited roles without affecting other roles, you must first make copies of those inherited roles. You
can either select the Copy top role and inherited roles option or copy individual inherited roles separately, edit
the copies, and use them to replace the existing versions.

Copying the Top Role and Inherited Roles

If you select the Copy top role and inherited roles option, you copy not only the role you have selected, but also all of
the roles in its hierarchy. Your copy of the top role is connected to new copies of subordinate roles.

Note:  Inherited duty roles are copied if a copy of the role with the same name doesn't already exist. Otherwise, the
copied role inherits links to the existing copies of the duty roles.

When inherited duty roles are copied, you can edit them without affecting other roles. Equally, changes made
subsequently to duty roles in the source role hierarchy aren't reflected in the copied role.

Review the Role Hierarchy
When you copy a predefined job, abstract or duty role, it's recommended that you first review the role hierarchy to
identify any inherited roles that you want to either copy, add, or delete in your custom role. You can review the role
hierarchy on the Roles tab of the Security Console in either graphical or tabular format. You can also:

• Export the role hierarchy to a spreadsheet from the Roles tab.

• Review the role hierarchy and export it to a spreadsheet from the Analytics tab.

• Run the User and Role Access Audit Report.

Job and abstract roles inherit function security privileges and data security policies from the roles that they inherit.
Function security privileges and data security policies can also be granted directly to a job or abstract role. Review these
directly granted privileges on the Roles tab of the Security Console, as follows:

• In the graphical view of a role, its inherited roles and function security privileges are visible at the same time.
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• In the tabular view, you set the Show value to switch between roles and function security privileges. You can
export either view to a spreadsheet.

Once your custom role exists, edit it to add or remove directly granted function security privileges.

Note:  Data security policies are visible only when you edit your role; they don't display in the graphical or tabular
role views. However, you can view the data security policies assigned to a role from the Analytics tab of the Security
Console.

Guidelines When Naming Copied Roles
By default, a copied role has the same name as its source role with the suffix Custom. The role codes of copied roles
have the suffix _CUSTOM. Copied roles lose the prefix ORA_ automatically from their role codes. You can define a
local naming convention for custom roles, with a prefix, suffix, or both, on the Roles subtab of the Security Console
Administration tab.

Note:  Copied roles take their naming pattern from the default values specified on the Roles subtab of the Security
Console Administration tab. You can override this pattern on the Copy Role: Basic Information page for the role that
you're copying. However, the names of roles inherited by the copied role are unaffected. For example, if you perform
a deep copy of the Employee role, then duty roles inherited by that role take their naming pattern from the default
values.

If any role in the hierarchy already exists when you copy a role, then no copy of that role is made. For example, if you
make a second copy of the Employee role, then copies of the inherited duty roles might already exist. In this case, the
copied role inherits links to the existing copies of the roles. To create unique copies of inherited roles, you must enter
unique values on the Administration tab of the Security Console before you perform a deep copy. To retain links to the
predefined job or abstract role hierarchy, perform a shallow copy of the predefined role.

Copying Roles and Access Groups
When you copy a job role, a custom job role is created that includes the same duty roles and the same function and
data security policies as the original role. A system access group is also generated for the custom job role, but it isn't
assigned any object sharing rules.

To provide your users with data access using the access group generated for the custom role, you must either add rules
to the group manually, or copy the rules from the access group generated for the source role you copied, then edit the
rules as required. For additional information, see the topics Overview of Managing System Access Groups and Copy
Object Sharing Rules from One Access Group to Another in the Access Groups chapter.

Report and Analytics Roles
You can't copy roles that are used to secure sales analytics and reports. Therefore you can't copy any of the following
types of roles:

• Transaction Analysis Duty roles

• Business Intelligence roles

• Any role with a role code prefix of OBIA, for example, OBIA_ANALYSIS_GENERIC_DUTY

You can, however, add any of these roles to custom job roles that you create. When you create a custom job role, either
from scratch or by copying an existing job role and editing it, make sure that the role is assigned the BI Consumer role
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and BI Author role if the custom role is to provide access to analyses and reports. The BI Consumer role provides view-
only access to analyses and reports; the BI Author role provides access to create and edit analyses and reports.

How do I capture and claim expenses in Partner
Relationship Management?  
You can capture and claim marketing expenses in Partner Relationship Management using the Marketing Development
Funds functionality. Here is how you can go about it:

• MDF Budgets: Create and manage MDF budgets that you can use to track funds used for channel marketing
activities that your partners carry out. You can also create budgets exclusively for a specific partner. Manage
fund requests and claims associated with the marketing budget.

• MDF Requests: You can use this functionality to request funds, which can be allocated from marketing budgets,
to implement strategic marketing activities.

• MDF Claims: You can use this functionality to submit claims seeking reimbursement for the marketing expense
incurred. It helps you track the progress of claims from submission to payment. You can approve, reject, return,
or withdraw a claim as required. You can also view all the claims submitted by partner users or create and
submit claims against any approved request yourself on behalf of a partner.

• MDF Claim Settlements: You can track the progress of your claim payment and capture your claim payment
information.

How can I view the Parent and Ultimate Parent account
fields in Workspace and Redwood UX?  
If you want the Parent and Ultimate Parent fields to be displayed in the UI, either as a filter or as a column in search
results, then you must first enable them on the Setup tab of the Configure Adaptive Search page and run the Publish
job. Make sure to enable the fields for display also on the Configure UI tab. See How do I make a field searchable in the
UI? for more information about how to do this.

Once the fields are enabled for display, you must run the Refresh Denormalized Data for Account Hierarchy
scheduled processes to refresh the denormalized data for the account hierarchy. This scheduled process is used to
update and organize the information about accounts. For more information about how to run this process, see How do I
refresh denormalized data for account hierarchy?

When the Refresh Denormalized Data for Account Hierarchy job completes, run the Periodic Refresh scheduled
processes. When the process completes, the values for the Parent and Ultimate Parent account fields are displayed in
the account hierarchy for both Workspace and Sales in the Redwood user experience.
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Are there any tools that automate migration of pages
and layouts to Redwood Sales?  
No. While Application Composer continues to be the tool for defining fields and objects, you must use Oracle CX
Extension Generator and Oracle Visual Builder Studio to recreate custom UI pages for Sales in the Redwood user
experience. The CX Extension Generator helps to speed up the migration by automating many of the UI creation steps.

Related Topics
• Create a New Application Using the CX Extension Generator

How do I import account contact data?  
You can use Import Management to create update, or delete Account Contact records as child under Account object.
This automatically also creates relationship record, associating referenced contact and account which can be viewed
under relationship child object.

To import Account Contact records, perform the following tasks:

1. Map your source data to Oracle Applications Cloud object attributes.
2. Create source Comma Separated Values (CSV) file for import.
3. Create the import activity.
4. Review the import results.

How You Map Your Source Data to Target Object Attributes
To import your Account Contact data into Oracle Applications Cloud, you need to populate a CSV file with your source
data and map that source data to target object attributes in Oracle Applications Cloud.

You need to do the following before creating the CSV file for data import:

• Identify how your source data attributes map to the target object attributes in Oracle Applications Cloud.

• Ensure prerequisite setups are done, if applicable.

• Understand your options for uniquely identifying the records.

• Ensure parent records exist before importing child records.

• Identify the target object attributes that are required in the CSV file for a successful import.

Before You Start
You must do some basic checks before starting your import. For example, make sure that:

• You have completed all the prerequisites for importing each attribute in your source data.

• You have all parent or referenced records in place before importing child records.
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Select a Unique Identifier for Your Records
All records must be unique in the application. You can import account contact object by submitting any one or more
of the conditionally required attributes. You can provide a combination of Account and Contact identifiers for create
and update. Alternatively for Update scenario, you can provide the primary unique identifier or one of the relationship
identifiers.

List of Contact Identifiers:

• ContactPartyId

• ContactPartyNumber

• ContactSourceSystem and ContactSourceSystemReferenceValue

List of Account Identifiers:

• AccountPartyId

• AccountPartyNumber

• AccountSourceSystem and AccountSourceSystemReferenceValue

List of Relationship Identifier:

• RelationshipRecId

• RelationshipSourceSystem and RelationshipSourceSystemReferenceValue

Primary unique identifier: AccountContactId is the primary unique identifier which is auto generated. You can use this
identifier to update account contact record.

Required Attributes and Validations for Account Contact Object
To import data successfully into Oracle Applications Cloud, your CSV file must include the required attributes. Ensure
that you provide valid values for the attributes. This table lists the required attributes for importing new Account
Contact records, required attributes for updating Account Contact records, prerequisite setup tasks for the attributes,
and specific validations, if any, for Account Contact import:

Attribute Description Prerequisite Setup Task/
Import Validations

Creating an Account
Contact Record

Updating an Existing
Account Contact Record

AccountContactId
 

The unique identifier of the
account contact which is
system generated.
 

Should be a valid value
which exists in the
application
 

Not Applicable
 

Conditionally Required
 

RelationshipRecId
 

Alternate unique identifier
for the account contact
which is system generated.
 

Should be a valid value
which exists in the
application
 

Not Applicable
 

Conditionally required
 

ContactPartyId
 

The primary key identifier
of the subject in this
relationship. Either
one of ContactPartyId,
 ContactPartyNumber,
 or a combination of
ContactSourceSystem and

The contact must exist
 

Conditionally Required
 
Provide a value along
with Account identifier
to uniquely identify
referenced account and

Conditionally Required
 
Provide a value along
with Account identifier to
uniquely identify account
contact record for update
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Attribute Description Prerequisite Setup Task/
Import Validations

Creating an Account
Contact Record

Updating an Existing
Account Contact Record

ContactSourceSystemReferenceValue,
 is used to identify the
subject party of the
relationship.
 

contact records to create
account contact record
 

ContactPartyNumber
 

The public key identifier
for the Contact party of
the relationship. Either
one of ContactPartyId,
 ContactPartyNumber,
 or a combination of
ContactSourceSystem and
ContactSourceSystemReferenceValue,
 is used to identify the
Contact party of the
relationship.
 

The contact must exist
 

Conditionally Required
 
Provide a value along
with Account identifier
to uniquely identify
referenced account and
contact records to create
account contact record
 

Conditionally Required
 
Provide a value along
with Account identifier to
uniquely identify account
contact record for update
 

ContactSourceSystem
 

The name of external
source system for the
subject party in the
relationship, which are
defined by an administrator
as part of system setup. To
be used in combination of
ContactSourceSystemReferenceValue.
 

The value for this attribute
should be predefined using
the setup task Manage
Trading Community Source
Systems
 

Conditionally Required
 
Provide a value along with
ContactSourceSystemReferenceValue
for uniquely identifying a
contact record
 
Additionally, provide an
Account Identifier
 

Conditionally Required
 
Provide a value along with
ContactSourceSystemReferenceValue
for uniquely identifying a
contact record
 
Additionally, provide an
Account Identifier
 

ContactSourceSystemReferenceValue
 

The identifier for the
subject party in the
relationship from external
source system. To be
used in combination with
ContactSourceSystem.
 

The Source System
Reference value should
exists for the Contact
 

Conditionally Required
 
Provide a value along with
ContactSourceSystem
for uniquely identifying a
contact record
 
Additionally, provide an
account identifier
 

Conditionally Required
 
Provide a value along with
ContactSourceSystem
for uniquely identifying a
contact record
 
Additionally, provide an
account identifier
 

AccountPartyId
 

The primary key identifier
of the object in this
relationship. Either
one of AccountPartyId,
 AccountPartyNumber,
 or combination of
AccountSourceSystem and
AccountSourceSystemReferenceValue,
 is used to identify the
Account party of the
relationship.
 

The Source System
Reference value should
exists for the Contact
 

Conditionally Required
 
Provide a value along
with Contact identifier
to uniquely identify
referenced account and
contact records to create
account contact record
 

Conditionally Required
 
Provide a value along
with Contact identifier to
uniquely identify account
contact record for update
 

AccountPartyNumber
 

The public unique
identification number
for the object party of
the relationship Either
one of AccountPartyId,
 AccountPartyNumber
or combination of
AccountSourceSystem and

No Validation
 

Conditionally Required
 
Provide a value along
with Contact identifier
to uniquely identify
referenced account and
contact records to create
account contact record

Conditionally Required
 
Provide a value along
with Contact identifier to
uniquely identify account
contact record for update
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Attribute Description Prerequisite Setup Task/
Import Validations

Creating an Account
Contact Record

Updating an Existing
Account Contact Record

AccountSourceSystemReferenceValue,
 is used to identify the
Account party of the
relationship.
 

 

AccountSourceSystem
 

The name of external
source system for the
subject party in the
relationship, which
are defined by an
administrator as part
of system setup. To be
used in combination with
AccountSourceSystemReferenceValue.
 

The value for this attribute
should be predefined using
the setup task Manage
Trading Community Source
Systems
 

Conditionally Required
 
Provide a value along with
AccountSourceSystemReferenceValue
for uniquely identifying an
account record
 
Additionally, provide a
contact identifier
 

Conditionally Required
 
Provide a value along with
AccountSourceSystemReferenceValue
for uniquely identifying an
account record
 
Additionally, provide a
contact identifier
 

AccountSourceSystemReferenceValue
 

The name of external
source system for the
subject party in the
relationship, which are
defined by an administrator
as part of system setup.
To be used in combination
with AccountSourceSystem.
 

The Source System
Reference value should
exist for the Account
 

Conditionally Required
 
Provide a value along with
AccountSourceSystem for
uniquely identifying an
account record
 
Additionally, provide a
contact identifier
 

Conditionally Required
 
Provide a value along with
AccountSourceSystem for
uniquely identifying an
account record
 
Additionally, provide a
contact identifier
 

RelationshipSourceSystem
 

The name of external
source system for the
relationship record,
 which are defined by
an administrator as part
of system setup. To be
used in combination with
RelationshipSourceSystemReferenceValue.
 

The value for this attribute
should be predefined using
the setup task Manage
Trading Community Source
Systems
 

Optionally Required
 

Conditionally Required for
uniquely identifying an
account contact record
 
Additionally,
 provide a value for
RelationshipSourceSystemReferenceValue
 

RelationshipSourceSystemReferenceValue
 

The name of external
source system for the
relationship record,
 which are defined by
an administrator as part
of system setup. To be
used in combination with
RelationshipSourceSystem.
 

The Source System
Reference value should
exists for the Contact.
 

Optionally Required
 

Conditionally Required for
uniquely identifying an
account contact record
 
Additionally
provide a value for
RelationshipSourceSystem
 

You can view the Account Contact object and its attributes in the Manage Import Objects page of the Import
Management flow. You can find attribute information like type, length, description, and so on, on this page.

Create the Source CSV File
You include the data that you want to import into Sales and Fusion Service in a source CSV file.

You can use the templates available in the Import Objects UI page to create the source CSV file. To download a template:

1. Go to Navigator  > Tools >  Import Management >  Import Objects.
2. Select the Account Contact object in the table and click Download.
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You can now edit the downloaded file and provide valid values for the required attributes.

Note:  For help in populating the CSV file and to avoid any issues in entering values, see the topic Potential Issues
When Opening CSV Files With Excel in Related Topics section.

Create the Import Activity
After you have the CSV file ready, create an import activity to import the information. To create an import activity:

1. Go to Navigator  > Tools >  Import Management >  Import Queue.
2. Click Create Import Activity in the Manage Imports page.
3. In the Enter Import Options page, provide a name for the import activity, and select Account Contact from the

Object drop-down list.
4. Select the CSV file in the File Name field, and click Next.
5. You would see that the source and target attributes are automatically mapped in the Map Fields page. Review

and edit the mappings if required.
6. Check the file for unmapped columns or data format issues by clicking Validate Data. Click Next.
7. Review the import details on the Review and Submit page, and click Submit when you're ready.

Review the Import Results
Check if your import succeeded on the Manage Imports page. This page shows the status of all active, completed, and
unsuccessful imports. To check the status of the import activity:

1. Go to Navigator  > Tools >  Import Management >  Import Queue.
2. Click All Imports and search for the import activity that you created earlier.
3. Check the Status column for the import activity. The import is successful if the status displays as Completed.

You can drill down on the import activity to go to the Import Status page which provides the status details of
the import activity.

Related Topics
• How do I import data?

• Potential Issues When Opening CSV Files in Excel

• How You Use Alternate Keys to Import Records

Is inline editing of records available from Workspace?  
No. Inline editing is available only in the legacy work areas. Workspace, which uses the Adaptive Search engine,
currently doesn't support inline editing for records displayed in Workspace list pages.
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Is there a limit to the number of leads that I can create in
my sales application?  
There's no threshold limit or maximum number of records that you can create in your sales application for your Sales
Lead object.

Can I view orchestration steps from my lead and
opportunity guidance panels?  
Yes. Each orchestration step that requires you to take an action appears at the top of the Guidance panel for opportunity
and lead overview pages. Note that the Guidance panel gets displayed only if there's an active orchestration running on
the specific lead or opportunity records that you're viewing.

For more information, see How Salespeople Interact with Orchestrations in the How do I get started with Orchestration?
solution playbook on the Oracle Help Center Sales > Playbooks page.

How do I automatically populate a field value based on
another field value without using a picker in Redwood
Sales?  
You can add an on-picker-value-changed="" and set up a listener as the value. Pass in the raw event. The payload in your
action chain of event.detail.event.detail.value (or .previousValue) will give you the key of the cx-picker DCL. Note the
double event.detail is required because this event wraps an oj-select-single event.

How do I configure the Edit Details page for accounts in
Redwood Sales?  
Drill in to an account record, click Details to display the Edit Details page, and edit the page in Oracle Visual Builder
Studio. For detailed steps, see the topic Configure the Create and Edit Layouts.
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How do I change the text of a warning message in
Redwood Sales?  
You can use the User Interface Text tool to change the text of warning, error, and confirmation messages and text in the
UI . For details, see the topic Modify Text Using User Interface Text Tool.

Can I remove the currency symbols from the opportunity
amounts listed in Workspace?  
No, the currency symbols that show up in the lists of opportunities in Workspace are hard-wired, so you can't remove
them. However, you could create a custom field for the currency amounts and display that instead.

How do I enable multiple currencies in Sales?  
Oracle Sales objects like opportunities and leads support multiple currencies.

This table has the high-level steps to set up multiple currencies in sales:

Step Description Where to Find More Information

Set the default currency profile options. Set the two profile options that specify default
corporate currency and rate type.

See: Set Default Currency Profile Options

Check the setting of the default currency profile
option.

Check the setting of the default currency profile
option. This currency is the default used for
salespeople in the transactional pages. The
default currency is also used in a salesperson's
forecast.

See: Check Default Currency Profile Option
Setting

Ensure currencies are enabled and verify
precision.

Ensure that all of the currencies you plan to use
are enabled for use and verify the precision.

See: Ensure Currencies are Enabled and Verify
Precision

Set the multicurrency profile option for
opportunities.

By default, one currency is set for an
opportunity and its product lines. This default
currency is a salesperson's preferred currency.
If you want to enable multiple currencies for
opportunities, set the multicurrency profile
option.

See: How do I allow salespeople select a
different currency in Opportunities and Leads?

Let salespeople select the currency when
editing leads and opportunities.

In the opportunity and lead edit pages, the
Currency list of values is read-only by default.
If you've enabled multiple currencies, you can
let users pick a different currency at the header
level by making the Currency field editable.

See: How do I allow salespeople select a
different currency in Opportunities and Leads?
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Step Description Where to Find More Information

Enter currency daily rates. To load daily rates, you can use a spreadsheet
or web services.
 

See: Load Daily Rates Automatically Using Web
Services

Define and maintain daily currency conversion
rates and conversion rate types.

The conversion rate is the ratio between two
currencies; it shows how much of one money
exchanges for another. Conversion rates are
also known as foreign exchange rates. You
define and maintain different conversion rates
between currencies for the same period using
conversion rate types.
 

See: Enter Daily Rates Using the Daily Rates
Spreadsheet

Set Default Currency Profile Options
Your first step in the setup is to specify the default corporate currency and rate type by setting the Corporate Currency
Default and Exchange Rate Type Default profile options.

Here's how you set the profile options:

1. As a setup user, in Setup and Maintenance, go to:
◦ Offering: Sales

◦ Functional Area: Company Profile

◦ Task: Manage Currency Profile Options

2. On the Manage Currency Profile Options page, click ZCA_COMMON_CORPORATE_CURRENCY and set it to
your default corporate currency. The display name for this profile option is Corporate Currency Default. It stores
configured corporate currency used across the applications.

3. Save your changes.
4. Click ZCA_COMMON_RATE_TYPE and set it to the default currency rate type. The display name for this profile

option is Exchange Rate Type Default. It stores the default currency exchange rate type.

Check Default Currency Profile Option Setting
You also need to check the setting of the profile option that specifies default currency for users in the applications. The
profile option, Default Currency (FND_CURRENCY), not only specifies the default currency in the transactional pages, it's
also used in a salesperson's forecast. By default, the profile option is set to US dollar. You can set this profile option at
site level (affecting all users of the environment), at product level, or at user level.

Note:  Users can set their own currency preference in the Personalization screens available in the user name menu
in the global header. The setting users set for themselves override the settings that you make in the profile options
screens at site or product level.

Here's how to check the default currency setting:

1. In the Sales offering, go to:
◦ Functional Area: Sales Foundation

◦ Task: Manage Administrator Profile Values

Note:  If you can't find this profile option, search for it from the main Sales offering page, using the
search available in the Tasks widget available in the collapsed panel on the page.
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2. On the Manage Applications Core Administrator Profile Values page, search for and select the profile option
name, Default Currency, or the code, FND_CURRENCY.

3. Ensure the profile option value is set to your environment's default currency at site level.

To set the profile option for a specific user, create a new row in the table and enter the values as needed.

Ensure Currencies are Enabled and Verify Precision
By default, all currencies are enabled. But it's a good idea to double-check that all of the currencies you plan to use are
enabled and that their precision levels are set correctly. Precision is the number of digits placed after the decimal point.
For example, set USD to precision 2 to display one dollar as $1.00 in the UI.

Here's how to check:

1. In the Sales offering, go to:

◦ Functional Area: Company Profile

◦ Task: Manage Currencies

2. On the Manage Currencies page, click Search to search for all currencies, without entering any search criteria.
3. Check that the Enabled option is set for each currency you plan to use.
4. Check that the Precision is set consistently for each currency you plan to use.

Note:  When setting currency precision, be sure to set it correctly for all currencies you plan to use. This best
practice ensures that decimal places are shown consistently in the UI for all the currencies you're using.

5. If you made any changes, save your work.

Overview of Defining Daily Currency Conversion Rates
You have a few options for defining daily currency conversion rates, and you can maintain daily currency conversion
rates between any two currencies. You can also enter daily conversion rates for specific combinations of foreign
currency, date, and conversion rate type. The ways you can load currency rates are:

• Load them manually using the Create Daily Rates spreadsheet.

• Load them automatically using web services.

For more information, see the related topics.

Related Topics
• Enter Daily Rates Using the Daily Rates Spreadsheet

• Load Daily Rates Automatically Using Web Services

How do I allow salespeople select a different currency in
Opportunities and Leads?  
For salespeople to be able to select a different currency in opportunities and leads, you must make the field editable. By
default, the currency selection field isn't editable for leads and opportunities.
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Here's how to make the currency field editable:

1. Ensure you're working in an active sandbox.
2. Navigate to Configuration > Application Composer.
3. In the navigation tree, expand Standard Objects, expand Opportunity or Sales Leads, and click Pages.
4. In the region that corresponds to the page you're modifying, duplicate the standard layout and edit the

resulting layout. For example, if you're making the field editable in opportunities, in the Creation Page Layout
region, duplicate the standard layout and then edit the resulting layout.

5. Select the newly created layout, click Actions and then click Edit UI Properties from the drop-down list.
6. Select Currency from the Field Selection drop-down list.
7. Select the custom layout in the Layout Properties section.
8. Click Update.
9. Select the Updatable option.

10. Click Submit.
11. Click Done on the Edit UI Properties: Creation Layout window and save your changes.
12. While still in the active sandbox, navigate to Sales > Opportunities or Sales > Leads as a user who's a sales

resource, such as a sales administrator or sales representative. Verify the change by editing an opportunity or
lead and validating that the Currency field is a drop-down list that users can select.

13. Publish the sandbox according to your company's business practices.
You can find more information on configuring lead and opportunity pages in the related topics.

How do I set up Visual Builder Studio (VBS) so I can use it
to extend my Sales application?  
Follow the instructions in the topic Before You Create an Application Extension topic in the Sales playbook How do I
create an application extension for custom objects in Oracle Visual Builder Studio?

Additional information is available in the Set Up VB Studio to Extend Oracle Cloud Applications section of the Oracle
Cloud Infrastructure documentation.

How do I enable Opportunity and Lead activity
configurations for Orchestration?  
You must first enable the orchestration feature by setting the profile option Enable Orchestration
(ORA_ZCA_ENABLE_ORCHESTRATION) to Yes at the site, lead, and opportunity management levels. If you're already
using Activities (the Activity Stream), then you must enable certain attributes to work with Orchestration.

Note:  If you're new to Sales in the Redwood user experience and you created and activated activities configurations,
then no further action is required.

If you haven't created your own activity configurations for sales leads and opportunities, then see How to Enable
Orchestration If You Haven't Created Custom Activity Configurations in the How do I get started with Orchestration?
solution playbook on the Oracle Help Center Sales > Playbooks page for more information.
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If you've created custom activity configurations for sales leads and opportunities, then you must edit your active
configurations for both objects and enable options for attributes related to Orchestration. The settings for both Sales
Lead and Opportunity objects are identical. See the related topics for more information.

Related Topics
• Enable the Orchestration feature

• Enable Opportunity and Lead Activity Configurations for Orchestration

Why can't I convert a lead to an opportunity?  
Only standard roles for the lead owner or sales administratator can convert leads to opportunities. In addition, lead to
opportunity conversion depends on the privileges assigned to your role, your access level as a lead sales team member,
and the current status of the lead.

You can convert a lead to an opportunity from the Actions menu by selecting Convert. This action creates an
opportunity based on lead information. When a lead is converted to an opportunity, the lead status is set to Converted.

Note:  Your administrator can assign the Convert Sales Lead (MKL_CONVERT_SALES_LEAD_PRIV) functional
privilege and the Sales Lead Follow Up (ORA_MKL_SALES_LEAD_FOLLOW_UP_DUTY) roles to users who aren't lead
owners but need to convert leads to opportunities. See the Data Sharing Mechanisms and Object Visibility chapter of
the Securing Sales and Fusion Service guide on Oracle Help Center (https://docs.oracle.com).

After creating the custom role, run the following scheduled processes from Navigator > Tools > Scheduled Processes.

• Retrieve Latest LDAP Changes

• Send Pending LDAP Requests

• Import User and Role Application Security Data

• Synchronize User GUID

After all the jobs run successfully, test by converting a lead to an opportinity from your sales leads UI.

How do I export data?  
You can export your object data using the Export Management option from the Tools work area. This topic is your guide
to exporting data.

You can find the list of objects supported in Export Management in How do I manage export objects?

To export data:

1. Click Tools > Export Management.
2. On the Manage Exports page, click the Create Export Activity button.
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3. On the Enter Export Options page, enter values for each of the following fields:

Field Description of the value

Name
 

The name of the export activity.
 

Object
 

The object to export. You must select the parent or child object from the drop-down list.
 
If you can't find an object in the drop-down list, then click the Search link. In the Search and
Select dialog box, enter the object name in the Object text box and click the Search button.
Select your object from the result list and click OK.
 
You can also use the advanced search option by clicking the Advanced button. Here you can
search based on various filter criteria such as object name, attachment supported, creation
date, and so on.
 

Note:
If the object you're exporting isn't listed then verify if you have the roles and privileges
required to export the object. For information on the roles, see the topic Roles Required for
Import and Export Management referenced in the Related Topics section.
 
The object must not include any field with display name length greater than 120 characters.
Your export job may fail if it includes a field with display name length greater than 120
characters.
 

Description
 

The optional description of the export activity.
 

File Name
 

The name of the export file to generate in ZIP format. This field is populated based on the
object and date time stamp.
 

Export Attachments
 

Select to export the attachments related to the object. This option is enabled only if the
selected object supports attachments.
 

4. Optionally to set additional export configurations, click the Advanced Options section. Here you can configure
settings in the Output File, Export Options, or Create Schedule sections.

◦ Following are the options in the Output File and Export Options regions:

Option Description Default Value

Delimiter
 

If your file doesn't use a comma to
separate values, then select the correct
delimiter in the Delimiter drop-down list.
Possible values are:
 

Comma
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Option Description Default Value

- Caret Symbol

- Closing Curly Bracket

- Closing Parenthesis

- Closing Square Bracket

- Colon

- Comma

- Exclamatory Mark

- Minus

- Opening Curly Bracket

- Opening Parenthesis

- Opening Square Bracket

- Pipe Symbol

- Plus

- Question Mark

- Semi-Colon

- Star Symbol

- Tilde Symbol

Escape Special Characters
 

If selected, then RFC4180 format is used,
 and quotes are escaped with another set
of quotes.
 

Deselected
 
 

Decimal Separator
 

The decimal separator used in your
export file. Possible values are Comma
and Period.
 

Period
 

Date Format
 

The format of the date fields in your file.
Possible values are:
 

- EU-YYYY/MM/DD

- ISO 8601 - YYYY-MM-DD

- UK/Canada - DD/MM/YYYY

- US - MM/DD/YYYY

US - MM/DD/YYYY
 

Time Stamp Format
 

The format of time fields in your file.
Possible values are:
 

- Canada - DD/MM/YYYY hh:mm:ss
PM

- EU - YYYY/MM/DD 24:mm:ss

- ISO 8601 - YYYY-MM-
DDThh:mm:ss sss+/-hh:mm

- UK - DD/MM/YYYY 24:mm:ss

- US - MM/DD/YYYY hh:mm:ss PM

US - MM/DD/YYYY hh:mm:ss PM
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Option Description Default Value

File Encoding
 

The format in which the characters within
your source file are encoded. Possible
values are:
 

- Chinese Simplified - GB, CP936

- Chinese Traditional - CP950

- Eastern European - Win, CP1250

- Greek - MS Windows, CP1253

- Japanese - Shift-JIS, CP932

- Unicode - UTF - 8

- Unicode - UTF - 16

- Unicode - UTF - 16BE, Mac, Unix

- Unicode - UTF - 16LE, MS Windows

- Western European - Win, CP1252

Unicode - UTF - 8
 

End of Line
 

The character used to indicate end of line
in the export file. Possible values are:
 

- Carriage Return

- Carriage Return and Line Feed

- Line Feed

Line Feed
 

Quote Character
 

The character used to indicate a quote.
This field is read-only.
 

N/A
 

Language Independent Header
 

Select to export column headers. If you're
modifying the exported data manually,
 then exporting column headers help in
automatic mapping during the reimport
process.
 

N/A
 

Notification Email
 

The email to send export-processing
notifications. The user submitting the
export receives an email notification
automatically. You use this field to specify
any additional recipients. If you want
to have more than one email recipient,
separate the email addresses with a
comma or semicolon. You can also
specify a mailing list address so that
a large number of recipients can be
notified. If you don't want to receive the
notification, then set the profile option
ORA_ZCA_IMPEXP_ENABLE_EMAIL_NOTIFY
to 'N' at user level.
 

N/A
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Option Description Default Value

Enable Split
 

Select to split the export data set based
on a specified record count. On selecting
this check box, you can see the Split Size
drop-down list, with a default value of
100k. You can specify the split size in
multiples of 100k records, ranging from
100k to 1000k.
 
The exported data is split into multiple
CSV files, and each file has a maximum
of 50K records. You can further split the
exported data into multiple ZIP files,
 based on the specified split size. For
example, if your export job retrieves 300k
records and split is enabled with a split
size of 200k, then 2 export ZIP files are
generated. The first ZIP file contains 200k
records which is divided into 4 CSV files
each with 50k records. The second ZIP
file contains 100k records which is then
divided into 2 CSV files each with 50k
records.
 

N/A
 

◦ In the Create Schedule region, you can schedule the export to run either immediately or at a future date.
If you select a future date, then provide the date and time to start the export.

You can save the Advanced Options for subsequent reuse by clicking on the Save advance options link in the UI.
The options will be retained till you click on the Reset link and reset the options to application defaults.

Note:  All fields except Schedule Mode and Schedule start time will be saved.

5. Click Next. On the Map Fields page you can see the exportable object, its child objects, and the associated
attributes. The Export Mapping drop-down list shows the maps that were used in earlier export jobs. You can
select an existing mapping from the drop-down list and click Apply.

You can save your export maps for future use by clicking on the pencil icon (Save As) in the Create Export
Activity page. You can also mark your maps as private by checking the Private Map check box. Private maps
can only be viewed and reused by the user who created and saved the map. Maps marked as private won't get
purged by the daily purge job.

Note:  Your maps will only be saved once the job is completed.

To select and apply your saved maps, check the My Maps check box, select the required map from the Export
Mapping drop down and click Apply in the Create Export Activity page.

6. You can select the child objects to export by selecting the Enabled check box. Selecting the Enabled check box
for a child object displays the associated attributes in the Available Fields section. You can select the attributes
to export by double-clicking the attribute in the Available Fields list. Alternatively, you can move the attribute
from Available Fields list to the Selected Fields list. If you select any formula fields for export, it might impact
your export performance.
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7. You must provide a filter criterion for at least the top-level object. To filter the records to export using
conditions, click the Filter Name icon. On the Filter Name dialog box, you can create the filter for the export
attributes using the operators AND, OR, >, <, =, and !=. On the Fields tab select the attribute and click the Insert
button. In the Script Edit window, provide the filter conditions for the selected attribute. After creating the filter
criteria script, click Validate Script. Click Save and Close to save the filter.

Note:  You must use GeographyCode='TM' filter to export the Zone Hierarchies. To export both Zone
Hierarchy information and Geography Country Information, you need to use filter GeographyCode='TM' Or
CountryCode='DE'. For more information see How to Use Export Management to Export Territory Geography
Zone Hierarchies?

8. Click Next. On the Review and Submit page, review the export activity configuration. If you want to change
any configuration, then click the Back button. Submit to activate the export activity. After the export activity
completes, clicking the My Completed Exports infotile shows your export status. Click the ZIP file link in the
Exported Data File column to download the exported file.

You can cancel the export by clicking the Cancel icon in the Manage Exports page when the job status is
Paused, Queued for Export, Preparing data to Export, or Exporting Data.

Note:   The cancel job option is available for the logged in user and the hierarchy user only when the profile
option ORA_ZCA_IMPEXP_RESTRICT_USERACCESS is enabled.

Note:   CSV String Escape: By default, the escape character is a " (double quote) for CSV-formatted files. If a value
contains a comma, a newline character, or a double quote then the string must be enclosed in double quotes. For
example: "Newline char in this field \n". A double quote must be escaped with another double quote. For example:
"The double quote character "" is offensive.".

Note:  By default, you can't view the Personally Identifiable Information(PII) such as mobile numbers in the exported
data. To view this information, follow these steps:

1. Navigate to Tools >  Security Console.
2. Search for the role ORA_MOT_QUOTA_EXPORT_MANAGEMENT_DUTY.
3. Edit role and click the Data Security Policies link.
4. Click the Create Data Security Policy button, and add a new data security policy on the database resource

Trading Community Contact Point with the following details.

◦ Policy Name: Custom Grant on Person Contact and Mobile Phone Data (you can provide any name)

◦ Database Resource: HZ_CONTACT_POINTS

◦ Data Set: All Values

◦ Actions: View Trading Community Person Contact, View Trading Community Mobile Phone Number

5. Click OK to save and navigate to Summary step to review and save changes.
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Related Topics
• What are the roles required to import or export data?

• How You Monitor Export Activity

• Export Queues

How can I edit Oracle Fusion pages and add fields?  
There are a wide variety of tools available for you to configure and extend Oracle Sales and other Oracle Fusion
applications.

• You can create additional fields using Application Composer.

• To add fields to pages and change page layout in the classic UI, use Application Composer.

• To add fields and edit the layout of pages in the Redwood user experience, use Oracle Visual Builder Studio. You
can tell if a page requires you to use Visual Builder Studio when you see the Edit Page in Visual Builder Studio
option in the Settings and Actions menu on the page.

• To edit text and messages, you can use the User Interface Text tool.

Here are a few places to get started:

• Overview of Application Configuration and Extension

• Overview of Using Application Composer

• Overview of Using Visual Builder Studio

• Modify Text Using User Interface Text Tool

What's the storage limit and retention period for content
stored in UCM?  
There's no storage limit and no finite retention period for content stored in Universal Content Management (UCM). UCM
provides storage for attachments and other documents in Oracle Fusion Applications.

How do I generate the diagnostics log for import?  
The diagnostic log files provide complete information about an import job and its errors. If you have errors in your
import job, then provide the diagnostic logs to technical support to help them resolve the issue.

You can generate the diagnostic logs by clicking the Generate button. You can then attach the log files (in ZIP format) to
the Service Request (SR). This helps technical support to resolve the issues.
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To generate the diagnostic logs for an import:

1. Click Tools > Import Management.
2. On the Manage Imports  page, click the Name link for your import that has failed.
3. On the Import Status page, click the Generate Diagnostics button in the Action menu to generate the

diagnostics files.
See the Import Attachments section for the link to download the generated files. Click Download under the Actions
column to download the file. For more information about the files, click on the details icon.

How do I find Customer Data Management (CDM)
subject areas for my reports?  
Use the Sales subject areas listed and described in the Subject Areas for Transactional Business Intelligence guide for
CDM. There aren't any separate CDM subject areas.

How do I send updated sales information from CDM to
an integrated outside application?  
You can call RESTful SOAP web services from your Groovy scripts in Application Composer.

See the following topics for more information:

• How to Call RESTful Web Services from Groovy Scripts

• How to Call SOAP Web Services

• Invoking Web Services from Your Scripts

How can I enable filtering of Price Books in Redwood
Sales?  
Price Books aren't enabled for Adaptive Search, the search technology used by Sales in the Redwood user experience.
However, you can use the Price Book REST API to search and filter using multiple terms. For example, a company that
manages multiple price books organized in brands and sales groups can use this method to search for price books by
brand and by sales group.

To access the REST URL for price books follow this pattern: https://fa-<podname>-saasfaprod1.fa.ocs.oraclecloud.com/
crmRestApi/resources/latest/priceBookHeaders?q=<custom field name>_c=<bindVal>.

Here's the code to add to the API call headers:

REST-Framework-Version as 9
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Payload to use -
getQueryStatus() {
 let retQuery = [
 {
 "type": "qbe",
 "provider": "adfRest",
 "q": "StatusCode='ACTIVE'"
 },
 {
 "type": "search",
 "provider": "adfRest",
 "params": [
 {
 "key": "<custom field name>_c",
 "operator": "contains"
 }
 ]
 }
 ];
 return retQuery;
 }

Can I save an OTBI analysis as a .CSV file directly to a
UCM location?  
In OTBI, you can use BI Agents to trigger alerts and deliver analyses to users by email, phone, and other means, but
you can't save analyses as a file directly to an Oracle Content Management (UCM) location. If you do require delivery
to UCM, then recreate your report in Oracle Analytics Publisher (BI Publisher). You can then schedule and send the BI
Publisher report to a content server.

For information about using BI Agents to send information using email, see the Send Email Reports topic in the Creating
Analyses and Dashboards in Oracle Transactional Business Intelligence guide.

In BI Publisher, you can specify a content server for your output as described in the topic Set Output Options in the
Using Oracle Analytics Publisher in Oracle Transactional Business Intelligence guide.

Is there a maximum number of fields that you can
display in the Details (Edit) page in Redwood Sales?  
There's no limit to the number of fields you can add to the Details page in the Redwood user experience. While there's
no upper limit, adding a large number of fields can degrade performance and make the page less usable.
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How do I export attachments?  
This topic explains how to export and download the object attachments to your local directory. Here is a list of objects
that support exporting of attachments:

• Account

• Activity

• Assets

• Competitor

• Contact

• ConversationMessage

• DealRegistration

• Household

• HRHelpDeskRequest

• InternalServiceRequest

• Opportunity

• Partner

• PartnerContact

• Product

• ProductGroup

• ServiceRequest

• WrapUp

You can export the attachments in two steps:

1. Export the object records and the attachment information based on the selected search criteria of the object.
2. Download the attachment files from the content management server using the External Data Loader Client tool.

Export the Object Records and the Attachment Information
To export the object records and the attachment information:

1. Click Tools > Export Management.
2. On the Manage Exports page, click the Create Export Activity button.
3. On the Enter Export Options page, enter the export activity information such as export name, export object,

and the file name. For more information on exporting data, see the topic Export Data.
4. Select the Export attachment check box to enable exporting the object attachments. You can optionally enter

the advanced configuration options. Click Next.
5. On the Map Fields page, you can select the attributes to export by dragging them from the Available Fields

section to the Selected Fields section. The Export Mapping drop-down list shows the maps used in earlier
export jobs. You can select an existing mapping from the drop-down list and click Apply. You can select the
Enabled check box to export the child object attributes.

6. You must provide a filter criterion for at least the top-level object. To filter the records to export using
conditions, click the Filter Name icon and enter the filter criteria for your object records. Click Next. On the
Review and Submit page, review the export activity configuration and click Submit.
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7. After the export activity completes, clicking the My Completed Exports infotile shows your export status. Click
the ZIP file link in the Exported Data File column to download the exported file.

Download the Attachment Files
The ZIP file you downloaded in the previous step contains the following files:

• The attachment information CSV file - this file contains information about the attachment records such as
content ID, REST resource URL, attachment file name, and so on.

• Attachment download instructions file - this HTML file contains the export details, and the sample EDLC
command to download the attachments.

You can use the export command of EDLC to download the attachment files from the content management server to
your directory. For example, use the following command to download your attachments exported from the previous
step:

java -jar oscdataloader.jar export -object Attachments -export-id {export-id} -username {username} -target-
url {environment-url} -output-path {output-directory-path}

Following are the parameters used in the command:

Parameter Description

-objects
 

Indicates the object type exported. Currently this parameter supports only the value Attachments.
 

-export -id
 

Job ID of the export job.
 

-username
 

User name of the user submitting the export command. This must be the same user who submitted
the export activity.
 

-target-url
 

URL of the environment.
 

-output-path
 

Directory path of the folder where the attachment files and reports are downloaded. The reports folder
contains details about the attachment files exported, such as their status and error details if any This
should be an existing directory with read and write permissions for the user performing the export.
 

You can view the details of all available parameters and their descriptions using the command export -help.

Related Topics
• How do I export data?

• Overview of External Data Loader Client

• Command-Line Parameters
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What is the impact of party merge on all Oracle Fusion
applications?  
Let's discuss what is a party merge and it's impact on all Oracle Fusion applications.

What is a party?
A party, in the Oracle Fusion Customer Data Model, is an entity that can enter into a business relationship, such as
buying and selling, and can be of the type Organization, Person, or Group. A party exists separately from any business
relationship that it enters into with another party. For example, Vision Corp could be a party within the customer data
model. However, Vision Corp can be simultaneously a supplier to its customers and a buyer or customer to its suppliers.

What is party merge?
Party merge is one of the two ways of resolving duplicate records of business entities, the other being linking the
parties. You can merge two or more duplicate parties by creating a merge duplicate resolution request. During merge
these parties are combined into one primary record. After the merge request is completed, you can update only the
master record. The merged duplicate records are also called non-master records. Note that merge supports the transfer
of attachments from duplicate records to a master record.

How does party merge impact the different roles and relationships of a
party across Oracle Fusion applications?
When you merge parties, the related child entities that get merged include party relationships, contact information,
party profiles, customer accounts, and information obtained from third-party sources. Note that you can only merge
parties with the same party type. This implies that an organization can only be merged with another organization,
a person with a person, and so on. In the case of parties and customer accounts, if you find duplicate parties, you
should determine if duplicate customer accounts also exist. When two customer accounts are merged and the
corresponding parties are verified as duplicates, the parties can be merged. When two parties are merged and the
corresponding customer accounts are verified as duplicates, the customer accounts can be merged. Similarly, you can
merge organization contacts between parties that you are merging.

When do deployments perform party merges?
An example of when you perform party merges is during mergers and acquisitions. The Customer Data Management
functionality of Oracle CX Sales acts as the customer master during Integration Cloud Service based integration
between different cloud services (also known as spoke systems). You can use Customer Data Management to cleanse,
consolidate, and share customer data across integrated cloud services.

Example of a party merge

This section explains how the duplicate resolution capability of the Customer Data Management functionality merges
records across integrated cloud services, for example, how it merges an Oracle CX Sales and Fusion Service account or
contact with an Oracle Service Cloud account or contact.
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Party Merge Impacts Across Applications
Many applications are impacted by party merges. Here is a list of applications and how they are impacted by party
merges:

Sales
What happens to custom objects in Sales, if they refer to Organizations?

The following information merges with the master party record:

• Information about a product in which the party is interested

• Information about sales leads associated with a party

• Information about the contact associated with the sales lead

• Forecast information for opportunities associated with a party

• Information about sales opportunities associated with a party

• Sales credits assigned to partner identified by the party

• Associations between a party contact and opportunity

• Information about competitors that exist for a sales opportunity

• Employee access to a party, opportunity and lead

• Changes to the parties and lead information that has been modified by a territory definition

• Information about the current environment of a party

The following information transfers to the master party record:

• Customer account plan information

Service
What happens to custom objects in Sales, if they refer to Organizations?

The following information merges with the master party record:

• Service request information associated with parties

• Service request incident location

• Audit information for service requests

• Contact point for a service request that is associated with a party

• Any party site used on a charge line

• Any site and site use that is associated to a party for a service request

Validations

If a service request has more than one contact, these contacts are merged. If duplicate contact points exist for the two
contacts that were merged, and these duplicate contact points are then merged, it could result in duplicate records in
CS_HZ_SR_CONTACT_POINTS. In this case, the duplicate records are deleted.
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Partner Management
The following information merges with the master account record:

• Partner referrals and deal registrations

How do I create merge requests?  
When you're sure that two or more records are confirmed duplicates, you can decide to create a duplicate resolution
request manually by linking or merging the records.

In this topic, we will be discussing the creation of merge requests.

1. Navigate to the Duplicate Resolution work area as follows: Navigator  > Customer Data Management >
Duplicate Resolution.

2. Click Tasks and then click Create Resolution Request.
3. Search for the records that you want to merge, link, or test merge. For example, select the Party Type as Person

and enter the Name as John, and click Search.

Note:  You can only search on standard fields using the Advanced Search option. Custom fields of the
Accounts or Contacts objects aren't available. Select two or more duplicate records using the Shift or Control
key.

4. Click Actions > Create Request.
5. Enter a name for the request in the Create Request: Select Type dialog.
6. Select the request type as Generic, Merge, Link, or Test Merge. You can also select the Master Record, if

needed.
7. Click OK.

You can also submit request dispatch jobs directly from the Duplicate Resolution work area by clicking the Dispatch
button, which will submit the job for immediate processing.

How do I merge duplicate records?  
Let's have a look at the process to merge records for resolving duplicates.

Suppose you have created a merge request. Your request may undergo some or all of the following processing stages
before the merge is performed. In this process flow, we assume that notifications are turned on. For more information
about turning on notifications for merge requests, see the Related Topics section.

• First the survivorship rules are used to determine the master record for the merge.

• After this, the agreement rule check is performed to verify if the merge request is violating any veto conditions.
If the agreement rule check succeeds then a check is performed to determine if system mapping must
be overridden or not. If the agreement rule check fails, then the merge request is rejected and a rejection
notification is sent to the initiator.

• However, a rejected merge request can also be restored in which case a new merge request is created.
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• If system mapping is overridden then the new mapping is stored before the merge request can be submitted.
After the merge request is submitted, the actual merge is performed.

• If the merge completes successfully then a completion notification is sent to the initiator and the submitter. If
the merge fails then an error notification is sent to the initiator and the submitter.

Note:  Check if you have the Master Customer Data Management Administrator role to perform merge.  Use the Purge
Duplicate Resolution Data scheduled process to purge the duplicate resolution data such as resolution logs and to
delete duplicate resolution batches and requests. You can schedule this process from the Scheduled Processes work
area. You can access this work area as follows: Navigator > Tools > Scheduled Processes.

Let's look at the following figure that illustrates the merge process flow.
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Merge Request Creation Options
A merge request is created as a result of one of the following:

• The batch duplicate identification process creates a duplicate resolution request automatically for each
identified duplicate set.

• A data steward or another user creates a merge request and submits the request through the Create Resolution
Request UI page or through the Accounts or Contact UI page.

• A data steward or another user creates a merge request for processing a generic resolution request on the
Duplicate Resolution work area.

• You can create a test merge request, examine the results, modify the test merge configuration multiple times
until you're satisfied with the merge results, and then create a merge request as per your requirements.

• A bulk or file-based import process creates a merge request.

Note:  You can also use the duplicate resolution request web service to create merge requests.

List of Merge Request Statuses
Your merge request may be in different statuses depending on its stage of processing.

This table lists the possible statuses of a merge request.

Status Description

Pending
 

All merge requests, and generic duplicate resolution requests, are created with the status as Pending.
The requests with pending status require review by a data steward.
 

New
 

The request dispatcher is run periodically for pending requests, and sets status of pending requests
to New. When the request dispatcher is run, the application selects the master record and attributes
based on the survivorship rules, and runs the agreement rule check for the request.
 

Submitted
 

This status indicates that the merge request has been submitted for processing. You can also create
merge requests with the status as Submitted to process the request without data steward intervention.
 

Rejected
 

This status indicates that the merge request is rejected by the data steward or by the process for
agreement rule violations. You can restore a rejected merge request.
 

Error
 

This status indicates the request has failed because one or more records can't be processed.
 

Completed
 

This status indicates that the request has been processed successfully.
 

How You Select Master and Records to Merge
You can review new merge requests to:

• Select the master record
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• Mark records as nonduplicates

• Remove records from the duplicate set to avoid merging them

The merge process selects the master record based on set master rules, if survivorship rules are active. However, you
can select to review and override system settings.

When to Override System Mapping
You can override system mappings, during the merge request review, if the system mapping of the request doesn't
meet your requirements. You can select the accounts, account addresses, and the relationships that should be merged,
transferred, or removed.

Merge Request Related Notifications
You can enable or disable notifications to notify the status of merge requests to interested parties. You can choose
to enable notifications while you're creating a duplicate identification batch or while processing individual duplicate
resolution requests. For more information about creating a duplicate identification batch, see Create Duplicate
Identification Batches and Define Subset Rules Related Topics section. To receive notifications for individual duplicate
resolution requests, select the request and click Actions >  Notify in the Duplicate Resolution work area.

The merge process sends the following related notifications:

• Rejection: This notification is sent to the merge request's initiator, such as a business user, salesperson, or
administrator. You can restore and resubmit a rejected merge request, by selecting a different master record or
by removing some records from the batch.

• Error: This notification is sent to the merge request's initiator and submitter. The notification indicates that the
merge request has errors and can't be processed.

• Completion: This notification is sent to the initiator and the assignee of the merge process. The process merges
duplicate records and updates the record hierarchies. The notifications include information such as the master
and duplicate records.

After receiving the completion notification, the request initiator and assignee can:

• Verify if the updated hierarchies are correct in the Manage Hierarchies work area.

• Optionally, make the necessary edits to the updated hierarchies.

Related Topics
• How do I override system mapping?

• Create Duplicate Identification Batches and Define Subset Rules

• How You Setup Duplicate Resolution Simplified Profile Options

548

https://www.oracle.com/pls/topic/lookup?ctx=fa-latest&id=s20030824
https://www.oracle.com/pls/topic/lookup?ctx=fa-latest&id=s20071304


Oracle Fusion Cloud Sales Automation
Sales Questions and Answers

Chapter 1
Sales Questions and Answers

How can I prevent users from creating appointments?  
If you don't want users to create appointments, you have a couple of options:

• Remove the Create Activity (ZMM_CREATE_ACTIVITY_APPOINTMENT_PRIV) privilege from the user's role.
Note this action also removes the ability to create other types of activities like tasks. See: How do I edit job or
abstract roles?

• Disable the Create Appointment smart action. See: How can I hide a smart action from the Actions menu in
Workspace objects?

Why can't a sales representative view all products in the
audit report?  
If users with the Sales Representative role can't see all of the objects in the audit report, do this:

1. Create a custom role.
2. Assign these privileges to the role:

◦ Manage Sales Audit Policies (FND_MANAGE_SALES_AUDIT_POLICIES_PRIV)

◦ Manage Audit Policies (FND_MANAGE_AUDIT_POLICIES_PRIV)

◦ View Audit History (FND_VIEW_AUDIT_HISTORY_PRIV)

3. Assign the custom role to the Sales Representative role.
4. Run the scheduled process Import User and Role Application Security Data.

How can I create rules to automatically provision job
roles to sales users?  
Before you create sales users, review the predefined role provisioning rules used to automatically assign job and
abstract roles to users, and create any additional rules you need.

For example, you might want to create a new resource role and rule to provision a custom job role you've created.

Oracle provides a role provisioning rule for each of the standard resource roles included with the application. But, you
must create role provisioning rules for any new resource roles you create.

The provisioning rules use the resource role that you assign to each sales user as the trigger condition for provisioning
job roles.

For all internal sales users, including sales administrators, map the Resource abstract role in addition to the required
job roles in the provisioning rule. The Resource abstract role lets users access the Resource Directory. Don't add the
Resource abstract role for partner roles.
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Note:  The role provisioning rules Oracle provides are created automatically when you set up your company
information using the Create Company Information quick setup task. If you didn't use the Create Company
Information quick setup task, then you must create all of these role-provisioning rules manually.

Review Existing and Create New Provisioning Rules
Use these steps to review existing provisioning rules, and to create new rules:

1. In the Setup and Maintenance work area, go to the following:

◦ Offering: Sales

◦ Functional Area: Users and Security

◦ Task: Manage HCM Role Provisioning Rules

2. On the Manage Role Mappings page, to review existing rules:
a. Search for a role mapping using one of the search fields. For example, to determine if a provisioning rule

exists for a resource role, in the Resource Role field, enter the name of a resource role.
b. Click Search.

If a role provisioning rule exists for the resource role (either a predefined rule or a rule you created), it's
displayed in the Search Results area.

c. To view or edit a provisioning rule, select the rule from the Search Results area.
d. In the Edit Role Mapping page, review the details for the rule.

3. To create a new provisioning rule, on the Manage Role Mappings page, click Create.
4. In the Create Role Mapping page, in the Mapping Name field, enter a name that identifies the mapping. For

example, if you're creating a rule to provision a resource role you created called Digital Sales Manager, enter
Digital Sales Manager for the mapping name too.

5. In the Conditions region, enter the conditions shown in this table:

Values to Enter in the Conditions Region

Field Entry

Resource Role Select the resource role you want to provision. For example, select Digital Sales Manager.

HR Assignment Status Select Active. This additional condition ensures that the provisioned roles are automatically
removed if the user is terminated in Global Human Resources.

6. In the Associated Roles region, click Add to add the job roles you want to provision.

For the Digital Sales Manager, for example, you might add the  Sales Manager job role.

For internal sales users, add the Resource abstract role. Don't add this role for partner roles.
7. For each role you've added, select one or more of the role provisioning options shown in this table:

Role Provisioning Options

Role Provisioning Option Description

Requestable Qualifying users can provision the role to other users.

550



Oracle Fusion Cloud Sales Automation
Sales Questions and Answers

Chapter 1
Sales Questions and Answers

Role Provisioning Option Description

Self-Requestable Qualifying users can request the role for themselves.

Autoprovision Qualifying users get the role automatically.

Qualifying users are users who satisfy the rule conditions.

Note:  Autoprovision is selected by default. Remember to deselect it if you don't want auto-provisioning.

8. Click Save and Close.
9. After creating or editing role mappings, run the scheduled process, Autoprovision Roles for All Users. This

process compares all current user role assignments with all current role mappings and creates appropriate
auto-provisioning requests.

Related Topics
• How do I update existing setup data?

What are the steps to provision a new, additional test
environment?  
Your newly provisioned, additional test environment should be provisioned like any other, similar to the production
environment after it was provisioned.

Review the article, Refreshing an Environment, to learn how to run self-service production-to-test (P2T) and test-to-test
(T2T) refreshes for your Fusion Applications environments: .

Also see the article, Oracle Applications Cloud Service Definition - Environment Refresh (Doc ID 2015788.1), on My Oracle
Support.

What are the privileges required to delete sales accounts
and contacts?  
Users with the sales administrator role can delete accounts and contacts.

Sales administrator can give privileges to the other administrative roles so that they can delete accounts and contacts.
Here's a description of the privileges you must have:
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Privileges Required to Delete Accounts and Contacts

Object Privilege More Information

Account Delete Sales Party You can't delete an account if it's a partner or
competitor account, or if the account is the
topmost tier in the account hierarchy.

Contact Delete Sales Party Contact You can delete standalone contacts. You must
also have full access to all of the accounts
associated with the contact. When you delete
a contact, you remove the entire person
record of the contact, including profile data,
 account usages, household memberships, and
relationships to other accounts.
 

Note:  When you delete an account or a contact, all the child entities might not become inactive. Run the Delete Child
Entities of Inactive Party Records scheduled process to deactivate them.
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